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Note
 

In order to be printed easily, this PDF-format manual is converted from the HTML-format instruction manual included
on the "User Manuals CD-ROM" supplied with the printer. Thus, there are descriptions that are applied only in HTML
format, and functions (video display function, etc.) that cannot be used. We appreciate your understanding.

 2



Contents
 

B
asic Printing W

orkflow

Basic Printing Workflow 19
Printing procedure 20

Printing Options Using Rolls and Sheets ................................................................................................................ 20
Turning the Printer On and Off ................................................................................................................................ 21
Loading and Printing on Rolls ................................................................................................................................. 22
Loading and Printing on Sheets ............................................................................................................................. 25
Printing in Windows ................................................................................................................................................ 26
Printing from Mac OS X .......................................................................................................................................... 27

Canceling print jobs 29
Canceling Print Jobs from the Control Panel .......................................................................................................... 29
Canceling Print Jobs from Windows ....................................................................................................................... 30
Canceling Print Jobs from Mac OS X ..................................................................................................................... 30

Pausing Printing 33
Pausing Printing ...................................................................................................................................................... 33

Enhanced Printing O
ptions

Enhanced Printing Options 35
Choosing Paper for Printing 36

Choosing a Paper for Printing ................................................................................................................................. 36
Specifying Paper in the Printer Driver ..................................................................................................................... 36

Printing Photos and Office Documents 37
Printing Photos and Images .................................................................................................................................... 37

Printing Photos and Images (Windows) ............................................................................................................ 38
Printing Photos and Images (Mac OS X) .......................................................................................................... 39

Printing from Photoshop ......................................................................................................................................... 42
Printing Adobe RGB Images (Windows) ........................................................................................................... 43
Printing Adobe RGB Images (Mac OS X) ......................................................................................................... 46

Printing Office Documents ...................................................................................................................................... 48
Printing Office Documents (Windows) .............................................................................................................. 48
Printing Office Documents (Mac OS X) ............................................................................................................. 50

Using PosterArtist to Compose Originals ............................................................................................................... 52

Adjusting Images 54
Adjusting the Color in the Printer Driver ................................................................................................................. 54

Fine-Tuning Colors of Photos and Images (Windows) ...................................................................................... 56
Fine-Tuning Colors of Photos and Images (Mac OS X) .................................................................................... 58

Giving Priority to Particular Graphic Elements and Colors for Printing ................................................................... 61
Choosing the Document Type and Printing Conditions (Windows) .................................................................. 63
Choosing the Document Type and Printing Conditions (Mac OS X) ................................................................ 65

Printing enlargements or reductions 68
Resizing Originals to Match the Paper Size ........................................................................................................... 68

Resizing Originals to Match the Paper Size (Windows) .................................................................................... 68
Resizing Originals to Match the Paper Size (Mac OS X) .................................................................................. 70

Resizing Originals to Fit the Roll Width ................................................................................................................... 72
Resizing Originals to Fit the Roll Width (Windows) ........................................................................................... 73
Resizing Originals to Fit the Roll Width (Mac OS X) ......................................................................................... 75

Resizing Originals by Entering a Scaling Value ...................................................................................................... 78
Resizing Originals by Entering a Scaling Value (Windows) .............................................................................. 78
Resizing Originals by Entering a Scaling Value (Mac OS X) ............................................................................ 80

Printing at full size 84
Printing on Oversize Paper ..................................................................................................................................... 84

3  



Enhanced Printing O
ptions

Printing at Full Size (Windows) .......................................................................................................................... 85
Printing at Full Size (Mac OS X) ........................................................................................................................ 86

Borderless Printing at Actual Size .......................................................................................................................... 89
Borderless Printing at Actual Size (Windows) ................................................................................................... 90
Borderless Printing at Actual Size (Mac OS X) ................................................................................................. 92

Borderless Printing 95
Borderless Printing on Paper of Equivalent Size .................................................................................................... 95

Borderless Printing by Resizing Originals to Match the Paper Size (Windows) ............................................... 96
Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X) .............................................. 98

Borderless Printing by Resizing Originals to Fit the Roll Width ............................................................................ 101
Borderless Printing by Resizing Originals to Fit the Roll Width (Windows) ..................................................... 102
Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X) ................................................... 104

Printing banners or at other non-standard sizes 108
Printing Vertical or Horizontal Banners (Large-Format Printing) ........................................................................... 108

Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) ..................................................... 109
Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X) ................................................... 113

Printing on Non-Standard Paper Sizes ................................................................................................................. 116
Printing on Non-Standard Paper Sizes (Windows) .......................................................................................... 116
Printing on Non-Standard Paper Sizes (Mac OS X) ........................................................................................ 118

Tiling and multiple pages per sheet 121
Printing Multiple Originals Next to Each Other ..................................................................................................... 121

Printing Multiple Originals Next to Each Other (Windows) .............................................................................. 122
Printing Multiple Originals Next to Each Other (Mac OS X) ............................................................................ 124

Printing Multiple Pages Continuously ................................................................................................................... 125
Printing Multiple Pages Continuously (Windows) ............................................................................................ 125
Printing Multiple Pages Continuously (Mac OS X) .......................................................................................... 127

Printing Multiple Pages Per Sheet ......................................................................................................................... 129
Printing Multiple Pages Per Sheet (Windows) ................................................................................................. 129
Printing Multiple Pages Per Sheet (Mac OS X) ............................................................................................... 131

Printing Posters in Sections .................................................................................................................................. 134
Printing Large Posters (Windows) ................................................................................................................... 135

Centering originals 138
Printing Originals Centered on Rolls ..................................................................................................................... 138

Printing Originals Centered on Rolls (Windows) ............................................................................................. 138
Printing Originals Centered on Rolls (Mac OS X) ............................................................................................ 140

Printing Originals Centered on Sheets .................................................................................................................. 143
Printing Originals Centered on Sheets (Windows) .......................................................................................... 143
Printing Originals Centered on Sheets (Mac OS X) ........................................................................................ 145

Conserving roll paper 148
Conserving Roll Paper by Rotating Originals 90 Degrees .................................................................................... 148

Conserving Roll Paper by Rotating Originals 90 Degrees (Windows) ............................................................ 148
Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X) .......................................................... 150

Conserving Roll Paper by Printing Originals Without Top and Bottom Margins ................................................... 152
Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows) ............................ 153
Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS X) .......................... 154

Checking Images Before Printing 158
Checking the Layout in a Preview Before Printing ................................................................................................ 158

Other useful settings 159
Printing With Watermarks ...................................................................................................................................... 159

Printing with Watermarks— COPY, FILE COPY, and so on (Windows) ........................................................... 160
Making the Original Orientation Match the Paper Orientation .............................................................................. 162

Making the Original Orientation Match the Paper Orientation (Windows) ...................................................... 162
Making the Original Orientation Match the Paper Orientation (Mac OS X) ..................................................... 164

Using Favorites ..................................................................................................................................................... 166

 4



Enhanced Printing O
ptions

Cutting Roll Paper After Printing ........................................................................................................................... 167
Cutting Roll Paper After Printing (Windows) ................................................................................................... 167
Cutting Roll Paper After Printing (Mac OS X) .................................................................................................. 168

W
indow

s Softw
are

Windows Software 171
Printer Driver 172

Printer Driver Settings ........................................................................................................................................... 172
Specifying Paper in the Printer Driver ................................................................................................................... 174
Confirming Print Settings ...................................................................................................................................... 176
Checking the Layout in a Preview Before Printing ................................................................................................ 176
Using Favorites ..................................................................................................................................................... 178
Accessing the Printer Driver Dialog Box from Applications ................................................................................. 179
Accessing the Printer Driver Dialog Box from the Operating System Menu ........................................................ 181
Main Sheet ............................................................................................................................................................ 182

Paper Information on Printer Dialog Box ......................................................................................................... 185
Paper Detailed Settings Dialog Box ................................................................................................................ 185
View Settings Dialog Box for the Printing Application ..................................................................................... 187
Color Adjustment Sheet: Color ........................................................................................................................ 187
Object Adjustment Dialog box: Color ............................................................................................................. 189
Matching Sheet ............................................................................................................................................... 189
Color Adjustment Sheet: Monochrome ........................................................................................................... 192
Object Adjustment Dialog box: Monochrome ................................................................................................. 193
Gray Adjustment Sheet ................................................................................................................................... 194

Page Setup Sheet ................................................................................................................................................. 195
Output Method Dialog box .............................................................................................................................. 198
Paper Size Options Dialog Box ....................................................................................................................... 199

Layout Sheet ......................................................................................................................................................... 200
Page Options Dialog Box ................................................................................................................................ 201
Special Settings Dialog Box ............................................................................................................................ 202

Favorites Sheet ..................................................................................................................................................... 203
Utility Sheet ........................................................................................................................................................... 204
Support Sheet ....................................................................................................................................................... 205

Settings Summaries Dialog Box ...................................................................................................................... 206
Device Settings Sheet ........................................................................................................................................... 206

Preview 207
The Features of Preview ........................................................................................................................................ 207
Starting Preview .................................................................................................................................................... 207
Preview Main Window ........................................................................................................................................... 208
Dialog Area ........................................................................................................................................................... 210
Enlarge/Reduce the screen display ...................................................................................................................... 211
Moving a Page ...................................................................................................................................................... 211
Using the ruler ....................................................................................................................................................... 211
Priority setting for rotating 90 degrees .................................................................................................................. 212
Printing with Selecting the Layout ......................................................................................................................... 213
Print on the Center ................................................................................................................................................ 215
Not Print Spaces at the Top/Bottom ...................................................................................................................... 216

Free Layout 217
The Features of Free Layout ................................................................................................................................. 217
Starting Free Layout .............................................................................................................................................. 217
Free Layout Main Window ..................................................................................................................................... 219

5  



W
indow

s Softw
are

Detailed Settings ................................................................................................................................................... 220
Preferences Dialog Box ........................................................................................................................................ 221
Page Options Dialog Box ...................................................................................................................................... 222
Zoom Dialog Box .................................................................................................................................................. 223
Format Dialog Box ................................................................................................................................................ 223
Laying out a Multiple-File Document on One Page .............................................................................................. 225
Laying out a Document Created with Multiple Application Programs on One Page ............................................ 227
Selecting an Object .............................................................................................................................................. 230
Changing the Object Size ..................................................................................................................................... 231
Moving an Object .................................................................................................................................................. 232
Rotating an Object ................................................................................................................................................ 232
Laying out Objects Automatically ......................................................................................................................... 232
Aligning Objects ................................................................................................................................................... 233
Changing the Object Overlapping Order ............................................................................................................. 234
Pasting a Copied or Cut Object ............................................................................................................................ 236
Folded Duplex Window ......................................................................................................................................... 236
Finished Size Settings Dialog Box ........................................................................................................................ 237
Binding Settings Dialog Box ................................................................................................................................. 238
Prints using Folded Duplex ................................................................................................................................... 239

Color imageRUNNER Enlargement Copy 240
The Features of Color imageRUNNER Enlargement Copy ................................................................................... 240
Starting Color imageRUNNER Enlargement Copy ............................................................................................... 240
Color imageRUNNER Enlargement Copy Dialog Box .......................................................................................... 241
Hot Folder ............................................................................................................................................................. 242
Creating a New Hot Folder ................................................................................................................................... 243
Specifying an Existing Shared Folder as a Hot Folder ......................................................................................... 246
Setting the Print Parameters ................................................................................................................................. 249
Printing Enlargements of Scanned Originals from a Color imageRUNNER ......................................................... 249

Print Plug-In for Photoshop / Digital Photo Professional 251
Features of the Print Plug-In for Photoshop/Digital Photo Professional ................................................................ 252
Installation Procedures ......................................................................................................................................... 252
Uninstall Procedures ............................................................................................................................................. 255
Starting from Photoshop ....................................................................................................................................... 255
Starting from Digital Photo Professional ................................................................................................................ 256
Print Plug-In for Photoshop/Digital Photo Professional Main Window ................................................................... 257

Preview Area .............................................................................................................................................. 259
Main Sheet ............................................................................................................................................................ 261
Page Setup Sheet ................................................................................................................................................. 264
Color Settings Sheet (Color) ................................................................................................................................. 266
Color Settings Sheet (Monochrome) ..................................................................................................................... 267
Print History Sheet ................................................................................................................................................ 268
Support Sheet ....................................................................................................................................................... 269
Adjustment pattern setting dialog box .................................................................................................................. 270
Paper Detailed Settings Dialog Box ...................................................................................................................... 274
Set Configuration Dialog Box ................................................................................................................................ 276
ICC Conversion Options dialog box ..................................................................................................................... 277
Roll Paper Options Dialog Box ............................................................................................................................. 278
Size Options Dialog Box ....................................................................................................................................... 278
Curves Dialog Box ................................................................................................................................................ 279
Print History Details Dialog Box ............................................................................................................................ 280
Utilize Three Types of Previews ............................................................................................................................ 281

Check Image with Print Area Layout ......................................................................................................... 281
Check the original image with Image ........................................................................................................ 282
Check Image with Roll Paper Preview ....................................................................................................... 282

Print with a Desired Picture Quality ....................................................................................................................... 283
Adjust the Colors and Print ................................................................................................................................... 284

Adjust the Colors while Checking the Preview (for Color) ......................................................................... 284
Adjust the Colors while Checking the Preview (for Monochrome) ............................................................ 285

 6



W
indow

s Softw
are

Adjust the Colors by Color Matching ......................................................................................................... 287
Print High-Quality Adobe RGB16bit Images ............................................................................................. 288
Prints monochrome photographs with high quality ................................................................................... 289
Using Adobe CMM .................................................................................................................................... 290

Printing an Adjustment Pattern and Selecting Adjustment Values ....................................................................... 291
Perform Black Point Compensation ...................................................................................................................... 293
Perform Printing Press Simulation Print ................................................................................................................ 294
Enlarge/Reduce and Print ..................................................................................................................................... 294

Enlarge/Reduce and Print Matching Output Media Size ........................................................................... 295
Enlarge/Reduce and Print Matching Width of Roll Paper .......................................................................... 296
Specify Scaling, Enlarge/Reduce and Print .............................................................................................. 297

Print with No Borders ............................................................................................................................................ 298
Customize Media Settings .................................................................................................................................... 299
Utilize Print History ................................................................................................................................................ 299

Confirm Print History Details ...................................................................................................................... 300
Apply Print History to an Image ................................................................................................................. 301
Store Print History to Print Preferences ...................................................................................................... 301
Delete Print History .................................................................................................................................... 303
Export Print History from Print Preferences ............................................................................................... 305
Import Print History to Print Preferences ................................................................................................... 306
Delete Print History from Print Preferences ............................................................................................... 308
Set Information to Print with Image ............................................................................................................ 309

Layout Plug-In for Photoshop 311
About the Layout Plug-In ...................................................................................................................................... 311
Layout Plug-In Main Window ................................................................................................................................ 311
Add Canvas Size dialog box ................................................................................................................................ 313
Creating and Printing a Layout Image for Mounting on a Frame .......................................................................... 314

Print Plug-In for Office 316
Print Plug-In for Office features ............................................................................................................................. 316
Steps to install ....................................................................................................................................................... 317
Steps to uninstall ................................................................................................................................................... 319
When Print Plug-In for Office is not displayed ...................................................................................................... 320
To start from Microsoft Word ................................................................................................................................. 324
Print Matching Roll Width (Word) .......................................................................................................................... 325
Borderless Printing (Word) .................................................................................................................................... 327
Multi-Page Printing (Word) .................................................................................................................................... 330
Register the settings (Word) ................................................................................................................................. 331
Print Using Registered Settings (Word) ................................................................................................................ 332
Portrait Orientation / Landscape Orientation (Word) ............................................................................................ 334
To start from Microsoft PowerPoint ........................................................................................................................ 335
Print Matching Roll Width (PowerPoint) ................................................................................................................ 337
Borderless Printing (PowerPoint) .......................................................................................................................... 339
Multi-Page Printing (PowerPoint) .......................................................................................................................... 342
Register the settings (PowerPoint) ........................................................................................................................ 343
Print Using Registered Settings (PowerPoint) ....................................................................................................... 344
Portrait Orientation / Landscape Orientation (PowerPoint) ................................................................................... 346
To start from Microsoft Excel ................................................................................................................................. 347
Print Entire Sheet (Excel) ...................................................................................................................................... 349
Print Selected Area (Excel) ................................................................................................................................... 351
Configuring Binding (Excel) .................................................................................................................................. 354
Configuring Special Settings ................................................................................................................................ 355

7  



M
ac O

S X Softw
are

Mac OS X Software 357
Printer Driver 358

Printer Driver Settings ........................................................................................................................................... 358
Specifying Paper in the Printer Driver ................................................................................................................... 360
Confirming Print Settings ...................................................................................................................................... 362
Checking the Layout in a Preview Before Printing ................................................................................................ 362
Using Favorites ..................................................................................................................................................... 363
Accessing the Printer Driver Dialog Box from Applications ................................................................................. 364
Main Pane ............................................................................................................................................................. 364

Paper Information on Printer Dialog Box ......................................................................................................... 367
Paper Detailed Settings Dialog Box ................................................................................................................ 368
View settings Dialog Box for the Printing Application ..................................................................................... 370
Matching pane ................................................................................................................................................ 370
Color Settings Pane: Color .............................................................................................................................. 373
Object Adjustment dialog box: Color .............................................................................................................. 374
Color Settings Pane: Monochrome .................................................................................................................. 375
Object Adjustment dialog box: Monochrome ................................................................................................. 376
Gray Adjustment Pane .................................................................................................................................... 376

Page Setup Pane .................................................................................................................................................. 378
Utility Pane ............................................................................................................................................................ 379
Additional Settings Pane ....................................................................................................................................... 380
Support Pane ........................................................................................................................................................ 380

Preview 382
The Features of Preview ........................................................................................................................................ 382
Starting Preview .................................................................................................................................................... 382
Preview Main Window ........................................................................................................................................... 384
Paper Settings Panel ............................................................................................................................................. 387

Easy Settings ................................................................................................................................................... 389
Advanced Settings .......................................................................................................................................... 390

Output Settings Panel ........................................................................................................................................... 392
Color Settings Panel .............................................................................................................................................. 394

Color Adjustment ............................................................................................................................................. 395
Gray Adjustment ............................................................................................................................................. 398
Matching ......................................................................................................................................................... 399

Driver Matching Mode ............................................................................................................................... 402
ICC Matching Mode .................................................................................................................................. 403
ColorSync .................................................................................................................................................. 404

Preferences Dialog Box ........................................................................................................................................ 404
Zoom Dialog Box .................................................................................................................................................. 405
Go to Page Dialog Box ......................................................................................................................................... 405
Print with No Borders ............................................................................................................................................ 405
Print on the Center ................................................................................................................................................ 406
Not Print Spaces at the Top/Bottom ...................................................................................................................... 406
Print Page Rotated 90 Degrees ............................................................................................................................ 407
Display with Fitting to the Width of the Paper ....................................................................................................... 408
Display with All ...................................................................................................................................................... 408
Display with Actual Size ........................................................................................................................................ 408
Moving a Page ...................................................................................................................................................... 409

Free Layout 410
The Features of Free Layout ................................................................................................................................. 410
Starting Free Layout .............................................................................................................................................. 410
Free Layout Main Window ..................................................................................................................................... 412
Paper Settings Panel ............................................................................................................................................. 415

Easy Settings ................................................................................................................................................... 417
Advanced Settings .......................................................................................................................................... 418

Color Settings Panel .............................................................................................................................................. 420

 8



M
ac O

S X Softw
are

Color Adjustment ............................................................................................................................................. 421
Gray Adjustment ............................................................................................................................................. 424
Matching ......................................................................................................................................................... 425

Driver Matching Mode ............................................................................................................................... 428
ICC Matching Mode .................................................................................................................................. 429
ColorSync .................................................................................................................................................. 430

Preferences Dialog Box ........................................................................................................................................ 431
Page Setup Dialog Box ......................................................................................................................................... 432
Zoom Dialog Box .................................................................................................................................................. 433
Format Dialog Box ................................................................................................................................................ 433
Laying out a Multiple-File Document on One Page .............................................................................................. 434
Laying out a Document Created with Multiple Application Programs on One Page ............................................ 434
Selecting an Object .............................................................................................................................................. 435
Changing the Object Size ..................................................................................................................................... 435
Moving an Object .................................................................................................................................................. 436
Rotating an Object ................................................................................................................................................ 436
Laying out Objects Automatically ......................................................................................................................... 437
Aligning Objects ................................................................................................................................................... 437
Changing the Object Overlapping Order ............................................................................................................. 439
Pasting a Copied or Cut Object ............................................................................................................................ 440

Color imageRUNNER Enlargement Copy 441
The Features of Color imageRUNNER Enlargement Copy ................................................................................... 441
Starting Color imageRUNNER Enlargement Copy ............................................................................................... 442
Color imageRUNNER Enlargement Copy Dialog Box .......................................................................................... 443
Hot Folder ............................................................................................................................................................. 443
Creating a New Hot Folder ................................................................................................................................... 444
Editing a Hot Folder (Setting Print Conditions) ..................................................................................................... 445
Deleting a Hot Folder ............................................................................................................................................ 447
Setting the Print Parameters ................................................................................................................................. 448
Paper Settings Panel ............................................................................................................................................. 448

Easy Settings ................................................................................................................................................... 450
Advanced Settings .......................................................................................................................................... 451

Output Settings Panel ........................................................................................................................................... 452
Color Settings Panel .............................................................................................................................................. 454

Driver Matching Mode ..................................................................................................................................... 455
ICC Matching Mode ........................................................................................................................................ 456

Printing Enlargements of Scanned Originals from a Color imageRUNNER ......................................................... 456

Print Plug-In for Photoshop / Digital Photo Professional 458
Features of the Print Plug-In for Photoshop/Digital Photo Professional ................................................................ 459
Installation Procedures ......................................................................................................................................... 459
Uninstall Procedures ............................................................................................................................................. 461
Starting from Photoshop ....................................................................................................................................... 463
Starting from Digital Photo Professional ................................................................................................................ 463
Print Plug-In for Photoshop/Digital Photo Professional Main Window ................................................................... 464

Preview Area .............................................................................................................................................. 466
Main Sheet ............................................................................................................................................................ 467
Page Setup Sheet ................................................................................................................................................. 470
Color Settings Sheet (Color) ................................................................................................................................. 472
Color Settings Sheet (Monochrome) ..................................................................................................................... 473
Print History Sheet ................................................................................................................................................ 474
Support Sheet ....................................................................................................................................................... 475
Adjustment pattern setting dialog box .................................................................................................................. 476
Paper Detailed Settings Dialog Box ...................................................................................................................... 480
Set Configuration Dialog Box ................................................................................................................................ 481
ICC Conversion Options dialog box ..................................................................................................................... 482
Roll Paper Options Dialog Box ............................................................................................................................. 483
Size Options Dialog Box ....................................................................................................................................... 483
Curves Dialog Box ................................................................................................................................................ 484

9  



M
ac O

S X Softw
are

Print History Details Dialog Box ............................................................................................................................ 485
Utilize Three Types of Previews ............................................................................................................................ 486

Check Image with Print Area Layout ......................................................................................................... 487
Check the original image with Image ........................................................................................................ 487
Check Image with Roll Paper Preview ....................................................................................................... 488

Print with a Desired Picture Quality ....................................................................................................................... 488
Adjust the Colors and Print ................................................................................................................................... 489

Adjust the Colors while Checking the Preview (for Color) ......................................................................... 489
Adjust the Colors while Checking the Preview (for Monochrome) ............................................................ 491
Adjust the Colors by Color Matching ......................................................................................................... 493
Print High-Quality Adobe RGB16bit Images ............................................................................................. 494
Prints monochrome photographs with high quality ................................................................................... 495
Using Adobe CMM .................................................................................................................................... 496

Printing an Adjustment Pattern and Selecting Adjustment Values ....................................................................... 497
Perform Black Point Compensation ...................................................................................................................... 499
Perform Printing Press Simulation Print ................................................................................................................ 500
Enlarge/Reduce and Print ..................................................................................................................................... 500

Enlarge/Reduce and Print Matching Output Media Size ........................................................................... 501
Enlarge/Reduce and Print Matching Width of Roll Paper .......................................................................... 501
Specify Scaling, Enlarge/Reduce and Print .............................................................................................. 503

Print with No Borders ............................................................................................................................................ 504
Customize Media Settings .................................................................................................................................... 505
Utilize Print History ................................................................................................................................................ 505

Confirm Print History Details ...................................................................................................................... 506
Apply Print History to an Image ................................................................................................................. 507
Store Print History to Print Preferences ...................................................................................................... 507
Delete Print History .................................................................................................................................... 509
Export Print History from Print Preferences ............................................................................................... 510
Import Print History to Print Preferences ................................................................................................... 511
Delete Print History from Print Preferences ............................................................................................... 513
Set Information to Print with Image ............................................................................................................ 514

Layout Plug-In for Photoshop 516
About the Layout Plug-In ...................................................................................................................................... 516
Layout Plug-In Main Window ................................................................................................................................ 516
Add Canvas Size dialog box ................................................................................................................................ 518
Creating and Printing a Layout Image for Mounting on a Frame .......................................................................... 519

H
andling and U

se of Paper

Handling and Use of Paper 521
Paper 522

Types of Paper ...................................................................................................................................................... 522
Paper Sizes ........................................................................................................................................................... 522
Using Paper Other Than Genuine Paper and feed confirmed Paper ................................................................... 525

Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings ......................................... 525
Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type ............. 526

Displaying the Paper Reference Guide ................................................................................................................ 527
Updating paper information .................................................................................................................................. 528

Handling rolls 530
Attaching the Roll Holder to Rolls ......................................................................................................................... 530
Loading Rolls in the Printer ................................................................................................................................... 533
Changing the Type of Paper ................................................................................................................................. 537
Specifying the Paper Length ................................................................................................................................ 539
Removing the Roll from the Printer ....................................................................................................................... 539
Removing the Roll Holder from Rolls .................................................................................................................... 542
Feeding Roll Paper Manually ................................................................................................................................ 543
Keeping Track of the Amount of Roll Paper Left ................................................................................................... 544
Specifying the Ink Drying Time for Rolls ............................................................................................................... 544
Specifying the Cutting Method for Rolls ............................................................................................................... 546

 10



H
andling and U

se of Paper

Cutting the Leading Edge of Roll Paper Automatically ......................................................................................... 552
Reducing Dust from Cutting Rolls ......................................................................................................................... 554

Handling sheets 555
Loading Sheets in the Printer ................................................................................................................................ 555
Printing From a Desired Starting Point .................................................................................................................. 558
Removing Sheets .................................................................................................................................................. 560

Output Stacker 562
Output Stacker ...................................................................................................................................................... 562
Parts of the Output Stacker ................................................................................................................................... 563
Using the Output Stacker ...................................................................................................................................... 564
Storing the Output Stacker .................................................................................................................................... 568

Media take-up unit 570
Media Take-up Unit ............................................................................................................................................... 570
Using the Media Take-up Unit ............................................................................................................................... 570
Enabling Roll Take-Up ........................................................................................................................................... 571
Disabling Roll Take-Up .......................................................................................................................................... 571
Loading the Rewind Spool on the Media Take-up Unit ......................................................................................... 572
Removing Printed Documents from the Media Take-up Unit ................................................................................ 579

Media Configuration Tool (Windows) 582
The Features of Media Configuration Tool ............................................................................................................ 582
Installation Procedures ......................................................................................................................................... 583
Starting Method .................................................................................................................................................... 585
Media Configuration Tool Main Window ................................................................................................................ 585
Editing Media Type Information for Genuine Paper and Feed Confirmed Paper ................................................. 586

Adding Media Types ....................................................................................................................................... 588
Changing Media Names ................................................................................................................................. 590
Deleting Media Types You Have Added ......................................................................................................... 592
Switching Media Types Display Show/Hide .................................................................................................... 594
Changing the Display Order of Media Types .................................................................................................. 595

Using Paper Other than Genuine Paper and Feed Confirmed Paper .................................................................. 597
Compatible Paper ........................................................................................................................................... 598
Add Custom Paper .......................................................................................................................................... 599
Delete Custom Paper ...................................................................................................................................... 605
Edit Custom Paper .......................................................................................................................................... 606
Export Custom Media Information ................................................................................................................... 607
Import Custom Media Information ................................................................................................................... 607
Warnings ......................................................................................................................................................... 609

Media Configuration Tool (Mac OS X) 611
The Features of Media Configuration Tool ............................................................................................................ 611
Procedures for Installing ....................................................................................................................................... 612
Procedures for Uninstalling ................................................................................................................................... 614
Starting Method .................................................................................................................................................... 617
Media Configuration Tool Main Window ................................................................................................................ 618
Editing Media Type Information for Genuine Paper and Feed Confirmed Paper ................................................. 619

Adding Media Types ....................................................................................................................................... 620
Changing Media Names ................................................................................................................................. 623
Deleting Media Types You Have Added ......................................................................................................... 625
Switching Media Types Display Show/Hide .................................................................................................... 627
Changing the Display Order of Media Types .................................................................................................. 629

Using Paper Other than Genuine Paper and Feed Confirmed Paper .................................................................. 630
Compatible Paper ........................................................................................................................................... 632
Add Custom Paper .......................................................................................................................................... 633
Delete Custom Paper ...................................................................................................................................... 640
Edit Custom Paper .......................................................................................................................................... 640
Export Custom Media Information ................................................................................................................... 641

11  



H
andling and U

se of Paper

Import Custom Media Information ................................................................................................................... 642
Warnings ......................................................................................................................................................... 644

C
ontrol Panel

Control Panel 647
Operations and Display Screen 648

Control Panel ......................................................................................................................................................... 648
Control Panel Display ............................................................................................................................................ 649
How to View Instructions With Navigate ............................................................................................................... 653
Checking Instructions During Printer Operations ................................................................................................. 655

Printer Menu 657
Printer Menu Operations ....................................................................................................................................... 657
Menu Operations .................................................................................................................................................. 658
Menu Structure ...................................................................................................................................................... 661
Menu Settings ....................................................................................................................................................... 667
Status Print ............................................................................................................................................................ 676
Printing Interface Setting Reports ......................................................................................................................... 679

Printer Parts

Printer Parts 683
Printer parts 684

Front ...................................................................................................................................................................... 684
Back ...................................................................................................................................................................... 686
Top Cover (Inside) ................................................................................................................................................. 687
Carriage ................................................................................................................................................................ 688
Ink Tank Cover (Inside) ......................................................................................................................................... 689
Stand ..................................................................................................................................................................... 690
Media Take-up Unit ............................................................................................................................................... 691

Hard Disk 693
Printer Hard Disk Operations ................................................................................................................................ 693
Checking the Free Hard Disk Space .................................................................................................................... 694
Erasing Data on the Printer's Hard Disk ............................................................................................................... 695

Optional accessories 697
Roll Holder Set ...................................................................................................................................................... 697

N
etw

ork Setting

Network Setting 699
Network Environment 700

Network Environment ............................................................................................................................................ 700

Using RemoteUI 703
Using RemoteUI .................................................................................................................................................... 703

Initial Settings 705
Configuring the IP Address on the Printer ............................................................................................................ 705

Configuring the IP Address Using the Printer Control Panel ........................................................................... 705
Configuring the IP Address Using ARP and PING Commands ...................................................................... 706

Configuring TCP/IPv6 Network Settings ............................................................................................................... 708
Configuring the Printer Driver Destination (Windows) .......................................................................................... 708

 12



N
etw

ork Setting

Configuring the Printer Driver Destination (Mac OS X) ......................................................................................... 709
Configuring the Printer's TCP/IP Network Settings With RemoteUI ...................................................................... 709

NetWare Settings 712
Configuring NetWare Network Settings ................................................................................................................ 712
Specifying the Printer's Frame Type ..................................................................................................................... 712
Specifying NetWare Print Services ....................................................................................................................... 715
Configuring the Printer's NetWare Network Settings With RemoteUI ................................................................... 717

Mac OS X Settings 720
Configuring the Destination in TCP/IP Networks ................................................................................................... 720
Configuring the Destination for Bonjour Network .................................................................................................. 721
Configuring the Destination for AppleTalk Networks ............................................................................................ 723
Configuring the Printer's AppleTalk Network Settings .......................................................................................... 724

Other Settings 726
Specifying Printer-Related Information ................................................................................................................. 726
Configuring the Communication Mode Manually .................................................................................................. 727
Email Notification When Printing is Finished or Errors Occur ............................................................................... 728
Initializing the Network Settings ............................................................................................................................ 728

Device Setup Utility (Windows) 730
imagePROGRAF Device Setup Utility ................................................................................................................... 730
Installing imagePROGRAF Device Setup Utility ................................................................................................... 730
Configuring the IP Address Using imagePROGRAF Device Setup Utility ............................................................ 730

Print Job M
anagem

ent

Print Job Management 733
Status Monitor (Windows) 734

The Features of imagePROGRAF Status Monitor ................................................................................................. 734
Job Management Using imagePROGRAF Status Monitor .................................................................................... 735

Printmonitor (Mac OS X) 737
The Features of imagePROGRAF Printmonitor ..................................................................................................... 737
Job Management Using imagePROGRAF Printmonitor ....................................................................................... 738

Accounting (Windows) 740
Accounting Manager ............................................................................................................................................ 740
Launching the Accounting Manager .................................................................................................................... 740
Accounting Manager Main Window ...................................................................................................................... 741

Job List Area .............................................................................................................................................. 743
Accounting Manager Basic Procedures ............................................................................................................... 744
Configuring Unit Costs in Accounting Manager ................................................................................................... 745

Setting the Unit Cost for Ink ............................................................................................................................ 745
Setting the Unit Cost for Paper ........................................................................................................................ 746
Setting the Unit Cost for Items Other Than Ink and Paper .............................................................................. 748

Configuring Units and Display Settings in Accounting Manager ......................................................................... 749
Automatically Acquiring Print Job Logs at Regular Intervals ................................................................................ 749
Canceling Regular Print Job Log Acquisition ....................................................................................................... 750
Switching Between Displaying Jobs on Printer and Regularly Acquired Jobs .................................................... 750
Exporting Print Job Data as a CSV File ................................................................................................................ 750
Displaying Job Properties or Period Properties .................................................................................................... 751
Showing, Saving and Loading Selected Unit Cost Data ...................................................................................... 752
Showing the Total Amount of Ink and Paper Consumed ...................................................................................... 752

Basic Print Job Operations 754
Using the Printer Hard Disk .................................................................................................................................. 754
Saving Print Jobs on the Printer Hard Disk ........................................................................................................... 756
Managing the Job Queue (Deleting or Preempting Other Jobs) .......................................................................... 759
Managing Pending Jobs (Printing or Deleting Jobs on Hold) .............................................................................. 761
Printing Saved Jobs .............................................................................................................................................. 763

13  



Print Job M
anagem

ent

Deleting Saved Jobs ............................................................................................................................................. 768
Moving Saved Jobs .............................................................................................................................................. 772

Advanced Print Job Operations 776
Saving Print Jobs Sent from Sources Other than the Printer Driver ...................................................................... 776
Printing Without Saving Jobs in the Common Box ................................................................................................ 777
Setting Passwords for Personal Boxes ................................................................................................................. 778
Naming Personal Boxes ........................................................................................................................................ 781
Displaying a List of Saved Jobs ............................................................................................................................ 784
Printing a List of Saved Jobs ................................................................................................................................ 787
Displaying Details of Saved Jobs ......................................................................................................................... 788
Renaming Saved Jobs .......................................................................................................................................... 791

A
djustm

ents for B
etter Print Q

uality

Adjustments for Better Print Quality 795
Adjustment for high-precision printing 796

Enhancing Printing Quality .................................................................................................................................... 796

Adjusting the Printhead 798
Adjusting the Printhead ......................................................................................................................................... 798

Automatic Adjustment to Straighten Lines and Colors ................................................................................... 798
Manual Adjustment to Straighten Lines and Colors ........................................................................................ 800
Adjustment When Installing the Printhead ...................................................................................................... 802

Troubleshooting Paper Abrasion and Blurry Images ............................................................................................ 803

Adjusting the feed amount 805
Adjusting the Feed Amount .................................................................................................................................. 805

Selecting a Feed Amount Adjustment Method ............................................................................................... 805
Automatic Banding Adjustment ...................................................................................................................... 806
Manual Banding Adjustment ........................................................................................................................... 807
Fine-Tuning the Paper Feed Amount ............................................................................................................... 809
Adjusting Line Length ..................................................................................................................................... 810

Adjusting the Vacuum Strength ............................................................................................................................ 811

C
olor M

anagem
ent

Color Management 813
Monitor Matching 814

Printing Images to Match Monitor Colors .............................................................................................................. 814
Printing Images to Match Monitor Colors (Windows) ...................................................................................... 815
Printing Images to Match Monitor Colors (Mac OS X) .................................................................................... 817

Color Calibration 820
Corrects slight differences in how colors appear (color calibration) .................................................................... 820

Paper that can be used in Color Calibration ................................................................................................... 822
M

aintenance and C
onsum

ables
Maintenance and Consumables 825
Ink Tanks 826

Ink Tanks ............................................................................................................................................................... 826
Replacing Ink Tanks .............................................................................................................................................. 826
Checking Ink Tank Levels ..................................................................................................................................... 836
When to Replace Ink Tanks ................................................................................................................................... 837

Printheads 838
Printhead ............................................................................................................................................................... 838
Checking for Nozzle Clogging .............................................................................................................................. 838
Cleaning the Printhead ......................................................................................................................................... 839
Replacing the Printhead ....................................................................................................................................... 840

Cutter Unit 848
Cutter Unit ............................................................................................................................................................. 848

 14



M
aintenance and C

onsum
ables

Replacing the Cutter Unit ...................................................................................................................................... 848

Maintenance Cartridge 852
Maintenance Cartridge ......................................................................................................................................... 852
Replacing the Maintenance Cartridge .................................................................................................................. 852
Checking the Remaining Maintenance Cartridge Capacity ................................................................................. 859
When to Replace the Maintenance Cartridge ...................................................................................................... 859

Cleaning the Printer 861
Cleaning the Printer Exterior ................................................................................................................................. 861
Cleaning Inside the Top Cover .............................................................................................................................. 861

Other Maintenance 865
Preparing to Transfer the Printer ........................................................................................................................... 865
Updating the Firmware ......................................................................................................................................... 871

Consumables 873

Troubleshooting

Troubleshooting 875
Frequently Asked Questions 876

Frequently Asked Questions ................................................................................................................................. 876

Problems Regarding Paper 878
Clearing Jammed Roll Paper ................................................................................................................................ 878
Clearing a Jammed Sheet .................................................................................................................................... 881
Roll paper cannot be inserted into the paper feed slot ........................................................................................ 883
Cannot load sheets ............................................................................................................................................... 884
Paper is not cut straight ........................................................................................................................................ 884
Paper is not cut ..................................................................................................................................................... 884
The media take-up unit continues rotating ........................................................................................................... 884
The size of clear film cannot be detected ............................................................................................................. 885
Margins are wide .................................................................................................................................................. 885
When printing on thin roll paper, the printed surface becomes scratched .......................................................... 885

Printing does not start 886
The Data lamp on the Control Panel does not light up ......................................................................................... 886
The printer does not respond even if print jobs are sent ...................................................................................... 886
Ink Filling.. is displayed ......................................................................................................................................... 886
The display screen indicates Agitating... .............................................................................................................. 886

The printer stops during a print job 887
An error message is shown on the Display Screen .............................................................................................. 887
The printer ejects blank, unprinted paper ............................................................................................................ 887

Problems with the printing quality 888
Printing is faint ....................................................................................................................................................... 888
Paper rubs against the printhead ......................................................................................................................... 889
The edges of the paper are dirty .......................................................................................................................... 889
The surface of the paper is dirty ........................................................................................................................... 890
The back side of the paper is dirty ....................................................................................................................... 890
Immediately after borderless printing, the trailing edge margin is soiled during regular printing ................................................. 891
Printed colors are inaccurate ................................................................................................................................ 891
Banding in different colors occurs ........................................................................................................................ 891
Colors in printed images are uneven .................................................................................................................... 892
Image edges are blurred or white banding occurs .............................................................................................. 893

Setting the Blue Switch on the Platen ............................................................................................................. 893
The contrast becomes uneven during printing ..................................................................................................... 896
The length of printed images is inaccurate in the feeding direction .................................................................... 896
Images are printed crooked ................................................................................................................................. 897
Documents are printed in monochrome ............................................................................................................... 897

15  



Troubleshooting

Line thickness is not uniform ................................................................................................................................ 897
Lines or colors are misaligned .............................................................................................................................. 898
Borders appear in borderless printing .................................................................................................................. 898

Cannot print over a network 899
Cannot connect the printer to the network ............................................................................................................ 899
Cannot print over a TCP/IP network ...................................................................................................................... 899
Cannot print over a NetWare network ................................................................................................................... 899
Cannot print over AppleTalk or Bonjour networks ................................................................................................. 900

Installation problems 901
Removing Installed Printer Drivers ........................................................................................................................ 901

Other problems 903
The printer does not go on .................................................................................................................................... 903
The printer takes time to start up .......................................................................................................................... 903
If the Printer Makes a Strange Sound ................................................................................................................... 903
Messages advising to check the maintenance cartridge are not cleared ........................................................... 903
The printer consumes a lot of ink .......................................................................................................................... 904
Ink Level Detection ............................................................................................................................................... 904

Error M
essage

Error Message 907
Error Messages 908

Messages regarding paper 910
Paper mismatch .................................................................................................................................................... 910
MediaType Mismatch ............................................................................................................................................ 910
The paper is too small. .......................................................................................................................................... 911
The paper is too small. .......................................................................................................................................... 911
PaprWidth Mismatch ............................................................................................................................................. 912
Paper size not detected. ....................................................................................................................................... 912
Insufficient paper for job ....................................................................................................................................... 913
This paper cannot be used as size is not supported. .......................................................................................... 913
Roll printing is selected. ........................................................................................................................................ 914
Roll printing is selected, but sheets are loaded. .................................................................................................. 914
The roll is empty. ................................................................................................................................................... 914
No sheets. ............................................................................................................................................................. 915
Sheet printing is selected. .................................................................................................................................... 915
Regular printing is selected, but a roll is loaded. ................................................................................................. 915
Paper jam. ............................................................................................................................................................. 915
Paper loaded askew. ............................................................................................................................................ 916
Cannot detect papr ............................................................................................................................................... 916
Cannot feed paper. ............................................................................................................................................... 916
Cannot cut this paper. ........................................................................................................................................... 916
End of paper feed. ................................................................................................................................................ 917
Rel lever is in wrong position. ............................................................................................................................... 917
Rewinding error. .................................................................................................................................................... 917
Media take-up unit ready. ..................................................................................................................................... 918
Turn on the media take-up unit. ............................................................................................................................ 918
Borderless printng not possible. ........................................................................................................................... 918
Paper position not suitable for borderless printing. .............................................................................................. 918

Messages regarding ink 920
Ink insufficient. ...................................................................................................................................................... 920
No ink left. ............................................................................................................................................................. 920
Remaining level of the ink cannot be correctly detected. .................................................................................... 920
Close Ink Tank Cover ............................................................................................................................................ 920
Ink tank is empty. .................................................................................................................................................. 921
Not much ink is left. ............................................................................................................................................... 921
No ink tank loaded. ............................................................................................................................................... 921

 16



Error M
essage

The following ink tanks cannot be recognized. .................................................................................................... 921

Messages regarding printing or adjustment 922
Cannot execute this command. Use other paper. ................................................................................................ 922
Cannot calibrate. ................................................................................................................................................... 922
Excessive temperature or humidity. ...................................................................................................................... 922
Please execute common calibration. .................................................................................................................... 923
Please commn calibrt using above paper. ........................................................................................................... 923
Please calibrate using above paper. .................................................................................................................... 923
Borderless printng not possible. Paper stretched or shrank. ............................................................................... 923
Before borderless printing, move the blue platen switch. .................................................................................... 923
Blue platen switch is dirty. .................................................................................................................................... 924
Move the blue platen switch No.xx to the right. (xx represents a number) .......................................................... 924
Cannot adjust paper feed. .................................................................................................................................... 924
Check printed document. ..................................................................................................................................... 924

Messages regarding printheads 925
Cannot adjust printhead. ...................................................................................................................................... 925
PHeads: wrong pos. ............................................................................................................................................. 925
Wrong x printhead. (x is L, R, or not displayed) ................................................................................................... 925
x printhead error (x is L, R, or not displayed) ....................................................................................................... 925
Cannot recognize print head x. (x is L, R, or not displayed) ................................................................................ 926
Execute printhead cleaning. ................................................................................................................................. 926

Messages regarding the maintenance cartridge 927
No maintenance cartridge. ................................................................................................................................... 927
Wrong maintenance cartridge. ............................................................................................................................. 927
Maint. cart. The level is low ................................................................................................................................... 927
No Maintenance Cartridge capacity. .................................................................................................................... 927
Maintenance cartridge full. ................................................................................................................................... 927
Maintenance cartridge problem. .......................................................................................................................... 927

Messages regarding the hard disk 928
Hard disk error. ..................................................................................................................................................... 928
File read error. ....................................................................................................................................................... 928
The mail box is full. ............................................................................................................................................... 928
Mail box full. Now printing without saving data. ................................................................................................... 928
Mail box nearly full. ............................................................................................................................................... 928
Maximum jobs stored. ........................................................................................................................................... 928
Mail box full. Delete unwanted data ...................................................................................................................... 928

Other Messages 930
GARO Wxxxx (x represents a number) ................................................................................................................. 930
ERROR Exxx-xxxx (x represents a letter or number) ............................................................................................ 930
Hardware error. xxxxxxxx-xxxx (x represents a letter or number) ......................................................................... 930
Top cover is open. ................................................................................................................................................. 930
Prepare for parts replacement. ............................................................................................................................. 931
Parts replacement time has passed. .................................................................................................................... 931
Unknown file. ......................................................................................................................................................... 931
Calibration There is a problem with the multi-sensor. ........................................................................................... 931
Multi-sensor error .................................................................................................................................................. 931

Specifications

Specifications 933
Printer Specifications 934

Specifications ........................................................................................................................................................ 934
Print Area .............................................................................................................................................................. 935

17  



A
ppendix

Appendix 937
Safety Precautions 938

Safety Precautions ................................................................................................................................................ 938
Legal Notices ........................................................................................................................................................ 940

Manuals for this printer 942
Manuals for this printer ......................................................................................................................................... 942
About This User Manual ........................................................................................................................................ 942

How to use this manual 944
Searching Topics .................................................................................................................................................. 944
HTML Version of the Manual for Printing ............................................................................................................... 945

Disposal of the product 951
WEEE Directive ..................................................................................................................................................... 951

 18



iPF9400
 
User's Guide

Basic Printing Workflow
 

Printing procedure ............................................................................ 20
Canceling print jobs .......................................................................... 29
Pausing Printing ............................................................................... 33

Enhanced Printing Options 35

Windows Software 171

Mac OS X Software 357

Handling and Use of Paper 521

Control Panel 647

Printer Parts 683

Network Setting 699

Print Job Management 733

Adjustments for Better Print Quality 795

Color Management 813

Maintenance and Consumables 825

Troubleshooting 875

Error Message 907

Specifications 933

Appendix 937

 

  

B
asic Printing W

orkflow

19  



Printing procedurePrinting procedure
Printing Options Using Rolls and Sheets ............................................................................................................. 20
Turning the Printer On and Off ............................................................................................................................. 21
Loading and Printing on Rolls .............................................................................................................................. 22
Loading and Printing on Sheets ........................................................................................................................... 25

Specifying Paper in the Printer Driver (Windows) .................................................................................... 174
Specifying Paper in the Printer Driver (Mac OS X) .................................................................................. 360

Printing in Windows .............................................................................................................................................. 26
Printing from Mac OS X ........................................................................................................................................ 27

Printing Options Using Rolls and SheetsPrinting Options Using Rolls and Sheets
The printer supports both rolls and sheets.
This section introduces the main features of each, as well as the main printing methods available. Select rolls or sheets
to suit your particular printing application.

Note

• For information on the types of paper the printer supports, see "Types of Paper." →P.522

• A variety of other ways to print are available besides those introduced here. For details, see "Enhanced Printing Options."
→P.35

Roll printing
Media in spooled rolls is generally called Roll Media. Rolls are loaded on the Roll Holder, which are in turn loaded in
the printer.
Rolls can be used to print large photos or create posters or banners that cannot be printed on regular sheets.

• Large-format printing
Easily print vertical or horizontal banners from familiar applications such as Microsoft Office applications.
 (See "Printing Vertical or Horizontal Banners (Large-Format Printing).") →P.108

• Borderless printing
Print without a margin (border) around posters or photos.
 (See "Borderless Printing on Paper of Equivalent Size.") →P.95
 (See "Borderless Printing by Resizing Originals to Fit the Roll Width.") →P.101
 (See "Borderless Printing at Actual Size.") →P.89

• Banner printing
You can print multiple pages as a single continuous image, without margins between pages.
 (See "Printing Multiple Pages Continuously.") →P.125

• 90-degree rotation before printing
Originals in portrait orientation are rotated 90 degrees when possible to use paper more efficiently.
 (See "Conserving Roll Paper by Rotating Originals 90 Degrees.") →P.148

• Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
 (See "Resizing Originals to Match the Paper Size.") →P.68
 (See "Resizing Originals to Fit the Roll Width.") →P.72
 (See "Resizing Originals by Entering a Scaling Value.") →P.78

• Free Layout (Windows) and imagePROGRAF Free Layout (Macintosh)
Print multiple documents from multiple applications (such as word-processing programs, spreadsheet programs,
and so on) next to each other.
 (See "Printing Multiple Originals Next to Each Other.") →P.121

Sheet printing
Sheets refer to individual sheets of paper.
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Insert the sheet between the Platen and the Paper Retainer.

• Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
 (See "Resizing Originals to Match the Paper Size.") →P.68
 (See "Resizing Originals by Entering a Scaling Value.") →P.78

• Free Layout (Windows) and imagePROGRAF Free Layout (Macintosh)
Print multiple documents from multiple applications (such as word-processing programs, spreadsheet programs,
and so on) next to each other.
 (See "Printing Multiple Originals Next to Each Other.") →P.121

Turning the Printer On and OffTurning the Printer On and Off

Turning the printer on

1
 

Press the Power button to turn on the printer.
The printer will now start up.
After the Display Screen shows the Canon logo, "Start-
ing up... Please wait." is displayed.

2
 

The Power Lamp is lit when the printer finishes starting
up, and the printer is now in Standby.

The printer will not go into Standby in the following sit-
uations. Take the appropriate action.

• The Top Cover is open
Close the Top Cover.

• The Ink Tank Cover is open
Close the Ink Tank Cover.

• The Printhead is not installed
see "Replacing the Printhead." →P.840

• An Ink Tank is not installed
see "Replacing Ink Tanks." →P.826

• If ERROR is shown on the Display Screen
see "Error Messages." →P.908
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• The Power Lamp and Message Lamp are not lit (even once), and nothing appears on the Display Screen
Make sure the printer is plugged in correctly. Check the connection at the plug and electrical outlet.

• No paper is loaded
Load paper.  (See "Loading and Printing on Rolls.") →P.22  (See "Loading and Printing on Sheets.")
→P.25

Important

• Starting the printer when it is connected via the USB cable to a Macintosh computer that is off may cause the computer to
start up at the same time. To prevent this, disconnect the USB cable before starting the printer. Connecting the printer to the
computer via a USB hub may solve this issue.

Turning the printer off

Important

• Never disconnect the printer's power supply or unplug it during a print job. This may damage the printer.

1
 

Make sure no print jobs are in progress.
If the Message Lamp is flashing, check the message
on the Display Screen and take action as necessary.
 (See "Error Messages.") →P.908

If the Data Lamp is flashing, the printer is receiving a
print job. Turn off the printer only after printing is finish-
ed.

2
 

Hold down the Power button for more than a second.

After "Shut Down.. Please Wait.." is shown on the Dis-
play Screen, the printer shuts off.

Loading and Printing on RollsLoading and Printing on Rolls
These are the basic steps for loading and printing on rolls.
Follow these steps to load and print on rolls.

• For details on using the Output Stacker, see "Using the Output Stacker." →P.564
• For details on using the Media Take-up Unit, see "Media Take-up Unit." →P.570
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Important

• If you are not using the Media Take-up Unit when printing long documents such as banners, spread a clean cloth or
paper on the floor. Use the Output Stacker to prevent long printed documents from being soiled by the floor after they
are printed.  (See "Using the Output Stacker.") →P.564

Note

• For details on supported sizes and types of rolls, see Paper Sizes or the Paper Reference Guide.  (See "Paper Sizes.")
→P.522   (See "Types of Paper.") →P.522

• To wait until the ink dries after printing before cutting the roll, set Drying Time in the printer driver.  (See "Specifying the
Ink Drying Time for Rolls.") →P.544

• Once you have used all the paper on a roll, clean the platen. If the Platen inside the Top Cover becomes dirty, it may soil
the underside of paper.  (See "Cleaning Inside the Top Cover.") →P.861

1
 

Turn the printer on.  (See "Turning the Printer On and
Off.") →P.21

2
 

Load the roll on the Roll Holder.  (See "Attaching the Roll
Holder to Rolls.") →P.530
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3
 

Load the roll in the printer.  (See "Loading Rolls in the
Printer.") →P.533

Important

• When printing without borders, definitely set the blue Switch on the platen to the ● side. If the switch is set incorrect-
ly, print quality may deteriorate.  (See "Setting the Blue Switch on the Platen.") →P.893

4
 

Select the type of paper.  (See "Changing the Type of
Paper.") →P.537
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Note

• If no barcode has been printed on the roll and you have set ManageRemainRoll to On, specify the roll length after
the type of paper.  (See "Specifying the Paper Length.") →P.539

5 Complete settings in the printer driver for the type of paper and other details.

• Specifying Paper in the Printer Driver (Windows) →P.174
• Specifying Paper in the Printer Driver (Mac OS X) →P.360

6 Send the print job.

• Printing in Windows →P.26
• Printing from Mac OS X →P.27

The printer now starts printing the print job.

Loading and Printing on SheetsLoading and Printing on Sheets
These are the basic steps for loading sheets and then printing.
Follow the steps below to load and print on sheets.

Note

• For details on supported types and sizes of paper, see Paper Sizes or the Paper Reference Guide.  (See "Paper Sizes.")
→P.522   (See "Types of Paper.") →P.522

• Borderless printing is not supported on sheets. For the features and the main printing methods available for sheet printing, see
"Printing Options Using Rolls and Sheets." →P.20

1
 

Turn the printer on.  (See "Turning the Printer On and
Off.") →P.21

2 Complete settings in the printer driver for the type of paper and other details.

• Specifying Paper in the Printer Driver (Windows) →P.174
• Specifying Paper in the Printer Driver (Mac OS X) →P.360
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3 Send the print job.

• Printing in Windows →P.26
• Printing from Mac OS X →P.27

4
 

Load the sheet.  (See "Loading Sheets in the Printer.")
→P.555

Start printing.

Printing in WindowsPrinting in Windows
Print from the application menu.

Important

• We recommend exiting unnecessary applications before printing. Running several applications while printing may interrupt
the transfer of print data and affect printing quality.

1 In the source application, select Print from the File menu to display the dialog box for printing conditions.
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2 After confirming that the printer is selected in the dialog box, click Print or OK to start printing.

Note

• The appearance of the dialog box varies depending on the
software application. In most cases, the dialog box includes
basic printing options and enables you to choose the print-
er, specify the range of pages, number of copies, and so
on.
Example: Print dialog box displayed by the application

• If another printer is selected, select the printer you want to use under Select Printer or in the dialog box displayed
after clicking Printer.

 

Settings for many printing methods (including enlarged or reduced printing, borderless printing, and so on) are dis-
played in the printer driver dialog box. There are two ways to access the printer driver dialog box, as follows.

• From the application
 (See "Accessing the Printer Driver Dialog Box from Applications.") →P.179

• From the operating system menu
 (See "Accessing the Printer Driver Dialog Box from the Operating System Menu.") →P.181

Printing from Mac OS XPrinting from Mac OS X
Print from the application menu after registering the printer.

Important

• We recommend exiting unnecessary applications before printing. Running several applications while printing may interrupt
the transfer of print data and affect printing quality.

Registering the printer
Before printing, you must register the printer in imagePROGRAF PrinterSetup.app.
For instructions on registering the printer, see "Configuring the Printer Driver Destination." →P.709

Important

• During this setup process, the printer will not be listed among available printers if it is off or disconnected.

Printing from the application software

1 In the application software, select Print from the File menu to display the dialog box for printing conditions.

Note

• This dialog box includes basic printing options and enables you to choose the printer, specify the range of pages,
number of copies, and so on.
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2
 

Select the printer in the Printer list.

3
 

Click Print to start printing.
As shown in the following illustration, you can switch to
other panes in this dialog box to complete settings for
various methods of printing, including enlarged and re-
duced printing, borderless printing, and so on.
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Canceling print jobsCanceling print jobs
Canceling Print Jobs from the Control Panel ....................................................................................................... 29
Canceling Print Jobs from Windows .................................................................................................................... 30
Canceling Print Jobs from Mac OS X .................................................................................................................. 30

Canceling Print Jobs from the Control PanelCanceling Print Jobs from the Control Panel
To cancel printing or reception of print jobs, press the Stop button on the Control Panel.

When you press the Stop button during printing, printer operation varies depending on the current status.

• If you press the Stop button before printing starts
Pressing the Stop button before printing starts will display a confirmation message. To cancel the print job, select
"Yes".

• If you press the Stop button during printing
Pressing the Stop button during printing will display a confirmation message. To cancel the print job immediately,
select "Yes".
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Canceling Print Jobs from WindowsCanceling Print Jobs from Windows
In the printer window, you can cancel jobs that are being sent to the printer.
Using imagePROGRAF Status Monitor, you can cancel print jobs that have already been received by the printer or that
are currently being printed.

1 Click the printer icon in the taskbar to display the printer window.

Note

• You can also display this window by double-clicking the printer icon in the Printers and Faxes (or Printer) folder,
accessible through the Windows start menu.

2
 

Right-click the job to cancel and select Cancel.

3 If the job to cancel is not shown in the printer window (that is, if the print data has already been received by the
printer), double-click the taskbar icon to display imagePROGRAF Status Monitor.

4
 

On the Printer Status sheet, click Cancel Job.

Note

• The screen may differ slightly depending on the model you are using.

Canceling Print Jobs from Mac OS XCanceling Print Jobs from Mac OS X
In the printer window, you can cancel jobs that are being sent to the printer.
Otherwise, you can cancel jobs from imagePROGRAF Printmonitor if they have been received by the printer or are
currently being printed.

Note

• Print jobs are shown in the printer window while they are being sent from the computer. After transmission, jobs are not dis-
played even during printing.

• Print jobs are displayed in the imagePROGRAF Printmonitor window from the moment the printer starts receiving the print
data until the moment printing is finished. They are not displayed before print data is sent to the printer, even if the computer
has started preparing the print data.
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1 Click the printer icon in the Dock to display the printer window.

2
 

Click Pause Printer to stop printing.

3
 

If there are no jobs in the printer window that can be
canceled, (that is, if the print data has already been
sent to the printer), click Utility to display imagePROG-
RAF Printmonitor.

4
 

Select the print job to cancel and click  to delete
the print job.

Note

• The screen may differ slightly depending on the model you are using.

The job sent to the printer is canceled.
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5 Exit imagePROGRAF Printmonitor. In the printer window, click Resume Printer.

Important

• Always follow these steps if you cancel print jobs from imagePROGRAF Printmonitor. If you do not restart job pro-
cessing, the next job cannot be printed.
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Pausing PrintingPausing Printing
Pausing PrintingPausing Printing

During printing, if you set Pause Print in the Control Panel menu to On, printing is stopped at that point and the printer
enters a state in which printing is paused.  (See "Control Panel Display.") →P.649
Printing from the job queue is not possible in this state.
To restore normal operation after this state, set Pause Print to Off.

Note

• In the following cases, the status is cleared even if you do not set Pause Print to Off, and printing from the job queue re-
sumes.

• When paper is advanced
• When you execute Chg. Paper Type in the Paper Menu

1
 

During printing, on the Tab Selection screen of the Control Panel, press

◀ or ▶ to select the Job tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu is displayed.

3 Press ▲ or ▼ to select Pause Print, and then press the OK button.

4 Press ▲ or ▼ to select On or Off, and then press the OK button.
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Choosing Paper for PrintingChoosing Paper for Printing
Choosing a Paper for Printing .............................................................................................................................. 36

Changing the Type of Paper ......................................................................................................................... 537
Specifying Paper in the Printer Driver .................................................................................................................. 36

Specifying Paper in the Printer Driver (Windows) ......................................................................................... 174
Specifying Paper in the Printer Driver (Mac OS X) ....................................................................................... 360

Choosing a Paper for PrintingChoosing a Paper for Printing
Select the appropriate media type from the printer control panel or printer driver to match the paper loaded in the print-
er. The appropriate media type differs between the case of genuine Canon paper or Canon feed confirmed paper and
the case of paper other than Canon feed confirmed paper. Select the media type by following the description below.
For information on how to select the media type in the printer control panel, see "Changing the Type of Pa-
per" →P.537 , and for information on how to select the media type in the printer driver, "Specifying Paper in the Printer
Driver (Windows)" →P.174  or see "Specifying Paper in the Printer Driver (Mac OS X)." →P.360

Important

• If you use paper other than Canon feed confirmed paper, Canon provides absolutely no guarantees regarding print quality or
paper feed properties.

Note

• Genuine Canon paper and Canon feed confirmed paper are detailed in " Paper Reference Guide".

• An error message is displayed on the printer Control Panel if the media type specified in the printer driver does not match the
media type specified in the printer. Although you can print under these conditions, the printing results may not be suitable.

• Genuine Canon paper or Canon feed confirmed paper
For genuine Canon paper or Canon feed confirmed paper, select the settings that are optimized for that type of
paper. For more information on the settings for genuine Canon paper or Canon feed confirmed paper, see " Paper
Reference Guide."

• Paper other than Canon feed confirmed paper
For paper other than Canon feed confirmed paper, one method is to select from existing settings and another
method is to create a new media type and add it to the printer control panel and printer driver. For details, see
"Using Paper Other Than Genuine Paper and feed confirmed Paper." →P.525

Specifying Paper in the Printer DriverSpecifying Paper in the Printer Driver
If you replace the paper, complete the printer driver settings for the paper type and size.
For instructions on configuring paper settings in the printer driver, refer to the following topics, as appropriate for your
computer and operating system.

• Specifying Paper in the Printer Driver (Windows) →P.174
• Specifying Paper in the Printer Driver (Mac OS X) →P.360
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Printing Photos and Office DocumentsPrinting Photos and Office Documents
Printing Photos and Images ................................................................................................................................. 37

Printing Photos and Images (Windows) .......................................................................................................... 38
Printing Photos and Images (Mac OS X) ........................................................................................................ 39

Printing from Photoshop ....................................................................................................................................... 42
Printing Adobe RGB Images (Windows) ........................................................................................................ 43
Printing Adobe RGB Images (Mac OS X) ....................................................................................................... 46

Printing Office Documents ................................................................................................................................... 48
Printing Office Documents (Windows) ............................................................................................................ 48
Printing Office Documents (Mac OS X) .......................................................................................................... 50

Using PosterArtist to Compose Originals ............................................................................................................ 52

Printing Photos and ImagesPrinting Photos and Images
By selecting the following Print Target from Easy Settings of the printer driver, you can easily configure the printing of
illustrations and photos.

Print Target Description
Photo (Color) Print photographic images from digital cameras with an optimal set-

ting.

Photo (Monochrome) Print monochrome photos with an optimal setting.

Poster An optimal setting for posters. Print in vivid colors with impact and
high saturation.

Faithful Color Reproduction Print with minimum color difference. Suitable for printing scanner im-
ages and when print results are too vivid.

Photo (Adobe RGB) Setting suitable for printing images created using the color space of
Adobe RGB in optimal color.

Important

• Depending on the Media Type setting, some Print Target options may not be available.

Note

• You can check the settings values for each print target by clicking View Settings.

• You can also fine-tune these values as needed. ( Advanced Settings)
For details on Advanced Settings, refer to "Giving Priority to Particular Graphic Elements and Colors for Printing →P.61 ".

For instructions on printing photos and images, refer to the following topics, as appropriate for your computer and oper-
ating system.

• Printing Photos and Images (Windows) →P.38
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• Printing Photos and Images (Mac OS X) →P.39

Printing Photos and Images (Windows)Printing Photos and Images (Windows)
This topic describes how to print photos based on the following example.

• Document: Photo image from a digital camera
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Canon Premium Glossy Paper 2 280
• Roll paper width: 10 inches (254.0 mm)

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Premium Glossy
Paper 2 280.
In the AMedia Type, choose the type of paper used for printing, such as Glossy Paper, Canon Coated Pa-
per, and so on. Make sure the paper you select is loaded in the printer.

Note

• The paper type setting in the printer driver and related software (as well as on the Control Panel) is updated when
you install the Media Configuration Tool from the User Software CD-ROM or if you change paper information by
using the Media Configuration Tool. For details, see Media Configuration Tool →P.582 .

5 After confirming that DEasy Settings is selected, click Photo (Color) in the EPrint Target list.

Note

• You can check the settings values selected in the E Print Target list by clicking G View Settings.
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6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In the APage Size list, click the size of the original as specified in the application. In this case, click 10"x12".

8 Select and click a roll paper in the LPaper Source list.

9 Select the width of the loaded roll in the MRoll Paper Width list—in this case, 10-in. Roll (254.0mm).

10 Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings →P.172 "

11 Confirm the print settings and print as desired.

Note

• For instructions on confirming print settings, see "Confirming Print Settings." →P.176

Printing Photos and Images (Mac OS X)Printing Photos and Images (Mac OS X)
This topic describes how to print photos based on the following example.

• Document: Photo image from a digital camera
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll paper
• Paper type: Canon Premium Glossy Paper 2 280
• Roll paper width: 10 inches (254.0 mm)
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1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 In the FPaper Size list, click the size of the original. In this case, click 10"x12".

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.

5
 

Access the Main pane.
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6 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Premium Glossy
Paper 2 280.
Make sure the paper you select is loaded in the printer.

Note

• The types of paper indicated in the printer driver and related software (as well as on the Control Panel) are updated
when you install the Media Configuration Tool from the User Software CD-ROM or if you change paper information
by using the Media Configuration Tool. For details, see Media Configuration Tool →P.611 .

7 After confirming that DEasy Settings is selected, click Photo (Color) in the EPrint Target list.

Note

• For information on settings optimized for printing photos and images, see "Printing Photos and Images →P.37 "

• You can check the settings values selected in the E Print Target list by clicking G View set..

8 Make your selection in the FPrint Quality list.

9
 

Access the Page Setup pane.

10 Select and click a roll paper in the APaper Source list.

11 Make sure the width of the loaded roll is displayed in the BRoll Width list—in this case, 10 in. (254.0mm).

Note

• If the width of the roll loaded in the printer is not shown in
B Roll Width, click L Printer Information on the Main
pane to update the printer information.
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12
 

Make sure CPage Size on the Page Setup pane
shows the original size as specified in CPaper Size in
the Page Attributes dialog box—in this case, 10"x12".

13 Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings →P.358 "

14 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "

Printing from PhotoshopPrinting from Photoshop
You can print images in the Adobe RGB color space that you have created in Photoshop, the Adobe Systems photo
retouching application. Using the dedicated Photoshop printer driver plug-in (provided with the printer) makes it easy to
print Adobe RGB images more attractively.

• Using the Plug-in to Print
The imagePROGRAF Print Plug-In for Photoshop is a dedicated plug-in provided with the printer that you can load
in Photoshop and customize for your printing needs. By using the plug-in, you can print while preserving the 16-bit
RGB data from Photoshop without losing the exceptional color gradations of original image. Some of the settings
and customizations available in the plug-in are as follows.

• Automatic detection of the color space (sRGB or Adobe RGB) for automatic selection of the optimal profile.
This feature eliminates the need to complete intricate settings when printing Adobe RGB images.

• Advanced gray adjustment, including adjustment of tone curves, in addition to an array of standard adjust-
ments for color balance, brightness, contrast, highlight, and shadow.

• Fine-tune color tones in Photoshop while viewing a preview that accurately reproduces printing results.

• With print log management, you can save and load setting parameters from past print jobs.

Note

• imagePROGRAF Print Plug-In for Photoshop for Windows and Macintosh are provided with the printer.

For instructions and details on which versions of Photoshop are compatible with the imagePROGRAF Print Plug-In
for Photoshop, refer to the following topics, as appropriate for your computer and operating system.

• Print Plug-In (Windows) →P.251
• Print Plug-In (Macintosh) →P.458

• Using the Printer Driver to Print
The printer driver offers the following settings and adjustments.

• Choose the standard sRBG color space or Adobe RGB as desired.
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• Adjust the color balance, brightness, contrast, saturation, and gray levels.

For instructions on using the printer driver to print Adobe RGB images created in Photoshop, refer to the following
topics, as appropriate for your computer and operating system.

• Printing Adobe RGB Images (Windows) →P.43
• Printing Adobe RGB Images (Mac OS X) →P.46

Printing Adobe RGB Images (Windows)Printing Adobe RGB Images (Windows)
This topic describes how to print Adobe RGB images based on the following example.

• Document: Adobe RGB image created in Photoshop
• Page Size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Canon Premium Glossy Paper 2 280
• Roll Paper Width: 10 inches (254.0 mm)

Important

• In Photoshop, select no color-matching.

• In the printer driver settings, select Driver Matching Mode and choose Adobe RGB in Color Space.

1 In Photoshop, create an image in the Adobe RGB color space.

Note

• The following procedures are based on the example of Photoshop CS3/CS4/CS5.

• For instructions on creating Adobe RGB images, refer to the Photoshop documentation.

2 Choose Print with Preview from the File menu to display the Print dialog box.

3 Make sure the setting mode is Color Management.

4 In the Color Handling list in Options, click Printer Manages Colors.

5 Click Print to display the Print dialog box.

6 Select the printer and click Properties to display the printer driver dialog box.

7
 

Make sure the Main sheet is displayed.
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8 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Premium Glossy
Paper 2 280.

9
 

Click DAdvanced Settings to switch the print mode.

10 Click Image in the EPrint Priority list.

11 Select the print quality in the FPrint Quality list.

Note

• Options displayed in the F Print Quality list vary depending on the paper type.

12 Click Color in the GColor Mode list.

13
 

Click HColor Settings to display the Color Settings
dialog box.
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14
 

Click the Matching tab to display the Matching sheet.

15 In AMatching Mode, click Driver Matching Mode.

16 In CColor Space, click Adobe RGB.

17 Click OK to close the Color Settings dialog box.

18
 

Click the Page Setup tab to display the Page Setup
sheet.

19 In the APage Size list, click the size of the original as specified in the source application. In this case, click
10"x12".

20 Select and click a roll paper in the LPaper Source list.

21 Select the width of the loaded roll in the MRoll Paper Width list. In this case, click 10-in. Roll (254.0mm), and
then click OK.
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22 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Printing Adobe RGB Images (Mac OS X)Printing Adobe RGB Images (Mac OS X)
This topic describes how to print Adobe RGB images based on the following example.

• Document: Adobe RGB image created in Photoshop
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Canon Premium Glossy Paper 2 280
• Roll paper width: 10 inches (254.0 mm)

Important

• In Photoshop, select no color-matching.

• In the printer driver settings, select Driver Matching Mode and choose Adobe RGB in Color Space.

1 In Photoshop, create an image in the Adobe RGB color space.

Note

• The following procedures are based on the example of Photoshop CS3/CS4/CS5.

• For instructions on creating Adobe RGB images, refer to the Photoshop documentation.

2 Choose Print with Preview from the Photoshop menu to display the Print dialog box.

3 Make sure the setting mode is Color Management.

4 In the Color Handling list, click Printer Manages Colors.

5 Click Print.

6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Premium Glossy
Paper 2 280.
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8
 

Click DAdvanced Settings to switch the print mode.

9 Click Image in the EPrint Priority list.

10 Select the print quality in the FPrint Quality list.

Note

• Options displayed in the F Print Quality list vary depending on the type of paper.

11 Click Color in the HColor Mode list.

12 Click ISet to display the Color Settings dialog box.

13 Click Matching to display the Matching pane.

14 In Matching Mode, click Driver Matching Mode.

15 In Color Space, click Adobe RGB.

16 Click OK to close the Color Settings dialog box.

17
 

Access the Page Setup pane.
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18 Select and click a roll paper in the APaper Source list.

19 Make sure the width of the loaded roll paper is displayed in the BRoll Width list—here, 10-in. Roll
(254.0mm).

Note

• If the width of the roll loaded in the printer is not shown in
B Roll Width, click L Printer Information on the Main
pane to update the printer information.

 

20 Make sure CPage Size in the Page Setup pane matches the size of the original as specified in Photoshop—
in this case, 10"x12".

21 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings." →P.362

Printing Office DocumentsPrinting Office Documents
By selecting Office Document from Easy Settings of the printer driver, you can easily configure settings for printing
office documents.

Print Target Description
Office Document Setting optimized for printing general office documents such as ma-

terials for distribution so that they can be viewed easily.

Note

• You can check the settings values for each print target by clicking View Settings.

• You can also fine-tune these values as needed. (Advanced Settings)
For details on Advanced Settings, refer to "Giving Priority to Particular Graphic Elements and Colors for Printing →P.61 ".

For instructions on printing office documents, refer to the following topics, as appropriate for your computer and operat-
ing system.

• Printing Office Documents (Windows) →P.48
• Printing Office Documents (Mac OS X) →P.50

Printing Office Documents (Windows)Printing Office Documents (Windows)
This topic describes how to print office documents based on the following example.

• Document: Office document created using word-processing or spreadsheet programs
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
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• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 After confirming that DEasy Settings is selected, click Office Document in the EPrint Target list.

Note

• You can check the settings values selected in the E Print Target list by clicking G View Settings.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO A4.

8 Click Cut Sheet in the LPaper Source list.
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9 Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings →P.172 "

10 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Printing Office Documents (Mac OS X)Printing Office Documents (Mac OS X)
This topic describes how to print office documents based on the following example.

• Document: Office document created using word-processing or spreadsheet programs
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])

 

1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 In the FPaper Size list, click the size of the original. In this case, click ISO A4 - for Paper Tray (Large Mar-
gins).

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.
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5
 

Access the Main pane.

6 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7 After confirming that DEasy Settings is selected, click Office Document in the EPrint Target list.

Note

• You can check the settings values selected in the E Print Target list by clicking G View set..

8 Make your selection in the FPrint Quality list.

9
 

Access the Page Setup pane.

10 Click Cut Sheet in the APaper Source list.
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11
 

Make sure the CPage Size setting matches the origi-
nal size as selected in CPaper Size in the Page At-
tributes dialog box—in this case, ISO A4 - for Paper
Tray (Large Margins).

12 Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings →P.358 "

13 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "

Using PosterArtist to Compose OriginalsUsing PosterArtist to Compose Originals
You can print a variety of source documents from word-processing or spreadsheet programs or screen shots from web
browsers after composing an original with them using PosterArtist.
This topic describes how to use PosterArtist to compose originals from multiple applications, creating a poster layout
for printing.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then open the printer driver dialog box. (See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows).") →P.179

3
 

Make sure the Main sheet is displayed.
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4
 

Click the Layout tab to display the Layout sheet.

5 Select the APage Layout check box.

6 Click in the Edit Using PosterArtist in the APage Layout list.

Note

• This function cannot be used with a 64-bit version OS.

7
 

When you attempt to print, PosterArtist starts up and
the PageCapture window is displayed. (At this point,
the document will not be printed yet.)

8 Choose the page to load in PosterArtist.

9 Edit and rearrange the image in the PosterArtist window as desired.
Without closing the PosterArtist window, repeat steps 1-8 to arrange originals from multiple applications on the
same page.

Note

• For details on how to edit and sort images, refer to the PosterArtist Manual.

10 Print from the PosterArtist menu.
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Adjusting ImagesAdjusting Images
Adjusting the Color in the Printer Driver ............................................................................................................... 54

Fine-Tuning Colors of Photos and Images (Windows) ................................................................................... 56
Fine-Tuning Colors of Photos and Images (Mac OS X) .................................................................................. 58

Giving Priority to Particular Graphic Elements and Colors for Printing ................................................................ 61
Choosing the Document Type and Printing Conditions (Windows) ............................................................... 63
Choosing the Document Type and Printing Conditions (Mac OS X) .............................................................. 65

Adjusting the Color in the Printer DriverAdjusting the Color in the Printer Driver
Color settings specified in the application for your documents are essentially given priority over other settings for each
print job, but further color adjustment is possible in the printer driver.

• Color Mode
Choose how the printer driver processes color, as desired.
The available options vary depending on the color mode.

Color Mode Description Color Adjustment
Color Print in color. You can select the color balance and color

matching functions.

Monochrome (Photo) Grayscale printing optimized for mono-
chrome photos.

You can adjust the color balance in ways tail-
ored to monochrome photos.

Monochrome Print in grayscale. You can adjust the color balance.

No color correction (*1) Prints without performing color-matching in
the printer driver.

You can adjust the color balance.

*1: If No color correction is selected, the Matching sheet / Matching pane is not displayed.

• Color Adjustment
You can adjust colors separately for images, graphics, and text documents.

Adjustment Item Description
Cyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

Magenta
Yellow
Gray Tone Adjust the grayscale, in a range from cool, blue tones to warm, red tones.

Brightness Adjust the brightness of printed images while keeping the darkest and lightest portions intact.

Contrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Saturation Adjust the level of color saturation, in a range from subdued to vivid.

Note

• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the color adjustment
target from Image, Graphics, and Text.

• Matching
You can choose the color-matching mode and method.
By adjusting the color-matching mode and method, you can make printed colors match the colors of on-screen
images more closely.

Important

• If No color correction is selected under Color Mode, the Matching cannot be changed.
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Matching Mode Description Remarks
Driver Matching Mode Enables printing of optimal color tones using

a driver specific color profile.
You should normally select this mode.

ICC Matching Mode Enables color matching using ICC profiles.
Select this if you want to print by specifying
the input profile, printer profile, and match-
ing method in detail.

This allows you to use ICC profiles for digital
cameras and scanners, ICC profiles created
using the profile creation tool, etc.

Host ICM Mode Enables color matching by the host comput-
er using the ICM function of Windows.
Select this if you want to print from an appli-
cation that supports the ICM function.

Available when using Windows.

ColorSync Enables color matching by using the Color-
Sync function of Mac OS.
Select this if you want to perform soft proof-
ing using ColorSync before printing.

Available when using Mac OS.
To select ColorSync, choose ColorSync on
the Color Matching panel.

Matching Method Description Remarks
Auto Color-matching optimized for images,

graphics, or text.
The available options and their display order
vary depending on your selected color-match-
ing mode, as well as the operating system.Perceptual Color-matching optimized for printing typical

photos attractively. Smooth gradation is a
feature. This is also an easy-to-use mode
when performing color adjustment using ap-
plication software.

Colorimetric Color-matching optimized for printing image
data with accurate colors in input color
space. This is the easiest-to-use mode
when you want to adjust the color and print.
However, gradation may be lost for colors of
wider range than the color reproduction
range of the printer. Generally, this is also
called relative colorimetric.

Colorimetric (No Wht-pnt Corr) Color-matching, which uses the same pro-
cessing method as Colorimetric process-
ing, is useful when you want to reproduce
colors down to the color of the paper. Color-
matching is often called "absolute colorimet-
ric."

Saturation Color-matching optimized for printing post-
ers, etc., vividly.

Monitor Matching Suitable for optimized printing to match the
appearance on the monitor.
Color-matching optimized for accurately re-
producing colors on the calibrated sRGB or
AdobeRGB monitor.

For instructions on color adjustment, refer to the following topics, as appropriate for your computer and operating
system.

• Fine-Tuning Colors of Photos and Images (Windows) →P.56
• Fine-Tuning Colors of Photos and Images (Mac OS X) →P.58
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Fine-Tuning Colors of Photos and Images (Windows)Fine-Tuning Colors of Photos and Images (Windows)
You can specify your own print settings instead of using the Print Target presets. This topic describes how to fine-tune
the color tone of photos before printing.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded.

5
 

Click DAdvanced Settings to switch the print mode.

6 Click Color in the GColor Mode list.
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7
 

Click HColor Settings to display the Color Settings
dialog box.

8 On the Color Adjustment sheet, adjust the color tones, brightness, and so on as desired.
Adjustment Item Description

D Cyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

E Magenta

F Yellow

G Gray Tone Adjust the gray tone to suit the images of monochrome photos. Choose cool black (tinged with
blue), pure black (neutral), warm black (tinged with red), and so on. Select the color tone in the
color region or from the list.

H Brightness Adjust the brightness of printed images while keeping the darkest and lightest portions intact.

I Contrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

J Saturation Adjust the level of color saturation, in a range from subdued to vivid.

Note

• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the color adjust-
ment target from Image, Graphics, and Text.

9 Close the Color Settings dialog box.

 

iPF9400                                                                                                                                                        Fine-Tuning Colors of Photos and Images (Windows)

User's Guide                                                                                                                                                                                                                                       

  

Enhanced Printing O
ptions

A
djusting Im

ages

57  



10
 

Click the Page Setup tab to display the Page Setup
sheet.

11 Confirm the settings of APage Size, LPaper Source, and so on.

12 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Fine-Tuning Colors of Photos and Images (Mac OS X)Fine-Tuning Colors of Photos and Images (Mac OS X)
You can specify your own print settings instead of using the Print Target presets. This topic describes how to fine-tune
the color tone of photos before printing.

1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.
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2 Select the printer in the APrinter list.

3 Choose the original size in the FPaper Size list.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.

5
 

Access the Main pane.

6 In the AMedia Type list, select the type of paper that is loaded.

7
 

Click DAdvanced Settings to switch the print mode.

8 Click Color in the HColor Mode list.
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9
 

Click ISet to display the Color Settings dialog box.

10 On the Color Adjustment pane, adjust the color tones, brightness, and so on as desired.
Adjustment Item Description

D Cyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

E Magenta

F Yellow

G Gray Tone Adjust the gray tone to suit the images of monochrome photos. Choose cool black (tinged with
blue), pure black (neutral), warm black (tinged with red), and so on. Select the color tone in the
color region or from the list.

H Brightness Adjust the brightness of printed images while keeping the darkest and lightest portions intact.

I Contrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

J Saturation Adjust the level of color saturation, in a range from subdued to vivid.

Note

• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the color adjust-
ment target from Images, Graphics, and Text.

11 Click OK to close the Color Settings dialog box.
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12
 

Access the Page Setup pane.

13 Confirm the settings of APaper Source and CPage Size.

14 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "

Giving Priority to Particular Graphic Elements and Colors for PrintingGiving Priority to Particular Graphic Elements and Colors for Printing
You can specify detailed print settings as desired for the quality level, colors, and other criteria.

• Print Priority
Choose the graphic elements that you want to emphasize for printing.

Print Priority (*1) Description
Image A setting for posters or other documents made up mainly of photos or images, or for emphasizing

photos or images in printed documents.

Line Drawing/Text Choose this setting for CAD drawings made up mainly of intricate lines, or to enhance the finish-
ing of fine text.
However, the quality may not be sufficient when printing photos or images that require a lot of
color coverage. In this case, choose Image instead.

Office Document Choose this setting for better legibility of documents combining text and graphics, such as docu-
ments and presentation material created with typical office applications.

Proof This is a setting for enhancing the reproduction of text, illustrations, and photos on print proofs.
However, this takes more time than regular printing.

*1: Options suitable for the selected type of paper are listed under Print Priority.

• Print Quality
Choose the print quality.
The printing mode is determined by a combination of the print quality and resolution.

Print Quality (*1) Description Print Priority
Highest A setting for printing at the highest resolution when

quality is most important. Printing takes longer and
consumes more ink than in other modes, but this
mode offers superior printing quality.

Image
Proof
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Print Quality (*1) Description Print Priority
High Choose this setting to print at high resolution when

quality is most important.
Printing takes longer and consumes more ink than in
Standard or Fast modes, but this mode offers excep-
tional printing quality.

Image
Line Drawing/Text
Proof

Standard Choose this setting to print at standard resolution
when quality and speed are both important.
Printing takes less time than in Highest or High
mode.

Image
Line Drawing/Text
Office Document
Proof

Fast Choose this setting to print faster.
Printing in draft mode can help you work more effi-
ciently when checking layouts.

Image
Line Drawing/Text

*1: Options suitable for the selected Print Priority are listed under Print Quality.

• Color Settings
Setting Item Options Description

Color Mode (*1) Color
Monochrome (Photo)
Monochrome
No color correction

Choose whether to print in color or mono-
chrome.
(Refer to "Adjusting the Color in the Printer
Driver →P.54 ")

Color Adjustment (Images) Cyan
Magenta
Yellow
Gray Tone
Brightness
Contrast
Saturation

You can adjust the levels of cyan, magenta,
and yellow as well as the brightness, con-
trast, saturation, and gray tone separately for
images, graphics, and text documents.
If you choose Monochrome in Color Mode
only Brightness and Contrast can be adjus-
ted.

Color Adjustment (Graphics)

Color Adjustment (Text)

Gray Adjustment Color Balance
Brightness
Contrast
Highlight
Shadow

Choose the gray tone color balance ( Cool
Black or Warm Black) and adjust levels of
brightness, contrast, highlight, and shadow as
desired.
These levels can be adjusted when Mono-
chrome (Photo) is selected in Color Mode.

Color-Matching Modes Driver Matching Mode
ICC Matching Mode

Choose the color-matching mode. Other col-
or-matching modes may be provided by the
computer operating system, such as ICM and
ColorSync.

Color-Matching Method (*2) Auto
Perceptual
Saturation
Monitor Matching
Colorimetric
other

Choose the color-matching method. The
available options vary depending on your se-
lection in Color-Matching Mode.

Color Space (*3) sRGB
Adobe RGB

Choose a standard color space ( sRGB) or
an expanded color space ( Adobe RGB).

*1: Options suitable for the selected Print Priority and Media Type are listed under Color Mode.
*2: The order of options displayed varies depending on the operating system.
*3: Adobe RGB is not available if an incompatible combination of the paper type and print quality is selected.

• Enhancing printing quality
Setting Item Description

Thicken Fine Lines Prints making fine lines appear thicker.
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Setting Item Description
Unidirectional Printing Prints by suppressing color variations and misaligned ruled lines. However, this takes more time

than regular printing.

Note

• To print at a higher level of quality, in the printer driver, choose High or Highest in Print Quality, and select the Unidir-
ectional Printing check box.

For instructions on specifying the print quality and color settings before printing, refer to the following topics, as
appropriate for your computer and operating system.

• Choosing the Document Type and Printing Conditions (Windows) →P.63
• Choosing the Document Type and Printing Conditions (Mac OS X) →P.65

Choosing the Document Type and Printing Conditions (Windows)Choosing the Document Type and Printing Conditions (Windows)
You can specify your own print settings instead of using the Print Target presets. This topic describes how print photo-
graphic images in monochrome.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(Refer to "Accessing the Print-
er Driver Dialog Box from Applications →P.179 ")

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded.

 

iPF9400                                                                                                                                    Choosing the Document Type and Printing Conditions (Windows)

User's Guide                                                                                                                                                                                                                                       

  

Enhanced Printing O
ptions

A
djusting Im

ages

63  



5
 

Click DAdvanced Settings to switch the print mode.

6 Click Image in the EPrint Priority list.

7 Click High (600dpi) in the FPrint Quality list.

Note

• Options displayed in the F Print Quality list vary depending on the type of paper.

8 Click Monochrome in the GColor Mode list.

9 To adjust the brightness and contrast, click HColor Settings.

Note

• For instructions on adjusting brightness and contrast, see "Adjusting the Color in the Printer Driver." →P.54

10
 

Click the Page Setup tab to display the Page Setup
sheet.

11 Confirm the settings of APage Size, LPaper Source, and so on.
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12 Confirm the print settings and print as desired.

Note

• For details on how to check the printing settings, refer to "Confirming Print Settings →P.176 ".

Choosing the Document Type and Printing Conditions (Mac OS X)Choosing the Document Type and Printing Conditions (Mac OS X)
You can specify your own print settings instead of using the Print Target presets. This topic describes how print photo-
graphic images in monochrome.

1
 

Choose Page Setup from the application menu to dis-
play the Page Attributes dialog box.

2 Select the printer in the BFormat for list.

3 Choose the original size in the CPaper Size list.

4 Click FOK to close the dialog box.

5 In the application menu, choose Print.

6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded.
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8
 

Click DAdvanced Settings to switch the print mode.

9 Click Image in the EPrint Priority list.

10 Click High (600dpi) in the FPrint Quality list.

Note

• Options displayed in the F Print Quality list vary depending on the paper type.

11 Click Monochrome in the HColor Mode list.

12 To adjust the brightness and contrast, click ISet.

Note

• For instructions on adjusting brightness and contrast, see "Adjusting the Color in the Printer Driver →P.54 "

13
 

Access the Page Setup pane.

14 Confirm the settings of APaper Source and CPage Size.

 

 

Choosing the Document Type and Printing Conditions (Mac OS X)                                                                                                                                   iPF9400

                                                                                                                                                                                                                                       User's Guide

  

Enhanced Printing O
ptions

A
djusting Im

ages

 66



15 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "
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Printing enlargements or reductionsPrinting enlargements or reductions
Resizing Originals to Match the Paper Size ......................................................................................................... 68

Resizing Originals to Match the Paper Size (Windows) ................................................................................. 68
Resizing Originals to Match the Paper Size (Mac OS X) ................................................................................ 70

Resizing Originals to Fit the Roll Width ................................................................................................................ 72
Resizing Originals to Fit the Roll Width (Windows) ......................................................................................... 73
Resizing Originals to Fit the Roll Width (Mac OS X) ....................................................................................... 75

Resizing Originals by Entering a Scaling Value ................................................................................................... 78
Resizing Originals by Entering a Scaling Value (Windows) ........................................................................... 78
Resizing Originals by Entering a Scaling Value (Mac OS X) .......................................................................... 80

Resizing Originals to Match the Paper SizeResizing Originals to Match the Paper Size
You can freely adjust the size of originals by enlarging or reducing them as desired.

• Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.

• Fit Paper Size
Enlarge or reduce the original to match the size of the paper you are using.

For instructions on resizing originals to match the paper size, refer to the following topics, as appropriate for your
computer and operating system.

• Resizing Originals to Match the Paper Size (Windows) →P.68
• Resizing Originals to Match the Paper Size (Mac OS X) →P.70

Note

• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an image-editing
application software such as Adobe Photoshop to specify an image resolution of 150 dpi or more at actual size.

Resizing Originals to Match the Paper Size (Windows)Resizing Originals to Match the Paper Size (Windows)
This topic describes how to enlarge originals before printing to match the paper size, based on the following example.

• Document: Any Type
• Page size: A4 (210.0×297.0mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications →P.179 ")
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Select the printing application in the EPrint Target list.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 Select and click a roll paper in the LPaper Source list.

8 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

9 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO A4.

10 Select the CEnlarged/Reduced Printing check box.

11 Select the DFit Paper Size check box.

12 Click ISO A3 in the GPaper Size list.
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13 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Resizing Originals to Match the Paper Size (Mac OS X)Resizing Originals to Match the Paper Size (Mac OS X)
This topic describes how to enlarge originals before printing to match the paper size, based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

 

1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 In the FPaper Size list, click the size of the original. In this case, click ISO A4.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.
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5
 

Access the Main pane.

6 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7 Make your selection in the EPrint Target list.

8 Make your selection in the FPrint Quality list.

9
 

Access the Page Setup pane.

10 Select and click a roll paper in the APaper Source list.
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11 Make sure the width of the loaded roll is displayed in the BRoll Width list—in this case, ISO A2/A3
(420.0mm).

Note

• If the width of the roll loaded in the printer is not shown in
B Roll Width, click L Printer Information on the Main
pane to update the printer information.

 

12
 

Make sure CPage Size on the Page Setup pane
shows the original size as specified in CPaper Size in
the Page Attributes dialog box—in this case, ISO A4.

13 Select the DEnlarged/Reduced Printing check box.

14 Make sure EFit Paper Size is selected.

15 Click ISO A3 in the IPaper Size list.

16 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "

Resizing Originals to Fit the Roll WidthResizing Originals to Fit the Roll Width
You can freely adjust the size of originals by enlarging or reducing them as desired.

• Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.
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• Fit Roll Paper Width
Enlarge or reduce the original as a whole to match the roll paper width, as desired.

For instructions on resizing originals to match the roll paper width, refer to the following topics, as appropriate for
your computer and operating system.

• Resizing Originals to Fit the Roll Width (Windows) →P.73
• Resizing Originals to Fit the Roll Width (Mac OS X) →P.75

Note

• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an image-editing
application software such as Adobe Photoshop to specify an image resolution of 150 dpi or more at actual size.

Resizing Originals to Fit the Roll Width (Windows)Resizing Originals to Fit the Roll Width (Windows)
This topic describes how to enlarge originals before printing to match the roll width, based on the following example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Select the printing application in the EPrint Target list.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 Select and click a roll paper in the LPaper Source list.

8 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").
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9 Select the CEnlarged/Reduced Printing check box.

Note

• If the C Enlarged/Reduced Printing check box is not dis-
played on the Page Setup sheet, clear the B Borderless
Printing check box.

 

10 Click EFit Roll Paper Width.

Note

• After you click E Fit Roll Paper Width, the Information dialog box is displayed. Select the width of the loaded roll in
the Roll Paper Width list and click OK.

• Make sure the roll paper width you specify matches the width of the loaded roll.

11 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Resizing Originals to Fit the Roll Width (Mac OS X)Resizing Originals to Fit the Roll Width (Mac OS X)
This topic describes how to enlarge originals before printing to match the roll width, based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)
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1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 In the FPaper Size list, click the size of the original. In this case, click ISO A4.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.

5
 

Access the Main pane.

6 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7 Make your selection in the EPrint Target list.

8 Make your selection in the FPrint Quality list.

 

Resizing Originals to Fit the Roll Width (Mac OS X)                                                                                                                                                            iPF9400

                                                                                                                                                                                                                                       User's Guide

  

Enhanced Printing O
ptions

Printing enlargem
ents or reductions

 76



9
 

Access the Page Setup pane.

10 Select and click a roll paper in the APaper Source list.

11 Make sure the width of the loaded roll is displayed in the BRoll Width list—in this case, 16 in. (406.4mm).

Note

• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information on the Main
pane to update the printer information.

12
 

Make sure the CPage Size setting matches the origi-
nal size as selected in CPaper Size in the Page At-
tributes dialog box—in this case, ISO A4.

13 Select the DEnlarged/Reduced Printing check box.

14 Click FFit Roll Paper Width.

15 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "
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Resizing Originals by Entering a Scaling ValueResizing Originals by Entering a Scaling Value
You can freely adjust the size of originals by enlarging or reducing them as desired.

• Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.

• Scaling
Enlarge or reduce originals by a particular amount, as desired.

For instructions on entering a scaling value to resize originals, refer to the following topics, as appropriate for your
computer and operating system.

• Resizing Originals by Entering a Scaling Value (Windows) →P.78
• Resizing Originals by Entering a Scaling Value (Mac OS X) →P.80

Note

• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an image-editing
application software such as Adobe Photoshop to specify an image resolution of 150 dpi or more at actual size.

Resizing Originals by Entering a Scaling Value (Windows)Resizing Originals by Entering a Scaling Value (Windows)
This topic describes how to enlarge originals before printing by entering a scaling value, based on the following exam-
ple.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

Important

• In borderless printing, you cannot resize originals by entering a scaling value.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Select the printing application in the EPrint Target list.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 Select and click a roll paper in the LPaper Source list.

8 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

9 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO A4.

10 Select the CEnlarged/Reduced Printing check box.

11 Click ISO A4 in the GPaper Size list.
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12 Click FScaling and enter 120.

Note

• You can specify enlargement that exceeds the paper size, but in this case, the portions off the bottom and right
edges of the paper will not be printed.

• If the original size after enlargement or reduction is smaller
than the paper size, the original is printed in the upper-left
corner. In this case, you can center originals by selecting
E Print Centered on the Layout sheet.

 

13 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Resizing Originals by Entering a Scaling Value (Mac OS X)Resizing Originals by Entering a Scaling Value (Mac OS X)
This topic describes how to enlarge originals before printing by entering a scaling value, based on the following exam-
ple.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])
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1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 In the FPaper Size list, click the size of the original. In this case, click ISO A4.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.

5
 

Access the Main pane.

6 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7 Make your selection in the EPrint Target list.

8 Make your selection in the FPrint Quality list.
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9
 

Access the Page Setup pane.

10 Select and click a roll paper in the APaper Source list.

11 Make sure the width of the loaded roll is displayed in the BRoll Width list—in this case, ISO A2/A3
(420.0mm).

Note

• If the width of the roll loaded in the printer is not shown in
B Roll Width, click L Printer Information on the Main
pane to update the printer information.

 

12
 

Make sure the CPage Size setting matches the origi-
nal size as selected in CPaper Size in the Page At-
tributes dialog box—in this case, ISO A4.

13 Select the DEnlarged/Reduced Printing check box.
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14 Click GScaling and enter 120.

Note

• You can specify enlargement that exceeds the paper size, but in this case, the portion off the edge of the paper will
not be printed.

• If the original size after enlargement or reduction is smaller than the paper size, the original is printed in the upper-
left corner. In this case, you can center originals by selecting the J Print Centered check box.

15 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "

iPF9400                                                                                                                                               Resizing Originals by Entering a Scaling Value (Mac OS X)

User's Guide                                                                                                                                                                                                                                       

  

Enhanced Printing O
ptions

Printing enlargem
ents or reductions

83  



Printing at full sizePrinting at full size
Printing on Oversize Paper .................................................................................................................................. 84

Printing at Full Size (Windows) ....................................................................................................................... 85
Printing at Full Size (Mac OS X) ...................................................................................................................... 86

Borderless Printing at Actual Size ........................................................................................................................ 89
Borderless Printing at Actual Size (Windows) ................................................................................................ 90
Borderless Printing at Actual Size (Mac OS X) ............................................................................................... 92

Printing on Oversize PaperPrinting on Oversize Paper
You can print all areas of the original at full scale by selecting the paper size from Oversize (sizes where the margins
needed for printer operation have been added to the page size).
We recommend when printing with a focus on image.

Note

• If you prepare an original for printing without a margin and print it on paper of regular size, the image near the edge will not be
printed.

• Oversize
When printing on standard paper sizes, printing is performed by taking the margins necessary for printer opera-
tions inside the region of the original. (See "Print Area.") →P.935  For example, printing the A4 size (210 x 297
mm) original shown in Figure (b) gives the result as shown in Figure (a).
However, if Oversize paper is selected, printing is performed by taking the margins necessary for printer opera-
tions outside of the region of the original to give the result as shown in Figure (c).
The A4 size print as shown in Figure (b) can then be obtained by trimming the margins from the periphery after
printing.

Important

• When printing on Oversize paper, load paper larger than the page size—a size that includes the margin required by the
printer.

• Sheets: Load paper that is at least 10 mm (0.39 in) wider and 28 mm (1.10 in) higher than the page size

• Rolls:Load paper that is at least 10 mm (0.39 in) wider and 10 mm (0.39 in) higher than the page size

Note

• Paper larger than the maximum size supported by the printer cannot be used as paper for oversized printing.  (See
"Paper Sizes.") →P.522

• Oversized printing (selecting Oversize in Page Size) is only available in Windows.

• To perform oversized printing on a Macintosh computer, you must specify a non-standard page size and print on it.

• To specify a non-standard paper size in oversized printing, register the paper size as a Custom Paper Size. Oversized
printing is not available with Custom Size.  (See "Printing on Non-Standard Paper Sizes.") →P.116
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For instructions on oversized printing, refer to the following topics, as appropriate for your computer and operating
system.

• Printing at Full Size (Windows) →P.85
• Printing at Full Size (Mac OS X) →P.86

Printing at Full Size (Windows)Printing at Full Size (Windows)
This topic describes how to print at full size based on the following example. (Oversized Printing)

• Document: Any Type
• Page Size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.
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5
 

Click the Page Setup tab to display the Page Setup
sheet.

6 Click OSize Options to display the Paper Size Options dialog box.

7 In the Paper Size Options dialog box, select the Oversize check box in Display Series.

8 Click OK to close the Paper Size Options dialog box.

9 Click Oversize - ISO A4 in the APage Size list.

10 Select and click a roll paper in the LPaper Source list.

11 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

12 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Printing at Full Size (Mac OS X)Printing at Full Size (Mac OS X)
This topic describes how to print at full size based on the following example. (Oversized Printing)

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])
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1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 In FPaper Size, click the size of the original. In this case, click ISO A4 - Oversize.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.

5
 

Access the Main pane.

6 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7 Make your selection in the EPrint Target list.

8 Make your selection in the FPrint Quality list.
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9
 

Access the Page Setup pane.

10 Select and click a roll paper in the APaper Source list.

11 Make sure the width of the loaded roll is displayed in the BRoll Width list—in this case, ISO A2/A3
(420.0mm).

Note

• If the width of the roll loaded in the printer is not shown in
B Roll Width, click L Printer Information on the Main
pane to update the printer information.

 

12
 

Make sure CPage Size shows the original size as
specified in CPaper Size in the Page Attributes dia-
log box—in this case, ISO A4 - Oversize.
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13 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "

Borderless Printing at Actual SizeBorderless Printing at Actual Size
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images) with-
out a surrounding margin, or border.
Borderless printing is only available with rolls.

• Borderless Printing
In regular printing, a margin required by the printer is added around the original. With borderless printing, you can
print documents without the margin, so that the printed image covers the entire surface of the paper.
Paper incompatible with the printer's auto cut function can be printed without borders on the left and right sides
only.
Printing without borders on the left and right sides only is available when CutDustReduct. is set to On.

Important

• When printing without borders, be certain to set the blue switch on the platen to the ● side. If the switch is set incorrect-
ly, print quality may deteriorate.  (See "Setting the Blue Switch on the Platen.") →P.893

• There are limits on the media type and roll paper width of paper that can be used for borderless printing. For information
on the media types that can be used for borderless printing, see " Paper Reference Guide."

• Borderless printing is not possible if details such as crop marks and margins are included as data on the periphery of
the original.

• These features cannot be used in combination with borderless printing: special page layouts, centering originals, and
printing cut lines on rolls.

• If Fit Paper Size or Print Image with Actual Size (Windows only) is selected while performing borderless printing,
Rotate Page 90 degrees (Conserve Paper) cannot be selected. Note that if borderless printing is possible, then even
if the original is rotated 90 degrees, it will be printed by automatically rotating the page by 90 degrees.

• Borderless Printing Method
Choose the method of borderless printing that suits the original, as desired.

• Print Image with Actual Size
Prints originals at actual size, without enlarging or reducing them. We recommend when focusing on image quality.
You should create the original at a size larger by 3 mm on each side than the paper size.
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Note

• Not all page sizes are available.

• When performing borderless printing without using Print Image with Actual Size, the image deteriorates slightly be-
cause the image is automatically enlarged.

For instructions on borderless printing of photos and images at actual size, refer to the following topics, as appro-
priate for your computer and operating system.

• Borderless Printing at Actual Size (Windows) →P.90
• Borderless Printing at Actual Size (Mac OS X) →P.92

Borderless Printing at Actual Size (Windows)Borderless Printing at Actual Size (Windows)
This topic describes how to print borderlessly at actual size based on the following example.

Important

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be uneven at the edges.
If you require higher image quality, select No from the Automatic Cutting list in the Roll Paper Options dialog box. In this
case, the paper can be printed without borders on the left and right sides only. Once printed and cut, please cut the upper
and lower bands with scissors.

• Document: Any type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Canon Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1 Create the original in the source application 3 mm (0.12 in) larger on each side than 254.0×304.8 mm (10 × 12
in) —that is, 260.0×310.8 mm (10.2 × 12.2 in)

Note

• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on specifying the mar-
gin, refer to the software documentation.

• The extra 3 mm (0.12 in) on each side will not be printed. Create the original so that it fits inside the paper area to be
printed on.

2 Choose Print in the application menu.

3 Select the printer in the dialog box, and then display the printer driver dialog box. (See "Accessing the Printer
Driver Dialog Box from Applications.") →P.179

4
 

Make sure the Main sheet is displayed.
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5 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Heavyweight Coat-
ed Paper.

6 Select the print target in the EPrint Target list.

Important

• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit touches
printing surfaces that are not dry yet, it may damage the paper or the edge of the document that is cut, depending
on frequency of use. In this kind of situation, change the ink drying time using the following procedure.

• Click Advanced Settings in Media Type.

• Select an ink drying time in the list for the Between Pages setting of Drying Time.

7
 

Click the Page Setup tab to display the Page Setup
sheet.

8 In the APage Size list, click the size of the original as specified in the source application. In this case, click
10"x12".

9 Select and click a roll paper in the LPaper Source list.

10
 

Select the BBorderless Printing check box to display
the Information dialog box.
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11 Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).

12 Click OK to close the Information dialog box.

13 In CBorderless Printing Method, click FPrint Image with Actual Size.

14 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings." →P.176

Borderless Printing at Actual Size (Mac OS X)Borderless Printing at Actual Size (Mac OS X)
This topic describes how to print borderlessly at actual size based on the following example.

Important

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be uneven at the edges.
If you require higher image quality, select No from the Automatic Cutting list in the Paper Detailed Settings dialog box. In
this case, the paper can be printed without borders on the left and right sides only. Once printed and cut, please cut the
upper and lower bands with scissors.

• Document: Any type
• Page size: 10 × 12 inches (254.0×304.8 mm)–Borderless
• Paper: Roll
• Paper type: Canon Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1
 

Choose Page Setup from the application menu to dis-
play the Page Attributes dialog box.

2 Select the printer in the BFormat for list.

3 In the CPaper Size list, choose a paper size supported for borderless printing. Here, click 10"x12" - Border-
less.

Note

• Paper sizes supported for borderless printing are indicated by -Borderless.

4 Click FOK to close the dialog box.

5 In the application, create an original that takes up the entire space of the paper size.
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6 Choose Print in the application menu.

7
 

Access the Main pane.

8 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Heavyweight Coat-
ed Paper.

9 Select the print target in the EPrint Target list.

Important

• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit touches
printing surfaces that are not dry yet, it may damage the paper or the edge of the document that is cut, depending
on frequency of use. In this kind of situation, change the ink drying time in Between Pages in the Paper Detailed
Settings dialog box.

10
 

Access the Page Setup pane.

11 Select and click a roll paper in the APaper Source list.
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12 Confirm that the roll paper width matches the paper size.
Make sure the width of the loaded roll is displayed in the BRoll Width list—in this case, 10 in. (254.0mm).

Note

• If the width of the loaded roll is not displayed in B Roll
Width, click L Printer Information on the Main pane and
update the printer information.

 

13
 

Make sure the CPage Size setting matches the origi-
nal size as selected in CPaper Size in the Page At-
tributes dialog box—in this case, 10"x12" - Border-
less.

14 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "
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Borderless Printing on Paper of Equivalent SizeBorderless Printing on Paper of Equivalent Size
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images) with-
out a surrounding margin, or border.
Borderless printing is only available with rolls.

• Borderless Printing
In regular printing, a margin required by the printer is added around the original. With borderless printing, you can
print documents without the margin, so that the printed image covers the entire surface of the paper.
Paper incompatible with the printer's auto cut function can be printed without borders on the left and right sides
only.
Printing without borders on the left and right sides only is available when CutDustReduct. is set to On.

Important

• When printing without borders, be certain to set the blue switch on the platen to the ● side. If the switch is set incorrect-
ly, print quality may deteriorate.  (See "Setting the Blue Switch on the Platen.") →P.893

• There are limits on the media type and roll paper width of paper that can be used for borderless printing. For information
on the media types that can be used for borderless printing, see " Paper Reference Guide."

• Borderless printing is not possible if details such as crop marks and margins are included as data on the periphery of
the original.

• These features cannot be used in combination with borderless printing: special page layouts, centering originals, and
printing cut lines on rolls.

• If Fit Paper Size or Print Image with Actual Size (Windows only) is selected while performing borderless printing,
Rotate Page 90 degrees (Conserve Paper) cannot be selected. Note that if borderless printing is possible, then even
if the original is rotated 90 degrees, it will be printed by automatically rotating the page by 90 degrees.

• Borderless Printing Method
Choose the method of borderless printing that suits the original, as desired.
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• Fit Paper Size
Enlarge or reduce the original to match the size of the paper you are using.

Note

• The printer driver automatically enlarges originals 3 mm (0.12 in) past the dimensions of the paper on each side. The 3
mm portion beyond the edge on each side is not printed.

For instructions on borderless printing of photos, images, and other documents to match the paper size, refer to
the following topics, as appropriate for your computer and operating system.

• Borderless Printing by Resizing Originals to Match the Paper Size (Windows) →P.96

• Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X) →P.98

Borderless Printing by Resizing Originals to Match the Paper Size (Windows)Borderless Printing by Resizing Originals to Match the Paper Size (Windows)
This topic describes how to enlarge originals before borderless printing to match the paper size, based on the following
example.

Important

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be uneven at the edges.
If you require higher image quality, select No from the Automatic Cutting list in the Roll Paper Options dialog box. In this
case, the paper can be printed without borders on the left and right sides only. Once printed and cut, please cut the upper
and lower bands with scissors.

• Document: Any type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Canon Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1 In the application, create an original that takes up the entire space of the paper size.

Note

• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on specifying the mar-
gin, refer to the software documentation.

2 Choose Print in the application menu.

3 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the Printer
Driver Dialog Box from Applications.") →P.179
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4
 

Make sure the Main sheet is displayed.

5 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Heavyweight Coat-
ed Paper.

6 Select the print target in the EPrint Target list.

Important

• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit touches
printing surfaces that are not dry yet, it may damage the paper or the edge of the document that is cut, depending
on frequency of use. In this kind of situation, change the ink drying time using the following procedure.

• Click Advanced Settings in Media Type.

• Select an ink drying time in the list for the Between Pages setting of Drying Time.

7
 

Click the Page Setup tab to display the Page Setup
sheet.

8 In the APage Size list, click the size of the original as specified in the application. In this case, click 10"x12".

9 Select and click a roll paper in the LPaper Source list.
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10
 

Select the BBorderless Printing check box to display
the Information dialog box.

11 Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).

12 Click OK to close the Information dialog box.

13 In CBorderless Printing Method, click DFit Paper Size.

14 Click Match Page Size in the GPaper Size list.

15 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings." →P.176

Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X)Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X)
This topic describes how to enlarge originals before borderless printing to match the paper size, based on the following
example.

Important

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be uneven at the edges.
If you require higher image quality, select No from the Automatic Cutting list in the Paper Detailed Settings dialog box. In
this case, the paper can be printed without borders on the left and right sides only. Once printed and cut, please cut the
upper and lower bands with scissors.

• Document: Any type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Canon Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)
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1
 

Choose Page Setup from the application menu to dis-
play the Page Attributes dialog box.

2 Select the printer in the BFormat for list.

3 In the CPaper Size list, click the size of the original. In this case, click 10"x12".

Note

• All sizes are available in borderless printing if you resize originals to match the paper size.

4 Click FOK to close the dialog box.

5 In the application, create an original that takes up the entire space of the paper size.

6 Choose Print in the application menu.

7
 

Access the Main pane.

8 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Heavyweight Coat-
ed Paper.
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9 Select the print target in the EPrint Target list.

Important

• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit touches
printing surfaces that are not dry yet, it may damage the paper or the edge of the document that is cut, depending
on frequency of use. In this kind of situation, change the ink drying time in Between Pages in the Paper Detailed
Settings dialog box.

10
 

Access the Page Setup pane.

11 Select and click a roll paper in the APaper Source list.

12 Make sure the width of the loaded roll is displayed in the BRoll Width list—in this case, 10 in. (254.0mm).

Note

• If the width of the loaded roll is not displayed in B Roll
Width, click L Printer Information on the Main pane and
update the printer information.
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13
 

Make sure the CPage Size setting matches the origi-
nal size as selected in CPaper Size in the Page At-
tributes dialog box—in this case, 10"x12".

14 Select the DEnlarged/Reduced Printing check box.

15 Select the HBorderless Printing check box.

16 Click EFit Paper Size under DEnlarged/Reduced Printing.

17 In IPaper Size, click the paper size. In this case, click 10"x12" - Borderless.

18 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "

Borderless Printing by Resizing Originals to Fit the Roll WidthBorderless Printing by Resizing Originals to Fit the Roll Width
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images) with-
out a surrounding margin, or border.
Borderless printing is only available with rolls.

• Borderless Printing
In regular printing, a margin required by the printer is added around the original. With borderless printing, you can
print documents without the margin, so that the printed image covers the entire surface of the paper.
Paper incompatible with the printer's auto cut function can be printed without borders on the left and right sides
only.
Printing without borders on the left and right sides only is available when CutDustReduct. is set to On.

Important

• When printing without borders, be certain to set the blue switch on the platen to the ● side. If the switch is set incorrect-
ly, print quality may deteriorate.  (See "Setting the Blue Switch on the Platen.") →P.893

• There are limits on the media type and roll paper width of paper that can be used for borderless printing. For information
on the media types that can be used for borderless printing, see " Paper Reference Guide."

• Borderless printing is not possible if details such as crop marks and margins are included as data on the periphery of
the original.

• These features cannot be used in combination with borderless printing: special page layouts, centering originals, and
printing cut lines on rolls.

• If Fit Paper Size or Print Image with Actual Size (Windows only) is selected while performing borderless printing,
Rotate Page 90 degrees (Conserve Paper) cannot be selected. Note that if borderless printing is possible, then even
if the original is rotated 90 degrees, it will be printed by automatically rotating the page by 90 degrees.
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• Borderless Printing Method
Choose the method of borderless printing that suits the original, as desired.

• Scale to fit Roll Paper Width
Enlarge or reduce the original as a whole to match the roll paper width.

Note

• You can combine this function with rotating pages 90 degrees before printing so that the original width (relative to portrait
orientation) matches the roll paper width in borderless printing.

For instructions on borderless printing of photos, images, and other documents to match the roll paper width, refer
to the following topics, as appropriate for your computer and operating system.

• Borderless Printing by Resizing Originals to Fit the Roll Width (Windows) →P.102

• Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X) →P.104

Borderless Printing by Resizing Originals to Fit the Roll Width (Windows)Borderless Printing by Resizing Originals to Fit the Roll Width (Windows)
This topic describes how to enlarge originals before borderless printing to match the roll width, based on the following
example.

Important

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be uneven at the edges.
If you require higher image quality, select No from the Automatic Cutting list in the Roll Paper Options dialog box. In this
case, the paper can be printed without borders on the left and right sides only. Once printed and cut, please cut the upper
and lower bands with scissors.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Canon Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1 In the application, create an original that takes up the entire space of the paper size.

Note

• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on specifying the mar-
gin, refer to the software documentation.

2 Choose Print in the application menu.

3 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the Printer
Driver Dialog Box from Applications.") →P.179
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4
 

Make sure the Main sheet is displayed.

5 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Heavyweight Coat-
ed Paper.

6 Select the print target in the EPrint Target list.

Important

• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit touches
printing surfaces that are not dry yet, it may damage the paper or the edge of the document that is cut, depending
on frequency of use. In this kind of situation, change the ink drying time using the following procedure.

• Click Advanced Settings in Media Type.

• Select an ink drying time in the list for the Between Pages setting of Drying Time.

7
 

Click the Page Setup tab to display the Page Setup
sheet.

8 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO A4.

9 Select and click a roll paper in the LPaper Source list.
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10
 

Select the BBorderless Printing check box to display
the Information dialog box.

11 Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).

12 Click OK to close the Information dialog box.

13 In CBorderless Printing Method, make sure EScale to fit Roll Paper Width is selected.

14 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings." →P.176

Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X)Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X)
This topic describes how to enlarge originals before borderless printing to match the roll width, based on the following
example.

Important

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be uneven at the edges.
If you require higher image quality, select No from the Automatic Cutting list in the Paper Detailed Settings dialog box. In
this case, the paper can be printed without borders on the left and right sides only. Once printed and cut, please cut the
upper and lower bands with scissors.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Canon Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

 

Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X)                                                                                                                       iPF9400

                                                                                                                                                                                                                                       User's Guide

  

Enhanced Printing O
ptions

B
orderless Printing

 104



1
 

Choose Page Setup from the application menu to dis-
play the Page Attributes dialog box.

2 Select the printer in the BFormat for list.

3 In CPaper Size, click the size of the original. In this case, click ISO A4.

Note

• All sizes are available in borderless printing if you resize originals to fit the roll width.

4 Click FOK to close the dialog box.

5 In the application, create an original that takes up the entire space of the paper size.

6 Choose Print in the application menu.

7
 

Access the Main pane.

8 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Heavyweight Coat-
ed Paper.
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9 Select the print target in the EPrint Target list.

Important

• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit touches
printing surfaces that are not dry yet, it may damage the paper or the edge of the document that is cut, depending
on frequency of use. In this kind of situation, change the ink drying time in Between Pages in the Paper Detailed
Settings dialog box.

10
 

Access the Page Setup pane.

11 Select and click a roll paper in the APaper Source list.

12 Make sure the width of the loaded roll is displayed in the BRoll Width list—here, 10 in. (254.0mm).

Note

• If the width of the loaded roll is not displayed in B Roll
Width, click L Printer Information on the Main pane and
update the printer information.
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13
 

Make sure the CPage Size setting matches the origi-
nal size as selected in CPaper Size in the Page At-
tributes dialog box—in this case, ISO A4.

14 Select the DEnlarged/Reduced Printing check box.

15 Select the HBorderless Printing check box.
This ensures that FFit Roll Paper Width is automatically selected in DEnlarged/Reduced Printing.

16 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "
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Printing banners or at other non-standard sizesPrinting banners or at other non-standard sizes
Printing Vertical or Horizontal Banners (Large-Format Printing) ........................................................................ 108

Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) .................................................. 109
Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X) ................................................. 113

Printing on Non-Standard Paper Sizes .............................................................................................................. 116
Printing on Non-Standard Paper Sizes (Windows) ....................................................................................... 116
Printing on Non-Standard Paper Sizes (Mac OS X) ...................................................................................... 118

Printing Vertical or Horizontal Banners (Large-Format Printing)Printing Vertical or Horizontal Banners (Large-Format Printing)
On this printer, large-format printing of up to 18.0 m is available using rolls.
If you use Print Plug-In for Office or PosterArtist, you can easily print maximum 18.0 m vertical or horizontal banners.
(Refer to "Print Plug-In for Office features (Windows) →P.316 " and "Using PosterArtist to Compose Originals →P.52 ".)
However, you may not be able to print 18.0 m due to restrictions in the settable document size according to the appli-
cation software.

Fit Roll Paper Width
To match the width of vertical and horizontal banners with the width of rolls, use the printer driver function for automati-
cally enlarging/reducing and printing.
For example, if you automatically enlarge a document created with application software such as Microsoft Word, you
can print the full width of the roll easily.

For instructions on printing vertical or horizontal banners, refer to the following topics, as appropriate for your computer
and operating system.

• Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) →P.109
• Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X) →P.113

Important

• Before printing, check how much of the roll paper is left. If you have activated automatic detection of the remaining roll paper,
a warning message is displayed when there is not enough roll paper left.

• If not much ink is left, prepare replacement ink tanks.

• To print at a higher level of quality, in the printer driver, choose High or Highest in Print Quality, and choose Unidirectional
Printing as the direction of printing.
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Printing Vertical or Horizontal Banners (Large-Format Printing; Windows)Printing Vertical or Horizontal Banners (Large-Format Printing; Windows)
By automatic enlargement of a document created with an application software by the printer driver, you can print maxi-
mum 18.0 m vertical or horizontal banners.
However, you may not be able to print 18.0 m due to restrictions in the settable document size according to the appli-
cation software.
This topic describes how to print a banner about five times as long as the roll width based on the following example.

• Document: A horizontal banner created in Microsoft Word
• Page size: Non-standard (100×500 mm [3.9×19.7 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 in (406.4 mm)

The print procedure is as follows.

1. Register a Custom Paper Size in the printer driver.
Call a non-standard paper size registered in the printer driver with Custom Paper Size.
Once you register Custom Paper Size, you then can select it repeatedly from the paper size list.
Custom Paper Size can be set up to 18.0 m.

2. In the application, create an original in the size you registered.

3. Print the banner, using the settings that correspond to banners.

Registering a Custom Paper Size
This example describes how to register a paper size that is horizontally elongated and suitable for banners in either
horizontal or vertical format.

1 Display the printer driver dialog box.(See "Accessing the Printer Driver Dialog Box from the Operating System
Menu →P.181 ")

2
 

Click the Page Setup tab to display the Page Setup
sheet.

3 Select and click a roll paper in the LPaper Source list.

4 Click OSize Options to display the Paper Size Options dialog box.

5 Enter a desired paper name in Custom Paper Size Name. My Horizontal Banner is used in this example.

6 In Units, click mm.
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7 Under Paper Size, enter 100 in Width and 500 in Height.

8 Click Add to add the paper size of My Horizontal Banner.

9 Click OK to close the Paper Size Options dialog box.

10 Close the printer driver dialog box.

Note

• Although you can even set Custom Size for the paper size, the maximum settable size is 3.2 m. The setting of Custom Size
is disabled when you exit the application software.
For more information, see "Printing on Non-Standard Paper Sizes →P.116 "

Creating the banner in the application
Follow the steps below to create the banner in Microsoft Word using the Custom Paper Size you registered.

1 Start Microsoft Word.

2 Choose Page Setup from the File menu to display the Page Setup dialog box.

3 Under Paper Size, click the Custom Paper Size you registered—My Horizontal Banner in this example.

Important

• If My Horizontal Banner is not listed, make sure this printer is selected as the printer to use.

• In applications such as Microsoft PowerPoint that do not enable you to choose registered paper sizes, use the cus-
tom paper size setting in Custom and specify 100×500 mm (3.9×19.7 in)

4 Set the printing orientation to horizontal.

5 Create the banner.

Printing the banner
Follow these steps to print the banner using the corresponding banner settings.

1 Choose Print in the Microsoft Word menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 After confirming that DEasy Settings is selected, click Poster in the EPrint Target list.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In the APage Size list, click the size you registered, My Horizontal Banner.
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8 Select the CEnlarged/Reduced Printing check box.

Note

• If the C Enlarged/Reduced Printing check box is not dis-
played on the Page Setup sheet, clear the B Borderless
Printing check box.

 

9 Select and click a roll paper in the LPaper Source list.

10 After you click EFit Roll Paper Width, the Information dialog box is displayed.

11 Select the width of the loaded roll in the Roll Paper Width list. In this case, click 16-in. Roll (406.4mm), and
then click OK.

12 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

If printing is unsuccessful, you may be able to print after completing the following setting.

1
 

On the Layout sheet, click JSpecial Settings to dis-
play the Special Settings dialog box.
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2
 

In the FineZoom Settings list, click Yes.

Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X)Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X)
By automatic enlargement of a document created with an application software by the printer driver, you can print maxi-
mum 18.0 m vertical or horizontal banners.
This topic describes how to print a banner about five times as long as the roll width based on the following example.

• Document: An original designed for a horizontal banner
• Page Size: Non-standard (100×500 mm [3.9×19.7 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)

The print procedure is as follows.

1. In the application, create an original in the format of a horizontal or vertical banner.

2. In Page Setup, register Custom Page Sizes (Mac OS X v10.5) / Custom Paper Sizes (Mac OS X v10.6 or later).
Once you register Custom Page Sizes / Custom Paper Sizes, you then can select it repeatedly from the paper
size list.
Custom Page Sizes / Custom Paper Sizes can be set up to 18.0 m.

3. Print the banner, using the settings that correspond to banners.

Note

• The following procedures are based on Mac OS X v10.5. The method of setting up non-standard paper sizes varies depend-
ing on the version of Mac OS X.

Register a Custom Page Sizes
This example describes how to register and print using a page size that is horizontally elongated and suitable for ban-
ners in either horizontal or vertical format.

1 Create the document in the application.

2
 

Choose Print in the application menu.
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3 Select the printer in the APrinter list.

4
 

Click Manage Custom Sizes in the FPaper Size list to
display the Custom Page Sizes dialog box.

5 Double-click Untitled in the list at left, and then enter a name for the page size you want to register. Here, en-
ter 100*500.
If the Untitled size is not listed at left, click + below the list.

6 Under Page Size, enter 10 in Width and 50 in Height. Here, measurements are entered in centimeters.

7 Specify the margins by entering 0.3 in Printer Margins. Here, too, measurements are entered in centimeters.

8 Click OK to close the Custom Page Sizes dialog box.

9 In the FPaper Size list, click the size of the original. In this case, click 100*500, the size you registered.

10 In GOrientation, click the icon of the document in landscape orientation.

11 Click OK to close the dialog box.

Print the banner
Follow the steps below to print the banner using the corresponding banner settings.

1 Choose Print in the application menu.
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2
 

Access the Main pane.

3 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

4 Make your selection in the EPrint Target list.

5 Make your selection in the FPrint Quality list.

6
 

Access the Page Setup pane.

7 Select and click a roll paper in the APaper Source list.
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8 Make sure the width of the loaded roll is displayed in the BRoll Width list—in this case, 16 in. (406.4mm).

Note

• If the width of the loaded roll is not displayed in B Roll
Width, click L Printer Information on the Main pane and
update the printer information.

 

9 In CPage Size, make sure 100*500 is displayed, as registered in Page Setup.

10 Select the DEnlarged/Reduced Printing check box.

11 Click FFit Roll Paper Width.

12 Confirm the print settings, and click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "

Printing on Non-Standard Paper SizesPrinting on Non-Standard Paper Sizes
For printing on non-standard size paper, first register the paper size in the printer driver.
Once you register a paper size, you then can select it repeatedly from the paper size list. The paper size can be set up
to 18.0 m.

Note

• In Windows, although you can even set Custom Size for the paper size, the maximum settable size is 3.2 m. The setting of
Custom Size is disabled when you exit the application software.

For instructions on specifying non-standard paper sizes for printing, refer to the following topics, as appropriate for your
computer and operating system.

• Printing on Non-Standard Paper Sizes (Windows) →P.116
• Printing on Non-Standard Paper Sizes (Mac OS X) →P.118

Printing on Non-Standard Paper Sizes (Windows)Printing on Non-Standard Paper Sizes (Windows)
For printing on non-standard size paper, first register the paper size in the printer driver.
Call a non-standard paper size registered in the printer driver with Custom Paper Size.
Once you register Custom Paper Size, you then can select it repeatedly from the paper size list.
Custom Paper Size can be set up to 18.0 m.

Note

• Although you also can set Custom Size for the paper size temporarily, the maximum settable size is 3.2 m. Also, the setting
of Custom Size is disabled when you exit the application software.
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Registering and Printing With a Custom Paper Size
This topic describes how to register a non-standard paper size by the name of 430 mm Squareand print based on the
following example.

• Document: Any Type
• Page Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])
• Paper: Sheets
• Media Type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])

1 Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.

2 Choose Print in the application menu.

3 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")

4
 

Make sure the Main sheet is displayed.

5 In the AMedia Type list, select the type of paper that is loaded.

6 After confirming that DEasy Settings is selected, select from the EPrint Target list.
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7
 

Click the Page Setup tab to display the Page Setup
sheet.

8 Click OSize Options to display the Paper Size Options dialog box.

9 Enter a desired paper name in Custom Paper Size Name. 430 mm Square is used in this example.

10 Select mm in Units.

11 Enter 430 (16.9 in) in both Width and Height.

Note

• If you select the Fix the Ratio of the Width to Height check box, after you enter a value in either Width or Height,
the other value will be automatically applied based on the original aspect ratio.

12 Click Add to register 430 mm Square.

13 Click OK to close the Paper Size Options dialog box.

14 Click Cut Sheet in the LPaper Source list.

15 In the APage Size list, click the size you added,430 mm Square.

16 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Printing on Non-Standard Paper Sizes (Mac OS X)Printing on Non-Standard Paper Sizes (Mac OS X)
For printing on non-standard size paper, first register the paper size in the printer driver.
Call a non-standard paper size registered in the printer driver with Custom Page Sizes (Mac OS X v10.5)/ Custom
Paper Sizes (Mac OS X v10.6 or later).
Once you register Custom Page Sizes / Custom Paper Sizes, you then can select it repeatedly from the paper size
list.
Custom Page Sizes / Custom Paper Sizes can be set up to 18.0 m.
This topic describes how to register a non-standard paper size by the name of 430*430and print based on the following
example.

 

Printing on Non-Standard Paper Sizes (Mac OS X)                                                                                                                                                            iPF9400

                                                                                                                                                                                                                                       User's Guide

  

Enhanced Printing O
ptions

Printing banners or at other non-standard sizes

 118



• Document: Any Type
• Page Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])
• Paper: Sheets
• Media Type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])

Note

• The following procedures are based on Mac OS X v10.5. The method of setting up non-standard paper sizes varies depend-
ing on the version of Mac OS X.

1 Create the document in the application.

2 Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.

3
 

Choose Print in the application menu.

4 Select the printer in the APrinter list.

5
 

Click Manage Custom Sizes in the FPaper Size list to
display the Custom Page Sizes dialog box.

6 In Page Size, enter the height and width of the original. Here, enter 43.00 cm in Height and Width.

7 In Printer Margins, enter 0.5 for the top and side margins and 2.3 for the bottom margin. Here, measurements
are entered in centimeters.

8 Double-click Untitled in the list at left in the Custom Page Sizes dialog box and enter the paper name—in this
case, 430*430.

9 Click OK to close the Custom Page Sizes dialog box.

10 In the FPaper Size list, click the size of the original. In this case, click 430*430, the size you registered.
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11 If you configured the settings using the Page Attributes dialog box, click OK to close the dialog box, and then
select Print from the application software menu.

12
 

Access the Main pane.

13 In the AMedia Type list, select the type of paper that is loaded.

14 After confirming that DEasy Settings is selected, select from the EPrint Target list.

15 Make your selection in the FPrint Quality list.

16
 

Access the Page Setup pane.

17 Click Cut Sheet in the APaper Source list.

18 In CPage Size, make sure 430*430 is displayed, as registered in Page Setup.

19 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "
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Printing Multiple Originals Next to Each OtherPrinting Multiple Originals Next to Each Other
By arranging originals from word-processing or spreadsheet programs or web browser screen shots next to each other
on single sheets, you can create highly expressive presentation materials, easy-to-understand meeting materials, and
a variety of other printed documents.

• Free Layout (Windows)
Besides combining multiple pages in a single-page layout, you can combine originals from multiple files—even
multiple source applications—in a single-page layout.
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• imagePROGRAF Free Layout (Macintosh)
Besides combining multiple pages in a single-page layout, you can combine originals from multiple files—even
multiple source applications—in a single-page layout.

For instructions on arranging originals from multiple applications, refer to the following topics.

• Printing Multiple Originals Next to Each Other (Windows) →P.122
• Printing Multiple Originals Next to Each Other (Mac OS X) →P.124

Printing Multiple Originals Next to Each Other (Windows)Printing Multiple Originals Next to Each Other (Windows)
This topic describes how to arrange multiple originals using the Free Layout function.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")

3
 

Make sure the Main sheet is displayed.
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4
 

Click the Layout tab to display the Layout sheet.

5 Select the APage Layout check box.

6 Click Free Layout in the APage Layout list.

7
 

When you attempt to print, the imagePROGRAF Free
Layout window is displayed. (At this point, the docu-
ment will not be printed yet.)

8 Edit and rearrange the image in the imagePROGRAF Free Layout window as desired.

Note

• Without closing the imagePROGRAF Free Layout window, repeat steps 1–7 to arrange originals from multiple appli-
cations on the same page.

• For instructions on editing and rearranging images, refer to the imagePROGRAF Free Layout help topic.

9 Print from the imagePROGRAF Free Layout menu.
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Note

• For details on imagePROGRAF Free Layout functions, refer to Free Layout →P.217 .

Printing Multiple Originals Next to Each Other (Mac OS X)Printing Multiple Originals Next to Each Other (Mac OS X)
This topic describes how to use the Free Layout function to arrange multiple originals next to each other before print-
ing.

1 Choose Print in the application menu.

2
 

Access the Page Setup pane.

3 Select the NFree Layout check box.

4 Click MPrint.

5
 

The Canon imagePROGRAF Free Layout window is
displayed.

6 Edit and rearrange the image in the Canon imagePROGRAF Free Layout window as desired.

Note

• Without closing the Canon imagePROGRAF Free Layout window, repeat steps 1 to 4 to arrange originals from
multiple applications on the same page.

• For instructions on editing and rearranging images, refer to the Canon imagePROGRAF Free Layout help topic.
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7 Print from the Canon imagePROGRAF Free Layout menu.

Note

• For details on Canon imagePROGRAF Free Layout functions, refer to Free Layout →P.410 .

Printing Multiple Pages ContinuouslyPrinting Multiple Pages Continuously
You can print multiple pages as a single continuous image, without margins between pages.

• Banner Printing

Important

• This feature is only available with rolls. It cannot be used when printing on sheets.

• During banner printing, settings for conserving paper, number of copies, borderless printing, enlargement or reduction,
and other layout-related settings are disregarded.

For instructions on borderless printing of photos and images at actual size, refer to the following topics, as appro-
priate for your computer and operating system.

• Printing Multiple Pages Continuously (Windows) →P.125
• Printing Multiple Pages Continuously (Mac OS X) →P.127

Printing Multiple Pages Continuously (Windows)Printing Multiple Pages Continuously (Windows)
This topic describes how to print multiple pages as a single continuous image, without margins between pages.

Important

• This feature is only available with rolls. It cannot be used when printing on sheets.

• During banner printing, settings for conserving paper, number of copies, borderless printing, enlargement or reduction, and
other layout-related settings are disregarded.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, click the type of paper that is loaded.

5
 

Click the Page Setup tab to display the Page Setup
sheet.

6 Select and click a roll paper in the LPaper Source list.

7
 

Click NRoll Paper Options to display the Roll Paper
Options dialog box.

8 Select the BBanner Printing check box.

9 Click OK.
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10 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Printing Multiple Pages Continuously (Mac OS X)Printing Multiple Pages Continuously (Mac OS X)
This topic describes how to print multiple pages as a single continuous image, without margins between pages.

Important

• This feature is only available with rolls. It cannot be used when printing on sheets.

• During banner printing, settings for conserving paper, number of copies, borderless printing, enlargement or reduction, and
other layout-related settings are disregarded.

 

1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 Click the original size in the FPaper Size list.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.
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5
 

Access the Main pane.

6 In the AMedia Type list, click the type of paper that is loaded.

7 Make your selection in the EPrint Target list.

8 Make your selection in the FPrint Quality list.

9
 

Access the Page Setup pane.

10 Click Roll Paper (Banner) in the APaper Source list.

11 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "
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Printing Multiple Pages Per SheetPrinting Multiple Pages Per Sheet
To conserve paper, you can print several pages of the original on a single sheet by reducing the original and dividing
the sheet into areas for each page.

• Page Layout
Specify a number of pages of the original to print on a single sheet, in a layout of multiple pages per sheet.

Important

• This function cannot be combined with the following options.

• Borderless Printing
• Scaling Originals (Windows)
• Banner Printing (Windows)

• When printing using this function, the Print Centered setting is disabled.

Note

• You can print up to 16 pages of the original on a single sheet.

• You can also change the page layout order and print page boundary lines, as desired.

For instructions on printing multiple pages per sheet, refer to the following topics, as appropriate for your computer
and operating system.

• Printing Multiple Pages Per Sheet (Windows) →P.129
• Printing Multiple Pages Per Sheet (Mac OS X) →P.131

Printing Multiple Pages Per Sheet (Windows)Printing Multiple Pages Per Sheet (Windows)
This topic describes how to print four pages of originals together on a single sheet based on the following example.

• Document: Any Type
• Page size: A3 (297.0×420.0 mm [11.7×16.5 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications →P.179 ")
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Make your selection in the EPrint Target list.

6 Make your selection in the FPrint Quality list.

7
 

Click the Page Setup tab to display the Page Setup
sheet.

8 In APage Size, click the size of the original as specified in the application software. In this case, click ISO A3.

9 Select and click a roll paper in the LPaper Source list.

10 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).
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11
 

Click the Layout tab to display the Layout sheet.

12 Select the APage Layout check box.

13 Click 4 Pages/Sheet in the APage Layout list.

Note

• You can select the layout order for placing four pages on a sheet and a frame border in the Page Layout Printing
dialog box by clicking B Set.

14 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Printing Multiple Pages Per Sheet (Mac OS X)Printing Multiple Pages Per Sheet (Mac OS X)
This topic describes how to print four pages of an original on a single sheet, based on the following example.

• Document: Any Type
• Page size: A3 (297.0 × 420.0 mm [11.7 × 16.5 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])
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1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 In the FPaper Size list, click the size of the original. In this case, click ISO A3.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.

5
 

Access the Layout pane.

6 Click 4 in the APages per Sheet list.
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7
 

Access the Main pane.

8 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

9 Make your selection in the EPrint Target list.

10 Make your selection in the FPrint Quality list.

11
 

Access the Page Setup pane.

12 Select and click a roll paper in the APaper Source list.
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13 Make sure the width of the loaded roll is displayed in the BRoll Width list—in this case, ISO A2/A3
(420.0mm).

Note

• If the width of the roll loaded in the printer is not shown in
B Roll Width, click L Printer Information on the Main
pane to update the printer information.

 

14
 

Make sure CPage Size shows the original size as
specified in CPaper Size in the Page Attributes dia-
log box—in this case, ISO A3.

15 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "

Printing Posters in SectionsPrinting Posters in Sections
You can enlarge an original to print it in sections on several sheets. By assembling the printed sheets, you can create a
poster larger than the maximum supported paper size of the printer.

• Page Layout
Choose poster printing.
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Important

• When printing using this function, the Print Centered, Watermark, No Spaces at Top or Bottom (Conserve Paper),
and Page Options settings are disabled.

For instructions on printing large posters, refer to the following topics, as appropriate for your computer and oper-
ating system.

• Printing Large Posters (Windows) →P.135

Note

• This method of poster printing is supported in Windows.

Printing Large Posters (Windows)Printing Large Posters (Windows)
You can enlarge an original to print it in sections on several sheets. By assembling the printed sheets, you can create a
poster larger than the maximum supported paper size of the printer. This topic describes how to enlarge an A2 original
for printing it in sections on four sheets, based on the following example.

• Document: Poster
• Page size: A2 (420.0×594.0 mm [16.5 × 23.4 in])
• Paper: Sheets
• Paper Size: A2 (420.0 × 594.0 mm [16.5 × 23.4 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded.

5 Click Poster in the EPrint Target list.
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6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In APage Size, click the size of the original as specified in the application. In this case, click ISO A2.

8 Click Cut Sheet in the LPaper Source list.

9
 

Click the Layout tab to display the Layout sheet.

10 Select the APage Layout check box.

11 Click Poster (2 x 2) in the APage Layout list.

Note

• Follow the steps below to print only a portion of the poster as divided for printing.

• Click B Set under A Page Layout to display the Pages to Print dialog box.

• On the Pages to Print dialog box, clear the check boxes of the portion you do not want to print.
• Click OK to close the Pages to Print dialog box.
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12 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "
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Centering originalsCentering originals
Printing Originals Centered on Rolls .................................................................................................................. 138

Printing Originals Centered on Rolls (Windows) ........................................................................................... 138
Printing Originals Centered on Rolls (Mac OS X) ......................................................................................... 140

Printing Originals Centered on Sheets ............................................................................................................... 143
Printing Originals Centered on Sheets (Windows) ........................................................................................ 143
Printing Originals Centered on Sheets (Mac OS X) ...................................................................................... 145

Printing Originals Centered on RollsPrinting Originals Centered on Rolls
You can print originals centered on a page—for example, if the paper is larger than the original, or if you are reducing
the original.

• Print Centered
If you use originals smaller than the roll paper width, you can center them relative to the width when printing.

For instructions on centering originals when printing on rolls, refer to the following topics, as appropriate for your
computer and operating system.

• Printing Originals Centered on Rolls (Windows) →P.138
• Printing Originals Centered on Rolls (Mac OS X) →P.140

Printing Originals Centered on Rolls (Windows)Printing Originals Centered on Rolls (Windows)
This topic describes how to center originals before printing on rolls based on the following example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll width: A3/A4 roll (297.0 mm [11.7 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Select the print target in the EPrint Target list.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

8 Select and click a roll paper in the LPaper Source list.

9 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A3/A4 Roll (297.0mm).
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10
 

Click the Layout tab to display the Layout sheet.

11 Select the EPrint Centered check box.

12 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Printing Originals Centered on Rolls (Mac OS X)Printing Originals Centered on Rolls (Mac OS X)
This topic describes how to center originals before printing on rolls based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])
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1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 In the FPaper Size list, click the size of the original. In this case, click ISO A4.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.

5
 

Access the Main pane.

6 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7 Make your selection in the EPrint Target list.

8 Make your selection in the FPrint Quality list.
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9
 

Access the Page Setup pane.

10 Select and click a roll paper in the APaper Source list.

11 Make sure the width of the loaded roll is displayed in BRoll Width —in this case, ISO A3/A4 (297.0mm).

Note

• If the width of the roll loaded in the printer is not shown in
B Roll Width, click L Printer Information on the Main
pane to update the printer information.

 

12
 

Make sure the CPage Size setting matches the origi-
nal size as selected in CPaper Size in the Page At-
tributes dialog box—in this case, ISO A4.

13 Select the JPrint Centered check box.
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14 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "

Printing Originals Centered on SheetsPrinting Originals Centered on Sheets
You can print originals centered on a page—for example, if the paper is larger than the original, or if you are reducing
the original.

• Print Centered
If you use paper larger than the original size or print originals after reduction, the printed images may be aligned in
the upper-left corner of the paper. In this case, you can center originals on sheets when printing.

For instructions on centering originals when printing on sheets, refer to the following topics, as appropriate for your
computer and operating system.

• Printing Originals Centered on Sheets (Windows) →P.143
• Printing Originals Centered on Sheets (Mac OS X) →P.145

Printing Originals Centered on Sheets (Windows)Printing Originals Centered on Sheets (Windows)
This topic describes how to reduce an original 50% for printing centered on a sheet.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Make your selection in the EPrint Target list.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO A4.

8 Select the CEnlarged/Reduced Printing check box.

9 Click Match Page Size in the GPaper Size list.

10 Click FScaling and enter 50.

11 Click Cut Sheet in the LPaper Source list.
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12
 

Click the Layout tab to display the Layout sheet.

13 Select the EPrint Centered check box.

14 Confirm the print settings and print as desired.

Important

• If you have selected Cut Sheet as the paper source, follow the instructions on the printer control panel to enter the
paper size.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Printing Originals Centered on Sheets (Mac OS X)Printing Originals Centered on Sheets (Mac OS X)
This topic describes how to center originals for printing on sheets, based on the following example.

• Document: Any Type
• Page size: A4
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: Non-standard
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1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 In the FPaper Size list, click the size of the original. In this case, click ISO A4 - Cut Sheet.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.

5
 

Access the Main pane.

6 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7 Make your selection in the EPrint Target list.

8 Make your selection in the FPrint Quality list.

 

Printing Originals Centered on Sheets (Mac OS X)                                                                                                                                                             iPF9400

                                                                                                                                                                                                                                       User's Guide

  

Enhanced Printing O
ptions

C
entering originals

 146



9
 

Access the Page Setup pane.

10 Click Cut Sheet in the APaper Source list.

11
 

Make sure the CPage Size setting matches the origi-
nal size as selected in CPaper Size in the Page At-
tributes dialog box—in this case, ISO A4 - Cut Sheet.

12 Select the JPrint Centered check box.

13 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "

Important

• If you have selected Cut Sheet as the paper source, follow the instructions on the printer control panel to enter the paper
size.
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Conserving roll paperConserving roll paper
Conserving Roll Paper by Rotating Originals 90 Degrees ................................................................................. 148

Conserving Roll Paper by Rotating Originals 90 Degrees (Windows) .......................................................... 148
Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X) ........................................................ 150

Conserving Roll Paper by Printing Originals Without Top and Bottom Margins ................................................ 152
Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows) ......................... 153
Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS X) ....................... 154

Conserving Roll Paper by Rotating Originals 90 DegreesConserving Roll Paper by Rotating Originals 90 Degrees
You can conserve roll paper by specifying particular settings as suitable for your original.

• Rotate Page 90 degrees (Conserve Paper)
When originals are printed in portrait orientation, the original is rotated 90 degrees before printing if it fits within the
roll width. This enables you to conserve paper.

Important

• If the page would exceed the roll paper width after rotation, use this function with Scale to fit Roll Paper Width to print
rotated pages.

For tips on conserving roll paper, refer to the following topics, as appropriate for your computer and operating sys-
tem.

• Conserving Roll Paper by Rotating Originals 90 Degrees (Windows) →P.148
• Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X) →P.150

Conserving Roll Paper by Rotating Originals 90 Degrees (Windows)Conserving Roll Paper by Rotating Originals 90 Degrees (Windows)
This topic describes how to conserve paper by rotating originals 90 degrees before printing, based on the following
example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3×11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

This example illustrates how to rotate an A4 (210.0×297.0 mm)/Letter (8.3×11.7 in) original in portrait orientation 90
degrees to fit within the width of A3/A4 roll paper (297.0 mm [11.7 in]), which enables you to conserve paper.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications →P.179 ")
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5
 

Click the Page Setup tab to display the Page Setup
sheet.

6 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

7 Select and click a roll paper in the LPaper Source list.

8 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A3/A4 Roll (297.0mm).

9 Select the KRotate Page 90 degrees (Conserve Paper) check box.

10 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "
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Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X)Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X)
This topic describes how to conserve roll paper by rotating originals 90 degrees before printing, based on the following
example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

This example illustrates how to rotate an A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in) original in portrait orientation 90
degrees to fit within the width of A3/A4 roll (297.0 mm [11.7 in]), which enables you to conserve paper.
 

1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 In the FPaper Size list, click the size of the original. In this case, click ISO A4.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.
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5
 

Access the Main pane.

6 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7
 

Access the Page Setup pane.

8 Select and click a roll paper in the APaper Source list.

9 Make sure the width of the loaded roll is displayed in BRoll Width —in this case, ISO A3/A4 (297.0mm).

Note

• If the width of the roll loaded in the printer is not shown in
B Roll Width, click L Printer Information on the Main
pane to update the printer information.
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10
 

Make sure the CPage Size setting matches the origi-
nal size as selected in CPaper Size in the Page At-
tributes dialog box—in this case, ISO A4.

11 Select the LRotate Page 90 degrees check box.

12 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "

Conserving Roll Paper by Printing Originals Without Top and Bottom MarginsConserving Roll Paper by Printing Originals Without Top and Bottom Margins
You can conserve roll paper by specifying particular settings as suitable for your original.

• No Spaces at Top or Bottom (Conserve Paper)
You can print without feeding the paper for blank portions of originals if there are top and bottom margins in origi-
nals. This enables you to conserve as much paper as the size of the margins.

Important

• Printing without the top and bottom margins is not supported in the following cases.

• Banner printing
• If you have chosen poster as the type of page layout

Note

• Even during borderless printing, you can print without the top and bottom margins.

• Printing without the top and bottom margins may cause inconsistency in the size of printed documents, depending on the
layout of images or text in your originals.

For tips on conserving roll paper, refer to the following topics, as appropriate for your computer and operating sys-
tem.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows) →P.153

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS X) →P.154
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Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows)Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows)
This topic describes how to conserve roll paper when printing originals that have a top and bottom margin, based on
the following example.

• Document: Any type
• Page size: A4 (210.0×297.0mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5
 

Click the Page Setup tab to display the Page Setup
sheet.
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6 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

7 Select and click a roll paper in the LPaper Source list.

8 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A3/A4 Roll (297.0mm).

9
 

Click the Layout tab to display the Layout sheet.

10 Select the GNo Spaces at Top or Bottom (Conserve Paper) check box.

11 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS X)Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS X)
This topic describes how to conserve roll paper when printing originals that have a top and bottom margin, based on
the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])
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1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 In the FPaper Size list, click the size of the original. In this case, click ISO A4.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.

5
 

Access the Main pane.

6 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.
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7
 

Access the Page Setup pane.

8 Select and click a roll paper in the APaper Source list.

9 Make sure the width of the loaded roll is displayed in BRoll Width —in this case, ISO A3/A4 (297.0mm).

Note

• If the width of the roll loaded in the printer is not shown in
B Roll Width, click L Printer Information on the Main
pane to update the printer information.

 

10
 

Make sure the CPage Size setting matches the origi-
nal size as selected in CPaper Size in the Page At-
tributes dialog box—in this case, ISO A4.

11 Select the KNo Spaces at Top or Bottom check box.
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12 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "
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Checking Images Before PrintingChecking Images Before Printing
Checking the Layout in a Preview Before PrintingChecking the Layout in a Preview Before Printing

You can check the print layout on the preview screen.

• Open Preview When Print Job Starts (Windows)
While viewing the preview screen, you can also adjust orientation or other settings, and your changes will be in-
stantly applied on the preview screen.

Note

• Under some settings and in some environments, PageComposer may be started.

• Preview (Macintosh)
While viewing the preview screen, you can also adjust layout or size settings, and your changes will be instantly
applied on the preview screen.

For instructions on how to check the layout before printing, refer to the following topics:

• Checking the Layout in a Preview Before Printing (Windows) →P.176
• Checking the Layout in a Preview Before Printing (Mac OS X) →P.362
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Other useful settingsOther useful settings
Printing With Watermarks ................................................................................................................................... 159

Printing with Watermarks— COPY, FILE COPY, and so on (Windows) ........................................................ 160
Making the Original Orientation Match the Paper Orientation ........................................................................... 162

Making the Original Orientation Match the Paper Orientation (Windows) .................................................... 162
Making the Original Orientation Match the Paper Orientation (Mac OS X) .................................................. 164

Using Favorites .................................................................................................................................................. 166
Using Favorites (Windows) ........................................................................................................................... 178
Using Favorites (Mac OS X) .......................................................................................................................... 363

Cutting Roll Paper After Printing ........................................................................................................................ 167
Cutting Roll Paper After Printing (Windows) ................................................................................................. 167
Cutting Roll Paper After Printing (Mac OS X) ................................................................................................ 168

Printing With WatermarksPrinting With Watermarks
You can add watermarks (background images) to documents that require special handling.

• Watermark
Watermarks are applied to all pages of your document.

Important

• Watermarks are not printed if you select poster as the type of page layout.

The following watermarks are provided:

• CONFIDENTIAL
• COPY
• DRAFT
• FILE COPY
• FINAL
• PRELIMINARY
• PROOF
• TOP SECRET

You can also create your own watermarks. Specify the following options to customize your watermark.

• Watermark string: Specify the font, size, color, and so on. Surround the watermark with a frame, if desired.

• Watermark position: Specify the position on the page, the angle, and so on.

• Watermark printing method: Specify whether to print the watermark superimposed or under the document im-
age. You can also print the watermark only on the first page, if desired.

Note

• Watermarks are supported in Windows.

• In addition to the provided watermarks, you can create up to 50 original watermarks.
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For detailed instructions on printing with watermarks, refer to the following topics:

• Printing with Watermarks— COPY, FILE COPY, and so on (Windows) →P.160

Printing with Watermarks— COPY, FILE COPY, and so on (Windows)Printing with Watermarks— COPY, FILE COPY, and so on (Windows)
This topic describes how to print with watermarks, based on the following example of printing with a FILE COPY water-
mark.

• Document: Any type
• Page size: A2 (420.0×594.0 mm [16.5 × 23.4 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in[)

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Make your selection in the EPrint Target list.

Note

• You can check the settings values selected in the E Print Target list by clicking G View Settings.
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6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In APage Size, click the size of the original as specified in the application software. In this case, click ISO A2.

8 Select and click a roll paper in the LPaper Source list.

9 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

10
 

Click the Layout tab to display the Layout sheet.

11 Select the CWatermark check box.

12 Click FILE COPY in the Watermarks list.

Note

• Click D Edit Watermark to open the Edit Watermark dialog box. In the Edit Watermark dialog box, you can create
custom watermarks and change the position and angle of watermarks.

13 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "
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Making the Original Orientation Match the Paper OrientationMaking the Original Orientation Match the Paper Orientation
You can specify the original orientation to match the orientation of the paper for printing.

• Orientation
Paper is usually loaded in the printer in portrait orientation. When you have an original in landscape orientation,
you can specify the printing orientation so that the original is printed in landscape orientation.

• Rotate 180 degrees
The original is rotated 180 degrees to print it upside down.

• Mirror
A mirror image of the original is printed.
For instructions on specifying the original orientation before printing, refer to the following topics, as appropriate for
your computer and operating system.

• Making the Original Orientation Match the Paper Orientation (Windows) →P.162
• Making the Original Orientation Match the Paper Orientation (Mac OS X) →P.164

Making the Original Orientation Match the Paper Orientation (Windows)Making the Original Orientation Match the Paper Orientation (Windows)
This topic describes how to print an original in landscape orientation after matching the paper orientation, based on the
following example.

• Document: An original in landscape orientation
• Page size: A4 (210.0 × 297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications →P.179 ")
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Make your selection in the EPrint Target list.

6 Make your selection in the FPrint Quality list.

7
 

Click the Page Setup tab to display the Page Setup
sheet.

8 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

9 In HOrientation, click JLandscape.

10 Select and click a roll paper in the LPaper Source list.

11 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).
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12 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Making the Original Orientation Match the Paper Orientation (Mac OS X)Making the Original Orientation Match the Paper Orientation (Mac OS X)
This topic describes how to print an original in landscape orientation after matching the paper orientation, based on the
following example.

• Document: An original in landscape orientation
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

 

1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 In the FPaper Size list, click the size of the original. In this case, click ISO A4.

4 In GOrientation, click the icon of the document in landscape orientation.

5 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.
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6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

8 Make your selection in the EPrint Target list.

9 Make your selection in the FPrint Quality list.

10
 

Access the Page Setup pane.

11 Select and click a roll paper in the APaper Source list.
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12 Make sure the width of the loaded roll is displayed in the BRoll Width list—in this case, ISO A2/A3
(420.0mm).

Note

• If the width of the roll loaded in the printer is not shown in
B Roll Width, click L Printer Information on the Main
pane to update the printer information.

 

13
 

Make sure the CPage Size setting matches the origi-
nal size as selected in CPaper Size in the Page At-
tributes dialog box—in this case, ISO A4.

14 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "

Using FavoritesUsing Favorites
You can register print settings as Favorites to reuse settings from a particular job that met your expectations, or set-
tings for a particular page size that you will use repeatedly.

• Favorites
Registering a favorite for later use. You can choose the settings you have registered from a list before printing, and
you can check the settings details.

Note

• You can also save the favorite settings as files. Using these files is a convenient way to print under the same conditions
on another computer. (In Windows.)

For instructions on using favorites to print, refer to the following topics, as appropriate for your computer and oper-
ating system.

• Using Favorites (Windows) →P.178
• Using Favorites (Mac OS X) →P.363
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Cutting Roll Paper After PrintingCutting Roll Paper After Printing
Roll paper can be automatically cut after printing.

Note

• It may not be possible to cut certain types of paper, such as adhesive paper. For details on types of paper that cannot be used
with the auto cut feature, see the Paper Reference Guide. (See "Types of Paper →P.522 ")

• Automatic Cutting
Roll paper is cut automatically after printing. If you prefer, you can print continuously without cutting the roll, or you
can print a cut line.
For instructions on cutting roll paper after printing, refer to the following topics, as appropriate for your computer
and operating system.

• Cutting Roll Paper After Printing (Windows) →P.167
• Cutting Roll Paper After Printing (Mac OS X) →P.168

Cutting Roll Paper After Printing (Windows)Cutting Roll Paper After Printing (Windows)
This topic describes how to cut roll paper automatically after printing (using the auto cut function), as well as how to
print a cut line for manual cutting.

Note

• The auto cut function is activated on the printer by default and when the printer driver is installed. Follow the steps below to
reactivate the function if it is disabled, or to select the setting for printing a cut line instead.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")

3
 

Click the Page Setup tab to display the Page Setup
sheet.

4 Select and click a roll paper in the LPaper Source list.
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5
 

Click NRoll Paper Options to display the Roll Paper
Options dialog box.

6 To enable automatic cutting, click Yes in the AAutomatic Cutting list. If you prefer to cut the paper later your-
self, click Print Cut Guideline.

7 Click OK to close the Roll Paper Options dialog box.

8 Confirm the print settings and print as desired.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.176 "

Roll paper will be automatically cut after printing.

Cutting Roll Paper After Printing (Mac OS X)Cutting Roll Paper After Printing (Mac OS X)
This topic describes how to cut roll paper automatically after printing (using the auto cut function), as well as how to
print a cut line for manual cutting.

Note

• The auto cut function is activated on the printer by default and when the printer driver is installed. Follow the steps below to
reactivate the function if it is disabled, or to select the setting for printing a cut line instead.

 

1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.
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2 Select the printer in the APrinter list.

3 Choose the original size in the FPaper Size list.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.

5
 

Access the Page Setup pane.

6 Select and click a roll paper in the APaper Source list.

7
 

Access the Main pane.

8 In the AMedia Type list, select the type of paper that is loaded.
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9
 

Click CSet to display the Paper Detailed Settings di-
alog box.

10 To enable automatic cutting, click Printer Default in the HAutomatic Cutting list. If you prefer to cut the pa-
per later yourself, click Print Cut Guideline.

Important

• If the automatic cut function has been deactivated on the printer, change the auto cut setting on the printer Control
Panel.

11 Click OK to close the Paper Detailed Settings dialog box.

12 Confirm the print settings, and then click MPrint to start printing.

Note

• For tips on confirming print settings, see "Confirming Print Settings →P.362 "
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Printer Driver SettingsPrinter Driver Settings
For instructions on accessing the Windows printer driver, refer to the following topics.

• Accessing the Printer Driver Dialog Box from Applications →P.179

• Accessing the Printer Driver Dialog Box from the Operating System Menu →P.181
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For information on the Windows printer driver settings, refer to the following topics.

• Main Sheet →P.182
You can specify the type of paper, color processing, print quality, print preview, and other settings. Choose Easy
Settings to specify basic print settings based on the printing application or Advanced Settings to complete more
detailed settings as desired.

• Paper Detailed Settings Dialog Box →P.185
• View Settings Dialog Box for the Printing Application →P.187
• Color Adjustment Sheet: Color →P.187
• Object Adjustment Dialog box: Color →P.189
• Matching Sheet →P.189
• Color Adjustment Sheet: Monochrome →P.192
• Object Adjustment Dialog box: Monochrome →P.193
• Gray Adjustment Sheet →P.194

• Page Setup Sheet →P.195
You can specify the page size of the original, borderless printing, enlargement or reduction, the orientation, the
paper size and feed source, and automatic cutting.

• Output Method Dialog box →P.198
• Paper Size Options Dialog Box →P.199

• Layout Sheet →P.200
You can specify the page layout, watermarks, the orientation, the number of copies, and print processing options.

• Page Options Dialog Box →P.201
• Special Settings Dialog Box →P.202

• Favorites Sheet →P.203
Groups of print settings you select on each sheet can be saved as a favorite. Favorites you have added can be
edited or used at the time of printing as desired.

• Utility Sheet →P.204
You can specify settings related to maintenance for the Printhead and feed amount, as well as settings for Color
imageRUNNER Enlargement Copy.

• Support Sheet →P.205
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You can view support information and the user manual.

• Device Settings Sheet →P.206
You can display settings for optional equipment installed on the printer and see the version information for the
printer driver.

imagePROGRAF Free Layout is a feature for freely arranging originals from various source applications on a single
page as desired before printing. For details, see Free Layout →P.217 .
Color imageRUNNER Enlargement Copy is a feature for automatic enlargement and printing of scanned originals
from a Color imageRUNNER. For details, see Color imageRUNNER Enlargement Copy →P.240 .

Specifying Paper in the Printer DriverSpecifying Paper in the Printer Driver
If you have replaced the paper, you must complete the following settings in the printer driver.

Important

• Always specify the same type and size of paper in the printer menu and printer driver.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded.

Note

• Click the B Get Information button to display the Paper Information on Printer dialog box. On the Paper Informa-
tion on Printer dialog box, you can obtain information on the paper in the printer and configure printer driver settings
for the feed source and type of paper.
This function requires that the Status Monitor be installed.

5
 

Click the Page Setup tab to display the Page Setup
sheet.

6 In the APage Size list, select the size of the original as specified in the application.

7 In the LPaper Source list, select how paper is supplied.

8 If you have selected roll paper in LPaper Source, select the width of the loaded roll in MRoll Paper Width.

Note

• A variety of settings are available in the printer driver to suit different printing applications.
For details on available printing conditions, see "Printer Driver Settings →P.172 "
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Confirming Print SettingsConfirming Print Settings
There are two ways to confirm the print settings, as follows.

• Checking a preview of the settings
A preview of the settings is displayed on the left side of the Main, Page Setup, and Layout sheets. By checking
illustrations and numerical values in the preview, you can confirm current settings for the page size, orientation,
paper source, layout, and so on.

Display Area Information Displayed

P Top illustrations Illustrations indicate the orientation, page layout, borderless printing selection, color mode, and
other settings information.

Q Middle, bordered area The page size, paper size, and method and percentage of enlargement or reduction are indica-
ted.

R Bottom illustrations Illustrations indicate the feed source, orientation, borderless printing selection, and other settings
information.

Note

• To confirm the Print Target specified in Easy Settings, click G View Settings on the Main sheet to display the View
Settings dialog box.

• Checking a print preview
You can check an image of the original just as it will be printed.
When you activate this feature, imagePROGRAF Preview or PageComposer is started before printing. Confirming
how documents will be printed this way helps prevent printing errors.
For details on print previews, see "Checking the Layout in a Preview Before Printing →P.158 "

Checking the Layout in a Preview Before PrintingChecking the Layout in a Preview Before Printing
This topic describes how to preview images of print jobs before actually printing them.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")
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3
 

Make sure the Main sheet is displayed.

4 Select the LOpen Preview When Print Job Starts check box.

5
 

After you click OK, when you print a job, the image-
PROGRAF Preview window will be displayed.

Note

• If PageComposer is running, access the Special Settings dialog box from the Layout sheet and clear Enable Pre-
view Switching.

6 On the main window, you can check the layout and change settings as needed.

7 To print, click Print in the File menu.

Note

• For details on imagePROGRAF Preview functions, see Preview →P.207 .
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Using FavoritesUsing Favorites
This topic describes how to register favorites and print using favorite settings.

Registering a favorite
This section describes the procedure for registering printing settings that have been changed in the driver as Favor-
ites.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box. (Refer to "Accessing the Print-
er Driver Dialog Box from Applications →P.179 ")

3 Perform normal printing settings.
The favorite is registered from here.

4
 

Click the Favorites tab to display the Favorites sheet.

5
 

Click HAdd to display the Add dialog box.

6 Enter a desired name in Name, such as Photos for Presentations or Monthly Report.

7 Choose a fitting icon for these print settings in the Icon list.

8 In Comment, enter a description of the favorite to be added, as desired.
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9 Click OK to close the Add dialog box.
The favorite you have added is now displayed in AFavorites.

Note

• To save a favorite as a file, click J Export and specify the file to save.

Printing using the favorite
Follow the steps below to print using the favorite you have registered.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")

3
 

Click the Favorites tab to display the Favorites sheet.

4 In the AFavorites, choose the favorite you registered.

Note

• To import a favorite, click I Import and specify the favorite file.

5 Click DApply Favorite to replace the favorite settings with the current print settings.

6 Confirm the print settings and print as desired.

Note

• For instructions on confirming print settings, see "Confirming Print Settings →P.176 "

Accessing the Printer Driver Dialog Box from ApplicationsAccessing the Printer Driver Dialog Box from Applications

1 Choose Print from the File menu to display the dialog box for printing conditions.
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2 Select the printer, and then display the printer driver dialog box.

Note

• The dialog box for specifying printing conditions varies depending on the source application. In some cases, when
you select the printer, a sheet for configuring the printer driver is added to the dialog box.
In the following case, click Preferences.

• Example: Print dialog box displayed by the application software

Six sheets of print settings are displayed by the printer
driver: Main, Page Setup, Layout, Favorites, Utility,
and Support.

Note

• The titles of dialog boxes may vary depending on the application, and sheets other than these six sheets may be
displayed.

Important

• If you access the printer driver dialog box from the source application, changes you make to the settings will only apply
temporarily to that application. Because these are sizes you specify temporarily in the printer driver, the sizes will not be
available after you exit the application.

• You can also access the printer driver dialog box from the Windows system menu.
To use the settings continuously in all applications, open the printer driver from the system menu to make the settings.
See "Accessing the Printer Driver Dialog Box from the Operating System Menu →P.181 ".
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Accessing the Printer Driver Dialog Box from the Operating System MenuAccessing the Printer Driver Dialog Box from the Operating System Menu

1 Click start > Printers and Faxes (or Printers).

2
 

Select the printer, and then display the printer proper-
ties dialog box.

3
 

Click Printing Preferences to display the Main (or
Printing Preferences) dialog box, titled with the name
of this printer.

Note

• The Device Settings sheet is also an extension of the printer driver.(See "Device Settings Sheet →P.206 ")
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Six sheets of print settings are displayed by the printer
driver: Main, Page Setup, Layout, Favorites, Utility,
and Support.

Important

• If you access the printer driver dialog box from the operating system menu, changes you make to the settings will apply to all
applications you use for printing.

• You can also access the printer driver dialog box from applications.
See "Accessing the Printer Driver Dialog Box from Applications →P.179 ".

Main SheetMain Sheet
The following settings are available on the Main sheet. For details on settings items, refer to the printer driver help file.

Note

• On the Main sheet, choose Easy Settings to specify basic print settings based on the particular printing application, or switch
to Advanced Settings to complete more detailed settings as desired.

Common Items

• AMedia Type
Select the type of paper.
For information on the types of paper the printer supports, refer to the Paper Reference Guide. (See " Paper Refer-
ence Guide".)

 

Main Sheet (Windows)                                                                                                                                                                                                         iPF9400

                                                                                                                                                                                                                                       User's Guide

  

W
indow

s Softw
are

Printer D
river

 182



• BGet Information
Displays Paper Information on Printer. You can update the printer driver settings for the feed source, media
type, and roll width by selecting the feed source.

• Paper Information on Printer Dialog Box →P.185

• CAdvanced Settings
Displays Paper Detailed Settings. You can configure the printing settings to match the type of media, such as the
ink drying time.

• Paper Detailed Settings Dialog Box →P.185

• LOpen Preview When Print Job Starts
If you turn this on, imagePROGRAF Preview starts before printing.
This allows you to check on-screen previews of documents before printing.

• Checking the Layout in a Preview Before Printing →P.158

• MStatus Monitor
Starts imagePROGRAF Status Monitor.
You can check the printer status, job status, and other conditions.
You can also set up email notification if printer errors occur by completing the Email Notice settings.
For details, refer to the Status Monitor help file.

• NAbout
Displays version information for the printer driver.

• SDefaults
Restores all settings on the sheet to the default values.

Configuration using Easy Settings

• FPrint Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.61

• GView Settings
Displays the EPrint Target setting values.
You can view and change the order of EPrint Target setting values.
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• View Settings Dialog Box for the Printing Application →P.187

Configuration using Advanced Settings

• EPrint Priority
Choose the graphic elements that you want to emphasize for printing.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.61

• FPrint Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.61

• GColor Mode
Choose the color mode.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.61

Note

• Depending on the A Media Type setting, some G Color Mode options may not be available.

• HColor Settings
Click to display the Color Settings dialog box for more advanced color settings.

• Adjusting the Color in the Printer Driver →P.54

• IThicken Fine Lines
Activate this option to print fine lines more distinctly.

• JUnidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the
printing speed becomes slower.
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Paper Information on Printer Dialog BoxPaper Information on Printer Dialog Box
On the Paper Information on Printer dialog box, you can obtain information on the paper in the printer and configure
printer driver settings for the paper source and media type.

Note

• To display the Paper Information on Printer dialog box, on the Main sheet, click Get Information by Media Type.(See
"Main Sheet →P.182 ")

• APaper Source
Shows the paper source supported by the printer, as well as information about the loaded paper. To update the
paper source and media type settings in the printer driver, select the desired Paper Source option and click OK.

Paper Detailed Settings Dialog BoxPaper Detailed Settings Dialog Box
In the Paper Detailed Settings dialog box, you can set Drying Time for the paper selected with Media Type of the
Main sheet, etc.
You can display this dialog box by clicking Settings of Media Type on the Main sheet. (Refer to "Main
Sheet →P.182 ".)
As for the items for which you can selectPrinter Default in this dialog box, you also can set them from the control pan-
el of the printer. (Refer to "Menu Settings →P.667 ".)

ADrying Time
Specify the time that the printer waits for ink to dry, as needed. The Drying Time setting is only valid for rolls.
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• BBetween Pages
You can set the time to wait after printing 1 document page until ejecting the paper. Since waiting time is required
for ink to dry before a roll is cut, you can deliver paper in the Output Stacker with the ink dried even if Cutting
Mode is set to Automatic.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

Off Paper is ejected immediately after printing completes.

30 sec. / 1 min. / 3 min. / 5 min. / 10
min. / 30 min. / 60 min.

Paper is ejected when the set time elapses after printing completes.

• CBetween Scans
You can set the time to wait after printing 1 line on a page until printing the next line. Set this to avoid bleeding or
color unevenness such as when bleeding occurs on a page or when color unevenness occurs during borderless
printing.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

Off The next line is printed immediately after a line is printed.

1 sec. / 3 sec. / 5 sec. / 7 sec. / 9 sec. The next line is printed when the set time elapses after a line is printed.
 

* Increase the time according to the occurrence condition of bleeding or unevenness.

DRoll Paper Margin for Safety
You can specify the length of a margin on the leading edge of paper to ensure that paper susceptible to curling is held
firmly against the Platen.

• ENear End Margin
Specify the length of the Near End Margin (the leading edge margin) of the roll, as needed.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

5 mm (0.2 in) The document is printed in the standard size.
 

* Select this when you do not have any problems in printing.

20 mm (0.8 in) Select this when rubbing against the printhead occurs such as when using paper that tends to
curl.

FCut Speed
Select the speed of automatic cutting, as needed. You can adjust this setting if paper is not cut well when automatic
cutting is used.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

High Speed When the Standard setting does not result in cutting the surface cleanly, select this.

Standard Select this when you do not have any problems in automatic cutting.

Low Speed This helps prevent adhesive from sticking to the cutter and keeps the cutter sharp if you select it
when using adhesive paper.

HCalibration Value
You can specify whether to apply the results of calibration performed on the printer to image processing.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.
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Setting Item Details
Enabled Print using the calibration results.

Disabled Print without using the calibration results. Select this to avoid the changing of the color of images
during printing by color calibration.

GMirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or image with
the left and right sides inverted.

View Settings Dialog Box for the Printing ApplicationView Settings Dialog Box for the Printing Application
In the View Settings dialog box, you can check details of the selected printing application.

Note

• To display the View Settings dialog box, on the Main sheet, click View Settings by Print Target.(See "Main
Sheet →P.182 ")

• APrint Target
Shows all Print Target options (settings items for the printing application).

• BName
Identifies the item selected in Print Target by its name and an icon.

• CDetails
Here, you can confirm detailed settings values for each listed item for the selected Print Target.

Color Adjustment Sheet: ColorColor Adjustment Sheet: Color
If the color tone as printed is not as you expected, you can adjust it on the Color Adjustment sheet.
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Note

• To display the Color Adjustment sheet, on the Main sheet, click Color Settings by Color Mode in Advanced Settings.(See
"Main Sheet →P.182 ")

• ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

• BView Color Pattern
Select this checkbox to display the color pattern.

• CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

• DCyan / EMagenta / FYellow
Fine-tune color tones by adjusting the levels of each color.

• GGray Tone
Adjust the color tone of grays as desired. Choose Cool Black (tinged with blue) or Warm Black (tinged with red).

• HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or
darker than the original image (that is, the original photo that was scanned or the original graphic as it appears on
the computer screen).

• IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Contrast
makes images sharper, and reducing the Contrast softens images.

• JSaturation
Adjust the color intensity as desired. Increasing the Saturation setting makes colors more vivid, and reducing the
Saturation makes colors more subdued.

• KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color
adjustment.

• Object Adjustment Dialog box: Color →P.189
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• SDefaults
Click to restore all settings on the sheet to the default values.

Note

• For details on settings items, see "Adjusting the Color in the Printer Driver →P.54 "

Object Adjustment Dialog box: ColorObject Adjustment Dialog box: Color
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note

• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment sheet.

• A Image
Select this option to apply color adjustment to image areas, such as photos.

• BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

• CText
Select this option to apply color adjustment to text.

Matching SheetMatching Sheet
On the Matching sheet, you can specify color matching to compensate for differences in the appearance of colors on
various devices.

Important

• If No color correction is selected under Color Mode, the Matching sheet is not displayed.

Note

• To display the Matching sheet, on the Main sheet, click Color Settings in Color Mode in Advanced Settings, and then click
the Matching sheet. (Refer to "Main Sheet →P.182 ")
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Driver Matching Mode
The following options are available when you select Driver Matching Mode in the AMatching Mode list.

• AMatching Mode
Select the color matching mode to use, as desired.
Normally, select Driver Matching Mode. For color matching based on ICC profiles, select ICC Matching Mode or
Host ICM Mode, depending on your color matching system.

• BMatching Method
Select the color matching method that suits the document to be printed. Various Matching Method options are
available depending on your selection in Matching Mode.

• CColor Space
Select the applicable color space as desired.

• DMonitor White Point
Enter the color temperature set on the monitor.
Displayed when the BMatching Method is set to Monitor Matching.

• EGamma
You can adjust the gradation of intermediate tones in an image.
2.2 is normally selected. If you want a softer impression than 2.2, select 1.8.
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ICC Matching Mode and Host ICM Mode
The following options are available when you select ICC Matching Mode or Host ICM Mode in the AMatching Mode
list.

• AMatching Mode
Select the color matching mode to use, as desired.

• B Input Profile Settings
You can select Image, Graphics, or Text. You can choose Matching Method and Input Profile.
Various options are available depending on your selected Matching Mode.
To apply the same input profile automatically for Graphics and Text, select Use the Same Profile for All Ob-
jects. To apply separate input profiles to Graphics and Text, clear Use the Same Profile for All Objects and
specify the individual settings.

• CPrinter Profile Settings
Specify the printer profile as desired. Normally, select Auto Settings.
We recommend that you select an ICC profile created using commercially available profile creation software in or-
der to perform color management accurately on paper other than genuine Canon paper and feed confirmed paper.
The created ICC profile needs to be saved in the following folder on the computer you are using.
C:Windows\system32\spool\drivers\color folder

Note

• C: may vary according to the user environment.

Note

• For details on settings items, see "Adjusting the Color in the Printer Driver." →P.54
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Color Adjustment Sheet: MonochromeColor Adjustment Sheet: Monochrome
On the Color Adjustment sheet for monochrome printing, you can adjust the brightness and contrast.

Note

• To display the Color Adjustment sheet, on the Main sheet, click Color Settings by Color Mode in Advanced Settings.(See
"Main Sheet →P.182 ")

• ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

• BView Color Pattern
Select this checkbox to display the color pattern.

• CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

• DCyan / EMagenta / FYellow
Not available.

• GGray Tone
Not available.

• HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or
darker than the original image (that is, the original photo that was scanned or the original graphic as it appears on
the computer screen).

• IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Contrast
makes images sharper, and reducing the Contrast softens images.

• JSaturation
Not available.

• KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color
adjustment.

• Object Adjustment Dialog box: Monochrome →P.193
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• SDefaults
Click to restore all settings on the sheet to the default values.

Note

• For details on settings items, see "Adjusting the Color in the Printer Driver →P.54 "

Object Adjustment Dialog box: MonochromeObject Adjustment Dialog box: Monochrome
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note

• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment sheet.

• A Image
Select this option to apply color adjustment to image areas, such as photos.

• BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

• CText
Select this option to apply color adjustment to text.
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Gray Adjustment SheetGray Adjustment Sheet
On the Gray Adjustment sheet, you can adjust the color balance, brightness, contrast, and other image qualities.

Note

• To display the Gray Adjustment sheet, on theMain Sheet →P.182 , select Monochrome (Photo) by Color Mode in Ad-
vanced Settings, and then click Color Settings.

• Monochrome (Photo) is not available for all types of paper.

• ASample Type
The image at left is updated to reflect any changes you make to setting items on the sheet, enabling you to check
the results of adjustment.

• BSample List
Select a sample image, as desired.

• CColor Balance
Click the list to select a color balance that suits the printing application.

• DX / EY
Adjust the color balance as you check the color tone in the adjustment area.
You can adjust the square area in the center by clicking or dragging it.
Drag the vertical or horizontal scroll bars for adjustment, as desired.
You can click the arrows by the DX (horizontal) and EY (vertical) boxes or enter the values directly.

• JTone
You can adjust the brightness of intermediate tones in an image. Selecting Hard tone gives a hard impression
with more definition. Selecting Soft tone gives a soft impression.

• FBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or
darker than the original image (that is, the original photo that was scanned or the original graphic as it appears on
the computer screen).

• GContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Contrast
makes images sharper, and reducing the Contrast softens images.
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• HHighlight
Adjust the brightness of the lightest portion.

• IShadow
Adjust the brightness of the darkest portion.

• SDefaults
Click to restore all settings on the sheet to the default values.

Page Setup SheetPage Setup Sheet
The following settings are available on the Page Setup sheet. For details on settings items, refer to the printer driver
help file.

• APage Size
Select the page size as specified in the source application.
For details on available page sizes, see "Paper Sizes →P.522 "

• BBorderless Printing

Borderless printing is available if roll paper is selected in the LPaper Source list. Choose from the following op-
tions when this setting is activated.

• Borderless Printing on Paper of Equivalent Size →P.95
• Borderless Printing by Resizing Originals to Fit the Roll Width →P.101
• Borderless Printing at Actual Size →P.89

• DFit Paper Size
Scales the document image to match the paper size.
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• EScale to fit Roll Paper Width
Scales the document image to match the roll width.

• FPrint Image with Actual Size
Prints documents at their actual size. This function is available when you have selected the size same as the width
of Roll Paper for either the length or width of the document from the APage Size list.

• GPaper Size
Available when DFit Paper Size is selected.
Choose the size of the paper you will print on.
For details on available paper sizes, see "Paper Sizes →P.522 "
Paper sizes compatible with borderless printing are shown in the list.

• CEnlarged/Reduced Printing

Choose from the following options when this setting is activated.

• Resizing Originals to Match the Paper Size →P.68
• Resizing Originals to Fit the Roll Width →P.72
• Resizing Originals by Entering a Scaling Value →P.78

• DFit Paper Size
Scales the document image to match the paper size.

• EFit Roll Paper Width
Scales the document image to match the roll width.

• FScaling
Resizes the document image based on a specified scaling value. Enter a value in a range of 5–600.

• GPaper Size
Choose the size of the paper you will print on.
For details on available paper sizes, see "Paper Sizes →P.522 "

• HOrientation
Choose the printing orientation.

• Making the Original Orientation Match the Paper Orientation →P.162

• KRotate Page 90 degrees (Conserve Paper)
Activate this setting to rotate the document image by 90 degrees before printing.

• Conserving Roll Paper by Rotating Originals 90 Degrees →P.148

• LPaper Source
Choose the feed source, as desired.
Options displayed in the list vary depending on the selection in Media Type on the Main sheet.

• MRoll Paper Width
Choose the roll width.
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For details on available roll widths, see "Paper Sizes →P.522 "

• NRoll Paper Options
Complete optional roll paper settings. Click to display the Roll Paper Options dialog box.

Under AAutomatic Cutting, you can specify Yes or No and Print Cut Guideline.

• Cutting Roll Paper After Printing →P.167

Select BBanner Printing when printing multiple pages continuously.

• Printing Multiple Pages Continuously →P.125

• POutput Method
Click to display the Output Method dialog box, which enables you to complete the Output Method and Name of
data to be saved settings.

• Output Method Dialog box →P.198

• OSize Options
Click to display the Paper Size Options dialog box, which enables you to register additional paper sizes or select
the size system for use.

• Paper Size Options Dialog Box →P.199

• SDefaults
Restores all settings on the sheet to the default values.
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Output Method Dialog boxOutput Method Dialog box
The Output Method dialog box allows you to select the Output Method and set the save settings when saving to the
box.

Note

• To display the Output Method dialog box, on the Page Setup sheet, click Output Method. (Refer to "Page Setup
Sheet →P.195 ")

• AOutput Method
If Print is selected, the print job is saved to the printer hard disk after printing has finished.
If Save in mail box is selected, the print job is saved to the printer hard disk. If you choose Save in mail box, also
specify the destination personal box in the Mail box list.
If Print after reception is complete is checked, you can prevent degradation of print quality that occurs when
receiving a print job is interrupted and printing is aborted in the middle.
These can be selected as Print options.

• BName of data to be saved
To use the file name, choose Use file name.
Otherwise choose Enter name and enter a name in Name.

• CMail box
Displays a list of mail boxes. If you choose Save in mail box, also specify the destination personal box from the
list.

• DAcquire Mail Box Name
When this is clicked, the box name acquired from the printer main unit is displayed in Mail box.
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Paper Size Options Dialog BoxPaper Size Options Dialog Box
In the Paper Size Options dialog box, you can create and register your own Custom Paper Size. The sizes you define
are listed with standard paper sizes for selection later as needed.

Important

• You cannot create any arbitrary roll paper width as a Custom Paper Size.

• If you select a Paper Size from Paper Size Options, load paper of a size equal to or larger than the Paper Size Options
into the printer. If the size of the loaded paper is smaller than the Paper Size Options, an incomplete output image may be
printed.

Note

• To display the Paper Size Options dialog box, on the Page Setup sheet, click Paper Size Options. (See "Page Setup
Sheet.") →P.195

• APaper Size List
Shows the names and sizes of paper that can be used with the printer driver.

• BDelete
Custom paper sizes created by users can be deleted from the APaper Size List, as needed.
However, they cannot be deleted in the following situations.

• If a standard paper size of the printer driver is selected.
• If an oversized paper size is selected.
• If a paper size marked with a red circle is selected.

• CCustom Paper Size Name
You can name Custom Paper Size as desired.

• DUnits
Specify the desired unit of measure for the Custom Paper Size height and width.

• EPaper Size
Specify the desired Width and Height. You can make your selection from sizes that are compatible with Border-
less Printing by selecting Borderless Printing Size. To maintain the aspect ratio of the Width and Height as you
resize the paper, select Fix the Ratio of the Width to Height.

• FAdd
Enables you to register the custom paper size you have specified or overwrite an existing custom paper size.

• GDisplay Series
You can limit the number of options shown in Page Size, Paper Size, and Paper Size List.
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Layout SheetLayout Sheet
The following settings are available on the Layout sheet. For details on settings items, refer to the printer driver help.

• APage Layout
Activate this setting to select a particular page layout.

• Printing Multiple Pages Per Sheet →P.129
• Printing Posters in Sections →P.134
• Printing Multiple Originals Next to Each Other →P.121
• Using PosterArtist to Compose Originals →P.52

• BSet
Click to display one of the following dialog boxes depending on the selection in APage Layout. In these dialog
boxes, you can specify layout details and which pages to print, as well as other settings.

• Page Layout Printing
• Pages to Print
• Free Layout Settings

• CWatermark
Activating this option makes two settings available, Watermarks and DEdit Watermark.

• Printing With Watermarks →P.159

• Watermarks
Lists the provided watermarks. Choose the watermark to print.

• DEdit Watermark
Click to display the Edit Watermark dialog box for creating your own, original watermark.

• EPrint Centered
Activate this setting to print document images in the center of the paper.

• Printing Originals Centered on Rolls →P.138
• Printing Originals Centered on Sheets →P.143

• FRotate 180 degrees
Activate this option to rotate document images by 180 degrees before printing.

• GNo Spaces at Top or Bottom (Conserve Paper)
Activate this setting to print the next image skipping blank areas above and below printable data in documents,
which enables you to conserve the paper.
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• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins →P.152

• HCopies
Enter the number of copies to print, in a range of 1–999.

• Reverse Order
Activate this option to print pages in reverse order.

• IPage Options
Click to display the Page Options dialog box, which enables you to complete settings for printing the user name,
date, or page number in the header or footer.

• Page Options Dialog Box →P.201

• JSpecial Settings
If the printing results are not as you expected, click this option to change how printing is processed.

• Special Settings Dialog Box →P.202

• SDefaults
Click to restore all settings on the sheet to the default values.

Page Options Dialog BoxPage Options Dialog Box
The Page Options dialog box offers the following settings.

Note

• To display the Page Options dialog box, on the Layout sheet, click Page Options.(See "Layout Sheet →P.200 ")

• APrint Date
Select where the date is printed, as desired. To print the time as well, select BPrint Time Also.

• CPrint User Name
Select where the user name is printed, as desired.

• DPrint Page Number
Select where the page number is printed, as desired.
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• EFormat Settings
Click to display the Format Settings dialog box, which enables you to complete format-related settings.

Note

• If you specify the same position for multiple items, the items are printed from left to right in this order: date, user name,
and page number.

• When you print multiple pages per sheet using Page Layout Printing or similar functions, these items will be printed for
each page.

Special Settings Dialog BoxSpecial Settings Dialog Box
If the printing results are not as you expected, you can change how printing is processed in the Special Settings dia-
log box.

Note

• To display the Special Settings dialog box, on the Layout sheet, click Special Settings. (See "Layout Sheet.") →P.200

• Click the processing method for Parameter within the Settings Summaries frame to display a list of the setting details under
the frame.

• ASpooling at Printer Driver
Sets whether or not print jobs are spooled in the printer driver and processed by PageComposer.
Printing results may be improved in some cases by setting this to No or No (EMF Spooling).

Note

• When set to No or No (EMF Spooling), functions such as Page Layout, Watermark, Reverse Order, Page Options,
FineZoom Settings, and Preview Switching can no longer be used.

• BFineZoom Settings
This function is used in large-format printing.
If it is set to Yes, problems in the printing may be improved.
If it is set to No, image distortions such as fine lines disappearing may be improved.

• CPreview Switching
When this setting is turned on, PageComposer starts when printing is performed with the Open Preview
When Print Job Starts check box selected in the Main sheet.
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• DApplication Color Matching Priority
When this is on, you can give applications priority in color management.

• EFast Graphic Process
Turning this setting on may help produce the expected results if image colors are inconsistent in printed docu-
ments or if lines are printed in varying thicknesses.

Note

• This function cannot be used on 64-bit version of Windows.

• FExtend print pass
Uneven printing that occurs when printing with Highest selected in Print Quality may be improved in some cases
by turning this setting on. However, this also reduces the printing speed.

Favorites SheetFavorites Sheet
The following settings are available on the Favorites sheet. For details on settings items, refer to the printer driver
help.

• AFavorites
Printing favorites you have created are listed with Default Settings favorites.

• Using Favorites →P.166

• BSettings Details
Displays details of the favorite selected in the AFavorites.

• CComment
Displays notes registered in the favorite.

• DApply Favorite
Click to change the current print settings to those of the favorite selected in the AFavorites.

• EApplication Settings Priority
Activate this setting to use settings values specified in the source application in preference to favorite settings se-
lected in the AFavorites, when clicking DApply Favorite. For details on the settings items used in preference,
refer to the printer driver help.
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• FDelete
Click to delete the selected favorite from the AFavorites list.

• GEdit
Click to display the Edit dialog box, which enables you to change the name and icon for the favorite selected in the
AFavorites list.

• HAdd
Click to display the Add dialog box, which enables you to add the current print settings as a favorite.

• I Import
Click to display the Open dialog box, which enables you to import favorite settings saved as a file.

• JExport
Click to display the Save As dialog box, which enables you to save the favorite settings as a file.

• KUp
Click to move the selected favorite up in the AFavorites list.

• LDown
Click to move the selected favorite down in the AFavorites list.

Utility SheetUtility Sheet
The following items can be executed on the Utility sheet. For details on the utilities, refer to the relevant utility help.
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• AMaintenance
Click to start the imagePROGRAF Status Monitor, which offers the following maintenance for the printer.

• Nozzle (ink ejecting outlet) check
• Nozzle (ink ejecting outlet) cleaning
• Head alignment adjustment
• Feed amount adjustment

• BColor imageRUNNER Enlargement Copy
Click to launch Color imageRUNNER Enlargement Copy (iR enlargement copy), which enables you to create hot
folders used for Color imageRUNNER Enlargement Copy and assign print settings to hot folders.

• Printing Enlargements of Scanned Originals from a Color imageRUNNER →P.249

For details, see Color imageRUNNER Enlargement Copy →P.240 .

Support SheetSupport Sheet
On the Support sheet, you can view support information and the user's manual.

• ASupport Information
Click to access the Canon support webpage, where you can find the latest information on the printer and consum-
ables, check for printer driver updates, and browse other information.

• BUser Manual
Click to view the printer user's manual. This function requires the user's manual to be installed on your computer.

• CSettings Summaries
Click to display the View Settings dialog box, which enables you to confirm the settings for the Main, Page Set-
up, Layout, and Favorites sheets.
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Settings Summaries Dialog BoxSettings Summaries Dialog Box
The Settings Summaries dialog box enables you to confirm the settings for the Main, Page Setup, Layout, and Fa-
vorites sheets.

• ACopy
Click to copy the settings information to the clipboard. You can paste the settings information into a file created
with a text editor or similar application.

Device Settings SheetDevice Settings Sheet
Many settings items on the printer properties sheets are controlled by Windows applications. However, the Device Set-
tings sheet is for configuring the printer, and it is an extension of the printer driver.
The following settings are available on the Device Settings sheet.

• AAbout
You can display version information for the printer driver.
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The Features of PreviewThe Features of Preview
The main features of Preview are as follows.

• While viewing this screen, you can adjust layout settings of a document created with application software.

• You can not only adjust layout settings but also your changes will be instantly applied on the preview screen, and
you can print the preview screen as it is seen.

Note

• The media type, image size, detailed media settings, and the printer settings can cause the actual print output to differ from
the Preview settings.

Starting PreviewStarting Preview
Follow the procedure below to start the Preview.

1 Start the apllication software which you use.

2 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note

• Normally, select Print from the File menu.

3
 

On the Main sheet, click on the Open Preview When
Print Job Starts check box.
Click the OK button to save the settings.
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Note

• Your printer is depicted in the lower-left area of this screen.

4 On the Print dialog box in the apllication software, click the Print button.

5
 

Preview main window is displayed.

Preview Main WindowPreview Main Window
The Preview main window consists of the menu and tool bars, preview and dialog area and status bar.

Note

• You can use the View menu to show or hide the tool bar.

• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.
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• Preview Area
You can check the settings you made in this area.

• Dialog Area
This allows you to set the print conditions and perform a print job.
For more information about Dialog Area, see "Dialog Area." →P.210

• Status Bar
This shows the message, Pages and Output Size.

iPF9400                                                                                                                                                                                                          Preview Main Window

User's Guide                                                                                                                                                                                                                                       

  

W
indow

s Softw
are

Preview

209  



Dialog AreaDialog Area
You can select the layout and print on the center.

• Media Type / Paper Source /Paper Size
You can confirm the information that is set.

• Layout Selection
You can print which conserves paper by selecting the layout.
For more information about Layout Selection, see "Printing with Selecting the Layout." →P.213

• Center Originals Across Roll
You can print on the center of the media loaded in the printer.
For more information about Center Originals Across Roll, see "Print on the Center." →P.215

Note

• Available only if rolls are selected in Paper Source.

• No Spaces at Top or Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top
or bottom.
For more information about No Spaces at Top or Bottom, see "Not Print Spaces at the Top/Bottom." →P.216

Note

• Available only if rolls are selected in Paper Source.

• Print Button
Click the button to start printing.
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• Cancel Button
Click the button to stop printing.

• Printer Information
You can confirm the information acquired from the printer.

• Update Printer Information Button
Click the button to update the printer information with connecting to the printer.

• Status Monitor Button
Click the button to start Status Monitor.

Enlarge/Reduce the screen displayEnlarge/Reduce the screen display
You can enlarge or reduce the screen display when you select Zoom from the View menu.

Setting Details
Fit Screen Display all.

Fit to Width Display to the width of the paper.

Reduce Display at half of the standard size.

Standard Display at the standard size.

Enlarge Display with the double of the standard size.

Enlarge More Display with the triple of the standard size.

Note

• This item can be selected even if you have clicked the ▼ button in the toolbar Zoom.

Moving a PageMoving a Page
You can move a page to display when you select Go to Page from the View menu.

Setting Details
First Page Go to the first page.

Previous Page Go to the previous page.

Next Page Go to the next page.

Last Page Go to the last page.

Go To Page Go to the specified page.

Note • You can also move a page by clicking  on the tool bar.

Using the rulerUsing the ruler
You can confirm the layout with using the ruler.

• Switching the ruler Show/Hide
In the View menu, select Ruler to switch the ruler Show/Hide.
 

• Changing the ruler unit
You can set the ruler unit when you select Units from the View menu.

Setting Details
mm Use mm as the ruler unit.
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Setting Details
inch Use inches as the ruler unit.

Priority setting for rotating 90 degreesPriority setting for rotating 90 degrees
You can select Rotate 90 Degrees If Possible or Use Driver Settings from the Options menu.

Setting Details
Rotate 90 Degrees If Possible Rotates pages in portrait orientation 90 degrees before printing. Pages are only rotated if they can

fit lengthwise across the roll.

Use Driver Settings Follows printer driver settings when determining whether to rotate pages.

Selecting Rotate 90 Degrees If Possible or Placing a checkmark for Rotate Page 90 degrees (Conserve Paper) on
the printer driver

Selecting Use Driver Settings
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Printing with Selecting the LayoutPrinting with Selecting the Layout
You can print which conserves paper by selecting the layout.

1
 

In Layout Selection, click the layout button to use.

Button Details
Upper Button

Turn at the position of .

Right Button

Turn at the position of .

Left Button

Turn at the position of .

Lower Button

Turn at the position of .
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Note

• Right Button or Left Button can be selected only when the rotated pages can fit lengthwise across the roll.

• By clicking Right Button or Left Button, you can save paper by printing in landscape orientation on roll paper.

• You can select only Upper Button or Lower Button if Cut
Sheet is selected.

 

Button Details
The button is selected currently.

The button can be selected.

The button can not be selected.

2 Click the Print Button.
 

Printing on the selected layout begins.
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Print on the CenterPrint on the Center
You can print on the center of the media loaded in the printer.

1
 

Click the Center Originals Across Roll check box on.

2 Click the Print button
 

Printing on the center begins.

Note

• Available only if rolls are selected in Paper Source.

 

iPF9400                                                                                                                                                                                                               Print on the Center

User's Guide                                                                                                                                                                                                                                       

  

W
indow

s Softw
are

Preview

215  



Not Print Spaces at the Top/BottomNot Print Spaces at the Top/Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top or
bottom.

1
 

Click the No Spaces at Top or Bottom check box on.

2 Click the Print button.
 

Printing on the settings with no spaces at top or bottom begins.
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The Features of Free LayoutThe Features of Free Layout
The main features of Free Layout are as follows.

• Allows you to lay out at will and print a document created with application software.

• You can not only lay out multiple pages on one page but also lay out and print a multiple-file document on one
page, or lay out and print a document created with multiple application programs on one page.

• Any two pages can be arranged and printed in a layout that becomes duplex on folding.
This can be used such as for advertising posters that are suspended from the ceiling.

Note

• The media type, image size, detailed media settings, and the printer settings can cause the actual print output to differ from
the Free Layout settings.

Starting Free LayoutStarting Free Layout
Follow the procedure below to start the Free Layout.

1 Start the apllication software which you use.
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2 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note

• Normally, select Print from the File menu.

3
 

From the list, select the printer and select the Layout
sheet.

Note

• Your printer is depicted in the lower-left area of this screen.

4 In the Layout sheet, click on the Page Layout check box and select Free Layout from the list.
Click the OK button to save the settings.

Note

• When you select Free Layout, all other setting items will be disabled.

5
 

On the Print dialog box in the apllication software, click
the Print button.
Free Layout main window is displayed.
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Free Layout Main WindowFree Layout Main Window
The Free Layout main window consists of the menu and tool bars, layout area and status bar.

Note

• You can use the View menu to show or hide the tool and status bar.

• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.
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• Layout Area
This allows you to lay out objects and edit the object size and orientation.

• Status Bar
This shows the paper size, unit of length, and number of objects.

Detailed SettingsDetailed Settings
The printer driver opens when you select Detailed Settings from the File menu. The printer driver is used to configure
basic settings to match the type of media loaded in the printer.

Refer to Printer Driver →P.172  for details on the printer driver.

Note

• When you select the Detailed Settings, the only three sheets displayed are the Main sheet, the Page Setup sheet, and the
Layout sheet. Some of the printer driver settings may be disabled.
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Preferences Dialog BoxPreferences Dialog Box
This dialog box appears when you select Preferences from the File menu. This allows you to configure the preferen-
ces of Free Layout.

• Units
Set the unit for paper length, margins, and so on.

• Gridlines
You can input a grid line width value in numerical characters so that they serve as a guide to laying out objects.

Note

• You can input between 10.0 and 200.0(mm) (between 0.39 and 7.88(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

• Divisions
You can change the number of divisions of grid lines so that they serve as a guide to laying out objects.

Note

• You can input between 1 and 10.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Grid Color
Select the grid line color.

• Auto Arrange Spacing
Change the object-to-object spacing to be applied in the operation of laying out objects automatically.

Note

• You can input between 0.0 and 100.0(mm) (between 0.00 and 3.94(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

• Object Frame Style
You can select the object frame style for printing.
The following settings are available for the object frame style.

Setting Details
None You can print with no frame style.

Solid Line You can print the solid line as the frame style.

Dotted Line You can print the dotted line as the frame style.

Dashed Line You can print the dashed line as the frame style.
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Setting Details
Crop Marks You can print with the crop marks.

Page Options Dialog BoxPage Options Dialog Box
This dialog box appears when you select Page Options from the File menu. This allows you to configure the roll paper
length, object layout order, and margins of Free Layout.

• Roll Paper Length
Set the length of one page to print on roll paper.
The following settings are available for roll paper length.

Setting Details
Auto Settings The one-page length to be printed on roll paper is automatically set so that the laid-out objects

are printed on one page.

Manual Settings You can input the length of one page to print on roll paper in numerical characters.

Note

• Available only if rolls are selected in Paper Source.
• You can input between 203.2 and 18000.0(mm) (between 8.00 and 708.66(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

• Order
Set the object layout order.
The following settings are available for order.

Setting Details
Upper Left to Right The objects are laid out from upper left to right.

Upper Left to Bottom The objects are laid out from upper left to bottom.

Upper Right to Left The objects are laid out from upper right to left.

Lower Left to Top The objects are laid out from lower left to top.
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Note

• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Vertical, you can choose Up-
per Left to Right or Upper Right to Left.

• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Horizontal, you can choose
Upper Left to Bottom or Lower Left to Top.

• Margins
You can input the paper margins in numerical characters.

Note

• You can input between 0.0 and 50.0(mm) (between 0.00 and 1.97(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Zoom Dialog BoxZoom Dialog Box
This dialog box appears when you select Zoom from the View menu. You can enlarge or reduce the screen display.

• Scaling
Set the magnification for enlargement or reduction of the screen display.

Note

• You can input between 25 and 400.
• You can change the numbers by clicking ▼ button.

Format Dialog BoxFormat Dialog Box
This dialog box appears when you select Format from the Object menu after you select an object.

Size Sheet
You can rotate, enlarge, or reduce an object.
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Note

• When the objects are not selected, you can not select Format.

• Rotate
When you place a checkmark here, you can select Rotate Right or Rotate Left.

Setting Details
Rotate Right Rotates the object 90 degrees clockwise.

Rotate Left Rotates the object 90 degrees counterclockwise.

Note

• When several objects are selected, you cannot select Rotate.

• Enl./Red.
When you place a checkmark here, you can select Scaling, Fit Paper Size, or Fit Photo Size.

Setting Details
Scaling Allows you to input the value of the enlargement or reduction ratio of an object.

Fit Paper Size Prints by enlarging or reducing each object to match the paper size. If you are using roll paper,
objects are enlarged or reduced so that the width of each object matches the width of the roll
paper.

Fit Photo Size Prints all of the objects at the specified photo size.

Note

• You can input between 25 and 600.
• You can change the numbers by clicking either ▲ button or ▼ button.

Position Sheet
You can rotate, enlarge, or reduce an object.

Note

• When the objects are not selected, you can not select Format.
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• Object Position
You can move the object position by changing the values.

Setting Details
Vertical Pos You can input the number of the vertical position in numerical characters.

Horizontal Pos You can input the number of the horizontal position in numerical characters.

Page Pos You can input the number of the page position in numerical characters.

• Object Size
You can confirm the object size.

Note

• When several objects are selected, you cannot display Object Size.

Laying out a Multiple-File Document on One PageLaying out a Multiple-File Document on One Page
You can lay out and print a multiple-file document on one page.

1 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note

• Normally, select Print from the File menu.

2
 

Click Properties to open the Properties dialog box.
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3
 

In the Page Setup sheet, select Paper Source.

Note

• Your printer is depicted in the lower-left area of this screen.

4
 

In the Layout sheet, click on the Page Layout check
box and select Free Layout from the list.

Note

• Your printer is depicted in the lower-left area of this screen.
• When you select Free Layout, all other setting items will be disabled.

5 Click the OK button to save the settings.
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6
 

In the Print dialog box, select the pages to print and the
number of copies, and click the OK button.

Free Layout starts, laying out the document created
with application software in the layout area as an ob-
ject.

7 Leaving Free Layout running, open other files with the application software and repeat the above steps.

Laying out a Document Created with Multiple Application Programs on One PageLaying out a Document Created with Multiple Application Programs on One Page
You can lay out and print a document created with multiple application programs on one page.

1 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note

• Normally, select Print from the File menu.
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2
 

Click Properties to open the Properties dialog box.

3
 

In the Page Setup sheet, select Paper Source.

Note

• Your printer is depicted in the lower-left area of this screen.
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4
 

In the Layout sheet, click on the Page Layout check
box and select Free Layout from the list.

Note

• Your printer is depicted in the lower-left area of this screen.
• When you select Free Layout, all other setting items will be disabled.

5 Click the OK button to save the settings.

6
 

In the Print dialog box, select the pages to print and the
number of copies, and click the OK button.
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Free Layout starts, laying out the document created
with application software in the layout area as an ob-
ject.

7 Leaving Free Layout running, open other files with other application software and repeat the above steps.

Selecting an ObjectSelecting an Object
When an object is selected, a select box (blue border) appears around the object.
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Note

• To select an object, click that object.
• To select multiple successive objects, click them while holding down the Shift key.
• To select multiple arbitrary objects, click them while holding down the Ctrl key.
• To select all objects, select Select All from the Edit menu.

• When you specify the area with dragging the mouse, the object in the area is selected.

Changing the Object SizeChanging the Object Size
You can change the object size by means of mouse operation or by specifying a scaling value.

Note

• The vertical-to-horizontal ratio remains unchanged when the object is enlarged or reduced.

Resizing by means of mouse operation

1 Select an object.

2
 

Place the pointer at a corner of the selection box
around the object to show the arrow handle, and drag
this handle to change the object size.

Resizing by specifying a scaling value

1 Select an object.
Click on the Enl./Red. checkbox in the Format Dialog Box →P.223  and select Scaling.

2 You either enter numbers directly.

Note

• You can input between 25 and 600.
• You can change the numbers by clicking either ▲ button or ▼ button.

3 Click the OK button.
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Moving an ObjectMoving an Object
You can move the object position.

1 Select an object.

2
 

Place the pointer inside the selection box of the object
to show the crosshair handle, and drag it to move the
object.
Alternatively, you can move the Object Position by
changing the values in Vertical Pos, Horizontal Pos
and Page Pos in the Format Dialog Box →P.223 .

Rotating an ObjectRotating an Object
You can rotate the object.

1 Select an object.

2
 

Select Rotate Left 90 Degrees or Rotate Right 90 De-
grees from the toolbar.
Alternatively, you may click on the Rotate check box in
the Format Dialog Box →P.223  then select Rotate
Right or Rotate Left, and click the OK button.

Laying out Objects AutomaticallyLaying out Objects Automatically
Click Auto Arrange Object in the tool bar. This automatically lays out objects. Alternatively, you may select Auto Ar-
range Object from the Object menu.
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Note

• The object layout order varies depending on the Order setting in the Page Options Dialog Box →P.222  dialog box.

Aligning ObjectsAligning Objects
You can align objects systematically.

1 Select multiple objects.

2 Click the align button from the toolbar.
Alternatively, you may select the align menu from the Object menu.

• Align Top
Lays out the objects, justifying them to the top.

• Center Vertically
Lays out the objects, justifying them to the vertical
center.

• Align Bottom
Lays out the objects, justifying them to the bottom.
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• Align Left
Lays out the objects, justifying them to the left.

• Center Horizontally
Lays out the objects, justifying them to the horizon-
tal center.

• Align Right
Lays out the objects, justifying them to the right.

Changing the Object Overlapping OrderChanging the Object Overlapping Order
You can change the object overlapping order.

1 Select an object.

2 Select the Overlapping Order menu from the Object menu.

Note

• The order of overlapping affects the order of objects automatically laid out.
• You can also select by clicking the right button of the mouse on an object.
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• Bring to Front
Moves the object to the frontmost position.

• Send to Back
Moves the object to the backmost position.

• Bring Forward
Moves the object one position to the front.

• Send Backward
Moves the object one position to the back.
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Pasting a Copied or Cut ObjectPasting a Copied or Cut Object

1 Click Copy or Cut from the toolbar.
Alternatively, you may select Copy or Cut from the Edit menu.

2 Click Paste from the toolbar.
Alternatively, you may select Paste from the Edit menu.

Note

• The copied or cut object is laid out at the end of the page.
• You can also select by clicking the right button of the mouse on an object.

• In order to paste an object on any position that you like, you can paste the object with Pointed Paste by clicking the right
button of the mouse on any position that you want.

Folded Duplex WindowFolded Duplex Window
This window is displayed if you select Folded Duplex from the Edit menu after selecting an object. Using the Folded
Duplex function allows you to print with fold lines added.
The Folded Duplex window consists of the menu and tool bars, layout area and status bar.

Note

• The toolbar and status bar can be toggled between hidden and displayed from the View menu.

• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.
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• Layout Area
This allows you to check the arrangement and orientation of objects.

• Status Bar
This shows the paper source, roll paper width, and output size.

Finished Size Settings Dialog BoxFinished Size Settings Dialog Box
This dialog box is displayed when you select Finished Size Settings from the Edit menu. This allows you to configure
finished size settings.

• Finished Size
Selects the method for setting the finished size.
The following settings are available for the finished size.

Setting Details
Fit Roll Paper Width Prints by automatically enlarging or reducing the entire document so that the width of the docu-

ment matches the roll paper width.

Specify Folded Size Prints by automatically enlarging or reducing the entire document to match the size of the paper.
Select the actual size of the paper you want to print on in Fit Paper Size.

Rotate Page 90 degrees (Conserve
Paper)

Prints by rotating pages by 90 degrees. Pages are automatically rotated if they will fit within the
roll paper width when rotated, and are not rotated if they will not fit within the roll paper width.
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Binding Settings Dialog BoxBinding Settings Dialog Box
This is displayed when you select Binding Settings from the Edit menu. This allows you to configure the binding edge
settings.

• Binding Edge
Configures the binding edge when folding paper.
The following settings are available for the binding edge.

Setting Details
Bottom Prints by placing the binding margin (gutter) at the bottom of the document.

Top Prints by placing the binding margin (gutter) at the top of the document.

• Binding
Configures the binding margin (gutter).
Prints by creating a binding margin (gutter) of the specified size. Enter the margin size as a number.

Note

• The values that can be entered are 0 to 50 (mm).

• Print Fold Lines
Configures the color and type of fold lines.

Note

• To not print fold lines, clear the Print Fold Lines checkbox.

• Fold Line Color
You can select the fold lines.

• Fold Line Type
You can select the fold lines.
The following settings are available for the fold line type.

Setting Details
Solid Line You can print the solid line as the frame style.

Dotted Line You can print the dotted line as the frame style.

Dashed Line You can print the dashed line as the frame style.

• Only Print Center and Edges
To print fold lines at the center and both edges, select the Only Print Center and Edges checkbox.
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Prints using Folded DuplexPrints using Folded Duplex
This prints 2 pages consecutively. Folding back the paper at the fold lines of the center substitutes for duplex printing.

1 Select two objects from the layout area of Free Layout.

2 Select Folded Duplex from the Edit menu of Free Layout.
Open the Folded Duplex window and arrange the selected objects in the layout area.

3 Open the Finished Size Settings dialog box from the Edit menu.

4 Select Fit Roll Paper Width or Specify Folded Size in Finished Size.

Note

• Rotate Page 90 degrees (Conserve Paper) is also available when Specify Folded Size is selected.

5 Click OK to save the settings.

6 Open the Binding Settings dialog box from the Edit menu.

7 Select Bottom or Top in Binding Edge.

8 Specify the Binding width in Binding.

9 Configure the Fold Line Color and Fold Line Type from Print Fold Lines.

Note

• When the Only Print Center and Edges checkbox is selected, fold lines are only printed at the three locations of the
center and both edges.

10 Click OK to save the settings.

11 Confirm the print setting and begin printing.
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The Features of Color imageRUNNER Enlargement CopyThe Features of Color imageRUNNER Enlargement Copy
The main features of Color imageRUNNER Enlargement Copy are as follows.

• Allows the document scanned with the Color imageRUNNER to be automatically enlarged and printed.

• You can perform basic printer settings such as printer selection, media type and output profile selection, and
matching methods, in addition to borderless printing and enlargement/reduction process without growing through
the printer driver.

Note

• The media type, image size, detailed media settings, and the printer settings can cause the actual print output to differ from
the Color imageRUNNER Enlargement Copy settings.

Starting Color imageRUNNER Enlargement CopyStarting Color imageRUNNER Enlargement Copy
Follow the procedure below to start the Color imageRUNNER Enlargement Copy.

To start by selecting Printers and Faxes from the start button

1 Open the folder of the OS you are using for configuring printers.
For example, on Windows XP click the start button on the desktop, and then select Printers and Faxes.

2
 

Right-click the Printers icon and select Printing Prefer-
ences to open the Printing Preferences dialog box.
In the Utility sheet, click the Color imageRUNNER En-
largement Copy button.
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3
 

The Color imageRUNNER Enlargement Copy dialog
box displays.

Note

• If you click on the Add to Startup folder check box in the Color imageRUNNER Enlargement Copy dialog box, the icon of
Color imageRUNNER Enlargement Copy utility will appear on the task bar when starting Windows thereafter.

To start by selecting Color imageRUNNER Enlargement Copy from the start button

1
 

From the Windows start button, select Color image-
RUNNER Enlargement Copy.

2
 

The Color imageRUNNER Enlargement Copy dialog
box displays.

Color imageRUNNER Enlargement Copy Dialog BoxColor imageRUNNER Enlargement Copy Dialog Box
The explanation below is on the Color imageRUNNER Enlargement Copy dialog box.

 

 

 

iPF9400                                                                                                                                       Color imageRUNNER Enlargement Copy Dialog Box (Windows)

User's Guide                                                                                                                                                                                                                                       

  

W
indow

s Softw
are

C
olor im

ageR
U

N
N

ER
 Enlargem

ent C
opy

241  



Note

• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color imageRUNNER Enlarge-
ment Copy." →P.240

• Hot Folder
The hot folder list appears.

• Add Button
Click the button to open the Easy Setup Wizard dialog box so that you can add a hot folder.

• Edit Button
From the Hot Folder list, select a hot folder and click the button to open the Add/Edit Hot Folder dialog box that
allows you to edit the hot folder.

• Delete Button
From the Hot Folder list, select a hot folder and click the button to delete the hot folder.

• Start Button
Clicking the button changes the status of the selected inactive Hot Folder to active.

• Stop Button
Clicking the button changes the status of the selected active Hot Folder to inactive.

• Add to Startup folder
Register the application in the Windows startup menu.

• Save Printed Data
Automatically saves printed data.

• About Button
Click the button to display the name and the version number of the utility.

• Operation Guide Button
Click the button to display the Color imageRUNNER Enlargement Copy Setup Manual.

Hot FolderHot Folder
Hot folder refers to a folder used for Color imageRUNNER Enlargement Copy.

• When transferred to the PC's hot folder, the document data scanned with the Color imageRUNNER is printed in
enlarged size from the printer according to the print conditions set in the hot folder.

• You can create a new hot folder, edit or delete an existing one, and set print conditions at will.

Note

• You can create up to 20 hot folders.
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Creating a New Hot FolderCreating a New Hot Folder

1
 

Open the Color imageRUNNER Enlargement Copy
dialog box, and then click the Add button.

Note

• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color imageRUNNER
Enlargement Copy." →P.240

2
 

The Easy Setup Wizard dialog box displays.
Click the Next button.

3
 

Select the type of printer to use.
Click the Next button.
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4 Select the media type to print.

Note

• If the Borderless Printing checkbox is checked, only media types that can be used for borderless printing are dis-
played in the list.

Click the Next button.

5
 

Select roll paper or cut sheet to print. Also, select the
media size to print.
Click the Next button.

6
 

Select the color matching method.
Click the Next button.
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7 To receive a document scanned with the Color imageRUNNER, you need to share a folder. Enter the folder
shared name in Shared Name.
Click the Next button.

Note

• This shared name is used as the name of the hot folder.
• You cannot use the Back button, after clicking the Next button here.

8
 

Click Finish button to close the Easy Setup Wizard di-
alog box.
 

The hot folder you have created appears in the Hot
Folder list in the Color imageRUNNER Enlargement
Copy dialog box.
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Specifying an Existing Shared Folder as a Hot FolderSpecifying an Existing Shared Folder as a Hot Folder

1 Share the folder you want to specify as a hot folder.

2
 

Open the Color imageRUNNER Enlargement Copy
dialog box, and then click the Add button.

Note

• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color imageRUNNER
Enlargement Copy." →P.240

3
 

The Easy Setup Wizard dialog box displays.
Click the Manual Settings button.

 

 

Specifying an Existing Shared Folder as a Hot Folder (Windows)                                                                                                                                      iPF9400

                                                                                                                                                                                                                                       User's Guide

  

W
indow

s Softw
are

C
olor im

ageR
U

N
N

ER
 Enlargem

ent C
opy

 246



4
 

The Add/Edit Hot Folder dialog box displays.
Enter the hot folder name in Name.
Click the Browse botton, with selecting Specify a fold-
er, to set the existing shared folder.

5
 

The location of the folders will appear.
Select the folder to specify a hot folder, and click the OK
button.
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6
 

As necessary, set the print conditions in the hot folder.
 (See "Setting the Print Parameters.") →P.249
Click the OK button to close the Add/Edit Hot Folder
dialog box.
 

The hot folder you have created appears in the Hot
Folder list in the Color imageRUNNER Enlargement
Copy dialog box.
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Setting the Print ParametersSetting the Print Parameters
The printer driver opens when you click the Properties button in the Add/Edit Hot Folder dialog box. The printer driv-
er is used to configure basic settings to match the type of media loaded in the printer.

Refer to Printer Driver →P.172  for details on the printer driver.

Note

• The only three sheets displayed are the Main sheet, the Page Setup sheet, and the Layout sheet. Some of the printer driver
settings may be disabled.

• Apply Sharpness
Place a checkmark here to set the sharpness.
Drag the slider bar to the left or right to adjust. You can also adjust by directly entering a number in the numeric
input field.

Note

• You can input between 0 and 500.
• You can change the numbers by clicking either ▲ button or ▼ button.
• You cannot be applied to PDF files.

Printing Enlargements of Scanned Originals from a Color imageRUNNERPrinting Enlargements of Scanned Originals from a Color imageRUNNER
Scanned originals from a Color imageRUNNER can be enlarged and printed automatically.
Originals you create by scanning with a Color imageRUNNER are transferred to a "hot folder" and printed automatically
after enlargement according to printing conditions you specify for that folder.
This processing sequence is called the Color imageRUNNER Enlargement Copy function.
To use Color imageRUNNER Enlargement Copy, first complete these settings in the following order.

1. Register a hot folder on your computer.
Register a hot folder on your computer for storing scanned originals from the Color imageRUNNER and complete
the settings for enlargement copy. For details, see "Creating a New Hot Folder." →P.243

2. Complete the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder.

After these settings are complete, you can print enlarged copies of scanned originals from the Color imageRUNNER.
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Completing the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder. It is easy to send scanned originals to
the hot folder if you assign the scanning settings and destination to a Favorites button on the Color imageRUNNER.
For instructions on assigning scanning settings and destinations to a Favorites button, refer to the setting manual, dis-
played by clicking Color imageRUNNER Enlargement Copy Setup Manual button of Color imageRUNNER Enlarge-
ment Copy utility, or refer to the Color imageRUNNER manual.

Scanning the original and print an enlargement
Follow the steps below to scan an original on the Color imageRUNNER for enlarged printing on the printer. For detailed
instructions, refer to the Color imageRUNNER manual.

1 Load the original on the platen glass or document feeder of the Color imageRUNNER.

2 Press Send to display the screen for transmission.

3 Press Favorites, and then press the Favorites button assigned to the hot folder.

4 Press Start on the control panel. If you scan originals on the platen glass, after scanning all originals, press
Done on the touch-panel display.
Scanned originals are sent to the hot folder and automatically enlarged and printed following the conditions you
specified for the folder.
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Features of the Print Plug-In for Photoshop/Digital Photo ProfessionalFeatures of the Print Plug-In for Photoshop/Digital Photo Professional
The main features of the Print Plug-In for Photoshop/Digital Photo Professional are as follows.

• You can automatically detect the color space of Adobe RGB or sRGB-use images, etc., and automatically set opti-
mal profiles. Thus, you can print without the trouble of configuring settings.

• You can modify image data directly in Photoshop and send the image data to the printer. This allows you to proc-
ess not only 8-bit, but also 16-bit image data.

• By using the preview function for images based on real images, and the preview function for layouts based on
image positioning by media size, you can use this software to make color adjustments and confirm print layout.

• You can perform basic printer settings such as printer selection, media type and output profile selection, and
matching methods, in addition to borderless printing and enlargement/reduction process without growing through
the printer driver.

• You can print an image with adjustment values such as the color balance, brightness, and contrast varying in
steps and select your preferred adjustment values.  (See "Adjustment pattern setting dialog box.") →P.270

• You can create and print a layout image for finishing by mounting in a frame with the image extended to the sides
of the frame by using the Layout Plug-In that is installed at the same time as the Print Plug-In for Photoshop.  (See
"About the Layout Plug-In.") →P.311

• By using the print history management function, you can import past print settings parameters. Additionally, you
can save preferences as a file.

Note

• The actual output may differ from the settings in Print Plug-In for Photoshop/Digital Photo Professional (the arrangement of the
image in the layout preview, print start position, and paper size) depending on the media type, image size, paper detailed
settings, and printer main unit settings.

• Loss of gradation in dark areas can be reduced by performing black point compensation.

Note

• Adobe CMM is required in order to use the black point compensation function.

• You can perform a printer simulation print by specifying the printer profile.

Installation ProceduresInstallation Procedures
The procedure for installing the Print Plug-In for Photoshop/Digital Photo Professional is as follows.

Note

• The Layout Plug-In is also installed when the Print Plug-In for Photoshop is installed.

1 Insert the User Software CD-ROM into the CD-ROM drive to start the installer.

Note

• If the installer screen does not appear, open the CD-ROM icon in My Computer and click on setup.exe to open the
icon.
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2
 

Click imagePROGRAF Print Plug-in button.

3 Click the Install button corresponding to the Print Plug-In for Photoshop/Digital Photo Professional you are us-
ing.

• For 32-bit Windows

• For 64-bit Windows
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Note

• If a version of Photoshop supported by Print Plug-In for Photoshop is not installed, The application is not installed.
is displayed. Install the Print Plug-In on a computer that has a supported version of Photoshop installed.

• If the folder for the Photoshop Plug-In to install Print Plug-In cannot be found, Specify the destination for installa-
tion of the plug-in? will appear. In this case, refer to the Photoshop manual then specify a folder for the Plug-In.

• The Print Plug-In for Photoshop cannot be installed on systems where the installed Photoshop has not been started
even once. In this situation, start and then exit Photoshop once before installing the Print Plug-In for Photoshop.

4
 

Click Next button.

5
 

After you have read the Licensing Agreement, select I
accept the terms of the license agreement and click
the Next button.

6
 

Click Install button.
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7
 

Click Finish button.

Installing the Print Plug-In for Photoshop/Digital Photo
Professional finishes.

Uninstall ProceduresUninstall Procedures
The procedure for uninstalling the Print Plug-In for Photoshop/Digital Photo Professional and Layout Plug-In is as fol-
lows.

Note

• This section describes the procedure in Windows 7.

• Uninstall the Print Plug-In for Photoshop

1. Select start in Control Panel menu.

2. Select Programs and Features.

3. Select Canon iPFxxxx Print Plug-In for Photoshop xx, then click Change/Remove.

• Uninstall the Print Plug-In for Digital Photo Professional

1. Select start in Control Panel menu.

2. Select Programs and Features.

3. Select Canon iPFxxxx Print Plug-In for Digital Photo Professional, then click Change/Remove.

Note

• iPFxxxx is the name of your printer.

• Uninstalling the Layout Plug-In

1. Select Control Panel from the start menu.

2. Select Programs and Features.

3. Select imagePROGRAF Layout Plug-In, and then click the Change/Remove button.

Starting from PhotoshopStarting from Photoshop
Follow the procedure below to start the Print Plug-In for Photoshop from Photoshop.

1 Start Photoshop.
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2 Open the image that you wish to print.

3 If required, select the print range.

Note

• Images for use with Print Plug-In for Photoshop are less than 60,000 pixels in width and height. Reduce the selection
range or reduce the image with processing for images more than 60,000 pixels in width and height, and then attempt
step 3.

4
 

Select Export(or Data Export) from the File menu and
then select the output plug-in that matches your printer.
The imagePROGRAF Print Plug-In for Photoshop win-
dow (known below as the Print Plug-In window) is dis-
played.

Important

• When a profile is created with a commercially available profile creation tool, it may be created in ICCv4 format.
When an image source profile is ICCv4, you must install AdobeCMM or use Print Plug-In in a Windows Vista or
later environment.
When Adobe CMM is not installed in a Windows XP environment, a message is displayed, and the source profile
changes to Adobe RGB. To use an ICCv4 profile in a Windows XP environment, exit Plug-In and then install Adobe
CMM. For details on installing Adobe CMM, refer to Using Adobe CMM →P.290 .

Note

• When the color space of the entry screen is CMYK, it changes to AdobeRGB due to processing with Print Plug-In.
Also, Relative Colorimetric is used for the matching method.

• If the message below is displayed but the Print Plug-In window is not displayed, install the newest imagePROGRAF
printer driver and then attempt step 3.
The imagePROGRAF Printer Driver for iPFxxxx is either not installed correctly or not installed at all. Please
install.
(The iPFxxxx portion of the above message will reflect your printer name.)

• If the message below is displayed but the Print Plug-In window is not displayed, convert the color space of the image
to either RGB color, grayscale, or CMYK color and then attempt step 3.
Set the color space of the image to either RGB color, grayscale, or CMYK color.

Starting from Digital Photo ProfessionalStarting from Digital Photo Professional
Follow the procedure below to start the Print Plug-In for Digital Photo Professional from Digital Photo Professional.

1 Start Digital Photo Professional.

2 Open the RGB color image that you want to print.
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3 If required, select the print range.

Note

• Images for use with Print Plug-In for Digital Photo Professional are less than 6,000 pixels in width and height. Re-
duce the selection range or reduce the image with processing for images more than 6,000 pixels in width and height,
and then attempt step 3.

4
 

Select File from the Plug-in printing menu and then
select the output plug-in that matches your printer.
The imagePROGRAF Print Plug-In for Digital Photo
Professional window (hereinafter referred to as the
Print Plug-In window) is displayed.

Important

• When a profile is created with a commercially available profile creation tool, it may be created in ICCv4 format.
When an image source profile is ICCv4, you must install AdobeCMM or use Print Plug-In in a Windows Vista or
later environment.
When Adobe CMM is not installed in a Windows XP environment, a message is displayed, and the source profile
changes to Adobe RGB. To use an ICCv4 profile in a Windows XP environment, exit Plug-In and then install Adobe
CMM. For details on installing Adobe CMM, refer to Using Adobe CMM →P.290 .

Print Plug-In for Photoshop/Digital Photo Professional Main WindowPrint Plug-In for Photoshop/Digital Photo Professional Main Window
The Print Plug-In for Photoshop/Digital Photo Professional main window consists of the sheet selection area, and the
preview and button area.
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• Sheet Selection Area
The tabs used to switch between each sheet on the Print Plug-In for Photoshop/Digital Photo Professional window
are displayed.

When you select a tab, a sheet is displayed. The settings available on each sheet are as follows.

• Main Sheet →P.261
• Page Setup Sheet →P.264
• Color Settings Sheet (Color) →P.266
• Print History Sheet →P.268
• Support Sheet →P.269

• Preview Area
You can check the settings you made on the image in this area.

About the settings available on the preview area, see "Preview Area." →P.259
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• Button Area
This contains the buttons Print, Quit and Help

• PrintButton
Click this button to begin printing.

• QuitButton
Click this button to close the Print Plug-In for Photoshop/Digital Photo Professional Main window and return to
application software.

• HelpButton
Click this button to display the Print Plug-In for Photoshop/Digital Photo Professional Help file.

Preview AreaPreview Area
You can check the settings you made on the image in this area.

• Preview
Select the preview display method.
For more information about preview, see "Utilize Three Types of Previews." →P.281

Setting Details
Print Area Layout Displays the print range and the area out of the print range in the layout matching the Paper Size

set.
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Setting Details
Print Area Layout *You can change the image print position when you drag the image while the cursor is displayed

as .

Image The entire image is displayed.
 

*You can select the print range when you drag the image while the cursor is displayed as .

*When you click the image while the cursor is displayed as , the selected area is deselected.

Roll Paper Preview Display the media size and roll paper information on the top in the layout printing on roll paper.
 

*To select Roll Paper Preview, select Roll Paper in Paper Source.

• Print Selected Range
Place a checkmark here to only print the selected range.

Note

• When you select Preview in the Image, then select a portion of the image on the preview display, this becomes valid.

• Perform Proof in Preview
Place a checkmark here to simulate the colors of the output product in the preview.

Note

• If Auto (Color) is selected under Output Profile, some media types are enabled.
• If ICC profile is selected under Output Profile, this is always enabled.

• The actual color balance of the print product and the simulation product may differ with some environments and condi-
tions. In addition, when you have selected an ICC Profile with Output Profile and it is not compatible with the printer or
media that you are using, the color balance of the actual print product will differ.

• Image Properties button
When you click the button to open the Image Properties dialog box, where Image Size, Resolution, Bit and
Color Space information of the image imported to Print Plug-In are displayed.
Click the Close button to return to Print Plug-In for Photoshop/Digital Photo Professional.
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Main SheetMain Sheet
You can use this sheet to perform basic settings such as selecting a printer, setting the media type, or adjusting image
quality.

• Printer
The printer types are displayed.

• Select button
Click this button to display the Select Printer dialog box.
When you click the OK button after selecting the printer in the Select Printer dialog box, you can change the print-
er that corresponds with Print Plug-In for Photoshop/Digital Photo Professional.

• Media Type
This allows you to select the media type.
For more information about Media Type, see "Customize Media Settings." →P.299

Note

• Always select media type that is actually set in the printer. When the media you chose is different from the media set in
the printer, you may not receive the desired print results.

• Advanced Settings button
Click the button to display the Paper Detailed Settings dialog box.
For more information about the media detailed settings, see "Paper Detailed Settings Dialog Box." →P.274

• Input Resolution to Plug-in
You can select the resolution to process the image with Print Plug-In.
The following settings are available for resolution.

Setting Details
Accuracy 300ppi This processes images at an accurate resolution. This can control print speed and memory ca-

pacity.

High Accuracy 600ppi This processes images at a more accurate resolution. This setting results in the best print quality,
but this takes more time to print than Accuracy 300ppi while also requiring more memory capaci-
ty.
 

*This may not be displayed depending on how you set Media Type

• Input Bit to Plug-in
You can select the bit number to process with Print Plug-In for Photoshop/Digital Photo Professional.
The following settings are available for the input bit number.
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Setting Details
High Gradation 8bit This processes images with at 8bit/channel (24 bit).

Highest Gradation 16bit This processes images with at 16bit/channel (48 bit).
 

*This may not be displayed depending on how you set Media Type and Input Resolution to
Plug-in.

• Print Mode
Selecting the printing mode strikes the balance between the quality of the printed image and printing speed.
The following settings are available for the print mode.

Setting Details
Highest A setting for printing at the highest resolution when quality is most important. Printing takes longer

and consumes more ink than in other modes, but this mode offers superior printing quality.

High Choose this setting to print at high resolution when quality is most important. Printing takes longer
and consumes more ink than in Standard or Fast modes, but this mode offers exceptional print-
ing quality.

Standard Choose this setting to print at standard resolution when quality and speed are both important.
Printing takes less time than in Highest or High mode.

Fast Choose this setting to print faster. Printing in fast mode can help you work more efficiently when
checking layouts.

Highest (Max. No. of Passes) If you are concerned about uneven colors in the print result of Highest quality, selecting this op-
tion may improve printing results. However, printing may take longer.

Note

• The selectable fields may vary according to the Media Type, Input Resolution to Plug-in and Input Bit to Plug-in
settings.

• Output Profile
You can select the output profile.
The following settings are available for the output profile.

Setting Details
Auto (Color) Performs the optimum color conversion from the input image data color space information (sRGB,

Adobe RGB), media settings etc. You should normally select these settings.

Auto (Monochrome Photo) Performs the best color conversion to monochrome from the input image data color space infor-
mation (sRGB, Adobe RGB), media settings etc.

None (No Color Correction) You cannot perform color conversion with a plug-in. This is useful for creating an original ICC
profile.

External ICC Profiles This selects printer ICC profiles to be output to ICC profiles saved in the OS standard folder. Use
the color space of the input data as well as the select ICC profile to perform color conversion.

Important

• To use an ICCv4 profile, you must install AdobeCMM or use Print Plug-In in a Windows Vista or later environment. For
details on installing Adobe CMM, refer to Using Adobe CMM →P.290 .

Note

• Auto (Monochrome Photo) can only be selected for the corresponding media types.

• Proof
This is displayed when an ICC profile is selected as the Output Profile.
When this is checked, you can perform printing press simulation prints.
Refer to Perform Printing Press Simulation Print →P.294  for details on printing press simulation prints.
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• Matching Method
You can select the processing method when performing color conversion.
The following settings are available for the matching method.

Setting Details
Perceptual This converts the image to an image with natural color balance and gradation. This is useful for

pictures.

Saturation This converts the image to an image with heightened color saturation. The color balance of pic-
tures and drawings may change.

Relative Colorimetric This converts the image with emphasis on color balance before the conversion or on visual color
balance. This is useful for pictures and drawings.

Note

• When the Output Profile you have set is Auto (Monochrome Photo) or None (No Color Correction), you cannot se-
lect a matching method.

• ICC Conversion Options button
This is displayed when an ICC profile is selected as the Output Profile.
When this button is clicked, the ICC Conversion Options dialog box is displayed allowing you to configure color
conversion related settings.
Refer to ICC Conversion Options dialog box →P.277  for details on ICC Conversion Options.
 

• Copies
You can input the number of print copies in numerical characters.

Note

• The maximum value is 99.
• You can change the numbers by clicking either ▲ or ▼.

• Set Configuration button
Clicking the button opens the Set Configuration dialog box that provides settings for the adjustment of image
sharpness and image enlargement method.
For more information about Set Configuration, see "Set Configuration Dialog Box." →P.276

• Defaults button
Click the button to return all of the settings on the Main sheet to their defaults.
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Page Setup SheetPage Setup Sheet
You can use this sheet to set the size of the image to be printed, the media size, and whether to enlarge/reduce the
image.

• Input Image Size
The size of the image imported to Print Plug-In for Photoshop/Digital Photo Professional is displayed.

• Borderless Printing
When you place a checkmark here, the Specify Roll Paper Width dialog box is displayed and you can print an
image without borders.
For more information about Borderless Printing, see "Print with No Borders." →P.298

Note

• Available only if rolls are selected in Paper Source.

• Enlarged/Reduced Printing
When you place a checkmark here, you can print enlarged/reduced images.
When printing an enlarged/reduced image, select the method for enlargement/reduction. The image size sent to
the printer is displayed matching the selected method in Output Image Size.
The following settings are available for enlarged/reduced printing.

Setting Details
Fit Paper Size This automatically enlarges/reduces the entire image imported to Print Plug-In to match the ex-

port media size when printing.

Fit Roll Paper Width This automatically enlarges/reduces the entire image imported to Print Plug-In to match the width
of the roll paper with the width of the image when printing.
 

*Displayed only if rolls are selected in Paper Source.

Scaling This enlarges/reduces the entire image by the specified scaling value. Input the scaling value in
numerical characters. You can specify a range between 5-600%.
 

*You can change the numbers by clicking either ▲ or ▼.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

• Output Image Size
The output image size is displayed up to one place after the decimal point in millimeters.
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Note

• When Paper Size is smaller than Output Image Size, part of the image may not print.

• Paper Size
You can select the size of the print media.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

• This is not displayed when Fit Roll Paper Width is set in Enlarged/Reduced Printing.

• Orientation
This selects the print orientation.
The following settings are available for orientation.

Setting Details
Portrait Prints the image on the media as it appears on the screen.

Landscape Prints the image on the media rotated 90 degrees.

• Layout
You can select the print position of an image on the media.
The following settings are available for layout.
 

Layout
Setting Details

Upper-Left of Output Paper Size Prints the image with fitting the top left of the active print area for Paper Size.

Center of Output Paper Size Prints the center of the image on the center of the selected Paper Size.

Specify Print Start Position You can print with specifying the top and left printing start positions in From Top Margin and
From Left Margin for Paper Size.

From Top Margin Input the margin from the top of the media in numbers.
 

*You can input between -9999 and 9999 mm.

From Left Margin Input the margin from the left of the media in numbers.
 

*You can input between -9999 and 9999 mm.

Note

• Select Print Area Layout or Image in Preview when you select Layout.

 

Roll Paper Layout
Setting Details

Upper-Left of Roll Paper Prints the top left of Media Size on the top left of the selected roll paper.

Center of Roll Paper Prints the center of Media Size on the center of the selected roll paper.

Note

• Select Roll Paper Preview in Preview when you select Roll Paper Layout.

• Paper Source
You can select the media source.
The following settings are available for media source.

Setting Details
Roll Paper Select to print on roll paper.
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Setting Details
Cut Sheet Select to print on the cut sheet.

• Roll Paper Options button
Click this button to open the Roll Paper Options dialog box, where you can set roll paper width and perform auto
cut settings.
For more information about the roll paper options, see "Roll Paper Options Dialog Box." →P.278
 

• Size Options
Click the Size Options button to open the Size Options dialog box and you can select a media name, size and
other settings.
For more information about the size options, see "Size Options Dialog Box." →P.278
 

• Defaults button
Click the button to return all of the settings on the Page Setup sheet to their defaults.
 

Color Settings Sheet (Color)Color Settings Sheet (Color)
You can use this sheet to adjust image Color, Brightness, Contrast, Saturation, and you can set the color balance of
print product more to your liking.

Note

• You can check a preview of the adjusted state for the following items.
Cyan / Magenta / Yellow, Gray Tone, Brightness, Contrast, Saturation, and Gray Tone Adjustment

• Cyan / Magenta / Yellow
You can adjust the strength or weakness of a color by either inputting a numerical value or dragging the slide bar.

• Gray Tone
You can adjust gray tone from cool black (cool tones) to warm black (red tones) by either inputting a numerical
value or dragging the slide bar.

• Brightness
You can adjust the brightness of the printed image without losing the brightest and darkest areas by either input-
ting a numerical value or dragging the slide bar.
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• Contrast
You can relatively adjust the brightness of the brightest and darkness areas by either inputting a numerical value
or dragging the slide bar.

• Saturation
You can adjust the saturation of vivid color balance to dark color balance by either inputting a numerical value or
dragging the slide bar.

• Adjustment pattern setting button
When this button is clicked, the Adjustment pattern setting dialog box is displayed. The Adjustment pattern
setting dialog box allows you to print an adjustment pattern with adjustment values that vary in steps up and
down, and to select your preferred adjustment values.
For details on Adjustment pattern setting, see "Adjustment pattern setting dialog box." →P.270

• Curve button
Click the button to open the Curve dialog box then set the Channel and other settings.
For more information about Curve, see "Curves Dialog Box." →P.279

• Defaults button
Click the button to return all of the settings on the Color Settings sheet to their defaults.

Color Settings Sheet (Monochrome)Color Settings Sheet (Monochrome)
This screen allows you to adjust settings such as the Color Balance, Tone, Brightness, and Contrast to configure
the printing result to be closer to your expected tone and gradation.
This is displayed when Auto (Monochrome Photo) is selected in the Output Profile on the Main Sheet →P.261 .

Note

• You can check a preview of the adjusted state for the following items.
Color Balance, Tone, Brightness, Contrast, Highlight, Shadow, and Tint

• Color Balance
Allow you to select the color balance to suit your application.

• X / Y
Adjust the color balance as you check the color tone in the adjustment area.
You can adjust the square area in the center by clicking or dragging it.
Drag the vertical or horizontal scroll bars for adjustment, as desired.
You can click the arrows by the X (horizontal) and Y (vertical) boxes or enter the values directly.
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• Tone
You can adjust the brightness of intermediate tones in an image. Selecting Hard tone gives a hard impression
with more definition. Selecting Soft tone gives a soft impression.

• Brightness
You can adjust the brightness of the printed image without losing the brightest and darkest areas by either input-
ting a numerical value or dragging the slide bar.

• Contrast
You can relatively adjust the brightness of the brightest and darkness areas by either inputting a numerical value
or dragging the slide bar.

• Highlight
Adjust the brightness of the lightest portion.

• Shadow
Adjust the brightness of the darkest portion.

• Tint
Fills in the white parts of the paper with a small amount of ink in order to reduce the difference in texture between
highlights in the image and the white parts of the paper.

• Adjustment pattern setting button
When this button is clicked, the Adjustment pattern setting dialog box is displayed. The Adjustment pattern
setting dialog box allows you to print an adjustment pattern with adjustment values that vary in steps up and
down, and to select your preferred adjustment values.
For details on Adjustment pattern setting, see "Adjustment pattern setting dialog box." →P.270

• Curve button
Click the button to open the Curve dialog box then set the Channel and other settings.
For more information about Curve, see "Curves Dialog Box." →P.279

• Defaults button
Click the button to return all of the settings on the Color Settings sheet to their defaults.

Print History SheetPrint History Sheet
You can use this sheet to apply settings history used in printing, and to print information, such as the image file name,
with the image.

• Print History and Favorites
This displays a list of print preferences.
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Select Restore Defaults and click the Apply button to restore all settings to their initial settings.

Note

• You can check the 3 print preferences in the preview display.

• Apply button
When you click the button, the print setting content applies to the current image selected with Print History and
Favorites.
 

• Details button
Click the Details button to open the Print History Details dialog box, where you can manage print history.
For more information about the print history details, see "Print History Details Dialog Box." →P.280
 

• Print Information
When you place a checkmark here, you can print the file name and print time and date on the image. The following
settings are available for the print position and content.
For more information about Print Information, see "Set Information to Print with Image." →P.309

Setting Details
Information Print Position Selects the information print position.

Top (Header) Information is printed on the top of the image.

Bottom (Footer) Information is printed on the bottom of the image.

Print History Number Place a checkmark here to print the print history number.

File Name Place a checkmark here to print the file name.

Printed at Place a checkmark here to print the time and date.

Color Adjustment Value Place a checkmark here to print the color adjustment value.

Printer Name Place a checkmark here to print the printer name.

Comment Place a checkmark here to print the comment details.

Comment Details Place a checkmark here to display the comment details.

• Edit Comment button
Click the button to display the Edit Comment dialog box, where you can edit the comment.
 

Support SheetSupport Sheet
You can display product support information and the electronic manual.
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• Support Information button
Click the button to display websites that contain the latest product information.

Note

• An Internet connection is needed to view the websites.

• User Manual button
Click the button to display the printer manuals installed on the computer.

Note

• You must have User Manual installed on your computer.

Adjustment pattern setting dialog boxAdjustment pattern setting dialog box
Displays the adjustment pattern by taking images with the adjustment values varying up and down in steps from the
baseline adjustment values in the Color Settings sheet (color or monochrome). This allows you to print the adjustment
pattern and select your preferred adjustment values while comparing the images.

• Preview Area
This area allows you to view adjustment pattern images side-by-side to check the state when changes to adjust-
ment values are applied.
The adjustment values of the image enclosed in the blue frame in the center are used as the base values, with
images arranged around this with the adjustment values varying in steps up and down from these base values. If
you click any of the images, the adjustment pattern is redisplayed with the adjustment values from that image as
the base values.
The adjustment values are displayed at the top of each image. If both the Horizontal Axis and Vertical Axis are
configured, the adjustment value for the Horizontal Axis is displayed on the right and the adjustment value for the
Vertical Axis is displayed on the left. If the image is so small that the adjustment values cannot be displayed, you
can check the adjustment values by displaying the tool tip.

Note

• For images where the adjustment values are out of range, an adjustment pattern is not displayed and the message Out
of Range is displayed instead.

• Paper Source
Selects the paper feed method for the paper to print the adjustment pattern on. You can split the usage between
printing adjustment patterns on cut paper (manual feed) and printing work pieces on roll paper.
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• Use Paper Size
Selects the paper size to print the adjustment pattern on.
The adjustment pattern is printed so that it fits into the selected paper size.

Note

• If the image size is large and Dimensions is selected in Pattern Size, the pattern display might not fit within the vertical
direction of the paper size. In this case, select Auto in Pattern Size.

• The printed paper size is displayed in Paper Size.

• Paper Size
Since the length in the vertical direction may differ between the Use Paper Size and actual printed material, this
displays the actual output paper size.

• No Space at Paper Bottom (Conserve Paper)
If a margin appears at the bottom of the paper with the paper size selected in Use Paper Size, you can conserve
paper by selecting this check box to print excluding the margin area. The state of the length in the vertical direction
being shortened to conserve the margin area is reflected in the displayed Paper Size.

• Horizontal Axis / Vertical Axis
Configures settings such as the items that change in steps and the number of patterns when multiple adjustment
patterns are arranged horizontally or vertically.

• Adjustment Item
Selects the items to change in steps.
For color, you can select Cyan, Magenta, Yellow, Gray Tone, Brightness, Contrast, or Saturation.
For monochrome, you can select X Color Balance, Y Color Balance, Tone, Brightness, Contrast, High-
light, Shadow, or Tint.
The icons for Horizontal Axis Adjustment Item are displayed above the preview area and the icons for Ver-
tical Axis Adjustment Item are displayed on the left of the preview area.

Note

• None can only be selected for Vertical Axis in both color and monochrome.

• Number of Patterns
You can select the number of images to display in the pattern in the horizontal or vertical direction from 3, 5,
and 7. If the adjustment item is Tone, you can select 3 or 5. When Tone is selected as the adjustment value,
-1 is Soft tone, 0 is Middle tone, 2 is Medium-hard tone, 3 is Hard tone, and 5 is Strong-hard tone.

• Adjustment Value Spacing
You can select the interval of the variation in adjustment values between neighboring adjustment pattern im-
ages from the range of 1 to 10. The larger the value, the greater the differences between the states of the
adjustment pattern images. Note that if the adjustment item is Tone, the Adjustment Value Spacing cannot
be selected.

• (Swap) button
Rearranges the adjustment pattern with the Horizontal Axis and Vertical Axis adjustment items swapped.

• Rotate 90 degrees
Rotating the image may make it easier to conserve paper and compare images.
Select Per Image to rotate each of the images in the adjustment pattern by 90 degrees.
Select Entire Image after layout to rotate the entire adjustment pattern by 90 degrees.
When None is selected, the image is not rotated.
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• Pattern Size
You can specify the size of the image when printing the adjustment pattern.
When Auto is selected, the image is enlarged or reduced to fit the adjustment pattern into the Use Paper Size.
When Dimensions is selected, the image is printed at the input image size without enlarging or reducing. Dimen-
sions cannot be selected when the paper feed method is Manual.

Note

• If the input image size is large, check the Paper Size before starting printing because it may be larger than the actual
printed material size.

• Select Dimensions in Pattern Size to print at the input image size without enlarging or reducing the images.

• Patterns that extend past the horizontal width of the paper are printed wrapped onto the next line.

• Pattern Spacing
You can select None or Available. If Available is selected, you can insert a background between each image.
The background color can be specified in Pattern Background.

• Pattern Background
You can select the background color from White, Black, and Gray.
If it is difficult to compare the differences between neighboring adjustment pattern images, changing the back-
ground color may make it easier to compare. The Pattern Spacing can be selected if Pattern Background is
Available.

• Update Base Values in the Color Settings Sheet
Select this check box and click the Close button to apply the setting values (standard values) of the image en-
closed in the blue frame in the center of the preview area in the Color Settings sheet (color or monochrome).

• Print Conditions
Displays the paper type, print mode, and output profile configured in the main window. This makes it possible to
check the details of each of the settings when printing the adjustment pattern without returning to the main win-
dow.
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• Specify the Range of Images button
When this button is clicked, the Specify the Range of Images dialog box is displayed for specifying the range of
images.

When you specify the range by using the mouse or other means and then click the OK button, the Specify the
Range of Images dialog box closes and the specified image range is redisplayed as the adjustment pattern.
If you click the Cancel button, the Specify the Range of Images dialog box closes even if a range is selected.

Note

• The selected range is cleared by clicking the image with a range selected.

• Restore to Previous button
When this button is clicked, the settings are restored to the defaults when the Adjustment pattern setting dialog
box was first displayed.

• Close button
When this button is clicked, the setting values in the Adjustment pattern setting dialog box are saved and the
dialog box is closed. These setting values are applied the next time the Print Plug-In for Photoshop/Digital Photo
Professional is started. Furthermore, if you select the Update Base Values in the Color Settings Sheet check
box and click the Close button, the setting values for the image enclosed in the blue frame in the preview area
(central image) are applied to the settings in the Color Settings sheet (color or monochrome).

• Print Adjustment Pattern button
When this button is clicked, printing the adjustment pattern is executed. The Adjustment pattern setting dialog
box does not close even after executing the printing.
The adjustment values are printed at the top of each image. If both the Horizontal Axis and Vertical Axis are
configured, the adjustment value for the Horizontal Axis is displayed on the right and the adjustment value for the
Vertical Axis is displayed on the left.
Each of the setting values for the paper type, print mode, and output profile as well as the adjustment values con-
figured in the Color Settings sheet (color or monochrome) are printed at the bottom of the paper. However, the
adjustment values for the Curve are not printed.
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Note

• The job name when printing the adjustment pattern is "Original Image Name + Pattern-Print". For example, the print job
name for the image "ABC.jpg" is "ABC_Pattern-Print.jpg".

Paper Detailed Settings Dialog BoxPaper Detailed Settings Dialog Box
This dialog box appears when you click the Advanced Settings button on the Main Sheet. You can set Drying Time
and Roll Paper Margin for Safety by media type.

• Drying Time
Between Pages
This sets the wait time for the ink to dry between each completely printed sheet and the output of the sheet.

Setting Details
Printer Default The settings of the printer operating panel are applied.

None The paper is ejected immediately after printing.

30sec. / 1min. / 3min. / 5min. /
10min. / 30min. / 60min.

The sheet is ejected when the specified time after printing has elapsed.

Between Scans
This sets the wait time between line scans during printing.

Setting Details
Printer Default The settings of the printer operating panel are applied.

None The printing continues to the next line immediately after the last line.

1sec. / 3sec. / 5sec. / 7sec. / 9sec. The printing continues to the next line after the set time.
 

*For the media type that has problems, such as ink smears on the page or colors that seem un-
even during borderless printing etc., increase the value for this setting.

• Roll Paper Margin for Safety
Near End Margin
This sets the length of the near end margin of the roll paper.

Setting Details
Printer Default The settings of the printer operating panel are applied.

5mm Print at a standard size.
 

*Select for Media Type that has no problem when printing with a standard size margin.

20mm Select this when rubbing against the printhead occurs such as when using paper that tends to
curl.

• Cut Speed
This selects the auto cut speed.
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Setting Details
Printer Default The settings of the printer operating panel are applied.

Fast Select this setting if cutting with the Standard setting is not clean.

Standard Select this setting when you are not experiencing problems.

Slow This helps prevent adhesive from sticking to the cutter and keeps the cutter sharp if you select it
when using adhesive paper.

• Calibration Value
When calibration has been carried out on the printer, use this setting to choose whether or not to use the results.

Setting Details
Printer Default The settings of the printer operating panel are applied.

Use Value The calibration results are used for printing.

Disregard Value The calibration results are not used for printing. Select this option to avoid changes to image color
tones during printing due to color calibration.

• Mirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or image
with the left and right sides inverted.
 

• Unidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the
printing speed becomes slower.
 

• High-Precision Text and Fine Lines
Print increasing ink impact accuracy, particularly for sharper text and fine lines. However, this takes more time
than regular printing.

Note

• When Highest (Max. No. of Passes) is selected as the print mode, High-Precision Text and Fine Lines cannot be
selected.
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Set Configuration Dialog BoxSet Configuration Dialog Box
This dialog box appears when you click the Set Configuration button on the Main Sheet. You can set the adjustment
of image sharpness and image enlargement method.

• Sharpen
Performs adjustment of the sharpness (outline) settings.
 

• Image Enlargement Method
You can select the image enlargement method.
The following settings are available for the image enlargement method.

Setting Details
Nearest Neighbor Performs simple enlargement.

Bilinear Performs line vector enlargement.

Bicubic Adjust pixels with calculation of elements such as a color or brightness of neighboring pixels.

• Close Plug-in After Printing
When you place a checkmark here, the plug-in closes after printing finishes.

Note

• If printing does not finish correctly because it was canceled or an error occurred, the plug-in does not close.

• Output Method
You can select the output method.
The following settings are available for the output method.

Setting Details
Print Normal printing. The print job data is stored temporarily in the box as the job prints.

Save in mail box Saves the print data in the mail box.
If you select Save in mail box, you must specify Name of data to be saved.

Print after reception is complete When you place a checkmark here, you can print after saving jobs in the temporary storage
space. This cannot be used when Save in mail box is selected.
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• Initialize all warning dialog boxes
When this is checked, all of the warning dialog boxes that have been set to "Do not show this screen again" be-
come displayed.
 

ICC Conversion Options dialog boxICC Conversion Options dialog box
This is displayed when an ICC profile is selected in the Output Profile list in the Main sheet and the ICC Conversion
Options button is clicked. This allows you to configure detailed color matching related settings.

• Conversion Engine
Selects the conversion engine to use when converting colors.

Note

• Adobe CMM needs to be installed in order to use Adobe CMM. Refer to Using Adobe CMM →P.290  for details on how
to install Adobe CMM.

 

• Black Point Compensation
Check this check box to perform black point compensation. Loss of gradation in dark areas can be improved by
performing black point compensation.

Note

• This can be used if Adobe CMM is selected as the Conversion Engine.

 

• Proof Options
Configures settings related to printing press simulation.
The proof options consist of the following settings.

Setting Details
Simulate Paper Color Select this when performing paper color simulation. When this is on, Simulate Black Ink is auto-

matically turned on and becomes grayed out.

Simulate Black Ink Select this when performing simulation of black ink. In order to enable this setting, Adobe CMM
needs to be selected under Conversion Engine.
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Roll Paper Options Dialog BoxRoll Paper Options Dialog Box
This dialog box appears when you click the Roll Paper Options button on the Page Setup Sheet. You can set the roll
paper width and perform the auto cut settings.

• Roll Paper Width
This selects the width of the roll media set to the printer.
 

• Automatic Cutting
You can set the printer to cut roll paper automatically or print a guideline for cutting.
The following settings are available for automatic cutting.

Setting Details
Available Each page is automatically cut after it is printed.

None Each page is not cut after it is printed and printing continues without interruption.

Print Cut Guideline A print cut guideline is printed after each page and printing continues without interruption.

• No Spaces at Top or Bottom (Conserve Paper)
When you place a checkmark here, the print data is printed without margins.
 

Size Options Dialog BoxSize Options Dialog Box
This dialog box appears when you click the Size Options button on the Page Setup Sheet. You can select a media
name, size and other settings.

• Paper Size List
Displays all the standard sizes and custom media sizes.
 

• Custom Paper Size Name
You can enter any name up to 63 characters.
 

• Units
You can select the units of measure to use when you define custom media size. Switching this setting resets the
units of measure for the entire Plug-In.
 

• Paper Size
Width
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Enter the width of the media size.
 

Height
Enter the height of the media size.

• Add button
Click the button to register the contents of the settings.
 

Curves Dialog BoxCurves Dialog Box
This dialog box appears when you click the Curves button on the Color Settings Sheet. You can set Channel and
other settings.

• Channel
Select from among RGB, Red, Green, or Blue.

Note

• Gray is displayed for monochrome printing and this selection cannot be changed.

• Input
Enter an input value.

Note

• The allowed entry range is 0 to 255.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Output
Enter an output value.

Note

• The allowed entry range is 0 to 255.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Load Curves button
Click the button to load stored data for a tone curve.
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• Save Curves button
Click the button to stores the current tone curve settings.
 

Print History Details Dialog BoxPrint History Details Dialog Box
This dialog box appears when you click the Details button on the Print History Sheet. This controls print history. For
more information about Print History Details, see "Utilize Print History." →P.299

• Print History
Print History appears in list format.

Display Items Details
Print History Number Displays the print history number.

File Name Displays image file name.

Printed at Displays time and date of printing.

Comment Displays comment details.

Note

• Up to 200 print history items can be displayed. All items above 200 are deleted.

• When you cannot print properly because you canceled the printing or an error occurred, appears  to the left of the
print history number.

• Delete button
Click the button to delete the selected print history.
 

• Add button

Click the  button to add the selected print history to preferences.

Note

• Up to 200 print preference items can be added.

• Favorites
The print history stored in print preferences displays in list format.

Note

• You can change the order by selecting an item and dragging it to another place.
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• Import button
Click the button to import print history saved as a file.
 

• Export button
Click the button to save print history as a file that is stored in print preferences.
 

• Delete button
Click the button to delete print history stored in print preferences.
 

• Settings
Displays the print history settings selected from the Print History or Favorites.

Setting Details
Main When you select this the Main sheet settings are displayed.

Page Setup When you select this the Page Setup sheet settings are displayed.

Color Settings When you select this the Color Settings sheet settings are displayed.

Utilize Three Types of PreviewsUtilize Three Types of Previews
You can use Print Plug-In for Photoshop/Digital Photo Professional to check an image in three types of previews.
The preview types are as follows.

• Check Image with Print Area Layout →P.281
• Check the original image with Image →P.282
• Check Image with Roll Paper Preview →P.282

Check Image with Print Area LayoutCheck Image with Print Area Layout
Displays the print range and the area out of the print range in the layout matching the media size set in the print area
layout.
Select Print Area Layout in Preview.

Note

• When the cursor on the preview is displayed as  on the preview, you can specify the print position by dragging the image.

• When the cursor is displayed as  on the preview, the below conditions on the Page Setup sheet have all been met.

• There is no checkmark in Borderless Printing.

• There is no checkmark in Enlarged/Reduced Printing or Scaling has been selected.
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Check the original image with ImageCheck the original image with Image
In the image preview you can check the entire image that you have input.
Select Image in Preview.

Note
• When the cursor appears as a small magnifying glass  while there is an Image in the Preview area, the Selected

Range feature is enabled and you an drag the cursor on the image and select an area for printing.

• When you click the image while the cursor is displayed as  on the preview, the selected area is deselected.

Check Image with Roll Paper PreviewCheck Image with Roll Paper Preview
Display the media size and roll paper information on the top in the layout printing on roll paper in Roll Paper Preview
Select Roll Paper Preview in Preview.

Note

• To select Roll Paper Preview in Preview, select Roll Paper in Paper Source.
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Print with a Desired Picture QualityPrint with a Desired Picture Quality
You can specify and print at the resolution you desire.

1
 

Display the Main sheet.

2 Select the media set to the printer in Media Type.

Note

• Always select media type that is actually set in the printer. When the media you chose is different from the media set
in the printer, you may not receive the desired print results.

3 Choose either Accuracy 300ppi or High Accuracy 600ppi for the resolution to process images in Input Res-
olution to Plug-in.

Note

• When you select Accuracy 300ppi images are processed at an accurate resolution. This can control print speed
and memory capacity.

• When you select High Accuracy 600ppi images are processed at a more accurate resolution. This setting results in
the best print quality, but this takes more time to print than Accuracy 300ppi while also requiring more memory
capacity.

• High Accuracy 600ppi will not display with some Media Type settings.

4 Choose either High Gradation 8bit or Highest Gradation 16bit for the bit number when processing images in
Input Bit to Plug-in.

Note

• When you select High Gradation 8bit, images are processed at 8 bit/channel (24 bit).

• When you select Highest Gradation 16bit, images are processed at 16bit/channel (48 bit).

• Highest Gradation 16bit will not display with some Media Type or Input Resolution to Plug-in settings.

5 Select the mode to be printed when processing images in Print Mode.

Note

• The settings that can be selected differ by Media Type,Input Resolution to Plug-in, and Input Bit to Plug-in
selected.

6 Click the Print button.
 

Printing begins.
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Adjust the Colors and PrintAdjust the Colors and Print
You can adjust the colors to your liking and print images.
The explanation below is on 6 ways to adjust the colors using Print Plug-In for Photoshop/Digital Photo Professional.

• Adjust the Colors while Checking the Preview (for Color) →P.284
• Adjust the Colors while Checking the Preview (for Monochrome) →P.285
• Adjust the Colors by Color Matching →P.287
• Print High-Quality Adobe RGB16bit Images →P.288
• Prints monochrome photographs with high quality →P.289
• Using Adobe CMM →P.290

Adjust the Colors while Checking the Preview (for Color)Adjust the Colors while Checking the Preview (for Color)
You can adjust the colors while checking the adjustments in the preview.
The following explanation is on the procedures for adjusting example image below.

• Low for Cyan
• High for Yellow
• Low for Saturation
• Warm Black for Gray Tone
• Enhance brightness for the curves

The above image adjustments are reflected in the before and after images below.

1
 

Display the Color Settings sheet.

2 Drag the slide bar in the direction of Low in Cyan.

3 Drag the slide bar in the direction of High in Yellow.
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4 Drag the slide bar in the direction of Low in Saturation.

5 Drag the slide bar in the direction of Warm Black in Gray Tone.

Note

• You can change the numbers by inputting in numerical characters.
• You can change the numbers by clicking either ▲ button or ▼ button.

6 Click the Curves button then click near the center of the curve.

7
 

Enter 120 in Input and 135 in Output then click the OK
button.

8 Click the Print button.
 

The adjustments are reflected in the image and printing begins.

Adjust the Colors while Checking the Preview (for Monochrome)Adjust the Colors while Checking the Preview (for Monochrome)
You can adjust the colors while checking the adjustments in the preview.
The following explanation is about the procedures for adjusting example image below.

• Low for Contrast
• Light for Highlight
• Light for Shadow
• Enhance brightness for the curves

The unapplied and the applied images of the above image adjustments are as below.
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1 Open the Main sheet.

2
 

Select Auto (Monochrome Photo) in Output Profile.

3
 

Open the Color Settings sheet.

4 In Contrast, drag the slide bar toward Low.

5 In Highlight, drag the slide bar toward Light.

6 In Shadow, drag the slide bar toward Light.

Note

• You can change the numbers by inputting in numerical characters.
• You can change the numbers by clicking either ▲ button or ▼ button.

7 Click the Curves button then click near the center of the curve.
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8
 

Enter 120 in Input and 135 in Output then click the OK
button.

9 Click the Print button.
 

This applies the image adjustments and starts the print job.

Adjust the Colors by Color MatchingAdjust the Colors by Color Matching
When you print a color image imported from a scanner or a digital camera, the image may appear different from the
image on the screen. That is due to the differences in color on the screen and in the printer. In Print Plug-In for Photo-
shop/Digital Photo Professional, you can get the color balance of the print product closer to the color balance displayed
on the screen through performing ICC (International Color Consortium) color profile settings, matching method settings,
and settings for the internal profile, which performs optimum color conversion in response to media and resolution set-
tings.

1
 

Display the Main sheet.
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2 Select the profile in Output Profile.

Note

• When you place a checkmark in Perform Proof in Preview, you can check the color matching in the preview. This
may not be displayed depending on how you set Media Type.

• The details of Output Profile you have set is saved even when you close the Print Plug-In for Photoshop/Digital
Photo Professional, but when the specified profile cannot be located it is set to Auto (Color).

• If an ICC profile is selected as the Output Profile, Adobe CMM can be selected as the color conversion engine.
Refer to Using Adobe CMM →P.290  for details.

3 Select the profile matching method in Matching Method.

4 Click the Print button.
 

Printing begins with the output profile and matching method that you have set.

Print High-Quality Adobe RGB16bit ImagesPrint High-Quality Adobe RGB16bit Images
This prints a high-quality Adobe RGB16bit image taken with a high-end digital camera. Print Plug-In for Photoshop/
Digital Photo Professional allows you to print high color gamut and high tone images, when the Adobe RGB16bit image
data has been retouched in Photoshop, without compromising the level of tone in the image.

1
 

Select the Adobe RGB16bit image data in Photoshop
and start Print Plug-In for Photoshop/Digital Photo Pro-
fessional.  (See "Starting from Photoshop.") →P.255

2 Click Image Properties button.

3
 

Check that Adobe RGB is displayed in Color Space,
and 16bit/channel is displayed in Bit in the Image
Properties dialog box, and click the Close button.
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4
 

Display the Main sheet.

5 Select High Accuracy 600ppi in Input Resolution to Plug-in.

6 Select Highest Gradation 16bit in Input Bit to Plug-in.

7 Select the highest quality possible in Print Mode.

8 If required, adjust the colors using color matching.

Note

• For more information about the color matching, see "Adjust the Colors by Color Matching." →P.287

9 Click the Print button.
 

Printing of the Adobe RGB16bit image begins.

Prints monochrome photographs with high qualityPrints monochrome photographs with high quality
Prints images captured with a scanner or digital camera in monochrome with high quality. Provides stable monochrome
photo images without color casts and minimizes the influences of the difference of the light source.

1
 

Display the Main sheet.
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2 Select Auto (Monochrome Photo) in Output Profile.

Note

• Auto (Monochrome Photo) can be selected only after a compatible Media Type has been selected.

3 Click the Print button.
 

Performs conversion to the most suitable monochrome and printing begins.

Using Adobe CMMUsing Adobe CMM
Adobe CMM is a color conversion engine made by Adobe. Using Adobe CMM makes it possible to obtain uniform color
conversion results and to use the black point compensation function.

• How to Obtain Adobe CMM
Adobe CMM can be obtained using the following procedure.

1 Open the Adobe website (http://www.adobe.com).

2 Enter "Adobe CMM" in the search input box on the screen.

3 Search for the "Adobe Color Management Module (CMM)" item and select the Windows version.

4 Download the file by following the on-screen directions.

5 Start the installer in the downloaded file to perform the installation.

Important

• Use version 1.1 or higher of Adobe CMM.

• Adobe CMM System Requirements
The system requirements for Adobe CMM are as follows.

• Supported OS
Windows XP SP2, Windows Vista
 

• Supported CPU
Intel Xeon, Xeon Dual, Intel Centrino, Pentium 4 processor

Note

• Check with Adobe for details.

• How to Use Adobe CMM
The procedure for using Adobe CMM is as follows.

Using Adobe CMM                                                                                                                                                                                                              iPF9400

                                                                                                                                                                                                                                       User's Guide

  

W
indow

s Softw
are

Print Plug-In for Photoshop / D
igital Photo Professional

 290



1
 

Display the Main sheet.

2 Select one of the ICC profiles as the Output Profile.

3 Click the ICC Conversion Options button.

4
 

In the ICC Conversion Options dialog box, select
Adobe CMM from Conversion Engine.

5 Click the OK button to close the ICC Conversion Options dialog box.

Printing an Adjustment Pattern and Selecting Adjustment ValuesPrinting an Adjustment Pattern and Selecting Adjustment Values
Since you can print an adjustment pattern and select your preferred adjustment values while comparing the images,
this allows you to conserve ink and paper, and save the time it takes to repeatedly check adjustment results.
The procedure for displaying and printing an adjustment pattern is as follows.

1 Display the Color Settings sheet (color or monochrome) and set the adjustment values to use as the baseline
values.
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2
 

Click the Adjustment pattern setting button to display
the Adjustment pattern setting dialog box.

3
 

Set the Adjustment Item, Number of Patterns, and
Adjustment Value Spacing for the Horizontal Axis
and Vertical Axis.
If you want to check part of an image as the adjustment
pattern, click the Specify the Range of Images button,
select the range you want to check in the Specify the
Range of Images dialog box, and then click the OK
button.

4 Set Rotate 90 degrees, Pattern Size, Pattern Spacing, and Pattern Background as needed.

5 For the Paper Source setting, select how the paper to print on is to be supplied.

6 For the Use Paper Size setting, select the paper size to print on.

7 Click the Print Adjustment Pattern button.
The adjustment pattern starts printing.

8 Check the image in the adjustment pattern that is closest to the customer image and click the corresponding
image in the preview area.
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9 If there are any other items that you want to adjust, select Adjustment Item and perform steps 7 and 8.

10 Once you have made the necessary adjustments, select the Update Base Values in the Color Settings
Sheet check box and click the Close button.
The previous adjustment values in the Color Settings sheet (color or monochrome) are updated.

Perform Black Point CompensationPerform Black Point Compensation
Black point compensation that is equivalent to Photoshop can be performed using the following procedure. Use this to
avoid saturation in the black areas of images.

Important

• Adobe CMM needs to be installed in order to use black point compensation. Refer to Using Adobe CMM →P.290  for details
on how to install Adobe CMM.

1
 

Display the Main sheet.

2 Select one of the ICC profiles as the Output Profile.

3 Click the ICC Conversion Options button to open the ICC Conversion Options dialog box.

4 Select Adobe CMM as the Conversion Engine.

5
 

Check the Black Point Compensation check box.

6 Click the OK button to close the ICC Conversion Options dialog box.
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Perform Printing Press Simulation PrintPerform Printing Press Simulation Print
You can perform printing press simulation prints by specifying ICC profiles such as Japan Color or SWOP, and specify-
ing an ICC profile for the printing press.

1
 

Display the Main sheet.

2 Select one of the ICC profiles as the Output Profile.

3 Check the Proof check box and select the profile for the printing press you want to target from the list on the
right.

4
 

Click the ICC Conversion Options button to open the
ICC Conversion Options dialog box.

5 Configure the Proof Options as needed.

Note

• The proof options are Simulate Paper Color and Simulate Black Ink. The settings that can be selected vary de-
pending on the Conversion Engine settings.

6 Click the OK button to close the ICC Conversion Options dialog box.

7 Click the Print button.
Printing begins.

Enlarge/Reduce and PrintEnlarge/Reduce and Print
You can enlarge or reduce an image in Print Plug-In.
Three methods to enlarge/reduce and print are as follows.

• Enlarge/Reduce and Print Matching Output Media Size →P.295
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• Enlarge/Reduce and Print Matching Width of Roll Paper →P.296
• Specify Scaling, Enlarge/Reduce and Print →P.297

Enlarge/Reduce and Print Matching Output Media SizeEnlarge/Reduce and Print Matching Output Media Size
By specifying the media type loaded in the printer, the image can be enlarged or reduced to fit the size of the image
area of the media. This feature is useful when you need to print on the full width of Media that you have selected.

Note

• When you need to print on the full width of roll media, see "Enlarge/Reduce and Print Matching Width of Roll Paper." →P.296

• When you do the procedure below to print on roll media, the print job will match the size of the output with the media selected
with the Paper Size setting.

1
 

Display the Page Setup sheet.

2 Select the size of the media that you want to print in Paper Size.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

• This is not displayed when Fit Roll Paper Widthis set in Enlarged/Reduced Printing.

3 Select either Portrait or Landscape as the media orientation for the image in Orientation.

Note

• When you select Portrait, the image on the media prints as it appears on the screen.

• When you select Landscape, the image on the media prints rotated 90 degrees.

4 Click the Enlarged/Reduced Printing check box on.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

5 Select Fit Paper Size.

6 Click the Print button.
 

The image prints filling the entire output media surface.

 

iPF9400                                                                                                                                                     Enlarge/Reduce and Print Matching Output Media Size

User's Guide                                                                                                                                                                                                                                       

  

W
indow

s Softw
are

Print Plug-In for Photoshop / D
igital Photo Professional

295  



Enlarge/Reduce and Print Matching Width of Roll PaperEnlarge/Reduce and Print Matching Width of Roll Paper
You can enlarge/reduce and print an image matching the width of the roll paper set in the printer. This is useful when
you wish to print an image that covers the entire width of the roll paper.

Note

• Printing will not occur properly when a print roll is not set to the printer.

1
 

Display the Page Setup sheet.

2 Select Roll Paper in Paper Source.

3 Click the Roll Paper Options button.

4 Set the roll paper options and click the OK button.

Note

• For more information about the Roll Paper Options dialog box, see "Roll Paper Options Dialog Box." →P.278

• Click the Defaults button to return all of the roll paper option settings to their defaults.

5 Select either Portrait or Landscape as the media orientation for the image in Orientation.

Note

• When you select Portrait, the image on the media prints as it appears on the screen.

• When you select Landscape, the image on the media prints rotated 90 degrees.

6 Click the Enlarged/Reduced Printing check box on.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

7 Select Fit Roll Paper Width.

8 Click the Print button.
 

The image prints covering the entire width of the roll paper.
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Specify Scaling, Enlarge/Reduce and PrintSpecify Scaling, Enlarge/Reduce and Print
You can specify scaling to enlarge/reduce an image and print. This is useful when you wish to print an image at a spe-
cific size.

1
 

Display the Page Setup sheet.

2 Select the size of the media that you want to print in Paper Size.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.
• Fit Roll Paper Widthis set in Enlarged/Reduced Printing.

3 Select either Portrait or Landscape as the media orientation for the image in Orientation.

Note

• When you select Portrait, the image on the media prints as it appears on the screen.

• When you select Landscape, the image on the media prints rotated 90 degrees.

4 Click the Enlarged/Reduced Printing check box on.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

5 Select Scaling and input the scaling factor or drag the four corners of the image in the Preview display.

Note

• You can specify scaling rate in intervals of 0.01%.
• You can specify a range between 5.00-600.00%.

• The size of the width and height proportionally grow when the image is enlarged/reduced.

6 Either drag the image on the Print Area Layout preview, or set the print position Layout.

7 Click the Print button.
 

Printing begins at the set scaling rate.
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Print with No BordersPrint with No Borders
You can use the borderless printing function to print without margins surrounding the image.

Note

• With some media borderless printing can be performed only between two edges.

• To use the borderless printing function, the specified media must be set to the printer.

1
 

Display the Page Setup sheet.

2 Select Roll Paper in Paper Source.

3 Click the Borderless Printing check box on.

Note

• Select the width for roll paper set in the printer in Roll Paper Width in the Specify Roll Paper Width dialog box, and
click OK.

4 Click the Print button.
 

Borderless printing begins.
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Customize Media SettingsCustomize Media Settings
You can customize media settings.

1
 

Display the Main sheet.

2 Select the media type that you wish to customize in Media Type.

Note

• Always select media type that is actually set in the printer. When the media you chose is different from the media set
in the printer, you may not receive the desired print results.

3 Click the Advanced Settings button.

4 Perform the settings in the Paper Detailed Settings Dialog Box →P.274  and click the OK button.

Utilize Print HistoryUtilize Print History
When you perform various settings and print in Print Plug-In for Photoshop/Digital Photo Professional, those settings
are saved as print history. Also, you can export and import as files. You can store often-used print history under a
specified name in print preferences.

Note

• You can save up to 200 print history items. All items over 200 are deleted in chronological order.

You can do the following things using print history.

• Confirm Print History Details →P.300
• Apply Print History to an Image →P.301
• Store Print History to Print Preferences →P.301
• Delete Print History →P.303
• Export Print History from Print Preferences →P.305
• Import Print History to Print Preferences →P.306
• Delete Print History from Print Preferences →P.308
• Set Information to Print with Image →P.309
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Confirm Print History DetailsConfirm Print History Details
You can confirm the print history details.

1
 

Display Print History sheet.

2 Click the Details button.

Note

• Select the print history you wish to check the details of,
from either Print History or Favorites in the Print History
Details dialog box.

 

3 Check the print history details in Settings, and click the OK button.

Note

• You can display the print history details by switching the sheets.
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Apply Print History to an ImageApply Print History to an Image
You can use previous print history, and apply it to an image.

1
 

Display the Print History sheet.

2 If required, check the print history details.  (See "Confirm Print History Details.") →P.300

3 Select the print history you wish to apply from Print History and Favorites, and click the Apply button.

Store Print History to Print PreferencesStore Print History to Print Preferences
You can store often-used print history to print preferences. Not only can you store the print history stored under a differ-
ent name in print preferences, you can also find it with ease.

Note

• You can store up to 200 print history items to print preferences.

1
 

Display the Print History sheet.

2 Click the Details button.
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3
 

Select the print history you wish to store in print prefer-
ences from Print History in the Print History Details
dialog box, and check the print history details in Set-
tings.

4
 

Select the print history you wish to store in print prefer-

ences from Print History and click the  button.

5
 

In the Add Favorites dialog box input the name of the
print history in Name, input a comment in Comment,
and click the OK button.
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6
 

Click the OK button to close the Print History Details
dialog box.

Delete Print HistoryDelete Print History
You can delete print history.

Important

• Be aware that you cannot undo deletions of print history.

1
 

Display the Print History sheet.

2 Click the Details button.
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3
 

Select the print history you wish to delete from Print
History in the Print History Details dialog box, and
click the Delete button.

4
 

Click the OK button.

5
 

Click the OKbutton to close the Print History Details
dialog box.
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Export Print History from Print PreferencesExport Print History from Print Preferences
You can export print history stored in print preferences as a file.

1
 

Display the Print History sheet.

2 Click the Details button.

3
 

Select the print history you wish to export from Favor-
ites in the Print History Details dialog box, and click
the Export button.

4
 

Input the name of the print history in File Name in the
Save As dialog box, and click the Save button.
 

The print history is exported under the specified file
name.
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5 Click the OK button to close the Print History Details dialog box.

Import Print History to Print PreferencesImport Print History to Print Preferences
You can import print history in file format and store it to print preferences.

1
 

Display the Print History sheet.

2 Click the Details button.

3
 

Click the Import button of the Favorites in the Print
History Details dialog box.
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4
 

Select the print history you wish to import in the Open
dialog box, and click the Open button.

The print history is imported.

Note

• The print history file name suffix is *.pjb.

• You cannot import a print history file exported from a different OS in Print Plug-In for Photoshop/Digital Photo Profes-
sional.

• You cannot import a print history file exported from a different printer in Print Plug-In for Photoshop/Digital Photo
Professional.

5
 

Click the OK button to close the Print History Details
dialog box.
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Delete Print History from Print PreferencesDelete Print History from Print Preferences
You can delete print history store to print preferences. You cannot store more than 200 print history items in print pref-
erences.

1
 

Display the Print History sheet.

2 Click the Details button.

3
 

Select the print history you wish to delete from Favor-
ites in the Print History Details dialog box, and click
the Delete button.

4
 

Click the OK button.
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5
 

Click the OK button to close the Print History Details
dialog box.

Set Information to Print with ImageSet Information to Print with Image
You can print information with an image that is related, such as the file name and the time and date.

Note

• When you use the borderless printing function to print, the information will not be printed.  (See "Print with No Borders.")
→P.298

• When the printed information is too long as does not fit on the media, a break will appear in the printed information.

• The information may print on the image data with some media sizes, enlargement rates and print position values.

• When Keep Media Size is set to On on the printer, a portion of bottom of the print data is not printed.

1
 

Display the Print History sheet.

2 Click the Print Information check box on.

3 Select the position where you wish to print the information in Information Print Position.

4 Click the information check box you wish to print on.
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5 When you wish to edit the comment, click the Edit Comment button.

Note

• When you do not wish to edit the comment, move to step 7.

6
 

Input the comment in the Edit Comment dialog box,
and click OK button.

7
 

Click the Print button.

Comments are printed with images.
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Layout Plug-In for PhotoshopLayout Plug-In for Photoshop
About the Layout Plug-In .................................................................................................................................... 311
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Add Canvas Size dialog box .............................................................................................................................. 313
Creating and Printing a Layout Image for Mounting on a Frame ....................................................................... 314

About the Layout Plug-InAbout the Layout Plug-In
When printing a photo to mount on a frame, you can start the Layout Plug-In from Photoshop and create a layout im-
age where the image extends to the sides of the frame.

Note

• The Layout Plug-In can be used with Photoshop CS5, Photoshop CS4, and Photoshop CS3.

• Layout images created in the Layout Plug-In can be printed as-is from the Print Plug-In for Photoshop.

For details on the functionality of the Layout Plug-In, see "Layout Plug-In Main Window." →P.311
For details on how to start and how to use the Layout Plug-In, see "Creating and Printing a Layout Image for Mounting
on a Frame." →P.314

Layout Plug-In Main WindowLayout Plug-In Main Window
This window is for creating a layout image for finishing an image extended around the sides of the frame when printing
a photo for mounting on a frame.
You can check the details of the settings in the preview area on the left side of the Layout Plug-In Main Window.

• Units
You can select the units from mm, inches, and pixels.

iPF9400                                                                                                                                                                                                     About the Layout Plug-In

User's Guide                                                                                                                                                                                                                                       

  

W
indow

s Softw
are

Layout Plug-In for Photoshop

311  



Important

• Since values entered in mm or inches are first converted temporarily to pixels and then reconverted to mm or inches,
values may be displayed that differ from the entered values.

• Select Canvas Size
Selects the canvas size. If Create the Canvas at the Image Size is selected, the image size is treated as the
canvas size. It is recommended that you provide a canvas that matches the image size.

• Add Canvas Size button
Click this button to display the Add Canvas Size dialog box and register a Custom Canvas Size.  (See "Add Can-
vas Size dialog box.") →P.313

• Thickness
Specifies the thickness of the canvas (the width of the canvas sides). Although you can select from 0.75 inches
(approx. 19 mm) and 1.5 inches (approx. 38 mm), you can also specify any arbitrary thickness.

Important

• Since values entered in mm or inches are first converted temporarily to pixels and then reconverted to mm or inches,
values may be displayed that differ from the entered values.

• Amount of Extension
Selecting this check box allows you to configure the amount of extension that protrudes past the canvas sides.
This allows you to prevent white paper from appearing on the canvas sides when mounted. The larger the amount
of extension, the larger the area hidden behind the back surface.

Important

• Since values entered in mm or inches are first converted temporarily to pixels and then reconverted to mm or inches,
values may be displayed that differ from the entered values.

• Thickness Effect
You can select from the following canvas effects.

• Image
Wraps the image to the canvas sides.

• Soft Image
Performs Gaussian filtering on the image on the canvas sides.

• Reflection
Reflects the image on the canvas sides.

• Soft Reflection
Reflects the image on the canvas sides and performs Gaussian filtering.

• White
Makes the canvas sides white.

• Black
Makes the canvas sides black.

• Custom Color
Makes the canvas sizes the specified color. The color is specified by clicking the Select Color button.

• Add Crop Marks
When this check box is selected, crop marks are printed at the outer edges of the image as guides to the positions
to fold the paper when mounting on a canvas.

• Display Information
Displays the following information.

• Input
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Displays the original image size before creating the layout image.

• Finished
Displays the image size of the entire layout image with the canvas sides, crop marks, and the amount of ex-
tension added to the input image size.

• Resolution
Displays the resolution of the image. This is not changed from the resolution of the original image. If the image
size is changed in the Layout Plug-In, the resolution is maintained the same as the original image, and resam-
pling is performed using the Bicubic method.
If you do not want the number of pixels in the image to change (resample), select Create the Canvas at the
Image Size in Select Canvas Size and select an option other than Image and Soft Image in Thickness Ef-
fect.

• Defaults button
Click this button to reset the setting values.

• Close button
When this button is clicked, the Layout Plug-In exits and the current setting values are saved. When the Layout
Plug-In is started the next time, the setting values from the previous time are used.

• Execute button
When this button is clicked, the Print Plug-In for Photoshop starts. To print the created layout image, click the Print
button in the Print Plug-In for Photoshop main window.

Important

• When you close the Print Plug-In, the created layout image is discarded.

Note

• If the Print Plug-In for Photoshop for multiple different models is installed, a screen for selecting the model is displayed when
you click the Execute button.

• When you close Print Plug-In for Photoshop main window after printing, the Layout Plug-In main window is displayed again.

• If the size of the layout image is larger than the paper size that can be printed by the printer, you should reduce the size of the
layout image to the output paper size in advance before printing.

Add Canvas Size dialog boxAdd Canvas Size dialog box
This dialog box is displayed when you click the Add Canvas Size button in the Layout Plug-In main window. It allows
you to register and delete arbitrary canvas sizes (custom canvas sizes).

Click the Close button to close the Add Canvas Size dialog box.

Adding a Canvas Size

1 Specify the units for the width and height of the canvas size you are adding in Units.
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2 Enter the width and height of the canvas size you are adding in Size.
When you select a size displayed in the Paper Size List, the values are displayed in the Width and Height in
the Size field. When Input Image Size is selected, the size of the input image is used as-is for the width and
height of the canvas.
Selecting the Create the Image with a Fixed Aspect Ratio check box allows you to create a custom size at
the same aspect ratio as the input image. For example, if you change the width, then the height also changes
according to the aspect ratio of the input image.

3 Enter the name of the canvas size to add in Custom Canvas Size Name.

4 Click the Add button.

Deleting a Canvas Size

1 Select the Custom Canvas Size Name you want to delete from the Paper Size List.

2 Click the Delete button.

Note

• Sizes that have a red circle in the Name cannot be deleted.

Creating and Printing a Layout Image for Mounting on a FrameCreating and Printing a Layout Image for Mounting on a Frame
The procedure for creating and printing a layout image for mounting on a frame is as follows.

1 Start Photoshop.

2 Open the image to lay out and edit the image in Photoshop as needed.

3
 

Select imagePROGRAF Layout Plug-In from Auto-
mate in the Photoshop File menu.
Run the Layout Plug-In to display the Layout Plug-In
Main Window.

Note

• The Layout Plug-In can handle images with a width and height of less than 60,000 pixels. For images with a width or
height of 60,000 pixels or more, either reduce the selection range or reduce the image through image processing
before performing step 3.
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4 Select the canvas size that matches the frame for mounting the image and create a layout image by adding
effects such as frame side effects.
For details, see "Layout Plug-In Main Window." →P.311

Important

• The created layout image cannot be modified in Photoshop.

5 Once you have finished creating the layout image, run the Print Plug-In for Photoshop and print on paper that
is larger than the size of the layout image.

Important

• When you click the Close button to close the Layout Plug-In, the created layout image is discarded.

6 Mount the printed layout image on the frame.

Important

• Fully dry the printed paper before mounting it on the frame.

• Take care when mounting on the frame. The ink may peel off if you touch the printed surface.

Note

• As you fold the printed paper along the frame, the folded areas may crack and reveal the paper underneath, depending on the
media type. You can prevent the folded areas from splitting to some degree by using commercially available inkjet protection
spray or liquid laminating agent for inkjets before folding.
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Print Plug-In for Office featuresPrint Plug-In for Office features
Print Plug-In for Office is a Plug-In that enables easy printing from Microsoft Office.

• It is displayed on the toolbar/ribbon, so it is easily accessible.
• It can be set by just selecting from the Wizard.

• Large-Format Printing custom size can also be set in the Wizard from Microsoft Word or Microsoft Power-
Point.

• Custom size can be set automatically from Microsoft Excel.
• The layout can be checked before printing by starting the preview screen.

Note

• 64 bit edition Windows OS operates only on WOW64 (32 bit emulator).

Important

• The Print Plug-In for Office toolbar/ribbon might not be displayed in Microsoft Office after installing imagePROGRAF
Print Plug-In for Office. For details, refer to When Print Plug-In for Office is not displayed →P.320 .

• If you opened the Office document from Internet Explorer, the software will not run correctly.

• If you are editing an embedded object or link object, the software will not run correctly.

• If you added the imagePROGRAF Print Plug-In ribbon to the Microsoft Office 2007/2010 Quick Access toolbar, the soft-
ware will not run correctly.
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Steps to installSteps to install
Below are the steps to install Print Plug-In for Office.

Note

• You must log into Windows as an Administrator before the installation.

1 Insert "User Software CD-ROM" into the CD-ROM drive and start the installer.

Note

• If the installer screen does not display, open the CD-ROM icon from My Computer, click setup.exe, and open the
icon.

2
 

Click the Install Individual Software button.

3
 

Click Install in imagePROGRAF Print Plug-In for Of-
fice.
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4
 

Click the Next button.

5
 

Read the License Agreement, and click the Yes but-
ton.

6
 

Click the Start button.
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7
 

Click the Yes button.

8
 

Click the Exit button.

The installation for Print Plug-In for Office is com-
plete.

Important

• When you install this software, the virtual printer Canon imagePROGRAF PrintPlugIn may be installed. If you want to use
this software, do not uninstall the virtual printer Canon imagePROGRAF PrintPlugIn.

• The Print Plug-In for Office toolbar/ribbon might not be displayed in Microsoft Office after installing imagePROGRAF
Print Plug-In for Office.
Refer to the following topic for details on how to display the imagePROGRAF Print Plug-In for Office toolbar/ribbon.

• When Print Plug-In for Office is not displayed →P.320

Steps to uninstallSteps to uninstall
Below are the steps to uninstall Print Plug-In for Office.

1 If Microsoft Office is open, close it.

2 Select Control Panel from the start menu.

3 Open Add or Remove Programs.
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4
 

Select imagePROGRAF Print Plug-In, and click the
Remove button.

Note

• You cannot uninstall Print Plug-In for Office if an Office application is running. When a message appears, select Cancel and
close all Office applications that are running.

When Print Plug-In for Office is not displayedWhen Print Plug-In for Office is not displayed
Buttons such as Start imagePROGRAF Print Plug-In sometimes do not appear in the Word, PowerPoint and Excel
Office applications, and the Print Plug-In for Office functions are not available.
In this event, re-install Print Plug-In for Office.
If you are using Microsoft Office 2003 or later, you can also enable add-ins to display Print Plug-In for Office.
See below for the procedure for re-installing the plug-in or enabling add-ins.

Re-installing Print Plug-In for Office
If a problem occurs, such as the system or an application terminating abnormally, the Microsoft Office application dis-
ables add-ins as a safety precaution.
In this event, you will need to re-install Print Plug-In for Office to display the imagePROGRAF Print Plug-In toolbar/
ribbon.

Note

• You cannot re-install Print Plug-In for Office once an Office application is running. When the message appears, select Can-
cel and close the active Office application.

Re-install Print Plug-In for Office as follows:

1 Close Microsoft Office if it is open.

2 Install Print Plug-In for Office.
For information about instsalling, see "Steps to install." →P.317

Enabling Print Plug-In for Office for items disabled in Office applications
If a problem occurs, such as the system or an application terminating abnormally, the Microsoft Office application dis-
ables add-ins as a safety precaution.
In this event, you will need to restore the disabled add-ins in order to display the imagePROGRAF Print Plug-In tool-
bar/ribbon.
Use the procedure below to restore the add-ins disabled by Microsoft Office.
 

• For Microsoft Office 2010
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1
 

Select Options from the File menu.

2 From the list on the left side of the <application name> options dialog box, select Add-ins.

3
 

Select Disabled Items in the Manage combo box and
click the Go button.

4
 

If Addin imageprograf print plug-in (ipfaddinif.dll) is dis-
played in the Disabled Items dialog box, select it and click the
Enable button.

5 Close all the dialog boxes and restart the Office application.

• For Microsoft Office 2007
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1
 

Click the Office button and then click the <application
name> options button.

2 From the list on the left side of the <application name> options dialog box, select Add-ins.

3
 

Select Disabled Items in the Manage combo box and
click the Go button.
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4
 

If Addin imageprograf print plug-in (ipfaddinif.dll) is
displayed in the Disabled Items dialog box, select it
and click the Enable button.

5 Close all the dialog boxes and restart the Office application.

• For Microsoft Office 2003

1
 

Click About <application name> in the Help menu of applica-
tion.

2
 

Click the Disabled Items button in the About <appli-
cation name> dialog box.
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3
 

If Addin imageprograf print plug-in (ipfaddinif.dll) is
displayed in the Disabled Items dialog box, select it
and click the Enable button.

4 Close all the dialog boxes and restart the Office application.

To start from Microsoft WordTo start from Microsoft Word
Below are the steps to start Print Plug-In for Office from Microsoft Word.

1 Start Microsoft Word.

2
 

If Start imagePROGRAF Print Plug-In is displayed on the toolbar/
ribbon, click it.

Important

• If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.

• When Print Plug-In for Office is not displayed →P.320

3
 

Check that the imagePROGRAF Print Plug-In toolbar/ribbon
is displayed.

4 Click the buttons on the toolbar/ribbon according to the items you want to set.
Icon Contents

Menu

Displays the About, Help, and Special Settings dialog boxes.
You can change the settings using the Special Settings dialog box.
Refer to Configuring Special Settings →P.355  for details.

Printer list

Select Printer.
If you select Show All Printers, the imagePROGRAF printers will be displayed again. Select
this when you want to display all printer drivers or update the display.

Print Button

The print Wizard is displayed.
The settings Print Matching Roll Width, Borderless Printing, Multi-Page Printing, and Print
Using Registered Settings can be set.

Paper Settings Button

Large-Format Wizard is displayed.
Settings for Portrait or Landscape Orientation can be set.
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   Printing Wizard dialog box

Important

• If you want to change the display to another file or application while the Printing Wizard is open, close the Printing
Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar.

   Large-Format Printing Wizard dialog box

Important

• If you want to change the display to another file or application while the Large-Format Printing Wizard is open,
close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

• The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

Print Matching Roll Width (Word)Print Matching Roll Width (Word)
Prints to the edge of the roll width. You can print large exhibits and posters, and also print Portrait and Landscape ori-
entations made in Large-Format Printing Wizard.

1 Start Microsoft Word.
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2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important

• If you want to change the display to another file or application while the Printing Wizard is open, close the Printing
Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/ribbon.

4
 

Click Print Matching Roll Width.

5 Select Roll Paper Width that is set in the printer.

6 Select image size.

7 Select layout.
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8
 

Select Next.

9 Select Media Type.

10 Select Print Range from All Pages, Current Page, and Pages.
If Pages is selected, enter the number of pages.

11 Enter Copies.

Note

• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to need print
multiple times using the same setting.

• Press the Print Preview button to display the preview screen. You can check and make changes to the layout in the
preview screen.

• When you print to the edge of the roll width, the maximum length will be the lesser of 5.587 times the roll paper
width, or 18.0m.

12 Press Print to start printing.

Borderless Printing (Word)Borderless Printing (Word)
Prints up to the border of the media. Photos and posters can be printed without worrying about margins.

1 Start Microsoft Word.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.
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3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important

• If you want to change the display to another file or application while the Printing Wizard is open, close the Printing
Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/ribbon.

4
 

Click Borderless Printing.

5 A confirmation dialog box is displayed. If the data fills up the page, confirm that Continue using the plug-in is
selected in Choose how to proceed and press OK.

Note

• To adjust the data, select Return to application and press OK. Exit Print Plug-In for Office and return to the appli-
cation.
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6 Select Roll Paper Width that is set in the printer.

7 Select Layout.

8
 

Select Next.

9 Select Media Type.

10 Select Print Range from All Pages, Current Page, and Pages.
For Pages, insert the page number.

11 Enter Copies.

Note

• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• Press the One-Touch Registration button to register the settings. This is useful for multiple printing using the same
settings.

• Press the Print Preview button to display the preview screen. You can confirm and make changes to the layout in
the preview screen.

• The maximum length for Borderless Printing is the lesser of 5.587 times the roll paper width, or 18.0m.
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12 Press Print to start printing.

Multi-Page Printing (Word)Multi-Page Printing (Word)
Prints multiple pages as one page. You can print handouts into a single page, or print matter with many pages.

1 Start Microsoft Word.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important

• If you want to change the display to another file or application while the Printing Wizard is open, close the Printing
Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/ribbon.

4
 

Click Multi-Page Printing.

5 Select the Roll Paper Width that is set in the printer.

6 Select layout from Layout Selection.
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7
 

Select Next.

8 Select Media Type.

9 Select Print Range from All Pages, Current Page, and Pages.
If Pages is selected, enter the number of pages.

10 Enter Copies.

Note

• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to need print
multiple times using the same setting.

• Press the Print Preview button to display the preview screen. You can check and make changes to the layout in the
preview screen.

• The maximum length for Multi-Page Printing is the lesser of 5.587 times the roll paper width, or 18.0m.

11 Press Print to start printing.

Register the settings (Word)Register the settings (Word)
If you are going to print multiple times using the same setting, you can select One-Touch Registration. Registered
settings can be recalled from Print Using Registered Settings.

1 Set up to the Print screen from Print Matching Roll Width, Borderless Printing or Multi-Page Printing of
Printing Menu.

Note

• Up to 20 items can be registered.
• The available settings are as follows.

• Print Matching Roll Width (Word) →P.325

• Borderless Printing (Word) →P.327

• Multi-Page Printing (Word) →P.330
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2
 

Click the One-Touch Registration button.

3 Enter name in Name.
Up to 31 characters can be entered.

4 Click . The name you entered is displayed in Registered Settings.

5 Click OK, and return to the Print screen.

6 Click Print to print, and click Cancel to cancel the print.

Note

• Clicking Cancel in the Print screen will not delete the registered settings.

Print Using Registered Settings (Word)Print Using Registered Settings (Word)
Prints using the registered settings.

1 Start Microsoft Word.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.
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Important

• If you want to change the display to another file or application while the Printing Wizard is open, close the Printing
Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/ribbon.

4
 

Click Print Using Registered Settings.

5
 

Click the Next button.

6 Select Media Type.

7 Select Print Range from All Pages, Current Page, or Pages.
If Pages is selected, enter the number of pages.

8 Enter Copies.

Note

• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• Press the Print Preview button to display the preview screen. You can check and make changes to the layout in the
preview screen.

• The maximum print length when printing with the registered settings is the lesser of 5.587 times the roll paper width,
or 18.0m.
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9 Press Print to start printing.

Portrait Orientation / Landscape Orientation (Word)Portrait Orientation / Landscape Orientation (Word)
Print to the edge of the roll width. You can print large exhibits and posters, or print the Landscape or Portrait Orienta-
tion Page Sizes made in the Large-Format Printing Wizard.

Create Page Size in Portrait or Landscape Orientation.
Use the Large-Format Printing Wizard to create portrait page sizes for Potrait Orientation, and landscape page sizes
for Landscape Orientation.

1 Start Microsoft Word.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3 Click Paper Settings from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Large-Format Printing Wizard dialog box is displayed.

Note

• If you want to change the display to another file or application while the Large-Format Printing Wizard is open,
close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4 Click Portrait Orientation or Landscape Orientation.

Note

• The steps taken to create a Portrait Page Size will be used as an example to explain the procedure.
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5 Adjust Length from the list-box or slide-bar.

6 Click the Create Page button.

7
 

Click OK if the message is displayed.

8 Edit and create the document.

Note

• Printing is done in Print Matching Roll Width of the Printing Wizard. For details on Print Matching Roll Width,
see "Print Matching Roll Width (Word)." →P.325

Important

• The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

To start from Microsoft PowerPointTo start from Microsoft PowerPoint
Below are the steps to start Print Plug-In for Office from Microsoft PowerPoint.

1 Start Microsoft PowerPoint.

2
 

If Start imagePROGRAF Print Plug-In is displayed on the toolbar/
ribbon, click it.
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Important

• If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.

• When Print Plug-In for Office is not displayed →P.320

3
 

Check that the imagePROGRAF Print Plug-In toolbar/ribbon
is displayed.

4 Click the buttons on the toolbar/ribbon according to the items you want to set.
Icon Contents

Menu

Displays the About, Help, and Special Settings dialog boxes.  (See "Configuring Special Set-
tings.") →P.355

Printer list

Select Printer.
If you select Show All Printers, the imagePROGRAF printers will be displayed again. Select
this when you want to display all printer drivers or update the display.

Print Button

The print Wizard is displayed.
The settings Print Matching Roll Width, Borderless Printing, Multi-Page Printing, and Print
Using Registered Settings can be set.

Paper Settings Button

Large-Format Wizard is displayed.
Settings for Portrait or Landscape Orientation can be set.

   Printing Wizard dialog box

Important

• If you want to change the display to another file or application while the Printing Wizard is open, close the Printing
Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/ribbon.

Note

• If you open a password protected document as read-only, the Printing Wizard cannot be run.
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   Large-Format Printing Wizard dialog box

Important

• If you want to change the display to another file or application while the Large-Format Printing Wizard is open,
close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

• The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

Note

• If you open a password protected document as read-only, the Large-Format Printing Wizard cannot be run. Re-
move the password protection.

Print Matching Roll Width (PowerPoint)Print Matching Roll Width (PowerPoint)
Prints to the edge of the roll width. You can print large exhibits and posters, and also print Portrait and Landscape ori-
entations made in Large-Format Printing Wizard.

1 Start Microsoft PowerPoint.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.
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3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important

• If you want to change the display to another file or application while the Printing Wizard is open, close the Printing
Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/ribbon.

4
 

Click Print Matching Roll Width.

5 Select Roll Paper Width that is set in the printer.

6 Select image size.

7 Select layout.
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8
 

Select Next.

9 Select Media Type.

10 Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

11 Enter Copies.

Note

• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to need print
multiple times using the same setting.

• Press the Print Preview button to display the preview screen. You can check and make changes to the layout in the
preview screen.

• When you print to the edge of the roll width, the maximum length will be the lesser of 14.22 times the roll paper
width, or 18.0m.

12 Press Print to start printing.

Borderless Printing (PowerPoint)Borderless Printing (PowerPoint)
Prints up to the border of the media. Photos and posters can be printed without worrying about margins.

1 Start Microsoft PowerPoint.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.
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3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important

• If you want to change the display to another file or application while the Printing Wizard is open, close the Printing
Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/ribbon.

4
 

Click Borderless Printing.

5 A confirmation dialog box is displayed. If the data fills up the page, confirm that Continue using the plug-in is
selected in Choose how to proceed and press OK.

Note

• To adjust the data, select Return to application and press OK. Exit Print Plug-In for Office and return to the appli-
cation.
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6 Select Roll Paper Width that is set in the printer.

7 Select Layout.

8
 

Select Next.

9 Select Media Type.

10 Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

11 Enter Copies.

Note

• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• Press the One-Touch Registration button to register the settings. This is useful for multiple printing using the same
settings.

• Press the Print Preview button to display the preview screen. You can confirm and make changes to the layout in
the preview screen.

• The maximum length for Borderless Printing is the lesser of 14.22 times the roll paper width, or 18.0m.
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12 Press Print to start printing.

Multi-Page Printing (PowerPoint)Multi-Page Printing (PowerPoint)
Prints multiple pages as one page. You can print handouts into a single page, or print matter with many pages.

1 Start Microsoft PowerPoint.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important

• If you want to change the display to another file or application while the Printing Wizard is open, close the Printing
Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/ribbon.

4
 

Click Multi-Page Printing.

5 Select the Roll Paper Width that is set in the printer.

6 Select layout from Layout Selection.
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7
 

Select Next.

8 Select Media Type.

9 Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

10 Enter Copies.

Note

• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to need print
multiple times using the same setting.

• Press the Print Preview button to display the preview screen. You can check and make changes to the layout in the
preview screen.

• The maximum length for Multi-Page Printing is the lesser of 14.22 times the roll paper width, or 18.0m.

11 Press Print to start printing.

Register the settings (PowerPoint)Register the settings (PowerPoint)
If you are going to print multiple times using the same setting, you can select One-Touch Registration. Registered
settings can be recalled from Print Using Registered Settings.

1 Set up to the Print screen from Print Matching Roll Width, Borderless Printing or Multi-Page Printing of
Printing Menu.

Note

• Up to 20 items can be registered.
• The available settings are as follows.

• Print Matching Roll Width (PowerPoint) →P.337

• Borderless Printing (PowerPoint) →P.339

• Multi-Page Printing (PowerPoint) →P.342
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2
 

Click the One-Touch Registration button.

3 Enter name in Name.
Up to 31 characters can be entered.

4 Click . The name you entered is displayed in Registered Settings.

5 Click OK, and return to the Print screen.

6 Click Print to print, and click Cancel to cancel the print.

Note

• Clicking Cancel in the Print screen will not delete the registered settings.

Print Using Registered Settings (PowerPoint)Print Using Registered Settings (PowerPoint)
Prints using the registered settings.

1 Start Microsoft PowerPoint.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.
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Important

• If you want to change the display to another file or application while the Printing Wizard is open, close the Printing
Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/ribbon.

4
 

Click Print Using Registered Settings.

5
 

Click the Next button.

6 Select Media Type.

7 Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

8 Enter Copies.

Note

• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• Press the Print Preview button to display the preview screen. You can check and make changes to the layout in the
preview screen.

• The maximum print length when printing with the registered settings is the lesser of 14.22 times the roll paper width,
or 18.0m.
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9 Press Print to start printing.

Portrait Orientation / Landscape Orientation (PowerPoint)Portrait Orientation / Landscape Orientation (PowerPoint)
Print to the edge of the roll width. You can print large exhibits and posters, or print the Landscape or Portrait Orienta-
tion Page Sizes made in the Large-Format Printing Wizard.

Create Page Size in Portrait or Landscape Orientation.
Use the Large-Format Printing Wizard to create portrait page sizes for Potrait Orientation, and landscape page sizes
for Landscape Orientation.

1 Start Microsoft PowerPoint.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3
 

Click Paper Settings from the imagePROGRAF Print
Plug-In toolbar/ribbon.
The Large-Format Printing Wizard dialog box is dis-
played.

Important

• If you want to change the display to another file or application while the Large-Format Printing Wizard is open,
close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4 Click Portrait Orientation or Landscape Orientation.

Note

• The steps taken to create a Portrait Page Size will be used as an example to explain the procedure.
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5 Adjust Length from the list-box or slide-bar.

6 Click the Create Page button.

7
 

Click OK if the message is displayed.

8 Edit and create the document.

Important

• The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

Note

• Printing is done in Print Matching Roll Width of the Printing Wizard. For details on Print Matching Roll Width,
see "Print Matching Roll Width (PowerPoint)." →P.337

To start from Microsoft ExcelTo start from Microsoft Excel
Below are the steps to start Print Plug-In for Office from Microsoft Excel.

1 Start Microsoft Excel.

2
 

If Start imagePROGRAF Print Plug-In is displayed on the toolbar/
ribbon, click it.
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Important

• If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.

• When Print Plug-In for Office is not displayed →P.320

3
 

Check that the imagePROGRAF Print Plug-In toolbar/ribbon is
displayed.

4 Click the buttons on the toolbar/ribbon according to the items you want to set.
Icon Contents

Menu

Displays the About, Help, and Special Settings dialog boxes.  (See "Configuring Special Set-
tings.") →P.355

Printer list

Select Printer.
If you select Show All Printers, the imagePROGRAF printers will be displayed again. Select
this when you want to display all printer drivers or update the display.

Print Button

The print Wizard is displayed.
The settings Print Entire Sheet and Print Selected Area can be set.

   Printing Wizard dialog box

Important

• If you want to change the display to another file or application while the Printing Wizard is open, close the Printing
Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/ribbon.

• The Printing Wizard will not start if you click the Print button on the toolbar/ribbon while editing a cell.

• When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one worksheet and
click Print again.

• When an object is selected, the Printing Wizard is not started if you click the Print button on the toolbar/ribbon.

• If the paper size in Excel is blank, the Printing Wizard cannot be run. From the File menu in Excel, select Page
Setup and check Paper size.
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Note

• If you click the Print button with a graph selected, a message dialog box will appear asking if you want to continue
printing. If you click No, you will return to the application.

• If you click the Print button with a page break set, a message dialog box will appear asking if you want to continue
printing. If you click No, you will return to the application. If you do not use the set page break, check the page break
preview and change the setting.

• If you click the Print button with a page range set, a message dialog box will appear asking if you want to continue
printing. If you click No, you will return to the application. If you do not use the set page range, check the page break
preview and change the setting.

• If you click the Print button with a worksheet or cell protected, a message dialog box will appear asking if you want
to continue printing. If you click No, you will return to the application. If you want to change the setting, remove the
protection from the worksheet or cell.

Print Entire Sheet (Excel)Print Entire Sheet (Excel)
For resizing the entire sheet to fit the roll width. Choose this option to enlarge the currently displayed sheet before print-
ing.

1 Start Microsoft Excel.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3 Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.

Important

• When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one worksheet and
click Print again.

If a print area is set, a confirmation message dialog box
will appear.
To print the entire sheet, cancel the setting of the print
area.
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The Printing Wizard dialog box is displayed.

4
 

Click Print Entire Sheet.
A message will appear informing you that analysis is in
progress.

The Layout menu will appear automatically.

Note

• If data analysis requires time, a message dialog will appear. If you select No, you will return to the application.
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5 Select Roll Paper Width that is set in the printer.

6 Select image size.

7 Select layout.

8 To configure Binding, click the Binding Settings button.
Refer to Configuring Binding (Excel) →P.354  for details on the procedure for configuring Binding.

9
 

Select Next.

10 Select Media Type.

11 Enter Copies.

Note

• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• Press the Print Preview button to display the preview screen. You can check and make changes to the layout in the
preview screen.

• When you print to the edge of the roll width, the maximum print length is 18.0m.

12 If the upper and lower margins are too wide, check No Spaces at Top or Bottom (Conserve Paper).
The upper and lower margins can be checked in Print Preview.

13 Press Print to start printing.

Important

• If divided into plural pages, try reducing the data size or the range you select.

• You cannot run Print or Print Preview if you select it for a worksheet with no data displayed.

Print Selected Area (Excel)Print Selected Area (Excel)
For resizing the selected range of cells to fit the roll width. Choose this option to enlarge a particular part of the sheet
before printing.

1 Start Microsoft Excel.
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2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3 Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.

Important

• When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one worksheet and
click Print again.

If a print area is set, a confirmation message dialog box
will appear.
To print the selected area, cancel the setting of the print
area.

The Printing Wizard dialog box is displayed.

4 Click Print Selected Area.

Important

• If only one cell is selected, Print Selected Area cannot be selected.
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A message will appear informing you that analysis is in
progress.

The Layout menu will appear automatically.

Important

• If the range selected in Excel 2007/2010 is too large, it will not be possible to analyze the data. Select a smaller
range and then run the analysis.

Note

• If data analysis requires time, a message dialog will appear. If you select No, you will return to the application.

5 Select Roll Paper Width that is set in the printer.

6 Select image size.

7 Select layout.

8 To configure Binding, click the Binding Settings button.
Refer to Configuring Binding (Excel) →P.354  for details on the procedure for configuring Binding.
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9
 

Select Next.

10 Select Media Type.

11 Enter Copies.

Note

• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• Press the Print Preview button to display the preview screen. You can check and make changes to the layout in the
preview screen.

• When you print to the edge of the roll width, the maximum print length is 18.0m.

12 If the upper and lower margins are too wide, check No Spaces at Top or Bottom (Conserve Paper).
The upper and lower margins can be checked in Print Preview.

13 Press Print to start printing.

Important

• If divided into plural pages, try reducing the data size or the range you select.

• You cannot run Print or Print Preview if you select it for a worksheet with no data displayed.

Configuring Binding (Excel)Configuring Binding (Excel)
You can configure Binding margins for binding printouts.

1 Configure the settings up to Layout Selection in the Layout screen in Print Entire Sheet or Print Selected
Area.
Refer to Print Entire Sheet (Excel) →P.349  and Print Selected Area (Excel) →P.351  for the configuration meth-
ods.

2 Click the Binding Settings button.

Important

• You cannot click the Binding Settings button in the following situations.

• When the Image Size is set to 100%
• When a graph is selected
• When page breaks have been set
• When a sheet or cell is protected
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Open the Binding Settings dialog box.

3 If the Binding checkbox is not checked, select it to turn binding on.

4 Select Binding Edge.

5 Select Binding Margin.

6
 

Click the OK button.
Return to the Layout screen.

Check that the Binding settings are applied in the pre-
view screen.

7 Configure the settings in the Printing Wizard dialog box.

Configuring Special SettingsConfiguring Special Settings
You can configure Special Settings from the imagePROGRAF Print Plug-In toolbar.

1
 

Click imagePROGRAF in the toolbar, and select Spe-
cial Settings.

2 Turn the checkbox for the item you want to change on or off.
Item Details

Show progress indicator during plug-in startup When this setting is off, hides the progress indicator that appears while the plug-
in is starting up.
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Item Details
Center sheets and print areas When this setting is off, printing is performed without changing the position.

When this setting is on, printing is performed with the top, bottom, left, and right
margins layed out equally. When this setting is off, printing is performed without
changing the position.
This function is only valid in Microsoft Excel.

Ensure image quality when creating page sizes When this setting is on, documents are created at the maximum size. This re-
duces the enlargement ratio during actual printing, which minimizes degradation
of the quality of photos, etc.
This function is only valid in [ Microsoft PowerPoint.

Correct the print area when analyzing For data that cannot be processed with usual data analysis, the print area is cor-
rected and then the data is processed. When data analysis fails, you may be able
to print by turning on this checkbox.
This function is only valid in Microsoft Excel.

3 Click OK to close the Special Settings dialog box.
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Printer Driver SettingsPrinter Driver Settings
For instructions on accessing the Mac OS X printer driver, refer to the following topics.

• Accessing the Printer Driver Dialog Box from Applications →P.364

For information on the Mac OS X printer driver settings, refer to the following topics.

• Main Pane →P.364
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You can specify the media type, color processing, print quality, print preview, and other settings. Choose Easy
Settings to specify basic print settings based on the printing application or Advanced Settings to complete more
detailed settings as desired.

• Paper Detailed Settings Dialog Box →P.368
• View settings Dialog Box for the Printing Application →P.370
• Color Settings Pane: Color →P.373
• Object Adjustment dialog box: Color →P.374
• Matching pane →P.370
• Color Settings Pane: Monochrome →P.375
• Object Adjustment dialog box: Monochrome →P.376
• Gray Adjustment Pane →P.376

• Page Setup Pane →P.378
You can specify the page size of the original, borderless printing, enlargement or reduction, the orientation, the
paper size and source, and automatic cutting.

• Utility Pane →P.379
You can specify settings related to maintenance for the Printhead and feed amount, as well as settings for Color
imageRUNNER Enlargement Copy.

• Additional Settings Pane →P.380
You can specify settings for how print jobs are sent to the printer.

• Support Pane →P.380
You can view support information and the user's manual.

With the imagePROGRAF Free Layout feature, you can arrange originals from various source applications on a single
page before printing. For details, see Free Layout →P.410 .
With the imagePROGRAF Preview feature, you can check the layout before printing and adjust layout or size settings
while viewing a preview screen. For details, see Preview →P.382 .
With the Color imageRUNNER Enlargement Copy feature, you can automatically enlarge and print scanned originals
from a Color imageRUNNER. For details, see Color imageRUNNER Enlargement Copy →P.441 .

iPF9400                                                                                                                                                                                      Printer Driver Settings (Mac OS X)

User's Guide                                                                                                                                                                                                                                       

  

M
ac O

S X Softw
are

Printer D
river

359  



Specifying Paper in the Printer DriverSpecifying Paper in the Printer Driver
If you have replaced the paper, you must complete the following settings in the printer driver.

1 This sets the BFormat for and CPaper Size.

Note

• The configuration method varies depending on the OS and
application software you are using.
If Page Setup is displayed in the application menu, the set-
tings are configured by opening the Page Attributes dialog
box from Page Setup.

If it is not displayed, the settings are configured in the up-
per part of the printer driver displayed when you select
Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 Choose the original size in the FPaper Size list.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.

5
 

Access the Main pane.

6 In the AMedia Type list, select the type of paper that is loaded.
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7
 

Access the Page Setup pane.

8 In the APaper Source list, select how paper is supplied.

9 If you have selected Cut Sheet in APaper Source, make sure the size as selected in Page Setup is dis-
played in CPage Size. If you have selected roll paper in APaper Source, make sure the width of the loaded
roll is displayed in BRoll Width.

Note

• If the width of the roll loaded in the printer is not shown in
B Roll Width, click L Printer Information on the Main
pane to update the printer information.

 

Note

• A variety of settings are available in the printer driver to suit different printing applications.
For details on available printing conditions, see "Printer Driver Settings →P.358 "
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Confirming Print SettingsConfirming Print Settings
There are two ways to confirm what printing conditions have been specified, as follows.

Checking a preview of the settings
A preview of the settings is displayed on the left side of the Main, Page Setup, Utility, and Additional Settings
panes.By checking images and numerical values in the preview, you can confirm current settings for the page size,
orientation, paper source, and so on.

Display Area Information Displayed

Pane displayed when the H Images
tab is clicked

On top, illustrations indicate the page size of the original, the paper size, orientation, layout, bor-
derless printing selection, color mode, and other settings information.
Under this, the page size, paper size, and method and percentage of enlargement or reduction is
displayed.

Pane displayed when the I Size tab is
clicked

Paper size details are indicated numerically.

Pane with printer and paper illustrations Illustrations indicate the paper source, orientation, borderless printing selection, and other set-
tings information.

Note

• To confirm the Print Target specified in Easy Settings, click G View set. on the Main pane to display the View settings
dialog box.

Checking a print preview
You can check an image of the original just as it will be printed.
Confirming the image of print jobs beforehand helps prevent printing errors.
For details on print previews, see "Checking the Layout in a Preview Before Printing →P.158 "

Checking the Layout in a Preview Before PrintingChecking the Layout in a Preview Before Printing
This topic describes how to check the layout before printing using the Canon imagePROGRAF Preview function.

1 Choose Print in the application menu.
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2
 

Access the Main pane.

3 Select the OPrint Preview check box.

4 Click MPrint.

5
 

The Canon imagePROGRAF Preview window is dis-
played.

6 Check the layout and adjust settings in the Canon imagePROGRAF Preview window as desired.

7 Print from the Canon imagePROGRAF Preview menu.

Note

• For details on imagePROGRAF Preview functions, refer to Preview →P.382 .

Using FavoritesUsing Favorites
You can use the Presets function in Mac OS X for favorite-based printing.

Note

• In the printing dialog box, click Save As in the Presets list to save the current print settings. This is a standard feature of the
operating system. For details, refer to the Mac OS documentation.
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Accessing the Printer Driver Dialog Box from ApplicationsAccessing the Printer Driver Dialog Box from Applications

1 In the application software, select Print from the File menu to display the dialog box for printing conditions.

Note

• This dialog box includes basic printing options and enables you to choose the printer, specify the range of pages,
number of copies, and so on.

2
 

Select the printer in the Printer list.

3
 

Click Print to start printing.
As shown in the following illustration, you can switch to
other panes in this dialog box to complete settings for
various methods of printing, including enlarged and re-
duced printing, borderless printing, and so on.

Main PaneMain Pane
The following settings are available on the Main pane. For details on settings items, refer to the printer driver help.

Note

• On the Main pane, choose Easy Settings to specify basic print settings based on the print target, or switch to Advanced
Settings to complete more detailed settings as desired.
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Common Items

• AMedia Type
Select the paper type.
For information on the types of paper the printer supports, refer to the Paper Reference Guide. (See " Paper Refer-
ence Guide".)

• BGet Information
Displays Paper Information on Printer. You can update the printer driver settings for the feed source, media
type, and roll width by selecting the feed source.

• Paper Information on Printer Dialog Box →P.367

• CSet
Displays Paper Detailed Settings. You can configure the printing settings to match the type of media, such as the
ink drying time.

• Paper Detailed Settings Dialog Box →P.368

• OPrint Preview
If you turn this on, imagePROGRAF Preview starts before printing.
This allows you to check on-screen previews of documents before printing.

Important

• When Free Layout is selected on the Page Setup panel, Free Layout is disabled.

• Checking the Layout in a Preview Before Printing →P.158

• LPrinter Information
Displays the Printer Information dialog box, which shows printer information such as ink levels and the calibration
history.

Note

• Each of the B Get Information, C Set, and L Printer Information buttons may not be usable depending on the appli-
cation type and OS version.
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Configuration using Easy Settings

• EPrint Target
Choose presets that match the type of document to be printed.

• Printing Photos and Images →P.37
• Printing Office Documents →P.48

• FPrint Quality
Choose the level of print quality.

• GView set.
Click to display the View settings dialog box, which enables you to confirm the settings for the selected item from
the EPrint Target list or change the order of items listed in EPrint Target.

• View settings Dialog Box for the Printing Application →P.370

Configuration using Advanced Settings

• EPrint Priority
Choose the graphic elements that you want to emphasize for printing.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.61
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• FPrint Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.61

• G Input Bit Depth
Choose the levels of gradation in print data, either 8-bit or 16-bit. Optimal results when printing data with rich gra-
dation are possible by choosing 16-bit. For example, this option is particularly suited to printing images created
after specifying 16 bits per channel in Photoshop.

• RFast Graphic Process
Select this option to print faster than usual, when possible.

• HColor Mode
Choose the color mode.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.61

• ISet
Click to display the Color Settings dialog box for more advanced color settings.

• Adjusting the Color in the Printer Driver →P.54

• JUnidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the
printing speed becomes slower.

• QThicken Fine Lines
Activate this option to print fine lines more distinctly.

Paper Information on Printer Dialog BoxPaper Information on Printer Dialog Box
On the Paper Information on Printer dialog box, you can obtain information on the paper in the printer and configure
printer driver media type setting.

Note

• To display the Paper Information on Printer dialog box, on the Main pane, click Get Information by Media Type.(See "Main
Pane →P.364 ")

• APaper Source
Shows the Paper Source supported by the printer, as well as the type of paper loaded. To update the media type
setting in the printer driver, select the desired Paper Source option and click OK.
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Paper Detailed Settings Dialog BoxPaper Detailed Settings Dialog Box
The Paper Detailed Settings dialog box offers the following settings. For details on settings items, refer to the printer
driver help.

Note

• To display the Paper Detailed Settings dialog box, on the Main pane, click Set by Media Type.(See "Main Pane →P.364 ")

AMedia Type
The paper selected with Media Type of the Main panel is displayed.
For information on the types of paper the printer supports, refer to the Paper Reference Guide. (See " Paper Reference
Guide".)

BDrying Time
Specify the time that the printer waits for ink to dry, as needed. The Drying Time setting is only valid for rolls.

• CBetween Pages
You can set the time to wait after printing 1 document page until ejecting the paper. Since waiting time is required
for ink to dry before a roll is cut, you can deliver paper in the Output Stacker with the ink dried even if Cutting
Mode is set to Automatic.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

None Paper is ejected immediately after printing completes.

30 sec. / 1 min. / 3 min. / 5 min. / 10
min. / 30 min. / 60 min.

Paper is ejected when the set time elapses after printing completes.

• DBetween Scans
You can set the time to wait after printing 1 line on a page until printing the next line. Set this to avoid bleeding or
color unevenness such as when bleeding occurs on a page or when color unevenness occurs during borderless
printing.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

None The next line is printed immediately after a line is printed.
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Setting Item Details
1 sec. / 3 sec. / 5 sec. / 7 sec. / 9 sec. The next line is printed when the set time elapses after a line is printed.

 

* Increase the time according to the occurrence condition of bleeding or unevenness.

ERoll Paper Margin for Safety
You can specify the length of a margin on the leading edge of paper to ensure that paper susceptible to curling is held
firmly against the Platen.

• FNear End Margin
Specify the length of the Near End Margin (the leading edge margin) of the roll, as needed.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

5 mm (0.2 in) The document is printed in the standard size.
 

* Select this when you do not have any problems in printing.

20 mm (0.8 in) Select this when rubbing against the printhead occurs such as when using paper that tends to
curl.

GCut Speed
Select the speed of automatic cutting, as needed. You can adjust this setting if paper is not cut well when automatic
cutting is used.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

High Speed When the Standard setting does not result in a clean cut surface, select this.

Standard Select this when you do not have any problems in automatic cutting.

Low Speed This helps prevent adhesive from sticking to the cutter and keeps the cutter sharp if you select it
when using adhesive paper.

HAutomatic Cutting
Set whether to perform roll cutting automatically or print a cut line.
The following settings are available for automatic cutting.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

None After printing completes, the roll is not cut per page, and the next page of data is printed succes-
sively.

Print Cut Guideline After printing completes, a line is printed per page, and the next page of data is printed succes-
sively.

ICalibration Value
You can specify whether to apply the results of calibration performed on the printer to image processing.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

Enabled Print using the calibration results.

Disabled Print without using the calibration results. Select this to avoid the changing of the color of images
during printing by color calibration.
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JMirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or image with
the left and right sides inverted.

KExtend print pass
Uneven printing that occurs when printing with Highest selected in Print Quality may be improved in some cases by
selecting this check box. However, this also reduces the printing speed.

View settings Dialog Box for the Printing ApplicationView settings Dialog Box for the Printing Application
In the View settings dialog box, you can check details of the selected printing application.

Note

• To display the View settings dialog box, on the Main pane, click View settings by Print Target.(See "Main Pane →P.364 ")

• APrint Target
Shows all Print Target options (settings items for the printing application).

• BName
Identifies the item selected in Print Target by its name and an icon.

• CDetails
Here, you can confirm detailed settings values for each item selected in the Print Target list.

Matching paneMatching pane
On the Matching pane, you can specify color matching to compensate for differences in the appearance of colors on
various devices.

Important

• The Matching pane is not displayed when No color correction or Monochrome is selected in Color Mode.

Note

• To display the Matching pane, on the Main pane click Color Settings by Color Mode in Advanced Settings, and then click
the Matching tab.  (See "Main Pane.") →P.364
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Driver Matching Mode
The following options are available when you select Driver Matching Mode in the AMatching Mode list.

• AMatching Mode
Select the color matching mode to use, as desired.
Normally, select Driver Matching Mode. For color matching based on ICC profiles, select ICC Matching Mode
depending on your color matching system.

• BMatching Method
Select the color matching method that suits the document to be printed. Various BMatching Method options are
available depending on your selection in AMatching Mode.

• CColor Space
Select the applicable color space as desired.

• DMonitor White Point
Enter the color temperature set on the monitor.
Displayed when the BMatching Method is set to Monitor Matching.

• EGamma
You can adjust the gradation of intermediate tones in an image.
2.2 is normally selected. If you want a softer impression than 2.2, select 1.8.

iPF9400                                                                                                                                                                                                                     Matching pane

User's Guide                                                                                                                                                                                                                                       

  

M
ac O

S X Softw
are

Printer D
river

371  



ICC Matching Mode
The following options are available when you select ICC Matching Mode, in the AMatching Mode list.

Note

• To display the Matching pane, on the Main pane, click Color Settings by Color Mode in Advanced Settings, and then click
the Matching tab.(See "Main Pane →P.364 ")

• AMatching Mode
Select the color matching mode to use, as desired.

• B Input Profile Settings
You can choose Input Profile.
Various options are available depending on your selected AMatching Mode.

• CMatching Method
You can choose CMatching Method.
Various options are available depending on your selected AMatching Mode.

• DPrinter Profile Settings
Specify the printer profile as desired.
We recommend that you select an ICC profile created using commercially available profile creation software in or-
der to perform color management accurately on paper other than genuine Canon paper and feed confirmed paper.
The created ICC profile needs to be saved in the following folder on the computer you are using.
/user/(user name)/library/ColorSync/Profiles folder

Note

• For details on settings items, see "Adjusting the Color in the Printer Driver." →P.54

Matching pane                                                                                                                                                                                                                     iPF9400

                                                                                                                                                                                                                                       User's Guide

  

M
ac O

S X Softw
are

Printer D
river

 372



Color Settings Pane: ColorColor Settings Pane: Color
In general, make any needed adjustments to the color of documents in the application used to create them. However, if
the color tone as printed is not as you expected, you can also adjust the color in the printer driver.
If the color tone as printed is not as you expected, you can adjust it on the Color Adjustment pane.

Note

• To display the Color Adjustment pane, on the Main pane click Color Settings by Color Mode in Advanced Settings.(See
"Main Pane →P.364 ")

• For details on settings items, see "Adjusting the Color in the Printer Driver →P.54 "

• ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

• BView Color Pattern
Select this checkbox to display the color pattern.

• CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

• DCyan / EMagenta / FYellow
Correct color tones by adjusting the levels of each color.

• GGray Tone
Adjust the color tone of grays as desired. Choose Cool (tinged with blue) or Warm (tinged with red).

• HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or
darker than the original image (that is, the original photo that was scanned or the original graphic as it appears on
the computer screen).

• IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Contrast
makes images sharper, and reducing the Contrast softens images.

• JSaturation
Adjust the color intensity as desired. Increasing the Saturation setting makes colors more vivid, and reducing the
Saturation makes colors more subdued.
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• KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color
adjustment.

• Object Adjustment dialog box: Color →P.374

Object Adjustment dialog box: ColorObject Adjustment dialog box: Color
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note

• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment panel.

• A Images
Select this option to apply color adjustment to image areas, such as photos.

• BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

• CText
Select this option to apply color adjustment to text.
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Color Settings Pane: MonochromeColor Settings Pane: Monochrome
On the Color Adjustment pane for monochrome printing, you can adjust the brightness and contrast.

Note

• To display the Color Adjustment pane, on the Main pane, click Color Settings in Advanced Settings.(See "Main
Pane →P.364 ")

• For details on settings items, see "Adjusting the Color in the Printer Driver →P.54 "

• ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

• BView Color Pattern
Select this checkbox to display the color pattern.

• CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

• DCyan / EMagenta / FYellow
Not available.

• GGray Tone
Not available.

• HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or
darker than the original image (that is, the original photo that was scanned or the original graphic as it appears on
the computer screen).

• IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the IContrast
makes images sharper, and reducing the IContrast softens images.

• JSaturation
Not available.

• KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color
adjustment.
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• Object Adjustment dialog box: Monochrome →P.376

Object Adjustment dialog box: MonochromeObject Adjustment dialog box: Monochrome
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note

• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment panel.

• A Images
Select this option to apply color adjustment to image areas, such as photos.

• BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

• CText
Select this option to apply color adjustment to text.

Gray Adjustment PaneGray Adjustment Pane
On the Gray Adjustment pane, you can adjust the color balance, brightness, contrast, and other image qualities.
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Note

• To display the Gray Adjustment pane, on theMain Pane →P.364 , select Monochrome (Photo) by Color Mode in Ad-
vanced Settings, and then click Color Settings.

• Monochrome (Photo) is not available for all types of paper.

• ASample
The image at left is updated to reflect any changes you make to setting items on the sheet, enabling you to check
the results of adjustment.

• BSample List
Select a sample image, as desired.

• CColor Balance
Click the list to select a color balance that suits the printing application.

• DX / EY
Adjust the color balance as you check the color tone in the adjustment area.
You can adjust the square area in the center by clicking or dragging it.
Drag the vertical or horizontal scroll bars for adjustment, as desired.
You can click the arrows by the DX (horizontal) and EY (vertical) boxes or enter the values directly.

• JTone
You can adjust the brightness of intermediate tones in an image. Selecting Hard tone gives a hard impression
with more definition. Selecting Soft tone gives a soft impression.

• FBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or
darker than the original image (that is, the original photo that was scanned or the original graphic as it appears on
the computer screen).

• GContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Contrast
makes images sharper, and reducing the Contrast softens images.

• HHighlight
Adjust the brightness of the lightest portion.

• IShadow
Adjust the brightness of the darkest portion.
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Page Setup PanePage Setup Pane
The following settings are available on the Page Setup pane. For details on settings items, refer to the printer driver
help.

• APaper Source
Choose how paper is supplied.
Options displayed in the list vary depending on the selection in AMedia Type in the Main pane.

• BRoll Width
Displays the paper width of the roll loaded in the printer. Unknown is displayed if the printer cannot detect the roll
paper width.

• CPage Size
Displays the size of the original, as specified in the page settings of the application.
For details on page sizes available in the application. see "Paper Sizes →P.522 "

• DEnlarged/Reduced Printing
Select this checkbox to choose the following options.

• Resizing Originals to Match the Paper Size →P.68
• Resizing Originals to Fit the Roll Width →P.72
• Resizing Originals by Entering a Scaling Value →P.78

• EFit Paper Size
Resizes the document image to match the paper size.

• FFit Roll Paper Width
Resizes the document image to match the roll width.

• GScaling
Resizes the document image based on a specified scaling value. Enter a value in a range of 5–600.

• HBorderless Printing
Borderless printing is available if roll paper is selected in the APaper Source list.
Activate this setting for borderless printing to match the size and width of the paper.

• Borderless Printing on Paper of Equivalent Size →P.95
• Borderless Printing by Resizing Originals to Fit the Roll Width →P.101
• Borderless Printing at Actual Size →P.89
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• IPaper Size
Choose the size of the paper you will print on.
Click Display all selections for Paper Size to list available sizes.
For details on available paper sizes, see "Paper Sizes →P.522 "

• JPrint Centered
Select this checkbox to print document images in the center of the paper.

• Printing Originals Centered on Rolls →P.138
• Printing Originals Centered on Sheets →P.143

• KNo Spaces at Top or Bottom
Select this checkbox to print the next image skipping blank areas above and below printable data in documents,
which enables you to conserve the paper.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins →P.152

• LRotate Page 90 degrees
Select this checkbox to rotate the document image by 90 degrees before printing.

• Conserving Roll Paper by Rotating Originals 90 Degrees →P.148

• NFree Layout
Select this checkbox to start imagePROGRAF Free Layout before printing.
This allows you to print multiple documents next to each other.

Important

• When Print Preview is selected on the Main panel, Print Preview is disabled.

• Printing Multiple Originals Next to Each Other →P.121

Utility PaneUtility Pane
The following settings are available on the Utility pane.

• ASet
Click to display the Printer Information dialog box, which offers the following maintenance for the printer.

• Nozzle (ink ejecting outlet) cleaning
• Head alignment adjustment
• Feed amount adjustment
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• BView
Click to start imagePROGRAF Printmonitor, which enables you to view the status of print jobs.

• CSet
Click to complete the settings for Color imageRUNNER Enlargement Copy (iR enlargement copy).
For details, see Color imageRUNNER Enlargement Copy →P.441 .

Additional Settings PaneAdditional Settings Pane
The following settings are available on the Additional Settings pane.

• AData Send Method
Display the method of sending print jobs to the printer.

• BSend job to
You can configure the method for saving print jobs to the printer hard disk.

• CPrint after reception is complete
You can prevent degradation of print quality that occurs when receiving a print job is interrupted and printing is
aborted in the middle.

Support PaneSupport Pane
On the Support pane, you can view support information and the user's manual.
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• ASupport Information
Click to access the Canon support webpage, where you can find the latest information on the printer and consum-
ables, check for printer driver updates, and browse other information.

• BUser Manual
Click to view the printer user's manual. This function requires the user's manual to be installed on your computer.

• CSettings
The settings can be saved as a file. Click to display the Export dialog box, which enables you to specify where to
save the file.

• DAbout
You can display version information for the printer driver.
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PreviewPreview
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The Features of PreviewThe Features of Preview
The main features of Preview are as follows.

• While viewing this screen, you can adjust layout settings of a document created with application software.

• You can not only adjust layout settings but also your changes will be instantly applied on the preview screen, and
you can print the preview screen as it is seen.

Note

• The media type, image size, detailed media settings, and the printer settings can cause the actual print output to differ from
the Preview settings.

Starting PreviewStarting Preview
Follow the procedure below to start the Preview.

1 Start the apllication software which you use.

2 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note

• Normally, select Print from the File menu.

3 Click Print Preview in the Main panel to attach a checkmark.
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4
 

Click the Print button in the Print dialog box.

Note

• Your printer is depicted in the lower-left area of this screen.

5
 

Preview main window is displayed.
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Preview Main WindowPreview Main Window
The Preview main window consists of the menu and tool bars, and preview, dialog , drawer and status area.

Note

• You can use the View menu to show or hide the tool bar.

• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.
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• Preview Area
You can check the settings you made in this area.
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• Dialog Area
This allows you to set the print conditions and perform a print job.

• Drawer Area
This allows you to display the thumbnails of a document.

This area appears when you click  Drawer from the tool bar.
Alternatively, you may select Drawer from the View menu.

Preview Main Window (Mac OS X)                                                                                                                                                                                      iPF9400

                                                                                                                                                                                                                                       User's Guide

  

M
ac O

S X Softw
are

Preview

 386



• Status Area
This shows Input Size and Output Size.

Paper Settings PanelPaper Settings Panel
This panel appears when you select Paper Settings in the dialog area.

• Media Type
This allows you to select the media type.

Note

• Always select media type that is actually set in the printer. When the media you chose is different from the media set in
the printer, you may not receive the desired print results.

• Easy Settings / Advanced Settings
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings →P.389
• Advanced Settings →P.390
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• Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details
Cut Sheet Select to print on the cut sheet.

Roll Paper Select to print on roll paper.

• Roll Paper Width
This selects the width of the roll media set to the printer.

Note

• Available only if rolls are selected in Paper Source.

• Copies
You can input the number of print copies in numerical characters.

Note

• The maximum value is 999.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Restore Defaults Button
Click the button to reset to the setting when starting Preview.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.

Paper Settings Panel (Mac OS X)                                                                                                                                                                                        iPF9400

                                                                                                                                                                                                                                       User's Guide

  

M
ac O

S X Softw
are

Preview

 388



Easy SettingsEasy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that matches
the content of the document.

• Print Target
You can easily select the best settings for the print job simply.
If you select each Print Target item the corresponding comment for that item is displayed below the list.

Setting Details
Default Settings Suitable for printing normal documents that contain a mixture of text, photographs, and graphics.

Photo (Color) Suitable for printing photographic images captured with a digital camera.

Photo (Monochrome) Suitable for optimized printing of monochrome photos.

Poster The best setting for posters.Prints using vivid and high impact colors.

Faithful Color Reproduction Prints by faithfully reproducing the colors of the original image.

Photo (Adobe RGB) Achieves the best color when printing an image created with the Adobe RGB color space feature.

Office Document Suitable for printing handouts as well as general office documents for which print clarity is key.

Note

• The number of settings available for selection depends on the media type.
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• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.
Setting Details

Print Quality Highest / High / Standard / Draft
Resolution 600dpi / 300dpi

Note

• The availability of settings is determined by the media type and print priority selections.

• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is higher.

• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.

Advanced SettingsAdvanced Settings
Presents detailed settings for the print quality, the color mode, and other items so you can select the values for these
settings yourself.

• Print Priority
Select a print quality mode that is appropriate for the print job.
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Setting Details
Image This mode achieves the best results for printing photographic images and illustrations.

Line Drawing This mode is best for printing CAD drawings with fine lines or wall newssheet or other documents
that contain large amounts of text. However, you may not achieve the quality you expect with
printing photographs or other images with many filled areas. For these types of jobs, select Im-
age.

Proof This is a setting for enhancing the reproducibility of characters, illustrations, and photos with print
proofing.However, this takes more time than regular printing.

Office Document Prints common office documents, such as proposals, memos for distribution, etc., so they are
easy to read.

Note

• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.
Setting Details

Print Quality Highest / High / Standard / Draft
Resolution 600dpi / 300dpi

Note

• The availability of settings is determined by the media type and print priority selections.

• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is higher.

• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.

iPF9400                                                                                                                                                                                           Advanced Settings (Mac OS X)

User's Guide                                                                                                                                                                                                                                       

  

M
ac O

S X Softw
are

Preview

391  



Output Settings PanelOutput Settings Panel
This panel appears when you select Output Settings in the dialog area.

• Enlarged/Reduced Printing
Select the method for enlarged/reduced printing.
The following settings are available for enlarged/reduced printing.

Setting Details
Fit Paper Size Enlarges/reduces the whole page automatically to fit the media size selected for output. Select

the media size to print from Paper Size.

Fit Roll Paper Width Enlarges/reduces the whole page automatically to fit the width of the roll paper with the page
width.
 

*Make sure that the width of the roll paper in the printer is set correctly for Roll Paper Width in
the Paper Settings panel.
*Displayed only if rolls are selected in Paper Source.

Scaling Enlarges/reduces the whole page by the scaling rate as specified. Input the scaling value in nu-
merical characters. You can specify a range between 5 and 600%.
 

*You can change the numbers by clicking either ▲ button or ▼ button.
*Although Scaling can be set to make the image larger than the media size, the part that does not
fit in the media cannot be printed.
*This is not displayed when a checkmark is placed in Borderless Printing.
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• Borderless Printing
You can print the media without margins on all sides when the roll paper with the specific width and the specific
media type is used.
For more information about Borderless Printing, see "Print with No Borders." →P.405

Note

• Available only if rolls are selected in Paper Source.
• This is not displayed when a checkmark is placed in Print Centered.

• Paper Size
You can select the size of the print media.

Note

• This is not displayed when Fit Roll Paper Width is set in Enlarged/Reduced Printing.

• Print Centered
You can print on the center of the media loaded in the printer.
For more information about Print Centered, see "Print on the Center." →P.406

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

• No Spaces at Top or Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top
or bottom.
For more information about No Spaces at Top or Bottom, see "Not Print Spaces at the Top/Bottom." →P.406

Note

• Available only if rolls are selected in Paper Source.

• Rotate Page
Select the method for rotating page.
The following settings are available for rotating page.

Setting Details
Rotate Right 90 Degrees Rotates the portrait page right 90 degrees and print in landscape orientation. When the rotated

page can fit in the width of roll paper, the page is rotated automatically, and when it can not fit in
the width of roll paper, the page is not rotated.

Rotate Left 90 Degrees Rotates the portrait page left 90 degrees and print in landscape orientation. When the rotated
page can fit in the width of roll paper, the page is rotated automatically, and when it can not fit in
the width of roll paper, the page is not rotated.

Rotate 180 degrees Allows you to rotate the image 180 degrees from the vertical to the right.

• Restore Defaults Button
Click the button to reset to the setting when starting Preview.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.

iPF9400                                                                                                                                                                                      Output Settings Panel (Mac OS X)

User's Guide                                                                                                                                                                                                                                       

  

M
ac O

S X Softw
are

Preview

393  



Color Settings PanelColor Settings Panel
This panel appears when you select Color Settings in the dialog area.

• Color Mode
You can select a color mode to suit the print job.

Setting Details
Color Enables color printing.

Monochrome (Photo) Prints monochrome photo image data in a gray scale that is free of color casting (phenomenon of
grays that appear tinted).

Monochrome Disables color printing and converts image from continuous color to grayscaled monochrome.

No color correction Prints without performing color matching in the printer driver. Select this when color matching is
performed by the application such as Adobe Photoshop or when you want to print color charts
using the profile creation tool.

Note

• The availability of settings depends on the print priority and media type selections.

• Color Adjustment / Gray Adjustment / Matching
You can set the color adjustment and matching.
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• Color Adjustment →P.395
• Gray Adjustment →P.398
• Matching →P.399

Note

• You can select Gray Adjustment only after Monochrome (Photo) has been selected in Color Mode.

• Matching is not displayed if No color correction has been selected in Color Mode.

• Restore Defaults Button
Click the button to reset to the setting when starting Preview.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.

Color AdjustmentColor Adjustment
You can set the color adjustment.

Adjusting Color
Normally colors should be adjusted in the software application, but if you see colors in the printout that do not match
colors on the screen, you can perform color adjustments.

1 Select Color on Color Mode in the Color Settings panel.
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2
 

Select Color Adjustment.

3 Drag each slider to the left or right to adjust.
Setting Details

Cyan Adjusts the strength of colors to compensate the hues.

Magenta Adjusts the strength of colors to compensate the hues.

Yellow Adjusts the strength of colors to compensate the hues.

Brightness Adjusts the brightness of the entire image. When the results of the printout are brighter than the
original images such as the original photo before scanning and graphics created on the display,
or when you want to print in different degrees of brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the image.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Saturation Adjusts the hues for vivid color or dark color.

Gray Tone Adjusts gray from cool black (bluish tones) to warm black (reddish tones).

Note

• You can also click the up or down arrow, or enter the number directly to increase or decrease the value.
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Adjusting Monochrome
Use the monochrome setting to print monochrome images of color photographs captured with a scanner or digital cam-
era or other color images.

1 Select Monochrome on Color Mode in the Color Settings panel.

2
 

Select Color Adjustment.

3 Drag each slider to the left or right to adjust.
Setting Details

Brightness Adjusts the brightness of the entire image. When the results of the printout are brighter than the
original images such as the original photo before scanning and graphics created on the display,
or when you want to print in different degrees of brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the image.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Note

• You can also click the up or down arrow, or enter the number directly to increase or decrease the value.
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Gray AdjustmentGray Adjustment
You can set the gray adjustment.

Adjusting Monochrome (Photo)
Sets monochrome printing for black-and-white photo image data captured with a scanner or digital camera.

1 Select Monochrome (Photo) on Color Mode in the Color Settings panel.

2
 

Select Gray Adjustment.

3 Click the Color Balance list and select the color settings.
Setting Details

Cool Black Adjusts cool black (blue tones) to gray.

Pure Neutral Black Adjusts to neutral gray.

Warm Black Adjusts warm black (red tones) to gray.

Note

• To perform the adjustments, drag the X or Y slide bar left and right.

• You can also click the up or down arrow, or enter the number directly to increase or decrease the value by X and Y.
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4 Drag each slider to the left or right to adjust.
Setting Details

Tone You can adjust the brightness of intermediate tones in an image. Selecting Hard tone gives a
hard impression with more definition. Selecting Soft tone gives a soft impression.

Brightness Adjusts the brightness of the entire image. When the results of the printout are brighter than the
original images such as the original photo before scanning and graphics created on the display,
or when you want to print in different degrees of brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the image.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Highlight Adjusts the brightness of the brightest areas.

Shadow Adjusts the brightness of the darkest areas.

Note

• You can also click the up or down arrow, or enter the number directly to increase or decrease the value.

• The availability of settings depends on the selected the media type.

MatchingMatching
You can set the matching.

Important

• If No color correction is selected under Color Mode, the Matching is not displayed.
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• Matching Mode
You can select a matching mode to suit the print job.

Setting Details
Driver Matching Mode →P.402 Enables printing of optimal color tones using a driver specific color profile. You should normally

select this mode.

ICC Matching Mode →P.403 Enables color matching using ICC profiles. Select this if you want to print by specifying the input
profile, printer profile, and matching method in detail. This allows you to use ICC profiles for digital
cameras and scanners, ICC profiles created using the profile creation tool, etc.

ColorSync →P.404 Enables color matching by using the ColorSync function of Mac OS. Select this if you want to
perform soft proofing using ColorSync before printing.

Note

• You need to set each correction on the printer driver.

• ColorSync needs to be selected in the Color Matching panel of the driver in order to select ColorSync.

• Matching Method
You can select a matching method to suit the print job.

• Color Space
Select the color space.
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Note

• You can select only after Driver Matching Mode has been selected in Matching Mode.

• Gamma
You can adjust the gradation of intermediate tones in an image. 2.2 is normally selected. If you want a softer im-
pression than 2.2, select 1.8.

• Input Profile
Select the input profile.

Note

• You can select only after ICC Matching Mode has been selected in Matching Mode.

• Printer Profile
Select the printer profile.

Note

• You can select only after ICC Matching Mode has been selected in Matching Mode.

• Soft Proof
When you place a checkmark here, ColorSync applies to the preview area.

Note

• You can select only after ColorSync has been selected in Matching Mode.
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Driver Matching ModeDriver Matching Mode

1
 

Under Matching Mode, select Driver Matching Mode.

2 Click the Matching Method list, and then select a setting.
Setting Details

Auto Automatically selects the best color matching method for each Image, Graphics, Text.

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation is a feature.
This is also an easy-to-use mode when performing color adjustment using application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color space. This
is the easiest-to-use mode when you want to adjust the color and print. However, gradation
may be lost for colors of wider range than the color reproduction range of the printer. Generally,
this is also called relative colorimetric.

Perceptual (People, Dark Areas) Color-matching optimized for printing subdued photos such as indoor shots of people or dark
scenes. Along with preventing the gradation loss of dark areas, you can realize photos of peo-
ple in warm tones.

3 Select Color Space for the print output.
Setting Details

sRGB Uses color space for a standard monitor. This selection is ideal for most software applications.
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Setting Details
Adobe RGB Uses wide color space. Use this setting to print images created with Adobe RGB color space.

ICC Matching ModeICC Matching Mode

1
 

Under Matching Mode, select ICC Matching Mode.

2 Click the Matching Method list, and then select a setting.
Setting Details

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation is a feature.
This is also an easy-to-use mode when performing color adjustment using application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color space. This
is the easiest-to-use mode when you want to adjust the color and print. However, gradation
may be lost for colors of wider range than the color reproduction range of the printer. Generally,
this is also called relative colorimetric.

Colorimetric (No White-Point Cor-
rection)

The processing method of color-matching is identical to Colorimetric. Use this when you want
to further reproduce the target paper material color of the image data. Generally, this also is
called absolute colorimetric.

3 Click the Input Profile list and select an input profile.
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4 Click the Printer Profile list and select a printer profile.

ColorSyncColorSync

1
 

Check that ColorSync is selected in Matching Mode.

2 To apply ColorSync to previews, check the Soft Proof check box.

Preferences Dialog BoxPreferences Dialog Box
This dialog box appears when you select Preferences from the imagePROGRAF Advanced Preview menu. You can
set the preferences for Preview.

• Units
Set the unit for paper length, margins, and so on.
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Zoom Dialog BoxZoom Dialog Box
This dialog box appears when you select Zoom from the View menu. You can enlarge or reduce the screen display.

• Scaling
Set the magnification for enlargement or reduction of the screen display.

Note

• You can input between 10 and 400.
• You can change the numbers by clicking ▼ button.

Go to Page Dialog BoxGo to Page Dialog Box
This dialog box appears when you select Go to Page from the View menu.

Note

• You can not select Go to Page if the document is only one page.

• Page
Input the page number in numerical characters to display in the preview area.

Note

• You can change the numbers in the range of the page of the documents.

Print with No BordersPrint with No Borders
You can use the borderless printing function to print without margins surrounding the image.

Note

• With some media borderless printing can be performed only between two edges.

• To use the borderless printing function, the specified media must be set to the printer.

1 On the Paper Settings Panel →P.387 , select Roll Paper in Paper Source.

2 On the Output Settings Panel →P.392 , click the Enlarged/Reduced Printing check box on.

3 Select Fit Roll Paper Width.
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4
 

Click the Borderless Printing check box on.

5 Click the Print button.
 

Borderless printing begins.

Print on the CenterPrint on the Center
You can print on the center of the media loaded in the printer.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

1
 

On the Output Settings Panel →P.392 , click the Print
Centered check box on.

2 Click the Print button.
 

Printing on the center begins.

Not Print Spaces at the Top/BottomNot Print Spaces at the Top/Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top or
bottom.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.
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1 On the Paper Settings Panel →P.387 , select Roll Paper in Paper Source.

2
 

On the Output Settings Panel →P.392 , click the No
Spaces at Top or Bottom check box on.

3 Click the Print button.
 

Printing on the settings with no spaces at top or bottom begins.

Print Page Rotated 90 DegreesPrint Page Rotated 90 Degrees
You can save paper by printing in landscape orientation on roll paper.

1 On the Paper Settings Panel →P.387 , select Roll Paper in Paper Source.

2 On the Output Settings Panel →P.392 , click the Rotate Page check box on.

3
 

Select Rotate Right 90 Degrees or Rotate Left 90 De-
grees.

4 Click the Print button.
 

Printing on rotating 90 degrees begins.
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Display with Fitting to the Width of the PaperDisplay with Fitting to the Width of the Paper
In the preview area, you can display to the width of the paper.

1 Select  Fit to Width from the tool bar.

2
 

Fitting to the width of the paper, it is displayed.

Display with AllDisplay with All
In the preview area, you can display all.

1 Select  Fit Screen from the tool bar.

2
 

All is displayed.

Display with Actual SizeDisplay with Actual Size
In the preview area, you can display the actual size.

1 Select  Actual Size from the tool bar.
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2
 

Actual size is displayed.

Moving a PageMoving a Page
You can move a page to display in the preview area.

1 Select each button in Go to Page on the tool bar.
Setting Details

Go to the first page.

Go to the previous page.

Go to the next page.

Go to the last page.

2
 

The target page appears.

Note

• You can also move a page by clicking the page on the thumbnails.
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The Features of Free LayoutThe Features of Free Layout
The main features of Free Layout are as follows.

• Allows you to lay out at will and print a document created with application software.

• You can not only lay out multiple pages on one page but also lay out and print a multiple-file document on one
page, or lay out and print a document created with multiple application programs on one page.

Note

• The media type, image size, detailed media settings, and the printer settings can cause the actual print output to differ from
the Free Layout settings.

Starting Free LayoutStarting Free Layout
Follow the procedure below to start the Free Layout.

1 Start the apllication software which you use.

2 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note

• Normally, select Print from the File menu.

3 Click on Free Layout in the Page Setup panel to attach a checkmark.
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4
 

Click the Print button in the Print dialog box.

Note

• Your printer is depicted in the lower-left area of this screen.

5
 

Free Layout main window is displayed.
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Free Layout Main WindowFree Layout Main Window
The Free Layout main window consists of the menu and tool bars, layout area and dialog areas.

Note

• You can use the View menu to show or hide the tool.

• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.
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• Layout Area
This allows you to lay out objects and edit the object size and orientation.
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• Dialog Area
This allows you to set the print conditions and perform a print job.
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Paper Settings PanelPaper Settings Panel
This panel appears when you select Paper Settings in the dialog area.

• Media Type
This allows you to select the media type.

Note

• Always select media type that is actually set in the printer. When the media you chose is different from the media set in
the printer, you may not receive the desired print results.

• Easy Settings / Advanced Settings
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings →P.417
• Advanced Settings →P.418

• Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details
Cut Sheet Select to print on the cut sheet.
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Setting Details
Roll Paper Select to print on roll paper.

• Roll Paper Width
This selects the width of the roll media set to the printer.

Note

• Available only if rolls are selected in Paper Source.

• Copies
You can input the number of print copies in numerical characters.

Note

• The maximum value is 999.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Restore Defaults Button
Click the button to reset to the setting when starting Free Layout.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.
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Easy SettingsEasy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that matches
the content of the document.

• Print Target
You can easily select the best settings for the print job simply.
If you select each Print Target item the corresponding comment for that item is displayed below the list.

Setting Details
Default Settings Suitable for printing normal documents that contain a mixture of text, photographs, and graphics.

Photo (Color) Suitable for printing photographic images captured with a digital camera.

Photo (Monochrome) Suitable for optimized printing of monochrome photos.

Poster The best setting for posters.Prints using vivid and high impact colors.

Faithful Color Reproduction Prints by faithfully reproducing the colors of the original image.

Photo (Adobe RGB) Achieves the best color when printing an image created with the Adobe RGB color space feature.

Office Document Suitable for printing handouts as well as general office documents for which print clarity is key.

Note

• The number of settings available for selection depends on the media type.
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• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.
Setting Details

Print Quality Highest / High / Standard / Draft
Resolution 600dpi / 300dpi

Note

• The availability of settings is determined by the media type and print priority selections.

• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is higher.

• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.

Advanced SettingsAdvanced Settings
Presents detailed settings for the print priority, the print quality, and other items so you can select the values for these
settings yourself.

• Print Priority
Select a print quality mode that is appropriate for the print job.
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Setting Details
Image This mode achieves the best results for printing photographic images and illustrations.

Line Drawing This mode is best for printing CAD drawings with fine lines or wall newssheet or other documents
that contain large amounts of text. However, you may not achieve the quality you expect with
printing photographs or other images with many filled areas. For these types of jobs, select Im-
age.

Proof This is a setting for enhancing the reproducibility of characters, illustrations, and photos with print
proofing.However, this takes more time than regular printing.

Office Document Prints common office documents, such as proposals, memos for distribution, etc., so they are
easy to read.

Note

• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.
Setting Details

Print Quality Highest / High / Standard / Draft
Resolution 600dpi / 300dpi

Note

• The availability of settings is determined by the media type and print priority selections.

• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is higher.

• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.
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Color Settings PanelColor Settings Panel
This panel appears when you select Color Settings in the dialog area.

• Color Mode
You can select a color mode to suit the print job.

Setting Details
Color Enables color printing.

Monochrome (Photo) Prints monochrome photo image data in a gray scale that is free of color casting (phenomenon of
grays that appear tinted).

Monochrome Disables color printing and converts image from continuous color to grayscaled monochrome.

No color correction Prints without performing color matching in the printer driver. Select this when color matching is
performed by the application such as Adobe Photoshop or when you want to print color charts
using the profile creation tool.

Note

• The availability of settings depends on the print priority and media type selections.

• Color Adjustment / Gray Adjustment / Matching
You can set the color adjustment and matching.
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• Color Adjustment →P.421
• Gray Adjustment →P.424
• Matching →P.425

Note

• You can select Gray Adjustment only after Monochrome (Photo) has been selected in Color Mode.

• Matching is not displayed if No color correction has been selected in Color Mode.

• Restore Defaults Button
Click the button to reset to the setting when starting Free Layout.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.

Color AdjustmentColor Adjustment
You can set the color adjustment.

Adjusting Color
Normally colors should be adjusted in the software application, but if you see colors in the printout that do not match
colors on the screen, you can perform color adjustments.

1 Select Color on Color Mode in the Color Settings panel.
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2
 

Select Color Adjustment.

3 Drag each slider to the left or right to adjust.
Setting Details

Cyan Adjusts the strength of colors to compensate the hues.

Magenta Adjusts the strength of colors to compensate the hues.

Yellow Adjusts the strength of colors to compensate the hues.

Brightness Adjusts the brightness of the entire image. When the results of the printout are brighter than the
original images such as the original photo before scanning and graphics created on the display,
or when you want to print in different degrees of brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the image.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Saturation Adjusts the hues for vivid color or dark color.

Gray Tone Adjusts gray from cool black (bluish tones) to warm black (reddish tones).

Note

• You can also click the up or down arrow, or enter the number directly to increase or decrease the value.
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Adjusting Monochrome
Use the monochrome setting to print monochrome images of color photographs captured with a scanner or digital cam-
era or other color images.

1 Select Monochrome on Color Mode in the Color Settings panel.

2
 

Select Color Adjustment.

3 Drag each slider to the left or right to adjust.
Setting Details

Brightness Adjusts the brightness of the entire image. When the results of the printout are brighter than the
original images such as the original photo before scanning and graphics created on the display,
or when you want to print in different degrees of brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the image.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Note

• You can also click the up or down arrow, or enter the number directly to increase or decrease the value.
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Gray AdjustmentGray Adjustment
You can set the gray adjustment.

Adjusting Monochrome (Photo)
Sets monochrome printing for black-and-white photo image data captured with a scanner or digital camera.

1 Select Monochrome (Photo) on Color Mode in the Color Settings panel.

2
 

Select Gray Adjustment.

3 Click the Color Balance list and select the color settings.
Setting Details

Cool Black Adjusts cool black (blue tones) to gray.

Pure Neutral Black Adjusts to neutral gray.

Warm Black Adjusts warm black (red tones) to gray.

Note

• To perform the adjustments, drag the X or Y slide bar left and right.

• You can also click the up or down arrow, or enter the number directly to increase or decrease the value by X and Y.
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4 Drag each slider to the left or right to adjust.
Setting Details

Tone You can adjust the brightness of intermediate tones in an image. Selecting Hard tone gives a
hard impression with more definition. Selecting Soft tone gives a soft impression.

Brightness Adjusts the brightness of the entire image. When the results of the printout are brighter than the
original images such as the original photo before scanning and graphics created on the display,
or when you want to print in different degrees of brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the image.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Highlight Adjusts the brightness of the brightest areas.

Shadow Adjusts the brightness of the darkest areas.

Note

• You can also click the up or down arrow, or enter the number directly to increase or decrease the value.

• The availability of settings depends on the selected the media type.

MatchingMatching
You can set the matching.

Important

• If No color correction is selected under Color Mode, the Matching is not displayed.
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• Matching Mode
You can select a matching mode to suit the print job.

Setting Details
Driver Matching Mode →P.428 Enables printing of optimal color tones using a driver specific color profile. You should normally

select this mode.

ICC Matching Mode →P.429 Enables color matching using ICC profiles. Select this if you want to print by specifying the input
profile, printer profile, and matching method in detail. This allows you to use ICC profiles for digital
cameras and scanners, ICC profiles created using the profile creation tool, etc.

ColorSync →P.430 Enables color matching by using the ColorSync function of Mac OS. Select this if you want to
perform soft proofing using ColorSync before printing.

Note

• You need to set each correction on the printer driver.

• ColorSync needs to be selected in the Color Matching panel of the driver in order to select ColorSync.

• Matching Method
You can select a matching method to suit the print job.

• Color Space
Select the color space.
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Note

• You can select only after Driver Matching Mode has been selected in Matching Mode.

• Gamma
You can adjust the gradation of intermediate tones in an image. 2.2 is normally selected. If you want a softer im-
pression than 2.2, select 1.8.

• Input Profile
Select the input profile.

Note

• You can select only after ICC Matching Mode has been selected in Matching Mode.

• Printer Profile
Select the printer profile.

Note

• You can select only after ICC Matching Mode has been selected in Matching Mode.

• Soft Proof
When you place a checkmark here, ColorSync applies to the layout area.

Note

• You can select only after ColorSync has been selected in Matching Mode.
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Driver Matching ModeDriver Matching Mode

1
 

Under Matching Mode, select Driver Matching Mode.

2 Click the Matching Method list, and then select a setting.
Setting Details

Auto Automatically selects the best color matching method for each Image, Graphics, Text.

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation is a feature.
This is also an easy-to-use mode when performing color adjustment using application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color space. This
is the easiest-to-use mode when you want to adjust the color and print. However, gradation
may be lost for colors of wider range than the color reproduction range of the printer. Generally,
this is also called relative colorimetric.

Perceptual (People, Dark Areas) Color-matching optimized for printing subdued photos such as indoor shots of people or dark
scenes. Along with preventing the gradation loss of dark areas, you can realize photos of peo-
ple in warm tones.

3 Select Color Space for the print output.
Setting Details

sRGB Uses color space for a standard monitor. This selection is ideal for most software applications.
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Setting Details
Adobe RGB Uses wide color space. Use this setting to print images created with Adobe RGB color space.

ICC Matching ModeICC Matching Mode

1
 

Under Matching Mode, select ICC Matching Mode.

2 Click the Matching Method list, and then select a setting.
Setting Details

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation is a feature.
This is also an easy-to-use mode when performing color adjustment using application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color space. This
is the easiest-to-use mode when you want to adjust the color and print. However, gradation
may be lost for colors of wider range than the color reproduction range of the printer. Generally,
this is also called relative colorimetric.

Colorimetric (No White-Point Cor-
rection)

The processing method of color-matching is identical to Colorimetric. Use this when you want
to further reproduce the target paper material color of the image data. Generally, this also is
called absolute colorimetric.

3 Click the Input Profile list and select an input profile.
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4 Click the Printer Profile list and select a printer profile.

ColorSyncColorSync

1
 

Check that ColorSync is selected in Matching Mode.

2 Place a checkmark on Soft Proof to simulate the output product in Layout Area.
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Preferences Dialog BoxPreferences Dialog Box
This dialog box appears when you select Preferences from the imagePROGRAF Advanced Preview menu. You can
set the preferences for Free Layout.

• Units
Set the unit for paper length, margins, and so on.

• Gridlines
You can input a grid line width value in numerical characters so that they serve as a guide to laying out objects.

Note

• You can input between 10.0 and 200.0(mm) (between 0.39 and 7.87(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

• Divisions
You can change the number of divisions of grid lines so that they serve as a guide to laying out objects.

Note

• You can input between 1 and 10.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Grid Color
Select the grid line color.

• Print Object Frames
You can print the object border.

Note

• If you do not want to print the object border, deselect the Print Object Frames check box.

• Object Frame Style
You can select the object frame style for printing.
The following settings are available for the object frame style.

Setting Details
Solid Line You can print the solid line as the frame style.

Dotted Line You can print the dotted line as the frame style.

Dashed Line You can print the dashed line as the frame style.
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• Auto Arrange Spacing
Change the object-to-object spacing to be applied in the operation of laying out objects automatically.

Note

• You can input between 0.0 and 100.0(mm) (between 0.00 and 3.94(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Page Setup Dialog BoxPage Setup Dialog Box
This dialog box appears when you select Page Setup from the File menu.This dialog box provides selections for set-
ting the media size, orientation and other important features.

• Paper Orientation
This selects the paper orientation.
The following settings are available for orientation.

Setting Details
Vertical Prints the image and text created with the application software in the orientation as it is.

Horizontal Prints the image and text by rotating sideways 90 degrees from the orientation as specified in the
application.

• Roll Paper Length
Set the length of one page to print on roll paper.
When you place a checkmark on Auto Settings, the one-page length to be printed on roll paper is automatically
set so that the laid-out objects are printed on one page.

Note

• Available only if rolls are selected in Paper Source.
• You can input between 203.2 and 18000.0(mm) (between 8.00 and 708.66(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

• Order
Set the object layout order.
The following settings are available for order.

Setting Details
Upper Left to Right The objects are laid out from upper left to right.

Upper Left to Bottom The objects are laid out from upper left to bottom.
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Note

• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Vertical, you can choose only
Upper Left to Right.

• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Horizontal, you can choose
only Upper Left to Bottom.

• Paper Size
You can select the size of the print media.

Note

• You cannot display this if Roll Paper is selected in Paper Source.

Zoom Dialog BoxZoom Dialog Box
This dialog box appears when you select Zoom from the View menu. You can enlarge or reduce the screen display.

• Scaling
Set the magnification for enlargement or reduction of the screen display.

Note

• You can input between 10 and 400.
• You can change the numbers by clicking ▼ button.

Format Dialog BoxFormat Dialog Box
This dialog box appears when you select Format from the Object menu after you select an object. You can rotate,
enlarge, or reduce an object.

Note

• When the objects are not selected, you can not select Format.
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• Rotate
When you place a checkmark here, you can select Rotate Right or Rotate Left.

Setting Details
Rotate Right Rotates the object 90 degrees clockwise.

Rotate Left Rotates the object 90 degrees counterclockwise.

Note

• When several objects are selected, you cannot select Rotate.

• Scaling
You can input the value for enlargement or reduction of the obeject in numerical characters.

Note

• You can input between 25 and 400.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Object Size
You can confirm the object size.

Note

• When several objects are selected, you cannot display Object Size.

Laying out a Multiple-File Document on One PageLaying out a Multiple-File Document on One Page
You can lay out and print a multiple-file document on one page.

1 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note

• Normally, select Print from the File menu.

2 Click on Free Layout in the Page Setup panel to attach a checkmark.

3 In the Print dialog box, select the pages to print and the number of copies, and click the Print button.
Free Layout starts, laying out the document created with application software in the layout area as an object.

4 Leaving Free Layout running, open other files with the application software and repeat the above steps.

Laying out a Document Created with Multiple Application Programs on One PageLaying out a Document Created with Multiple Application Programs on One Page
You can lay out and print a document created with multiple application programs on one page.

1 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note

• Normally, select Print from the File menu.

2 Click on Free Layout in the Page Setup panel to attach a checkmark.

3 In the Print dialog box, select the pages to print and the number of copies, and click the Print button.
Free Layout starts, laying out the document created with application software in the layout area as an object.

4 Leaving Free Layout running, open the files with other application software and repeat the above steps.
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Selecting an ObjectSelecting an Object
When an object is selected, a select box (blue border) appears around the object.

Note

• To select an object, click that object.
• To select multiple successive objects, click them while holding down the shift key.
• To select multiple arbitrary objects, click them while holding down the command key.
• To select all objects, select Select All from the Edit menu.

Changing the Object SizeChanging the Object Size
You can change the object size by means of mouse operation or by specifying a scaling value.

Note

• The vertical-to-horizontal ratio remains unchanged when the object is enlarged or reduced.

Resizing by means of mouse operation

1 Select an object.

2
 

Place the pointer at a corner of the selection box
around the object to show the arrow handle, and drag
this handle to change the object size.
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Resizing by specifying a scaling value

1 Select an object.

2 Open the Format Dialog Box →P.433 .

3 Use Scaling to set the magnification for enlargement or reduction. You either enter numbers directly.

Note

• You can input between 25 and 400.
• You can change the numbers by clicking either ▲ button or ▼ button.

4 Click the OK button.

Moving an ObjectMoving an Object
You can move the object position.

1 Select an object.

2
 

Place the pointer inside the selection box of the object
to show the crosshair handle, and drag it to move the
object.

Rotating an ObjectRotating an Object
You can rotate the object.

1 Select an object.

2
 

Select Rotate Left or Rotate Right from the toolbar.
Alternatively, you may click on the Rotate check box in
the Format Dialog Box →P.433  then select Rotate
Right or Rotate Left, and click the OK button.

Note

• When several objects are selected, you cannot select Rotate.
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Laying out Objects AutomaticallyLaying out Objects Automatically
Click Auto Arrange in the tool bar. This automatically lays out objects. Alternatively, you may select Auto Arrange
Object from the Object menu.

Note

• The object layout order varies depending on the Order setting on the Page Setup Dialog Box →P.432 .

Aligning ObjectsAligning Objects
You can align objects systematically.

1 Select multiple objects.

2 Select the align menu from the Object menu.

• Align Top
Lays out the objects, justifying them to the top.
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• Center Vertically
Lays out the objects, justifying them to the vertical
center.

• Align Bottom
Lays out the objects, justifying them to the bottom.

• Align Left
Lays out the objects, justifying them to the left.

• Center Horizontally
Lays out the objects, justifying them to the horizon-
tal center.
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• Align Right
Lays out the objects, justifying them to the right.

Changing the Object Overlapping OrderChanging the Object Overlapping Order
You can change the object overlapping order.

1 Select an object.

2 Select the overlapping order menu from the Object menu.

• Bring to Front
Moves the object to the frontmost position.

• Send to Back
Moves the object to the backmost position.
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• Bring Forward
Moves the object one position to the front.

• Send Backward
Moves the object one position to the back.

Pasting a Copied or Cut ObjectPasting a Copied or Cut Object

1 Click Copy or Cut from the toolbar.
Alternatively, you may select Copy or Cut from the Edit menu.

2 Click Paste from the toolbar.
Alternatively, you may select Paste from the Edit menu.

Note

• The copied or cut object is laid out at the end of the page.
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The Features of Color imageRUNNER Enlargement CopyThe Features of Color imageRUNNER Enlargement Copy
The main features of Color imageRUNNER Enlargement Copy are as follows.

• Allows the document scanned with the Color imageRUNNER to be automatically enlarged and printed.

• You can perform basic printer settings such as printer selection, media type and output profile selection, and
matching methods, in addition to borderless printing and enlargement/reduction process without growing through
the printer driver.

Note

• The media type, image size, detailed media settings, and the printer settings can cause the actual print output to differ from
the Color imageRUNNER Enlargement Copy settings.
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Starting Color imageRUNNER Enlargement CopyStarting Color imageRUNNER Enlargement Copy
Follow the procedure below to start the Color imageRUNNER Enlargement Copy.

1
 

Open the Utility panel of the Print dialog box.

Note

• Your printer is depicted in the lower-left area of this screen.

2
 

Click the Set button in Configure Color imageRUN-
NER Enlargement Copy. to open the Color image-
RUNNER Enlargement Copy dialog box.

Note

• You can also start the utility directly by clicking on the Color imageRUNNER Enlargement Copy.app icon in Applications >
Canon Utilities > iR Enlargement Copy.

• If you are using Mac OS X v10.7 and later, start it from Launchpad.
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Color imageRUNNER Enlargement Copy Dialog BoxColor imageRUNNER Enlargement Copy Dialog Box
The explanation below is on the Color imageRUNNER Enlargement Copy dialog box.

Note

• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color imageRUNNER Enlarge-
ment Copy." →P.442

• Delete files in the folder
From the Hot Folder list, select a hot folder and click the Delete button to delete only files in the hot folder.

• Delete the entire folder, as well as items in the list above
From the Hot Folder list, select a hot folder and click the Delete button to delete the hot folder.

• Delete Button
Select Delete files in the folder or Delete the entire folder, as well as items in the list above and click this
button to delete the hot folder or only files in the hot folder.

• Add Button
Click the button to open the Destination Selection dialog box so that you can add a hot folder.

• Edit Button
From the Hot Folder list, select a hot folder and click this button to open the Add/Edit Hot Folder dialog box that
allows you to edit the hot folder.

• Monitor Hot Folder Constantly
If the check box is selected, the Hot Folder is monitored from after the next login.

Hot FolderHot Folder
Hot folder refers to a folder used for Color imageRUNNER Enlargement Copy.

• When transferred to the PC's hot folder, the document data scanned with the Color imageRUNNER is printed in
enlarged size from the printer according to the print conditions set in the hot folder.

• You can create a new hot folder, edit or delete an existing one, and set print conditions at will.

Note

• You can create up to 10 hot folders.
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Creating a New Hot FolderCreating a New Hot Folder

1
 

Open the Color imageRUNNER Enlargement Copy
dialog box.

Note

• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color imageRUNNER
Enlargement Copy." →P.442

2
 

Click the Add button in Enlarged Copy Settings to
open the Destination Selection dialog box.

3 From the printer list in Destination, select the printer of destination.

4
 

Click the OK button to open the Add/Edit Hot Folder
dialog box.

5 In Name, enter the name to display in the Hot Folder list.

6 In Hot Folder, enter the Hot Folder name.
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7
 

Click the OK button. The created Hot Folder is listed in
the Color imageRUNNER Enlargement Copy dialog
box.

8 Click the Close button to close the Color imageRUNNER Enlargement Copy dialog box.

9 From the Apple Menu, open the Sharing dialog box for System Preferences.

10 For Mac OS X v10.5-v10.6:
Check the File Sharing checkbox and click the Options button.
Check the Share files and folders using FTP and Share files and folders using SMB checkboxes to config-
ure the sharing.
For Mac OS X v10.7 and later:
Check the File Sharing checkbox and click the Options button.
Check the Share files and folders using SMB checkbox to configure the sharing.

Note

• You can create up to 10 hot folders.

Editing a Hot Folder (Setting Print Conditions)Editing a Hot Folder (Setting Print Conditions)

1
 

Open the Color imageRUNNER Enlargement Copy
dialog box.

2 Select the Hot Folder from the Hot Folder list.

3 From Enlarged Copy Settings, click Edit button to open the Add/Edit Hot Folder dialog box.
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4
 

Make the necessary settings in the Paper Settings Pan-
el →P.448 .

5
 

Make the necessary settings in the Output Settings Pan-
el →P.452 .
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6
 

Make the necessary settings in the Color Settings Pan-
el →P.454 .

7 Click the OK button to close the Add/Edit Hot Folder dialog box.

8 From the Apple Menu, open the Sharing dialog box for System Preferences.

9 For Mac OS X v10.5-v10.6:
Check the File Sharing checkbox and click the Options button.
Check the Share files and folders using FTP and Share files and folders using SMB checkboxes to config-
ure the sharing.
For Mac OS X v10.7 and later:
Check the File Sharing checkbox and click the Options button.
Check the Share files and folders using SMB checkbox to configure the sharing.

Note

• If you've made shared settings when you created a new Hot Folder, you do not need to execute steps 8 to 9.

Deleting a Hot FolderDeleting a Hot Folder

1
 

Open the Color imageRUNNER Enlargement Copy
dialog box.
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2 Select the Hot Folder you want to delete from the Hot Folder list.

3
 

Select Delete the entire folder, as well as items in
the list above, and then click the Delete button.

4 Read the messag,e and then click the OK button.

Note

• Select Delete files in the folder to delete only files in the hot folder.

Setting the Print ParametersSetting the Print Parameters
You can set the print conditions in the setting panels within the Add/Edit Hot Folder dialog box.
The settings available on each panel are as follows.

• Paper Settings Panel →P.448
• Output Settings Panel →P.452
• Color Settings Panel →P.454

Paper Settings PanelPaper Settings Panel

• Easy Settings / Advanced Settings
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings →P.450
• Advanced Settings →P.451
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• Media Type
This allows you to select the media type.

Note

• Always select media type that is actually set in the printer. When the media you chose is different from the media set in
the printer, you may not receive the desired print results.

• Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details
Cut Sheet Select to print on the cut sheet.

Roll Paper Select to print on roll paper.

• Roll Paper Width
This selects the width of the roll media set to the printer.

Note

• Available only if rolls are selected in Paper Source.

• Automatic Cutting
You can set the printer to cut roll paper automatically or print a guideline for cutting.
The following settings are available for automatic cutting.

Setting Details
Printer Default The value set on the printer operation panel takes priority.

None Each page is not cut after it is printed and printing continues without interruption.

Print Cut Guideline A print cut guideline is printed after each page and printing continues without interruption.

Note

• Available only if rolls are selected in Paper Source.

• Copies
You can input the number of print copies in numerical characters.

Note

• The maximum value is 999.
• You can change the numbers by clicking either ▲ button or ▼ button.
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Easy SettingsEasy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that matches
the content of the document.

• Print Target
You can easily select the best settings for the print job simply.
If you select each Print Target item the corresponding comment for that item is displayed below the list.

Setting Details
Default Settings Suitable for printing normal documents that contain a mixture of text, photographs, and graphics.

Photo (Color) Suitable for printing photographic images captured with a digital camera.

Photo (Monochrome) Suitable for optimized printing of monochrome photos.

Poster The best setting for posters.Prints using vivid and high impact colors.

Faithful Color Reproduction Prints by faithfully reproducing the colors of the original image.

Office Document Suitable for printing handouts as well as general office documents for which print clarity is key.

Note

• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.
Setting Details

Print Quality Highest / High / Standard / Fast
Resolution 600dpi / 300dpi

Note

• The availability of settings is determined by the media type and print priority selections.

• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is higher.

• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is lower.
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Advanced SettingsAdvanced Settings
Presents detailed settings for the print priority, the print quality, and other items so you can select the values for these
settings yourself.

• Print Priority
Select a print quality mode that is appropriate for the print job.

Setting Details
Image This mode achieves the best results for printing photographic images and illustrations.

Line Drawing This mode is best for printing CAD drawings with fine lines or wall newssheet or other documents
that contain large amounts of text. However, you may not achieve the quality you expect with
printing photographs or other images with many filled areas. For these types of jobs, select Im-
age.

Proof This is a setting for enhancing the reproducibility of characters, illustrations, and photos with print
proofing.However, this takes more time than regular printing.

Office Document Prints common office documents, such as proposals, memos for distribution, etc., so they are
easy to read.

Note

• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.
Setting Details

Print Quality Highest / High / Standard / Fast
Resolution 600dpi / 300dpi

Note

• The availability of settings is determined by the media type and print priority selections.

• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is higher.

• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is lower.
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Output Settings PanelOutput Settings Panel

• Enlarged/Reduced Printing
Select the method for enlarged/reduced printing.
The following settings are available for enlarged/reduced printing.

Setting Details
Fit Paper Size Enlarges/reduces the whole page automatically to fit the media size selected for output. Select

the media size to print from Paper Size.

Fit Roll Paper Width Enlarges/reduces the whole page automatically to fit the width of the roll paper with the page
width.
 

*Make sure that the width of the roll paper in the printer is set correctly for Roll Paper Width in
the Paper Settings panel.
*Displayed only if rolls are selected in Paper Source.

Scaling Enlarges/reduces the whole page by the scaling rate as specified. Input the scaling value in nu-
merical characters. You can specify a range between 5 and 600%.
 

*You can change the numbers by clicking either ▲ button or ▼ button.
*Although Scaling can be set to make the image larger than the media size, the part that does not
fit in the media cannot be printed.
*This is not displayed when a checkmark is placed in Borderless Printing.

• Borderless Printing
You can print the media without margins on all sides when the roll paper with the specific width and the specific
media type is used.

Note

• Available only if rolls are selected in Paper Source.

• Paper Size
You can select the size of the print media.

Note

• This is not displayed when Fit Roll Paper Width is set in Enlarged/Reduced Printing.
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• Print Centered
Select this feature to print the image in the center of a cut sheet or to print left and right margins evenly from the
edges of roll paper.

Note

• This feature is useful when you print the document enlarged or reduced with Scaling as well. When an image is scaled,
it is always enlarged or reduced in reference to a starting point in the upper left corner of the page. If the image is re-
duced, the bottom and right margins are enlarged and the top and left margins remain unchanged. At that point, you can
set all margins evenly with this feature.

• No Spaces at Top or Bottom
You can set the printer to print without any empty area when the print data contains empty area at the top or bot-
tom. Since the printer does not feed paper over the empty area, you can save paper.

Note

• Available only if rolls are selected in Paper Source.

• Rotate Page
Select the method for rotating page.
The following settings are available for rotating page.

Setting Details
Rotate Right 90 Degrees Rotates the portrait page right 90 degrees and print in landscape orientation. When the rotated

page can fit in the width of roll paper, the page is rotated automatically, and when it can not fit in
the width of roll paper, the page is not rotated.
 

*When Fit Roll Paper Width is selected under Enlarged/Reduced Printing, then the image is
enlarged or reduced after rotating to fit the width of the roll paper.

Rotate Left 90 Degrees Rotates the portrait page left 90 degrees and print in landscape orientation. When the rotated
page can fit in the width of roll paper, the page is rotated automatically, and when it can not fit in
the width of roll paper, the page is not rotated.
 

*When Fit Roll Paper Width is selected under Enlarged/Reduced Printing, then the image is
enlarged or reduced after rotating to fit the width of the roll paper.

Rotate 180 degrees Allows you to rotate the image 180 degrees from the vertical to the right.

Note

• Available only if rolls are selected in Paper Source.

• Output Method Button
Click the button to open the Output Method dialog box.
In this dialog box, you can specify the object output method.
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Color Settings PanelColor Settings Panel

• Color Mode
You can select a color mode to suit the print job.

Setting Details
Color Enables color printing.

Monochrome (Photo) Prints monochrome photo image data in a gray scale that is free of color casting (phenomenon of
grays that appear tinted).

Monochrome Disables color printing and converts image from continuous color to grayscaled monochrome.

Note

• The availability of settings depends on the print priority and media type selections.

• Matching Mode
Under Matching Mode, select the matching mode.

Setting Details
Driver Matching Mode →P.455 Enables printing of optimal color tones using a driver specific color profile. You should normally

select this mode.

ICC Matching Mode →P.456 Enables color matching using ICC profiles. Select this if you want to print by specifying the input
profile, printer profile, and matching method in detail. This allows you to use ICC profiles for digital
cameras and scanners, ICC profiles created using the profile creation tool, etc.

No Correction No color matching is performed. Select this option when you want to perform color matching in
the software application.
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Driver Matching ModeDriver Matching Mode

1
 

Under Matching Mode, select Driver Matching Mode.

2 Click Matching Method list, and then select a setting.
Setting Details

Auto Automatically selects the best color matching method for each Image, Graphics, Text.

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation is a feature.
This is also an easy-to-use mode when performing color adjustment using application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color space. This
is the easiest-to-use mode when you want to adjust the color and print. However, gradation
may be lost for colors of wider range than the color reproduction range of the printer. Generally,
this is also called relative colorimetric.

Perceptual (People, Dark Areas) Color-matching optimized for printing subdued photos such as indoor shots of people or dark
scenes. Along with preventing the gradation loss of dark areas, you can realize photos of peo-
ple in warm tones.
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ICC Matching ModeICC Matching Mode

1
 

Under Matching Mode, select ICC Matching Mode.

2 Click Matching Method list, and then select a setting.
Setting Details

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation is a feature.
This is also an easy-to-use mode when performing color adjustment using application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color space. This
is the easiest-to-use mode when you want to adjust the color and print. However, gradation
may be lost for colors of wider range than the color reproduction range of the printer. Generally,
this is also called relative colorimetric.

Colorimetric (No White-Point Cor-
rection)

The processing method of color-matching is identical to Colorimetric. Use this when you want
to further reproduce the target paper material color of the image data. Generally, this also is
called absolute colorimetric.

3 Click the Input Profile list, and then select an input profile.

Note

• To match the color on the printing, select the input profile for Color imageRUNNER Enlargement Copy of the Color
imageRUNNER type in use.

4 Click the Printer Profile list, and then select a printer profile.

Printing Enlargements of Scanned Originals from a Color imageRUNNERPrinting Enlargements of Scanned Originals from a Color imageRUNNER
Scanned originals from a Color imageRUNNER can be enlarged and printed automatically.
Originals you create by scanning with a Color imageRUNNER are transferred to a "hot folder" and printed automatically
after enlargement according to printing conditions you specify for that folder.
This processing sequence is called the Color imageRUNNER Enlargement Copy function.
To use Color imageRUNNER Enlargement Copy, first complete these settings in the following order.

1. Register a hot folder on your computer.
Register a hot folder on your computer for storing scanned originals from the Color imageRUNNER and complete
the settings for enlargement copy. For details, see "Creating a New Hot Folder." →P.444
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2. Complete the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder.

After these settings are complete, you can print enlarged copies of scanned originals from the Color imageRUNNER.

Completing the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder. It is easy to send scanned originals to
the hot folder if you assign the scanning settings and destination to a Favorites button on the Color imageRUNNER.
For instructions on assigning scanning and sending settings to the Favorites button, refer to the Color imageRUNNER
manual.

Scanning the original and print an enlargement
Follow the steps below to scan an original on the Color imageRUNNER for enlarged printing on the printer. For detailed
instructions, refer to the Color imageRUNNER manual.

1 Load the original on the platen glass or document feeder of the Color imageRUNNER.

2 Press Send to display the screen for transmission.

3 Press Favorites, and then press the Favorites button assigned to the hot folder.

4 Press Start on the control panel. If you scan originals on the platen glass, after scanning all originals, press
Done on the touch-panel display.
Scanned originals are sent to the hot folder and automatically enlarged and printed following the conditions you
specified for the folder.
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Features of the Print Plug-In for Photoshop/Digital Photo ProfessionalFeatures of the Print Plug-In for Photoshop/Digital Photo Professional
The main features of the Print Plug-In for Photoshop/Digital Photo Professional are as follows.

• You can automatically detect the color space of Adobe RGB or sRGB-use images, etc., and automatically set opti-
mal profiles. Thus, you can print without the trouble of configuring settings.

• You can modify image data directly in Photoshop and send the image data to the printer. This allows you to proc-
ess not only 8-bit, but also 16-bit image data.

• By using the preview function for images based on real images, and the preview function for layouts based on
image positioning by media size, you can use this software to make color adjustments and confirm print layout.

• You can perform basic printer settings such as printer selection, media type and output profile selection, and
matching methods, in addition to borderless printing and enlargement/reduction process without growing through
the printer driver.

• You can print an image with adjustment values such as the color balance, brightness, and contrast varying in
steps and select your preferred adjustment values.  (See "Adjustment pattern setting dialog box.") →P.476

• You can create and print a layout image for finishing by mounting in a frame with the image extended to the sides
of the frame by using the Layout Plug-In that is installed at the same time as the Print Plug-In for Photoshop.  (See
"About the Layout Plug-In.") →P.516

• By using the print history management function, you can import past print settings parameters. Additionally, you
can save preferences as a file.

Note

• The actual output may differ from the settings in Print Plug-In for Photoshop/Digital Photo Professional (the arrangement of the
image in the layout preview, print start position, and paper size) depending on the media type, image size, paper detailed
settings, and printer main unit settings.

• Loss of gradation in dark areas can be reduced by performing black point compensation.

Note

• Adobe CMM is required in order to use the black point compensation function.

• You can perform a printer simulation print by specifying the printer profile.

Installation ProceduresInstallation Procedures
The procedures to install Print Plug-In for Photoshop/Digital Photo Professional are as follows.

Note

• Always install the printer driver before installing the Print Plug-In for Photoshop/Digital Photo Professional.

• The Layout Plug-In is also installed when the Print Plug-In for Photoshop is installed.

1 Insert the User Software CD-ROM into the CD-ROM drive to start the installer.

2
 

Click on the iPFxxxx PlugIn InstallerX icon in the Plug-in folder in the User
Software CD-ROM.

Note

• The iPFxxxx icon is the name of the printer you are using.
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3
 

Input the Administrator name and password and click
the OK button.

4
 

After you have read the software User's Licensing
Agreement, click the Continue button.

5
 

Click the Agree button.

6
 

Select Custom Install to put a checkmark on your Print
Plug-In, then click the Install button.
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7
 

To quit another application, click the Continue button.

8
 

Click the Quit button.

The Print Plug-In for Photoshop/Digital Photo Profes-
sional installation is complete.

Uninstall ProceduresUninstall Procedures
The procedures for uninstalling the Print Plug-In for Photoshop/Digital Photo Professional are as follows.

• Uninstall Print Plug-In for Photoshop

1. Close Photoshop.

2. In Finder, display the Print Plugin for iPFxxxx folder.

3. Delete the Print Plugin for iPFxxxx folder.

Note

• iPFxxxx is the name of your printer.

• Uninstall Print Plug-In for Digital Photo Professional

1. Perform the installation procedures 1 through 5.
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2.  

Select Uninstall.

3.  

Click the Uninstall button.

4.  

To quit another application, click on the Continue but-
ton.

5.  

Click the Quit button.
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Starting from PhotoshopStarting from Photoshop
Follow the procedure below to start the Print Plug-In for Photoshop from Photoshop.

1 Start Photoshop.

2 Open the image that you wish to print.

3 If required, select the print range.

Note

• Images for use with Print Plug-In for Photoshop are less than 60,000 pixels in width and height. Reduce the selection
range or reduce the image with processing for images more than 60,000 pixels in width and height, and then attempt
step 3.

4
 

Select Export (or Data Export) from the File menu and
then select the output plug-in that matches your printer.
The imagePROGRAF Print Plug-In for Photoshop win-
dow (known below as the Print Plug-In window) is dis-
played.

Note

• When the color space of the input image is CMYK, it is changed to AdobeRGB for processing with Print Plug-In for
Photoshop. Also, Relative Colorimetric is used for the matching method.

• If the message below is displayed but the Print Plug-In window is not displayed, install the newest imagePROGRAF
printer driver and then attempt step 3.
To install imagePROGRAF Print Plug-In, the latest version of the imagePROGRAF printer driver must be in-
stalled.

• If the following message is displayed, but the Print Plug-In window is not displayed, open only one Photoshop.
When Photoshop is running in multiple windows, the plug-in may not start.

• If the message below is displayed but the Print Plug-In window is not displayed, convert the color space of the image
to either RGB color, grayscale, or CMYK color and then attempt step 3.
Set the color space of the image to either RGB color, grayscale, or CMYK color.

Starting from Digital Photo ProfessionalStarting from Digital Photo Professional
Follow the procedure below to start the Print Plug-In for Digital Photo Professional from Digital Photo Professional.

1 Start Digital Photo Professional.

2 Open the RGB color image that you want to print.

3 If required, select the print range.

Note

• Images for use with Print Plug-In for Digital Photo Professional are less than 6,000 pixels in width and height. Re-
duce the selection range or reduce the image with processing for images more than 6,000 pixels in width and height,
and then attempt step 3.
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4
 

Select File from the Plug-in printing menu and then
select the output plug-in that matches your printer.
The imagePROGRAF Print Plug-In for Digital Photo
Professional window (hereinafter referred to as the
Print Plug-In window) is displayed.

Print Plug-In for Photoshop/Digital Photo Professional Main WindowPrint Plug-In for Photoshop/Digital Photo Professional Main Window
The Print Plug-In main window consists of the sheet selection area, and the preview and button area.

• Sheet Selection Area
The tabs used to switch between each sheet on the Print Plug-In window are displayed.

When you select a tab, a sheet is displayed. The settings available on each sheet are as follows.
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• Main Sheet →P.467
• Page Setup Sheet →P.470
• Color Settings Sheet (Color) →P.472
• Print History Sheet →P.474
• Support Sheet →P.475

• Preview Area
You can check the settings you made on the image in this area.

About the settings available on the preview area, see "Preview Area." →P.466
 

• Button Area
This contains the buttons Print, Quit, Help and Maximize Dialog Box

• Print Button
Click this button to begin printing.

• Quit Button
Click this button to close the Print Plug-In window and return to application software.

•  Button
Click this button to display the Print Plug-In for Photoshop/Digital Photo Professional Help file.

• Maximize Dialog Box button
When this button is clicked, the Print Plug-In main window is displayed enlarged to cover the entire display
screen.
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Preview AreaPreview Area
You can check the settings you made on the image in this area.

• Preview
Select the preview display method.
For more information about preview, see "Utilize Three Types of Previews." →P.486

Setting Details
Print Area Layout Displays the print range and the area out of the print range in the layout matching the Paper Size

set.
 

*You can change the image print position when you drag the image while the cursor is displayed
as .

Image The entire image is displayed.
 

*You can select the print range when you drag the image while the cursor is displayed as .

*When you click the image while the cursor is displayed as , the selected area is deselected.

Roll Paper Preview Display the media size and roll paper information on the top in the layout printing on roll paper.
 

*To select Roll Paper Preview, select Roll Paper in Paper Source.

• Print Selected Range
Place a checkmark here to only print the selected range.

Note

• When you select Preview in the Image, then select a portion of the image on the preview display, this becomes valid.

• Perform Proof in Preview
Place a checkmark here to simulate the colors of the output product in the preview.

Note

• If Auto (Color) is selected under Output Profile, some media types are enabled.
• If ICC profile is selected under Output Profile, this is always enabled.

• The actual color balance of the print product and the simulation product may differ with some environments and condi-
tions. In addition, when you have selected an ICC Profile with Output Profile and it is not compatible with the printer or
media that you are using, the color balance of the actual print product will differ.

• Image Properties button
When you click the button to open the Image Properties dialog box, where Image Size, Resolution, Bit and
Color Space information of the image imported to Print Plug-In are displayed.
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Click the Close button to return to Print Plug-In.

Main SheetMain Sheet
You can use this sheet to perform basic settings such as selecting a printer, setting the media type, or adjusting image
quality.

• Printer
The printer types are displayed.
 

• Select button
Click this button to display the Select Printer dialog box.
When you click the OK button after selecting the printer in the Select Printer dialog box, you can change the print-
er that corresponds with Print Plug-In.
 

• Media Type
This allows you to select the media type.
For more information about, see "Customize Media Settings." →P.505

Note

• Always select media type that is actually set in the printer. When the media you chose is different from the media set in
the printer, you may not receive the desired print results.

• Advanced Settings button
Click the button to display the Paper Detailed Settings dialog box.
For more information about the media detailed settings, see "Paper Detailed Settings Dialog Box." →P.480
 

• Input Resolution to Plug-in
You can select the resolution to process the image with Print Plug-In.
The following settings are available for resolution.
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Setting Details
Accuracy 300ppi This processes images at an accurate resolution. This can control print speed and memory ca-

pacity.

High Accuracy 600ppi This processes images at a more accurate resolution. This setting results in the best print quality,
but this takes more time to print than Accuracy 300ppi while also requiring more memory capaci-
ty.
 

*This may not be displayed depending on how you set Media Type

• Input Bit to Plug-in
You can select the bit number to process with Print Plug-In.
The following settings are available for the input bit number.

Setting Details
High Gradation 8bit This processes images with at 8bit/channel (24 bit).

Highest Gradation 16bit This processes images with at 16bit/channel (48 bit).
 

*This may not be displayed depending on how you set Media Type and Input Resolution to
Plug-in.

• Print Mode
Selecting the printing mode strikes the balance between the quality of the printed image and printing speed.
The following settings are available for the print mode.

Setting Details
Highest A setting for printing at the highest resolution when quality is most important. Printing takes longer

and consumes more ink than in other modes, but this mode offers superior printing quality.

High Choose this setting to print at high resolution when quality is most important. Printing takes longer
and consumes more ink than in Standard or Fast modes, but this mode offers exceptional print-
ing quality.

Standard Choose this setting to print at standard resolution when quality and speed are both important.
Printing takes less time than in Highest or High mode.

Fast Choose this setting to print faster. Printing in fast mode can help you work more efficiently when
checking layouts.

Highest (Max. No. of Passes) If you are concerned about uneven colors in the print result of Highest quality, selecting this op-
tion may improve printing results. However, printing may take longer.

Note

• The selectable fields may vary according to the Media Type, Input Resolution to Plug-in and Input Bit to Plug-in
settings.

• Output Profile
You can select the output profile.
The following settings are available for the output profile.

Setting Details
Auto (Color) Performs the optimum color conversion from the input image data color space information (sRGB,

Adobe RGB), media settings etc. You should normally select these settings.

Auto (Monochrome Photo) Performs the best color conversion to monochrome from the input image data color space infor-
mation (sRGB, Adobe RGB), media settings etc.

None (No Color Correction) You cannot perform color conversion with a plug-in. This is useful for creating an original ICC
profile.

External ICC Profiles This selects printer ICC profiles to be output to ICC profiles saved in the OS standard folder. Use
the color space of the input data as well as the select ICC profile to perform color conversion.
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Note

• Auto (Monochrome Photo) can only be selected for the corresponding media types.

• Proof
This is displayed when an ICC profile is selected as the Output Profile.
When this is checked, you can perform printing press simulation prints.
Refer to Perform Printing Press Simulation Print →P.500  for details on printing press simulation prints.

• Matching Method
You can select the processing method when performing color conversion.
The following settings are available for the matching method.

Setting Details
Perceptual This converts the image to an image with natural color balance and gradation. This is useful for

pictures.

Saturation This converts the image to an image with heightened color saturation. The color balance of pic-
tures and drawings may change.

Relative Colorimetric This converts the image with emphasis on color balance before the conversion or on visual color
balance. This is useful for pictures and drawings.

Note

• When the Output Profile you have set is Auto (Monochrome Photo) or None (No Color Correction), you cannot se-
lect a matching method.

• ICC Conversion Options button
This is displayed when an ICC profile is selected as the Output Profile.
When this button is clicked, the ICC Conversion Options dialog box is displayed allowing you to configure color
conversion related settings.
Refer to ICC Conversion Options dialog box →P.482  for details on ICC Conversion Options.
 

• Copies
You can input the number of print copies in numerical characters.

Note

• The maximum value is 99.
• You can change the numbers by clicking either ▲ or ▼.

• Set Configuration button
Clicking the button opens the Set Configuration dialog box that provides settings for the adjustment of image
sharpness and image enlargement method.
For more information about Set Configuration, see "Set Configuration Dialog Box." →P.481
 

• Defaults button
Click the button to return all of the settings on the Main sheet to their defaults.
 

iPF9400                                                                                                                                                                                                                           Main Sheet

User's Guide                                                                                                                                                                                                                                       

  

M
ac O

S X Softw
are

Print Plug-In for Photoshop / D
igital Photo Professional

469  



Page Setup SheetPage Setup Sheet
You can use this sheet to set the size of the image to be printed, the media size, and whether to enlarge/reduce the
image.

• Input Image Size
The size of the image imported to Print Plug-In is displayed.
 

• Borderless Printing
When you place a checkmark here, the Specify Roll Paper Width dialog box is displayed and you can print an
image without borders.
For more information about Borderless Printing, see "Print with No Borders." →P.504

Note

• Available only if rolls are selected in Paper Source.

• Enlarged/Reduced Printing
When you place a checkmark here, you can print enlarged/reduced images.
When printing an enlarged/reduced image, select the method for enlargement/reduction. The image size sent to
the printer is displayed matching the selected method in Output Image Size.
The following settings are available for enlarged/reduced printing.

Setting Details
Fit Paper Size This automatically enlarges/reduces the entire image imported to Print Plug-In to match the ex-

port media size when printing.

Fit Roll Paper Width This automatically enlarges/reduces the entire image imported to Print Plug-In to match the width
of the roll paper with the width of the image when printing.
 

*Displayed only if rolls are selected in Paper Source.

Scaling This enlarges/reduces the entire image by the specified scaling value. Input the scaling value in
numerical characters. You can specify a range between 5-600%.
 

*You can change the numbers by clicking either ▲ or ▼.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

• Output Image Size
The output image size is displayed up to one place after the decimal point in millimeters.
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Note

• When Paper Size is smaller than Output Image Size, part of the image may not print.

• Paper Size
You can select the size of the print media.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

• This is not displayed when Fit Roll Paper Width is set in Enlarged/Reduced Printing.

• Orientation
This selects the print orientation.
The following settings are available for orientation.

Setting Details
Portrait Prints the image on the media as it appears on the screen.

Landscape Prints the image on the media rotated 90 degrees.

• Layout
You can select the print position of an image on the media.
The following settings are available for layout.
 

Layout
Setting Details

Upper-Left of Output Paper Size Prints the image with fitting the top left of the active print area for Paper Size.

Center of Output Paper Size Prints the center of the image on the center of the selected Paper Size.

Specify Print Start Position You can print with specifying the top and left printing start positions in From Top Margin and
From Left Margin for Paper Size.

From Top Margin Input the margin from the top of the media in numbers.
 

*You can input between -9999 and 9999 mm.

From Left Margin Input the margin from the left of the media in numbers.
 

*You can input between -9999 and 9999 mm.

Note

• Select Print Area Layout or Image in Preview when you select Layout.

 

Roll Paper Layout
Setting Details

Upper-Left of Roll Paper Prints the top left of Media Size on the top left of the selected roll paper.

Center of Roll Paper Prints the center of Media Size on the center of the selected roll paper.

Note

• Select Roll Paper Preview in Preview when you select Roll Paper Layout.

• Paper Source
You can select the media source.
The following settings are available for media source.

Setting Details
Roll Paper Select to print on roll paper.

iPF9400                                                                                                                                                                                                                Page Setup Sheet

User's Guide                                                                                                                                                                                                                                       

  

M
ac O

S X Softw
are

Print Plug-In for Photoshop / D
igital Photo Professional

471  



Setting Details
Cut Sheet Select to print on the cut sheet.

• Roll Paper Options button
Click this button to open the Roll Paper Options dialog box, where you can set roll paper width and perform auto
cut settings.
For more information about the roll paper options, see "Roll Paper Options Dialog Box." →P.483
 

• Size Options
Click the Size Options button to open the Size Options dialog box and you can select a media name, size and
other settings.
For more information about the size options, see "Size Options Dialog Box." →P.483
 

• Defaults button
Click the button to return all of the settings on the Page Setup sheet to their defaults.
 

Color Settings Sheet (Color)Color Settings Sheet (Color)
You can use this sheet to adjust image Color, Brightness, Contrast, Saturation, and you can set the color balance of
print product more to your liking.

Note

• You can check a preview of the adjusted state for the following items.
Cyan / Magenta / Yellow, Gray Tone, Brightness, Contrast, Saturation, and Gray Tone Adjustment

• Cyan / Magenta / Yellow
You can adjust the strength or weakness of a color by either inputting a numerical value or dragging the slide bar.

• Gray Tone
You can adjust gray tone from cool black (cool tones) to warm black (red tones) by either inputting a numerical
value or dragging the slide bar.

• Brightness
You can adjust the brightness of the printed image without losing the brightest and darkest areas by either input-
ting a numerical value or dragging the slide bar.

• Contrast
You can relatively adjust the brightness of the brightest and darkness areas by either inputting a numerical value
or dragging the slide bar.

Color Settings Sheet (Color)                                                                                                                                                                                                iPF9400

                                                                                                                                                                                                                                       User's Guide

  

M
ac O

S X Softw
are

Print Plug-In for Photoshop / D
igital Photo Professional

 472



• Saturation
You can adjust the saturation of vivid color balance to dark color balance by either inputting a numerical value or
dragging the slide bar.

• Adjustment pattern setting button
When this button is clicked, the Adjustment pattern setting dialog box is displayed. The Adjustment pattern
setting dialog box allows you to print an adjustment pattern with adjustment values that vary in steps up and
down, and to select your preferred adjustment values.
For details on Adjustment pattern setting,see "Adjustment pattern setting dialog box." →P.476

• Curve button
Click the button to open the Curve dialog box then set the Channel and other settings.
For more information about Curve, see "Curves Dialog Box." →P.484

• Defaults button
Click the button to return all of the settings on the Color Settings sheet to their defaults.

Color Settings Sheet (Monochrome)Color Settings Sheet (Monochrome)
This screen allows you to adjust settings such as the Color Balance, Tone, Brightness, and Contrast to configure
the printing result to be closer to your expected tone and gradation.
This is displayed when Auto (Monochrome Photo) is selected in the Output Profile on the Main Sheet →P.467 .

Note

• You can check a preview of the adjusted state for the following items.
Color Balance, Tone, Brightness, Contrast, Highlight, Shadow, and Tint

• Color Balance
Allow you to select the color balance to suit your application.

• X / Y
Adjust the color balance as you check the color tone in the adjustment area.
You can adjust the square area in the center by clicking or dragging it.
Drag the vertical or horizontal scroll bars for adjustment, as desired.
You can click the arrows by the X (horizontal) and Y (vertical) boxes or enter the values directly.

• Tone
You can adjust the brightness of intermediate tones in an image. Selecting Hard tone gives a hard impression
with more definition. Selecting Soft tone gives a soft impression.
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• Brightness
You can adjust the brightness of the printed image without losing the brightest and darkest areas by either input-
ting a numerical value or dragging the slide bar.

• Contrast
You can relatively adjust the brightness of the brightest and darkness areas by either inputting a numerical value
or dragging the slide bar.

• Highlight
Adjust the brightness of the lightest portion.

• Shadow
Adjust the brightness of the darkest portion.

• Tint
Fills in the white parts of the paper with a small amount of ink in order to reduce the difference in texture between
highlights in the image and the white parts of the paper.

• Adjustment pattern setting button
When this button is clicked, the Adjustment pattern setting dialog box is displayed. The Adjustment pattern
setting dialog box allows you to print an adjustment pattern with adjustment values that vary in steps up and
down, and to select your preferred adjustment values.
For details on Adjustment pattern setting, see "Adjustment pattern setting dialog box." →P.476

• Curve button
Click the button to open the Curve dialog box then set the Channel and other settings.
For more information about Curve, see "Curves Dialog Box." →P.484

• Defaults button
Click the button to return all of the settings on the Color Settings sheet to their defaults.

Print History SheetPrint History Sheet
You can use this sheet to apply settings history used in printing, and to print information, such as the image file name,
with the image.

• Print History and Favorites
This displays a list of print preferences.
Select Restore Defaults and click the Apply button to restore all settings to their initial settings.

Note

• You can check the 3 print preferences in the preview display.
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• Apply button
When you click the button, the print setting content applies to the current image selected with Print History and
Favorites.
 

• Details button
Click the Details button to open the Print History Details dialog box, where you can manage print history.
For more information about the print history details, see "Print History Details Dialog Box." →P.485
 

• Print Information
When you place a checkmark here, you can print the file name and print time and date on the image. The following
settings are available for the print position and content.
For more information about Print Information, see "Set Information to Print with Image." →P.514

Setting Details
Information Print Position Selects the information print position.

Top (Header) Information is printed on the top of the image.

Bottom (Footer) Information is printed on the bottom of the image.

Print History Number Place a checkmark here to print the print history number.

File Name Place a checkmark here to print the file name.

Printed at Place a checkmark here to print the time and date.

Color Adjustment Value Place a checkmark here to print the color adjustment value.

Printer Name Place a checkmark here to print the printer name.

Comment Place a checkmark here to print the comment details.

Comment Details Place a checkmark here to display the comment details.

• Edit Comment button
Click the button to display the Edit Comment dialog box, where you can edit the comment.
 

Support SheetSupport Sheet
You can display product support information and the electronic manual.

• Support Information button
Click the button to display websites that contain the latest product information.
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Note

• An Internet connection is needed to view the websites.

• User Manual button
Click the button to display the printer manuals installed on the computer.

Note

• You must have User Manual installed on your computer.

• About button
Click the button to open the version information window of the Print Plug-In. Click the OK button in the version
information window to return to the Print Plug-In window.
 

Adjustment pattern setting dialog boxAdjustment pattern setting dialog box
Displays the adjustment pattern by taking images with the adjustment values varying up and down in steps from the
baseline adjustment values in the Color Settings sheet (color or monochrome). This allows you to print the adjustment
pattern and select your preferred adjustment values while comparing the images.

• Preview Area
This area allows you to view adjustment pattern images side-by-side to check the state when changes to adjust-
ment values are applied.
The adjustment values of the image enclosed in the blue frame in the center are used as the base values, with
images arranged around this with the adjustment values varying in steps up and down from these base values. If
you click any of the images, the adjustment pattern is redisplayed with the adjustment values from that image as
the base values.
The adjustment values are displayed at the top of each image. If both the Horizontal Axis and Vertical Axis are
configured, the adjustment value for the Horizontal Axis is displayed on the right and the adjustment value for the
Vertical Axis is displayed on the left. If the image is so small that the adjustment values cannot be displayed, you
can check the adjustment values by displaying the tool tip.

Note

• For images where the adjustment values are out of range, an adjustment pattern is not displayed and the message Out
of Range is displayed instead.

• Paper Source
Selects the paper feed method for the paper to print the adjustment pattern on. You can split the usage between
printing adjustment patterns on cut paper (manual feed) and printing work pieces on roll paper.
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• Use Paper Size
Selects the paper size to print the adjustment pattern on.
The adjustment pattern is printed so that it fits into the selected paper size.

Note

• If the image size is large and Dimensions is selected in Pattern Size, the pattern display might not fit within the vertical
direction of the paper size. In this case, select Auto in Pattern Size.

• The printed paper size is displayed in Paper Size.

• Paper Size
Since the length in the vertical direction may differ between the Use Paper Size and actual printed material, this
displays the actual output paper size.

• No Space at Paper Bottom (Conserve Paper)
If a margin appears at the bottom of the paper with the paper size selected in Use Paper Size, you can conserve
paper by selecting this check box to print excluding the margin area. The state of the length in the vertical direction
being shortened to conserve the margin area is reflected in the displayed Paper Size.

• Horizontal Axis / Vertical Axis
Configures settings such as the items that change in steps and the number of patterns when multiple adjustment
patterns are arranged horizontally or vertically.

• Adjustment Item
Selects the items to change in steps.
For color, you can select Cyan, Magenta, Yellow, Gray Tone, Brightness, Contrast, or Saturation.
For monochrome, you can select X Color Balance, Y Color Balance, Tone, Brightness, Contrast, High-
light, Shadow, or Tint.
The icons for Horizontal Axis Adjustment Item are displayed above the preview area and the icons for Ver-
tical Axis Adjustment Item are displayed on the left of the preview area.

Note

• None can only be selected for Vertical Axis in both color and monochrome.

• Number of Patterns
You can select the number of images to display in the pattern in the horizontal or vertical direction from 3, 5,
and 7. If the adjustment item is Tone, you can select 3 or 5. When Tone is selected as the adjustment value,
-1 is Soft tone, 0 is Middle tone, 2 is Medium-hard tone, 3 is Hard tone, and 5 is Strong-hard tone.

• Adjustment Value Spacing
You can select the interval of the variation in adjustment values between neighboring adjustment pattern im-
ages from the range of 1 to 10. The larger the value, the greater the differences between the states of the
adjustment pattern images. Note that if the adjustment item is Tone, the Adjustment Value Spacing cannot
be selected.

• (Swap) button
Rearranges the adjustment pattern with the Horizontal Axis and Vertical Axis adjustment items swapped.

• Rotate 90 degrees
Rotating the image may make it easier to conserve paper and compare images.
Select Per Image to rotate each of the images in the adjustment pattern by 90 degrees.
Select Entire Image after layout to rotate the entire adjustment pattern by 90 degrees.
When None is selected, the image is not rotated.
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• Pattern Size
You can specify the size of the image when printing the adjustment pattern.
When Auto is selected, the image is enlarged or reduced to fit the adjustment pattern into the Use Paper Size.
When Dimensions is selected, the image is printed at the input image size without enlarging or reducing. Dimen-
sions cannot be selected when the paper feed method is Manual.

Note

• If the input image size is large, check the Paper Size before starting printing because it may be larger than the actual
printed material size.

• Select Dimensions in Pattern Size to print at the input image size without enlarging or reducing the images.

• Patterns that extend past the horizontal width of the paper are printed wrapped onto the next line.

• Pattern Spacing
You can select None or Available. If Available is selected, you can insert a background between each image.
The background color can be specified in Pattern Background.

• Pattern Background
You can select the background color from White, Black, and Gray.
If it is difficult to compare the differences between neighboring adjustment pattern images, changing the back-
ground color may make it easier to compare. The Pattern Spacing can be selected if Pattern Background is
Available.

• Update Base Values in the Color Settings Sheet
Select this check box and click the Close button to apply the setting values (standard values) of the image en-
closed in the blue frame in the center of the preview area in the Color Settings panel (color or monochrome).

• Print Conditions
Displays the paper type, print mode, and output profile configured in the main window. This makes it possible to
check the details of each of the settings when printing the adjustment pattern without returning to the main win-
dow.
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• Specify the Range of Images button
When this button is clicked, the Specify the Range of Images dialog box is displayed for specifying the range of
images.

When you specify the range by using the mouse or other means and then click the OK button, the Specify the
Range of Images dialog box closes and the specified image range is redisplayed as the adjustment pattern.
If you click the Cancel button, the Specify the Range of Images dialog box closes even if a range is selected.

Note

• The selected range is cleared by clicking the image with a range selected.

• Restore to Previous button
When this button is clicked, the settings are restored to the defaults when the Adjustment pattern setting dialog
box was first displayed.

• Close button
When this button is clicked, the setting values in the Adjustment pattern setting dialog box are saved and the
dialog box is closed. These setting values are applied the next time the Print Plug-In for Photoshop/Digital Photo
Professional is started. Furthermore, if you select the Update Base Values in the Color Settings Sheet check
box and click the Close button, the setting values for the image enclosed in the blue frame in the preview area
(central image) are applied to the settings in the Color Settings sheet (color or monochrome).

• Print Adjustment Pattern button
When this button is clicked, printing the adjustment pattern is executed. The Adjustment pattern setting dialog
box does not close even after executing the printing.
The adjustment values are printed at the top of each image. If both the Horizontal Axis and Vertical Axis are
configured, the adjustment value for the Horizontal Axis is displayed on the right and the adjustment value for the
Vertical Axis is displayed on the left.

iPF9400                                                                                                                                                                                Adjustment pattern setting dialog box

User's Guide                                                                                                                                                                                                                                       

  

M
ac O

S X Softw
are

Print Plug-In for Photoshop / D
igital Photo Professional

479  



Each of the setting values for the paper type, print mode, and output profile as well as the adjustment values con-
figured in the Color Settings sheet (color or monochrome) are printed at the bottom of the paper. However, the
adjustment values for the Curve are not printed.

Note

• The job name when printing the adjustment pattern is "Original Image Name + Pattern-Print". For example, the print job
name for the image "ABC.jpg" is "ABC_Pattern-Print.jpg".

• Maximize Dialog Box button
When this button is clicked, the Adjustment pattern setting dialog box is displayed enlarged to cover the entire
display screen.

Paper Detailed Settings Dialog BoxPaper Detailed Settings Dialog Box
This dialog box appears when you click the Advanced Settings button on the Main Sheet. You can set Drying Time
and Roll Paper Margin for Safety by media type.

• Roll Paper Margin for Safety
Near End Margin
This sets the length of the near end margin of the roll paper.

Setting Details
Printer Default The settings of the printer operating panel are applied.

5mm Print at a standard size.
 

*Select for Media Type that has no problem when printing with a standard size margin.

20mm Select this when rubbing against the printhead occurs such as when using paper that tends to
curl.

• Cut Speed
This selects the auto cut speed.

Setting Details
Printer Default The settings of the printer operating panel are applied.

Fast Select this setting if cutting with the Standard setting is not clean.

Standard Select this setting when you are not experiencing problems.

Slow This helps prevent adhesive from sticking to the cutter and keeps the cutter sharp if you select it
when using adhesive paper.

• Calibration Value
When calibration has been carried out on the printer, use this setting to choose whether or not to use the results.

Setting Details
Printer Default The settings of the printer operating panel are applied.

Use Value The calibration results are used for printing.
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Setting Details
Disregard Value The calibration results are not used for printing. Select this option to avoid changes to image color

tones during printing due to color calibration.

• Mirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or image
with the left and right sides inverted.
 

• Unidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the
printing speed becomes slower.
 

• High-Precision Text and Fine Lines
Print increasing ink impact accuracy, particularly for sharper text and fine lines. However, this takes more time
than regular printing.

Note

• When Highest (Max. No. of Passes) is selected as the print mode, High-Precision Text and Fine Lines cannot be
selected.

 

Set Configuration Dialog BoxSet Configuration Dialog Box
This dialog box appears when you click the Set Configuration button on the Main Sheet. You can set the adjustment
of image sharpness and image enlargement method.

• Sharpen
Performs adjustment of the sharpness (outline) settings.
 

• Image Enlargement Method
You can select the image enlargement method.
The following settings are available for the image enlargement method.

Setting Details
Nearest Neighbor Performs simple enlargement.

Bilinear Performs line vector enlargement.

Bicubic Adjust pixels with calculation of elements such as a color or brightness of neighboring pixels.
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• Perform printing in the background
When you place a checkmark here, the plug-in performs printing with the Plug-In in the background.
 

• Close Plug-in After Printing
When you place a checkmark here, the plug-in closes after printing finishes.

Note

• If printing does not finish correctly because it was canceled or an error occurred, the plug-in does not close.

• Output Method
You can select the output method.
The following settings are available for the output method.

Setting Details
Print Normal printing. The print job data is stored temporarily in the box as the job prints.

Save in mail box Saves the print data in the mail box.
If you select Save in mail box, you must specify Name of data to be saved.

Print after reception is complete When you place a checkmark here, you can print after saving jobs in the temporary storage
space. This cannot be used when Save in mail box is selected.

• Initialize all warning dialog boxes
When this is checked, all of the warning dialog boxes that have been set to "Do not show this screen again" be-
come displayed.
 

ICC Conversion Options dialog boxICC Conversion Options dialog box
This is displayed when an ICC profile is selected in the Output Profile list in the Main sheet and the ICC Conversion
Options button is clicked. This allows you to configure detailed color matching related settings.

• Conversion Engine
Selects the conversion engine to use when converting colors.

Note

• Adobe CMM needs to be installed in order to use Adobe CMM. Refer to Using Adobe CMM →P.496  for details on how
to install Adobe CMM.

 

• Black Point Compensation
Check this check box to perform black point compensation. Loss of gradation in dark areas can be improved by
performing black point compensation.

Note

• This can be used if Adobe CMM is selected as the Conversion Engine.
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• Proof Options
Configures settings related to printing press simulation.
The proof options consist of the following settings.

Setting Details
Simulate Paper Color Select this when performing paper color simulation.

Roll Paper Options Dialog BoxRoll Paper Options Dialog Box
This dialog box appears when you click the Roll Paper Options button on the Page Setup Sheet. You can set the roll
paper width and perform the auto cut settings.

• Roll Paper Width
This selects the width of the roll media set to the printer.
 

• Automatic Cutting
You can set the printer to cut roll paper automatically or print a guideline for cutting.
The following settings are available for automatic cutting.

Setting Details
Available Each page is automatically cut after it is printed.

None Each page is not cut after it is printed and printing continues without interruption.

Print Cut Guideline A print cut guideline is printed after each page and printing continues without interruption.

• No Spaces at Top or Bottom (Conserve Paper)
When you place a checkmark here, the print data is printed without margins.
 

Size Options Dialog BoxSize Options Dialog Box
This dialog box appears when you click the Size Options button on the Page Setup Sheet. You can select a media
name, size and other settings.

• Paper Size List
Displays all the standard sizes and custom media sizes.
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• Custom Paper Size Name
You can enter any name up to 63 characters.
 

• Units
You can select the units of measure to use when you define custom media size. Switching this setting resets the
units of measure for the entire Plug-In.
 

• Paper Size
Width
Enter the width of the media size.
 

Height
Enter the height of the media size.

• Add button
Click the button to register the contents of the settings.
 

Curves Dialog BoxCurves Dialog Box
This dialog box appears when you click the Curves button on the Color Settings Sheet. You can set Channel and
other settings.

• Channel
Select from among RGB, Red, Green, or Blue.

Note

• Gray is displayed for monochrome printing and this selection cannot be changed.

• Input
Enter an input value.
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Note

• The allowed entry range is 0 to 255.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Output
Enter an output value.

Note

• The allowed entry range is 0 to 255.

• Load Curves button
Click the button to load stored data for a tone curve.
 

• Save Curves button
Click the button to stores the current tone curve settings.
 

Print History Details Dialog BoxPrint History Details Dialog Box
This dialog box appears when you click the Details button on the Print History Sheet. This controls print history. For
more information about Print History Details, see "Utilize Print History." →P.505

• Print History
Print History appears in list format.

Display Items Details
Print History Number Displays the print history number.

File Name Displays image file name.

Printed at Displays time and date of printing.

Comment Displays comment details.

Note

• Up to 200 print history items can be displayed. All items above 200 are deleted.

• When you cannot print properly because you canceled the printing or an error occurred, appears  to the left of the
print history number.

• Delete button
Click the button to delete the selected print history.
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• Add button

Click the  button to add the selected print history to preferences.

Note

• Up to 200 print preference items can be added.

• Favorites
The print history stored in print preferences displays in list format.

Note

• You can change the order by selecting an item and dragging it to another place.

• Import button
Click the button to import print history saved as a file.
 

• Export button
Click the button to save print history as a file that is stored in print preferences.
 

• Delete button
Click the button to delete print history stored in print preferences.
 

• Settings
Displays the print history settings selected from the Print History or Favorites.

Setting Details
Main When you select this the Main sheet settings are displayed.

Page Setup When you select this the Page Setup sheet settings are displayed.

Color Settings When you select this the Color Settings sheet settings are displayed.

Utilize Three Types of PreviewsUtilize Three Types of Previews
You can use Print Plug-In to check an image in three types of previews.
The preview types are as follows.

• Check Image with Print Area Layout →P.487
• Check the original image with Image →P.487
• Check Image with Roll Paper Preview →P.488
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Check Image with Print Area LayoutCheck Image with Print Area Layout
Displays the print range and the area out of the print range in the layout matching the media size set in the print area
layout.
Select Print Area Layout in Preview.

Note

• When the cursor on the preview is displayed as  on the preview, you can specify the print position by dragging the image.

• When the cursor is displayed as  on the preview, the below conditions on the Page Setup sheet have all been met.

• There is no checkmark in Borderless Printing.

• There is no checkmark in Enlarged/Reduced Printing or Scaling has been selected.

Check the original image with ImageCheck the original image with Image
In the image preview you can check the entire image that you have input.
Select Image in Preview.

Note

• When the cursor appears as a small magnifying glass  while there is an Image in the Preview area, the Selected Range
feature is enabled and you an drag the cursor on the image and select an area for printing.

• When you click the image while the cursor is displayed as  on the preview, the selected area is deselected.
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Check Image with Roll Paper PreviewCheck Image with Roll Paper Preview
Display the media size and roll paper information on the top in the layout printing on roll paper in Roll Paper Preview
Select Roll Paper Preview in Preview.

Note

• To select Roll Paper Preview in Preview, select Roll Paper in Paper Source.

Print with a Desired Picture QualityPrint with a Desired Picture Quality
You can specify and print at the resolution you desire.

1
 

Display the Main sheet.

2 Select the media set to the printer in Media Type.

Note

• Always select media type that is actually set in the printer. When the media you chose is different from the media set
in the printer, you may not receive the desired print results.

 

Check Image with Roll Paper Preview                                                                                                                                                                                 iPF9400

                                                                                                                                                                                                                                       User's Guide

  

M
ac O

S X Softw
are

Print Plug-In for Photoshop / D
igital Photo Professional

 488



3 Choose either Accuracy 300ppi or High Accuracy 600ppi for the resolution to process images in Input Res-
olution to Plug-in.

Note

• When you select Accuracy 300ppi images are processed at an accurate resolution. This can control print speed
and memory capacity.

• When you select High Accuracy 600ppi images are processed at a more accurate resolution. This setting results in
the best print quality, but this takes more time to print than Accuracy 300ppi while also requiring more memory
capacity.

• High Accuracy 600ppi will not display with some Media Type settings.

4 Choose either High Gradation 8bit or Highest Gradation 16bit for the bit number when processing images in
Input Bit to Plug-in.

Note

• When you select High Gradation 8bit, images are processed at 8 bit/channel (24 bit).

• When you select Highest Gradation 16bit, images are processed at 16bit/channel (48 bit).

• Highest Gradation 16bit will not display with some Media Type or Input Resolution to Plug-in settings.

5 Select the mode to be printed when processing images in Print Mode.

Note

• The settings that can be selected differ by Media Type,Input Resolution to Plug-in, and Input Bit to Plug-in
selected.

6 Click the Print button.
 

Printing begins.

Adjust the Colors and PrintAdjust the Colors and Print
You can adjust the colors to your liking and print images.
The explanation below is on 5 ways to adjust the colors using Print Plug-In.

• Adjust the Colors while Checking the Preview (for Color) →P.489
• Adjust the Colors while Checking the Preview (for Monochrome) →P.491
• Adjust the Colors by Color Matching →P.493
• Print High-Quality Adobe RGB16bit Images →P.494
• Prints monochrome photographs with high quality →P.495
• Using Adobe CMM →P.496

Adjust the Colors while Checking the Preview (for Color)Adjust the Colors while Checking the Preview (for Color)
You can adjust the colors while checking the adjustments in the preview.
The following explanation is on the procedures for adjusting example image below.

• Low for Cyan
• High for Yellow
• Low for Saturation
• Warm Black for Gray Tone
• Enhance brightness for the curves
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The above image adjustments are reflected in the before and after images below.

1
 

Display the Color Settings sheet.

2 Drag the slide bar in the direction of Low in Cyan.

3 Drag the slide bar in the direction of High in Yellow.

4 Drag the slide bar in the direction of Low in Saturation.

5 Drag the slide bar in the direction of Warm Black in Gray Tone.

Note

• You can change the numbers by inputting in numerical characters.
• You can change the numbers by clicking either ▲ button or ▼ button.

6 Click the Curves button then click near the center of the curve.
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7
 

Enter 120 in Input and 135 in Output then click the OK
button.

8 Click the Print button.
 

The adjustments are reflected in the image and printing begins.

Adjust the Colors while Checking the Preview (for Monochrome)Adjust the Colors while Checking the Preview (for Monochrome)
You can adjust the colors while checking the adjustments in the preview.
The following explanation is about the procedures for adjusting example image below.

• Low for Contrast
• Light for Highlight
• Light for Shadow
• Enhance brightness for the curves

The unapplied and the applied images of the above image adjustments are as below.

1 Open the Main sheet.
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2
 

Select Auto (Monochrome Photo) in Output Profile.

3
 

Open the Color Settings sheet.

4 In Contrast, drag the slide bar toward Low.

5 In Highlight, drag the slide bar toward Light.

6 In Shadow, drag the slide bar toward Light.

Note

• You can change the numbers by inputting in numerical characters.
• You can change the numbers by clicking either ▲ button or ▼ button.

7 Click the Curves button then click near the center of the curve.
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8
 

Enter 120 in Input and 135 in Output then click the OK
button.

9 Click the Print button.
 

This applies the image adjustments and starts the print job.

Adjust the Colors by Color MatchingAdjust the Colors by Color Matching
When you print a color image imported from a scanner or a digital camera, the image may appear different from the
image on the screen. That is due to the differences in color on the screen and in the printer. In Print Plug-In, you can
get the color balance of the print product closer to the color balance displayed on the screen through performing ICC
(International Color Consortium) color profile settings, matching method settings, and settings for the internal profile,
which performs optimum color conversion in response to media and resolution settings.

1
 

Display the Main sheet.
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2 Select the profile in Output Profile.

Note

• When you place a checkmark in Perform Proof in Preview, you can check the color matching in the preview. This
may not be displayed depending on how you set Media Type.

• The details of Output Profile you have set is saved even when you close the Print Plug-In, but when the specified
profile cannot be located it is set to Auto (Color).

• If an ICC profile is selected as the Output Profile, Adobe CMM can be selected as the color conversion engine.
Refer to Using Adobe CMM →P.496  for details.

3 Select the profile matching method in Matching Method.

4 Click the Print button.
 

Printing begins with the output profile and matching method that you have set.

Print High-Quality Adobe RGB16bit ImagesPrint High-Quality Adobe RGB16bit Images
This prints a high-quality Adobe RGB16bit image taken with a high-end digital camera. Print Plug-In allows you to print
high color gamut and high tone images, when the Adobe RGB16bit image data has been retouched in Photoshop,
without compromising the level of tone in the image.

1
 

Select the Adobe RGB16bit image data in Photoshop
and start Print Plug-In.  (See "Starting from Photoshop.")
→P.463

2 Click Image Properties button.

3
 

Check that Adobe RGB is displayed in Color Space,
and 16bit/channel is displayed in Bit in the Image
Properties dialog box, and click the Close button.
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4
 

Display the Main sheet.

5 Select High Accuracy 600ppi in Input Resolution to Plug-in.

6 Select Highest Gradation 16bit in Input Bit to Plug-in.

7 Select the highest quality possible in Print Mode.

8 If required, adjust the colors using color matching.

Note

• For more information about the color matching, see "Adjust the Colors by Color Matching." →P.493

9 Click the Print button.
 

Printing of the Adobe RGB16bit image begins.

Prints monochrome photographs with high qualityPrints monochrome photographs with high quality
Prints images captured with a scanner or digital camera in monochrome with high quality. Provides stable monochrome
photo images without color casts and minimizes the influences of the difference of the light source.

1
 

Display the Main sheet.

 

 

iPF9400                                                                                                                                                             Prints monochrome photographs with high quality

User's Guide                                                                                                                                                                                                                                       

  

M
ac O

S X Softw
are

Print Plug-In for Photoshop / D
igital Photo Professional

495  



2 Select Auto (Monochrome Photo) in Output Profile.

Note

• Auto (Monochrome Photo) can be selected only after a compatible Media Type has been selected.

3 Click the Print button.
 

Performs conversion to the most suitable monochrome and printing begins.

Using Adobe CMMUsing Adobe CMM
Adobe CMM is a color conversion engine made by Adobe. Using Adobe CMM makes it possible to obtain uniform color
conversion results and to use the black point compensation function.

Important

• Use version 1.1 or higher of Adobe CMM.

• How to Obtain Adobe CMM
Adobe CMM can be obtained using the following procedure.

1 Open the Adobe website (http://www.adobe.com).

2 Enter "Adobe CMM" in the search input box on the screen.

3 Search for the "Adobe Color Management Module (CMM)" item and select the Macintosh version.

4 Download the file by following the on-screen directions.

5 Start the installer in the downloaded file to perform the installation.

• Adobe CMM System Requirements
The system requirements for Adobe CMM are as follows.

• Supported OS
Mac OS X 10.4.8 or later
 

• Supported CPU
PowerPC G4 or G5
Intel Core Duo, Intel Core 2 Duo, Intel Xeon processor

Note

• Check with Adobe for details.

• How to Use Adobe CMM
The procedure for using Adobe CMM is as follows.
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1
 

Display the Main sheet.

2 Select one of the ICC profiles as the Output Profile.

3 Click the ICC Conversion Options button.

4
 

In the ICC Conversion Options dialog box, select
Adobe CMM from Conversion Engine.

5 Click the OK button to close the ICC Conversion Options dialog box.

Printing an Adjustment Pattern and Selecting Adjustment ValuesPrinting an Adjustment Pattern and Selecting Adjustment Values
Since you can print an adjustment pattern and select your preferred adjustment values while comparing the images,
this allows you to conserve ink and paper, and save the time it takes to repeatedly check adjustment results.
The procedure for displaying and printing an adjustment pattern is as follows.

1 Display the Color Settings sheet (color or monochrome) and set the adjustment values to use as the baseline
values.
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2
 

Click the Adjustment pattern setting button to display
the Adjustment pattern setting dialog box.

3
 

Set the Adjustment Item, Number of Patterns, and
Adjustment Value Spacing for the Horizontal Axis
and Vertical Axis.
If you want to check part of an image as the adjustment
pattern, click the Specify the Range of Images button,
select the range you want to check in the Specify the
Range of Images dialog box, and then click the OK
button.

4 Set Rotate 90 degrees, Pattern Size, Pattern Spacing, and Pattern Background as needed.

5 For the Paper Source setting, select how the paper to print on is to be supplied.

6 For the Use Paper Size setting, select the paper size to print on.

7 Click the Print Adjustment Pattern button.
The adjustment pattern starts printing.

8 Check the image in the adjustment pattern that is closest to the customer image and click the corresponding
image in the preview area.
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9 If there are any other items that you want to adjust, select Adjustment Item and perform steps 7 and 8.

10 Once you have made the necessary adjustments, select the Update Base Values in the Color Settings
Sheet check box and click the Close button.
The previous adjustment values in the Color Settings sheet (color or monochrome) are updated.

Perform Black Point CompensationPerform Black Point Compensation
Black point compensation that is equivalent to Photoshop can be performed using the following procedure. Use this to
avoid saturation in the black areas of images.

Important

• In order to make the black point compensation settings effective, close down and restart Photoshop or Digital Photo Profes-
sional.

• Adobe CMM needs to be installed in order to use black point compensation. Refer to Using Adobe CMM →P.496  for details
on how to install Adobe CMM.

1
 

Display the Main sheet.

2 Select one of the ICC profiles as the Output Profile.

3 Click the ICC Conversion Options button to open the ICC Conversion Options dialog box.

4 Select Adobe CMM as the Conversion Engine.

5
 

Check the Black Point Compensation check box.

6 Click the OK button to close the ICC Conversion Options dialog box.
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Perform Printing Press Simulation PrintPerform Printing Press Simulation Print
You can perform printing press simulation prints by specifying ICC profiles such as Japan Color or SWOP, and specify-
ing an ICC profile for the printing press.

1
 

Display the Main sheet.

2 Select one of the ICC profiles as the Output Profile.

3 Check the Proof check box and select the profile for the printing press you want to target from the list on the
right.

4
 

Click the ICC Conversion Options button to open the
ICC Conversion Options dialog box.

5 Configure the Proof Options as needed.

Note

• The proof option is Simulate Paper Color.

6 Click the OK button to close the ICC Conversion Options dialog box.

7 Click the Print button.
Printing begins.

Enlarge/Reduce and PrintEnlarge/Reduce and Print
You can enlarge or reduce an image in Print Plug-In.
Three methods to enlarge/reduce and print are as follows.

• Enlarge/Reduce and Print Matching Output Media Size →P.501
• Enlarge/Reduce and Print Matching Width of Roll Paper →P.501
• Specify Scaling, Enlarge/Reduce and Print →P.503
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Enlarge/Reduce and Print Matching Output Media SizeEnlarge/Reduce and Print Matching Output Media Size
By specifying the media type loaded in the printer, the image can be enlarged or reduced to fit the size of the image
area of the media. This feature is useful when you need to print on the full width of Media that you have selected.

Note

• When you need to print on the full width of roll media, see "Enlarge/Reduce and Print Matching Width of Roll Paper." →P.501

• When you do the procedure below to print on roll media, the print job will match the size of the output with the media selected
with the Paper Size setting.

1
 

Display the Page Setup sheet.

2 Select the size of the media that you want to print in Paper Size.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

• This is not displayed when Fit Roll Paper Widthis set in Enlarged/Reduced Printing.

3 Select either Portrait or Landscape as the media orientation for the image in Orientation.

Note

• When you select Portrait, the image on the media prints as it appears on the screen.

• When you select Landscape, the image on the media prints rotated 90 degrees.

4 Click the Enlarged/Reduced Printing check box on.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

5 Select Fit Paper Size.

6 Click the Print button.
 

The image prints filling the entire output media surface.

Enlarge/Reduce and Print Matching Width of Roll PaperEnlarge/Reduce and Print Matching Width of Roll Paper
You can enlarge/reduce and print an image matching the width of the roll paper set in the printer. This is useful when
you wish to print an image that covers the entire width of the roll paper.

Note

• Printing will not occur properly when a print roll is not set to the printer.
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1
 

Display the Page Setup sheet.

2 Select Roll Paper in Paper Source.

3 Click the Roll Paper Options button.

4 Set the roll paper options and click the OK button.

Note

• For more information about the Roll Paper Options dialog box, see "Roll Paper Options Dialog Box." →P.483

• Click the Defaults button to return all of the roll paper option settings to their defaults.

5 Select either Portrait or Landscape as the media orientation for the image in Orientation.

Note

• When you select Portrait, the image on the media prints as it appears on the screen.

• When you select Landscape, the image on the media prints rotated 90 degrees.

6 Click the Enlarged/Reduced Printing check box on.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

7 Select Fit Roll Paper Width.

8 Click the Print button.
The image prints covering the entire width of the roll paper.
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Specify Scaling, Enlarge/Reduce and PrintSpecify Scaling, Enlarge/Reduce and Print
You can specify scaling to enlarge/reduce an image and print. This is useful when you wish to print an image at a spe-
cific size.

1
 

Display the Page Setup sheet.

2 Select the size of the media that you want to print in Paper Size.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.
• Fit Roll Paper Widthis set in Enlarged/Reduced Printing.

3 Select either Portrait or Landscape as the media orientation for the image in Orientation.

Note

• When you select Portrait, the image on the media prints as it appears on the screen.

• When you select Landscape, the image on the media prints rotated 90 degrees.

4 Click the Enlarged/Reduced Printing check box on.

Note

• This is not displayed when a checkmark is placed in Borderless Printing.

5 Select Scaling and input the scaling factor or drag the four corners of the image in the Preview display.

Note

• You can specify scaling rate in intervals of 0.01%.
• You can specify a range between 5.00-600.00%.

• The size of the width and height proportionally grow when the image is enlarged/reduced.

6 Either drag the image on the Print Area Layout preview, or set the print position Layout.

7 Click the Print button.
 

Printing begins at the set scaling rate.
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Print with No BordersPrint with No Borders
You can use the borderless printing function to print without margins surrounding the image.

Note

• With some media borderless printing can be performed only between two edges.

• To use the borderless printing function, the specified media must be set to the printer.

1
 

Display the Page Setup sheet.

2 Select Roll Paper in Paper Source.

3 Click the Borderless Printing check box on.

Note

• Select the width for roll paper set in the printer in Roll Paper Width in the Specify Roll Paper Width dialog box, and
click OK.

4 Click the Print button.
 

Borderless printing begins.
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Customize Media SettingsCustomize Media Settings
You can customize media settings.

1
 

Display the Main sheet.

2 Select the media type that you wish to customize in Media Type.

Note

• Always select media type that is actually set in the printer. When the media you chose is different from the media set
in the printer, you may not receive the desired print results.

3 Click the Advanced Settings button.

4 Perform the settings in the Paper Detailed Settings Dialog Box →P.480  and click the OK button.

Utilize Print HistoryUtilize Print History
When you perform various settings and print in Print Plug-In, those settings are saved as print history. Also, you can
export and import as files. You can store often-used print history under a specified name in print preferences.

Note

• You can save up to 200 print history items. All items over 200 are deleted in chronological order.

You can do the following things using print history.

• Confirm Print History Details →P.506
• Apply Print History to an Image →P.507
• Store Print History to Print Preferences →P.507
• Delete Print History →P.509
• Export Print History from Print Preferences →P.510
• Import Print History to Print Preferences →P.511
• Delete Print History from Print Preferences →P.513
• Set Information to Print with Image →P.514
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Confirm Print History DetailsConfirm Print History Details
You can confirm the print history details.

1
 

Display Print History sheet.

2 Click the Details button.

Note

• Select the print history you wish to check the details of, from either Print History or Favorites in the Print History
Details dialog box.

3 Check the print history details in Settings, and click the OK button.

Note

• You can display the print history details by switching the sheets.
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Apply Print History to an ImageApply Print History to an Image
You can use previous print history, and apply it to an image.

1
 

Display the Print History sheet.

2 If required, check the print history details.  (See "Confirm Print History Details.") →P.506

3 Select the print history you wish to apply from Print History and Favorites, and click the Apply button.

Store Print History to Print PreferencesStore Print History to Print Preferences
You can store often-used print history to print preferences. Not only can you store the print history stored under a differ-
ent name in print preferences, you can also find it with ease.

Note

• You can store up to 200 print history items to print preferences.

1
 

Display the Print History sheet.

2 Click the Details button.
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3
 

Select the print history you wish to store in print prefer-
ences from Print History in the Print History Details
dialog box, and check the print history details in Set-
tings.

4
 

Select the print history you wish to store in print prefer-

ences from Print History and click the  button.

5
 

In the Add Favorites dialog box input the name of the
print history in Name, input a comment in Comment,
and click the OK button.

6
 

Click the OK button to close the Print History Details
dialog box.
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Delete Print HistoryDelete Print History
You can delete print history.

Important

• Be aware that you cannot undo deletions of print history.

1
 

Display the Print History sheet.

2 Click the Details button.

3
 

Select the print history you wish to delete from Print
History in the Print History Details dialog box, and
click the Delete button.

4
 

Click the OK button.
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5
 

Click the OKbutton to close the Print History Details
dialog box.

Export Print History from Print PreferencesExport Print History from Print Preferences
You can export print history stored in print preferences as a file.

1
 

Display the Print History sheet.

2 Click the Details button.

3
 

Select the print history you wish to export from Favor-
ites in the Print History Details dialog box, and click
the Export button.
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4
 

Input the name of the print history in Save As in the
Save dialog box, and click the Save button.
 

The print history is exported under the specified file
name.

5 Click the OK button to close the Print History Details dialog box.

Import Print History to Print PreferencesImport Print History to Print Preferences
You can import print history in file format and store it to print preferences.

1
 

Display the Print History sheet.

2 Click the Details button.

3
 

Click the Import button of the Favorites in the Print
History Details dialog box.
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4
 

Select the print history you wish to import in the Open
dialog box, and click the Open button.

The print history is imported.

Note

• The print history file name suffix is *.pjb/*.pjb2.

• You cannot import a print history file exported from a different OS in Print Plug-In.

• You cannot import a print history file exported from a different printer in Print Plug-In.

5
 

Click the OK button to close the Print History Details
dialog box.
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Delete Print History from Print PreferencesDelete Print History from Print Preferences
You can delete print history store to print preferences. You cannot store more than 200 print history items in print pref-
erences.

1
 

Display the Print History sheet.

2 Click the Details button.

3
 

Select the print history you wish to delete from Favor-
ites in the Print History Details dialog box, and click
the Delete button.

4
 

Click the OK button.
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5
 

Click the OK button to close the Print History Details
dialog box.

Set Information to Print with ImageSet Information to Print with Image
You can print information with an image that is related, such as the file name and the time and date.

Note

• When you use the borderless printing function to print, the information will not be printed.  (See "Print with No Borders.")
→P.504

• When the printed information is too long as does not fit on the media, a break will appear in the printed information.

• The information may print on the image data with some media sizes, enlargement rates and print position values.

• When Keep Media Size is set to On on the printer, a portion of bottom of the print data is not printed.

1
 

Display the Print History sheet.

2 Click the Print Information check box on.

3 Select the position where you wish to print the information in Information Print Position.

4 Click the information check box you wish to print on.

5 When you wish to edit the comment, click the Edit Comment button.

Note

• When you do not wish to edit the comment, move to step 7.
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6
 

Input the comment in the Edit Comment dialog box,
and click OK button.

7
 

Click the Print button.

Comments are printed with images.
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Layout Plug-In for PhotoshopLayout Plug-In for Photoshop
About the Layout Plug-In .................................................................................................................................... 516
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Creating and Printing a Layout Image for Mounting on a Frame ....................................................................... 519

About the Layout Plug-InAbout the Layout Plug-In
When printing a photo to mount on a frame, you can start the Layout Plug-In from Photoshop and create a layout im-
age where the image extends to the sides of the frame.

Note

• The Layout Plug-In can be used with Photoshop CS5, Photoshop CS4, and Photoshop CS3.

• Layout images created in the Layout Plug-In can be printed as-is from the Print Plug-In for Photoshop.

For details on the functionality of the Layout Plug-In, see "Layout Plug-In Main Window." →P.516
For details on how to start and how to use the Layout Plug-In, see "Creating and Printing a Layout Image for Mounting
on a Frame." →P.519

Layout Plug-In Main WindowLayout Plug-In Main Window
This window is for creating a layout image for finishing an image extended around the sides of the frame when printing
a photo for mounting on a frame.
You can check the details of the settings in the preview area on the left side of the Layout Plug-In Main Window.

• Units
You can select the units from mm, inches, and pixels.
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Important

• Since values entered in mm or inches are first converted temporarily to pixels and then reconverted to mm or inches,
values may be displayed that differ from the entered values.

• Select Canvas Size
Selects the canvas size. If Create the Canvas at the Image Size is selected, the image size is treated as the
canvas size. It is recommended that you provide a canvas that matches the image size.

• Add Canvas Size button
Click this button to display the Add Canvas Size dialog box and register a Custom Canvas Size.  (See "Add Can-
vas Size dialog box.") →P.518

• Thickness
Specifies the thickness of the canvas (the width of the canvas sides). Although you can select from 0.75 inches
(approx. 19 mm) and 1.5 inches (approx. 38 mm), you can also specify any arbitrary thickness.

Important

• Since values entered in mm or inches are first converted temporarily to pixels and then reconverted to mm or inches,
values may be displayed that differ from the entered values.

• Amount of Extension
Selecting this check box allows you to configure the amount of extension that protrudes past the canvas sides.
This allows you to prevent white paper from appearing on the canvas sides when mounted. The larger the amount
of extension, the larger the area hidden behind the back surface.

Important

• Since values entered in mm or inches are first converted temporarily to pixels and then reconverted to mm or inches,
values may be displayed that differ from the entered values.

• Thickness Effect
You can select from the following canvas effects.

• Image
Wraps the image to the canvas sides.

• Soft Image
Performs Gaussian filtering on the image on the canvas sides.

• Reflection
Reflects the image on the canvas sides.

• Soft Reflection
Reflects the image on the canvas sides and performs Gaussian filtering.

• White
Makes the canvas sides white.

• Black
Makes the canvas sides black.

• Custom Color
Makes the canvas sizes the specified color. The color is specified by clicking the Select Color button.

• Add Crop Marks
When this check box is selected, crop marks are printed at the outer edges of the image as guides to the positions
to fold the paper when mounting on a canvas.

• Display Information
Displays the following information.

• Input
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Displays the original image size before creating the layout image.

• Finished
Displays the image size of the entire layout image with the canvas sides, crop marks, and the amount of ex-
tension added to the input image size.

• Resolution
Displays the resolution of the image. This is not changed from the resolution of the original image. If the image
size is changed in the Layout Plug-In, the resolution is maintained the same as the original image, and resam-
pling is performed using the Bicubic method.
If you do not want the number of pixels in the image to change (resample), select Create the Canvas at the
Image Size in Select Canvas Size and select an option other than Image and Soft Image in Thickness Ef-
fect.

• Defaults button
Click this button to reset the setting values.

• Close button
When this button is clicked, the Layout Plug-In exits and the current setting values are saved. When the Layout
Plug-In is started the next time, the setting values from the previous time are used.

• Execute button
When this button is clicked, the Print Plug-In for Photoshop starts. To print the created layout image, click the Print
button in the Print Plug-In for Photoshop main window.

Important

• When you close the Print Plug-In, the created layout image is discarded.

Note

• If the Print Plug-In for Photoshop for multiple different models is installed, a screen for selecting the model is displayed when
you click the Execute button.

• When you close Print Plug-In for Photoshop main window after printing, the Layout Plug-In main window is displayed again.

• If the size of the layout image is larger than the paper size that can be printed by the printer, you should reduce the size of the
layout image to the output paper size in advance before printing.

Add Canvas Size dialog boxAdd Canvas Size dialog box
This dialog box is displayed when you click the Add Canvas Size button in the Layout Plug-In main window. It allows
you to register and delete arbitrary canvas sizes (custom canvas sizes).

Click the Close button to close the Add Canvas Size dialog box.

Adding a Canvas Size

1 Specify the units for the width and height of the canvas size you are adding in Units.
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2 Enter the width and height of the canvas size you are adding in Size.
When you select a size displayed in the Paper Size List, the values are displayed in the Width and Height in
the Size field. When Input Image Size is selected, the size of the input image is used as-is for the width and
height of the canvas.
Selecting the Create the Image with a Fixed Aspect Ratio check box allows you to create a custom size at
the same aspect ratio as the input image. For example, if you change the width, then the height also changes
according to the aspect ratio of the input image.

3 Enter the name of the canvas size to add in Custom Canvas Size Name.

4 Click the Add button.

Deleting a Canvas Size

1 Select the Custom Canvas Size Name you want to delete from the Paper Size List.

2 Click the Delete button.

Note

• Sizes that have a red circle in the Name cannot be deleted.

Creating and Printing a Layout Image for Mounting on a FrameCreating and Printing a Layout Image for Mounting on a Frame
The procedure for creating and printing a layout image for mounting on a frame is as follows.

1 Start Photoshop.

2 Open the image to lay out and edit the image in Photoshop as needed.

3
 

Select imagePROGRAF Layout Plug-In from Auto-
mate in the Photoshop File menu.
Run the Layout Plug-In to display the Layout Plug-In
Main Window.

Note

• The Layout Plug-In can handle images with a width and height of less than 60,000 pixels. For images with a width or
height of 60,000 pixels or more, either reduce the selection range or reduce the image through image processing
before performing step 3.
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4 Select the canvas size that matches the frame for mounting the image and create a layout image by adding
effects such as frame side effects.
For details, see "Layout Plug-In Main Window." →P.516

Important

• The created layout image cannot be modified in Photoshop.

5 Once you have finished creating the layout image, run the Print Plug-In for Photoshop and print on paper that
is larger than the size of the layout image.

Important

• When you click the Close button to close the Layout Plug-In, the created layout image is discarded.

6 Mount the printed layout image on the frame.

Important

• Fully dry the printed paper before mounting it on the frame.

• Take care when mounting on the frame. The ink may peel off if you touch the printed surface.

Note

• As you fold the printed paper along the frame, the folded areas may crack and reveal the paper underneath, depending on the
media type. You can prevent the folded areas from splitting to some degree by using commercially available inkjet protection
spray or liquid laminating agent for inkjets before folding.
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PaperPaper
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Types of PaperTypes of Paper
The following types of paper are supported by the printer. For details on the paper supported by the printer, refer to the
Paper Reference Guide. (See Paper Reference Guide.)

• Plain Paper
• Coated Paper
• Photo Paper
• Glossy Paper
• Proofing Paper
• CAD-dedicated Paper Etc.

The following content is described in the Paper Reference Guide.

• Types of paper
• Paper handling
• Paper product specifications
• Use precautions
• Setting of printer driver, control panel etc.

Note

• For more information on how to use paper that is not listed in the Paper Reference Guide,see "Using Paper Other Than Genu-
ine Paper and feed confirmed Paper." →P.525

• Paper Reference Guide display method
You can display the Paper Reference Guide from [imagePROGRAF Support Information].  (See "Displaying the
Paper Reference Guide.") →P.527

• Method of Updating Supported Paper
Paper supported by the printer may be newly released on the imagePROGRAF website.
To use newly released paper, register the latest paper information on the printer with the Media Configuration
Tool.  (See "Updating paper information.") →P.528

Important

• To install the Paper Reference Guide and register paper types applicable to your region on your printer even when not
using the printer driver, install the Media Configuration Tool.
For information about the Media Configuration Tool, see Media Configuration Tool (Windows) →P.582  or Media Con-
figuration Tool (Macintosh) →P.611 .

Paper SizesPaper Sizes

Rolls
Rolls that meet the following conditions are supported.

• Outer diameter: up to 150 mm (6.0 in)
• Inner diameter of paper core: 2 or 3 inches
• Printing side out
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Roll width Roll Paper Width Settings in Printer Driver Borderless Printing (*1)
1524.0 mm (60.00 in) 60-in. Roll (1524.0mm) Yes

1371.6 mm (54.00 in) 54-in. Roll (1371.6mm) No

1270.0 mm (50.00 in) 50-in. Roll (1270.0mm) Yes

1117.6 mm (44.00 in) 44-in. Roll (1117.6mm) Yes

1066.8 mm (42.00 in) 42-in. Roll (1066.8mm) Yes

1030.0 mm (40.55 in) JIS B0/B1 Roll (1030.0mm) Yes

914.4 mm (36.00 in) 36-in. Roll (914.4mm) Yes

841.0 mm (33.11 in) ISO A0/A1 Roll (841.0mm) Yes

762.0 mm (30.00 in) 30-in. Roll (762.0mm) No

728.0 mm (28.66 in) JIS B1/B2 Roll (728.0mm) No

609.6 mm (24.00 in) 24-in. Roll (609.6mm) Yes

594.0 mm (23.39 in) ISO A1/A2 Roll (594.0mm) Yes

515.0 mm (20.28 in) JIS B2/B3 Roll (515.0mm) Yes

431.8 mm (17.00 in) 17-in. Roll (431.8mm) Yes

420.0 mm (16.54 in) ISO A2/A3 Roll (420.0mm) No

406.4 mm (16.00 in) 16-in. Roll (406.4mm) No

355.6 mm (14.00 in) 14-in. Roll (355.6mm) Yes

297.0 mm (11.69 in) ISO A3/A4 Roll (297.0mm) No

254.0 mm (10.00 in) 10-in. Roll (254.0mm) Yes

*1:  For information on types of paper compatible with borderless printing, refer to the Paper Reference Guide. (See "Types of Paper.")
→P.522

Sheets
Sheets of the following sizes are supported.

Paper size Dimensions
ISO A0 841.0 × 1189.0 mm (33.11 × 46.81 in)

ISO A1 594.0 × 841.0 mm (23.39 × 33.11 in)

ISO A2 420.0 × 594.0 mm (16.54 × 23.39 in)

ISO A2+ 431.8 × 609.6 mm (17.00 × 24.00 in)

ISO A3 297.0 × 420.0 mm (11.69 × 16.54 in)

ISO A3+ 329.0 × 483.0 mm (12.95 × 19.02 in)

ISO A4 210.0 × 297.0 mm (8.27 × 11.69 in)

ISO B0 1000.0 × 1414.0 mm (39.37 × 55.67 in)

ISO B1 707.0 × 1000.0 mm (27.83 × 39.37 in)

ISO B2 500.0 × 707.0 mm (19.69 × 27.83 in)

ISO B3 353.0 × 500.0 mm (13.90 × 19.69 in)

ISO B4 250.0 × 353.0 mm (9.84 × 13.90 in)

JIS B0 1030.0 × 1456.0 mm (40.55 × 57.32 in)

JIS B1 728.0 × 1030.0 mm (28.66 × 40.55 in)

JIS B2 515.0 × 728.0 mm (20.28 × 28.66 in)

JIS B3 364.0 × 515.0 mm (14.33 × 20.28 in)

JIS B4 257.0 × 364.0 mm (10.12 × 14.33 in)
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Paper size Dimensions
34"x44"(ANSI E) 863.6 × 1117.6 mm (34.00 × 44.00 in)

28"x40"(ANSI F) 711.2 × 1016.0 mm (28.00 × 40.00 in)

22"x34"(ANSI D) 558.8 × 863.6 mm (22.00 × 34.00 in)

17"x22"(ANSI C) 431.8 × 558.8 mm (17.00 × 22.00 in)

11"x17"(Ledger) 279.4 × 431.8 mm (11.00 × 17.00 in)

13"x19"(Super B) 330.2 × 482.6 mm (13.00 × 19.00 in)

Letter(8.5"x11") 215.9 × 279.4 mm (8.50 × 11.00 in)

Legal(8.5"x14") 215.9 × 355.6 mm (8.50 × 14.00 in)

36"x48"(ARCH E) 914.4 × 1219.2 mm (36.00 × 48.00 in)

30"x42"(ARCH E1) 762.0 × 1066.8 mm (30.00 × 42.00 in)

26"x38"(ARCH E2) 660.4 × 965.2 mm (26.00 × 38.00 in)

27"x39"(ARCH E3) 685.8 × 990.6 mm (27.00 × 39.00 in)

24"x36"(ARCH D) 609.6 × 914.4 mm (24.00 × 36.00 in)

18"x24"(ARCH C) 457.2 × 609.6 mm (18.00 × 24.00 in)

12"x18"(ARCH B) 304.8 × 457.2 mm (12.00 × 18.00 in)

9"x12"(ARCH A) 228.6 × 304.8 mm (9.00 × 12.00 in)

DIN C0 917.0 × 1296.0 mm (36.10 × 51.02 in)

DIN C1 648.0 × 917.0 mm (25.51 × 36.10 in)

DIN C2 458.0 × 648.0 mm (18.03 × 25.51 in)

DIN C3 324.0 × 458.0 mm (12.76 × 18.03 in)

DIN C4 229.0 × 324.0 mm (9.02 × 12.76 in)

20"x24" 508.0 × 609.6 mm (20.00 × 24.00 in)

18"x22" 457.2 × 558.8 mm (18.00 × 22.00 in)

14"x17" 355.6 × 431.8 mm (14.00 × 17.00 in)

12"x16" 304.8 × 406.4 mm (12.00 × 16.00 in)

10"x12" 254.0 × 304.8 mm (10.00 × 12.00 in)

10"x15" 254.0 × 381.0 mm (10.00 × 15.00 in)

8"x10" 203.2 × 254.0 mm (8.00 × 10.00 in)

US Photo 16"x20" 406.4 × 508.0 mm (16.00 × 20.00 in)

Poster 20"x30" 508.0 × 762.0 mm (20.00 × 30.00 in)

Poster 30"x40" 762.0 × 1016.0 mm (30.00 × 40.00 in)

Poster 42"x60" 1066.8 × 1524.0 mm (42.00 × 60.00 in)

Poster 44"x62" 1117.6 × 1574.8 mm (44.00 × 62.00 in)

Poster 50"x70" 1270.0 × 1778.0 mm (50.00 × 70.00 in)

Poster 54"x76" 1371.6 × 1930.4 mm (54.00 × 76.00 in)

Poster 60"x84" 1524.0 × 2133.6 mm (60.00 × 84.00 in)

13"x22" 329.0 × 558.0 mm (12.95 × 21.97 in)

Poster 300x900mm 300.0 × 900.0 mm (11.81 × 35.43 in)

Custom Paper Size 203.2 × 203.2 mm (8.00 × 8.00 in) – 1524.0 × 1600.0 mm (60.00 × 62.99in)
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Note

• For details on non-standard paper sizes, see "Printing on Non-Standard Paper Sizes." →P.116

• Borderless printing is not supported on sheets.

Using Paper Other Than Genuine Paper and feed confirmed PaperUsing Paper Other Than Genuine Paper and feed confirmed Paper
When using this printer to print on paper other than genuine Canon paper and feed confirmed paper, use paper that
meets the following conditions.

Note

• Refer to Paper Reference Guide for details on genuine Canon paper and feed confirmed paper. (Refer to " Paper Reference
Guide")

• Paper where the size is described in "Paper Sizes"  (See "Paper Sizes.") →P.522

• Paper where the thickness is described in "Paper Thickness" in "Specifications"  (See "Specifications.") →P.934
• Paper where bleeding and ink overflow does not occur when printing
• Paper that does not warp severely when loading the paper or printing

Important

• If you use paper other than genuine Canon paper and feed confirmed paper, Canon provides absolutely no guarantees re-
garding print quality or paper feed properties. Refer to Paper Reference Guide for details on genuine Canon paper and feed
confirmed paper. (Refer to " Paper Reference Guide")

After loading the paper in the printer, select the media type in the control panel and printer driver and then perform the
printing. For the media type, you can select easily from existing settings or you can create and use settings for the
paper you are using.

Printing Using Existing Settings
You can print easily by selecting from existing settings provided in the printer control panel and printer driver.  (See
"Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings.") →P.525

Printing Using Additional Settings
You can print by using the Add Custom Paper function in the Media Configuration Tool to create settings suitable for
the paper other than genuine paper and feed confirmed paper you are using and adding these settings as a new media
type to the printer control panel and printer driver.  (See "Printing on Paper Other Than Genuine Paper and feed con-
firmed Paper by Adding a Media Type.") →P.526

Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing SettingsPrinting on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings
You can easily print on paper other than genuine Canon paper and feed confirmed paper without making complicated
settings by selecting existing settings provided in the printer control panel and printer driver depending on the media
type you are using. The existing settings consist of general-purpose paper settings provided for each media type and
special settings that allow you to select the amount of ink to use.

Important

• The genuine Canon paper settings provided in the printer control panel and printer driver are optimized for genuine Canon
paper. If these settings are selected for printing on paper other than genuine Canon paper, the ink may bleed or the print-
head may rub against the paper. In order to easily print on paper other than genuine Canon paper and feed confirmed paper,
we recommend that you select one of the following general-purpose paper settings or special settings.

Note

• For an overview of the media types, see "Types of Paper." →P.522

• For details on how to select the media type in the control panel and printer driver, see "Types of Paper." →P.522
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Choosing General-Purpose Paper Settings
Since these settings anticipate a wide variety of paper other than genuine Canon paper and feed confirmed paper,
these settings will make it difficult for bleeding ink and the printhead rubbing to occur. Refer to the following table for
the relationships between the conditions of the paper other than genuine Canon paper and feed confirmed paper and
the media type to select.

Type Approximate weight Approximate thickness Printer control panel Printer driver
Plain Paper 70 g/m² 0.09 mm (0.0035 in.) Plain Paper Plain Paper
Coated Paper 90 g/m² 0.13 mm (0.0051 in.) LW. Coated Paper Lightweight Coated Paper
Coated Paper 170 g/m² 0.22 mm (0.0087 in.) HW. Coated Paper Heavyweight Coated Paper
Photo Paper 180 g/m² 0.18 mm (0.0071 in.) LW. Photo Paper Lightweight Photo Paper
Photo Paper 260 g/m² 0.26 mm (0.010 in.) HW. Photo Paper Heavyweight Photo Paper
Proof 80 g/m² 0.10 mm (0.0039 in.) News Proof Newsprint for Proofing
Art Paper 65 g/m² 0.15 mm (0.0059 in.) JPN Paper Washi Japanese Paper Washi
Art Paper 200 g/m² 0.35 mm (0.014 in.) HW. Art Paper Heavyweight Art Paper
Art Paper 300 g/m² 0.44 mm (0.017 in.) Ex HW. Art Paper Extra Heavyweight Art Paper
Sign/CAD Paper 470 g/m² 0.35 mm (0.014 in.) Bannr Vinyl Banner Vinyl
Sign/CAD Paper 300 g/m² 0.28 mm (0.011 in.) Adhesive Vinyl Adhesive Vinyl
Sign/CAD Paper 240 g/m² 0.18 mm (0.0071 in.) Glossy Film Glossy Film
Sign/CAD Paper 150 g/m² 0.11 mm (0.0043 in.) CAD Clear Film CAD Clear Film

Selecting Special Settings
Special settings are provided that allow you to select the amount of ink used in steps. You can fix lackluster colors or
bleeding ink by selecting special settings where the amount of ink used is suitable for the paper you are using. The
special settings are organized as follows so that they can be used as follows depending on the type of black ink and
the media type.

Type of special settings Type of black ink Example of applicable paper
"Special 1" to "Special 5" BK (photo black) Glossy paper, proofing paper

"Special 6" to "Special 10" MBK (matte black) Coated Paper, Matte Paper, Art Paper

"Special 1" and "Special 6" use the least amount of ink, with the amount of ink used increasing through 5 steps as the
number increases up to "Special 5" and "Special 10" which use the greatest amount of ink. Although colors become
more vivid as the amount of ink used increases, bleeding also occurs more easily. We recommend that you try in order
starting from "Special 1" or "Special 6" while checking the state of the printing.

Note

• If you cannot obtain sufficiently good image quality by selecting the general-purpose settings or special settings, you can cre-
ate settings as suitable for the paper you are using by using the "Add Custom Paper" function in the Media Configuration Tool.
For details, see "Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type." →P.526

Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media TypePrinting on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type
The Add Custom Paper function in the Media Configuration Tool is provided as a method for improving print quality
and feed properties over printing paper other than genuine Canon paper and feed confirmed paper using the general-
purpose settings. This can be expected to improve properties such as print quality because it allows you to configure
settings such as the maximum amount of ink to use and the height of the printhead depending on the characteristics of
the paper you are using. Furthermore, printing can be performed by adding the settings created using this function to
the printer control panel and printer driver as a new media type.
For details on Media Configuration Tool, refer as follows.

• Media Configuration Tool（Windows）→P.582
• Media Configuration Tool（Macintosh）→P.611
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Important

• For details on how to select the added media type in the control panel, see "Changing the Type of Paper." →P.537

• For details on how to select the media type in the printer driver, refer to the following topics.
Specifying Paper in the Printer Driver (Windows) →P.174
Specifying Paper in the Printer Driver (Mac OS X) →P.360

• We recommend that you use an ICC profile created using commercially available profile creation software in order to
perform color management accurately on paper other than genuine Canon paper and feed confirmed paper. The cre-
ated ICC profile can be registered to the printer driver and printed. For details, see "Matching Sheet (Windows)."
→P.189

Displaying the Paper Reference GuideDisplaying the Paper Reference Guide
The Paper Reference Guide can be accessed from imagePROGRAF Support Information. Follow these instructions,
as appropriate for your operating system.

• Windows

1.  

Double-click the iPFxxxx Support desktop icon. (iPFxxxx indicates the printer
model.)

The imagePROGRAF Support Information window is displayed.

2.  

Click the Paper Reference Guide button.

The Paper Reference Guide is displayed.

• Mac OS X

1.  

Click the iPF Support icon in the Dock ( Launchpad in OS10.7).

The imagePROGRAF Support Information window is displayed.
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2.  

Click the Paper Reference Guide button.

The Paper Reference Guide is displayed.

Updating paper informationUpdating paper information
As for paper information of the Paper Reference Guide, printer Control Panel, and printer driver, you can update it to
the latest information by downloading and installing the latest version of Media Information File (Media Information
File) from the imagePROGRAF website.
Download the latest Media Information File (Media Information File) after accessing the imagePROGRAF-dedicated
site from imagePROGRAF Support Information. If you cannot download it, contact your Canon dealer.
For details on Media Information File (Media Information File), refer as follows.

• Media Configuration Tool →P.582  (Windows)
• Media Configuration Tool →P.611  (Macintosh)

Important

• When your version of Media Configuration Tool is older than the version released on the imagePROGRAF website,
download and install the latest version of Media Configuration Tool before installing Media Information File. If you do
not install the latest version of Media Configuration Tool before installing Media Information File, the latest paper infor-
mation cannot be updated.

• Windows

1.  

Double-click the iPFxxxx Support desktop icon. (iPFxxxx indicates the printer
model.)

The imagePROGRAF Support Information window is displayed.
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2.  

Click Visit the imagePROGRAF webpage.

The default browser on your computer is started and
the imagePROGRAF webpage is displayed.

• Mac OS X

1.  

Click the iPF Support icon in the Dock ( Launchpad in OS10.7).

The imagePROGRAF Support Information window is displayed.

2.  

Click Visit the imagePROGRAF webpage.

The default browser on your computer is started and the image-
PROGRAF webpage is displayed.
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Handling rollsHandling rolls
Attaching the Roll Holder to Rolls ...................................................................................................................... 530
Loading Rolls in the Printer ................................................................................................................................ 533
Changing the Type of Paper .............................................................................................................................. 537
Specifying the Paper Length .............................................................................................................................. 539
Removing the Roll from the Printer ..................................................................................................................... 539
Removing the Roll Holder from Rolls ................................................................................................................. 542
Clearing Jammed Roll Paper ............................................................................................................................. 878
Feeding Roll Paper Manually ............................................................................................................................. 543
Keeping Track of the Amount of Roll Paper Left ................................................................................................ 544
Specifying the Ink Drying Time for Rolls ............................................................................................................ 544
Specifying the Cutting Method for Rolls ............................................................................................................. 546
Cutting the Leading Edge of Roll Paper Automatically ...................................................................................... 552
Reducing Dust from Cutting Rolls ...................................................................................................................... 554
Roll Holder Set ................................................................................................................................................... 697

Attaching the Roll Holder to RollsAttaching the Roll Holder to Rolls
When printing on rolls, attach the Roll Holder to the roll.
Rolls have a two- or three-inch paper core. Use the correct attachment for the paper core. The printer comes equipped
with the 2-Inch Paper Core Attachment installed.

Using Rolls with a 2-inch Paper Core Using Rolls with a 3-inch Paper Core
Roll Holder Side Holder Stopper Side Roll Holder Side Holder Stopper Side

No Attachment Needed 2-Inch Paper Core Attachment 3-Inch Paper Core Attachment #1 3-Inch Paper Core Attachment #2

Caution

• Set the roll on a table or other flat surface so that it does not roll or fall. Rolls are heavy, and dropping a roll may cause injury.
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Important

• When handling the roll, be careful not to soil the printing surface. This may affect the printing quality. We recommend wearing
clean cloth gloves when handling rolls to protect the printing surface.

• Use scissors or a cutting tool to cut the edge of the roll paper if it is uneven, dirty, or has tape residue. Otherwise, it may
cause feeding problems and affect the printing quality. Be careful not to cut through any barcodes printed on the roll.

• Align the edges of the paper on both ends of the roll. Misalignment may cause feeding problems.

Note

• For details on supported sizes and types of rolls, see Paper Sizes or the Paper Reference Guide.  (See "Paper Sizes.")
→P.522   (See "Types of Paper.") →P.522

• To view instructions as you attach the Roll Holder, press the Navigate button.  (See "How to View Instructions With Navigate.")
→P.653

1
 

Lift the Holder Stopper lever (a) from the shaft side to
unlock it. Holding the Holder Stopper at the position in-
dicated (b), remove it from the Roll Holder.

2 Insert the respective attachments for the roll paper core on the Roll Holder and Holder Stopper.

• Using rolls with a 2-inch paper core
Holder Stopper Side Roll Holder Side

Align the tips (a) of the 2-Inch Paper Core Attachment with the holes (b) of the Holder Stopper and insert it firmly. No attachment is
needed.
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• Using rolls with a 3-inch paper core
Holder Stopper Side Roll Holder Side

Align the tips (a) of 3-Inch Paper Core Attachment #2 with the
holes (b) of the Holder Stopper and insert it firmly.

Align the tips (a) of 3-Inch Paper Core Attachment #1 with the holes
(b) of the Roll Holder and insert it firmly.

3
 

With the edge of the roll paper facing forward as shown, in-
sert the Roll Holder from the right of the roll. Insert it firmly
until the roll touches the flange (a) of the Roll Holder, leaving
no gap.
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4
 

Insert the Holder Stopper from the left in the Roll Holder
as shown. Holding it at the position shown (b), push it
firmly in until the flange (a) of the Holder Stopper touch-
es the roll. Lock the Holder Stopper lever (c) by pushing
it down toward the shaft side.

Loading Rolls in the PrinterLoading Rolls in the Printer
Follow these steps to load rolls in the printer.

Important

• Always load rolls when the printer is on. If the printer is off when you load a roll, the paper may not be advanced correctly
when you turn the printer on.

• Before loading a roll, confirm whether the inside of the Top Cover or the Ejection Guide is soiled. If soiled, we recommend
cleaning in advance.  (See "Cleaning Inside the Top Cover.") →P.861

1
 

Press the Load button.

2 Press ▲ or ▼ to select Load Roll Paper, and then press the OK button.

Note

• If any paper has been advanced that will not be used, a message is shown requesting you to remove it.
Press ▲ or ▼ to select "Yes", and then press the OK button. Remove the paper and go to the next step.
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3
 

Open the Top Cover and lift the Ejection Guide.

4
 

Holding the Roll Holder so that the side with the white
gear faces the side of the Roll Holder Slot with a white
gear, load the Roll Holder shaft (a) into the grooves (b)
on both ends of the Roll Holder Slot, fully into the slot.

Caution

• Be careful not to drop the roll and hurt yourself when loading it.

• Be careful not to pinch your fingers between the Roll Holder shaft (a) and the guide grooves (b) when loading rolls.
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5
 

Pull out the roll evenly on both ends and insert it in the
Paper Feed Slot (a). Advance the roll until it touches
the Paper Retainer (b).

Once the roll reaches the Paper Retainer, it is automati-
cally advanced over the Platen.

Important

• When handling the roll, be careful not to soil the printing surface. Otherwise, it may affect printing quality. We rec-
ommend wearing clean cloth gloves when handling rolls to protect the printing surface.

• If the paper is wrinkled or warped, straighten it out before loading it.

• For paper that tends to curl, lift the Release Lever and manually pull the roll paper over the Platen.

• Load paper straight so it is not fed askew.

 

6
 

Lower the Ejection Guide.
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7
 

Holding the edge of the roll paper, lift the Release Lev-
er.

8
 

Hold the edge of the roll paper as you gently pull it
evenly with both hands to the position of the Ejection
Guide (a). Align the right side of the roll paper with the
Paper Alignment Line (b), keeping this side parallel to
the line, and then lower the Release Lever.

Important

• Do not omit steps 7 and 8. If paper cannot be advanced straight or if it wrinkles, it may jam or rub against the
Printhead.

• Do not force the roll paper into alignment with the paper alignment line (b). This may prevent the paper from being
advanced straight.

Note

• You can adjust the strength of suction holding paper against the Platen when the Release Lever is released. If it is
difficult to load paper, press the ▲ or ▼ button on the Control Panel to adjust the strength. Set suction stronger by
pressing the ▲ button or weaker with the ▼ button. Three settings are available.
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9
 

Close the Top Cover.

10 Once paper feeding starts, you will need to do the following, based on the ManageRemainRoll setting and the
barcode printed on rolls.  (See "Keeping Track of the Amount of Roll Paper Left.") →P.544

ManageRemainRoll Barcodes Printer Operation After the Paper is Fed
Off Printed A menu for selection of the type of paper is shown on the Display Screen.

Press ▲ or ▼ to select the type of paper, and then press the OK button.Not printed

On Printed The type and amount of paper left is automatically detected based on the barcode printed on the roll.
There is no need to specify the type and length of the paper.

Not printed A menu for selection of the type and length of paper is shown on the Display Screen.
Press ▲ or ▼ to select the type and length of paper loaded, and then press the OK button.

Important

• Cut the edge of the roll using the Paper Cutting function if the edge is creased or soiled.  (See "Specifying the
Cutting Method for Rolls.") →P.546

Note

• For details on types of paper to select, see the Paper Reference Guide.  (See "Types of Paper.") →P.522

• Adjusting the printhead alignment with the type of paper to be used in printing may enhance printing quality.  (See
"Automatic Adjustment to Straighten Lines and Colors.") →P.798

• When paper leading edge detection is set to Off for Manual, printing will start at the position at which the roll was set
in procedure 8. Thus, the margin of the paper leading edge will enlarge.  (See "Specifying the Cutting Method for
Rolls.") →P.546

Changing the Type of PaperChanging the Type of Paper
Follow these steps to change the type of paper specified on the printer after you have loaded paper.
If you will continue using this type of paper later, selecting Keep Paper Type > On will save the time and effort of con-
figuring the media type setting when you load the paper again. The current media type settings before you select On
will be automatically selected at that time.  (See "Using the Same Type of Paper Regularly.") →P.538

Important

• For best printing results, the printer fine-tunes the print head height and the feed amount for each type of paper. Be sure to
select the type of paper to use correctly before printing.

• Because the printer fine-tunes the feed amount for each type of paper, the margins and the size of printed images may vary
depending on the type of paper used. If margins and the size of images are not as you expected, adjust the paper feed
amount.
 (See "Adjusting the Feed Amount.") →P.805

• Rolls and sheets have different printing areas, and sheets having a larger bottom margin than rolls.
 (See "Print Area.") →P.935
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Changing the Type of Paper

Note

• When you load a roll, a menu for selection of the type of paper is shown on the Display Screen. Select the type of paper, and
then press the OK button.
If no barcode has been printed on the roll and you have set ManageRemainRoll to On, specify the roll length after the type of
paper.  (See "Specifying the Paper Length.") →P.539

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Chg. Paper Type, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper loaded ( Roll Paper or Cut Sheet), and then press the OK button.

5 Press ▲ or ▼ to select the type of paper loaded in the printer, and then press the OK button.

Important

• Be sure to select the correct paper type. If this setting does not match the loaded paper, it may cause feed errors
and affect printing quality.

Note

• For details on types of paper, see the Paper Reference Guide.  (See "Types of Paper.") →P.522  By default, Plain
Paper is selected.

• If you move the Release Lever, the setting automatically reverts to the previously selected paper.

Using the Same Type of Paper Regularly
Configure this setting so that current media type settings will be automatically selected when you load the same type of
paper later.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.
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3 Press ▲ or ▼ to select Keep Paper Type, and then press the OK button.

4 Press ▲ or ▼ to select On, and then press the OK button.

Note

• The specified media type setting is updated in the following situations.

• When using sheets, if you send a print job before loading a sheet, the media type setting is updated to match the type of
paper specified by the print job.

• When you have selected ManageRemainRoll > On on the Control Panel and a barcode is printed on the roll, the media
type setting is updated to match the type of paper specified by the barcode.

• To change the media type setting, see "Changing the Type of Paper." →P.538

Specifying the Paper LengthSpecifying the Paper Length
When changing the length of paper after the paper has been advanced, specify the length as follows.

Note

• Specify the paper length when you have set ManageRemainRoll to On.  (See "Keeping Track of the Amount of Roll Paper
Left.") →P.544

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Chg. Paper Size, and then press the OK button.

4 Press ▲ or ▼ to select Roll Length, and then press the OK button.

5 Press ▲ or ▼ to select the length of paper loaded in the printer, and then press the OK button.
Specify the roll length as follows.

1. Press the ◀ or ▶ button to move to the next field for input.

2. Press the ▲ or ▼ button to enter the value.

3. Repeat steps 1 and 2 to finish entering the value, and then press the OK button.

Removing the Roll from the PrinterRemoving the Roll from the Printer
Remove rolls from the printer as follows.

Note

• If you need to cut the roll, see "Specifying the Cutting Method for Rolls." →P.546
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1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Eject Paper, and then press the OK button.

4 Press ▲ or ▼ to select "Yes", and then press the OK button.
The roll is rewound.

Important

• If you have selected ManageRemainRoll > On in the Control
Panel menu, a barcode is printed on the leading edge of the
roll.
Do not remove the roll before the barcode is printed. You will
be unable to keep track of the amount of roll paper left.  (See
"Keeping Track of the Amount of Roll Paper Left.") →P.544

 

5
 

Open the Top Cover and lift the Ejection Guide.

6
 

Using both hands, rotate the Roll Holder in the direction
of the arrow to rewind the roll.
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7
 

Holding the Roll Holder flange (a), remove the holder
from the Roll Holder Slot.

Note

• For instructions on removing the Roll Holder from rolls, see "Removing the Roll Holder from Rolls." →P.542

8
 

Lower the Ejection Guide and close the Top Cover.

Note

• To load new paper in the printer at this point, see "Loading Rolls in the Printer." →P.533

• Clean inside the top cover before loading paper.
 (See "Cleaning Inside the Top Cover.") →P.861
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Removing the Roll Holder from RollsRemoving the Roll Holder from Rolls

1
 

Lift the Holder Stopper lever (a) from the shaft side to un-
lock it. Holding the Holder Stopper at the position indica-
ted (b), remove it from the Roll Holder.

2
 

Remove the Roll Holder from the roll.

3 When removing attachments, push the tips (a) in as you remove the attachment.

• 3-Inch Paper Core Attachment #1 ( Roll Holder side)
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• 3-Inch Paper Core Attachment #2 ( Holder Stopper side)

• 2-Inch Paper Core Attachment

Important

• Store the roll in the original bag or box, away from high temperature, humidity, and direct sunlight. If paper is not stored
properly, the printing surface may become scratched, which may affect the printing quality when you use it again.

Feeding Roll Paper ManuallyFeeding Roll Paper Manually
After a roll has been advanced, you can press the Feed button to feed or retract the roll with the ▲ and ▼ buttons.

1 Press the Feed button.

2 Press the ▲ or ▼ button to advance or retract the roll.
Press ▲ to retract the roll manually.
Press ▼ to advance the roll manually.

Note

• If you hold down ▲ or ▼ for less than a second, the roll will move about 1 mm (0.04 in).
If you hold down ▲ or ▼ for more than a second, the roll will move until you release the button. Release the button when the
Display Screen indicates "End of paper feed. Cannot feed paper more.".
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Keeping Track of the Amount of Roll Paper LeftKeeping Track of the Amount of Roll Paper Left
Setting ManageRemainRoll to On in the Paper Menu of the Control Panel will print a barcode with text on the roll
when the roll is removed that identifies the type of paper and amount left. When ManageRemainRoll is On and you
load rolls with printed barcodes, the type of paper and amount left are automatically detected after rolls are loaded. The
barcode will be cut off after it has been read.

Important

• If the barcode on the roll is not detected, enter the type and length of paper on the Control Panel.

Follow these steps to set ManageRemainRoll to On as follows.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select ManageRemainRoll, and then press the OK button.

4 Press ▲ or ▼ to select On, and then press the OK button.

Specifying the Ink Drying Time for RollsSpecifying the Ink Drying Time for Rolls
When you are using paper that takes longer for ink to adhere, ink may be transferred onto the paper surface during
ejection, soiling it. In that case, you may be able to improve the condition by setting the time to wait for the ink to dry
after printing.

Note

• If the Cutter touches the print surface on which the ink is not dry, the paper surface may become scratched or soiled, or the
paper surface may rub when the paper falls and the surface may become soiled.
To wait for the ink to dry without allowing printed documents to fall after printing, set Cutting Mode on the menu of the printer
to Eject.  (See "Specifying the Cutting Method for Rolls.") →P.546

Windows

1 Display the printer driver dialog box.
 (See "Accessing the Printer Driver Dialog Box from the Operating System Menu (Windows).") →P.181
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2
 

Select the Main sheet and click CAdvanced Settings
in AMedia Type.

3
 

In the Paper Detailed Settings dialog box displayed
next, select the desired settings values in BBetween
Pages and CBetween Scans in ADrying Time, and
then click OK.
 (See "Paper Detailed Settings Dialog Box (Windows).")
→P.185

Mac OS X

1 Choose Print in the application menu.

2
 

Select the Main pane and click CSettings in AMedia
Type.
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3
 

In the Paper Detailed Settings dialog box displayed
next, select the desired settings values in CBetween
Pages and DBetween Scans in BDrying Time, and
then click OK.
 (See "Paper Detailed Settings Dialog Box (Mac OS X).")
→P.368

Specifying the Cutting Method for RollsSpecifying the Cutting Method for Rolls
How rolls are cut after ejection varies depending on printer settings.

Cutting Method Printer Setting Driver Setting
Automatic The roll is automatically cut by the Cutter Unit following

printer driver settings.
Media
Menu > Pa-
per Details
> (Various
Types of
Paper) >
Cutting
Mode

Automatic Auto Cut
 (See "Cut-
ting Roll Pa-
per After
Printing.")
→P.167

Yes

Eject Select this to move the cutter by key operation and cut
paper. Although there are cases with Automatic in
which the paper falls and the paper surface is scratched
when the paper rubs the Output Stacker, you can avoid
damaging the paper with this method since you can cut
by holding the paper with your hand so that the paper
does not fall when cutting, Also, since you can cut while
visually confirming the drying of the ink, you can avoid
ejecting paper before the ink has dried.
To cut the roll with the Cutter Unit, press the Cut but-
ton.

Eject Yes

Manual Select this for paper that cannot be cut with the Cutter
Unit and for paper of which the leading edge curls
strongly and rubs the printhead.
Use scissors to cut each document from the roll after
printing. For continuous printing (if you will cut each
page later), select Auto Cut > Yes or select Print Cut
Guideline.

Manual No Yes Print Cut
Guideline

Paper Cut-
ting

Choose this option if you want to cut pages by pressing
Cutter Unit buttons for manual cutting after printing
when Auto Cut > No is selected or Print Cut Guide-
line is selected in the printer driver.
Otherwise choose this option if you want to cut the roll
edge after loading a roll.

Cut button
pressed

Yes No Print Cut
Guideline
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Note

• Automatic and Eject are valid only when you have selected Auto Cut > Yes in the printer driver.

• With Eject, printing does not resume after a series of jobs have been printed continuously until the roll is cut.

• Eject is the preset selection in Cutting Mode for some types of paper. For this paper, we recommend keeping the preset
cutting mode.

• If documents printed using Automatic, Eject, or manual cutting are short, rolls are advanced a specific amount before cutting
to prevent problems with cutting and paper ejection. This may create a wider bottom margin, in some cases.

Cut rolls manually in the following cases:

Eject (when the paper surface is being scratched / to wait for ink to dry)

Important

• When cutting wide printed documents after ejection, have two people support the documents. If the paper drops, printed
documents may be damaged.

• Do not lift the paper when holding printed documents before cutting. If the paper rises, it may affect the printing quality or
cause rough cut edges.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button. The Paper Menu is displayed.

3 Press ▲ or ▼ to select Paper Details, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper, and then press the OK button.

5 Press ▲ or ▼ to select Cutting Mode, and then press the OK button.

6 Press ▲ or ▼ to select Eject, and then press the OK button.

7 Print the job.
When printing is finished, the printer will stop without cutting.
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8
 

Holding the printed document to prevent it from drop-
ping, press the Cut button to cut the roll.

Manual (when using media that cannot be cut with the Cutter Unit)

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button. The Paper Menu is displayed.

3 Press ▲ or ▼ to select Paper Details, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper, and then press the OK button.

5 Press ▲ or ▼ to select Cutting Mode, and then press the OK button.

6 Press ▲ or ▼ to select Manual, and then press the OK button.

7 When Perform the detection of paper leading edge? is displayed, select Perform(recommend).

8 Print the job.
The printer stops advancing the paper after printing.
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9
 

Press the Feed button.

Roll paper is fed to the specified cut position and then
automatically stopped.

10
 

Cut the roll paper manually with scissors or the like.

11
 

Press the OK button.

After the roll is rewound, it stops automatically.

Manual (for paper of which the leading edge rubs the printhead)
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1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button. The Paper Menu is displayed.

3 Press ▲ or ▼ to select Paper Details, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper, and then press the OK button.

5 Press ▲ or ▼ to select Cutting Mode, and then press the OK button.

6 Press ▲ or ▼ to select Manual, and then press the OK button.

7 When Perform the detection of paper leading edge? is displayed, select Do not perform.

Note

• If you set the detection of paper leading edge to Do not perform, a margin of about 10 cm is created at the paper
leading edge when printing starts.

• When the detection of paper leading edge is set to Do not perform, printing will start at the position at which the roll
was set for the first printing after replacing a roll. Thus, the margin of the paper leading edge will enlarge.
 (See "Loading Rolls in the Printer.") →P.533

8
 

Press the Feed button.

9
 

Press ▲ or ▼ to align the paper leading edge with the
(a) position.
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10 Print the job.
The printer stops advancing the paper after printing.

Note

• The printer can continue to receive print jobs from computers. If a print job is received and printed here, it can be
printed without the margin of about 10 cm being created at the paper leading edge.

11
 

Press the Feed button.

Roll paper is fed to the specified cut position and then
automatically stopped.

12
 

Cut the roll paper manually with scissors or the like.

Important

• Cut at the dotted line printed on the paper. If you cut on the printer side of the dotted line, the paper leading edge
may rub against the printhead and may deviate from the paper retainer.

13
 

Press the OK button.

After the roll is rewound, it stops automatically.
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Paper cutting (to have the roll cut at your specified position)

1 Press the Feed button.

2
 

Press the ▼ button to advance the roll to the position
for cutting.

3
 

Press the Cut button.

4 Press ▲ or ▼ to select Yes, and then press the OK button.
After the roll paper is cut, it is rewound automatically.

Cutting the Leading Edge of Roll Paper AutomaticallyCutting the Leading Edge of Roll Paper Automatically
If the leading edge of the paper is cut crooked or is not cut straight when roll paper is loaded, it will not print correctly. If
this happens, you can cut the leading edge of the paper straight when loading a paper roll by using Trim Edge First in
the Control Panel menu.
Trim Edge First offers the following options.

• Automatic
If the leading edge of the paper is cut crooked and is not cut straight when loading roll paper, cut the leading edge
straight and eject the fragment of paper to prevent printing on the platen and soiling the printer.
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• On (Preset Len)
The amount to cut from the leading edge of the paper varies depending on the media type, and is cut to a prescri-
bed length. For more information on the prescribed length, see the leading edge precut length in the Paper Refer-
ence Guide. (See " Paper Reference Guide")

• On(Input Length)
The amount to cut from the leading edge of paper is specified in the control panel. The amount to cut from the
leading edge can be specified in the range of lengths displayed in the control panel. The range of lengths differs
between each media type.

Note

• The amount to cut from the leading edge of paper cannot be set shorter than the length displayed in the control panel.

• Manual
The amount to cut from the leading edge of the paper can be adjusted by pressing the ▲ and ▼ buttons.
After making the adjustment, you can cut the paper by pressing the Paper Cutting button and selecting Cut pa-
per.
After the paper has been cut, press Finish paper set.

Note

• If you do not press Finish paper set after cutting the paper, you will not be able to print again.

• Off
The edge is not cut and scraps are not removed.

 

Follow these steps to change the Trim Edge First setting.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Paper Details, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper, and then press the OK button.

5 Press ▲ or ▼ to select Trim Edge First, and then press the OK button.
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6 Press ▲ or ▼ to select the desired setting option, and then press the OK button.
This setting takes effect the next time you load a roll.

Reducing Dust from Cutting RollsReducing Dust from Cutting Rolls
For media such as Backlit Film that are more likely to generate debris when cut, select CutDustReduct. > On in the
Paper Menu of the Control Panel. This option reduces debris from cutting by printing black lines at the leading and
trailing edges of documents. It may help prevent Printhead damage. You can specify for CutDustReduct. to be activa-
ted for particular types of paper.

Important

• Do not set CutDustReduct. to On for paper that wrinkles easily, such as Plain Paper or lightweight paper. This may impair
cutting and cause paper jams.

• Borderless printing is not available when CutDustReduct. is set to On. To use borderless printing, select CutDustReduct. >
Off.

Set CutDustReduct. to On as follows.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Paper Details, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper loaded in the printer, and then press the OK button.

5 Press ▲ or ▼ to select CutDustReduct., and then press the OK button.

6 Press ▲ or ▼ to select On, and then press the OK button.
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Handling sheetsHandling sheets
Loading Sheets in the Printer ............................................................................................................................. 555
Changing the Type of Paper .............................................................................................................................. 537
Printing From a Desired Starting Point ............................................................................................................... 558
Removing Sheets ............................................................................................................................................... 560
Clearing a Jammed Sheet .................................................................................................................................. 881

Loading Sheets in the PrinterLoading Sheets in the Printer
Follow these steps to load sheets in the printer.

Important

• Paper that is wrinkled or warped may jam. If necessary, straighten the paper and reload it.

• Load the paper straight. Loading paper askew will cause an error.

Note

• Loading sheets when a roll is already loaded in the printer may cause jams. We recommend removing rolls before loading
sheets.  (See "Removing the Roll from the Printer.") →P.539

• To prevent the roll from unwinding if you leave it loaded, wrap a sheet of paper around the roll and tape it.

• Before loading sheets, make sure the printer is clean inside the Top Cover and around the Ejection Guide. If these areas are
dirty, we recommend cleaning them in advance.  (See "Cleaning Inside the Top Cover.") →P.861

• Store unused paper in the original package, away from high temperature, humidity, and direct sunlight.

1 Select sheets as the paper source.

• If a print job was received
Sheets are automatically selected, and the media type and size specified by the print job are shown on the
Display Screen.
Press ▲ or ▼ to select Load Paper, and then press the OK button.
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• If no print job was received

1.  

Press the Load button.

2. Press ▲ or ▼ to select Load Cut Sheet, and then press the OK button.

Note

• If any paper has been advanced that will not be used, a message is shown requesting you to remove it.
Press ▲ or ▼ to select "Yes", and then press the OK button. Remove the paper and go to the next step.

2
 

Lift the Release Lever and open the Top Cover.

Important

• Do not touch the Linear Scale (a), Carriage Shaft (b), or
Fixed Blade (c). This may stain your hands and damage
the printer.
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3 With a sheet lengthwise and printing-side up, insert it between the Platen (a) and the Paper Retainer (b). Align
the edges of the sheet as follows.

1. Align the sheet with the Paper Alignment Line (c) at right.

2. Align the inserted edge of the sheet with the leading edge of the Paper Alignment Line (d), as shown.

When inserted, sheets are automatically held by suction against the Platen.

Important

• Load a sheet so that it is parallel to the Paper Alignment Line at right (c). Loading paper askew will cause an error.

• Warped paper may rub against the Printhead. Straighten paper if it is warped before loading it.

Note

• You can adjust the strength of suction holding paper against the Platen when the Release Lever is up. If it is difficult
to load paper, press the ▲ or ▼ button on the Control Panel to adjust the strength. Set suction stronger by pressing
the ▲ button or weaker with the ▼ button. Three settings are available.
However, even if you increase the suction, it may not be sufficient to hold some types of paper against the Platen
well. In this case, use your hand to load the paper.

• Sheets are held in place by suction through holes on the Platen. Although the suction may produce a noise when
paper is loaded in some positions, it does not indicate a problem. If the noise is distracting, try moving the paper over
slightly to the left or right (up to 1 mm [0.039 in]) while keeping it parallel to the Paper Alignment Line.

• The suction remains on for about 30 seconds during loading. If you cannot finish loading a sheet during this time, pull
the sheet away and reinsert it to start the suction again.
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4
 

Lower the Release Lever and close the Top Cover.

• If a print job was received
Pressing the OK button will advance the paper, and then printing will begin.

• If no print job was received
A menu for selection of the type of paper is shown on the Display Screen.
Press ▲ or ▼ to select the type of paper, and then press the OK button.
The printer now starts feeding the paper.

Note

• For details on types of paper to select, see the Paper Reference Guide.  (See "Types of Paper.") →P.522

• When using the Output Stacker, if you will print on large, stiff sheets, we recommend adjusting the Output Stacker
into the lowest position to prevent printed sheets from being bent.  (See "Using the Output Stacker.") →P.564

Printing From a Desired Starting PointPrinting From a Desired Starting Point
Print on sheets from a desired starting point as follows.

Set Width Detection to Off

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Paper Details, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper, and then press the OK button.

5 Press ▲ or ▼ to select Width Detection, and then press the OK button.
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6 Press ▲ or ▼ to select Off, and then press the OK button.

Load paper in the desired position to start printing from
Follow these instructions to load paper at the desired starting position for printing when Width Detection is Off.

1 If you did not send a print job in advance, a menu for selection of the type of paper is displayed.
Press ▲ or ▼ to select the type of paper, and then press the OK button.

Note

• If a print job was received before paper was advanced, the media type and size specified by the job are shown on
the Display Screen.
Thus, this screen is not displayed. Go to step 2.

2 "Width Detection OFF. OK to continue?" is now shown on the Display Screen. Press ▲ or ▼ to select
"Leave OFF", and then press the OK button.

3 After a menu for selection of the paper size is displayed, press ▲ or ▼ to select the paper size, and then press
the OK button.

4
 

Open the Top Cover and check the position where pa-
per is loaded.

To start printing from the current position, close the Top
Cover.
To reposition the paper, lift the Release Lever.
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5
 

Keeping the right edge of the paper aligned with the ex-
tended line of the paper alignment line (a) on the right
side of the printer and the position from which to start
printing aligned with the groove (b) at the far end of the
platen, load the paper.

6
 

Lower the Release Lever and close the Top Cover.

Removing SheetsRemoving Sheets
Remove sheets from the printer as follows.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.
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3 Press ▲ or ▼ to select Eject Paper, and then press the OK button.

4 Press ▲ or ▼ to select "Yes", and then press the OK button.
The paper is ejected from the front of the printer.

5
 

Open the Top Cover, lift the Release Lever, and re-
move the sheet.

6
 

Lower the Release Lever and close the Top Cover.
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Output StackerOutput Stacker
Output Stacker ................................................................................................................................................... 562
Parts of the Output Stacker ................................................................................................................................ 563
Using the Output Stacker ................................................................................................................................... 564
Storing the Output Stacker ................................................................................................................................. 568

Output StackerOutput Stacker
A cloth tray that catches ejected documents. (Optional)

• Output Stacker BU-01

Note

• For more information on how to attach the Output Stacker, refer to the Setup Guide.
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Parts of the Output StackerParts of the Output Stacker

a Output Stacker
A cloth tray that catches ejected documents.

b White tag
A point of reference for attaching the Output Stacker in the right direction.

c Basket Arm R and Basket Arm L
Holds the Basket Rod (tag side) attached to the Output Stacker. When the Output Stacker is not used, push it
down and store it next to the Stand Leg.

d Basket Rod (tag side) and Basket Rod (cord side)
Holds the cloth Output Stacker securely in specific positions.

e Basket Rod
Keeps Basket Arm R and Basket Arm L at the same angle.

f Rod Holder
Holds the middle of the Basket Rod (cord side).
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 (See "Using the Output Stacker.") →P.564

Using the Output StackerUsing the Output Stacker
The Output Stacker can be held at four positions, as shown.

• When storing printed documents on the Output Stacker
Use position (1).

• When the Output Stacker is not used
Use position (2).

• When the Media Take-up Unit is used, or when the Output Stacker is stored for long periods
Lower it to position (3) for storage.  (See "Storing the Output Stacker.") →P.568

When using the Output Stacker again after storage, reattach the Basket Rod on the front of the Output Stacker to
the tips of the left and right basket arms and pull it out completely .

• When printing on large, stiff sheets
Use position (3).
Set it to position (4) when printing banners or when printing on delicate paper.  (See "Using the output stacker for
ejection in front.") →P.565
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Important

• When storing printed documents on the Output Stacker, always use it in position (1). If you do not, printed documents may
not be dropped into the Output Stacker, and the printed surface may become soiled.

• The Output Stacker can hold one sheet. When printing multiple pages, remove each sheet after it is printed.

• Before using the Output Stacker, remove the Rewind Spool. If you do not, it may prevent printed documents from being held
correctly, and they may be scratched.

• The Output Stacker can hold roll paper up to 84 inches (2133.6 mm) long. When printing longer documents, adjust the stack-
er for ejection in front or use the Media Take-up Unit (option).

The Output Stacker locks into position if you lift it to position (1) or (2). To lower the Output Stacker, lift the front Basket
Rod lightly to release the lock, and then lower the stacker.

Using the output stacker for ejection in front
You can also set the stacker to the following position when printing banners or when printing on delicate paper.
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Important

• When using the stacker for ejection in front, always select Cutting Mode > Eject. Selecting Automatic may damage printed
documents.  (See "Specifying the Cutting Method for Rolls.") →P.546

• During ejection in the front of the printer, be especially careful when using delicate paper or paper that curls easily.

• Depending on the type of paper, the edge may curl or bend during ejection. In this case, straighten out the paper. If the paper
is curled or bent, it may damage printed documents.

• Some types of paper may get caught between the Ejection Guide and Output Stacker during ejection. In this case, free the
paper from where it is caught. If the paper is caught, it may damage printed documents.

1
 

Lift the Basket Rod gently to release the lock, lower the
stacker toward the front, and push it back.

2
 

Remove the Output Stacker from the printer.
Remove the front Basket Rod from the left and right
basket arms, and remove the back Basket Rod and
black cord from the Rod Holder.
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3
 

Stow the left and right basket arms. Next, with the Rod
Holder still attached, remove the Rod Holder Adapter
and put it in front of the printer.

4
 

Pull out the left and right Basket Hooks from the Ejec-
tion Guide.

5
 

Attach the Basket Rod to the Basket Hooks so that the
white tag of the Basket Cloth is on the left.
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6
 

Form the Basket Cloth into a sloping shape to make it
taut, and attach the middle Basket Rod to the Rod
Holder.

Storing the Output StackerStoring the Output Stacker
Stow the Output Stacker if you will use the Media Take-up Unit or if you will not use the Output Stacker for an extended
period.

1
 

When the Output Stacker is in the position used when storing
printed documents (a), lift the front Basket Rod gently to release
the lock, lower the stacker toward the front (b), and push it all the
way back.

2
 

Remove the front Basket Rod from the left and right basket arms.
Roll up the Basket Cloth and put it at the back of the Bottom Stand
Stay.
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Important

• When using the Media Take-up Unit, position the Basket Cloth
and Basket Rod so they do not interfere with the Media Take-up
Sensor (wave portion). This may impair operation.

 

3
 

Push in the left and right basket arms toward the back
all the way, until they stop.
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Media take-up unitMedia take-up unit
Media Take-up Unit ............................................................................................................................................ 570
Using the Media Take-up Unit ........................................................................................................................... 570
Enabling Roll Take-Up ....................................................................................................................................... 571
Disabling Roll Take-Up ...................................................................................................................................... 571
Loading the Rewind Spool on the Media Take-up Unit ..................................................................................... 572
Removing Printed Documents from the Media Take-up Unit ............................................................................. 579

Media Take-up UnitMedia Take-up Unit
Use the Media Take-up Unit to have documents that are printed on rolls rewound automatically after printing. This is
convenient for large-format printing, or when printing large-volume jobs continuously.

Note

• For more information on how to attach the Media Take-up Unit, refer to the Setup Guide.

• For information on the types of paper compatible with the Media Take-up Unit, refer to the Paper Reference Guide. (See
"Types of Paper.") →P.522

• For Media Take-up Unit instructions, see "Using the Media Take-up Unit." →P.570

Using the Media Take-up UnitUsing the Media Take-up Unit

1 Turn the printer on.  (See "Turning the Printer On and Off.") →P.21

2 Enable roll take-up.  (See "Enabling Roll Take-Up.") →P.571

3 Load the rewind spool on the media take-up unit.  (See "Loading the Rewind Spool on the Media Take-up Unit.")
→P.572

4 Turn on the Media Take-up Unit.

5 Print on the roll.

6 Turn off the Media Take-up Unit.
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7 Remove the printed document from the media take-up unit.  (See "Removing Printed Documents from the Media
Take-up Unit.") →P.579

8 Disable roll take-up.  (See "Disabling Roll Take-Up.") →P.571

Important

• The Media Take-up Unit cannot be used with sheets.

• If you have attached the Output Stacker, always stow it before using the Media Take-up Unit.  (See "Storing the Output Stack-
er.") →P.568

• Position the Basket Cloth and Basket Rod so they do not interfere with the Media Take-up Sensor. This may impair opera-
tion.  (See "Storing the Output Stacker.") →P.568

• Rolls are not cut automatically when the Media Take-up Unit is used, regardless of the Cutting Mode setting in the printer
menu or the Automatic Cutting setting in the printer driver. However, you can cut paper by pressing the Cut button.

• Color tones after printing may change during the ink drying period for some types of paper. Allow ample drying time before
the final check of colors, and do not remove printed documents from the Media Take-up Unit too soon.

• In humid environments, documents printed using plenty of ink on relatively insubstantial media such as lightweight Canon
Coated Paper may not be retracted evenly by the unit. In this case, take steps to control humidity in the operating environ-
ment, or adjust the Roll DryingTime setting so that printed documents are retracted after the ink has fully dried.

• In humid environments, documents printed on Fabric Banner or Adhesive Synthetic Paper may not be retracted evenly by
the unit. In this case, take steps to control humidity in the operating environment, or adjust the Roll DryingTime setting so
that printed documents are retracted after the ink has fully dried.

Enabling Roll Take-UpEnabling Roll Take-Up

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Take-up Reel, and then press the OK button.

4 Press ▲ or ▼ to select Use Take-up Reel, and then press the OK button.

5 Press ▲ or ▼ to select Enable, and then press the OK button.

Disabling Roll Take-UpDisabling Roll Take-Up

1 Press the Cut button.
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2 Press ▲ or ▼ to select Yes, and then press the OK button.
The mode now switches from take-up mode to regular mode.

Note

• The printer will also switch from take-up mode to regular mode if you lift the Release Lever and cut the roll with
scissors instead of pressing the Cut button.

3
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

4 Press the OK button.
The Set./Adj. Menu is displayed.

5 Press ▲ or ▼ to select Take-up Reel, and then press the OK button.

6 Press ▲ or ▼ to select Use Take-up Reel, and then press the OK button.

7 Press ▲ or ▼ to select Disable, and then press the OK button.

Loading the Rewind Spool on the Media Take-up UnitLoading the Rewind Spool on the Media Take-up Unit

1 When using the Output Stacker, stow the Output Stacker before this procedure.  (See "Storing the Output
Stacker.") →P.568

Important

• Position the Basket Cloth and Basket Rod so they do not interfere
with the Media Take-up Sensor (wave portion). This may impair
operation.
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2
 

Unlock the flange on the left side of the Rewind Spool
by lifting the lever (a) from the shaft side. Remove the
flange.

3
 

When rewinding rolls with 3-inch paper cores, insert the
3-inch Adapter on the flanges at both ends.

4
 

Insert the paper core, which serves as the spindle for
rewinding a roll, on the Rewind Spool.

Important

• Definitely load the same size of paper core in the Rewind Spool as that of the roll to be rewound. Using a paper
core of a different size may cause rewinding problems.
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5
 

Push the flanges in firmly until the paper core is se-
cured in place and push down the lever (a) toward the
shaft.

Important

• After the flange is pressed strongly, confirm that the paper core does not move. If you can hold and move the paper
core leftward and rightward and there is clearance between the flange and paper core, repeat procedures 2 to 4. If
there is clearance, a rewinding problem may result.

6
 

Load the Rewind Spool on the Media Take-up Unit so
that the gear of the Rewind Spool (a) meshes with the
gear of the Right Media Take-up Unit (b).

Important

• If the gear of the Rewind Spool (a) does not mesh with the gear of the Right Media Take-up Unit (b), the Media
Take-up Unit cannot be turned on.

7
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

8 Press the OK button.
The Set./Adj. Menu is displayed.

 

 

 

Loading the Rewind Spool on the Media Take-up Unit                                                                                                                                                       iPF9400

                                                                                                                                                                                                                                       User's Guide

  

H
andling and U

se of Paper
M

edia take-up unit

 574



9 Press ▲ or ▼ to select Take-up Reel, and then press the OK button.

10 Press ▲ or ▼ to select Auto Feed, and then press the OK button.
The roll is now advanced to the Media Take-up Unit.

11
 

Hold the roll paper by the middle of the leading edge
and align the right edge with the right edge of the paper
core of the Rewind Spool. With the left and right edges
of the roll paper evenly taut, tape the middle to the pa-
per core to fasten it.

12
 

Making sure the roll paper is not slack, tape the left and
right side of the leading edge to the paper core.

Note

• When rewinding heavyweight paper, use strong adhesive tape to fasten it. Otherwise, a rewinding problem may re-
sult.
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13
 

Press the ▼ button to make the roll a little slack.

14
 

On the Right Media Take-up Unit, pull the Rewind
Mode Switch forward to turn it on. Press the ▼ button
to rewind the roll so that it is nearly taut.

Important

• Rewind the paper so that the paper core makes at least two revolutions. If the paper is not rewound two full revolu-
tions, repeat steps 13 and 14.

• Do not manually force the Rewind Spool or paper core to rotate them. This may damage them. To rewind or unwind
rolls, press ▲ or ▼ on the Media Take-up Unit.
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15
 

You can unwind rolls by holding down ▼ on the control
panel.

16
 

Refer to the following table and securely insert the
Weight Flange and Weight Joint suitable for the type
and width of roll into the Weight Roll.

The following list identifies Weight Roll and Weight
Flange you can use. A Color Label is applied to each
Weight Roll.

Weight Roll
Roll Width Weight Roll to Use

B2 Width: 515.0 mm (20.3 in) D
B1 Width: 728.0 mm (28.7 in) A+E
B0 Width: 1,030.0 mm (40.6 in) A+G
A1 Width: 594.0 mm (23.4 in) E
A0 Width: 841.0 mm (33.1 in) B+E
431.8 mm (17 in) C
609.6 mm (24 in) E
762.0 mm (30 in) B+D
914.4 mm (36 in) G
1,066.8 mm (42 in) C+E
1,117.6 mm (44 in) D+E
1270.0 mm (50 in) D+F
1371.6 mm (54 in) E+F
1524.0 mm (60 in) E+G
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Weight Flange

Roll Type Weight Flange to
Use

Canon Premium Glossy Paper 2 280, Semi-Glossy Photo Paper, Canon Premium Glossy Paper 2 280, Heavy-
weight SemiGlossy Photo Paper, Fine Art Photo, Fine Art Heavyweight Photo, Fine Art Textured, Canvas Matte,
Canon Proofing Paper, Canon Coated Paper, Canon Heavyweight Coated Paper, Extra Heavyweight Coated
Paper, Colored Coated Paper, Adhesive Synthetic Paper, Synthetic Paper, Backprint Film, Backlit Film, Canon
Flame-Resistant Cloth, Fabric Banner, Thin Fabric Banner

Weight Flange
1 (*1)

Premium Matte Paper Weight Flange
2

*1:  If you cannot retract stiff paper well using Weight Flange 1 or if the diameter of the retracted paper is wider than the Rewind
Spool, use Weight Flange 2. When using Weight Flange 2, adjust the paper feed amount by executing Auto(GenuinePpr) or
Auto(OtherPaper).  (See "Automatic Banding Adjustment.") →P.806

Important

• Do not use combinations other than those identified here.
• Insert the Weight Flange and Weight Joint firmly on the Weight Roll.

• Use identical Weight Flange on the left and right ends. Insert matching Weight Flanges (1 or 2) on both ends of the
Weight Roll.

Note

• Keep unused weight rolls, weight joints, and weight flanges handy by putting them in the box and putting the box
under the Stand .

17
 

Set the Weight Roll gently on top of the slack in the roll
paper.

The media take-up unit is now ready for use. Printed
rolls can now be rewound automatically.

Important

• Always set the Weight Roll on the paper. Failure to do this may cause rewinding problems.

• When setting the Weight Roll on the paper, avoid touching the paper core and causing the wound roll to become
misaligned on the left and right end. If it is misaligned on the left and right ends, a rewinding problem may result.

Note

• When the media take-up unit is in use, an icon indicating the take-up
mode is shown on the Display Screen.
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Removing Printed Documents from the Media Take-up UnitRemoving Printed Documents from the Media Take-up Unit

1
 

Press the Feed button.

2
 

Hold down the ▼ button to advance the roll a little.
To protect the paper that has been rewound, advance it
an amount longer than the outer circumference.

3
 

Remove the Weight Roll from the roll paper.

4
 

Press the Cut button.
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5 Press ▲ or ▼ to select Yes. As you hold the trailing edge of the printed document, press the OK button.
The roll is now cut.

Important

• Always hold the trailing edge of printed documents when cutting rolls. If you do not hold the documents, they may
fall on the floor and the printed surface may become soiled.

6
 

Hold the trailing edge of the printed document and
press the ▼ button on the Media Take-up Unit to re-
wind the printed document.

Apply adhesive tape to the rewound paper to hold it in
place, if necessary.

Important

• Be careful not to scratch the printed surface.

7
 

Turn off the Media Take-up Unit by pushing in the Re-
wind Mode Switch.
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8
 

Remove the Rewind Spool from the Media Take-up
Unit.

Important

• Always turn off the Media Take-up Unit before removing the Rewind Spool. The Media Take-up Unit may be dam-
aged if you do not turn it off first.

• Remove the Rewind Spool, pulling off both ends from the Media Take-up Unit at once. If you do not pull off both
ends at once, the Media Take-up Unit may become damaged.

9
 

Unlock the flange on the left side of the Rewind Spool
by lifting the lever (a) from the shaft side. Remove the
flange.

10
 

Remove the entire paper core with the rewound printed
documents from the Rewind Spool.

Note

• You can leave the Rewind Spool on the Media Take-up Unit even when it is not used for rewinding rolls.
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The Features of Media Configuration ToolThe Features of Media Configuration Tool
In imagePROGRAF, the best printer settings for each paper are collected together in media information files in order to
give the highest quality printing results. Settings for Canon genuine paper and Canon feed confirmed paper are provi-
ded by Canon in these media information files.

Note

• Canon genuine paper and Canon feed confirmed paper are detailed in the Paper Reference Guide. Any other paper is called
custom paper.

The Media Configuration Tool allows you to perform the following tasks.

• When supported paper has been newly added to the printer, you can add that media type to the printer control
panel and printer driver by using the media information file provided by Canon.

• You can customize Canon genuine paper and feed confirmed paper media information files to create a media in-
formation file for custom paper (paper that is neither Canon genuine paper or feed confirmed paper), and add that
media type to the printer control panel and printer driver.
Furthermore, you can also import the created media information file into other computers and printers, and add
media types to the printer drivers and printers of the computers where the data was imported.

• You can rearrange lists of the types of paper on the printer control panel and in printer driver dialog boxes and
rename them, in addition to other functions.

Important

• Normally, the Media Configuration Tool is installed and the media information is configured when you install the printer driver
from the User Software CD-ROM. Use this software if you want to add new media information or edit existing media informa-
tion.

• Administration of paper information using the Media Configuration Tool should be performed by the printer administrator.

Drivers Applicable with Media Configuration Tool

• imagePROGRAF Printer Driver
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Installation ProceduresInstallation Procedures
The Media Configuration Tool installation screen appears when you start the installation of a new version of the Media
Configuration Tool. The installation procedure started from this screen is described below.

Important

• If the printer driver is installed from the User Software CD-ROM, the Media Configuration Tool is also installed and the media
information is also configured. Therefore, the following procedure does not normally need to be performed. To install the
Media Configuration Tool without using the User Software CD-ROM, such as when you have downloaded a new version of
the Media Configuration Tool from the Canon website, use the following procedure.

• You must be logged in as Administrator when installing software in Windows.

1
 

Start the Media Configuration Tool installer.
Click the Next button.

2
 

The next screen presents selections for the country or
area where the printer is used.
Select a country or territory then click the Next button.
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3
 

The License Agreement is displayed.
Select I accept the terms of the license agreement
and click the Next button.

4
 

The Choose Destination Location screen appears.
Select the destination folder then click the Next button.

5
 

The Ready to Install the Program screen appears.
Click the Install button.
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6
 

All the required files are copied to your computer and
InstallShield Wizard Complete screen appears.
Click the Finish button.
 

This completes the installation of Media Configuration
Tool.

Starting MethodStarting Method
Follow the procedure below to start Media Configuration Tool.
From the start menu go to All Programs > iPFxxxx Media Configuration Tool > iPFxxxx Media Configuration
Tool.
Media Configuration Tool main window is displayed.

Media Configuration Tool Main WindowMedia Configuration Tool Main Window
The explanation below is on the Media Configuration Tool main window.

Note

• For the step to open the Media Configuration Tool main window, see "Starting Method." →P.585
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• Add Genuine Paper button
When this button is clicked, the Edit Media Types dialog box is displayed, which allows you to add media informa-
tion files released by Canon to the printer control panel and printer driver. You can also change names, toggle
between displaying and hiding, and delete added media types.
You can also change the display order of Canon genuine paper and custom paper.
Refer to Editing Media Type Information for Genuine Paper and Feed Confirmed Paper →P.586  for details on Add
Genuine Paper.

• Add and Edit Custom Paper button
When this button is clicked, the Add and Edit Custom Paper dialog box is displayed, which allows you to added
custom paper to the printer control panel and printer driver.
Refer to Using Paper Other than Genuine Paper and Feed Confirmed Paper →P.597  for details on Add and Edit
Custom Paper.

• Link to Support Information button
Opens imagePROGRAF Support Information. You can check information such as the latest information for the
product and software version upgrade information.

• Link to User Manual Button
Click this button to display the User's Guide. This function requires that the User's Guide be installed on your com-
puter.

Editing Media Type Information for Genuine Paper and Feed Confirmed PaperEditing Media Type Information for Genuine Paper and Feed Confirmed Paper
To add genuine paper and feed confirmed paper to the printer control panel and printer driver and edit the media type
information, click the Add Genuine Paper button in the Media Configuration Tool main window.
Confirm the printer, where media type information is to be updated, to be displayed in Printer in the Select Printer
dialog box, and then click the Next button.

Communication with the printer begins.

Important

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

The Edit Media Types dialog box is displayed.

Note

• The printer cannot be changed after this.
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Note

• Paper that is displayed grayed out does not appear in the printer driver or printer panel.

• Add Button
To add genuine paper or feed confirmed paper to the printer control panel and printer driver, click this button.
For details on the procedure for adding media types, see "Adding Media Types." →P.588

Important

• To add media types, download the media information file (.amf file) in advance from the Canon website.

• Rename Button
To change the name on the printer control panel and the name in the printer driver for genuine paper and feed
confirmed paper, select the paper to change and click this button.
For details on the procedure for changing paper display names, see "Changing Media Names." →P.590

• Delete Button
To delete added genuine paper and feed confirmed paper from the printer control panel and printer driver, select
the paper to delete and click this button.
For details on the procedure for deleting added media types, see "Deleting Media Types You Have Added."
→P.592

• Show/Hide Button
To change whether or not genuine paper or feed confirmed paper is displayed in the printer control panel and
printer driver, select the paper to change and click this button.
For details on the procedure for changing whether or not to display media types, see "Switching Media Types Dis-
play Show/Hide." →P.594

•
Change Display Order button (  or )
To change the display order of a media type in the printer control panel and printer driver, select the paper to
change and click this button.
For details on the procedure for changing the display order of media types, see "Changing the Display Order of
Media Types." →P.595

Note

• The display order for custom paper can also be changed.
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Important

• When you update the media type information, perform the same update on all of the PCs that are using that printer.

Note

• It may not be possible to deleting, showing/hiding, and changing the display order under some conditions.

• If a display name is displayed grayed out, that media type will not appear in the printer driver or printer panel.

Adding Media TypesAdding Media Types
Media information files (.amf files) released by Canon are registered in the printer control panel and printer driver.

Important

• Do not perform printing on the target printer while adding the media types.

• Reinstalling Media Configuration Tool after registering a media information file may delete the registered media information
file.In this case, first download and install latest Media Configuration Tool, then download and register the required media
information file.

1
 

Open the Edit Media Types dialog box, and then click
the Add button.

Note

• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Information for
Genuine Paper and Feed Confirmed Paper." →P.586

2
 

The Add Media Type dialog box displays.
Click the Browse button.
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3
 

Open the folder that contains the media information files
(.amf files).

4
 

The names of the media information files contained in
the selected folder are displayed in Media Information
File in the Add Media Type dialog box. Select the
check box for the paper you want to add and click the
OK button.

Note

• If Master Media Information File is displayed as the Type of the Media Information File, the media type display
order and media type display/non-display settings are initialized. Reconfigure these after added the master media
information file.

5 Click OK when the confirmation message is displayed.

6
 

In the Edit Media Types dialog box, click the Update
button.
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7
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute button.
Communication with the printer begins.

Note

• You should normally select Update the printer control panel and printer driver.

Important

• When setting a data to the printer that differs from the data to be updated, the selected media information file is
updated. When you would like to remain the data that is set to the printer, click the Cancel button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

8
 

Click the OK button.

Changing Media NamesChanging Media Names

1
 

Open the Edit Media Types dialog box.

Note

• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Information for
Genuine Paper and Feed Confirmed Paper." →P.586
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2
 

In the Media Type list, select the name to change.
Click the Rename button.

3
 

The Rename Media dialog box is displayed.
Edit the names in Name in Printer Driver and Name
on Control Panel and click the OK button.

Note

• To restore the original names, click the Restore button.

• The characters that can be entered for Name in Printer Driver and Name on Control Panel are stated below.
alphanumeric, space, "-", ".", "_", "()", "+", "%", ",", "/"

• For Name in Printer Driver up to 32 one Byte characters can be entered, and for Name on Control Panel up to 16
one Byte characters can be entered.

4
 

In the Edit Media Types dialog box, click the Update
button.

5
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute button.
Communication with the printer begins.

 

 

 

 

iPF9400                                                                                                                                                                                    Changing Media Names (Windows)

User's Guide                                                                                                                                                                                                                                       

  

H
andling and U

se of Paper
M

edia C
onfiguration Tool (W

indow
s)

591  



Note

• You should normally select Update the printer control panel and printer driver.

Important

• When setting a data to the printer that differs from the data to be updated, the selected media information file is
updated. When you would like to remain the data that is set to the printer, click the Cancel button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

6
 

Click the OK button.

Deleting Media Types You Have AddedDeleting Media Types You Have Added

1
 

Open the Edit Media Types dialog box.

Note

• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Information for
Genuine Paper and Feed Confirmed Paper." →P.586

2
 

In the Media Type list, select the name of the media to
delete.
Click the Delete button.

Note

• Only paper for which Status in the Media Type is Add can be deleted.
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3
 

In the Edit Media Types dialog box, click the Update
button.

4
 

The Confirm Update dialog box is displayed.
Click the Execute button.
Communication with the printer begins.

Important

• When setting a data to the printer that differs from the data to be updated, the selected media information file is
updated. When you would like to remain the data that is set to the printer, click the Cancel button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

5
 

Click the OK button.
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Switching Media Types Display Show/HideSwitching Media Types Display Show/Hide

1
 

Open the Edit Media Types dialog box.

Note

• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Information for
Genuine Paper and Feed Confirmed Paper." →P.586

2
 

In the Media Type list, select the name of the media to
switch off or on for display.
Click the Show/Hide button.
The selected paper is alternately shown or hidden.

Note

• You can select multiple paper.

• The names of media switched for non-display appear grayed out in the Media Type list.

• Each time you click the Show/Hide button, the display mode cycles from showing both the printer driver and printer
panel, to hiding both the printer driver and printer panel, and then to showing only the printer panel.

3
 

In the Edit Media Types dialog box, click the Update
button.
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4
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute button.
Communication with the printer begins.

Note

• You should normally select Update the printer control panel and printer driver.

Important

• When setting a data to the printer that differs from the data to be updated, the selected media information file is
updated. When you would like to remain the data that is set to the printer, click the Cancel button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

5
 

Click the OK button.

Changing the Display Order of Media TypesChanging the Display Order of Media Types

1
 

Open the Edit Media Types dialog box.

Note

• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Information for
Genuine Paper and Feed Confirmed Paper." →P.586

 

 

 

iPF9400                                                                                                                                                    Changing the Display Order of Media Types (Windows)

User's Guide                                                                                                                                                                                                                                       

  

H
andling and U

se of Paper
M

edia C
onfiguration Tool (W

indow
s)

595  



2
 

Select the paper in the Media Type list for which to
change the display order, and then click the buttons to

move the item (  or ).
The selected item moves one line up or down for every
button click.

3
 

In the Edit Media Types dialog box, click the Update
button.

4
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute button.
Communication with the printer begins.

Note

• You should normally select Update the printer control panel and printer driver.

Important

• When setting a data to the printer that differs from the data to be updated, the selected media information file is
updated. When you would like to remain the data that is set to the printer, click the Cancel button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.
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5
 

Click the OK button.

Using Paper Other than Genuine Paper and Feed Confirmed PaperUsing Paper Other than Genuine Paper and Feed Confirmed Paper
To add paper other than Canon genuine paper and feed confirmed paper to the printer control panel and printer driver,
and export and import the media information file for that paper, click the Add and Edit Custom Paper button in the
Media Configuration Tool main window.
Confirm the printer, where media type information is to be updated, to be displayed in Printer in the Select Printer
dialog box, and then click the Next button.

Communication with the printer begins.
The Add and Edit Custom Paper dialog box is displayed.

Note

• The printer cannot be changed after this.

• Custom paper is paper other than Canon genuine paper and feed confirmed paper (paper that is detailed in the Paper Refer-
ence Guide).

• Added Custom Paper
Added custom paper is displayed here.

• Name in Printer Driver
Added custom paper is displayed in the printer driver using this name.

• Name on Printer Control Panel
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Added custom paper is displayed on the printer control panel using this name.

• Standard Paper
Displays the paper selected as the standard paper when the custom paper was added.

• Add Button
To add new custom paper to the printer control panel and printer driver, click this button.
For details on the procedure for adding custom paper, see "Add Custom Paper." →P.599

• Edit Button
To change the settings of added custom paper, select the paper to edit and click this button.
For details on the procedure for changing custom paper settings, see "Edit Custom Paper." →P.606

• Delete Button
To delete added custom paper from the printer control panel and printer driver in your computer, select the paper
to delete and click this button.
For details on the procedure for deleting custom paper, see "Delete Custom Paper." →P.605

• Import Button
To add custom paper to the printer control panel and printer driver by importing a Custom Media Information File
saved in a folder, click this button.
For details on the procedure for importing a Custom Media Information File, see "Import Custom Media Informa-
tion." →P.607

• Export Button
To export media information for added custom paper to a file, select the paper to export and click this button.
For details on the procedure for exporting media information for custom paper, see "Export Custom Media Informa-
tion." →P.607

Important

• When adding or editing custom paper, make the same changes on all of the other PCs that use the target printer. The
changes can be made easily by creating a Custom Media Information File (.am1 file) using the custom paper export function
and importing the file on the other PCs.

• When deleting custom paper, make the same changes on all of the other PCs that use the target printer.

• When using custom paper in another printer, always add the custom paper to that printer before use.

Note

• Canon genuine paper and feed confirmed paper cannot be changed from this dialog box. Refer to "Editing Media Type Infor-
mation for Genuine Paper and Feed Confirmed Paper" →P.586 .

• Changing the display order of media types displayed in the printer control panel and printer driver is performed from the Edit
Media Types dialog box regardless of whether it is Canon genuine paper or custom paper. Refer to "Editing Media Type Infor-
mation for Genuine Paper and Feed Confirmed Paper" →P.586 .

Compatible PaperCompatible Paper

Paper specifications
Refer to "Specifications" and "Paper" for specifications such as thickness and size of paper that can be added as cus-
tom paper  (See "Specifications.") →P.934

Notes on the operating environment
In low humidity environments (below 40%), your printer may develop the following problems.

• Paper becomes curled or wrinkled.

• Paper and the printhead are more likely to touch each other, resulting in a scratched print surface or damaged
printhead.

• The cut printed matter sticks to the printer and will not fall down (film media).

• Paper sticks to the printer, making its transfer impossible and preventing its normal ejection (film media).
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• Uneven printing (film media)

In high humidity environments (over 60%), your printer may develop the following problems.

• Printed matter will not dry.
• Wavy paper surface
• Cut edges are ragged (fabric media).
• Margins remain due to borderless printing.

Important

• Canon offers absolutely no guarantees regarding the print quality or paper feed properties of customer paper (paper that is
not Canon genuine paper or Canon feed confirmed paper).

Add Custom PaperAdd Custom Paper
In order to add new custom paper to the printer control panel and printer driver, first select the media type to use as the
basis from among the Canon genuine paper and feed confirmed paper.. Add this as custom paper after making various
changes to the standard paper as necessary.

Important

• Canon offers absolutely no guarantees regarding the print quality or paper feed properties of customer paper.

• For Canon genuine paper and Canon feed confirmed paper, print using the media type as recommended in the Paper Refer-
ence Guide. The print quality and feed properties are not guaranteed if you use Add Custom Paper in the Media Configura-
tion Tool.

• Do not execute printing on the target printer while adding custom paper.

• When adding custom paper, check the specifications of paper that can be added using "Compatible Paper" →P.598 .

• Custom paper added using the add custom paper function can only be used by the printer driver. It cannot be used by other
software.

1 Open the Add and Edit Custom Paper dialog box.

Note

• For details on the procedure for opening the Add and Edit Custom Paper dialog box, see "Using Paper Other than
Genuine Paper and Feed Confirmed Paper." →P.597

2
 

Click the Add button.

3 The Step 1: Select the standard paper dialog box is displayed. In Paper Category, select the category of
media type to use as the basis of the custom paper you are adding.

Important

• Select the category that you think is the closest to the custom paper you are adding.
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4 The media type names of the Canon genuine paper and feed confirmed paper within the selected category are
shown in Media Type Name. Select the media type to use as the basis of the custom paper, and click the Next
button.

Note

• If you do not know which media type to use as the basis of the custom paper, click the Assist button to open the
Media Type Selection Assistance dialog box, and then set either the Weight (grammage) or the Thickness. The
Media Configuration Tool automatically selects the appropriate paper from the selected paper category. Alternatively,
select the media type called General from among the displayed Media Type Name.

• Depending on the selected category, there might not be a media type called General.

• Depending on the selected category, the Assist button may be disabled.

5
 

The Step 2: Set the custom paper name dialog box is
displayed.
Enter an arbitrary name to display in the printer control
panel and printer driver, and then click the Next button.

Note

• The characters that can be entered for Name in Printer Driver and Name on Control Panel are stated below.
alphanumeric, space, "-", ".", "_", "()", "+", "%", ",", "/"

• For Name in Printer Driver up to 32 one Byte characters can be entered, and for Name on Control Panel up to 16
one Byte characters can be entered.

• Paper Name (English) is used in keeping track of the amount of roll paper left, in status print, etc.

6
 

Load the custom paper in the printer and then click the
OK button.
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Important

• Do not load paper that is curled or that has already been printed on.

7
 

The Step 3: Paper Source Settings dialog box is dis-
played. Select the paper source where the custom pa-
per is loaded and then click the OK button.

8
 

The Step 4: Paper feed adjustment dialog box is dis-
played. Click the Execute button to execute paper feed
adjustment.
The adjustment pattern is printed, and the paper feed is
automatically adjusted based on the printing result.
Once the paper feed adjustment is complete, click the
Next button.

Important

• Check that there is no paper left on the ejection guide.

• If Paper Feed Adjustment is not executed, horizontal stripes with different color tones may appear in the printed
material. Paper feed adjustment does not need to be executed more than once. Execute paper feed adjustment
only once each time you add a custom paper.

9 The Roll Paper Settings dialog box is displayed.

Note

• If a paper source other than Roll Paper is selected in the Step 3: Paper Source Settings dialog box, this screen is
not displayed.

Configure the following settings as necessary, and then click the Next button.
Setting Details

Automatic Cutting Settings Configures the method for cutting roll paper when it is ejected after printing.
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Setting Details
Automatic Cutting Settings • Automatic Cut :Roll paper is automatically cut by the cutter unit.

• Eject Cut :When the Cut key is pressed on the printer control panel, the roll paper is cut by
the cutter unit. Select this if you do not want the printed material to drop immediately after
printing, such as to wait for the ink to dry.

• User Cut :Cutting is not performed by the cutter unit. Cut the roll paper using scissors after
each sheet. Select this for paper that cannot be cut by the cutter unit.

Drying Time Specify the time that the printer waits for ink to dry, as needed.

• Off :Ejects immediately after printing finishes.

• 30 sec./1 min./3 min./5 min./10 min./30 min./60 min. :Ejects after the specified time has
elapsed after printing finishes.

Borderless Printing Configures whether or not to permit borderless printing.

• Permit : Borderless printing is permitted.
• Deny : Borderless printing is denied.

Important

• Depending on the paper, there are types that cannot be cut by the cutter unit, and types that speed deterioration of
the blade and cause damage to the cutter. For thick paper, hard paper, etc. do not use the cutter unit, and instead
cut the roll paper using scissors, etc. after printing. In this case, select User Cut as the Automatic Cutting Set-
tings.

• If borderless printing is performed on paper where the ink drying is poor, the cutter unit may leave scratches where
it touches the printed surface, or may not cut correctly. In this kind of situation, configure the amount of time to wait
for the ink to dry after printing using Drying Time. Alternatively, if the paper cannot be cut well by the cutter, set the
Automatic Cutting Settings to User Cut and cut the roll paper using scissors, etc.

• Paper where borderless printing can be performed is limited by the media type and roll paper width. Refer to
"Compatible Paper" →P.598 .

• For custom paper where there is a need to set the Automatic Cutting Settings to User Cut, set the Borderless
Printing to Deny.

10
 

The Step 5: Configure the amount of ink used dialog
box is displayed.
The upper limit on the amount of ink used to print to the
custom paper is set on this screen by selecting from
among several levels.
First, click the Test Print button to perform a test print
of each level.

Note

• If a standard paper that does not display the Name in Printer Driver is selected in the screen in Step 5, you cannot
perform test prints or configure the maximum amount of ink to use.
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11
 

The Test Print Settings dialog box is displayed.
Select the print priority and print quality of the test print
using Print Priority and Print Quality.
Set the level to test print using Maximum ink usage
and the image to use using Image used in test print,
and then click the Start Print button.

12
 

Determine and set the ink level that is thought to give the
best visual test print results with no bleeding or scraping
of ink.
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Note

• Select the optimal ink level by referring to the help.

• If you cannot obtain sufficiently high quality printing no matter which maximum ink usage level you select, use the
Step 1: Select the standard paper dialog box to change the paper that is the basis of the custom paper to another
paper.

• Because this settings imposes an upper limit on the amount of ink used during printing, the printing result might not
change even if the level is changed depending on the image.

• The color tone cannot be configured using the Media Configuration Tool. Although the color tone may change when
the maximum ink usage is changed, at this point you should select the optimal level by only focusing on bleeding and
scraping of ink. If the color tone needs to be adjusted, provide an ICC color profile that matches the paper you are
using, and select that ICC color profile in your software. For details on how to specify the ICC profile in the printer
driver, see "Matching Sheet." →P.189

• Depending on the maximum ink usage setting, some of the print qualities in the printer driver may become unselect-
able.

13
 

Configure Head Height and Vacuum Strength as re-
quired and click the Next button.
Usually, these do not need to be set.

Important

• If you set the Head Height lower than the automatically set height in parentheses ( ), check that the printhead does
not rub against the paper. (If the printhead rubs against the paper, there will be scratches in the printing results.) If
the printhead rubs against the paper, this can cause damage to the printhead.

• If you change the Vacuum Strength, check that the printhead is not rubbing against the paper. (If the printhead
rubs against the paper, there will be scratches in the printing results.) If the printhead rubs against the paper, this
can cause damage to the printhead.

• For details on the Head Height and Vacuum Strength, refer to the help.

14
 

The Step 6: Confirm the settings dialog box is dis-
played.
Configure the settings of the custom paper, and then
click the Next button.
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15
 

The Confirm Update dialog box is displayed.
Confirm the updates and then click the Execute button.

The custom paper is added to the control panel of the
printer and to the printer driver of the PC you are using.

Important

• If you have added custom paper with the POP Board / Cardboard category as the Standard Paper, remove the
loaded custom paper from the printer.

Note

• When the custom paper is correctly added to the printer driver, the name of the added custom paper is displayed in
the Edit Media Types dialog box that is opened by Add Genuine Paper in the Media Configuration Tool window.

Delete Custom PaperDelete Custom Paper
You can delete custom paper that you have already added from printer control panel and from the printer driver of the
PC you are using.

1 Open the Add and Edit Custom Paper dialog box.

Note

• For details on the procedure for opening the Add and Edit Custom Paper dialog box, see "Using Paper Other than
Genuine Paper and Feed Confirmed Paper." →P.597

2
 

Select the paper you want to delete from the Added
Custom Paper list and then click the Delete button.

Note

• You can select multiple paper.
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3
 

The Confirm Update dialog box is displayed.
Confirm the updates and then click the Execute button.

The custom paper is deleted from the control panel of
the printer and from the printer driver of the PC you are
using.

Edit Custom PaperEdit Custom Paper
You can change the settings of custom paper you have already added.

1 Open the Add and Edit Custom Paper dialog box.

Note

• For details on the procedure for opening the Add and Edit Custom Paper dialog box, see "Using Paper Other than
Genuine Paper and Feed Confirmed Paper." →P.597

2
 

Select the paper you want to edit from the Added Cus-
tom Paper list and then click the Edit button.

3
 

The View Settings dialog box is displayed.

Follow the on-screen directions and change the set-
tings as required.

Note

• Refer to Steps 5 to 15 of the "Add Custom Paper" →P.599  for details on how to configure each setting.
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Export Custom Media InformationExport Custom Media Information
You can export to file and save media information about custom paper that you have added.
The saved Custom Media Information File can be used by importing it into another printer or PC. Refer to "Import Cus-
tom Media Information" →P.607  for details on "importing custom media information".

1 Open the Add and Edit Custom Paper dialog box.

Note

• For details on the procedure for opening the Add and Edit Custom Paper dialog box, see "Using Paper Other than
Genuine Paper and Feed Confirmed Paper." →P.597

2
 

Select the paper you want to export to media informa-
tion file from the Added Custom Paper list and then
click the Export button.

Note

• You can select multiple paper.

3
 

Specify the location to save the Custom Media Informa-
tion File.

Note

• You can change the file name by selecting and editing the File.
A Custom Media Information File (.am1 file) is saved.

Import Custom Media InformationImport Custom Media Information
You can import a Custom Media Information File that has been saved in a folder, and add the file to the printer control
panel and to the printer driver of the PC you are using.

1 Open the Add and Edit Custom Paper dialog box.

Note

• For details on the procedure for opening the Add and Edit Custom Paper dialog box, see "Using Paper Other than
Genuine Paper and Feed Confirmed Paper." →P.597
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2
 

Click the Import button.

3
 

Select the Custom Media Information File (.am1 file) to
import.

4
 

The Confirm Update dialog box opens.
Click the Execute button.

Note

• You should normally select Update the printer control panel and printer driver.
The custom paper is added to the control panel of the printer and to the printer driver of the PC you are using.

• When the custom paper is correctly added to the printer driver, the name of the added custom paper is displayed in
the Edit Media Types dialog box that is opened by Add Genuine Paper in the Media Configuration Tool window.
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WarningsWarnings
Take note of the following warnings when added custom paper other than Canon genuine paper and feed confirmed
paper to the printer driver and the printer itself.

About the Cutter

• Depending on the paper, there are types that cannot be cut by the cutter unit, and types that speed deterioration of
the blade and cause damage to the cutter. For thick paper, hard paper, etc. do not use the cutter unit, and instead
cut the roll paper using scissors, etc. after printing. In this case, select User Cut as the Automatic Cutting Set-
tings in the Roll Paper Settings dialog box.

Note

• If the cutter is damaged, contact your Canon dealer for assistance.

• For details on the methods for cutting roll paper, see "Specifying the Cutting Method for Rolls." →P.546

About the Printhead

• If the printhead rubs against the paper during printing, this may cause damage to the printhead. If the printhead is
rubbing against the paper, configure the Vacuum Strength in the Step 5: Configure the amount of ink used
dialog box as follows.

• For paper-based media such as Heavyweight Coated Paper: Set to Strong or Strongest
• For film-based media such as CAD Tracing Paper: Set to Standard, Strong, or Strongest
• For thin paper of thickness 0.1mm or less: Set to Weakest

Note

• If the printhead still rubs even after changing the Vacuum Strength, set the Head Height to be higher in the Step 5: Config-
ure the amount of ink used dialog box.

• For details on how to handle the printhead rubbing against the paper, see "Paper rubs against the printhead." →P.889

About Borderless Printing

• When performing borderless printing on paper where the ink does not dry well, the cutter unit may leave scratches
where it touches the printed surface, or may not cut correctly. In this kind of situation, configure the amount of time
to wait for the ink to dry after printing using Drying Time in the Roll Paper Settings dialog box.
Alternatively, if the paper cannot be cut well by the cutter, set the Automatic Cutting Settings to User Cut in the
Roll Paper Settings dialog box, and cut the roll paper using scissors, etc.

About the Print Quality

• If the edges of images are blurry, set the Vacuum Strength to be weaker in the Step 5: Configure the amount of
ink used dialog box.

• If lines are warped or scratched, set the Head Height to be lower in the Step 5: Configure the amount of ink
used dialog box.

• If the amount of ink used is too much, wrinkles may appear and the ink may bleed in the printed material. Further-
more, if the amount of ink used is too little, color production may be poor and lines may become scratched. In this
kind of situation, change the amount of ink used in the Step 5: Configure the amount of ink used dialog box.

• If horizontal bands with different color tone appear in the printed material, execute Paper Feed Adjustment in the
Step 4: Paper feed adjustment dialog box. If you have already executed Paper Feed Adjustment, execute Adj.
Fine Feed from the printer control panel and fine tune the amount of paper feed.

Note

• For details on Adj. Fine Feed, see "Fine-Tuning the Paper Feed Amount." →P.809

• If horizontal bands appear even after executing Adj. Fine Feed, refer to "Banding in different colors occurs" in "Trouble-
shooting".  (See "Banding in different colors occurs.") →P.891
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• If you cannot obtain sufficiently high print quality, change the maximum ink usage, or change the media type used
as the basis for the custom paper in the Step 1: Select the standard paper dialog box.

• If there is no luster in printed material, set the paper used as the basis for the custom paper to a paper that uses
photo ink as the Black ink.
The types of Black ink used are displayed on the right side of each media type in the Step 1: Select the standard
paper dialog box.

Note

• For details on problems with printing quality, see "Problems with the printing quality." →P.888

About the Color Tone

• The color tone cannot be configured using the Media Configuration Tool. If the color tone needs to be adjusted,
provide an ICC color profile that matches the paper you are using, and select that ICC color profile in your soft-
ware. For details on how to specify the ICC color profile in the printer driver, see "Matching Sheet." →P.189

• Custom paper cannot be used with the ambient light adjustment function or Monitor Matching in Color-Matching
Method.
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Media Configuration Tool (Mac OS X)Media Configuration Tool (Mac OS X)
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Warnings ....................................................................................................................................................... 644

The Features of Media Configuration ToolThe Features of Media Configuration Tool
In imagePROGRAF, the best printer settings for each paper are collected together in media information files in order to
give the highest quality printing results. Settings for Canon genuine paper and Canon feed confirmed paper are provi-
ded by Canon in these media information files.

Note

• Canon genuine paper and Canon feed confirmed paper are detailed in the Paper Reference Guide. Any other paper is called
custom paper.

The Media Configuration Tool allows you to perform the following tasks.

• When supported paper has been newly added to the printer, you can add that media type to the printer control
panel and printer driver by using the media information file provided by Canon.

• You can customize Canon genuine paper and feed confirmed paper media information files to create a media in-
formation file for custom paper (paper that is neither Canon genuine paper or feed confirmed paper), and add that
media type to the printer control panel and printer driver.
Furthermore, you can also import the created media information file into other computers and printers, and add
media types to the printer drivers and printers of the computers where the data was imported.

• You can rearrange lists of the types of paper on the printer control panel and in printer driver dialog boxes and
rename them, in addition to other functions.

Important

• Normally, the Media Configuration Tool is installed and the media information is configured when you install the printer driver
from the User Software CD-ROM. Use this software if you want to add new media information or edit existing media informa-
tion.

• Administration of paper information using the Media Configuration Tool should be performed by the printer administrator.

Drivers Applicable with Media Configuration Tool

• imagePROGRAF Printer Driver
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Procedures for InstallingProcedures for Installing
Start the installer in the new version of Media Configuration Tool, and follow procedures below to install the Media Con-
figuration Tool.

Important

• If the printer driver is installed from the User Software CD-ROM, the Media Configuration Tool is also installed and the media
information is also configured. Therefore, the following procedure does not normally need to be performed. To install the
Media Configuration Tool without using the User Software CD-ROM, such as when you have downloaded a new version of
the Media Configuration Tool from the Canon website, use the following procedure.

1
 

Double click the MCT Installer iPFxxxx for X icon to start the Media Con-
figuration Tool installer.

Note

• The iPFxxxx in the icon will be the printer name in use.

2
 

Input the administrator name and password, and click
the OK button.

3
 

The next screen presents selections for the country or
area where the printer is used.
Select a country or territory then click the OK button.
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4
 

The License is displayed.
After you have read Canon Software License Agree-
ment, click the Continue button.

5
 

Click the Agree button.

6
 

Select Easy Install then click the Install button.

7
 

Click the Continue button to quit another application.

 

 

 

 

iPF9400                                                                                                                                                                                  Procedures for Installing (Mac OS X)

User's Guide                                                                                                                                                                                                                                       

  

H
andling and U

se of Paper
M

edia C
onfiguration Tool (M

ac O
S X)

613  



8
 

When the following message is displayed, click the
Quit button.

The installation of Media Configuration Tool is com-
plete.

Note

• When the installation is completed properly, the Media Configuration Tool folder is saved in the following folder.
Applications > Canon Utilities > iPFxxxx Media Configuration Tool

• The iPFxxxx in the folder above will be the printer name in use.

Procedures for UninstallingProcedures for Uninstalling

1
 

Double click the MCT Installer iPFxxxx for X icon to start the Media Con-
figuration Tool installer.

Note

• The iPFxxxx in the icon will be the printer name in use.

2
 

Input the administrator name and password, and click
the OK button.
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3
 

The next screen presents selections for the country or
area where the printer is used.
Select a country or territory then click the OK button.

4
 

The License is displayed.
After you have read Canon Software License Agree-
ment, click the Continue button.

5
 

Click the Agree button.
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6
 

Select Uninstall.

7
 

Click the Uninstall button.

8
 

Press the Continue button when another application is
running.
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9
 

When the following message is displayed, click the
Quit button.
 

Media Configuration Tool has been uninstalled.

Starting MethodStarting Method
Follow the procedure below to start the Media Configuration Tool.
From the Applications menu > Canon Utilities >iPFxxxx Media Configuration Tool > MCTxxxx.app.
Media Configuration Tool main window is displayed.

Note

• If a compatible printer driver is not installed, the Media Configuration Tool will not start. If you attempt to start the Media Con-
figuration Tool when a printer driver is not installed, the warning message below is displayed.
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Media Configuration Tool Main WindowMedia Configuration Tool Main Window
The explanation below is on the Media Configuration Tool main window.

Note

• For the step to open the Media Configuration Tool main window, see "Starting Method." →P.617

• Add Genuine Paper button
When this button is clicked, the Edit Media Types dialog box is displayed, which allows you to add media informa-
tion files released by Canon to the printer control panel and printer driver. You can also change names, toggle
between displaying and hiding, and delete added media types.
You can also change the display order of Canon genuine paper and custom paper.
Refer to Editing Media Type Information for Genuine Paper and Feed Confirmed Paper →P.619  for details on Add
Genuine Paper.

• Add and Edit Custom Paper button
When this button is clicked, the Add and Edit Custom Paper dialog box is displayed, which allows you to added
custom paper to the printer control panel and printer driver.
Refer to Using Paper Other than Genuine Paper and Feed Confirmed Paper →P.630  for details on Add and Edit
Custom Paper.

• Link to Support Information button
Opens imagePROGRAF Support Information. You can check information such as the latest information for the
product and software version upgrade information.

• Link to User Manual Button
Click this button to display the User's Guide. This function requires that the User's Guide be installed on your com-
puter.
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Editing Media Type Information for Genuine Paper and Feed Confirmed PaperEditing Media Type Information for Genuine Paper and Feed Confirmed Paper
To add genuine paper and feed confirmed paper to the printer control panel and printer driver and edit the media type
information, click the Add Genuine Paper button in the Media Configuration Tool main window.
Confirm the printer, where media type information is to be updated, to be displayed in Printer in the Select Printer
dialog box, and then click the Next button.

Communication with the printer begins.

Important

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

The Edit Media Types dialog box is displayed.

Note

• The printer cannot be changed after this.

Note

• Paper that is displayed grayed out does not appear in the printer driver or printer panel.

• Add Button
To add genuine paper or feed confirmed paper to the printer control panel and printer driver, click this button.
For details on the procedure for adding media types, see "Adding Media Types." →P.620

Important

• To add media types, download the media information file (.amf file) in advance from the Canon website.
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• Rename Button
To change the name on the printer control panel and the name in the printer driver for genuine paper and feed
confirmed paper, select the paper to change and click this button.
For details on the procedure for changing paper display names, see "Changing Media Names." →P.623

• Delete Button
To delete added genuine paper and feed confirmed paper from the printer control panel and printer driver, select
the paper to delete and click this button.
For details on the procedure for deleting added media types, see "Deleting Media Types You Have Added."
→P.625

• Show/Hide Button
To change whether or not genuine paper or feed confirmed paper is displayed in the printer control panel and
printer driver, select the paper to change and click this button.
For details on the procedure for changing whether or not to display media types, see "Switching Media Types Dis-
play Show/Hide." →P.627

•
Change Display Order button (  or )
To change the display order of a media type in the printer control panel and printer driver, select the paper to
change and click this button.
For details on the procedure for changing the display order of media types, see "Changing the Display Order of
Media Types." →P.629

Note

• The display order for custom paper can also be changed.

Important

• When you update the media type information, perform the same update on all of the PCs that are using that printer.

Note

• It may not be possible to deleting, showing/hiding, and changing the display order under some conditions.

• If a display name is displayed grayed out, that media type will not appear in the printer driver or printer panel.

Adding Media TypesAdding Media Types
Media information files (.amf files) released by Canon are registered in the printer control panel and printer driver.

Important

• Do not perform printing on the target printer while adding the media types.

• Reinstalling Media Configuration Tool after registering a media information file may delete the registered media information
file.In this case, first download and install latest Media Configuration Tool, then download and register the required media
information file.
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1
 

Open the Edit Media Types dialog box, and then click
the Add button.

Note

• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Information for
Genuine Paper and Feed Confirmed Paper." →P.619

2
 

The Add Media Type dialog box displays.
Click the Browse button.

3
 

Open the folder that contains the media information
files (.amf files).
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4
 

The names of the media information files contained in
the selected folder are displayed in Media Information
File in the Add Media Type dialog box. Select the
check box for the paper you want to add and click the
OK button.

Note

• If Master Media Information File is displayed as the Type of the Media Information File, the media type display
order and media type display/non-display settings are initialized. Reconfigure these after added the master media
information file.

5 Click OK when the confirmation message is displayed.

6
 

In the Edit Media Types dialog box, click the Update
button.

7
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute button.
Communication with the printer begins.

Note

• You should normally select Update the printer control panel and printer driver.
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Important

• When setting a data to the printer that differs from the data to be updated, the selected media information file is
updated. When you would like to remain the data that is set to the printer, click the Cancel button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

8
 

Click the OK button.

Changing Media NamesChanging Media Names

1
 

Open the Edit Media Types dialog box.

Note

• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Information for
Genuine Paper and Feed Confirmed Paper." →P.619

2
 

In the Media Type list, select the name to change.
Click the Rename button.
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3
 

The Rename Media dialog box is displayed.
Edit the names in Name in Printer Driver and Name
on Control Panel and click the OK button.

Note

• To restore the original names, click the Restore button.

• The characters that can be entered for Name in Printer Driver and Name on Control Panel are stated below.
alphanumeric, space, "-", ".", "_", "()", "+", "%", ",", "/"

• For Name in Printer Driver up to 32 one Byte characters can be entered, and for Name on Control Panel up to 16
one Byte characters can be entered.

4
 

In the Edit Media Types dialog box, click the Update
button.

5
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute button.
Communication with the printer begins.

Note

• You should normally select Update the printer control panel and printer driver.

Important

• When setting a data to the printer that differs from the data to be updated, the selected media information file is
updated. When you would like to remain the data that is set to the printer, click the Cancel button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.
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6
 

Click the OK button.

Deleting Media Types You Have AddedDeleting Media Types You Have Added

1
 

Open the Edit Media Types dialog box.

Note

• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Information for
Genuine Paper and Feed Confirmed Paper." →P.619

2
 

In the Media Type list, select the name of the media to
delete.
Click the Delete button.

Note

• Only paper for which Status in the Media Type is Add can be deleted.
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3
 

In the Edit Media Types dialog box, click the Update
button.

4
 

The Confirm Update dialog box is displayed.
Click the Execute button.
Communication with the printer begins.

Important

• When setting a data to the printer that differs from the data to be updated, the selected media information file is
updated. When you would like to remain the data that is set to the printer, click the Cancel button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

5
 

Click the OK button.
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Switching Media Types Display Show/HideSwitching Media Types Display Show/Hide

1
 

Open the Edit Media Types dialog box.

Note

• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Information for
Genuine Paper and Feed Confirmed Paper." →P.619

2
 

In the Media Type list, select the name of the media to
switch off or on for display.
Click the Show/Hide button.
The selected paper is alternately shown or hidden.

Note

• You can select multiple paper.

• The names of media switched for non-display appear grayed out in the Media Type list.

• Each time you click the Show/Hide button, the display mode cycles from showing both the printer driver and printer
panel, to hiding both the printer driver and printer panel, and then to showing only the printer panel.
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3
 

In the Edit Media Types dialog box, click the Update
button.

4
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute button.
Communication with the printer begins.

Note

• You should normally select Update the printer control panel and printer driver.

Important

• When setting a data to the printer that differs from the data to be updated, the selected media information file is
updated. When you would like to remain the data that is set to the printer, click the Cancel button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

5
 

Click the OK button.
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Changing the Display Order of Media TypesChanging the Display Order of Media Types

1
 

Open the Edit Media Types dialog box.

Note

• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Information for
Genuine Paper and Feed Confirmed Paper." →P.619

2
 

Select the paper in the Media Type list for which to
change the display order, and then click the buttons to

move the item (  or ).
The selected item moves one line up or down for every
button click.

3
 

In the Edit Media Types dialog box, click the Update
button.
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4
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute button.
Communication with the printer begins.

Note

• You should normally select Update the printer control panel and printer driver.

Important

• When setting a data to the printer that differs from the data to be updated, the selected media information file is
updated. When you would like to remain the data that is set to the printer, click the Cancel button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

5
 

Click the OK button.

Using Paper Other than Genuine Paper and Feed Confirmed PaperUsing Paper Other than Genuine Paper and Feed Confirmed Paper
To add paper other than Canon genuine paper and feed confirmed paper to the printer control panel and printer driver,
and export and import the media information file for that paper, click the Add and Edit Custom Paper button in the
Media Configuration Tool main window.
Confirm the printer, where media type information is to be updated, to be displayed in Printer in the Select Printer
dialog box, and then click the Next button.

Communication with the printer begins.
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The Add and Edit Custom Paper dialog box is displayed.

Note

• The printer cannot be changed after this.

• Custom paper is paper other than Canon genuine paper and feed confirmed paper (paper that is detailed in the Paper Refer-
ence Guide).

• Added Custom Paper
Added custom paper is displayed here.

• Name in Printer Driver
Added custom paper is displayed in the printer driver using this name.

• Name on Printer Control Panel
Added custom paper is displayed on the printer control panel using this name.

• Standard Paper
Displays the paper selected as the standard paper when the custom paper was added.

• Add Button
To add new custom paper to the printer control panel and printer driver, click this button.
For details on the procedure for adding custom paper, see "Add Custom Paper." →P.633

• Edit Button
To change the settings of added custom paper, select the paper to edit and click this button.
For details on the procedure for changing custom paper settings, see "Edit Custom Paper." →P.640

• Delete Button
To delete added custom paper from the printer control panel and printer driver in your computer, select the paper
to delete and click this button.
For details on the procedure for deleting custom paper, see "Delete Custom Paper." →P.640

• Import Button
To add custom paper to the printer control panel and printer driver by importing a Custom Media Information File
saved in a folder, click this button.
For details on the procedure for importing a Custom Media Information File, see "Import Custom Media Informa-
tion." →P.642

• Export Button
To export media information for added custom paper to a file, select the paper to export and click this button.
For details on the procedure for exporting media information for custom paper, see "Export Custom Media Informa-
tion." →P.641
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Important

• When adding or editing custom paper, make the same changes on all of the other PCs that use the target printer. The
changes can be made easily by creating a Custom Media Information File (.am1 file) using the custom paper export function
and importing the file on the other PCs.

• When deleting custom paper, make the same changes on all of the other PCs that use the target printer.

• When using custom paper in another printer, always add the custom paper to that printer before use.

Note

• Canon genuine paper and feed confirmed paper cannot be changed from this dialog box. Refer to "Editing Media Type Infor-
mation for Genuine Paper and Feed Confirmed Paper" →P.619 .

• Changing the display order of media types displayed in the printer control panel and printer driver is performed from the Edit
Media Types dialog box regardless of whether it is Canon genuine paper or custom paper. Refer to "Editing Media Type Infor-
mation for Genuine Paper and Feed Confirmed Paper" →P.619 .

Compatible PaperCompatible Paper

Paper specifications
Refer to "Specifications" and "Paper" for specifications such as thickness and size of paper that can be added as cus-
tom paper  (See "Specifications.") →P.934

Notes on the operating environment
In low humidity environments (below 40%), your printer may develop the following problems.

• Paper becomes curled or wrinkled.

• Paper and the printhead are more likely to touch each other, resulting in a scratched print surface or damaged
printhead.

• The cut printed matter sticks to the printer and will not fall down (film media).

• Paper sticks to the printer, making its transfer impossible and preventing its normal ejection (film media).
• Uneven printing (film media)

In high humidity environments (over 60%), your printer may develop the following problems.

• Printed matter will not dry.
• Wavy paper surface
• Cut edges are ragged (fabric media).
• Margins remain due to borderless printing.

Important

• Canon offers absolutely no guarantees regarding the print quality or paper feed properties of customer paper (paper that is
not Canon genuine paper or Canon feed confirmed paper).
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Add Custom PaperAdd Custom Paper
In order to add new custom paper to the printer control panel and printer driver, first select the media type to use as the
basis from among the Canon genuine paper and feed confirmed paper.. Add this as custom paper after making various
changes to the standard paper as necessary.

Important

• Canon offers absolutely no guarantees regarding the print quality or paper feed properties of customer paper.

• For Canon genuine paper and Canon feed confirmed paper, print using the media type as recommended in the Paper Refer-
ence Guide. The print quality and feed properties are not guaranteed if you use Add Custom Paper in the Media Configura-
tion Tool.

• Do not execute printing on the target printer while adding custom paper.

• When adding custom paper, check the specifications of paper that can be added using "Compatible Paper" →P.632 .

• Custom paper added using the add custom paper function can only be used by the printer driver. It cannot be used by other
software.

1 Open the Add and Edit Custom Paper dialog box.

Note

• For details on the procedure for opening the Add and Edit Custom Paper dialog box, see "Using Paper Other than
Genuine Paper and Feed Confirmed Paper." →P.630

2
 

Click the Add button.

3 The Step 1: Select the standard paper dialog box is displayed. In Paper Category, select the category of
media type to use as the basis of the custom paper you are adding.

Important

• Select the category that you think is the closest to the custom paper you are adding.
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4 The media type names of the Canon genuine paper and feed confirmed paper within the selected category are
shown in Media Type Name. Select the media type to use as the basis of the custom paper, and click the Next
button.

Note

• If you do not know which media type to use as the basis of the custom paper, click the Assist button to open the
Media Type Selection Assistance dialog box, and then set either the Weight (grammage) or the Thickness. The
Media Configuration Tool automatically selects the appropriate paper from the selected paper category. Alternatively,
select the media type called General from among the displayed Media Type Name.

• Depending on the selected category, there might not be a media type called General.

• Depending on the selected category, the Assist button may be disabled.

5
 

The Step 2: Set the custom paper name dialog box is
displayed.
Enter an arbitrary name to display in the printer control
panel and printer driver, and then click the Next button.

Note

• The characters that can be entered for Name in Printer Driver and Name on Control Panel are stated below.
alphanumeric, space, "-", ".", "_", "()", "+", "%", ",", "/"

• For Name in Printer Driver up to 32 one Byte characters can be entered, and for Name on Control Panel up to 16
one Byte characters can be entered.

• Paper Name (English) is used in keeping track of the amount of roll paper left, in status print, etc.
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6
 

Load the custom paper in the printer and then click the
OK button.

Important

• Do not load paper that is curled or that has already been printed on.

7
 

The Step 3: Paper Source Settings dialog box is dis-
played. Select the paper source where the custom pa-
per is loaded and then click the OK button.

8
 

The Step 4: Paper feed adjustment dialog box is dis-
played. Click the Execute button to execute paper feed
adjustment.
The adjustment pattern is printed, and the paper feed is
automatically adjusted based on the printing result.
Once the paper feed adjustment is complete, click the
Next button.

Important

• Check that there is no paper left on the ejection guide.

• If Paper Feed Adjustment is not executed, horizontal stripes with different color tones may appear in the printed
material. Paper feed adjustment does not need to be executed more than once. Execute paper feed adjustment
only once each time you add a custom paper.

9 The Roll Paper Settings dialog box is displayed.

Note

• If a paper source other than Roll Paper is selected in the Step 3: Paper Source Settings dialog box, this screen is
not displayed.
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Configure the following settings as necessary, and then click the Next button.
Setting Details

Automatic Cutting Settings Configures the method for cutting roll paper when it is ejected after printing.

• Automatic Cut :Roll paper is automatically cut by the cutter unit.

• Eject Cut :When the Cut key is pressed on the printer control panel, the roll paper is cut by
the cutter unit. Select this if you do not want the printed material to drop immediately after
printing, such as to wait for the ink to dry.

• User Cut :Cutting is not performed by the cutter unit. Cut the roll paper using scissors after
each sheet. Select this for paper that cannot be cut by the cutter unit.

Drying Time Specify the time that the printer waits for ink to dry, as needed.

• Off :Ejects immediately after printing finishes.

• 30 sec./1 min./3 min./5 min./10 min./30 min./60 min. :Ejects after the specified time has
elapsed after printing finishes.

Borderless Printing Configures whether or not to permit borderless printing.

• Permit : Borderless printing is permitted.
• Deny : Borderless printing is denied.

Important

• Depending on the paper, there are types that cannot be cut by the cutter unit, and types that speed deterioration of
the blade and cause damage to the cutter. For thick paper, hard paper, etc. do not use the cutter unit, and instead
cut the roll paper using scissors, etc. after printing. In this case, select User Cut as the Automatic Cutting Set-
tings.

• If borderless printing is performed on paper where the ink drying is poor, the cutter unit may leave scratches where
it touches the printed surface, or may not cut correctly. In this kind of situation, configure the amount of time to wait
for the ink to dry after printing using Drying Time. Alternatively, if the paper cannot be cut well by the cutter, set the
Automatic Cutting Settings to User Cut and cut the roll paper using scissors, etc.

• Paper where borderless printing can be performed is limited by the media type and roll paper width. Refer to
"Compatible Paper" →P.632 .

• For custom paper where there is a need to set the Automatic Cutting Settings to User Cut, set the Borderless
Printing to Deny.
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10
 

The Step 5: Configure the amount of ink used dialog
box is displayed.
The upper limit on the amount of ink used to print to the
custom paper is set on this screen by selecting from
among several levels.
First, click the Test Print button to perform a test print
of each level.

Note

• If a standard paper that does not display the Name in Printer Driver is selected in the screen in Step 5, you cannot
perform test prints or configure the maximum amount of ink to use.

11
 

The Test Print Settings dialog box is displayed.
Select the print priority and print quality of the test print
using Print Priority and Print Quality.
Set the level to test print using Maximum ink usage
and the image to use using Image used in test print,
and then click the Start Print button.
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12
 

Determine and set the ink level that is thought to give
the best visual test print results with no bleeding or
scraping of ink.

Note

• Select the optimal ink level by referring to the help.

• If you cannot obtain sufficiently high quality printing no matter which maximum ink usage level you select, use the
Step 1: Select the standard paper dialog box to change the paper that is the basis of the custom paper to another
paper.

• Because this settings imposes an upper limit on the amount of ink used during printing, the printing result might not
change even if the level is changed depending on the image.

• The color tone cannot be configured using the Media Configuration Tool. Although the color tone may change when
the maximum ink usage is changed, at this point you should select the optimal level by only focusing on bleeding and
scraping of ink. If the color tone needs to be adjusted, provide an ICC color profile that matches the paper you are
using, and select that ICC color profile in your software. For details on how to specify the ICC profile in the printer
driver, see "Matching Sheet." →P.189

• Depending on the maximum ink usage setting, some of the print qualities in the printer driver may become unselect-
able.

13
 

Configure Head Height and Vacuum Strength as re-
quired and click the Next button.
Usually, these do not need to be set.
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Important

• If you set the Head Height lower than the automatically set height in parentheses ( ), check that the printhead does
not rub against the paper. (If the printhead rubs against the paper, there will be scratches in the printing results.) If
the printhead rubs against the paper, this can cause damage to the printhead.

• If you change the Vacuum Strength, check that the printhead is not rubbing against the paper. (If the printhead
rubs against the paper, there will be scratches in the printing results.) If the printhead rubs against the paper, this
can cause damage to the printhead.

• For details on the Head Height and Vacuum Strength, refer to the help.

14
 

The Step 6: Confirm the settings dialog box is dis-
played.
Configure the settings of the custom paper, and then
click the Next button.

15
 

The Confirm Update dialog box is displayed.
Confirm the updates and then click the Execute button.

The custom paper is added to the control panel of the
printer and to the printer driver of the PC you are using.

Important

• If you have added custom paper with the POP Board / Cardboard category as the Standard Paper, remove the
loaded custom paper from the printer.

Note

• When the custom paper is correctly added to the printer driver, the name of the added custom paper is displayed in
the Edit Media Types dialog box that is opened by Add Genuine Paper in the Media Configuration Tool window.
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Delete Custom PaperDelete Custom Paper
You can delete custom paper that you have already added from printer control panel and from the printer driver of the
PC you are using.

1 Open the Add and Edit Custom Paper dialog box.

Note

• For details on the procedure for opening the Add and Edit Custom Paper dialog box, see "Using Paper Other than
Genuine Paper and Feed Confirmed Paper." →P.630

2
 

Select the paper you want to delete from the Added
Custom Paper list and then click the Delete button.

Note

• You can select multiple paper.

3
 

The Confirm Update dialog box is displayed.
Confirm the updates and then click the Execute button.

The custom paper is deleted from the control panel of
the printer and from the printer driver of the PC you are
using.

Edit Custom PaperEdit Custom Paper
You can change the settings of custom paper you have already added.

1 Open the Add and Edit Custom Paper dialog box.

Note

• For details on the procedure for opening the Add and Edit Custom Paper dialog box, see "Using Paper Other than
Genuine Paper and Feed Confirmed Paper." →P.630
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2
 

Select the paper you want to edit from the Added Cus-
tom Paper list and then click the Edit button.

3
 

The View Settings dialog box is displayed.

Follow the on-screen directions and change the set-
tings as required.

Note

• Refer to Steps 5 to 15 of the "Add Custom Paper" →P.633  for details on how to configure each setting.

Export Custom Media InformationExport Custom Media Information
You can export to file and save media information about custom paper that you have added.
The saved Custom Media Information File can be used by importing it into another printer or PC. Refer to "Import Cus-
tom Media Information" →P.642  for details on "importing custom media information".

1 Open the Add and Edit Custom Paper dialog box.

Note

• For details on the procedure for opening the Add and Edit Custom Paper dialog box, see "Using Paper Other than
Genuine Paper and Feed Confirmed Paper." →P.630
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2
 

Select the paper you want to export to media informa-
tion file from the Added Custom Paper list and then
click the Export button.

Note

• You can select multiple paper.

3
 

Specify the location to save the Custom Media Informa-
tion File.

Note

• You can change the file name by selecting and editing the File.
A Custom Media Information File (.am1 file) is saved.

Import Custom Media InformationImport Custom Media Information
You can import a Custom Media Information File that has been saved in a folder, and add the file to the printer control
panel and to the printer driver of the PC you are using.

1 Open the Add and Edit Custom Paper dialog box.

Note

• For details on the procedure for opening the Add and Edit Custom Paper dialog box, see "Using Paper Other than
Genuine Paper and Feed Confirmed Paper." →P.630
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2
 

Click the Import button.

3
 

Select the Custom Media Information File (.am1 file) to
import.

4
 

The Confirm Update dialog box opens.
Click the Execute button.

Note

• You should normally select Update the printer control panel and printer driver.
The custom paper is added to the control panel of the printer and to the printer driver of the PC you are using.

• When the custom paper is correctly added to the printer driver, the name of the added custom paper is displayed in
the Edit Media Types dialog box that is opened by Add Genuine Paper in the Media Configuration Tool window.
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WarningsWarnings
Take note of the following warnings when added custom paper other than Canon genuine paper and feed confirmed
paper to the printer driver and the printer itself.

About the Cutter

• Depending on the paper, there are types that cannot be cut by the cutter unit, and types that speed deterioration of
the blade and cause damage to the cutter. For thick paper, hard paper, etc. do not use the cutter unit, and instead
cut the roll paper using scissors, etc. after printing. In this case, select User Cut as the Automatic Cutting Set-
tings in the Roll Paper Settings dialog box.

Note

• If the cutter is damaged, contact your Canon dealer for assistance.

• For details on the methods for cutting roll paper, see "Specifying the Cutting Method for Rolls." →P.546

About the Printhead

• If the printhead rubs against the paper during printing, this may cause damage to the printhead. If the printhead is
rubbing against the paper, configure the Vacuum Strength in the Step 5: Configure the amount of ink used
dialog box as follows.

• For paper-based media such as Heavyweight Coated Paper: Set to Strong or Strongest
• For film-based media such as CAD Tracing Paper: Set to Standard, Strong, or Strongest
• For thin paper of thickness 0.1mm or less: Set to Weakest

Note

• If the printhead still rubs even after changing the Vacuum Strength, set the Head Height to be higher in the Step 5: Config-
ure the amount of ink used dialog box.

• For details on how to handle the printhead rubbing against the paper, see "Paper rubs against the printhead." →P.889

About Borderless Printing

• When performing borderless printing on paper where the ink does not dry well, the cutter unit may leave scratches
where it touches the printed surface, or may not cut correctly. In this kind of situation, configure the amount of time
to wait for the ink to dry after printing using Drying Time in the Roll Paper Settings dialog box.
Alternatively, if the paper cannot be cut well by the cutter, set the Automatic Cutting Settings to User Cut in the
Roll Paper Settings dialog box, and cut the roll paper using scissors, etc.

About the Print Quality

• If the edges of images are blurry, set the Vacuum Strength to be weaker in the Step 5: Configure the amount of
ink used dialog box.

• If lines are warped or scratched, set the Head Height to be lower in the Step 5: Configure the amount of ink
used dialog box.

• If the amount of ink used is too much, wrinkles may appear and the ink may bleed in the printed material. Further-
more, if the amount of ink used is too little, color production may be poor and lines may become scratched. In this
kind of situation, change the amount of ink used in the Step 5: Configure the amount of ink used dialog box.

• If horizontal bands with different color tone appear in the printed material, execute Paper Feed Adjustment in the
Step 4: Paper feed adjustment dialog box. If you have already executed Paper Feed Adjustment, execute Adj.
Fine Feed from the printer control panel and fine tune the amount of paper feed.

Note

• For details on Adj. Fine Feed, see "Fine-Tuning the Paper Feed Amount." →P.809

• If horizontal bands appear even after executing Adj. Fine Feed, refer to "Banding in different colors occurs" in "Trouble-
shooting".  (See "Banding in different colors occurs.") →P.891
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• If you cannot obtain sufficiently high print quality, change the maximum ink usage, or change the media type used
as the basis for the custom paper in the Step 1: Select the standard paper dialog box.

• If there is no luster in printed material, set the paper used as the basis for the custom paper to a paper that uses
photo ink as the Black ink.
The types of Black ink used are displayed on the right side of each media type in the Step 1: Select the standard
paper dialog box.

Note

• For details on problems with printing quality, see "Problems with the printing quality." →P.888

About the Color Tone

• The color tone cannot be configured using the Media Configuration Tool. If the color tone needs to be adjusted,
provide an ICC color profile that matches the paper you are using, and select that ICC color profile in your soft-
ware. For details on how to specify the ICC color profile in the printer driver, see "Matching Sheet." →P.189

• Custom paper cannot be used with the ambient light adjustment function or Monitor Matching in Color-Matching
Method.
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Control PanelControl Panel

a Display Screen
Shows printer menus, as well as the printer status and messages.

b Data Lamp (green)

• Flashing
During printing, the Data lamp flashes when the printer is receiving or processing print jobs. Otherwise, this
lamp flashes when the print job is paused or the printer is updating the firmware.

• Off
There are no active print jobs when the Data lamp is off.

c Message Lamp (orange)

• On
A warning message is displayed.

• Flashing
An error message is displayed.

• Off
The printer is off or is operating normally.

d Menu button
Displays the Tab Selection screen.  (See "Menu Settings.") →P.667

e Arrow buttons

• ◀ button
Press this button on the Tab Selection screen to move to another tab.
In menu items requiring numerical input, press this button to move to another digit.
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• ▲ button
Press this button when viewing menus to display the next menu item or setting value.

• ▶ button
Press this button on the Tab Selection screen to move to another tab.
In menu items requiring numerical input, press this button to move to another digit.

• ▼ button
Press this button when viewing menus to display the next menu item or setting value.

f OK button
Press this button on the Tab Selection screen to display the menu of the tab shown.
Pressing this button in menu items of each tab for which  is displayed at left will move to the lower level of the
menu item, enabling you to execute menu commands or set menu values.
Also press this button if the Display Screen indicates to press the OK button.

g Stop button
Cancels print jobs in progress and ends the ink drying period.

h Power button (green)
Turns the printer on and off.  (See "Turning the Printer On and Off.") →P.21

The Power button is lit when the printer is on or in Sleep mode.

i Navigate button
Enables you to check instructions for loading and removing paper or replacing ink tanks or printheads, as well as
other operations.  (See "How to View Instructions With Navigate.") →P.653

j Back button
Displays the screen before the current screen.

k Cut button
Pressing this button when rolls are loaded cuts the paper, if you have specified Automatic or Eject in Cutting
Mode in the Control Panel menu.  (See "Specifying the Cutting Method for Rolls.") →P.546

l Feed button
Pressing this button when rolls are loaded enables you to reposition the paper.  (See "Feeding Roll Paper Manual-
ly.") →P.543

m Load button
Press this button when loading or replacing paper.
 (See "Loading Rolls in the Printer.") →P.533

 (See "Loading Sheets in the Printer.") →P.555

n Roll Media lamp (green)
Lit when rolls are selected as the paper source.

o Cut Sheet lamp (green)
Lit when sheets are selected as the paper source.

Note

• To recover from Sleep mode, any button can be pressed on the Control Panel.

Control Panel DisplayControl Panel Display
After the printer starts up, the Tab Selection screen is displayed.
Each of the four tabs presents status, menus, and error information related to the particular tab.

iPF9400                                                                                                                                                                                                          Control Panel Display

User's Guide                                                                                                                                                                                                                                       

  

C
ontrol Panel

O
perations and D

isplay Screen

649  



Types of tabs
The Tab Selection screen presents four tabs. Each tab is represented by an icon in the top row. Press the ◀ or ▶
button to access other tabs.

Paper tab A tab indicating status and showing menus related to paper. Pressing the OK button when this tab is highlighted
will display the Paper Menu.

• Top line displayed
The paper icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu names.

• Bottom line displayed
The first and second lines display the paper type and size.

Ink tab A tab indicating status and showing menus related to ink. Pressing the OK button when this tab is highlighted
will display the Ink Menu.

• Top line displayed
The ink icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu names.

• Bottom line displayed
Here, the remaining ink level is indicated.  (See "Checking Ink Tank Levels.") →P.836

Job tab A tab indicating status and showing menus related to print jobs. Pressing the OK button when this tab is high-
lighted will display the Job Menu menu.

• Top line displayed
The job icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu names.

Settings/Adj. tab A tab indicating status and showing menus related to settings and adjustment. Pressing the OK button when
this tab is highlighted will display the Set./Adj. Menu.

• Top line displayed
The settings/adjustment icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu names.

• Bottom line displayed
The remaining Maintenance Cartridge capacity is shown on the first line and Tot.Print Area on the second.
The display unit for Tot.Print Area can be specified in the Length Unit menu.  (See "Menu Settings.")
→P.667

Printer status and modes
Printer status is classified according to the following five modes.
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Standby The printer is ready to receive jobs sent from the computer. Jobs sent from the computer are printed immediate-
ly.

Printing Paused Printing is paused on the printer. Any jobs sent from the computer are held without being printed.

Printing Printing is in progress on the printer. Jobs sent from the computer are printed after the current job. The time left
until printing is finished is indicated in the upper-right corner of the screen. (Values exceeding 10 hours are not
shown.)

Sleep The printer is in power-saving mode. The printer automatically enters Sleep mode to conserve power when idle
for a specific period (by default, five minutes), that is, if no print jobs are received or buttons are pressed while
all covers are closed.
You can specify the period before the printer enters Sleep mode in the Sleep Timer menu.  (See "Menu Set-
tings.") →P.667
After entering Sleep mode from Standby mode, the printer automatically recovers if print jobs are received, and
the jobs are printed.

Error The printer requires your attention. Any jobs sent from the computer cannot be processed. The tab related to
the error is displayed.
For information about the display in the case of multiple errors, see "Display Transitions in Error Status."
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Display Transitions in Normal Status
The display transitions while the printer is in the normal status (the status where no errors have occurred) are shown
below.

*1: The printer automatically enters Sleep mode when idle for a specific period (by default, five minutes), that is, if no
print jobs are received or buttons are pressed while all covers are closed. However, it does not enter Sleep mode
while error messages are displayed or when a roll can be manually advanced by pressing the Feed button.

*2: When the printer is in Sleep mode, you can press any button except the Power button to recover from Sleep mode.
Sleep mode is also terminated if a print job is received or a command is issued from RemoteUI.

Display Transitions in Error Status
The display transitions while an error has occurred on the printer are shown below.
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If multiple errors have occurred, the tabs for errors that have occurred other than the currently displayed error are dis-
played flashing. You can move between the tabs to check the errors by pressing the ◀ and ▶ keys. If multiple errors
have occurred in the Job tab and Settings/Adj. tab, the error message switches every four seconds within each tab.

How to View Instructions With NavigateHow to View Instructions With Navigate
You can refer to instructions for loading paper, replacing ink tanks, and performing other operations on the printer con-
trol panel.

1 Press the Navigate button.

2 Press ▲ or ▼ to select the desired navigation menu.

3 Press ▲ or ▼ to select View Op. Guide, and then press the OK button.
Instructions are now displayed.

iPF9400                                                                                                                                                                              How to View Instructions With Navigate

User's Guide                                                                                                                                                                                                                                       

  

C
ontrol Panel

O
perations and D

isplay Screen

653  



  Example: Loading sheets

How to View Instructions With Navigate                                                                                                                                                                              iPF9400

                                                                                                                                                                                                                                       User's Guide

  

C
ontrol Panel

O
perations and D

isplay Screen

 654



Checking Instructions During Printer OperationsChecking Instructions During Printer Operations
You can refer to instructions on the printer control panel when loading paper, replacing ink tanks, or performing other
operations.

How to view instructions
Once you complete an action described in the instructions, the printer detects the action and switches to the next in-
struction screen.
 

In the case of actions the printer cannot detect, instruction screens are switched every four seconds, and the sequence
of operations is shown repeatedly.
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When all actions in the sequence are finished, the instruction screen for the next step is displayed.
  Example: Ink tank replacement

Note

• During a continuous display of instructions, you can press the ◀ button to pause the instructions on the current screen.
Press the ◀ or ▶ button to display the previous or next screens. If you do not press the ◀ or ▶ button within 30 seconds,
continuous display is resumed.
Press the OK button to display the instruction screen for the next step.
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Printer MenuPrinter Menu
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Status Print ......................................................................................................................................................... 676
Printing Interface Setting Reports ...................................................................................................................... 679

Printer Menu OperationsPrinter Menu Operations
The printer menu is classified into regular menu items available when no print job is in progress and menu during print-
ing items only available while printing is in progress.

• Regular menu operations →P.657
• Menu operations during printing →P.657

Regular menu operations
To view available menus organized on tabs, select a tab on the Tab Selection screen and press the OK button.

Note

• If the Tab Selection screen is not displayed, pressing OK will not display menus.
Menus can be selected after you resolve the problem.

The following operations are available from the menu.

• Paper Menu
Paper menu settings

• Ink Menu
Ink menu operations

• Job Menu
Menu operations to manage print jobs

• Set./Adj. Menu
Menu operations for printer adjustment and maintenance

For a description of specific menu items available, see "Menu Settings." →P.667
For instructions on selecting menu items, see "Menu Operations." →P.658

Note

• By default, menu settings apply to all print jobs. However, for settings that are also available in the printer driver, the values
specified in the printer driver take priority.

Menu operations during printing
During printing, only a limited set of menu items are displayed. Menu items that are not displayed during printing should
be operated after printing has finished.
To display menus during printing, select a tab on the Tab Selection screen on the Control Panel, and then press the
OK button.

Note

• If the Tab Selection screen is not displayed, pressing OK will not display menus.
Menus can be selected after you resolve the problem.

The following operations are available from the menu during printing.

• Ink Menu
Ink menu operations

• Job Menu
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Menu operations to manage print jobs

• Set./Adj. Menu
Fine-tuning paper feeding
Display of printer-related information

For a description of specific menu items available, see "Menu Settings." →P.667
For instructions on selecting menu items during printing, see "Menu Operations." →P.658

Menu OperationsMenu Operations
To view available menus organized on tabs, select a tab on the Tab Selection screen and press the OK button. For
details, see "Menu Settings." →P.667

• Menus (when the Ink tab is selected and the OK button is pressed)

Note

• If the Tab Selection screen is not displayed, press the Menu button.

Simply press buttons on the Control Panel to access menus on various tabs from the Tab Selection screen and set or
execute Menu items.
The following section describes menu operations.

• Accessing menus →P.658
• Specifying menu items →P.659
• Specifying numerical values →P.660
• Executing menu commands →P.660

Accessing menus
Printer menus are grouped by function.
Menus are displayed with the upper line selected. You can use the buttons on the Control Panel to access each menu.
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• Press Back to access a higher menu in the menu list, and press OK to access a lower one. If not all menu items
are displayed, hold down ▲ or ▼ to scroll through higher and lower menu items. Items you select are highlighted.

The scroll bar at right indicates the current position in the overall menu.

• Lower menus are available if  is displayed at left next to the second and subsequent rows. To access the lower
menus, select the menu and press the OK button.

Specifying menu items
Menu items can be set as follows.

1
 

Press ▲ or ▼ to select the desired setting, and then press the OK button.
After two seconds, the display reverts to the upper level menu.

Note

• If a confirmation message is displayed regarding the setting you entered, press the OK button. The setting is applied,
and the printer is now in Standby.
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Specifying numerical values
Follow these steps to enter numbers. In this example, network settings items are entered.

1
 

Press the ◀ or ▶ button to move to the next field for input.

2 Press the ▲ or ▼ button to enter the value.

Note

• Hold down ▲ or ▼ to increase or decrease the value continuously.

3 Repeat steps 1 and 2 to complete the settings, and then press the OK button.

Note

• If a confirmation message is displayed regarding the setting you entered, press the OK button. The setting is applied,
and the printer is now in Standby.

Executing menu commands
Menu commands can be executed as follows.

1 Press ▲ or ▼ to select the action to execute, and then press the OK button.
The menu command is now executed.
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Menu StructureMenu Structure
The menu structure is shown categorized by tab. The * on the right side of an item indicates the default value.
The printer menu is classified into regular menu items available when no print job is in progress and menu during print-
ing items only available while printing is in progress. see "Printer Menu Operations." →P.657

Regular menu Menu during printing
Paper Menu Not displayed

Ink Menu The same Ink Menu as normal is displayed.

Job Menu The same Job Menu as normal is displayed.

Set./Adj. Menu A limited Set./Adj. Menu containing the following items is displayed.

• Adj. Fine Feed (*1)
• Printer Info

*1: Only displayed in the menu during printing. Not displayed in the regular menu.

For instructions on menu operations, see "Menu Operations." →P.658
For details on menu items, see "Menu Settings." →P.667

 Paper Menu
The Paper Menu is not displayed during printing.

 First Level  Second Level  Third Level  Fourth Level  Fifth Level

Load Paper Roll Paper ┋ Cut Sheet
Eject Paper
Chg. Paper Type (*1) Roll Paper (The paper type is displayed here.) (*1)

  Cut Sheet (The paper type is displayed here.) (*1)
Chg. Paper Size Sheet Size (The size of paper is displayed here.) (*2)

    CustomPaperSize (Set the length and width)
  Roll Length (*3) (Set the length)
  Roll Width (*4) (Set the width)

ManageRemainRoll Off *┋ On
Paper Details (The paper type is dis-

played here.) (*1)
Head Height Automatic *┋ Highest ┋ High ┋ Standard ┋ Low ┋

Lowest ┋ Super Low
   Skew Check Lv. Standard *┋ Loose ┋ Off
   Cutting Mode (*6) Automatic ┋ Eject ┋ Manual
   Cut Speed Fast ┋ Standard ┋ Slow
   Trim Edge First Automatic ┋ Off ┋ On (Preset Len) ┋ On(Input

Length) ┋ Manual
   CutDustReduct. Off ┋ On
   VacuumStrngth Automatic *┋ Strongest ┋ Strong ┋ Standard ┋

Weak ┋ Weakest
   Roll Tension High ┋ Standard
   Scan Wait Time Dry time Off *┋ 1 sec. ┋ 3 sec.

┋ 5 sec. ┋ 7 sec. ┋ 9
sec.

     Area (*5) Entire area *┋ Leading
edge

   Roll DryingTime Off ┋ 30 sec. ┋ 1 min. ┋ 3 min. ┋ 5 min. ┋ 10
min. ┋ 30 min. ┋ 60 min.

   NearEnd RollMrgn 5mm ┋ 20mm
   NearEnd Sht Mrgn 5mm ┋ 20mm
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 First Level  Second Level  Third Level  Fourth Level  Fifth Level
   BordlessOversize Standard *┋ Little
   Width Detection Off ┋ On *
   Return Defaults

Paper Details
Keep Paper Type Off *┋ On

*1: For information on the types of paper the printer supports, refer to the Paper Reference Guide. (See Paper Reference Guide.) Types of
paper in the printer driver and related software (as well as on the Control Panel) are updated when you install the printer driver from
the User Software CD-ROM or if you update paper information with the Media Configuration Tool.  (See "Updating paper information.")
→P.528

*2: For information on the sizes of paper the printer supports, see "Paper Sizes." →P.522

*3: Available only if ManageRemainRoll is On.
*4: Available only if Width Detection is Off.
*5:  Leading edge is not available as a setting option in the Paper Detailed Settings dialog box of the printer driver.
*6: see "Specifying the Cutting Method for Rolls." →P.546

 Ink Menu

 First Level

Rep. Ink Tank
Head Cleaning A

 Job Menu

 First Level  Second Level  Third Level  Fourth Level  Fifth Level

Print Job Job List (Choose a print job.) Delete ┋ Preempt Jobs (*1)
Stored Job Mailbox List (Enter a password if one

has been set.)
Job List Print ┋ Delete

    Print Job List
Job Log (Choose from information

about the latest three print
jobs.)

Document Name
   User Name
   Page Count
   Job Status OK ┋ CANCELED
   Print Start Time yyyy/mm/dd hh:mm:ss
   Print End Time yyyy/mm/dd hh:mm:ss
   Print Time xxxsec.
   Output Img. Size (The image size is displayed)
   Media Type
   Paper Consumed
   Paper Length
   Paper Width
   Interface USB ┋ Network ┋ HDD
   Ink Consumed Tot.Ink Consumed xxx.xxx ml
     (The ink color is dis-

played here.)
xxx.xxx ml

   Print settings
   Head Height
   Temp./Humidity
   Adjustment req.
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 First Level  Second Level  Third Level  Fourth Level  Fifth Level

Print Job Log
Pause Print Off *┋ On
HDD Information Total capacity ┋ Box free space

*1: If a pending job is selected, Print Anyway is displayed.

 Set./Adj. Menu
Limited items are displayed during printing. The displayed items are indicated by annotations.

 First Level  Second Level  Third Level  Fourth Level  Fifth Level  Sixth Level  Seventh Level

Test Print Nozzle Check ┋ Status Print ┋ Interface Print ┋ Paper Details ┋ Print Job Log ┋ Menu Map
Adjust Printer Head Posi. Adj. Standard

    Simple
    Other Initial adjustmt ┋ Manual (*1)
  Feed Priority Adj. Priority Automatic *┋ Print Quality ┋ Print Length
    Adj. Quality (*2) Auto(GenuinePpr) ┋ Auto(OtherPaper) ┋ Manual
    Adjust Length

(*3)
Adjustment-
Print

A:High ┋ B:Standard/Draft

     Change Set-
tings

A:High ┋ B:Standard/Draft

  Calibration Auto Adjust
   Calibration Log Date ┋ Paper Type ┋ Adjustment Type
   Use Adj. Value Disabled ┋ Enabled *
   Set Exec.

Guide
Off *┋ On

   Return Defaults
Maintenance Head Cleaning Head Cleaning A ┋ Head Cleaning B

  Nozzle Check
  Replace

P.head
Printhead L ┋ Printhead R ┋ L & R Printheads

  Repl. maint cart
  Head Info Printhead L ProductName: ┋ s/n: ┋ Days elapsed: ┋ Count [Mdot]:
    Printhead R ProductName: ┋ s/n: ┋ Days elapsed: ┋ Count [Mdot]:
  Repl. S. Cleaner
  Change Cutter

Interface Setup
(*8)

EOP Timer (*8) 10 sec. ┋ 30 sec. ┋ 1 min. ┋ 2 min. ┋ 5 min. ┋ 10 min. *┋ 30 min. ┋ 60 min.
  TCP/IP (*8) IPv4 (*8) IPv4 Mode (*8) Automatic ┋ Manual *
      Protocol (*4)

(*8)
DHCP (*8) On ┋ Off *

        BOOTP (*8) On ┋ Off *
        RARP (*8) On ┋ Off *
      IPv4 Settings IP Address (*9) xxx.xxx.xxx.xxx
        Subnet Mask

(*9)
xxx.xxx.xxx.xxx

        Default G/W (*9) xxx.xxx.xxx.xxx
      DNS Settings

(*9)
DNS Dync up-
date (*9)

On ┋ Off *

       Pri. DNS SrvAddr (*9)
       Sec. DNS SrvAddr (*9)
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 First Level  Second Level  Third Level  Fourth Level  Fifth Level  Sixth Level  Seventh Level
       DNS Host Name (*9)
       DNS Domain Name (*9)
    IPv6 (*8) IPv6 Support

(*8)
On ┋ Off *

     IPv6 Stles-
sAddrs (*8)
(*10)

On *┋ Off

     DHCPv6 (*8)
(*10)

On ┋ Off *

     DNS Settings
(*9)(*10)

DNS Dync up-
date (*9)

Statefull Addr
(*9)

On ┋ Off *

        Stateless Addr
(*9)

On ┋ Off *

      Pri. DNS SrvAddr (*9)
      Sec. DNS SrvAddr (*9)
      DNS Host Name (*9)
      DNS Domain Name (*9)
  NetWare (*8) NetWare (*8) On ┋ Off *
    Frame Type

(*5)(*8)
Auto Detect ┋ Ethernet 2 ┋ Ethernet 802.2 *┋ Ethernet 802.3 ┋
Ethernet SNAP

    Print Service
(*5)(*8)

BinderyPServer ┋ RPrinter ┋ NDSPServer *┋ NPrinter

  AppleTalk (*8) On ┋ Off *
  Ethernet Driver

(*8)
Auto Detect
(*8)

On *┋ Off

    Comm.Mode
(*6)(*8)

Half Duplex *┋ Full Duplex

    Ethernet Type
(*6)(*8)

10 Base-T *┋ 100 Base-TX ┋ 1000 Base-T

    Spanning Tree
(*8)

Not Use *┋ Use

    MAC Address
(*8)

xxxxxxxxxxxx

  Interface Print (*8)
  Return Defaults (*8)

System Setup Sleep Timer
(*11)

5 min. *┋ 10 min. ┋ 15 min. ┋ 20 min. ┋ 30 min. ┋ 40 min. ┋ 50 min. ┋ 60 min.
┋ 210 min.

  Shut Down
Timer

Off ┋ 5 min. ┋ 10 min. ┋ 30 min. ┋ 1 hour ┋ 4 hours ┋ 8 hours *┋ 12 hours

  Buzzer Off ┋ On *
  Contrast Adj. -4,-3,-2,-1,0*,+1,+2,+3,+4
  Date & Time

(*8)
Date
 

yyyy/mm/dd
(*7)(*8)

Time
 

hh:mm

  Date Format
(*8)

yyyy/mm/dd *┋ dd/mm/yyyy ┋ mm/dd/yyyy

  Language English┋日本語┋Français┋Italiano┋Deutsch┋Español┋Русский┋中文（簡体字）
┋한국어
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 First Level  Second Level  Third Level  Fourth Level  Fifth Level  Sixth Level  Seventh Level
  Time Zone (*8) 0:London (GMT) ┋ +1:Paris,Rome ┋ +2:Athens,Cairo ┋ +3:Moscow ┋ +4:Eere-

van,Baku ┋ +5:Islamabad ┋ +6:Dacca ┋ +7:Bangkok ┋ +8:Hong Kong ┋ +9:To-
kyo,Seoul ┋ +10:Canberra ┋ +11NewCaledonia ┋ +12:Wellington ┋ -12:Eniwetok
┋ -11:Midway is. ┋ -10Hawaii(AHST) ┋ -9:Alaska(AKST) ┋ -8:Oregon (PST) ┋
-7:Arizona(MST) ┋ -6:Texas (CST) ┋ -5:NewYork(EST) ┋ -4:Santiago ┋ -3:Bue-
nos Aires ┋ -2: ┋ -1:Cape Verde

  Length Unit meter *┋ feet/inch
  Detect Mis-

match
Pause ┋ Warning ┋ None *┋ Hold Job

  Paper Size Ba-
sis

Sht Selection 1 ISO A3+ *┋ 13"x19"(Super B)
    Sht Selection 2 ISO B1 *┋ 28"x40" (ANSI F)
  Keep Paper

Size
Off *┋ On

  Rep.P.head
Print

Off ┋ On *

  Nozzle Check Frequency Standard *┋ 1 page
    Warning Off *┋ On
  CarriageS-

canWdth
Automatic *┋ Fixed

  Use RemoteUI
(*8)

On *┋ Off

  Reset PaprSetngs (*8)
  Erase HDD Da-

ta
High Speed (*8)┋ Secure High Spd. (*8)┋ Secure (*8)

  Output Method Print *┋ Print (Auto Del) ┋ Save: Box XX
  Print After Recv Off *┋ On
  Common Box

Set. (*4)(*8)
Print *┋ Print (Auto Del)

  Show Job Log
(*8)

Off ┋ On *

Take-up Reel
(*12)

Use Take-up
Reel

Disable *┋ Enable

  Auto Feed (*13)
  Skip Take-Up

Err (*14)
Off *┋ On

Prep.Move-
Printer

Level 1 ┋ Level 2 ┋ Level 3

Admin. Menu
(*9)

Change Pass-
word (*9)

(The screen for setting the password is displayed)

  Init.Admin.Pswd (*9)
Adj. Fine Feed (*15)(*16)
Printer Info
(*15)

Paper Info
 Ink Info
 Head Info ProductName:
   s/n:
   Days elapsed:
   Count [Mdot]:
   Printhead L ProductName: ┋ s/n: ┋ Days elapsed: ┋ Count [Mdot]:
   Printhead R ProductName: ┋ s/n: ┋ Days elapsed: ┋ Count [Mdot]:
 System Info
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 First Level  Second Level  Third Level  Fourth Level  Fifth Level  Sixth Level  Seventh Level

 Error Log
 Other Counter

*1: Available after you have used Standard or Initial adjustmt in Head Posi. Adj. once.
*2: Available if Adj. Priority is Automatic or Print Quality.
*3: Available if Adj. Priority is Automatic or Print Length.
*4: Not displayed if IPv4 Mode is Manual.
*5: Not displayed if NetWare is Off.
*6: Not displayed if Auto Detect is On.
*7: Follows the setting in Date Format.
*8: Viewing and configuration is possible for administrators, and only viewing for other users.
*9: Viewing and configuration is possible for administrators only.
*10: Not displayed if IPv6 Support is Off.
*11: Default setting for the time to enter the power save mode/Sleep mode is recommended.
*12: Displayed only when the Media Take-up Unit is attached.
*13: Available if: (a) Use Take-up Reel is Enable, (b) roll paper is loaded, and (c) you have not executed Auto Feed for the loaded roll.
*14: Available when Use Take-up Reel is Enable.
*15: Displayed as the menu during printing while printing is in progress.
*16: Not displayed in the regular menu.
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Menu SettingsMenu Settings
Menu items are as follows.
The printer menu is classified into regular menu items available when no print job is in progress and menu during print-
ing items only available while printing is in progress. see "Printer Menu Operations." →P.657

Regular menu Menu during printing
Paper Menu Not displayed

Ink Menu The same Ink Menu as normal is displayed.

Job Menu The same Job Menu as normal is displayed.

Set./Adj. Menu A limited Set./Adj. Menu containing the following items is displayed.

• Adj. Fine Feed (*1)
• Printer Info

*1: Only displayed in the menu during printing. Not displayed in the regular menu.

For instructions on selecting menu items, see "Menu Operations." →P.658
For details on the displayed menu hierarchy, see "Menu Structure." →P.661

Paper Menu
The Paper Menu is not displayed during printing.

Setting Item Description, Instructions
Load Paper Select either sheets or rolls and load the paper.

Eject Paper Choose this item before removing loaded paper.

Chg. Paper Type (*1) Change the type of paper loaded.  (See "Changing the Type of Paper.")
→P.537

Chg. Paper Size Change the size of paper loaded.  (See "Specifying the Paper Length.")
→P.539  (See "Paper Sizes.") →P.522

ManageRemainRoll Choose On to print a barcode at the end of a roll before you remove it.
The printed barcode can be used in managing the amount of roll paper
left. Choose Off if you prefer not to print the barcode.
 (See "Keeping Track of the Amount of Roll Paper Left.") →P.544

Paper Details (The type of paper
is displayed here.)
(*1)

Head Height Adjust the Printhead height.  (See "Troubleshooting Paper Abrasion and
Blurry Images.") →P.803

Skew Check Lv. If you print on Japanese paper (washi) or other handmade paper that
has an irregular width, choose Loose for a higher skew detection
threshold, or choose Off to disable skew detection. However, if paper is
loaded askew when detection is Off, note that paper jams or Platen
soiling may occur.

Cutting Mode Specify whether or not to cut with the standard round-bladed cutter.
If you choose Automatic, the roll will be cut automatically using the
Cutter Unit, depending on the printer driver settings.
Select Eject to prevent printed documents from falling immediately after
printing such as when you wait for the ink to dry, etc. Manual prints
lines at the cut position instead of cutting after printing. If you select
Manual, the setting screen for detection of the paper leading edge is
displayed.
 (See "Specifying the Cutting Method for Rolls.") →P.546

Cut Speed Choose the cutting speed. The preset selection represents the optimal
cutting speed for the type of paper. We recommend keeping the preset
cutting speed.
If you use adhesive paper, choosing Slow helps prevent adhesive from
sticking to the cutter and keeps the cutter sharp.
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Setting Item Description, Instructions
Paper Details (The type of paper

is displayed here.)
(*1)

Trim Edge First Selects whether or not to automatically cut the leading edge of the roll
paper when roll paper is loaded.
 (See "Cutting the Leading Edge of Roll Paper Automatically.") →P.552

CutDustReduct. If you choose On, a line will be printed at the cut position when paper
cutting is selected. This option reduces the amount of debris given off
after cutting. It also helps prevent adhesive from sticking to the cutter
and keeps the cutter sharp if you use adhesive paper.  (See "Reducing
Dust from Cutting Rolls.") →P.554

VacuumStrngth Specify the level of suction that holds paper against the Platen.  (See
"Adjusting the Vacuum Strength.") →P.811

Roll Tension Adjust the slack of the roll paper loaded in the printer.
If there is slack in thin roll paper and the paper is becoming scratched,
or wrinkles or creases are occurring, set this to High to make it harder
for slack to occur, and reduce the amount of scratches, etc.
If you change the Roll Tension setting, We recommend that you per-
form Adj. Quality.  (See "Automatic Banding Adjustment.") →P.806

Scan Wait Time Specify the time to wait for the ink to dry between each scan (after the
printhead finishes moving in one direction), in consideration of how
quickly the ink dries. Also specify the applicable area for the ink drying
time. Select Entire area to apply the ink drying time after each scan un-
til the document is fully printed. Select Leading edge to apply the ink
drying time after each scan only in the area 110–160 mm from the lead-
ing edge. (The applicable length varies depending on the Print Quality
setting.) Note that printing will take longer if you specify the Scan Wait
Time setting. In particular, when Leading edge is selected, colors may
be uneven in the boundary between the areas with and without a drying
time.

Roll DryingTime Specify the time to wait for the ink to dry for each sheet.

NearEnd RollMrgn Specify the minimum margin at the leading edge of roll paper to ensure
better printing quality at the leading edge.
Note that if you choose 5mm, it may lower the printing quality at the
leading edge and affect feeding accuracy. The printed surface may be
scratched, and ink may adhere to the leading edge. It may also cause
the Platen to become soiled.

NearEnd Sht Mrgn Specify a margin at the leading edge of sheets to ensure better printing
quality at the leading edge.
Note that if you choose 5mm, it may lower the printing quality at the
leading edge and affect feeding accuracy. The printed surface may be
scratched, and ink may adhere to the leading edge.

"BordlessOver-
size"

Select the amount of oversize extension of the original during border-
less printing.
Normally, we recommend that you set this to Standard.
If it is set to "Little", although it will reduce soiling on the back surface,
white patches may remain on the printed surface.

Width Detection Specify this option to print inside boundaries or in other cases when
specifying a particular starting position for printing.
Paper width and skew are not detected if you select Off. If paper is loa-
ded askew, paper jams or Platen soiling may occur.

Return Defaults Choose OK to restore Paper Details to the default values.

Paper Details Print the paper settings as specified in Paper Details.

Keep Paper Type Select On when printing on a particular type of paper regularly.  (See
"Changing the Type of Paper.") →P.537
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*1: For information on the types of paper the printer supports, refer to the Paper Reference Guide. (See Paper Reference Guide.) Types of
paper in the printer driver and related software (as well as on the Control Panel) are updated when you install the printer driver from the
User Software CD-ROM or if you update paper information with the Media Configuration Tool.  (See "Updating paper information.")
→P.528

Ink Menu
Setting Item Description, Instructions

Rep. Ink Tank Replace the Ink Tank at this point. Follow the instructions displayed
to complete the required procedure.  (See "Replacing Ink Tanks.")
→P.826

Head Cleaning A Printhead cleaning options.  (See "Cleaning the Printhead.")
→P.839

Execute Head Cleaning A if printing is faint, oddly colored, or con-
tains foreign substances.

Job Menu
Setting Item Description, Instructions

Print Job Job List (Choose a
print job)

Delete Delete the current job or queued jobs.  (See "Managing the Job
Queue (Deleting or Preempting Other Jobs).") →P.759

Preempt Jobs Print the job first after the current print job is finished.  (See "Manag-
ing the Job Queue (Deleting or Preempting Other Jobs).") →P.759

Stored
Job

Mailbox
List

(Enter a
password
if one has
been set.)

Job List Print Print the saved job.

Delete Delete the saved job.

Print Job List Print a list of saved print jobs.

Job Log (Choose
from infor-
mation
about the
last three
print jobs.)

Document Name Indicates the document name of the selected print job.

User Name Indicates the name of the user who sent the print job.

Page Count Indicates the number of pages in the job.

Job Status Indicates the printing results.

Print Start Time Indicates when the print job was started.

Print End Time Indicates when the print job was finished.

Print Time Indicates the time required to print the job.

Output Img. Size Indicates the image size in the print job.

Media Type Indicates the type of paper in the print job.

Paper Consumed Indicates the total amount of paper consumed.

Paper Length Indicates the length of paper.

Paper Width Indicates the width of paper.

Interface Indicates the interface used for the print job.

Ink Consumed Indicates a rough estimate of how much ink was consumed per job.
(*1)

Print settings A counter for maintenance purposes. Indicates job print settings.

Head Height A counter for maintenance purposes. Indicates the head height when
jobs wereprinted.

Temp./Humidity A counter for maintenance purposes. Indicates the temperature and
humiditywhen jobs were printed.

Adjustment req. A counter for maintenance purposes. Indicates adjustment condi-
tions appliedto jobs.
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Setting Item Description, Instructions
Print Job Log Print a record of print jobs, including the paper type and size, amount

of ink consumed, and so on. Ink consumption indicates a rough esti-
mate of the amount of ink consumed per print job.(*1)

Pause Print Choose On to stop printing.

HDD Information Indicates the total hard disk capacity and the mail box free space.

*1: A rough estimate of the amount of ink consumed per print job is displayed. Actual ink consumption may be different. The average margin
of error for estimates calculated according to Canon measurement conditions for ink costs is ±15%. Canon does not guarantee the
accuracy of these estimates. Estimates may vary depending on conditions of use. Calculation of these estimates does not include ink
consumed when cleaning printheads by forceful ejection of ink.

Set./Adj. Menu
Limited items are displayed during printing. The displayed items are indicated by annotations.

Setting Item Description, Instructions
Test
Print

Nozzle Check Print a test pattern to check the nozzles.

Status Print Print information about the setting values and condition of the
printer.

Interface Print Print interface settings information.

Paper Details Print the paper settings as specified in Paper Details.

Print Job Log Print a record of print jobs, including the paper type and size,
amount of ink consumed, and so on. Ink consumption indicates
a rough estimate of the amount of ink consumed per print job.
(*1)

Menu Map Print the menu structure.

Adjust
Printer

Head
Posi.
Adj.

Standard An adjustment pattern is printed and the print position is auto-
matically adjusted to fix misaligned printing. Select Standard if
vertical lines in printed material are warped or colors are out of
alignment. Select Standard also if the printing results are not
improved by executing Simple.  (See "Automatic Adjustment to
Straighten Lines and Colors.") →P.798

Simple An adjustment pattern is printed and the print position is auto-
matically adjusted to fix misaligned printing. Simple executes a
simple adjustment in a short time. Select Simple when fre-
quently adjusting the printhead, such as during daily mainte-
nance.  (See "Automatic Adjustment to Straighten Lines and Col-
ors.") →P.798

Other Initial adjustmt Printhead position adjustment is executed during the initial set-
up. If adjusting the printhead position has not been performed
such as due to an error during initial setup or the state of the
operating settings when replacing the printhead, select Initial
adjustmt.  (See "Adjustment When Installing the Printhead.")
→P.802

Manual Input the setting values from the adjustment pattern printing re-
sults and adjust the printing position to fix misaligned printing.
Normally, select Standard. However, when printing on special
paper, or if printing is not improved after Standard, try Manual.
 (See "Manual Adjustment to Straighten Lines and Colors.")
→P.800
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Setting Item Description, Instructions
Adjust
Printer

Feed Pri-
ority

Adj. Pri-
ority

Automatic Specify exact paper feeding, if desired. Normally, select Auto-
matic. Choose Print Quality for attractive printing. Choosing
Print Quality also makes banding less noticeable. Choose
Print Length if you prefer to feed the paper an exact amount.
However, note that slight banding may occur in the direction of
carriage scanning when Print Length is selected.

Print Quality
Print Length

Adj.
Quality

Auto(GenuinePpr) Specify this mode with paper identified in the Paper Reference
Guide.(See Paper Reference Guide.)
The printer prints and reads a test pattern for automatic adjust-
ment of the feed amount.  (See "Automatic Banding Adjust-
ment.") →P.806

Auto(OtherPaper) Specify this mode with paper not in the Paper Reference
Guide.(See Paper Reference Guide.)
The printer prints and reads a test pattern for automatic adjust-
ment of the feed amount. Note that this function takes more
time and consumes more ink than Auto(GenuinePpr).  (See
"Automatic Banding Adjustment.") →P.806

Manual Use this mode with highly transparent media or other paper for
which Auto(GenuinePpr) or Auto(OtherPaper) cannot be
used.
Print a test pattern for adjustment of the feed amount based on
the type of paper.  (See "Manual Banding Adjustment.")
→P.807

Adjust
Length

Adjust-
ment-
Print

A:High Print a test pattern for particular types of paper to compensate
for paper stretching or shrinkage, after which you enter the
amount of adjustment.  (See "Adjusting Line Length.")
→P.810

B:Standard/Draft

Change
Settings

A:High Displayed when you have selected Feed Priority > Adj. Prior-
ity > Print Length.
Adjustment relative to the amount of stretching or shrinkage of
the current paper.
Enter either the adjustment results from AdjustmentPrint or
the discrepancy that you measured (as a percentage).
For paper that tends to stretch, increase the feed amount by
choosing a higher adjustment value. For paper that tends to
shrink, decrease the feed amount by choosing a lower adjust-
ment value. (See "Adjusting Line Length.") →P.810

B:Standard/Draft

Calibra-
tion

Auto Adjust A test pattern for color calibration is printed and the adjustment
values are adjusted automatically.
 (See "Corrects slight differences in how colors appear (color cal-
ibration).") →P.820

Calibration Log The Date, Paper Type, and Adjustment Type for which color
calibration was executed are displayed on the Display Screen
where you can confirm them.
 

Common calibration and unique calibration are the Adjust-
ment Type of color calibration.
When paper is set in the printer, the history of effective color
calibration for the set paper is displayed.
When paper is not set in the printer, the latest history among
common calibration or unique calibration is displayed.
Also, a hyphen (-) is displayed when there are no execution re-
sults.
 (See "Corrects slight differences in how colors appear (color cal-
ibration).") →P.820
 (See "Paper that can be used in Color Calibration.") →P.822
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Setting Item Description, Instructions
Adjust
Printer

Calibra-
tion

Use Adj. Value Choose Disabled > OK if you prefer not to apply the color cali-
bration adjustment value in print jobs. However, printer driver
settings are given priority.
Choose Enabled > OK to apply the color calibration adjust-
ment value in print jobs. However, printer driver settings are
given priority.

"Set Exec. Guide" If you select On, a message is displayed on the control panel
at the timing recommended for executing color calibration.

Return Defaults Clear the color calibration adjustment value and the execution
log.

Mainte-
nance

Head Cleaning Clean the Printhead.  (See "Cleaning the Printhead.")
→P.839

Choose Head Cleaning A if printing is faint, oddly colored, or
contains foreign substances.
Choose Head Cleaning B if no ink is printed at all, or if printing
is not improved by Head Cleaning A.

Nozzle Check Print a test pattern to check the nozzles.

Replace P.head Execute when replacing the Printhead. Follow the instructions
displayed to complete the required procedure.  (See "Replacing
the Printhead.") →P.840
Not displayed during a warning message that the remaining
Maintenance Cartridge capacity is low.

Repl. maint cart Execute when replacing the Maintenance Cartridge. Follow the
instructions displayed to complete the required procedure.
 (See "Replacing the Maintenance Cartridge.") →P.852

Head In-
fo

Printhead L Indicates information about the printhead.

Printhead R
Repl. S. Cleaner Replace the Shaft Cleaner. Follow the instructions displayed to

complete the required procedure.  (See "Replacing the Mainte-
nance Cartridge.") →P.852

Change Cutter Replace the Cutter Unit. Follow the instructions displayed to
complete the required procedure.  (See "Replacing the Cutter
Unit.") →P.848
Once you replace the Cutter Unit, you can also reset the cut
counter.

Interface
Setup

EOP Timer Specify the timeout period before cancellation of print jobs that
cannot be received by the printer.

TCP/IP IPv4 IPv4 Mode Choose whether the printer IP address is configured automati-
cally or a static IP address is entered manually.

Protocol DHCP Specify the protocol used to configure the IP address automati-
cally.BOOTP

RARP
IPv4 Set-
tings

IP Address Specify the printer network information when using a static IP
address.
Enter the IP address assigned to the printer, as well as the net-
work subnet mask and default gateway.
The value that was automatically configured is displayed if you
have set IPv4 Mode to Automatic.

Subnet Mask
Default G/W

DNS Set-
tings

DNS Dync update Specify whether DNS server registration is updated automati-
cally.

Pri. DNS SrvAddr Specify the DNS server address.
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Setting Item Description, Instructions
Interface
Setup

TCP/IP IPv4 DNS Set-
tings

Sec. DNS SrvAddr Specify the DNS server address.

DNS Host Name Specify the DNS host name.

DNS Domain Name Specify the DNS domain name.

IPv6 IPv6 Support Specify whether to connect via IPv6.

IPv6 StlessAddrs Specify whether a IPv6 stateless address is used.

DHCPv6 Specify whether DHCPv6 settings are used.

DNS Set-
tings

DNS
Dync up-
date

Statefull
Addr

Specify whether DNS server registration is updated automati-
cally.

Stateless
Addr

Pri. DNS SrvAddr Specify the DNS server address.

Sec. DNS SrvAddr
DNS Host Name Specify the DNS host name.

DNS Domain Name Specify the DNS domain name.

NetWare NetWare Specify the NetWare protocol. To apply your changes, choose
Register Setting.

Frame Type Specify the frame type to use.

Print Service Choose the print service.

AppleTalk Specify whether to use the AppleTalk protocol. To apply your
changes, choose Register Setting.

Ethernet
Driver

Auto Detect Specify the communication method. To apply your changes,
choose Register Setting.
Choose On for automatic configuration of the LAN communica-
tion protocol. Choose Off to use settings values of
Comm.Mode and Ethernet Type.

Comm.Mode Choose the LAN communication method.

Ethernet Type Choose the LAN transfer rate.

Spanning Tree Choose whether spanning-tree packets are supported over the
LAN.

MAC Address Indicates the MAC address.

Interface Print Print interface settings information.

Return Defaults Choose OK to restore Interface Setup settings to the default
values.

System
Setup

Sleep Timer Specify the period before the printer enters sleep mode.

Shut Down Timer Sets the time until the printer turns off automatically. If no oper-
ations are performed on the printer for the duration of the time
set in Shut Down Timer after entering Sleep mode, the printer
automatically turns off.

Buzzer Choose On for the buzzer to sound once for warnings and
three times for errors.

Contrast Adj. Adjust the Display Screen contrast level.

Date &
Time

Date Set the current date.

Time Set the current time. Available only if the Date setting is speci-
fied.

Date Format Specify the date format.

Language Specify the language used on the Display Screen.

iPF9400                                                                                                                                                                                                                      Menu Settings

User's Guide                                                                                                                                                                                                                                       

  

C
ontrol Panel

Printer M
enu

673  



Setting Item Description, Instructions
System
Setup

Time Zone Specify the time zone. Time zone options indicate a main city
in this time zone and the difference from Greenwich Mean
Time.

Length Unit Choose the display unit for length. Change the unit displayed
for the remaining amount of roll paper, Tot.Print Area, and so
on.

Detect Mismatch Specify printing behavior if the type and size of paper specified
in the printer menu does not match the type and size in the
printer driver.
Choose Pause to have printing paused under these circum-
stances. Choose Warning to continue printing after notifica-
tion. Choose None to continue printing without notification.
Choose Hold Job to store jobs with mismatched types and
sizes of paper on the printer hard disk, in a print queue await-
ing processing.  (See "Using the Printer Hard Disk.") →P.754

Paper
Size Ba-
sis

Sht Selection 1 If sheet size detection is activated, choose whether ISO A3+ or
13"x19"(Super B) is applied when a sheet of an intermediate
size is detected.

Sht Selection 2 If sheet size detection is activated, choose whether ISO B1 or
28"x40" (ANSI F) is applied when a sheet of an intermediate
size is detected.

Keep Paper Size Choose On to use the paper size setting as the basis for print-
ing instead of other settings. The margin setting of the printer
menu will be used instead of the margin setting of the printer
driver if the latter is smaller, which may prevent text or images
in the margin from being printed.

Choose Off to give priority to margin settings. The larger value
is used if the margin specified in the printer driver does not
match the margin in the printer menu.

Rep.P.head Print Choose On to have the printer automatically execute the Ad-
vanced Adj. operations after you replace the Printhead.  (See
"Automatic Adjustment to Straighten Lines and Colors.")
→P.798

Nozzle Check In Frequency, specify the timing for automatic checks of noz-
zle clogging. Choose Standard to have the printer adjust the
timing for checks based on the frequency of nozzle use.
Choose 1 page to check once per page.
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Setting Item Description, Instructions
System
Setup

Nozzle Check Select Warning > On to display warnings if the nozzles clog
during printing.

CarriageScanWdth Specify the scan width of the carriage during printing. Select
Automatic for movement equivalent to the width of paper loa-
ded. Selecting Fixed will reduce any soiling on the back of the
paper, although printing may take a little longer.

Use RemoteUI Choosing Off prohibits access from RemoteUI. Settings can
only be configured from the control panel.

Reset PaprSetngs Restores settings that you have changed with Media Configu-
ration Tool to the default values.

Erase
HDD Da-
ta

High Speed Erases file management data for print job data stored on the
printer's hard disk.  (See "Erasing Data on the Printer's Hard
Disk.") →P.695

Secure High Spd. Overwrites the entire hard disk with random data.  (See "Eras-
ing Data on the Printer's Hard Disk.") →P.695

Secure Overwrites the entire hard disk with 00, FF, and random data
(one time each). Verification is performed to check if the data
was correctly written.  (See "Erasing Data on the Printer's Hard
Disk.") →P.695

Output
Method

Print Select the printing method for jobs received from software oth-
er than the printer driver. When using the printer driver, config-
ure settings on the printer.
To print as usual, select Print. Selecting Print (Auto Del) will
print the job and then delete the data from the printer's hard
disk. Selecting Save: Box 01 will only save the print job in the
box, without printing it.

Print (Auto Del)
Save: Box XX

Print After Recv A setting for jobs received from software other than the printer
driver. When using the printer driver, configure settings on the
printer. Select On to print the job after it has been saved.

Common Box Set. Select Print (Auto Del) to print without saving jobs in the box
shared among multiple users.

Show Job Log Selecting Off prevents display of the log in Job Menu > Job
Log. Additionally, the log is not printed if you choose Job
Menu > Print Job Log. Note that because job logs are not col-
lected, the Status Monitor accounting functions will not work
correctly.

Take-up
Reel

Use Take-up Reel Selecting Enable allows use of the Media Take-up Unit.

Auto Feed Available only if Use Take-up Reel is already set to Enable.
Rolls are automatically advanced to the position for attachment
to the Rewind Spool.

Skip Take-Up Err Available only if Use Take-up Reel is already set to Enable.
Choose On to continue with printing even if an error occurs
with the Media Take-up Unit. Choose Off to pause printing if a
take-up error occurs.

Prep.MovePrinter When transferring the printer to another location, choose the
level of transfer and follow the instructions on the screen.  (See
"Preparing to Transfer the Printer.") →P.865
Not displayed during a warning message that the remaining
Maintenance Cartridge capacity is low.

Admin.
Menu

Change Password The password that can be entered is a number from 0 to
9999999.
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Setting Item Description, Instructions
Admin.
Menu

Change Password The restriction states and main items are shown below. For
more specific information on restricted items, see "Menu Struc-
ture." →P.661

• Viewing and configuration by administrators only
Change Password
Init.Admin.Pswd
Etc.

• Viewing and configuration by administrators, and only
viewing by other users
Date & Time
Time Zone
Use RemoteUI
Etc.

Init.Admin.Pswd Choose OK to restore the Admin. Menu password to the de-
fault values.

Adj. Fine Feed (*2)(*3) Displayed when you have selected Feed Priority > Adj. Prior-
ity > Automatic or Print Quality. Fine-tune the feed amount
manually.

Printer
Info (*2)

Paper Info Indicates the current paper size, type, and related printer set-
tings.

Ink Info Indicates ink levels and maintenance cartridge capacity.

Head In-
fo

Printhead L Indicates information about the printhead.

Printhead R
System Info Indicates the firmware version, serial number, and interface in-

formation.

Error Log Indicates the most recent error messages (up to five).

Other Counter Indicates the total printing volume of the printer.

*1: A rough estimate of how much ink was consumed per job is displayed. Actual ink consumption may be different. The average margin of
error for estimates calculated according to Canon measurement conditions for ink costs is ±15%. Canon does not guarantee the accu-
racy of these estimates. Estimates may vary depending on conditions of use. Calculation of these estimates does not include ink con-
sumed when cleaning printheads by forceful ejection of ink.

*2: Displayed as the menu during printing while printing is in progress.
*3: Not displayed in the regular menu.

Status PrintStatus Print
You can print a Status Print report indicating the current status of the printer.
With Status Print, information is printed regarding the printer firmware version, various settings, and the status of con-
sumables.

Printing Status Print reports

1 Load paper.
When using sheets, load paper of A4/Letter size. You will need at least four sheets.
The required sheet quantity varies depending on the execution log quantity of unique calibration.
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2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Test Print, and then press the OK button.

5 Press ▲ or ▼ to select Status Print, and then press the OK button.

Checking the information in Status Print reports
The following information is included in Status Print reports.

Canon imagePROGRAF iPFxxxx Status Print Printer model

Firm Firmware version

Boot Boot ROM version

MIT(DBF) MIT database format version

MIT(DB) MIT database version

S/N Printer serial number

Date Indicates when the status print report was printed.

Paper Menu Information on the loaded paper.

 Paper Type

 Roll Media

Cut Sheet

ManageRemainRoll

Keep Paper Type

Job Menu Job-related information.

 Job Log A counter for maintenance purposes.
Various information about previous jobs.

HDD Information Indicates the total hard disk capacity and the mail box free space.

 Total capacity

Box free space

Set./Adj. Menu Settings and adjustment information.

 System Setup Printer system settings, as well as settings regarding
warnings and errors. Sleep Timer

Shut Down Timer
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  Buzzer Printer system settings, as well as settings regarding
warnings and errors.

Contrast Adj.

Date Format

Language

Time Zone

Length Unit

Detect Mismatch

Paper Size Basis Paper-related settings.

 Sht Selection 1

Sht Selection 2

Keep Paper Size

Rep.P.head Print Settings after a test pattern was printed following
head replacement.

Nozzle Check Nozzle-check settings.

 Frequency

Warning

CarriageScanWdth Carriage scan width setting.

Use RemoteUI Settings used by RemoteUI.

Output Method Print job settings.

Print After Recv

Common Box Set.

Show Job Log

Adjust Printer Adjustment settings.

 Head Posi. Adj. A counter for maintenance purposes.
Head position adjustment values for previous jobs. Adjust Log

Calibration Color calibration settings.

 Calibration Log (Common Calibration) A record of when common calibration was per-
formed.

 Date Indicates the date when calibration was performed
and the type of paper used.Paper Type

Use Adj. Value A setting value indicating whether color calibration
adjustment values are to be applied to printing.

Set Exec. Guide A setting value indicating whether to display a mes-
sage recommending the execution of color calibra-
tion.

Take-up Reel Settings regarding the Media Take-up Unit.

 Use Take-up Reel

Skip Take-Up Err

Printer Info Ink information, RAM usage, and a record of errors.

 Ink Info Ink-related information.

 MC Maintenance Cartridge capacity (%)

PC, C, MBK, Y, M, PM, R, G, B, PGY,
GY, BK

Ink levels.
The remaining ink is displayed in a five-level scale.

System Info Indicates the total amount of RAM.
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   Indicates the total amount of RAM.RAM

Error Log The past five error codes.

HEAD LOT NUMBER Printhead lot number.

 LOT L: R:

PARTS STATUS Utilization status of replacement parts that require servicing.

 COUNTER

COUNTER Utilization status of the cutter, media, and other items (indicating
how much they have been used). CUTTER

MEDIA

 LIFE TTL

LIFE ROLL

LIFE CUTSHEET

MEDIA 1-7,OTHER

 NAME

TTL

ROLL

CUTSHEET

AFTER INSTALLATION

DUTY Counters for maintenance purposes. Needed when service is re-
quested. UNIT:m2

UNIT:sq.f

UNIT:A4 Sheet

UNIT:Letter Sheet

Set./Adj. Menu Settings and adjustment information.

 Adjust Printer Adjustment settings.

 Calibration Color calibration settings.

 Calibration Log (Unique Calibration) A record of when unique calibration was performed.

 No. Log number.

Paper Type Indicates the date when calibration was performed
and the type of paper used.Date

AdjType The adjustment type.

PatternSize The pattern size.

Temp/Humid The temperature and humidity when executed.

Backing Information on the backing plate when executed.

Printing Interface Setting ReportsPrinting Interface Setting Reports
You can print an Interface Print report indicating the current interface settings values of the printer.
Interface Print reports indicate settings values for TCP/IP, NetWare, and other settings.
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Printing Interface Print reports

1 Load the paper.
If using sheets, load paper A4/Letter-sized, you will need at least three sheets.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Test Print, and then press the OK button.

5 Press ▲ or ▼ to select Interface Print, and then press the OK button.

Confirming Interface Print information
The following information is included in the Interface Print report.

Canon imagePROGRAF iPFxxxx Interface Print Printer model

Firm Firmware Version

Boot Boot ROM Version

MIT(DBF) MIT Database Format Version

MIT(DB) MIT Database Version

S/N Printer serial number

Date The date when the interface setup print report was
printed.

EOP Timer Specify the timeout period before cancellation of print
jobs that cannot be received by the printer.

TCP/IPv4 Frame Type IPv4 settings values.

Use DHCP

Use BOOTP

Use RARP

Enable DNS Dynamic Update

Use Zeroconf Function

IP Address

Subnet Mask

Gateway Address

LPD Printing
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TCP/IPv4 IPP Printing IPv4 settings values.

IPP Printer URI

RAW Printing

Raw Mode Bi-direction

FTP Printing

Use Discovery

Scope

Primary DNS Server Address

Secondary DNS Server Address

DNS Host Name

DNS Domain Name

MulticastDNS ServiceName

SNMPv1

SNMPv3

TCP/IPv6 Use IPv6 IPv6 settings values.

Use DHCPv6 Stateful Address

Prefix Length

Primary DNS Server Address

Secondary DNS Server Address

Use a stateless address Stateless Address 1

Prefix Length 1

Stateless Address 2

Prefix Length 2

Stateless Address 3

Prefix Length 3

Stateless Address 4

Prefix Length 4

Stateless Address 5

Prefix Length 5

Stateless Address 6

Prefix Length 6

Use a link-local Address Link-Local Address

Prefix Length

Use a manual address IP Address

Prefix Length

Default Router Address

Prefix Length

Primary DNS Server Address

Secondary DNS Server Address

Use the same host name and domain
name as IPv4

DNS Host Name

DNS Domain Name
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TCP/IPv6 Perform dynamic updating of stateful addresses IPv6 settings values.

Dynamically update the stateless address

Dynamically update the manual address

NetWare Frame Type NetWare settings val-
ues.IPX External Network Number

Node Number

Print Application

Bindery PServer File Server Name

Print Server Name

Print Server Password

Polling Interval

RPrinter Print Server Name

Printer Number

NDS PServer Tree Name

Context Name

Print Server Name

Print Server Password

Polling Interval

NPrinter Print Server Name

Printer Number

AppleTalk Phase Type AppleTalk settings val-
ues.Name

Network Number

Zone

Network Interface Physical Interface Network interface set-
tings values.Transmission Rate

MAC Address

Auto Detect

Communication

Ethernet Type

Spanning Tree

Use the Jumbo Frame Function
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FrontFront

a Top Cover
Open this cover to install the Printhead, load paper, and remove any jammed paper from inside the printer as nee-
ded.  (See "Top Cover (Inside).") →P.687

b Cutter Groove
Paper is cut (using the cutter or manually with scissors) over this groove.

c Ejection Guide
Guides printed documents as they are ejected. Raise the guide when loading a roll.

d Roll Holder Slot
Slide the Roll Holder into this slot.
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e Roll Holder
Load the roll on this holder.

f Ejection Support
Prevents printed documents from winding around the Roll Holder or being drawn into the Paper Feed Slot.

g Paper Feed Slot
When loading a roll, insert the edge of the roll paper here.

h Holder Stopper
Secure rolls on the Roll Holder with this part.

i Ink Tank Cover
Open this cover to replace an Ink Tank.  (See "Ink Tank Cover (Inside).") →P.689

j Control Panel
Use this panel to operate the printer and check the printer status.  (See "Control Panel.") →P.648

k Release Lever
Releases the Paper Retainer. Lift this lever toward the front of the printer when loading paper.

l Maintenance Cartridge
Absorbs ink used for maintenance purposes such as head cleaning. (Replace the cartridge when it is full.)

m Carrying Handles
When carrying the printer, have six people hold it by these handles under both sides.

n Maintenance Cartridge Cover
Open this cover to replace the Maintenance Cartridge.

o Stand
A stand that holds the printer. Equipped with casters to facilitate moving it.  (See "Stand.") →P.690

p Media Take-up Unit
Automatically winds documents printed on rolls.  (See "Media Take-up Unit.") →P.691

q Accessory Box
Stores printer accessories.
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BackBack

a Carrying Handles
When carrying the printer, have six people hold it by these handles under both sides.

b Media Take-up Unit Power Inlet
Connect the power cord of the Media Take-up Unit here.

c Ethernet Port
Connect an Ethernet cable to this port.

d USB Port
Connect a USB cable to this port. It supports Hi-Speed USB.

e Manual Pocket
Store printer manuals in this pocket.
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f Power Supply Connector
Connect the power cord to this connector.

Top Cover (Inside)Top Cover (Inside)

a Top Cover Roller
Prevents paper from rising when ejected.

b Paper Alignment Line
Align paper with this line when loading it.

c Carriage
Moves the Printhead. The carriage serves a key role in printing.  (See "Carriage.") →P.688
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d Carriage Shaft
The Carriage slides along this shaft.

e Paper Retainer
Important in supplying the paper. This retainer holds paper as it is fed.

f Platen
The Printhead moves across the platen to print. Vacuum holes on the platen hold paper in place.

g Borderless Printing Ink Grooves
For catching ink outside the edges of paper during borderless printing.

h Cleaning Brush
When cleaning inside the printer under the Top Cover, use this brush to sweep away paper dust on the Platen.
Also use the brush to move the blue Switch on the Platen.

i Fixed Blade
The Cutter Unit passes over this rail to cut paper.

j Linear Scale
The linear scale serves a key role in detecting the Carriage position. Be careful not to touch this part when clean-
ing inside the Top Cover or clearing paper jams.

k Switch
Set the switch to the side opposite ● if the edges of printed images are blurred. Set the switch to the ● side before
borderless printing.  (See "Setting the Blue Switch on the Platen.") →P.893

CarriageCarriage

a Carriage Cover
Protects the Carriage.

b Printhead Fixer Cover
Holds the Printhead in place.

c Printhead L
The printhead is equipped with ink nozzles. The carriage serves a key role in printing.

d Printhead R
The printhead is equipped with ink nozzles. The carriage serves a key role in printing.

e Printhead Fixer Lever
Locks the Printhead Fixer Cover.

Carriage                                                                                                                                                                                                                               iPF9400

                                                                                                                                                                                                                                       User's Guide

  

Printer Parts
Printer parts

 688



f Cutter Unit
A round-bladed cutter for automatic paper cutting. Retracted when not in use.

g Shaft Cleaner
Prevents the Carriage Shaft from becoming dirty.

h Cutter Unit Detachment Lever
Used when replacing the Cutter Unit.

Ink Tank Cover (Inside)Ink Tank Cover (Inside)
Left Side Right Side

*1: Note: The figure shows the printer as loaded with 700 ml (23.7 fl oz) Ink Tank.

a Ink tanks
Cartridges of ink in various colors.

b Ink Tank Lock Lever
A lever that locks the Ink Tank in place and protects it. Lift and lower the lever when replacing an Ink Tank. To
open it, lift the stopper of the lever until it stops, and then push it down toward the front. To close it, push it down
until it clicks into place.
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a Ink Color Label
Load an Ink Tank that matches the color and name on this label.

b Ink Lamp (Red)
Indicates the state of the Ink Tank as follows when the Ink Tank Cover is opened.

• On
The Ink Tank is installed correctly.

• Off
No Ink Tank is installed, or the ink level detection function is disabled.

• Flashing Slowly
Not much ink is left.

• Flashing Rapidly
Ink tank is empty.

StandStand

a Stand L
The left leg of the Stand.

b Stand R
The right leg of the Stand.

c Top Stand Stay
Supports Stand L and Stand R. Attach the optional Media Take-up Unit to this part.

d Bottom Stand Stay
Supports Stand L and Stand R.
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e Leg Covers
Covers for Stand L and Stand R.

f Stopper
Locks the Stand casters.
Always release the Stopper before moving the printer. Moving the printer while the Stopper is locked may scratch
the casters or the floor.

g Accessory Pocket
Stores printer accessories.

Media Take-up UnitMedia Take-up Unit
  Main Unit

a Left Media Take-up Unit
Load the Rewind Spool here.

b Right Media Take-up Unit
Load the Rewind Spool here. Includes the Media Take-up Unit Power button, ▲ and ▼ buttons to advance or
rewind paper, and a power cord.

c Rewind Spool
Winds documents printed on rolls.

d 3-inch Adapter
When rewinding rolls with 3-inch paper cores, attach the adapter to the Rewind Spool.

e Media Take-up Sensor
A sensor for automatically rewinding rolls.
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  Weight

a Weight Roll (7)
Weights required when rewinding rolls. Use one roll or combine two (with a Weight Joint), depending on the roll
width.

b Weight Joint
Fastens two Weight Roll.

c Weight Flange (2 Sets)
Attached to the ends of Weight Roll to adjust the weight. Use Weight Flange 1 or Weight Flange 2, depending on
the type of paper. (See "Loading the Rewind Spool on the Media Take-up Unit.") →P.572
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Hard DiskHard Disk
Printer Hard Disk Operations ............................................................................................................................. 693
Checking the Free Hard Disk Space ................................................................................................................. 694
Erasing Data on the Printer's Hard Disk ............................................................................................................. 695

Printer Hard Disk OperationsPrinter Hard Disk Operations
Printer hard disk operations are available from the following programs and interfaces.

• Printer driver
• imagePROGRAF Print Plug-In
• imagePROGRAF Status Monitor
• imagePROGRAF Printmonitor
• RemoteUI
• Control Panel

The hard disk operations available through each interface are as follows.

Operation
• Printer driver
• imagePROGRAF Print

Plug-In

• imagePROGRAF Status
Monitor

• imagePROGRAF Print-
monitor

RemoteUI Control Panel

Saving print jobs Save in mail box Yes No No No

Do Not Save Print Jobs
in the Common Box

No No No Yes

Save print jobs sent from
sources other than the
printer driver

No No No Yes

Operations with saved
jobs

Print saved jobs No Yes Yes Yes

Delete saved jobs No Yes Yes Yes

Job queue management Display job queue No Yes Yes Yes

Delete No Yes Yes Yes

Preempt Jobs No Yes Yes Yes

Operations with held jobs No Yes Yes Yes

Mail box management Move saved jobs No Yes Yes No

Modify saved jobs No Yes Yes No

Modify mail boxes No Yes Yes No

Print a list of saved jobs No No No Yes

Display a list of saved
jobs

No Yes Yes Yes

Other operations Display free hard disk
space

No Yes Yes Yes

Initialize hard disk No No No Yes

Display the time of print-
ing

No Yes Yes Yes

Display error messages No Yes Yes Yes
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Checking the Free Hard Disk SpaceChecking the Free Hard Disk Space
Check the space available on the printer's hard disk as follows.
This operation is available from the Control Panel, in RemoteUI, imagePROGRAF Status Monitor, and imagePROG-
RAF Printmonitor.

Using the Control Panel

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Job tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu is displayed.

3 Press ▲ or ▼ to select HDD Information, and then press the OK button.
 
 

Using RemoteUI
To view the box list, select Stored Job in Job Management. On the Stored Job page, the free hard disk space is
shown in the upper-right corner when boxes are listed.

For details, refer to the RemoteUI help file.
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Using imagePROGRAF Status Monitor
The Hard Disk sheet shows the free hard disk space.

For details, refer to the imagePROGRAF Status Monitor help file.
 
 

Using imagePROGRAF Printmonitor
The Hard Disk pane shows the free hard disk space.

For details, refer to the imagePROGRAF Printmonitor help file.

Erasing Data on the Printer's Hard DiskErasing Data on the Printer's Hard Disk
When erasing all data on the hard disk, choose from the following three options.
This operation is only available from the Control Panel.

Erasure Method Details
High Speed Erases file management data for print job data stored on the printer's hard disk. Choose this method for relative-

ly fast erasure. Because only the file management data is erased, the print job data itself is not erased. Note
that it may be possible to read this data using commercial data recovery software.
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Erasure Method Details
Secure High Spd. Overwrites the entire hard disk with random data. No verification is performed to check if the data was correctly

written. Choose this method to erase highly confidential data. Note that it may be possible to read the overwrit-
ten data using specialized data recovery tools.

Secure Overwrites the entire hard disk with 00, FF, and random data (one time each). Verification is performed to check
if the data was correctly written. Choose this method to erase especially confidential data. It is virtually impossi-
ble to recover the overwritten data. Conforms to the DoD5220.22-M standard of the U.S. Department of De-
fense.

Important

• For a more secure method of preventing data recovery, we recommend physically or magnetically destroying the hard disk.
In this case, the hard disk can no longer be used.

• Erase HDD Data is not available if there is a job queue.
Additionally, print jobs are not processed during execution of Erase HDD Data.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select System Setup, and then press the OK button.

4 Press ▲ or ▼ to select Erase HDD Data, and then press the OK button.

5 Press ▲ or ▼ to select High Speed, Secure High Spd., or Secure, and then press the OK button to display
the confirmation screen.

Note

• If a password has been set on the printer, the Admin.Pswd screen is displayed. In this case, enter the password
and press the OK button to go to the next step.

• As for the time required for deletion, confirm it on the Control Panel. However, when High Speed is selected, this
finishes in several seconds.

6 Press ▲ or ▼ to select Yes, and then press the OK button to start erasure.
After the printer hard disk is erased, the printer automatically restarts.
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Optional accessoriesOptional accessories
Roll Holder SetRoll Holder Set

Load a roll on the roll holder and then load the holder in the printer. The Roll Holder in the Roll Holder Set RH2-64 is for
use with both 2-inch and 3-inch paper cores. Use the correct attachment for the particular paper core.  (See "Attaching
the Roll Holder to Rolls.") →P.530

• Roll Holder Set RH2-64

• Roll Holder (for 2- and 3-inch paper cores)

• Attachments
Using the 2-Inch Paper Core Attachment Using the 3-Inch Paper Core Attachment
2-Inch Paper Core Attachment 3-Inch Paper Core Attachment #1 3-Inch Paper Core Attachment #2
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Network EnvironmentNetwork Environment
Network EnvironmentNetwork Environment

System requirements
The system requirements, which vary depending on your network, are as follows.

• Printing over a TCP/IP network (when using IPv4)

• Compatible operating systems

• Windows XP
• Windows Server 2003
• Windows Vista
• Windows Server 2008
• Windows 7
• Windows Server 2003 x64
• Windows Vista x64
• Windows Server 2008 x64
• Windows 7 x64
• Mac OS X v10.2.8 or later
• Unix (Solaris 9)
• Unix (Red Hat 9)

• Printing over a TCP/IP network (when using IPv6)

• Compatible operating systems

• Windows Vista
• Windows Server 2008
• Windows 7
• Windows Vista x64
• Windows Server 2008 x64
• Windows 7 x64
• Mac OS X v10.3.9 or later

Note

• When using IPv6, you must specify IPv6 on the Control Panel or in RemoteUI. For instructions, "Configuring TCP/IPv6
Network Settings" →P.708  or see "Configuring the Printer's TCP/IP Network Settings With RemoteUI." →P.709

• The imagePROGRAF printer driver is supported in Mac OS X v10.5.8 or later.

• The imagePROGRAF printer driver is not compatible with Unix.

• Printing over an AppleTalk network

• Compatible operating systems

• Mac OS X v10.2.8–10.4

Note

• The printer cannot be used over a LocalTalk network.
• Compatible with EtherTalk Phase 2.
• The imagePROGRAF printer driver is not compatible with AppleTalk.

• Printing over a NetWare network

• Compatible servers

• Novell NetWare 4.2/5.1/6.0

• Compatible clients
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• Windows XP (Professional)

Note

• In NetWare 6.0, iPrint is not supported.

Network Environment
After confirming what type of network environment you will connect the printer to, set up the printer and computers as
needed. For the specifications of the network interface, see "Specifications." →P.934

• Example of a Windows network
In Windows networks, print over TCP/IP.

Note

• NetBIOS is not supported.

• Example of a Macintosh network
In Macintosh networks, print over TCP/IP using the Bonjour (Zeroconf) function.

Note

• The imagePROGRAF printer driver is not compatible with AppleTalk.
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• Example of a NetWare network

Note

• Even if there is a NetWare server in your network environment, you can use it in conjunction with TCP/IP or AppleTalk.
In this case, complete the settings for each protocol you will use.
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Using RemoteUIUsing RemoteUI
Using RemoteUIUsing RemoteUI

RemoteUI is software with which you can access the printer via the network from your Web browser to confirm the
printer status, operate jobs, and configure the settings. Since the software (Web server) for using RemoteUI is built in
the printer, preparing software other than a Web browser is unnecessary. You can use RemoteUI if an imagePROG-
RAF printer on a network is connected to your computer. If you start your Web browser and specify the IP address of
the printer, the RemoteUI screen is displayed, and you can use RemoteUI.

Important

• To use RemoteUI, an IP address must be set on the printer in advance. For the method of setting an IP address, see
"Configuring the IP Address on the Printer." →P.705

What You Can Do With RemoteUI
With RemoteUI, you can access the printer via a network, configure network settings, and display the current status of
the printer, various types of information, the processing status of jobs, etc.

Starting RemoteUI
Start RemoteUI by the following operations.

1 Start your Web browser.

2 Enter the following URL in Address or Location.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

3
 

The RemoteUI screen is displayed.

Note

• The screen slightly differs depending on the model of printer.

Configuring the Network With RemoteUI
For details on configuring printer settings for networks, refer to the following topics.

• Configuring the Printer's TCP/IP Network Settings With RemoteUI →P.709
• Configuring the Printer's AppleTalk Network Settings →P.724
• Configuring the Printer's NetWare Network Settings With RemoteUI →P.717
• Specifying Printer-Related Information →P.726
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Important

• For the Web browser, use Netscape Navigator 6.0 or later, Internet Explorer 5.01 or later, or Firefox 1.5 or later. For Mac OS
X, Safari 1.32 or later or 2.03 or later also is supported.

• This cannot be used connected via a proxy server. In environments where a proxy server is used, add the printer's IP ad-
dress to Exceptions (addresses accessed without a proxy server) in the web browser proxy server settings. (Settings may
vary depending on the network environment.)

• Enable JavaScript and cookies in the web browser.

• If you access RemoteUI with the printer name instead of its IP address, make sure the DNS settings are correctly configured.

• Depending on the network environment, you may not be able to start RemoteUI.

• Confirm whether System Setup > Use RemoteUI is set to On on the Control Panel of the printer.

Note

• RemoteUI also offers many other features. You can display the ink levels, check error messages and other status information,
and cancel print jobs.

• By factory default, the English screen is displayed. To change the display language, select the desired language under Lan-
guage before logging on in administrator mode.

• If you login in Administrator Mode, you can configure to use the Jumbo Frame function in the Network page. However, this
function might not be able to be used depending on the network environment.
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Initial SettingsInitial Settings
Configuring the IP Address on the Printer ......................................................................................................... 705

Configuring the IP Address Using imagePROGRAF Device Setup Utility .................................................... 730
Configuring the IP Address Using the Printer Control Panel ........................................................................ 705
Configuring the IP Address Using ARP and PING Commands .................................................................... 706

Configuring TCP/IPv6 Network Settings ............................................................................................................. 708
Configuring the Printer Driver Destination (Windows) ........................................................................................ 708
Configuring the Printer Driver Destination (Mac OS X) ...................................................................................... 709
Configuring the Printer's TCP/IP Network Settings With RemoteUI ................................................................... 709

Configuring the IP Address on the PrinterConfiguring the IP Address on the Printer
You must configure the printer's IP address before using the printer in a TCP/IP network.
The printer's IP address is configured automatically when you install the printer driver following the instructions in the
Setup Guide.
Configure the IP address by using imagePROGRAF Device Setup Utility, the printer Control Panel, or ARP or PING
commands, if the IP address is changed, or if you change the printer connection mode to a network connection. For
details on configuring the IP address, refer to the following topics.

• Configuring the IP Address Using imagePROGRAF Device Setup Utility →P.730  (Windows)

• Configuring the IP Address Using the Printer Control Panel →P.705

• Configuring the IP Address Using ARP and PING Commands →P.706

Important

• If you use a DHCP server for automatic assignment of the printer's IP address, printing may no longer be possible after the
printer is turned off and on. This is because an IP address different from before has been assigned. Thus, when using DHCP
server functions, consult your network administrator and configure the settings in one of the following ways.

• Configure the setting for dynamic DNS updating
In the printer menu, either set DNS Dync update to On, or activate the setting Enable DNS Dynamic Update in Remo-
teUI.
 (See "Menu Settings.") →P.667
 (See "Configuring the Printer's TCP/IP Network Settings With RemoteUI.") →P.709

• Configure the setting for assignment of the same IP address each time the printer starts up

Note

• We recommend configuring the printer's IP address even if you will use the printer in networks other than TCP/IP networks.
Configuring the printer's IP address enables you to use RemoteUI to configure the network settings and manage the printer
with a web browser.
For details on RemoteUI, see "Using RemoteUI." →P.703

Configuring the IP Address Using the Printer Control PanelConfiguring the IP Address Using the Printer Control Panel
This topic describes how to configure the printer's IP address on the Control Panel.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.
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2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4 Press ▲ or ▼ to select TCP/IP, and then press the OK button.

5 Press ▲ or ▼ to select IPv4, and then press the OK button.

6 Press ▲ or ▼ to select IPv4 Settings, and then press the OK button.

7 Press ▲ or ▼ to select IP Address, and then press the OK button.

8 After you press ◀ or ▶ to select the input field, numerical input is possible.

9 Press the ▲ or ▼ button to enter the value.

Note

• Hold down ▲ to increase the value continuously. However, 0 follows 2 for digits of 100 and 0 follows 9 for digits of
10 and 1.

• Hold down ▼ to decrease the value continuously. However, 2 follows 0 for digits of 100 and 9 follows 0 for digits of
10 and 1.

• Hold down ▲ or ▼ to increase or decrease the value continuously.

• Make sure the IP address you enter for the printer is not the same as any computer IP address in your network.

10 Repeat steps 8 and 9 to complete the settings, and then press the OK button.

11
 

Press the Menu button.
If you have changed the settings, a confirmation mes-
sage is displayed. Press ▲ or ▼ to select Yes, and
then press the OK button.

Important

• Be sure to complete step 11. This will activate the values you have entered.

• If an error message is displayed, check the settings and correct any invalid values.

Note

• You can also specify the subnet mask and default gateway on the Control Panel.
• The DNS can also be configured from the printer Control Panel.

Configuring the IP Address Using ARP and PING CommandsConfiguring the IP Address Using ARP and PING Commands
This topic describes how to configure the IP address using ARP and PING commands.
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To use the ARP and PING commands, you will need to know the printer's MAC address. You can confirm the MAC
address on the Control Panel.

1 Check the printer's MAC address.
You can confirm the MAC address on the Control Panel as follows:

1.  

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to

select the Settings/Adj. tab ( ).

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4. Press ▲ or ▼ to select Ethernet Driver, and then press the OK button.

5. Press ▲ or ▼ to select MAC Address, and then press the OK button.

Note

• If the Tab Selection screen is not displayed, press the Menu button.

• You can investigate the MAC address by printing an interface setting report.
 (See "Printing Interface Setting Reports.") →P.679

2 In Windows, open a command prompt, or in Mac OS X, start Terminal.

3 Execute the following command to add entries to the ARP table for managing IP addresses and corresponding
MAC addresses.
arp -s [IP address] [the printer's MAC address you have verified]
Example: arp -s xxx.xxx.xxx.xxx xx-xx-xx-xx-xx-xx

Note

• In Mac OS X when using Terminal, enter the arp command in the format
arp -s xxx.xxx.xxx.xxx xx-xx-xx-xx-xx-xx.
For details, refer to the help file for the command line.

4 Execute the following command to send the IP address to the printer and configure it.
ping [IP address as specified in the ARP command] -l 479
Example: ping xxx.xxx.xxx.xxx -l 479

Note

• In -l, the l is the letter l.

• In Mac OS X when using Terminal, enter the ping command in the format
ping -s 479 xxx.xxx.xxx.xxx.
For details, refer to the help file for the command line.

Note

• The subnet mask and default gateway are set to 0.0.0.0. Use RemoteUI to change the subnet mask and default gateway to
match your network settings.
For details on RemoteUI, see "Using RemoteUI." →P.703
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Configuring TCP/IPv6 Network SettingsConfiguring TCP/IPv6 Network Settings
When printing in a TCP/IPv6 network, you must configure the TCP/IPv6 settings on the Control Panel.
Follow the steps below to configure the TCP/IPv6 network settings.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4 Press ▲ or ▼ to select TCP/IP, and then press the OK button.

5 Press ▲ or ▼ to select IPv6, and then press the OK button.

6 Press ▲ or ▼ to select IPv6 Support, and then press the OK button.

7 Press ▲ or ▼ to select On, and then press the OK button.

Important

• Once you set IPv6 Support to On, the IPv6 StlessAddrs setting takes effect.

Note

• You can also configure IPv6 StlessAddrs and DHCPv6 from the printer Control Panel.

• The DNS can also be configured from the printer Control Panel.

Configuring the Printer Driver Destination (Windows)Configuring the Printer Driver Destination (Windows)
This topic describes how to specify the printer driver destination if the printer's IP address is changed, or if you will use
the printer over a network connection instead of via USB connection.
The procedure described below is the configuration based on the LPR or Raw protocol using the standard TCP/IP port
in Windows ( Standard TCP/IP Port).

Important

• If you will use the printer in a TCP/IP network, make sure the printer's IP address is configured correctly.

• Configuring the IP Address on the Printer →P.705

Note

• This section describes the procedure in Windows 7.

1 Open the Devices and Printers window.

2 Right-click the icon of this printer and choose Printer Properties to open the printer properties window.
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3 Click the Port tab to display the Port sheet.

4 Click Add Port to display the Printer Ports dialog box.

5 In the Available Port list, select Standard TCP/IP Port.

6 Click New Port.
After the wizard starts, a window is displayed for the Welcome to the Add Standard TCP/IP Printer Port Wiz-
ard.

7 Click Next.

8 In Printer Name or IP Address, enter the printer's IP address. If the DNS is configured, you can also enter the
DNS Domain Name.

9 Follow the instructions on the screen to add a printer port.

10 Click Close to close the Printer Ports dialog box.

11 Make sure the printer port you added is displayed under Ports, and that the port is selected.

12 Click Close to close the printer properties window.

Configuring the Printer Driver Destination (Mac OS X)Configuring the Printer Driver Destination (Mac OS X)
Specify the printer driver destination as follows if the printer's IP address is changed, or if you will use the printer over a
network connection instead of via USB connection.

• If you switch to printing in a TCP/IP network, or if the printer's IP address is changed, see "Configuring the Destina-
tion in TCP/IP Networks." →P.720

• If you switch to printing in a Bonjour network, see "Configuring the Destination for Bonjour Network." →P.721

Configuring the Printer's TCP/IP Network Settings With RemoteUIConfiguring the Printer's TCP/IP Network Settings With RemoteUI
Follow the steps below to configure the TCP/IP network settings.

When using an IPv4 IP address

1 Start the web browser and enter the following URL in the Location (or Address) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2 Select Administrator Mode and click Logon.

3 If a password has been set on the printer, enter the password.

4 Click Network in the Device Manager menu at left to display the Network page.

5 Click Edit in the upper-right corner of the TCP/IPv4 group to display the Edit TCP/IP Protocol Settings page.
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6 Refer to the TCP/IP Settings Items table to complete the settings.
TCP/IP Settings Items

Item Details Default Setting
Use DHCP Activate this setting to use DHCP for configuring the IP address. Off

Use BOOTP Activate this setting to use BOOTP for configuring the IP address. Off

Use RARP Activate this setting to use RARP for configuring the IP address. Off

Enable DNS Dynamic
Update

Activate this setting to perform DNS server registration automatically. Off

Use Zeroconf Function Activate this setting to use Bonjour. On

IP Address Specify the printer's IP address. 0.0.0.0

Subnet Mask Specify the printer's subnet mask. 0.0.0.0

Gateway Address Specify the printer's default gateway. 0.0.0.0

LPD Printing Activate this setting to use LDP Printing. On

IPP Printing Activate this setting to use IPP Printing. On

IPP Printer URI Specify the URI of the printer used for IPP printing using up to 252 characters. printer

RAW Printing Activate this setting to use Raw Printing. On

RAW Mode Bi-direc-
tion

Activate this setting to use Raw mode bidirectional communication. Off

FTP Printing Activate this setting to use FTP Printing. On

Use Discovery Activate this setting to use SLP Discovery function. On

Scope Enter the SLP search range. default

SMTP Server Address Specify the SMTP server's IP address.
You can also specify the SMTP server domain name, if desired.

0.0.0.0

Primary DNS Server
Address

Specify the IP address of the primary DNS server. 0.0.0.0

Secondary DNS Server
Address

Specify the IP address of the secondary DNS server. 0.0.0.0

DNS Host Name Specify the printer host name, up to 63 characters (1–63 characters). Use single-
byte letters, numbers, and - (hyphens). Do not use numbers or - for the first char-
acter or - for the last character.

NB-18GBipxxxxxx

DNS Domain Name Specify the printer domain name, up to 63 characters. Use single-byte letters,
numbers, - (hyphens), and . (periods). Do not use numbers, -, or . for the first
character, or - or . for the last character.

blank

Multicast DNS Service
Name

Specify the printer's Multicast DNS service name. (1–63 characters)
This name will be displayed when Bonjour functions are used.

Canon iPFxxxx
(xxxxxx)

7 Click OK to display the Network page.

Note

• If you specify to configure the IP address using DHCP, BOOTP, or RARP, there must be a server that supports such protocol
running in the network.

• If you specify to configure the IP address using DHCP, BOOTP, or RARP, the IP address obtained by this method is used
first. If you cannot obtain the IP address, the address specified in IP Address is used.

• It takes up to two minutes to determine whether DHCP, BOOTP, or RARP are available. We recommend clearing check boxes
of options you will not use.

• If you are using a DNS server, select Enable DNS Dynamic Update and enter the IP Address for DNS servers and DNS
domain name in Primary DNS Server Address, Secondary DNS Server Address and DNS Domain Name, respectively.
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When using an IPv6 IP address

1 Start the web browser and enter the following URL in the Location (or Address) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2 Select Administrator Mode and click Logon.

3 If a password has been set on the printer, enter the password.

4 Click Network in the Device Manager menu at left to display the Network page.

5 Click Edit in the upper-right corner of the TCP/IPv6 group to display the Edit TCP/IPv6 Protocol Settings
page.

6 Refer to the TCP/IPv6 Settings Items table to complete the settings.
TCP/IPv6 Settings Items

Item Details Default Setting
Use IPv6 Activate to enable IPv6. Off

Use DHCPv6 Activate when using a DHCPv6 server to acquire the IP address. Off

Use a stateless address Activate when using an IPv6-compatible router to acquire the IP ad-
dress.

On

Use a manual address Activate when configuring the IP address manually. Off

IP Address Enter the printer's IP address. ::

Prefix Length Enter the IP address prefix length. 0

Default Router Address Enter the default router address. ::

Prefix Length Enter the prefix length of the default router address. 0

Primary DNS Server Address Specify the IP address of the primary DNS server. ::

Secondary DNS Server Address Specify the IP address of the secondary DNS server. ::

Use the same host name and domain
name as IPv4

Activate when using the same DNS host and domain names as for
IPv4.

Off

DNS Host Name Specify the printer host name, up to 63 characters (1–63 characters).
Use single-byte letters, numbers, and - (hyphens). Do not use num-
bers or - for the first character or - for the last character.

NB-18GBip6xxxxxx

DNS Domain Name Specify the printer domain name, up to 63 characters. Use single-
byte letters, numbers, - (hyphens), and . (periods). Do not use num-
bers, -, or . for the first character, or - or . for the last character.

blank

Perform dynamic updating of stateful
addresses

Activate this setting to automatically register the stateful address with
the DNS server.

Off

Dynamically update the stateless ad-
dress

Activate this setting to automatically register the stateless address
with the DNS server.

Off

Dynamically update the manual ad-
dress

Activate this setting to automatically register the manual address with
the DNS server.

Off

7 Click OK to display the Network page.

Note

• If you are using a DNS server, select Enable DNS Dynamic Update and enter the IP Address for DNS servers and DNS
domain name in Primary DNS Server Address, Secondary DNS Server Address and DNS Domain Name, respectively.
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NetWare SettingsNetWare Settings
Configuring NetWare Network Settings ............................................................................................................. 712
Specifying the Printer's Frame Type .................................................................................................................. 712
Specifying NetWare Print Services .................................................................................................................... 715
Configuring the Printer's NetWare Network Settings With RemoteUI ................................................................ 717

Configuring NetWare Network SettingsConfiguring NetWare Network Settings
To print over a NetWare network, configure the network environment as follows.

Important

• To configure network settings, you must be logged in with administrative rights such as Administrator account. We recom-
mend that your network administrator configure the network settings.

Note

• This section describes the procedure in Windows 7.

1 Specify the Ethernet frame type for communication between the printer and computers.
For instructions, see "Specifying the Printer's Frame Type." →P.712

2 Specify the NetWare print services, including the print server and queue.
For instructions, see "Specifying NetWare Print Services." →P.715

3 Specify NetWare protocol details besides the frame type.
For details on how to configure the settings, see "Configuring the Printer's NetWare Network Settings With Re-
moteUI." →P.717
After you have completed the steps above, configure each computer for printing over the NetWare network.

4 Connect to the NetWare network.
Install NetWare client software on each computer to be used for printing over the network, and log in to the
NetWare server or tree. For instructions on connection, refer to the NetWare and operating system documenta-
tion.

5 Install the printer driver.
Follow the instructions of your network administrator to install the printer driver on each computer to be used
for printing. When installing the printer driver, choose Network Printer as the printer destination, and then
choose the print queue created from the NetWare print service settings.

6 Follow these steps to configure the printer port. This step is not necessary if you specified the printer destina-
tion during installation of the printer driver.

1. Open the Devices and Printers window.

2. Right-click the icon of this printer and choose Printer Properties to open the printer properties window.

3. Click the Port (or Advanced) tab to display the Port (or Advanced) sheet.

4. As the destination port, specify the print queue created by configuring the NetWare print service settings.

Specifying the Printer's Frame TypeSpecifying the Printer's Frame Type
To enable communication between the printer and computers on your network, specify the Ethernet frame type in your
NetWare environment.
Follow the steps below to specify the frame type by using imagePROGRAF Device Setup Utility or the printer Control
Panel.
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Important

• Before specifying the frame type, make sure the printer is on and connected to the network.

Note

• You can specify the frame type by using RemoteUI if the printer's IP address is configured.

• For instructions on installing imagePROGRAF Device Setup Utility, see "Installing imagePROGRAF Device Setup Utility."
→P.730 .

Specifying the frame type using imagePROGRAF Device Setup Utility

1
 

Start imagePROGRAF Device Setup Utility.

2 In the list of printers, select the printer to configure.

3 Choose Protocol Settings from the Printer menu.

4
 

Click the NetWare tab and select the frame type in the
NetWare Frame Type list.
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5
 

Select the IPv4 tab. In IP Address, enter the IP ad-
dress assigned to the printer, and then enter the subnet
mask in Subnet Mask and the default gateway in
Gateway Address.

Important

• You must specify the IP address here to be able to configure NetWare protocol settings using RemoteUI.

6 Click Set.

7 Click OK after the Confirmation message is displayed.

8 Exit imagePROGRAF Device Setup Utility.

Specifying the frame type using the printer Control Panel

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.
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3 Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4 Press ▲ or ▼ to select NetWare, and then press the OK button.

5 Press ▲ or ▼ to select NetWare, and then press the OK button.

6 Press ▲ or ▼ to select On, and then press the OK button.
The display reverts to the NetWare menu.

7 Press ▲ or ▼ to select Frame Type, and then press the OK button.

8 Press ▲ or ▼ to select the frame type to use, and then press the OK button.
The display reverts to the NetWare menu.

9 Press ▲ or ▼ to select Print Service, and then press the OK button.

10 Press ▲ or ▼ to select the desired print service, and then press the OK button.
The display reverts to the NetWare menu.

11
 

Press the Menu button.
If you have changed any settings, a confirmation mes-
sage is displayed. In this case, press the OK button.

Important

• Be sure to complete step 11. This will activate the values you have entered.

Note

• If an error message is displayed, check the settings and correct any invalid values.

• To cancel this process, press the Back button.

Specifying NetWare Print ServicesSpecifying NetWare Print Services
Before printing in a NetWare network, you must configure print services such as print servers, print queues, and so on.
You can configure the print service settings from a computer using any of the following Novell software provided with
NetWare.

• NWADMIN
• PCONSOLE

Important

• If you use NWADMIN to configure the print service settings, Novell Client (the Novell NetWare client software) must be instal-
led as the client software application.

• NetWare networking is unsupported in Windows Vista, Windows Server 2008 and Windows 7.

This topic gives instructions for configuring NetWare print services. The order of this procedure may vary depending on
the environment.
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Choosing the type of print services
Before completing print service settings, choose the type of print service. Refer to the following descriptions as needed.

Note

• In NetWare 5.1 or 6.0, NDPS may also be used as the print service. If you use NDPS, use the Novell printer gateway included
with NetWare. For details on configuring NDPS, refer to the NetWare documentation.

• NDS (Novell Directory Service) and bindery
NDS and bindery are both supported. Use the mode that is compatible with your network environment.

• Queue server mode and remote printer mode
Queue server mode and remote printer mode are both supported.

• Queue server mode
When using queue server mode, all print server functions are supported, so there is no need for other print
server software or hardware. In NDS queue server mode (NDS PServer), the NDS print server is used for
printing. In bindery queue server mode (Bindery PServer), the bindery print server is used for printing. Note
that if you use queue server mode, a NetWare user license is required for each network interface.

• Remote printer mode
In remote printer mode, the printer is controlled by the NetWare print server. Thus, a NetWare print server is
required. In NDS remote printer mode (NPrinter), the NDS print server is used for printing, and in bindery re-
mote printer mode (RPrinter), the bindery print server is used for printing.

Using NWADMIN or PCONSOLE to set up the print server
Use NWADMIN to set up the print server if NDS queue server mode or remote printer mode is used.

1 Log into NetWare as Administrator or with equivalent rights, and then start NWADMIN.

2 Run Quick Setup.

1. Choose Print Services Quick Setup in the Tools menu.

2. Enter a desired name in Print Server Name. To use an existing print server, click the button at right and
choose the name from the list.

3. Enter a desired printer name in Name.

4. To use the printer in queue server mode, choose Other/Unknown in Type. To use the printer in remote
printer mode, choose Parallel in Type, click Communications, and set Ports to LPT1 and Connection
Type to Manual Load.

5. Enter a desired queue name in Name.

6. In Volume, enter the volume object (that is, the object representing the physical volume on the network)
where the print queue will be created. Click the button at right to choose from a list.

7. Complete other settings as needed and click OK.

Note

• The print server name will be required when configuring the printer's protocol settings. Write down the print server
name for future reference.

• When running Quick Setup, the printer is assigned printer number 0. When using the printer in queue server mode,
do not change the printer number from 0.

3 Set a password.

1. Right-click the print server created in step 2 and choose Details.

2. Click Change Password to open the password input dialog box. Enter the password.

3. Click OK to close the password input dialog box.
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4. Click OK or Cancel to close the details dialog box.

4 To use the printer in remote printer mode, start the print server.
To use the NetWare file server as the print server, enter LOAD PSERVER.NLM at the file server and press the
Enter key.

Note

• This procedure is not required when using queue server mode.

Use PCONSOLE to set up the print server if bindery queue server mode or remote printer mode is used.

1 Log into NetWare as Admin and start PCONSOLE.

2 Switch to bindery mode.

3 If the print server has not been created, create it.

1. In Available Options, select Quick Setup, and press the Enter key.

2. Enter the name of the new print server, the new printer, and the queue.

Note

• The print server name will be required when configuring the printer's protocol settings. Write down the print server
name for future reference.

4 Specify the printer type.

1. To use the printer in queue server mode, choose Other/Unknown in Type. To use remote printer mode,
set Printer Type to Parallel and Position to Manual Load.

2. Press the Esc key.

3. After the confirmation message is displayed, choose Yes and press the Enter key.

5 Set a password.

1. In Available Options, select Print Servers and press the Enter key.

2. Select the print server created in step 2 and press the Enter key.

3. Select Password, and press the Enter key to display the password input dialog box.

4. Enter the password and press the Enter key.

6 Press the Esc key several times to display the dialog box for confirming that PCONSOLE is finished.

7 Click Yes to exit PCONSOLE.

Configuring the Printer's NetWare Network Settings With RemoteUIConfiguring the Printer's NetWare Network Settings With RemoteUI
Follow the steps below to configure NetWare protocol settings other than the frame type by using RemoteUI.

Note

• For details on RemoteUI, see "Using RemoteUI." →P.703
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1 Start the web browser and enter the following URL in the Location (or Address) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2 Select Administrator Mode and click Logon.

3 If a password has been set on the printer, enter the password.

4 Click Network in the Device Manager menu at left to display the Network page.

5 Click Edit in the upper-right corner of the NetWare group to display the Edit NetWare Protocol Settings
page.

6 Refer to the NetWare Settings Items table to complete the settings.
NetWare Settings Items

Item Details Default Set-
ting

Frame Type Specify the type of frame to use in NetWare. Disabled

NCP Burst Mode Activate this setting to use NCP Burst Mode.
This mode supports fast data transfer when printing in queue server mode.
Normally, leave the setting On.

On

Print Application Choose the print service.
The print service selected here is enabled. Multiple print services cannot be
enabled simultaneously.

• Bindery PServer
• RPrinter
• NDS PServer
• NPrinter

NDS PSer-
ver

Packet Signature Select If Requested by Server to use packet signature. If Reques-
ted by
Server

Bindery PServer File Server Name Specify the name of a file server that has a NetWare print server.
(0–47 characters)

—

Print Server Name Specify the name of a NetWare print server.
(0–47 characters)

—

Print Server Pass-
word

Set a password for the print server.
(0–20 characters)

—

Polling Interval Specify the interval to confirm jobs.
(1–15 seconds)

5

RPrinter Print Server Name Specify the name of a NetWare print server.
(0–47 characters)

—

Printer Number Specify the number of the printer connected to the NetWare print server.
(0-15)

0

NDS PServer Tree Name Specify the name of an NDS tree that has a NetWare print server.
(0–32 characters)

—

Context Name Specify the name of a context that has a NetWare print server.
(0–255 characters)

—

Print Server Name Specify the name of a NetWare print server.
(0–64 characters)

—
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Item Details Default Set-
ting

NDS PServer Print Server Pass-
word

Set a password for the print server.
(0–20 characters)

—

Polling Interval Specify the interval to confirm jobs.
(1–255 seconds)

5

NPrinter Print Server Name Specify the name of a NetWare print server.
(0–47 characters)

—

Printer Number Specify the number of the printer connected to the NetWare print server.
(0-254)

0

7 Complete the following settings based on the selected service.

• If you have selected Bindery PServer: Queue Server Mode (Using a Bindery Print Server)

1. In File Server Name, enter the file server name.

2. In Print Server Name, enter the name of the print server created in "Specifying NetWare Print Serv-
ices →P.715 ."

3. In Print Server Password, enter the password of the print server created in "Specifying NetWare Print
Services →P.715 ."

4. In Polling Interval, specify the interval at which the printer checks the NetWare print queue.

• If you have selected RPrinter: Remote Printer Mode (Using a Bindery Print Server)

1. In Print Server Name, enter the advertising name of the print server created in "Specifying NetWare
Print Services →P.715 ."

2. In Printer Number, enter the same printer number specified in "Specifying NetWare Print Serv-
ices →P.715 ."

• If you have selected NDS PServer: Queue Server Mode (Using an NDS Print Server)

1. In Tree Name and Context Name, enter the tree and context name of the print server.

2. In Print Server Name, enter the name of the print server created in "Specifying NetWare Print Serv-
ices →P.715 ."

3. In Print Server Password, enter the password of the print server created in "Specifying NetWare Print
Services →P.715 ."

4. In Polling Interval, specify the interval at which the printer checks the NetWare print queue.

• If you have selected NPrinter: Remote Printer Mode (Using a NDS Print Server)

1. In Print Server Name, enter the advertising name of the print server created in "Specifying NetWare
Print Services →P.715 ." Usually, the advertising name is the same as the name of the print server.

2. In Printer Number, enter the same printer number specified in "Specifying NetWare Print Serv-
ices →P.715 ."

8 Click OK to display the Network page.
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Mac OS X SettingsMac OS X Settings
Configuring the Destination in TCP/IP Networks ................................................................................................ 720
Configuring the Destination for Bonjour Network ............................................................................................... 721
Configuring the Destination for AppleTalk Networks ......................................................................................... 723
Configuring the Printer's AppleTalk Network Settings ....................................................................................... 724

Configuring the Destination in TCP/IP NetworksConfiguring the Destination in TCP/IP Networks
Follow these steps to configure the destination when using the printer in a TCP/IP network.

Important

• If you use the printer in a TCP/IP network, make sure the printer's IP address is configured correctly.  (See "Configuring the IP
Address Using the Printer Control Panel.") →P.705

1 Navigate to Applications > Canon Utilities > imagePROGRAF PrinterSetup and double-click imagePROG-
RAF PrinterSetup.app.

2
 

Click Next.

3
 

Click Registering IP Address.
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4
 

Select the model and type and then enter the IP ad-
dress before clicking the Next button.

5
 

Complete Printer Name and Location as desired and
click Register.

6
 

Click Finish.

Configuring the Destination for Bonjour NetworkConfiguring the Destination for Bonjour Network
Follow the steps below to configure the destination if you are using the printer in a network that uses the Bonjour func-
tion.

Important

• Bonjour and IP Print (Auto) do not support printing to a printer on other network groups that require a router for connection.
Make sure the computer and printer are on the same network. For information about network settings, ask your network
administrator.

• By default, Bonjour is activated on the printer. You can activate or deactivate the Bonjour function or change the printer name
by using RemoteUI. For instructions on changing it, see "Using RemoteUI." →P.703

1 Navigate to Applications > Canon Utilities > imagePROGRAF PrinterSetup and double-click imagePROG-
RAF PrinterSetup.app.
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2
 

Click Next.

3
 

Select the printer to register and click Next.

4
 

Complete Printer Name and Location as desired and
click Register.

5
 

Click Finish.
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Configuring the Destination for AppleTalk NetworksConfiguring the Destination for AppleTalk Networks
To print over an AppleTalk network, activate the AppleTalk protocol and configure the destination as follows.

Activating AppleTalk on the printer

Important

• By default, the AppleTalk protocol is disabled on the printer.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4 Press ▲ or ▼ to select AppleTalk, and then press the OK button.

5 Press ▲ or ▼ to select On, and then press the OK button.

6
 

Press the Menu button.
If you have changed any settings, a confirmation mes-
sage is displayed. In this case, press the OK button.

Important

• Be sure to complete step 6. This will activate the values you have entered.

Note

• By using RemoteUI, you can also specify the object name used for AppleTalk, as well as the printer zone name.
For details on RemoteUI, see "Using RemoteUI." →P.703

Configuring the Destination (Mac OS X)

Important

• AppleTalk is supported in Mac OS X 10.2.8–10.4.
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Note

• The following procedures are based on Mac OS X 10.4. The method of configuring the destination varies depending on the
version of Mac OS X.

• The imagePROGRAF printer driver is not compatible with AppleTalk.

1 In System Preferences, click Network to display the Network window.

2
 

In Show, choose Built-in Ethernet. Next, click Apple-
Talk, select Make AppleTalk Active, and click Apply
now.

3 Close the Network window and save the settings.

Configuring the Printer's AppleTalk Network SettingsConfiguring the Printer's AppleTalk Network Settings
Follow the steps below to configure the AppleTalk network settings.

1 Start the web browser and enter the following URL in the Location (or Address) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2 Select Administrator Mode and click Logon.

3 If a password has been set on the printer, enter the password.

4 Click Network in the Device Manager menu at left to display the Network page.

5 Click Edit in the upper-right corner of the AppleTalk group to display the Edit AppleTalk Protocol Settings
page.

6 Refer to the AppleTalk Settings Items table to complete the settings.
AppleTalk Settings Items

Item Details Default Setting
Phase
Type

Specify whether to use AppleTalk.
If you will use AppleTalk, choose Phase 2.
If you will not use AppleTalk, choose Disabled.

Disabled

Name (*1) Specify the object name used by AppleTalk (in up to 31 single-byte or 15 double-byte characters).
However, do not use the following single-byte characters: @, *, :, and =.

Canon NB-18GB
(xxxxxx)
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Item Details Default Setting
Zone (*2) Specify the printer zone name, up to 31 single-byte characters.

However, do not use the following single-byte characters: Also avoid using * (which represents the
default zone) in the middle of a string.

*

*1:  The object name you have specified in Name is displayed in Printer Setup Utility (or Print Center) in Mac OS X 10.2.8–10.4. If
you use multiple printers in the same zone, assign a unique name to each printer. By default, the network interface name is
Canon NB-18GB (xxxxxx). (Here, xxxxxx is the last six digits of the printer's MAC address.)

*2:  If zones have been created on the network, enter the name of the printer's zone. If there are no zones, leave the asterisk * entry
(for the default zone) as it is. If you enter a network zone name that does not match created zones, the printer will not be detec-
ted by Macintosh computers. Consult your network administrator for information on zone names.

7 Click OK to display the Network page.
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Other SettingsOther Settings
Specifying Printer-Related Information .............................................................................................................. 726
Configuring the Communication Mode Manually ............................................................................................... 727
Email Notification When Printing is Finished or Errors Occur ............................................................................ 728
Initializing the Network Settings ......................................................................................................................... 728

Specifying Printer-Related InformationSpecifying Printer-Related Information
Follow the steps below to specify device information and security settings.

1 Start the web browser and enter the following URL in the Location (or Address) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2 Select Administrator Mode and click Logon.

3 If a password has been set on the printer, enter the password.

4 Click Information in the Device Manager menu at left to display the Information page.
To change the administrator password, click the Change Password button in the Security group.

5 Refer to the table of settings for device information and security as you complete these settings.
Security setting items are displayed when you click the Change Password button in the Security group.
Device Information Settings

Item Details Default Setting
Device Name Enter a device name.

(0–32 characters)
blank

Location Enter the location where the device is installed.
(0–32 characters)

blank

Administrator Enter the administrator's name.
(0–32 characters)

blank

Phone Enter the administrator's contact information.
(0–32 characters)

blank

Comments(E-mail) Enter any comments regarding the administrator.
(0–32 characters)

blank

Security Settings
Item Details Default Setting

New Password Enter the new password.
(0-9999999)

blank

Confirm Enter the new password again to confirm it.
(0-9999999)

blank

*1: On the Security settings screen, besides entering a password, you can specify other security-related information, such as IP
address-based SNMP or TCP usage restrictions, MAC address-based access restrictions, or IPP and FTP authentication set-
tings.

6 Click OK to activate the settings.
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Configuring the Communication Mode ManuallyConfiguring the Communication Mode Manually
This topic gives instructions for configuring the communication mode manually.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4 Press ▲ or ▼ to select Ethernet Driver, and then press the OK button.

5 Press ▲ or ▼ to select Auto Detect, and then press the OK button.

6 Press ▲ or ▼ to select Off, and then press the OK button.
The display reverts to the Ethernet Driver menu.

7 Press ▲ or ▼ to select Comm.Mode, and then press the OK button.

8 Press ▲ or ▼ to select the communication mode, and then press the OK button.
The display reverts to the Ethernet Driver menu.

9 Press ▲ or ▼ to select Ethernet Type, and then press the OK button.

10 Press ▲ or ▼ to select the Ethernet type, and then press the OK button.
The display reverts to the Ethernet Driver menu.

11 Press ▲ or ▼ to select Spanning Tree, and then press the OK button.

12 Press ▲ or ▼ to enable or disable spanning tree support, and then press the OK button.
The display reverts to the Ethernet Driver menu.

13
 

Press the Menu button.
After the confirmation message is displayed, press the
OK button.
The new settings will take effect after the printer re-
starts.
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Note

• Communication can also be configured on the Network page in RemoteUI.

Email Notification When Printing is Finished or Errors OccurEmail Notification When Printing is Finished or Errors Occur
The printer can notify you of the printer status by email. Even when you are away from the printer, you can know when
printing is finished or if errors occur. Receive notification via email on your mobile phone or at your computer.

Use the imagePROGRAF Status Monitor (Windows) function to set up email recipients and message timing. Besides
being informed of finished print jobs or errors, you can also complete settings for email notification when service is nee-
ded or it's time to replace consumables. For detailed instructions,see "Specifying Printer-Related Information." →P.726

Note

• For details on email notification using imagePROGRAF Status Monitor (in Windows), refer to the imagePROGRAF Status
Monitor help.

• Mail server authentication is only supported with imagePROGRAF Status Monitor.

Initializing the Network SettingsInitializing the Network Settings
Use RemoteUI to restore the network settings to the default values as follows.

Important

• Initializing the network settings will also restore the default value of the printer's IP address. As a result, the RemoteUI page
cannot be displayed in the web browser after this procedure.

• For instructions on reconfiguring the IP address, see "Configuring the IP Address on the Printer." →P.705

• For details on RemoteUI, see "Using RemoteUI." →P.703

1 Start the web browser and enter the following URL in the Location (or Address) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2 Select Administrator Mode and click Logon.

3 If a password has been set on the printer, enter the password.

4 Click Network in the Device Manager menu at left to display the Network page.

5 Click Reset to Default settings in the lower-right corner of the Network Interface group.

6 After confirming the message, click OK to restore the network settings to the default values.
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Note

• You can also use imagePROGRAF Device Setup Utility or the Control Panel to restore the default network settings.
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Device Setup Utility (Windows)Device Setup Utility (Windows)
imagePROGRAF Device Setup Utility ................................................................................................................ 730
Installing imagePROGRAF Device Setup Utility ................................................................................................. 730
Configuring the IP Address Using imagePROGRAF Device Setup Utility ......................................................... 730

imagePROGRAF Device Setup UtilityimagePROGRAF Device Setup Utility
imagePROGRAF Device Setup Utility is a utility to establish communication between the printer and your computer by
completing relevant settings. After the printer is installed, for example, you can use imagePROGRAF Device Setup
Utility to complete the network settings initially.

• Starting imagePROGRAF Device Setup Utility will show a list of printers found on the network. In this list, select
the printer (specifically, the printer's MAC address) that you want to set up, and then configure the basic settings
from your computer, such as the printer's IP address and the network frame type.

• You can see which printers are online in the network by checking the printer list. Communication between your
computer and these printers is possible.

Note

• We recommend that your network or printer administrator complete the setup work using imagePROGRAF Device Setup Utili-
ty.

• For details, refer to the imagePROGRAF Device Setup Utility help.

Installing imagePROGRAF Device Setup UtilityInstalling imagePROGRAF Device Setup Utility
Install imagePROGRAF Device Setup Utility from the User Software CD-ROM provided with the printer as follows:

1 Insert the User Software CD-ROM in the CD-ROM drive.

2 On the Setup Menu window, click Install Individual Software.

3 Click Install in imagePROGRAF Device Setup Utility.

4 Follow the instructions on the screen to proceed with the installation.

Configuring the IP Address Using imagePROGRAF Device Setup UtilityConfiguring the IP Address Using imagePROGRAF Device Setup Utility
On a computer running Windows, you can use imagePROGRAF Device Setup Utility provided with the printer to con-
figure the printer's IP address. This topic describes how to configure the IP address using imagePROGRAF Device
Setup Utility.

Important

• To configure network settings, you must be logged in with administrative rights such as Administrator account. We recom-
mend that your network administrator configure the network settings.

Note

• For instructions on installing imagePROGRAF Device Setup Utility, see "Installing imagePROGRAF Device Setup Utility."
→P.730
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When specifying an IPv4 IP address

1
 

Start imagePROGRAF Device Setup Utility from the
start menu.

2 In the Device Name list displayed, select the printer to configure.

3 Choose Protocol Settings from the Printer menu.

4
 

Select the IPv4 tab.

5 In the Setting IP Address list, choose Manual.

6 Enter the IP address assigned to the printer and click the Set button.

7 Click OK after the Confirmation message is displayed.

8 Exit imagePROGRAF Device Setup Utility.

Note

• To configure the IP address automatically, choose Auto in the Setting IP Address list and select DHCP, BOOTP, or RARP.

• You can also specify the subnet mask and default gateway.
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When specifying an IPv6 IP address

1
 

Start imagePROGRAF Device Setup Utility from the
start menu.

2 In the Device Name list displayed, select the printer to configure.

3 Choose Protocol Settings from the Printer menu.

4
 

Select the IPv6 tab.

5 In IPv6, select On.

6 When there is an IPv6-compatible router in the network environment, select On in Stateless Address.
Additionally, when there is an DHCPv6-compatible server in the network environment, select On in DHCPv6.

Note

• When there is no IPv6-compatible router or DHCPv6-compatible server, select On in Manual and enter the IPv6
Address and Prefix Length.

7 Click Set.

8 Click OK after the Confirmation message is displayed.

9 Exit imagePROGRAF Device Setup Utility.
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Status Monitor (Windows)Status Monitor (Windows)
The Features of imagePROGRAF Status Monitor .............................................................................................. 734
Job Management Using imagePROGRAF Status Monitor ................................................................................. 735

The Features of imagePROGRAF Status MonitorThe Features of imagePROGRAF Status Monitor
imagePROGRAF Status Monitor is a utility for checking the printer status and managing print jobs.
Two screens are available in imagePROGRAF Status Monitor : Printer List shows a list of printers, and Status Moni-
tor shows details for each printer.

• You can view a list of the printers for which printer drivers have been installed on your computer, printers connec-
ted to your computer, and printers found on the network.

• If a printer error occurs, you can investigate the corrective action immediately.

• Printer status can be checked in real time on a computer monitor.

• Displays the ink level of every color in the printer. An icon and warning message will notify you when ink levels are
low.

• The type of paper loaded in each media source is identified. You can also check to see if paper has run out.

• This way, the utility enables you to check printer information and take care of printer maintenance for optimal print-
ing results.

• You can also set up automatic email notification of any printer problems or errors to email addresses you desig-
nate in advance.
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• You can check the status of the hard disk and the documents saved on the hard disk.

• You can use the Accounting Manager to collect the print job logs for the printers and check information such as the
printing costs.
For details of the Accounting Manager, see Accounting Manager →P.740 .

Note

• For details, refer to the imagePROGRAF Status Monitor help.

Job Management Using imagePROGRAF Status MonitorJob Management Using imagePROGRAF Status Monitor
You can use the Job sheet in imagePROGRAF Status Monitor for operations such as pausing and canceling print jobs.

• Preempting Other Jobs
If you select a print job and click the Preempt Other Jobs button, the selected job is printed ahead of the job that
currently precedes it in the print queue.

• Pausing/Resuming Print Jobs
Selecting a print job and clicking the Pause button pauses printing of the selected job.
To resume printing of a paused print job, select the print job and click the Resume button.

Note

• Once all the print data for a print job has been sent to the printer, the job can no longer be paused/resumed.

• Canceling Print Jobs
Selecting a print job and clicking the Cancel Job button cancels printing of the selected job.

Note

• You cannot cancel other users' print jobs.

• Printing Held Jobs
Printing of the job with a Status of Holding is paused because the paper specified by the driver does not match
the paper currently loaded in the printer.
Use the procedure below to print the held job.

1 Select the held job and click the Replace Paper button.

2 Replace the paper in the printer with the correct paper.
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Note

• To continue printing without changing the paper in the printer, select the held job and click Continue to print button.

• The printing behavior when the paper specified by the driver does not match the paper currently loaded in the printer can be
changed by using Detect Mismatch in the operation panel menu. Refer to Menu Settings →P.667  for details.
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Printmonitor (Mac OS X)Printmonitor (Mac OS X)
The Features of imagePROGRAF Printmonitor .................................................................................................. 737
Job Management Using imagePROGRAF Printmonitor ..................................................................................... 738

The Features of imagePROGRAF PrintmonitorThe Features of imagePROGRAF Printmonitor
imagePROGRAF Printmonitor is a utility for checking the printer status and managing print jobs.

• Printer status can be checked in real time on a computer monitor.
• You can check the status of print jobs, cancel jobs, and manage them as needed.
• If a printer error occurs, you can investigate the corrective action immediately.

• You can also set up automatic email notification of any printer problems or errors to email addresses you desig-
nate in advance.

• You can check the status of the hard disk and the documents saved on the hard disk.

Note

• If the status of the desired printer is not shown in imagePROGRAF Printmonitor, select the printer again as follows.

1. Make sure the printer is on and connected to the network or to a local port.

2. In the Printer menu, select the name of the desired printer. After the printer is detected, the printer status is shown.

3. If information about the printer is not shown in step 2, choose Search Printer in the Printer menu. Printer names listed in
the Printer menu are updated with the printers that are now detected.

4. In the Printer menu, select the name of the desired printer. After the printer is detected, the printer status is shown.
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Job Management Using imagePROGRAF PrintmonitorJob Management Using imagePROGRAF Printmonitor
You can use the Driver Panel in imagePROGRAF Printmonitor for operations such as pausing and canceling print
jobs.

• Preempting Other Jobs

If you select a print job and click the  button, the selected job is printed ahead of the job that currently pre-
cedes it in the print queue.

• Pausing/Resuming Print Jobs

Selecting a print job and clicking the  button pauses printing of the selected job.

To resume printing of a paused print job, select the print job and click the  button.

Note

• Once all the print data for a print job has been sent to the printer, the job can no longer be paused/resumed.

• Canceling Print Jobs

Selecting a print job and clicking the  button cancels printing of the selected job.

Note

• You cannot cancel other users' print jobs.

• Printing Held Jobs
Printing of the job with a Status of Holding is paused because the paper specified by the driver does not match
the paper currently loaded in the printer.
Use the procedure below to print the held job.

1 Select the held job and click the Replace Paper button.

2 Replace the paper in the printer with the correct paper.
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Note

• To continue printing without changing the paper in the printer, select the held job and click Continue to print button.

iPF9400                                                                                                                                                      Job Management Using imagePROGRAF Printmonitor

User's Guide                                                                                                                                                                                                                                       

  

Print Job M
anagem

ent
Printm

onitor (M
ac O

S X)

739  



Accounting (Windows)Accounting (Windows)
Accounting Manager .......................................................................................................................................... 740
Launching the Accounting Manager .................................................................................................................. 740
Accounting Manager Main Window ................................................................................................................... 741

Job List Area ............................................................................................................................................ 743
Accounting Manager Basic Procedures ............................................................................................................ 744
Configuring Unit Costs in Accounting Manager ................................................................................................ 745

Setting the Unit Cost for Ink .......................................................................................................................... 745
Setting the Unit Cost for Paper ..................................................................................................................... 746
Setting the Unit Cost for Items Other Than Ink and Paper ............................................................................ 748

Configuring Units and Display Settings in Accounting Manager ....................................................................... 749
Automatically Acquiring Print Job Logs at Regular Intervals ............................................................................. 749
Canceling Regular Print Job Log Acquisition .................................................................................................... 750
Switching Between Displaying Jobs on Printer and Regularly Acquired Jobs .................................................. 750
Exporting Print Job Data as a CSV File .............................................................................................................. 750
Displaying Job Properties or Period Properties ................................................................................................. 751
Showing, Saving and Loading Selected Unit Cost Data .................................................................................... 752
Showing the Total Amount of Ink and Paper Consumed ................................................................................... 752

Accounting ManagerAccounting Manager
The Accounting Manager stores the printer's print job logs so that you can use the information for checking printing
costs, etc.
The benefits of using the Accounting Manager are outlined below.

• Print Job Log Collection
This allows you to check which documents were printed from each printer, who printed them and when.

• Calculation of the Total Pages Used and the Total Cost
This allows you to use the collected print job logs to calculate totals for items such as the number of pages printed,
the amount of paper used and the printing costs incurred.

• Regular Data Acquisition for Print Jobs
Job logs can be automatically collected periodically.

• Exporting Print Job Data
This allows you to export collected print job data as a CSV file.

Important

• The Accounting Manager in Status Monitor displays approximate estimates of the amount of paper consumed and the ink
consumed per job. Canon cannot guarantee the accuracy of these estimates. These estimates will also vary depending on
the conditions of printer use.

• Print job log collection is not performed when Set./Adj. Menu -> Printer Info -> Show Job Log of the control panel is Off.
However,

• even if Show Job Log is set to Off, regularly acquired jobs that already have been retrieved at that time are displayed.

• When Show Job Log has been set to On again, all jobs within the printer at that time are displayed.

Launching the Accounting ManagerLaunching the Accounting Manager
The procedure for launching the Accounting Manager is shown below.

1 Open the imagePROGRAF Status Monitor window.
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2
 

Select Accounting in the Accounting menu.
Or, open the Accounting sheet and click the Account-
ing button.

Accounting Manager Main WindowAccounting Manager Main Window
The Accounting Manager main window consists of a title bar, menu bar, toolbars, listed job selection area, job list area,
totals area and status bar.

• Title Bar
This displays the printer model, its serial number and the port number it is using.

• Menu Bar
Allows you to select the menu options required for operation.

• Toolbars
Provide tool buttons and pull-down menus for the main operations.

Note

• You can opt to either show or hide the toolbars in the View menu.

• Listed Job Selection Area
You can use this area to select which job log is displayed.
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If you are using regular data acquisition, this area allows you to view the collective job logs for each specified peri-
od.

For more information on how to select the job logs displayed, see Switching Between Displaying Jobs on Printer
and Regularly Acquired Jobs →P.750 .

• Job List Area
This area lists the details of acquired jobs.
Displays a list of the jobs in the printers or periodically acquired jobs.  (See "Job List Area.") →P.743

Note

• You can change the items that are displayed and the display order using the Advanced Display Settings dialog box.
The Advanced Display Settings dialog box can be displayed by selecting Advanced Display Settings from the Show
menu.

• Totals Area
Displays the total costs for the selected job and the amounts of paper and ink consumed.

Note

• If you are viewing regularly acquired print jobs, selecting a period on the left side of the window displays the total costs
for that period and the amounts of paper and ink consumed.
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• Status Bar
Displays messages and other information.

Job List AreaJob List Area
The job items and details that can be displayed in the job list area are as follows.

• No.
The job serial number.

• Job Cost
The cost of printing.

Note

• If the ink and paper unit costs are not set, **** is displayed.

• Document Name
This is the name of the printed document.

• Printing Results
OK is displayed when the print process was executed, and Cancel is displayed if the print process was not execu-
ted.

• Media Type
This is the type of paper used in printing.

• Output Image Size
The size of the image used for printing.

Note

• If the job has multiple pages, the size of the last page is displayed.

• Paper Consumed
The area of paper used for printing.

Note

• The Paper Consumed may differ from the product of Paper Width and Paper Length.

• Paper Width
The width of paper used for printing.
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Note

• If the job has multiple pages, the width of the last page is displayed.

• Paper Length
The length of paper used for printing.

• Ink Consumed
The amount of ink used for printing.

• Owner
The sender of the job.

• Print Job Start Time / Print Time
The time when printing started and the time taken to print.

• Number of Pages
The number of pages printed.

• Roll Paper Width
The width of roll paper used for printing.

• Paper Cost
The cost of paper used for printing.

Note

• If the paper unit cost is not set, **** is displayed.

• Total Ink Cost
The total value of the cost of ink used for printing.

Note

• If the ink unit cost is not set, **** is displayed.

• Total of Other Costs
The total value of costs other than paper and ink.

• Ink Cost Details
The cost of each ink color.

• Ink Consumption Details
The amount of each color of ink used.

Accounting Manager Basic ProceduresAccounting Manager Basic Procedures
The first time you use the Accounting Manager, use the following procedures to configure the settings.

1 Configure unit costs, including the costs of ink and paper.
For details of the unit cost settings, see Configuring Unit Costs in Accounting Manager →P.745 .

2 Set options such as the units displayed.
For details of the unit settings, see Configuring Units and Display Settings in Accounting Manager →P.749 .
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3 If you are using Regular Data Acquisition, configure the Regular Data Acquisition settings.
For details of the Regular Data Acquisition settings, see Automatically Acquiring Print Job Logs at Regular Inter-
vals →P.749 .

4 Specify the jobs to be listed.
For details of how to select the job logs displayed, see Switching Between Displaying Jobs on Printer and Regu-
larly Acquired Jobs →P.750 .

This displays the required print job logs and lists the details.

Configuring Unit Costs in Accounting ManagerConfiguring Unit Costs in Accounting Manager
Select Unit Costs in the Settings menu to open the Unit Costs dialog box. Configure the unit cost settings in this
dialog box.

Note

• When you select a job and then open the Unit Costs dialog box, items with unit costs that have not yet been configured for
that job are shown highlighted.

• Setting the Unit Cost for Ink →P.745
• Setting the Unit Cost for Paper →P.746
• Setting the Unit Cost for Items Other Than Ink and Paper →P.748

Setting the Unit Cost for InkSetting the Unit Cost for Ink
Open the Ink sheet. Set the unit cost for ink in this sheet.

To set the same unit cost for all the inks

1 Select the Use same price for all ink checkbox.
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2 Enter the Tank Capacity and corresponding Price.

3 Click the OK button.

Important

• Your settings are not applied until you click the OK button.

To set different unit costs for each ink color

1 Select the ink color to be costed.

2 Enter the Tank Capacity and corresponding Price.

3 Click the Overwrite button.

4 Repeat steps 1 to 3 for all the inks.

5 Click the OK button.

Important

• Your settings are not applied until you click the OK button.

Setting the Unit Cost for PaperSetting the Unit Cost for Paper
Opens the Paper sheet. This sheet is used to configure the unit cost of paper.
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Setting Standard Prices

1 Select the media type in Media Type.

2 Enter the Width and Length of the paper, as well as the Price for the area of the configured width x height.

3 Click the Add button. To change the unit cost of a media type that has already been configured, click the Over-
write button.

4 Click the OK button.

Important

• The settings are not applied until you click the OK button.

Specifying Price by Roll Paper

1 Select the media type in Media Type.

2
 

Click the Roll Paper Width Settings button to display
the Roll Paper Width Settings dialog box.

3 Enter the Roll Paper Width and Length of the paper, as well as the Price for the configured length.

4 Click the Add button to return to the Paper sheet.

5 To change the unit cost of a media type that has already been configured, click the Overwrite button.

6 Click the OK button.

Important

• If you do not set the standard prices, you cannot set the price for each roll paper.

• If the Roll Paper Width is set to the same value as the Width of the paper configured in the standard prices, the cost is
calculated using the price configured in the Roll Paper Width Settings dialog box.

• The settings are not applied until you click the OK button.
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Setting the Unit Cost for Items Other Than Ink and PaperSetting the Unit Cost for Items Other Than Ink and Paper
Open the Other sheet. Use this sheet to set any price for items other than inks and paper.

1 Enter any name in the Name field.

2 Enter a value in Unit Cost.

3 Use Allocated to specify whether the costs are allocated as being incurred by the print job.

4 Click the Add button. To change the unit cost for a media type you have already set, click the Overwrite but-
ton.

5 Click the OK button.

Important

• Your settings are not applied until you click the OK button.

Note

• You can set unit costs for up to 5 items.
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Configuring Units and Display Settings in Accounting ManagerConfiguring Units and Display Settings in Accounting Manager
Select Units and Display in the Settings menu to open the Units and Display dialog box. Use this dialog box to con-
figure the display settings.

• Date Display Format
Use this option to select the display format for dates. "YYYY" indicates the year, "MM" the month and "DD" the
day.

• Currency Unit
Enter the currency unit. Enter a text string up to 3 characters long.

• 1000 Separator
Use this option to select the symbol used as a separator in numbers. The symbol is inserted every 3 digits.

• Decimal Symbol
Use this option to select the symbol used as a decimal point.

• Ink Consumed
Use this option to select the unit used for ink consumption.

• Paper Width
Use this to select the unit used for paper width.

• Paper Length
Use this to select the unit used for paper length.

• Area Display Format
Use this to select the unit used for paper area.

Automatically Acquiring Print Job Logs at Regular IntervalsAutomatically Acquiring Print Job Logs at Regular Intervals
This feature collects print job logs from the printer at regular intervals and saves the logs on your computer.

1 Select Regular Data Acquisition in the Settings menu.

2 Select Acquire print job logs regularly.

3 Click the OK button to close the dialog box.

Important

• Print job log collection is not performed when Set./Adj. Menu -> Printer Info -> Show Job Log of the control panel is Off.
However, even if Show Job Log is set to Off, regularly acquired jobs that already have been retrieved at that time are dis-
played.
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Note

• Immediately after you configure Regular Data Acquisition, no print jobs are displayed. Wait a few moments and then select
Refresh in the View menu to display the print jobs.

• A maximum of 10,000 records are saved in a print job log. If this number is exceeded, jobs are deleted from the log starting
from the oldest record. To save old data, it is recommended that you export the data as a CSV file.
For details of how to export print job logs as CSV files, see Exporting Print Job Data as a CSV File →P.750 .

Canceling Regular Print Job Log AcquisitionCanceling Regular Print Job Log Acquisition
You can use this procedure to cancel the regular acquisition of print job logs from printers.

1 Select Regular Data Acquisition in the Settings menu.

2 Uncheck the Acquire print job logs regularly option.

3 Click the OK button to close the dialog box.

Switching Between Displaying Jobs on Printer and Regularly Acquired JobsSwitching Between Displaying Jobs on Printer and Regularly Acquired Jobs
The print job logs displayed by the Status Monitor Accounting Manager contain two types of job: Jobs on Printer and
Regularly Acquired Jobs.
You can select whether to display Jobs on Printer or Regularly Acquired Jobs in the Listed Job Selection Area on the
left side of the window.

• Jobs on Printer
This shows a list of the print jobs currently held on printers.
You can change the number of jobs displayed per page using the Print Jobs Shown Per Page setting in the View
menu or the toolbar.
You can skip to a particular page using the Go to option in the View menu or the toolbar.

Note

• For printers with built-in hard disks, you can view up to 500 print jobs per printer.

• For printers without built-in hard disks, you can view up to 32 print jobs per printer. However, only 10 jobs can be dis-
played if the printer is switched off.

• Regularly Acquired Jobs
This shows a list of regularly acquired print jobs.
To view all the jobs in a set period, specify the period using Calculate Total for Period and then Starting Date (or
Starting Day of Week or Starting Month) in the View menu or the toolbar.
For example, to view monthly job logs starting on the 1st of each month, set Calculate Total for Period to Month-
ly and set Starting Date to 1.

Note

• Up to 10,000 regularly acquired jobs are displayed for each printer.

Exporting Print Job Data as a CSV FileExporting Print Job Data as a CSV File
You can export the collected print job data in the form of a CSV file by selecting Export Job Cost Data in the File
menu.

Note

• You can also select Export Job Cost Data using the icon in the toolbar.
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• Selected Jobs
Exports the data for the selected print jobs in the job list as a CSV file.

Note

• You can select multiple jobs by holding down the Shift key or Ctrl key as you click the job names.

• Listed Jobs
Exports the data for the print jobs currently displayed in the list as a CSV file.

Displaying Job Properties or Period PropertiesDisplaying Job Properties or Period Properties
You can display the Job properties dialog box or Period Properties dialog box to check detailed cost information and
other items.
The Job properties dialog box displays detailed information about the selected job.
The Period Properties dialog box displays detailed information within the Regularly Acquired Jobs period.

• Displaying the Job properties Dialog Box
Select a job from the job list, and then select Show Job Properties from Job properties in the File menu. You
can also select multiple jobs at once.

Note

• You can also display the dialog box by selecting a job, right-clicking it, and then selecting Show Job Properties, or by
using the icon in the toolbar.

• Displaying the Period Properties Dialog Box
Select a period from the Regularly Acquired Jobs list, and then select Show Period Properties from Job prop-
erties in the File menu. You can also select multiple periods at once.

Note

• You can also display the dialog box by selecting and right-clicking a period and then selecting Show Period Properties,
or by using the icon in the toolbar.
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• Components of the Job properties Dialog Box/ Period Properties Dialog Box

• Job tab
Displays detailed information about the selected job. You can display detailed information about each job by
selecting the corresponding Document Name.

• Owner tab
You can display detailed information about each owner by selecting the corresponding Owner.

• Copy button
Click this button to copy the displayed text information to the clipboard.

Showing, Saving and Loading Selected Unit Cost DataShowing, Saving and Loading Selected Unit Cost Data

• Show Unit Cost Data
Select Show Unit Cost Data in the File menu to open the Unit Cost Data dialog box. This lists the unit costs for
items such as the selected ink and paper.
You can copy text-based information in this dialog box to the clipboard by clicking the Copy button.

• Save Unit Cost Data
Select a destination folder using Save Unit Cost Data in the File menu. The unit cost data for items such as the
selected ink and paper is saved as a file.

• Load Unit Cost Data
Selecting Load Unit Cost Data in the File menu loads saved unit cost data.

Showing the Total Amount of Ink and Paper ConsumedShowing the Total Amount of Ink and Paper Consumed
Select Show Ink and Paper Consumed in the File menu to open the Show Ink and Paper Consumed dialog box.
This lists the total amounts of ink and paper consumed by the printer so far.
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You can copy text-based information in this dialog box to the clipboard by clicking the Copy button.

Note

• Up to 7 types of media are listed in order of the amount consumed. The total consumption for other media types is shown as
Other.
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Basic Print Job OperationsBasic Print Job Operations
Using the Printer Hard Disk ................................................................................................................................ 754
Saving Print Jobs on the Printer Hard Disk ........................................................................................................ 756
Managing the Job Queue (Deleting or Preempting Other Jobs) ....................................................................... 759
Managing Pending Jobs (Printing or Deleting Jobs on Hold) ........................................................................... 761
Printing Saved Jobs ........................................................................................................................................... 763
Deleting Saved Jobs .......................................................................................................................................... 768
Moving Saved Jobs ............................................................................................................................................ 772

Using the Printer Hard DiskUsing the Printer Hard Disk
The printer can save print jobs on the built-in hard disk.
Using print jobs stored on the printer enables you to print the jobs again as needed without using a computer.

Saving print jobs offers the following benefits.

• Save the time spent using a computer
When you send a print job to the printer, you can save it on the printer after printing or simply save it on the printer
without printing it yet. Saved print jobs can be printed in the required quantity later without the need to use a com-
puter again.

• Simplify reprinting, if any errors occur
If errors occur in the middle of printing (as when paper runs out), you can resume printing after clearing the error
without resending the print job from a computer.

• Streamline printing work
Without using a computer, you can select print jobs and print in the desired quantity. You can also select multiple
print jobs to print during the same period. This enables unattended operation at night, for example.

Output Method
To save print jobs on the printer's hard disk, configure the printer driver.
In Windows, this is set using the Output Method dialog box.
In Mac OS X, this is set using the Additional Settings pane.

• Print
Save print jobs on the printer's hard disk after printing.

• Save in mail box
Save print jobs on the printer's hard disk.

• Print after reception is complete
This option is available in combination with Print. You can prevent degradation of print quality that occurs when
receiving a print job is interrupted and printing is aborted in the middle.
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Storage destination
The storage area on the printer's hard disk is divided into a temporary storage area and a permanent storage area. The
temporary storage area stores print jobs in the job queue or shared mailbox. The permanent storage area stores jobs
in personal boxes.

• Job queue
The job queue refers to print jobs that are being processed by the printer (saved, received, prepared for process-
ing, printed, deleted, or held). Up to 64 jobs can be stored in the temporary storage area.
When the job queue is full, additional jobs sent from a computer are treated as "standby" jobs, to be processed
when possible.
However, if all queued jobs are simply being held, the oldest job is deleted and the print job sent from the comput-
er is processed.

• Shared mailbox
Jobs for which you have specified Print in Output Method (in Windows) or Send job to (in Mac OS X) are saved
in the shared mailbox and classified as saved jobs.
There is one shared mailbox, numbered 00. A password cannot be set for the shared mailbox.
Up to 100 print jobs can be saved here, but they will be deleted one after another starting with the oldest job in the
following situations.

• If there are more than 100 jobs queued and saved in the shared mailbox combined

• If no more temporary storage space is available when jobs for which you have selected Print in Output Meth-
od (in Windows) or Send job to (in Mac OS X) are received

• If there is not enough space in the temporary or permanent storage area when jobs for which you have selec-
ted Save in mail box in Output Method (in Windows) or Send job to (in Mac OS X) are received

• Personal boxes
Jobs are classified as saved jobs and saved in personal boxes in the following situations.

• When a saved job stored in the shared mailbox is moved to a personal box

• When you have selected Save in mail box as the option in Output Method (in Windows) or Send job to (in
Mac OS X)

There are 29 personal boxes, numbered 01 to 29. You can specify a name and password for each personal box.
Up to 100 print jobs can be saved in all personal boxes combined.
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Saving Print Jobs on the Printer Hard DiskSaving Print Jobs on the Printer Hard Disk
To save print jobs on the printer's hard disk, configure the printer driver.

Note

• Printing from the following software also enables you to save print jobs on the printer's hard disk.
Windows

• Print Plug-In →P.251

Mac OS

• Print Plug-In →P.458

Configuring the Printer Driver in Windows

1
 

Access the Page Setup sheet.
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2
 

Click Output Method to display the Output Method di-
alog box.

3 Make your selection in Output Method.

• Print
Save print jobs on the printer's hard disk after printing.

• Save in mail box
Save print jobs on the printer's hard disk.
If you choose Save in mail box, also specify the destination personal box in the Mail box list.

• Print after reception is complete
This option is available in combination with Print. You can prevent degradation of print quality that occurs
when receiving a print job is interrupted and printing is aborted in the middle.

Note

• Click Acquire Mail Box Name to display personal box names in the Mail box list, as acquired from the printer.

4 In Name of data to be saved, specify how to name saved print jobs.

• To use the file name, choose Use file name.
• Otherwise choose Enter name and enter a name in Name.

5 Click OK to close the Output Method dialog box.
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Configuring the printer driver in Mac OS

1
 

Access the Additional Settings pane.

2 Make your selection in Send job to.

• Print
Save print jobs on the printer's hard disk after printing.

• Save in mail box
Save print jobs on the printer's hard disk.
The Destination dialog box is displayed if you se-
lect Save in mail box. Here, specify the name and
personal box number for saved print jobs.

1. In Document title, enter a name to identify saved print jobs.

Note

• If printed from Free Layout or Preview, the Document title is saved under the name imagePROGRAF.

2. Select the personal box number in the Mail box list.

3. Click OK to close the Destination dialog box.

• Print after reception is complete
This option is available in combination with Print. You can prevent degradation of print quality that occurs
when receiving a print job is interrupted and printing is aborted in the middle.

 

 

Saving Print Jobs on the Printer Hard Disk                                                                                                                                                                         iPF9400

                                                                                                                                                                                                                                       User's Guide

  

Print Job M
anagem

ent
B

asic Print Job O
perations

 758



Managing the Job Queue (Deleting or Preempting Other Jobs)Managing the Job Queue (Deleting or Preempting Other Jobs)
Print jobs being processed by the printer are collectively called the job queue. You can delete or preempt jobs in the
job queue as needed.
These operations are available from the Control Panel or in RemoteUI, imagePROGRAF Status Monitor, and image-
PROGRAF Printmonitor.

• Delete
Note that only jobs that are not currently being deleted can be deleted from the job queue.

• Preempting other jobs
You can preempt other jobs by printing jobs that are currently being received or prepared for processing first.

Note

• For information on managing jobs being held, see "Managing Pending Jobs (Printing or Deleting Jobs on Hold)." →P.761

Using the Control Panel

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Job tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.
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2 Press the OK button.
The Job Menu is displayed.

3 Manage the job queue as needed.

• Deleting jobs

1. Press ▲ or ▼ to select Print Job, and then press the OK button.

2. Press ▲ or ▼ to select the print job to delete, and then press the OK button.

3. Press ▲ or ▼ to select Delete, and then press the OK button.

• Preempting other jobs

1. Press ▲ or ▼ to select Print Job, and then press the OK button.

2. Press ▲ or ▼ to select the job to print first, and then press the OK button.

3. Press ▲ or ▼ to select Preempt Jobs, and then press the OK button.

Using RemoteUI
Manage jobs as needed on the Print Job page. For details, refer to the RemoteUI help.

Using imagePROGRAF Status Monitor (Windows)
Manage jobs as needed on the Job sheet. For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor (Mac OS)
Manage jobs as needed on the Driver sheet. For details, refer to the imagePROGRAF Printmonitor help file.

Managing Pending Jobs (Printing or Deleting Jobs on Hold)Managing Pending Jobs (Printing or Deleting Jobs on Hold)
If the type or size of paper loaded does not match the settings in the print job received when you have set Detect Mis-
match to Hold Job in the Control Panel menu, the print job is held on the printer as a pending job in the job queue.
Manage held jobs such as these as follows.
These operations are available from the Control Panel or in RemoteUI, imagePROGRAF Status Monitor, and image-
PROGRAF Printmonitor.

Note

• As long as you do not manage held jobs from the Control Panel, imagePROGRAF Status Monitor, or imagePROGRAF Print-
monitor, they will remain in the job queue. In this case, the printer processes the next job in the queue without pausing.

• To print held jobs, replace the loaded paper with the paper specified in the print job.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

Using the Control Panel

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Job tab ( ).
"There are held jobs." is displayed if jobs are being held.

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu menu is displayed.

3 Press ▲ or ▼ to select Print Job, and then press the OK button.
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4
 

Press ▲ or ▼ to select the print job to manage, and then press the OK
button.
Held jobs are labeled with an icon.

5 Press ▲ or ▼ to select Print Anyway or Delete, and then press the OK button.

• If you choose Print Anyway
Press ▲ or ▼ to select Yes or No, and then press the OK button.

• If you choose Delete
Press ▲ or ▼ to select Yes or No, and then press the OK button.

Using RemoteUI
Manage jobs as needed on the Print Job page. For details, refer to the RemoteUI help file.

Using imagePROGRAF Status Monitor
Manage jobs as needed on the Job sheet. For details, see "Job Management Using imagePROGRAF Status Monitor."
→P.735
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Using imagePROGRAF Printmonitor
Manage jobs as needed on the Driver sheet. For details, see "Job Management Using imagePROGRAF Printmonitor."
→P.738

Printing Saved JobsPrinting Saved Jobs
Print saved print jobs stored on the printer's hard disk as follows.
These operations are available from the Control Panel or in RemoteUI, imagePROGRAF Status Monitor, and image-
PROGRAF Printmonitor.

Using the Control Panel

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Job tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu menu is displayed.

3 Press ▲ or ▼ to select Stored Job, and then press the OK button.
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4 Press ▲ or ▼ to select the box number (in the range 00–29), and then press the OK button.

Note

• Enter a password if one has been set, and then press the OK button.

5 Press ▲ or ▼ to select Job List, and then press the OK button.

6 Press ▲ or ▼ to select the saved job, and then press the OK button.

7 Press ▲ or ▼ to select Print, and then press the OK button.

8 Specify the number of copies and press the OK button.

Using RemoteUI

1
 

On the Stored Job page, choose the box.

Note

• Enter a password if one has been set.

 

2
 

Select the print job and click Resume.
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3
 

On the Print Saved Document page, enter the quanti-
ty to print in Copies and click OK.

For details, refer to the RemoteUI help.
 

Using imagePROGRAF Status Monitor

1
 

On the Hard Disk sheet, select a box and click Open.

Note

• Enter a password if one has been set.
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2
 

In the Documents dialog box, select the print job and
click Print.

3
 

In the Print dialog box, enter the quantity to print in
Copies and click OK.

Note

• The printing time initially indicates how long it took to finish printing one copy during the previous print job.
If you change the value in Copies, the printing time indicates the time it took to print one copy during the previous
print job multiplied by the number of copies.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor

1
 

On the Hard Disk pane, click ▶ by Inbox No./Name.

Note

• Enter a password if one has been set.
The password is a four-digit number.

 

2
 

Select the saved job and click Resume Printing.
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3
 

In the Resume Printing dialog box, enter the quantity
to print and click OK.

For details, refer to the imagePROGRAF Printmonitor help file.

Deleting Saved JobsDeleting Saved Jobs
Delete saved print jobs stored on the printer's hard disk as follows.
This operation is available from the Control Panel, in RemoteUI, imagePROGRAF Status Monitor, and imagePROG-
RAF Printmonitor.

Using the Control Panel

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Job tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu is displayed.

3 Press ▲ or ▼ to select Stored Job, and then press the OK button.

4 Press ▲ or ▼ to select the box number (in the range 00–29), and then press the OK button.

Note

• Enter a password if one has been set, and then press the OK button.

5 Press ▲ or ▼ to select Job List, and then press the OK button.

6 Press ▲ or ▼ to select the saved job, and then press the OK button.

7 Press ▲ or ▼ to select Delete, and then press the OK button.

8 Press ▲ or ▼ to select "Yes", and then press the OK button.
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Using RemoteUI

1
 

On the Stored Job page, choose the mail box.

Note

• Enter a password if one has been set.

 

2
 

Select the print job and click Delete.

For details, refer to the RemoteUI help file.
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Using imagePROGRAF Status Monitor

1
 

On the Hard Disk sheet, select a box and click Open.

Note

• Enter a password if one has been set.

 

2
 

In the Documents dialog box, select the print job and
click Delete.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor

1
 

In the Hard Disk pane, click ▶ next to Inbox No./
Name.

Note

• Enter a password if one has been set.
The password is a four-digit number.

 

2
 

Select the print job and click the Delete button.

For details, refer to the imagePROGRAF Printmonitor help file.
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Moving Saved JobsMoving Saved Jobs
Print jobs stored on the printer's hard disk (saved jobs) can be moved from the current box to another box as follows.
However, jobs saved in personal boxes cannot be moved to the shared mailbox.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.

Important

• Jobs stored in the shared mailbox may be automatically deleted under some conditions. To prevent jobs from being deleted,
move them from the shared mailbox to personal boxes.  (See "Using the Printer Hard Disk.") →P.754

Using RemoteUI

1
 

On the Stored Job page, choose the box.

Note

• Enter a password if one has been set.

 

2
 

Select the print job and click Move Document.
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3
 

On the Move Document page, select the name or
number of the destination personal box in the Destina-
tion mail box list and click OK.

For details, refer to the RemoteUI help file.
 

Using imagePROGRAF Status Monitor (Windows)

1
 

On the Hard Disk sheet, select a box and click Open.

Note

• Enter a password if one has been set.
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2
 

In the Documents dialog box, select the print job and
click Move.

3
 

In the Move dialog box, select the destination personal
box and click OK.

For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor (Macintosh)

1
 

In the Hard Disk pane, click ▶ next to Inbox No./
Name.
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Note

• Enter a password if one has been set.
The password is a four-digit number.

 

2
 

Select the print job and click Move.

3
 

In the Move Document dialog box, select the destina-
tion personal box and click OK.

For details, refer to the imagePROGRAF Printmonitor help file.

 

 

iPF9400                                                                                                                                                                                                             Moving Saved Jobs

User's Guide                                                                                                                                                                                                                                       

  

Print Job M
anagem

ent
B

asic Print Job O
perations

775  



Advanced Print Job OperationsAdvanced Print Job Operations
Saving Print Jobs Sent from Sources Other than the Printer Driver ................................................................... 776
Printing Without Saving Jobs in the Common Box ............................................................................................. 777
Setting Passwords for Personal Boxes .............................................................................................................. 778
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Displaying a List of Saved Jobs ......................................................................................................................... 784
Printing a List of Saved Jobs .............................................................................................................................. 787
Displaying Details of Saved Jobs ...................................................................................................................... 788
Renaming Saved Jobs ....................................................................................................................................... 791
Printer Hard Disk Operations ............................................................................................................................. 693
Checking the Free Hard Disk Space ................................................................................................................. 694

Saving Print Jobs Sent from Sources Other than the Printer DriverSaving Print Jobs Sent from Sources Other than the Printer Driver
To save print jobs sent from software or systems other than the printer driver or applications provided with the printer,
complete the Output Method and Print After Recv settings in the Control Panel menu.

Note

• Contact the software or system developer for information about support for this printer function.

Specifying Output Method
In Output Method, specify how to manage jobs, regarding printing and saving them.

• Print
Save print jobs automatically at the same time they are printed. (This is the default format.)

• Print (Auto Del)
Save print jobs temporarily at the same time they are printed and delete them after printing.

• Save: Box 01 (Here, the number represents a box number)
Save print jobs on the printer.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.
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3 Press ▲ or ▼ to select System Setup, and then press the OK button.

4 Press ▲ or ▼ to select Output Method, and then press the OK button.

5 Press ▲ or ▼ to select Print, Print (Auto Del), or Save: Box 01.
Follow these steps only when you select Save: Box 01.

6 Press ▲ or ▼ to select the box, and then press the OK button.

Specify Print After Recv
To save print jobs on the hard disk before printing, specify Print After Recv.
Printing will start when Print After Recv is set to On, even if you have selected Save: Box 01 in Output Method.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select System Setup, and then press the OK button.

4 Press ▲ or ▼ to select Print After Recv, and then press the OK button.

5 Press ▲ or ▼ to select On or Off, and then press the OK button.

Printing Without Saving Jobs in the Common BoxPrinting Without Saving Jobs in the Common Box
Jobs sent from a computer for which you have selected Print in Output Method (in Windows) or Send job to (in Mac
OS X) in the printer driver are saved in the shared mailbox.  (See "Using the Printer Hard Disk.") →P.754
When Common Box Set. is Print (Auto Del) in the Control Panel menu, print jobs for which you have selected Print
in the Output Method dialog box of the printer driver are deleted from the shared mailbox after printing.
Use this function when printing highly confidential documents.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.
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2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select System Setup, and then press the OK button.

4 Press ▲ or ▼ to select Common Box Set., and then press the OK button.

Note

• If a password has been set on the printer, the Logon screen is displayed.
To change the setting, select Administrator and press the OK button. Enter the password when Admin.Pswd is
displayed and press the OK button before going to the next procedure.
If you select User and press the OK button, you can check settings values but cannot change them.

5 Press ▲ or ▼ to select Print (Auto Del), and then press the OK button.

Setting Passwords for Personal BoxesSetting Passwords for Personal Boxes
For greater security, you can specify a password for personal boxes. After you set a password, it will be required to
modify the personal box settings, as well as to display, print, delete, move, and modify jobs saved in the personal box.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.

Note

• By default, no passwords are set for personal boxes.
• A password cannot be set for the shared mailbox.
• Enter a four-digit number as the password, in the range 0001–9999.

• Even if you have set passwords, they are not required to access personal boxes in Administrator Mode in RemoteUI.

Using RemoteUI

1 On the Stored Job page, choose the personal box.

2
 

Click Edit.

3 In the Set/Register User's Inbox dialog box, specify the password and click OK.

• Set Password
Select the check box.

• Password
Enter the password. (This field is limited to four digits in the range 0001–9999.)

• Confirmation Number
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Re-enter the password to confirm it.

For details, refer to the RemoteUI help.
 

Using imagePROGRAF Status Monitor (Windows)

1
 

On the Hard Disk sheet, select the personal box and
click Open.

2
 

In the Documents dialog box, click Settings.

3 In the Settings dialog box, specify the password and click OK.

• Set password
Select the check box.
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• Password
Enter the password. (This field is limited to four digits in the range 0001–9999.)

• Re-enter to confirm
Re-enter the password to confirm it.

For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor (Macintosh)

1
 

On the Hard Disk pane, click ▶ by Inbox No./Name.
Select a saved job in the list and click Set.

2 In the Settings dialog box, specify the password and click OK.

• Set password
Select the check box.

• Password
Enter the password. (This field is limited to four digits in the range 0001–9999.)

• Verify
Re-enter the password to confirm it.
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For details, refer to the imagePROGRAF Printmonitor help file.

Naming Personal BoxesNaming Personal Boxes
For easier identification, you can assign names to personal boxes.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.

Using RemoteUI

1
 

On the Stored Job page, choose the personal box.

Note

• Enter a password if one has been set for the personal box.

 

2
 

Click Edit.
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3
 

In the Set/Register User's Inbox dialog box, enter the
name in Inbox Name and click OK.

For details, refer to the RemoteUI help file.

 

Using imagePROGRAF Status Monitor (Windows)

1
 

On the Hard Disk sheet, select the personal box and
click Open.

Note

• Enter a password if one has been set for the personal box.
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2
 

In the Documents dialog box, click Settings.

3
 

In the Settings dialog box, enter the name and click
OK.

For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor (Macintosh)

1
 

In the Hard Disk pane, click ▶ next to Inbox No./
Name. Select a saved job in the list and click Set.
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Note

• Enter a password if one has been set.
The password is a four-digit number.

 

2
 

In the Settings dialog box, enter the name and click
OK.

For details, refer to the imagePROGRAF Printmonitor help file.

Displaying a List of Saved JobsDisplaying a List of Saved Jobs
Print jobs stored on the printer's hard disk (saved jobs) can be listed by box as follows.
These operations are available from the Control Panel or in RemoteUI, imagePROGRAF Status Monitor, and image-
PROGRAF Printmonitor.

Using the Control Panel

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Job tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu is displayed.

3 Press ▲ or ▼ to select Stored Job, and then press the OK button.
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4 Press ▲ or ▼ to select the box number (in the range 00–29), and then press the OK button.

Note

• Enter a password if one has been set, and then press the OK button.

5 Press ▲ or ▼ to select Job List, and then press the OK button.

Using RemoteUI
On the Stored Job page, choose the box.

Note

• Enter a password if one has been set.

Jobs saved in the box are listed.

For details, refer to the RemoteUI help.
 

iPF9400                                                                                                                                                                                          Displaying a List of Saved Jobs

User's Guide                                                                                                                                                                                                                                       

  

Print Job M
anagem

ent
A

dvanced Print Job O
perations

785  



Using imagePROGRAF Status Monitor (Windows)
On the Hard Disk sheet, select a box and click Open.

Note

• Enter a password if one has been set.

Jobs saved in that box are displayed in the Documents dialog box.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor (Macintosh)
On the Hard Disk pane, click ▶ by Inbox No./Name.

Note

• Enter a password if one has been set.
The password is a four-digit number.

For details, refer to the imagePROGRAF Printmonitor help file.

Printing a List of Saved JobsPrinting a List of Saved Jobs
The list of print jobs stored on the printer's hard disk (saved jobs) can be printed by box as follows.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Job tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu is displayed.
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3 Press ▲ or ▼ to select Stored Job, and then press the OK button.

4 Press ▲ or ▼ to select the box number (in the range 00–29), and then press the OK button.

Note

• Enter a password if one has been set, and then press the OK button.

5 Press ▲ or ▼ to select Print Job List, and then press the OK button.

Displaying Details of Saved JobsDisplaying Details of Saved Jobs
Details of print jobs stored on the printer's hard disk (saved jobs) can be displayed as follows.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.

Using RemoteUI

1
 

On the Stored Job page, choose the box.

Note

• Enter a password if one has been set.

 

2
 

Select the print job and click Details.
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The Details of the saved document page is dis-
played.

For details, refer to the RemoteUI help file.
 

Using imagePROGRAF Status Monitor (Windows)

1
 

On the Hard Disk sheet, select a box and click Open.

Note

• Enter a password if one has been set.
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2
 

In the Documents dialog box, select the print job and
click Properties.

The Properties dialog box is displayed.

For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor (Macintosh)

1
 

In the Hard Disk pane, click ▶ next to Inbox No./
Name.
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Note

• Enter a password if one has been set.
The password is a four-digit number.

 

For details, refer to the imagePROGRAF Printmonitor help file.

Renaming Saved JobsRenaming Saved Jobs
Print jobs stored on the printer's hard disk (saved jobs) can be renamed as follows.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.

Using RemoteUI

1
 

On the Stored Job page, choose the box.

Note

• Enter a password if one has been set.

 

2
 

Select the print job and click Details.
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3
 

On the Details of the saved document page, click
Change Document.

4
 

In the Rename Saved Document dialog box, enter the
name and click OK.

For details, refer to the RemoteUI help file.
 

Using imagePROGRAF Status Monitor (Windows)

1
 

On the Hard Disk sheet, select a box and click Open.

Note

• Enter a password if one has been set.
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2
 

In the Documents dialog box, select the print job and
click Properties.

3
 

In the Properties dialog box, enter the new name and
click OK.

For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor (Macintosh)

1
 

In the Hard Disk pane, click ▶ next to Inbox No./
Name.
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Note

• Enter a password if one has been set.
The password is a four-digit number.

 

2
 

Select the print job and click Set.

3
 

In the Settings dialog box, enter the new name and
click OK.

For details, refer to the imagePROGRAF Printmonitor help file.
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Adjustment for high-precision printingAdjustment for high-precision printing
Enhancing Printing QualityEnhancing Printing Quality

With some types of paper and under some conditions, adjusting the printer as follows with the paper to be used can
enhance printing quality when printing fine lines/text or photos.
Two adjustment options are available: standard adjustment (with the Printhead height set to Automatic) and supple-
mental adjustment (used if standard adjustment is not effective).

Important

• Ideal temperature and humidity during adjustment and for printing in general when the Printhead height is set to Automatic
are 20–30ºC and 30–60%. Under other environmental conditions, adjustment may not enhance printing quality.

Standard Adjustment
Perform standard adjustment with the Printhead height set to Automatic.

1 Load paper in the printer.

• Attaching the Roll Holder to Rolls →P.530
• Loading Rolls in the Printer →P.533

2 On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Head Posi. Adj., and then press the OK button.

6 Press ▲ or ▼ to select Standard, and then press the OK button.

A test pattern is printed for adjustment. This process will take about 13 minutes.

Note

• If standard adjustment does not enhance printing quality, next try supplemental adjustment, which may be helpful.

Supplemental Adjustment
Perform supplemental adjustment with the Printhead height set to Super Low.

Important

• Printing with Head Height set to Super Low may enhance printing quality, but it may also cause paper to rub against or
become caught on the Printhead, which may cause paper jams or soiling on printed documents.

Note

• We recommend that additional adjustment be executed using paper matching the following criteria.
Type: Glossy or semi-glossy photo paper, or proofing paper (in either case, roll paper only)
Thickness/weight: 300 μm or less, or 300 g/m² or less
Width: 420.0 mm (16.54 in.) or more
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1 Set Head Height to Super Low.  (See "Troubleshooting Paper Abrasion and Blurry Images.") →P.803

Note

• If Super Low is not available, select Lowest.

2 Execute Standard in Head Posi. Adj..

Note

• If paper rubs against the Printhead or becomes jammed during Printhead height adjustment, try selecting a higher
level in Head Height and performing Standard again.
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Adjusting the PrintheadAdjusting the Printhead
Adjusting the Printhead ...................................................................................................................................... 798

Automatic Adjustment to Straighten Lines and Colors ................................................................................. 798
Manual Adjustment to Straighten Lines and Colors ...................................................................................... 800
Adjustment When Installing the Printhead .................................................................................................... 802

Troubleshooting Paper Abrasion and Blurry Images ......................................................................................... 803

Adjusting the PrintheadAdjusting the Printhead
If printed documents are affected by the following problems, try adjusting the printhead.

• Printing is faint or affected by banding in different colors
Execute Nozzle Check in the Control Panel menu to check for printhead nozzle clogging.
For instructions, see "Checking for Nozzle Clogging." →P.838

• Printed vertical lines are warped or colors are out of alignment
Execute Head Posi. Adj. in the Control Panel menu to adjust the printhead position.

• Normally, execute Standard.
 (See "Automatic Adjustment to Straighten Lines and Colors.") →P.798

• When printing on special paper, or if printing is not improved after Standard, try Manual.
 (See "Manual Adjustment to Straighten Lines and Colors.") →P.800

Note

• In the next case, execute Initial adjustmt.
 (See "Adjustment When Installing the Printhead.") →P.802

• If adjusting the printhead position has not been performed such as due to an error during initial setup

• If Rep.P.head Print in the Control Panel menu is set to Off and adjusting the printhead position has not been
performed when replacing the printhead

• Paper rubs against the printhead, or image edges are blurred
Selecting Head Height in the Control Panel menu and changing the printhead height may improve the situation.
 (See "Troubleshooting Paper Abrasion and Blurry Images.") →P.803

Automatic Adjustment to Straighten Lines and ColorsAutomatic Adjustment to Straighten Lines and Colors
If vertical lines in printed documents are warped or colors are out of alignment, execute Head Posi. Adj.. The printer
will print and read a test pattern, and the Printhead position will be adjusted automatically.
There are two modes for automatic Printhead adjustment: Standard and Simple.

• Standard
Execute if vertical lines in printed material are warped or colors are out of alignment.
Furthermore, if Simple does not improve printing, try Standard.

• Simple
Executes simple adjustment in a short time.
Execute this when frequently adjusting the printhead, such as during daily inspection.
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Important

• This function is not available with CAD Tracing Paper, CAD Translucent Matte Film, or CAD Clear Film.

• If adjustment is not possible as expected using special media, try another type of paper, or try Manual adjustment.
 (See "Manual Adjustment to Straighten Lines and Colors.") →P.800

Note

• Because the results of adjustment vary depending on the type of paper used for adjustment, use the same type of paper as
you will use for printing.

• If Standard does not improve printing, try adjusting the printhead manually.
 (See "Manual Adjustment to Straighten Lines and Colors.") →P.800

• If the printhead position was not adjusted during initial setup or when the printhead was replaced, execute Initial adjustmt.
 (See "Adjustment When Installing the Printhead.") →P.802

• Advanced adjustment can enable superior printing quality when printing fine lines or text at high precision on glossy or semi-
glossy photo or proofing paper.
 (See "Enhancing Printing Quality.") →P.796

Items to Prepare
When Using Rolls An unused roll at least 254.0 mm (10.00 in) wide

When Using Sheets Standard : Six sheets of unused paper, A4/Letter size (or one sheet when using A2)
Simple : One sheet of unused paper, A4/Letter size

Perform adjustment as follows.

1 Load paper.

• Attaching the Roll Holder to Rolls →P.530
• Loading Rolls in the Printer →P.533
• Loading Sheets in the Printer →P.555

Important

• Always make sure the loaded paper matches the type of paper specified on the printer. Adjustment cannot be com-
pleted correctly unless the loaded paper matches the settings.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.
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4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Head Posi. Adj., and then press the OK button.

6 Press ▲ or ▼ to select Standard or Simple, and then press the OK button.
A test pattern is printed for adjustment.
Adjustment is now finished if you have printed on a roll.

7 If you are printing on cut sheets, a confirmation message is displayed on the Display Screen asking you wheth-
er to continue printing.
Press the OK button and follow the instructions on the Display Screen.

Manual Adjustment to Straighten Lines and ColorsManual Adjustment to Straighten Lines and Colors
If printed vertical lines are warped or colors are out of alignment, execute Head Posi. Adj. to adjust the Printhead
alignment.
Normally, execute Standard.
 (See "Automatic Adjustment to Straighten Lines and Colors.") →P.798
However, when printing on special paper, or if printing is not improved after Standard, try Manual.
Manual adjustment requires you to examine the printed test pattern and enter an adjustment value.

Note

• We recommend using the type of paper you use most often for adjustment.

• If the printhead position was not adjusted during initial setup or when the printhead was replaced, execute Initial adjustmt.
 (See "Adjustment When Installing the Printhead.") →P.802

Items to Prepare
When Using Rolls An unused roll at least 254.0 mm (10.00 in) wide

When Using Sheets Three sheets of unused paper, A4/Letter size (or one sheet when using A2)

Perform adjustment as follows.

1 Load paper.

• Attaching the Roll Holder to Rolls →P.530
• Loading Rolls in the Printer →P.533
• Loading Sheets in the Printer →P.555

Important

• Always make sure the loaded paper matches the type of paper specified on the printer. Adjustment cannot be
completed correctly unless the loaded paper matches the settings.
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2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Head Posi. Adj., and then press the OK button.

6 Press ▲ or ▼ to select Other, and then press the OK button.

7 Press ▲ or ▼ to select Manual, and then press the OK button.
A test pattern is printed for adjustment.

Note

• Manual may be unavailable in some cases, even if it is displayed in the menu.
If so, execute Standard once.
 (See "Automatic Adjustment to Straighten Lines and Colors.") →P.798

8 Press ▲ or ▼ to select D, and then press the OK button.

9 Press ▲ or ▼ to select D-1, and then press the OK button.

10
 

Examine adjustment test pattern D-1 and determine the number
with straight lines.

Note

• If two patterns seem equally good and you cannot decide which one is better, choose an intermediate value.
For example, choose 11 if you cannot decide whether pattern 10 or 12 is better.

11 Press ▲ or ▼ to select the pattern number you have decided, and then press the OK button.

12 Repeat steps 8–10 to specify the adjustment value for D-1 to D-36.
Note that D-6, D-18, and D-30 cannot be configured.
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13 Press the Back button.

14 Press ▲ or ▼ to select Register Setting, and then press the OK button.

15 Press ▲ or ▼ to select Yes, and then press the OK button.
The adjustment value is now registered, and adjustment is complete.

Adjustment When Installing the PrintheadAdjustment When Installing the Printhead
Printhead position adjustment is executed when the printhead is first installed.
This adjustment should be executed in the following situations.

• If adjusting the printhead position has not been performed such as due to an error during initial setup

• If Rep.P.head Print in the Control Panel menu is set to Off and adjusting the printhead position has not been per-
formed when replacing the printhead

Note

• We recommend that the same paper as the paper included with the printer is used for this adjustment.

Items to Prepare
When Using Rolls An unused roll at least 254.0 mm (10.00 in) wide

When Using Sheets Seven sheets of unused paper, A4/Letter size (or one sheet when using A2)

Perform adjustment as follows.

1 Load paper.

• Attaching the Roll Holder to Rolls →P.530
• Loading Rolls in the Printer →P.533
• Loading Sheets in the Printer →P.555

Important

• Always make sure the loaded paper matches the type of paper specified on the printer. Adjustment cannot be com-
pleted correctly unless the loaded paper matches the settings.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Head Posi. Adj., and then press the OK button.

6 Press ▲ or ▼ to select Other, and then press the OK button.
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7 Press ▲ or ▼ to select Initial adjustmt, and then press the OK button.
A test pattern is printed for adjustment.
Adjustment is now finished if you have printed on a roll.

8 If you are printing on sheets, a confirmation message is displayed requesting you to continue printing. Press
the OK button and follow the instructions.

Note

• Advanced adjustment can enable superior printing quality when printing fine lines or text at high precision on glossy
or semi-glossy photo or proofing paper.
 (See "Enhancing Printing Quality.") →P.796

Troubleshooting Paper Abrasion and Blurry ImagesTroubleshooting Paper Abrasion and Blurry Images
The Printhead height setting affects printing quality.
Specifying a low Printhead height makes images clearer and enhances printing quality but may cause paper to rub
against the Printhead.
On the other hand, specifying a high Printhead height will prevent paper from rubbing against the Printhead but may
reduce the printing quality.

Important

• Paper rubbing against or becoming caught on the Printhead may jam or result in printed documents that are soiled.

Note

• Raise or lower the printhead, depending on the nature of the problem.
 (See "Paper rubs against the printhead.") →P.889
 (See "The edges of the paper are dirty.") →P.889
 (See "Image edges are blurred or white banding occurs.") →P.893

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Paper Details, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper, and then press the OK button.

Note

• When Head Height is set to Automatic, the setting value selected for the
previous print job is displayed (to the right of Automatic) once you select
the type of paper currently supplied.
However, the value is cleared when the printer is turned off or the paper
is replaced.

 

5 Press ▲ or ▼ to select Head Height, and then press the OK button.
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6 Press ▲ or ▼ to select the desired setting value, and then press the OK button.

Note

• Using Automatic will ensure that the printer adjusts the Printhead height to the optimal level before printing, ac-
counting for the ambient temperature and humidity. When a setting other than Automatic is used, that value will
always be applied.

• Depending on the type of paper, some setting values may not be available.
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Adjusting the feed amountAdjusting the feed amount
Adjusting the Feed Amount ................................................................................................................................ 805

Selecting a Feed Amount Adjustment Method ............................................................................................. 805
Automatic Banding Adjustment .................................................................................................................... 806
Manual Banding Adjustment ......................................................................................................................... 807
Fine-Tuning the Paper Feed Amount ............................................................................................................ 809
Adjusting Line Length ................................................................................................................................... 810

Adjusting the Vacuum Strength ......................................................................................................................... 811

Adjusting the Feed AmountAdjusting the Feed Amount
If printed documents are affected by the following problems, try adjusting the feed amount.

• Banding in different colors
• Line length is not accurate in the direction paper is fed

To adjust the feed amount, do the following, in this order.

1 Depending on the issue, adjust Adj. Priority to suit the particular type of paper.
 (See "Selecting a Feed Amount Adjustment Method.") →P.805

2 Execute Adj. Quality or Adjust Length, depending on the selection in Adj. Priority.
 (See "Automatic Banding Adjustment.") →P.806
 (See "Manual Banding Adjustment.") →P.807
 (See "Adjusting Line Length.") →P.810

3 After executing Adj. Quality, execute Adj. Fine Feed for further adjustment as needed.
 (See "Fine-Tuning the Paper Feed Amount.") →P.809

Selecting a Feed Amount Adjustment MethodSelecting a Feed Amount Adjustment Method
There are two methods of adjusting the paper feed amount, Print Quality and Print Length, either of which will be
applied during printing.
Since the method that is applied during printing is determined from the value of the Adj. Priority setting, configure the
Adj. Priority to match the print target.

• Print Quality : Adjusts the feed amount to reduce banding across the sheet in printed documents.
Adj. Quality settings are applied. When Adj. Fine Feed is executed, the Adj. Fine Feed settings are applied in
addition to the Adj. Quality settings.

• Print Length : Adjusts the feed amount for better accuracy of lines in printed documents.
The settings of A:High or B:Standard/Draft in Adjust Length are applied.

• Automatic : Print Quality or Print Length is selected, depending on Print Priority as selected in the printer driv-
er at the time of printing.

Note

• Either A:High or B:Standard/Draft in the Adjust Length menu is applied, depending on printer driver settings at the time of
printing.

Follow these steps to configure the settings.

1 Load the paper.

• Attaching the Roll Holder to Rolls →P.530
• Loading Rolls in the Printer →P.533
• Loading Sheets in the Printer →P.555
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2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Feed Priority, and then press the OK button.

6 Press ▲ or ▼ to select Adj. Priority, and then press the OK button.

7 Press ▲ or ▼ to select Automatic, Print Quality, or Print Length, and then press the OK button.

Automatic Banding AdjustmentAutomatic Banding Adjustment
If printed images are affected by banding in different colors across the sheet, execute Adj. Quality for automatic ad-
justment of the paper feed amount.
There are two modes of automatic adjustment to correct banding: Auto(GenuinePpr) and Auto(OtherPaper). In either
mode, the printer prints and reads a test pattern for automatic adjustment of the feed amount.

• Auto(GenuinePpr)
Use this mode with paper identified in the Paper Reference Guide.
 (See "Types of Paper.") →P.522

• Auto(OtherPaper)
Use this mode with paper not in the Paper Reference Guide, or if Auto(GenuinePpr) does not eliminate banding.
 (See "Types of Paper.") →P.522

Important

• Adjustment is not possible with Auto(GenuinePpr) and Auto(OtherPaper) when using highly transparent media.
In this case, use Manual adjustment.
 (See "Manual Banding Adjustment.") →P.807

Note

• We recommend executing the adjustment if you have changed the paper type or paper size.

• Always check the Adj. Priority values before using Auto(GenuinePpr) or Auto(OtherPaper).
 (See "Selecting a Feed Amount Adjustment Method.") →P.805

• If additional fine-tuning is necessary after Auto(GenuinePpr) and Auto(OtherPaper), execute Adj. Fine Feed.
 (See "Fine-Tuning the Paper Feed Amount.") →P.809

• Use Adjust Length to ensure that lines in CAD drawings are printed at exactly the right length.
 (See "Adjusting Line Length.") →P.810

• This may take some time, depending on the type of paper.
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Items to Prepare
When Using Rolls An unused roll at least 254.0 mm (10.00 in) wide

When Using Sheets Auto(GenuinePpr) : One sheet of unused paper, A4/Letter size
Auto(OtherPaper) : Two sheets of unused paper, A4/Letter size (or one sheet when using A2)

Perform adjustment as follows.

1 Load the paper.

• Attaching the Roll Holder to Rolls →P.530
• Loading Rolls in the Printer →P.533
• Loading Sheets in the Printer →P.555

Important

• Always make sure the loaded paper matches the type of paper specified in the settings. Adjustment cannot be com-
pleted correctly unless the loaded paper matches the settings.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Feed Priority, and then press the OK button.

6 Press ▲ or ▼ to select Adj. Quality, and then press the OK button.

7 Press ▲ or ▼ to select Auto(GenuinePpr) or Auto(OtherPaper), and then press the OK button.
A test pattern is printed for adjustment.
Adjustment is now finished if you have printed on a roll or a sheet of A2 size or larger.

8 If you are printing on sheets smaller than A2 size for Auto(OtherPaper), a confirmation message is shown on
the Display Screen requesting you to continue printing.
Press the OK button and follow the instructions on the Display Screen.

Manual Banding AdjustmentManual Banding Adjustment
If printed images are affected by banding in different colors, execute Adj. Quality for adjustment of the paper feed
amount.
Use Manual adjustment with highly transparent media or other paper for which Auto(GenuinePpr) or Auto(OtherPa-
per) cannot be used.
 (See "Automatic Banding Adjustment.") →P.806
Manual adjustment requires you to enter an adjustment value after a test pattern is printed.
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Note

• We recommend executing the adjustment if you have changed the paper type or paper size.

• Always check the Adj. Priority values before using Manual adjustment.
 (See "Selecting a Feed Amount Adjustment Method.") →P.805

• If additional fine-tuning is necessary after Manual adjustment, use Adj. Fine Feed
 (See "Fine-Tuning the Paper Feed Amount.") →P.809

• Use Adjust Length to ensure that lines in CAD drawings are printed at exactly the right length.
 (See "Adjusting Line Length.") →P.810

Paper to Prepare
When Using Rolls An unused roll at least 254.0 mm (10.00 in) wide

When Using Sheets Two sheets of unused paper of at least A4/Letter size

Perform adjustment as follows.

1 Load the paper.

• Attaching the Roll Holder to Rolls →P.530
• Loading Rolls in the Printer →P.533
• Loading Sheets in the Printer →P.555

Important

• Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be completed correctly
unless the loaded paper matches the settings.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Feed Priority, and then press the OK button.

6 Press ▲ or ▼ to select Adj. Quality, and then press the OK button.

7 Press ▲ or ▼ to select Manual, and then press the OK button.
Test pattern A is printed for manual adjustment.

Note

• When printing on sheets, follow the instructions on the Display Screen and remove the sheet.
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8
 

Examine test pattern A for adjustment. Determine the
pattern in which banding is least noticeable.

Note

• If banding seems least noticeable in two patterns but you cannot decide which one is better, choose an intermediate
value.
For example, choose 11 if you cannot decide whether pattern 10 or 12 is better.

9 Press ▲ or ▼ to select the pattern number you have decided, and then press the OK button.
Test pattern B is printed for adjustment.

Note

• If you printed test pattern A on a sheet, follow the instructions on the Display Screen and use another sheet of the
same type of paper.
Additionally, after test pattern B is printed, follow the instructions on the Display Screen and remove the sheet.

10 Examine test pattern B for adjustment. Determine the pattern in which banding is least noticeable.

11 Press ▲ or ▼ to select the pattern number you have decided, and then press the OK button.
The adjustment value is now registered, and adjustment is complete.

Fine-Tuning the Paper Feed AmountFine-Tuning the Paper Feed Amount
If the contrast is uneven or banding in different colors appears at 50 mm (2.0 in) intervals in printed documents, try
executing Adj. Fine Feed during printing to fine-tune the feed amount.

Note

• The Adj. Fine Feed menu is only displayed during printing.
Additionally, it is displayed when you have selected Automatic or Print Quality in Adj. Priority in Feed Priority.
 (See "Menu Structure.") →P.661

• Always execute Adj. Quality before Adj. Fine Feed.
Once you execute Adj. Quality, the Adj. Fine Feed value will revert to 0.
 (See "Automatic Banding Adjustment.") →P.806
 (See "Manual Banding Adjustment.") →P.807

Perform adjustment as follows.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.
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3 Press ▲ or ▼ to select Adj. Fine Feed, and then press the OK button.

4 Press ▲ or ▼ to select a setting value in the range -5 to 5, and then press the OK button.
At this time, if banding in dark colors appears, select a setting value in the range 1 to 5, and if banding in light
colors appears, select a setting value in the range -1 to -5.

Adjusting Line LengthAdjusting Line Length
To ensure that lines in CAD drawings are printed at exactly the right length, use Adjust Length to adjust the amount
that paper is advanced.
There are two options in Adjust Length : AdjustmentPrint and Change Settings.

• AdjustmentPrint
After a test pattern is printed, you will measure the discrepancy based on the results of printing.

• Change Settings
No test pattern is printed. Instead, you will measure a document already printed to determine the discrepancy.

Additionally, two modes are available in both AdjustmentPrint and Change Settings : A:High or B:Standard/Draft.
Choose the mode that suits your particular printing application.

• A:High
This setting is applied when Highest quality or High is selected in Print Quality in the printer driver.

• B:Standard/Draft
This setting is applied when Standard or Fast is selected in Print Quality in the printer driver.

Note

• We recommend executing the adjustment if you have changed the paper type or paper size.

• Always check the Adj. Priority values before using Adjust Length.  (See "Selecting a Feed Amount Adjustment Method.")
→P.805

Paper to Prepare
When Using Rolls • An unused roll at least 254.0 mm (10.00 in) wide

• High-precision ruler

When Using Sheets • One sheet of unused paper of at least A4/Letter size
• High-precision ruler

Perform adjustment as follows.

1 Load the paper.

• Attaching the Roll Holder to Rolls →P.530
• Loading Rolls in the Printer →P.533
• Loading Sheets in the Printer →P.555

Important

• Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be completed correctly
unless the loaded paper matches the settings.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).
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Note

• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Feed Priority, and then press the OK button.

6 Press ▲ or ▼ to select Adjust Length, and then press the OK button.

7
 

Press ▲ or ▼ to select AdjustmentPrint or Change Settings, and
then press the OK button.
When you select AdjustmentPrint, a test pattern is printed for you to
measure the scale and calculate the discrepancy. The scale bar prints
Millimeter in 50 mm increments and Inch in 1-inch increments.

Note

• A test pattern is printed in black when you choose A:High or in magenta if you choose B:Standard/Draft.

• To cancel printing the test pattern for adjustment, hold down the Stop button. When "Stop printing?" is displayed,
press ▲ or ▼ to select "Yes", and then press the OK button.

8 Press ▲ or ▼ to enter the amount of discrepancy, and then press the OK button.
If the scale is shorter than the actual size, use a positive setting value. If it is longer, use a negative value.
The feed amount can be adjusted in 0.02% increments.

Adjusting the Vacuum StrengthAdjusting the Vacuum Strength
When printing on heavyweight paper or paper that curls or wrinkles easily, if the Printhead rubs against paper, adjust-
ing the level of suction against paper on the Platen may improve results.

Important

• Paper rubbing against or becoming caught on the Printhead may jam or result in printed documents that are soiled.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Paper tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.
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3 Press ▲ or ▼ to select Paper Details, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper, and then press the OK button.

Note

• When VacuumStrngth is set to Automatic, the setting value selected for
the previous print job is displayed (to the right of Automatic) once you
select the type of paper currently supplied.
However, the value is cleared when the printer is turned off or the paper
is replaced.

 

5 Press ▲ or ▼ to select VacuumStrngth, and then press the OK button.

6 Press ▲ or ▼ to select the desired setting value, and then press the OK button.
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Printing Images to Match Monitor ColorsPrinting Images to Match Monitor Colors
Adjusting the colors printed so that they more closely match the colors displayed on the monitor is called "monitor
matching." Using this mode requires adjustment or configuration of the settings of your monitor, the source application,
the file for printing, and the printer driver.

Important

• Monitor matching may not be applied, or these settings may not be configurable or adjustable, depending on your monitor
and the source application.
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Note

• Printing in exactly the same colors as displayed on the monitor may not be possible due to differences in the monitor and
printer color gamuts.

• Calibrating your monitor requires a measuring device.

• Because colors appear different under sunlight at different times of day, we recommend following this procedure in a room not
exposed to sunlight.

• Monitor Matching
The sequence in monitor matching is as follows.

1 Calibrate the printer.
Calibration improves color consistency by compensating for slight differences in how color appears due to indi-
vidual variation among printheads or conditions in various printing environments.
 (See "Corrects slight differences in how colors appear (color calibration).") →P.820

2 Calibrate the monitor.
i1-Display and similar measurement devices are commonly used.
Set white point to 6500K or 5000K, Gamma to 2.2, and brightness to 120 cd.
The exact procedure varies depending on your monitor and measurement device.

3 Open the file to print and configure settings in the source application.
Display the file in the sRGB or Adobe RGB color space.
Configure settings to prevent color conversion by the application.
In Photoshop CS3, for example, select Color Management in the Print dialog box, and then select No Color
Management in Color Handling.

4 Configure and adjust printer driver settings.
Select Monitor Matching using the Matching Method, and then select the Monitor White Point that you set
up in monitor calibration.
In Color Space, select the color space used when displaying the file in the source application.

Note

• To print multiple times using the same value, we recommend opening the Printer Driver dialog box from the System
menu and configuring the appropriate settings.  (See "Accessing the Printer Driver Dialog Box from the Operating Sys-
tem Menu (Windows).") →P.181

For instructions on configuring printer driver settings for monitor matching, refer to the following topic, as appropriate
for your computer and operating system.

• Printing Images to Match Monitor Colors (Windows) →P.815
• Printing Images to Match Monitor Colors (Mac OS X) →P.817

Printing Images to Match Monitor Colors (Windows)Printing Images to Match Monitor Colors (Windows)
By calibrating your monitor and configuring settings in the source application in advance, you can complete settings to
print in colors that are as close as possible to the colors displayed on the monitor.

Important

• Before using this feature, you must calibrate the monitor and configure settings in the source application. (See "Printing Im-
ages to Match Monitor Colors →P.814 ")

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box. (See "Accessing the Printer
Driver Dialog Box from Applications →P.179 ")
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded (for example, Canon Premium Glossy Paper
2 280).

5
 

Click DAdvanced Settings to switch the print mode.

6 In FPrint Quality, click High.

7 Click Color in the GColor Mode list.

8 Click HColor Settings to display the Color Settings dialog box.
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9
 

Click the Matching tab to display the Matching sheet.

10 Make sure Driver Matching Mode is selected in AMatching Mode.

11 In BMatching Method, select Monitor Matching.

12 In CColor Space, select the color space used when displaying the file in the source application.

13 In DMonitor White Point, select the white point set on the monitor.

14 Click OK.

15 Confirm the print settings and print as desired.

Printing Images to Match Monitor Colors (Mac OS X)Printing Images to Match Monitor Colors (Mac OS X)
By calibrating your monitor and configuring settings in the source application in advance, you can complete settings to
print in colors that are as close as possible to the colors displayed on the monitor.

Important

• Before using this feature, you must calibrate the monitor and configure settings in the source application. (See "Printing Im-
ages to Match Monitor Colors.") →P.814

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box. (See "Accessing the Printer
Driver Dialog Box from Applications.") →P.364
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3
 

Make sure the Main panel is displayed.

4 In the AMedia Type list, select the type of paper that is loaded (for example, Canon Premium Glossy Paper
2 280).

5
 

Click DAdvanced Settings to switch the print mode.

6 In FPrint Quality, click High.

7 Click Color in the HColor Mode list.

8 Click ISet to display the Color Settings dialog box.
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9
 

Click the Matching tab to display the Matching panel.

10 Make sure Driver Matching Mode is selected in AMatching Mode.

11 In BMatching Method, select Monitor Matching.

12 In CColor Space, select the color space used when displaying the file in the source application.

13 In DMonitor White Point, select the white point set on the monitor.

14 Click OK.

15 Confirm the print settings and print as desired.
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Color CalibrationColor Calibration
Corrects slight differences in how colors appear (color calibration) ................................................................. 820

Paper that can be used in Color Calibration ................................................................................................. 822

Corrects slight differences in how colors appear (color calibration)Corrects slight differences in how colors appear (color calibration)

What is Color Calibration?
Color calibration improves color consistency by compensating for slight differences in how color appears when printing
due to individual variations or aging among the printers.
Executing color calibration will print a test pattern, which will be read automatically by a sensor built in the printer.
By this operation, a calibration adjustment value reflecting the print result of the test pattern is set automatically.

Important

• When executing color calibration, keep the temperature and humidity conditions the same each time for better color consis-
tency.
If you execute color calibration under various conditions of temperature and humidity, correct adjustment may not be possi-
ble.

• Before color calibration, ensure the printer is not exposed to direct sunlight or other strong sources of light.
If the printer is exposed to strong sources of light, correct adjustment may not be possible.

Recommend Timing for Color Calibration
We recommend color calibration in the following situations.

• After initial printer installation
• After Printhead replacement

• If colors seem different from before, despite using the same printing environment, under the same conditions

• To ensure uniform colors when printing on multiple printers (however, be sure to use the same version of firmware
and printer driver, under the same settings)

• When the Execution Guide is displayed (Specifying Execution Guide →P.821 )

Executing Color Calibration

• Prepare the printer

1 You can confirm whether the paper to be loaded can be used in color calibration.
 (See "Paper that can be used in Color Calibration.") →P.822

2 Load the paper.
 (See "Attaching the Roll Holder to Rolls.") →P.530
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

• Executing Color Calibration

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect ( Settings/Adj. tab).
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Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

4 Press ▲ or ▼ to select Calibration, and then press the OK button.

5 Press ▲ or ▼ to select Auto Adjust, and then press the OK button.
After the environment measurements and paper are confirmed, and color calibration is executed, the calibra-
tion adjustment value is set automatically.

Applying the Calibration Adjustment Values During Printing
The application of the calibration adjustment value when printing can be set in the printer driver or on the menu of the
Control Panel.
However, when the setting value of the printer driver and the setting value of the Control Panel differ, the setting of the
printer driver is prioritized.

How to apply How to operate
Configure on the printer driver menu. (Windows) Configure Calibration Value.

 (See "Paper Detailed Settings Dialog Box (Windows).") →P.185

Configure on the printer driver menu. (Mac OS X) Configure Calibration Value.
 (See "Paper Detailed Settings Dialog Box (Mac OS X).") →P.368

Configure on the menu of the Control Panel. From Set./Adj. Menu, select Adjust Printer > Calibration > Use Adj. Value.
 (See "Menu Settings.") →P.667

Note

• After executing color calibration, you can also adjust colors as desired in the printer driver.  (See "Adjusting the Color in the
Printer Driver.") →P.54

Checking Color Calibration Execution Logs
You can confirm information of color calibration such as the execution date and executed paper type by the following
method.

How to check How to operate
Confirm it on the Control Panel of the printer. From Set./Adj. Menu, select Adjust Printer > Calibration > Calibration Log.

 (See "Menu Settings.") →P.667

Print information about the printer. From Set./Adj. Menu, select Test Print > Status Print.
 (See "Status Print.") →P.676

Confirm with imagePROGRAF Status Monitor.
(Windows)

On the Information sheet of imagePROGRAF Status Monitor, click the View Calibration
Log button.
 (See "The Features of imagePROGRAF Status Monitor.") →P.734

Confirm this in the Printer Information dialog
box of the printer driver. (Mac OS X)

In the Printer Information dialog box, click the Information tab, and click the View Cali-
bration Log button.
 (See "Main Pane (Mac OS X).") →P.364

Specifying Execution Guide
Execution Guide is a function in which a guide is displayed on the Control Panel, imagePROGRAF Status Monitor
(Windows), imagePROGRAF Printmonitor (Macintosh), or RemoteUI when you execute color calibration.
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If you enable this function, an Execution Guide is displayed in the following cases.

• When a new Printhead has been installed

• When a certain amount of printing has been executed after color calibration is executed
• When the data of color calibration has been initialized

To enable the function, set "Set Exec. Guide" to On on the menu of the Control Panel.
 (See "Menu Settings.") →P.667

Paper that can be used in Color CalibrationPaper that can be used in Color Calibration

Recommended Environment for Use of Paper
Since the recommended use environment varies according to the paper type, use within the recommended environ-
ment range suiting the paper type.
For details, refer to the Paper Reference Guide.

Paper Type and Adjustment Type

• In color calibration, you can use any of the following paper types.
Also, the adjustment type of color calibration is decided according to the paper type. (Adjustment Types of Color
Calibration →P.823 )

• The media types shown in the table are the names that are displayed in the printer Control Panel.

Paper Type

Country or Region of Use selected when the printer driver was in-
stalled

Adjustment TypeJapan, Asia, Oce-
ania EU North or South

America
Opaque Paper 120 Not available Available Not available Common calibration

HW Coated Available Available Available Common calibration

GlossyPhoto 170g Available Available Available Common calibration

SatinPhoto 170g Available Available Available Common calibration

GlossyPhotoHG170 Available Available Available Common calibration

SemGlsPhotoHG170 Available Available Available Common calibration

GlossyPhoto 200g Not available Available Available Common calibration

SatinPhoto 200g Not available Available Available Common calibration

GlossyPhoto 240 Not available Available Available Common calibration

SatinPhoto 240 Not available Available Available Common calibration

GlossyPhotoHG255 Available Available Available Common calibration

SemGlsPhotoHG255 Available Available Available Common calibration

RC Photo Luster Not available Not available Available Unique calibration

Premium Gl2 280 Available Available Available Common calibration

Prem.SemiGl2 280 Available Available Available Common calibration

PhotoProPlat adj Available Available Available Common calibration

LW Gloss Proof Available Not available Available Unique calibration

LW Matte Proof Available Not available Available Unique calibration

Proofing Paper3 Available Not available Available Unique calibration

Proofing Paper Available Not available Available Common calibration

Proof SemiGl 195 Not available Available Not available Unique calibration

FineArt Photo Available Available Available Common calibration
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Paper Type

Country or Region of Use selected when the printer driver was in-
stalled

Adjustment TypeJapan, Asia, Oce-
ania EU North or South

America
FneArt HW Photo Available Available Available Common calibration

Note

• If the paper you are using is not specified in media type, execute color calibration using the paper where the adjustment type
is Common calibration, then you can set the calibration adjustment values for the paper you are using.

• The settings for each media type can be changed using Media Configuration Tool.
Not available media types can be displayed in the Control Panel by changing the settings.
 (See "Switching Media Types Display Show/Hide (Windows).") →P.594
 (See "Switching Media Types Display Show/Hide (Mac OS X).") →P.627

• For details on the paper that can be used when PhotoProPlat adj is selected as the paper type, refer to the Paper Reference
Guide.

Paper Sizes that can be Used in Color Calibration
Paper sizes that can be used in color calibration differ for sheets and rolls.
For details, refer to the Paper Reference Guide.

When Using Rolls An unused roll at least 254.0 mm (10.00 in) wide
(however, a roll at least 406.4 mm (16.00 in) wide depending on the paper type)

When Using Sheets One sheet of unused paper of at least A4/Letter size
(however, one sheet of unused paper of at least A2 size depending on the paper type)

Registration and Confirmation of Paper Information

• To Register Paper Information on the Printer
When using newly released paper, paper information must be registered on the printer and the printer driver.
Download the new version of Media Information File from the Canon website and install it.
 (See "Types of Paper.") →P.522

• To Confirm the Paper Information Registered on the Printer
When confirming the paper information registered on the printer, select Paper Details on the Control Panel menu,
and print the detailed information of the paper.
 (See "Menu Settings.") →P.667

Important

• To restore the default settings, set Reset PaprSetngs to Yes in System Setup in the Control Panel menu.
Because paper information added or modified by the Media Configuration Tool is deleted, if you have calibrated the printer
using paper with information added by the Media Configuration Tool, color calibration executed this way can no longer be
applied to any type of paper.
If you wish to apply calibration results, prepare calibration-compatible paper that was in the original settings and perform
calibration again.

Adjustment Types of Color Calibration
Color calibration has two adjustment types, Common calibration and Unique calibration, with one of these selected
when color calibration is executed.
The selected adjustment type is determined from the media type that color calibration is executed on.

• Common calibration
Common calibration is a feature that allows you to use multiple media types easily in a short time because it is not
necessary to execute color calibration on each media type.
If color calibration is executed on paper categorized as Common calibration, dedicated calibration adjustment val-
ues are set on the media type that Common calibration was executed on.
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Furthermore, calibration adjustment values are set on all print qualities for all media types where color calibration
has not been executed.

Note

• The calibration adjustment values are not overwritten for media types where color calibration has been executed once
and dedicated calibration adjustment values have been set.

• Unique calibration
If color calibration is executed on paper categorized as Unique calibration, calibration adjustment values are set
only for the media type that the color calibration was executed on.

Note

• Even if paper categorized as Unique calibration is used, if the media type has yet to execute color calibration even once
and does not have any dedicated calibration adjustment values, the calibration adjustment values are overwritten when
Common calibration is executed.
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Ink TanksInk Tanks
When purchasing, check the Model number.

Shape Colors Model number Ink Type Capacity
Matte black PFI-306 MBK

Pigment ink 330 ml (11.2 fl oz)

Black PFI-306 BK

Cyan PFI-306 C

Magenta PFI-306 M

Yellow PFI-306 Y

Photo cyan PFI-306 PC

Photo magenta PFI-306 PM

Red PFI-306 R

Green PFI-306 G

Blue PFI-306 B

Gray PFI-306 GY

Photo gray PFI-306 PGY

Shape Colors Model number Ink Type Capacity
Matte black PFI-706 MBK

Pigment ink 700 ml (23.7 fl oz)

Black PFI-706 BK

Cyan PFI-706 C

Magenta PFI-706 M

Yellow PFI-706 Y

Photo cyan PFI-706 PC

Photo magenta PFI-706 PM

Red PFI-706 R

Green PFI-706 G

Blue PFI-706 B

Gray PFI-706 GY

Photo gray PFI-706 PGY

Note

• For instructions on Ink Tank replacement, see "Replacing Ink Tanks." →P.826

• The provided Starter Ink Tanks contain 330 ml (11.2 fl oz) each.

Replacing Ink TanksReplacing Ink Tanks

Compatible ink tanks
For information on compatible ink tanks, see "Ink Tanks." →P.826
Replacement ink tanks in 330 ml (11.2 fl oz) and 700 ml (23.7 fl oz) capacities are supported.

Ink Tanks                                                                                                                                                                                                                             iPF9400

                                                                                                                                                                                                                                       User's Guide

  

M
aintenance and C

onsum
ables

Ink Tanks

 826



Note

• Depending on the color, you can also use an ink tank with a different capacity.

Precautions when handling ink tanks
Take the following precautions when handling ink tanks.

Caution

• For safety, keep ink tanks out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.

Important

• There may be ink around the ink supply section of ink tanks you removed. Handle ink tanks carefully during replacement.
The ink may stain clothing.

• Do not install used ink tanks in another model of printer.
This will prevent correct ink level detection, which may damage the printer or cause other problems.

• We recommend using up an Ink Tank in the course of printing within six months after breaking the seal. Printing quality may
be affected if you use older ink tanks.

• Do not leave the printer without ink tanks installed for extended periods (a month or more). Residual ink may become clog-
ged inside the printer and affect printing quality.

How to replace an Ink Tank

1. Confirm the message. →P.827

2. Access the menu for Ink Tank replacement. →P.828  (Otherwise, open the Ink Tank Cover.)

3. Remove the Ink Tank.

• 330 ml ink tanks →P.828
• 700 ml ink tanks →P.830

4. Load the new Ink Tank.

• 330 ml ink tanks →P.831
• 700 ml ink tanks →P.833

Confirm the message
When the ink level becomes low, a message is displayed on the Display Screen.
According to the message, replace the ink tank or prepare a new ink tank.  (See "When to Replace Ink Tanks.")
→P.837
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If a message requests you to replace an Ink Tank, press the OK button. In this case, you can skip the step Access the
menu for ink tank replacement. Follow the instructions in Remove the ink tanks.

Important

• Do not remove an Ink Tank during initialization immediately after turning on the printer, or during printhead cleaning. Ink may
leak out.

Note

• Ink Tank replacement is possible even during printing, when print jobs are being canceled, or when paper is being advanced.

Access the menu for Ink Tank replacement

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Ink tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Ink Menu is displayed.

3 Press ▲ or ▼ to select Rep. Ink Tank, and then press the OK button.
Instructions are displayed on the Display Screen.

Remove the Ink Tank (330 ml)

1
 

Open the Ink Tank Cover of the tank for replacement
and check the Ink Lamp.
The Ink Lamp flashes quickly if there is no ink left.

Important

• Avoid hitting the printer when replacing an Ink Tank. Handle the printer gently when replacing tanks. Jolting the
printer during printing may deteriorate print quality.
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2
 

Lift the stopper (a) of the Ink Tank Lock Lever for the
color to replace. Lift the Ink Tank Lock Lever until it
stops, and then push it down to the front.

Note

• Push the Ink Tank Lock Lever down until it locks.
• Make sure the Ink Tank Lock Lever does not return to the original position.

3
 

Hold the Ink Tank by the grips (a) and remove it. Press
the OK button.

Important

• If there is still ink in the Ink Tank you removed, store it with the ink holes
(a) facing up. Otherwise, ink may leak and cause stains. Put the removed
Ink Tank in a plastic bag and seal it.

 

Note

• Dispose of used ink tanks according to local regulations.
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Remove the Ink Tank (700 ml)

1
 

Open the Ink Tank Cover of the tank for replacement
and check the Ink Lamp.
The Ink Lamp flashes quickly if there is no ink left.

Important

• Avoid hitting the printer when replacing an Ink Tank. Handle the printer gently when replacing tanks. Jolting the
printer during printing may deteriorate print quality.

2
 

Lift the stopper (a) of the Ink Tank Lock Lever for the
color to replace. Lift the Ink Tank Lock Lever until it
stops, and then push it down to the front.

Note

• Push the Ink Tank Lock Lever down until it locks.
• Make sure the Ink Tank Lock Lever does not return to the original position.

3
 

Hold the Ink Tank by the handle (a) and remove it.
Press the OK button.
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Important

• If there is still ink in the Ink Tank you removed, store it in the box with the
ink holes (a) facing up. Otherwise, ink may leak and cause stains.

 

Note

• Dispose of used ink tanks according to local regulations.

Load the Ink Tank (330 ml)

1
 

Before opening the pouch, tilt the Ink Tank to the left and right
gently seven or eight times.

Important

• Do not remove and agitate ink tanks that have already been installed in the printer. Ink may leak out.

• If you do not agitate the Ink Tank, the ink may settle, which may affect printing quality.

2
 

Open the pouch and remove the Ink Tank.
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Important

• Never touch the ink holes or electrical contacts. This may cause stains, damage the Ink Tank, and affect printing
quality.

3
 

Press the OK button and insert the Ink Tank into the
holder facing as shown, with the ink holes down.

Important

• Ink tanks cannot be loaded in the holder if the color or orientation is incorrect.
If the Ink Tank does not fit in the holder, do not force it into the holder. Make sure the color of the Ink Tank Lock
Lever matches the color of the Ink Tank, and check the orientation of the Ink Tank before reloading it.

4
 

Lift the Ink Tank Lock Lever until it stops, and then push
it down until it clicks into place.
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5
 

Make sure the Ink Lamp is lit in red.

Note

• If the Ink Lamp is not lit in red, reload the tank.

6
 

Close the Ink Tank Cover.

Important

• After Ink Tank replacement, always close the Ink Tank Cover. If the Ink Tank Cover cannot close, some Ink Tank
Lock Lever may not be closed completely. Make sure all ink tank lock levers are fully closed.

Load the Ink Tank (700 ml)

1
 

Before opening the pouch, hold the new Ink Tank with both
hands and tilt it to the left and right as shown, shaking gen-
tly it seven or eight times.

Caution

• 700 ml ink tanks are heavy, so use your whole arm to agitate it instead of just your wrist. If you agitate it using just
your wrist, you may injure your wrist.
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Important

• Do not remove and agitate ink tanks that have already been installed in the printer. Ink may leak out.

• If you do not agitate the Ink Tank, the ink may settle, which may affect printing quality.

2
 

Open the pouch and remove the Ink Tank.

Important

• Never touch the ink holes or electrical contacts. This may cause stains, damage the Ink Tank, and affect printing
quality.

3
 

Press the OK button and insert the Ink Tank into the
holder facing as shown, with the ink holes down.

Important

• Ink tanks cannot be loaded in the holder if the color or orientation is incorrect.
If the Ink Tank does not fit in the holder, do not force it into the holder. Make sure the color of the Ink Tank Lock
Lever matches the color of the Ink Tank, and check the orientation of the Ink Tank before reloading it.
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4
 

Lift the Ink Tank Lock Lever until it stops, and then push
it down until it clicks into place.

5
 

Make sure the Ink Lamp is lit in red.

Note

• If the Ink Lamp is not lit in red, reload the tank.

6
 

Close the Ink Tank Cover.
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Important

• After Ink Tank replacement, always close the Ink Tank Cover. If the Ink Tank Cover cannot close, some Ink Tank
Lock Lever may not be closed completely. Make sure all ink tank lock levers are fully closed.

• To close the Ink Tank Cover when no Ink Tank is installed
(as when moving the printer), push the release lever (a)
as shown while returning the Ink Tank Lock Lever to the
original position.

 

Checking Ink Tank LevelsChecking Ink Tank Levels
On the Display Screen, you can check how much ink is left in the ink tanks.
To check remaining Ink Tank levels, access the Tab Selection screen on the Control Panel and press ◀ or ▶ to se-

lect the Ink tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

• If an error has occurred and the Tab Selection screen cannot be displayed, display Ink Info as follows.

1. Press the OK button to display Printer Info.
2. Press the ▲ or ▼ button to select Ink Info.
3. Press the OK button.

The remaining ink levels shown on the Display Screen correspond to the inks identified by the Color Label on the bot-
tom of the Display Screen.
These symbols may be displayed above the ink level: ! if ink is low, × if no ink is left, and ? if you have deactivated ink
level detection.
The remaining ink level is indicated as shown below.
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If the Display Screen indicates to replace the Ink Tank, replace the Ink Tank. If a message is displayed indicating to
check the remaining ink levels, or after tasks that consume a lot of ink such as large-format printing or head cleaning,
check the remaining levels and replace Ink Tank as needed.  (See "Replacing Ink Tanks.") →P.826

When to Replace Ink TanksWhen to Replace Ink Tanks
Replace or prepare to replace ink tanks in the following situations.

If a message for checking the ink is shown on the Display Screen
When there is little ink left, the Message Lamp is lit and "Not much ink is left." is shown on the Display Screen. You
can continue to print, but prepare to replace the Ink Tank.  (See "Checking Ink Tank Levels.") →P.836

Before print jobs and maintenance that consume a lot of ink
If little ink is left, there may not be enough for large-format printing, head cleaning, and maintenance, which require a
lot of ink. Replace or prepare to replace the Ink Tank.

If a message for ink replacement is shown on the Display Screen
When ink runs out, the Message Lamp flashes, a message regarding Ink Tank replacement is shown on the Display
Screen, and printing is disabled. Replace the Ink Tank at this point.
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PrintheadsPrintheads
Printhead ............................................................................................................................................................ 838
Checking for Nozzle Clogging ........................................................................................................................... 838
Cleaning the Printhead ....................................................................................................................................... 839
Replacing the Printhead ..................................................................................................................................... 840

PrintheadPrinthead
When purchasing, check the Model number.

Shape Model number

PF-05

Note

• For instructions on replacing the Printhead, see "Replacing the Printhead." →P.840

Checking for Nozzle CloggingChecking for Nozzle Clogging
If printing is faint or affected by banding in different colors, make sure the Printhead nozzles are clear by printing a test
pattern to check the nozzles.

Note

• Nozzles are periodically checked to ensure they are clear. Configure the settings on the Control Panel menu in Nozzle Check.
 (See "Menu Settings.") →P.667

Paper to Prepare
When Using Rolls An unused roll at least 254.0 mm (10.00 in) wide

When Using Sheets One sheet of unused paper of at least A4/Letter size

1 Load paper.

• Attaching the Roll Holder to Rolls →P.530
• Loading Rolls in the Printer →P.533
• Loading Sheets in the Printer →P.555

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.
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3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Test Print, and then press the OK button.

5 Press ▲ or ▼ to select Nozzle Check, and then press the OK button.
The printer now prints a test pattern for checking the nozzles.

6
 

Check the printing results.
If the horizontal lines are not faint or incomplete, the nozzles are
clear.

If some sections of the horizontal lines are faint or incomplete, the
nozzles for those colors are clogged.

If horizontal lines are faint or incomplete, follow the steps below
and check again for nozzle clogging.

1. Clean the Printhead.  (See "Cleaning the Printhead.") →P.839

2. Print a test pattern to check the nozzles.

Important

• If you repeat these steps several times but the horizontal lines are still faint or incomplete, contact your Canon
dealer.

Cleaning the PrintheadCleaning the Printhead
If printing is faint, cleaning the Printhead may improve results.
Choose one of two Printhead cleaning modes ( Head Cleaning A or Head Cleaning B), depending on the problem to
resolve.

• Head Cleaning A
Use this mode if printing is faint or contains foreign substances. This method of cleaning consumes the least
amount of ink.
It takes about four minutes to complete.

• Head Cleaning B
Use this mode if no ink is ejected at all, or if Head Cleaning A does not solve the problem.
It takes about five minutes to complete.

Important

• Do not remove the Maintenance Cartridge or ink tanks during either Head Cleaning A or Head Cleaning B.
Ink may leak or an error may occur.

• If printing does not improve even if you execute Head Cleaning B, try repeating Head Cleaning B once or twice. If this still
does not improve printing, the Printhead may have reached the end of its useful life. Contact your Canon dealer for assis-
tance.

Note

• Nozzles are periodically checked to ensure they are clear. Configure the settings on the Control Panel menu in Nozzle Check.
 (See "Menu Settings.") →P.667
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Perform cleaning as follows.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Maintenance, and then press the OK button.

4 Press ▲ or ▼ to select Head Cleaning, and then press the OK button.

5 Press ▲ or ▼ to select Head Cleaning A or Head Cleaning B, and then press the OK button.
Head cleaning is now executed.

6 Print a test pattern to check the nozzles, and determine whether cleaning has cleared the nozzles.  (See
"Checking for Nozzle Clogging.") →P.838

Replacing the PrintheadReplacing the Printhead

When to replace the Printhead
This printer is equipped with two printheads.
Replace one or both printheads in the following situations.

• If the printing quality does not improve even after one or two cycles of Head Cleaning B from the printer menu
Replace any printheads with poor printing performance.

• If the Display Screen indicates "Open top cover and replace the left printhead."
Replace the Printhead on the left side.

• If the Display Screen indicates "Open top cover and replace the right printhead."
Replace the Printhead on the right side.

• If the Display Screen indicates "Open top cover and replace the printhead."
Replace both printheads.

• If your Canon dealer has advised Printhead replacement
Replace the Printhead as directed.

Compatible printheads
For information on compatible printheads, see "Printhead." →P.838

Precautions when handling the Printhead
Take the following precautions when handling the Printhead.
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Caution

• For safety, keep the Printhead out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.

• Do not touch the Printhead immediately after printing. The Printhead becomes extremely hot, and there is a risk of burns.

Important

• There may be ink around the nozzles of the Printhead you remove. Handle the Printhead carefully during replacement. The
ink may stain clothing.

• Do not open the Printhead pouch until immediately before installation. After removing the Printhead from the pouch, install it
right away. If the Printhead is left after the pouch is opened, the nozzles may dry out, which may affect printing quality.

Access the menu for Printhead replacement

Caution

• When replacing the Printhead immediately after printing, wait a few minutes before replacing it. The metal parts of the Print-
head become hot during printing, and there is a risk of burns from touching these parts.

Important

• Your hands may become dirty during Printhead replacement. Use the gloves provided with the new Printhead for replace-
ment.

Note

• Prepare a new Ink Tank when ink levels are low.

• When the remaining capacity of Maintenance cartridge is low, prepare a new Maintenance cartridge.

1 Remove any paper that has been advanced by selecting Eject Paper in the Control Panel menu.

• When using a roll, rewind it.
 (See "Removing the Roll from the Printer.") →P.539

• When using sheets, remove the sheet.
 (See "Removing Sheets.") →P.560

2 Clean inside the Top Cover.  (See "Cleaning Inside the Top Cover.") →P.861

3
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

4 Press the OK button.
The Set./Adj. Menu is displayed.

5 Press ▲ or ▼ to select Maintenance, and then press the OK button.

6 Press ▲ or ▼ to select Replace P.head, and then press the OK button.

7 Press ▲ or ▼ to select the Printhead for replacement.
Select Printhead L when replacing the left printhead, Printhead R when replacing the right printhead, and L &
R Printheads when replacing both. Make sure your selection is correct.
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8 Press the OK button.
Ink begins being drawn in. When it finishes, instructions are displayed on the Display Screen.
It takes about three minutes for ink to be drawn into the system.

Replace the Printhead

1
 

Open the Top Cover.

2
 

If the Carriage Cover is dirty, use a damp cloth that you
have wrung out completely to wipe it clean.
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Important

• Do not touch the Linear Scale (a), Carriage Shaft (b), or
Fixed Blade (c). This may stain your hands and damage
the printer.

• Never touch the metal contacts of the Carriage. This may damage the printer.

 

3
 

If the ventilation duct (a) is dirty, use a damp cloth that
you have wrung out completely to wipe it clean.
If the Carriage is obscuring the ventilation duct, move
the Carriage manually before cleaning the duct.

4
 

Pull up the Carriage Cover to open it completely.
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5
 

Pull the Printhead Fixer Lever forward all the way to
open it completely.

6
 

Pull up the Printhead Fixer Cover to open it completely.

7
 

Remove the Printhead and press the OK button.

Note

• Dispose of the used Printhead in accordance with local regulations.
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8
 

Holding the new Printhead by the grips (a), remove it from the
pouch.

Important

• When handling the Printhead, always hold it by the grips (a). Never touch the nozzles (b) or metal contacts (c). This
may damage the Printhead and affect printing quality.

• Never touch the ink supply section (d). This may cause printing
problems.

 

9
 

While firmly holding the Printhead you have removed, use
your other hand to remove the orange Protective Part (a).
Squeeze the grips (c) of Protective Part (b) and pull it
down to remove it.

Important

• The inside surface of the Protective Part (a) and Protective Part (b) is coated with ink to protect the nozzles. Be
careful not to touch these surfaces when removing the caps.

• The Printhead contains ink to protect the nozzles. We recommend removing Protective Part (b) as you hold it over
the Printhead package or safely out of the way to avoid spilling ink and staining your clothes or the surrounding
area. If ink accidentally spills, wipe off the ink with a dry cloth.

• If you need to put a Printhead somewhere temporarily before installation, do not keep the nozzles and metal con-
tacts facing down. If the nozzles or metal contacts are damaged, it may affect the printing quality.

• Do not reattach the Protective Part or protective material. Dispose of these materials in accordance with local regu-
lations.
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10
 

With the nozzles facing down and the metal contacts
toward the back, tilt the Printhead slightly forward and
insert it into the Carriage. Carefully push the printhead
firmly into the Carriage, ensuring that the nozzles and
metal contacts do not touch the carriage.

11
 

Pull the Printhead Fixer Cover down toward the front to
lock the Printhead in place.

12
 

Push the Printhead Fixer Lever toward the back of the
printer until it clicks.
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13
 

Push the Carriage Cover down toward the front.

14
 

Close the Top Cover.
Ink now fills the system. It takes about 13 minutes for
ink to fill the system.

Important

• While ink is being filled, definitely do not remove the Ink Tank or Maintenance Cartridge. Ink may leak out.

Note

• The procedure is now finished if you have set Rep.P.head Print to Off in the Control Panel menu.
In this case, execute Initial adjustmt in Head Posi. Adj. in the Control Panel menu.
 (See "Adjustment When Installing the Printhead.") →P.802

15 Feed paper by following the instructions on the Display Screen.
After the paper has advanced, Initial adjustmt in Head Posi. Adj. is executed automatically.

Note

• When printing fine lines or text at high precision on glossy or semi-glossy photo or proofing paper, set the optimal
Printhead height before aligning the printhead.
 (See "Enhancing Printing Quality.") →P.796
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Cutter UnitCutter Unit
Cutter Unit .......................................................................................................................................................... 848
Replacing the Cutter Unit ................................................................................................................................... 848

Cutter UnitCutter Unit
When purchasing, check the Model number.

Shape Model number

CT-06

Note

• For instructions on Cutter Unit replacement, see "Replacing the Cutter Unit." →P.848

Replacing the Cutter UnitReplacing the Cutter Unit

Compatible Cutter Units
For information on compatible cutter units, see "Cutter Unit." →P.848

Access the menu for cutter unit replacement

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Maintenance, and then press the OK button.

4 Press ▲ or ▼ to select Change Cutter, and then press the OK button.
The Carriage moves. When it finishes moving, instructions are displayed on the Display Screen.

Note

• If you do not respond within two minutes, cutter cleaner replacement is canceled. In this case, repeat the procedure.
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Replacing the Cutter Unit

1
 

Open the Top Cover.

2 If the Cutter Unit or Carriage Cover is dirty, use a damp cloth that you have wrung out completely to wipe it
clean.

Important

• Do not touch the Linear Scale (a), Carriage Shaft (b), or
Fixed Blade (c). This may stain your hands and damage
the printer.

 

3
 

Push the Cutter Unit Detachment Lever to the left to unlock it.
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4
 

Holding the Cutter Unit by the Lock Lever (a) and grip (b), remove it
from the Carriage.

Caution

• Never touch any part of the Cutter Unit except the Lock Lever (a) and grip (b). This may stain your hands or cause
injury. Additionally, this may damage the printer.

• Do not disassemble the Cutter Unit. Touching the blade may cause injury.

Note

• Dispose of the used Cutter Unit in accordance with local regulations.

5 Holding the new Cutter Unit by the Lock Lever (a) and grip (b), insert it on the Carriage until it clicks into place
(c).

Important

• After installing the Cutter Unit, hold it only by the grip (b) and pull the Cutter Unit forward to make sure it does not
come off. It may damage the printer if the Cutter Unit comes off.

6
 

Lift the Cutter Unit Detachment Lever to lock it.
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7
 

Close the Top Cover.

8 A confirmation message is displayed about the Cutter Unit lock.
Press ▲ or ▼ to select "Yes", and then press the OK button.

9 The Carriage is moved, and a confirmation message is displayed about resetting the cut count.
To reset the cut counter, press ▲ or ▼ to select Yes, and then press the OK button.
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Maintenance CartridgeMaintenance Cartridge
Maintenance Cartridge ...................................................................................................................................... 852
Replacing the Maintenance Cartridge ............................................................................................................... 852
Checking the Remaining Maintenance Cartridge Capacity .............................................................................. 859
When to Replace the Maintenance Cartridge .................................................................................................... 859

Maintenance CartridgeMaintenance Cartridge
When purchasing, check the Model number.
This Maintenance Cartridge comes with a Shaft Cleaner.

Shape Model number

MC-08

Note

• For instructions on replacing the Maintenance Cartridge and Shaft Cleaner, see "Replacing the Maintenance Cartridge."
→P.852

Replacing the Maintenance CartridgeReplacing the Maintenance Cartridge

Compatible maintenance cartridges
For information on compatible maintenance cartridges, see "Maintenance Cartridge." →P.852

Precautions when handling the Maintenance Cartridge
Take the following precautions when handling the Maintenance Cartridge.

Caution

• For safety, keep the Maintenance Cartridge out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.

Important

• Do not remove the Maintenance Cartridge except to replace it. Ink may leak out.

• To prevent ink from leaking from a used Maintenance Cartridge, avoid dropping the cartridge or storing it at an angle. Other-
wise, ink may leak and cause stains.

• Ink adheres to the top of the Maintenance Cartridge after it has been used. Handle the Maintenance Cartridge carefully dur-
ing replacement. The ink may stain clothing.
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Confirm the message
When the Maintenance Cartridge is almost empty, a message is shown on the Display Screen. According to the mes-
sage, replace the Maintenance Cartridge or prepare a new Maintenance Cartridge.  (See "When to Replace the Mainte-
nance Cartridge.") →P.859

If a message is displayed requesting Maintenance Cartridge replacement, you can skip the step Access the menu for
Maintenance Cartridge replacement. Follow the instructions in Replace the Maintenance Cartridge.

Important

• Do not replace the Maintenance Cartridge during initialization immediately after turning on the printer, during Printhead clean-
ing, or when ink is being absorbed. Ink may leak out.

Access the menu for Maintenance Cartridge replacement

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Maintenance, and then press the OK button.

4 Press ▲ or ▼ to select Repl. maint cart, and then press the OK button.
Instructions are displayed on the Display Screen.
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Replace the Maintenance Cartridge

1
 

Open the box, remove the plastic bag, packaging mate-
rial, and Shaft Cleaner, and then take out the Mainte-
nance Cartridge.

Important

• Never touch the metal contacts (a). This may damage the
Maintenance Cartridge.

 

2
 

At this point, open the Maintenance Cartridge Cover.

3
 

Hold the used Maintenance Cartridge by the grip (a)
with one hand and put your other hand under the Main-
tenance Cartridge to hold it firmly on the bottom, keep-
ing it level as you pull it out.
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Important

• Used maintenance cartridges are heavy. Always grasp the cartridge firmly and keep the cartridge level during re-
moval and storage. If you drop a used Maintenance Cartridge or store it at an angle, ink may leak and cause stains.

• The remaining Maintenance Cartridge capacity is recorded on each printer. Do not install a used Maintenance Car-
tridge in another printer.

4
 

Attach the packaging material to the used Maintenance
Cartridge and put it in the box. Keep it level as you put
it in the plastic bag. Expel excess air from the plastic
bag and seal the zipper.

5
 

Confirm the Maintenance Cartridge is right-side up, put
it in the box, and store it so that it stays level.

Important

• Always put the used Maintenance Cartridge back in the box and store the box on a flat surface. Otherwise, ink may
leak and cause stains.

Note

• In accordance with active and ongoing environmental programs, Canon supports recycling of used maintenance car-
tridges. Follow the instructions provided with the new Maintenance Cartridge that describe how to process the used
Maintenance Cartridge.

6
 

Wipe away any soiling on the Maintenance Cartridge
Cover.
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Important

• Support the Maintenance Cartridge Cover from underneath as you wipe it.

7
 

Keeping the new Maintenance Cartridge level, insert it
all the way in.

8
 

Close the Maintenance Cartridge Cover.

9
 

Press the OK button.
The printer now initializes the Maintenance Cartridge.
Next, replace the Shaft Cleaner.

Replacing the Shaft Cleaner
Replace the Shaft Cleaner when you replace the Maintenance Cartridge. New Shaft Cleaner is included with replace-
ment Maintenance Cartridge.
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After you execute Repl. maint cart and replace the Maintenance Cartridge, a message will appear on the Display
Screen requesting you to replace the Shaft Cleaner. Select Yes and press the OK button. When a message requests
you to open the Top Cover, go to step 5.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Maintenance, and then press the OK button.

4 Press ▲ or ▼ to select Repl. S. Cleaner, and then press the OK button.
The Carriage moves. When it finishes moving, instructions are displayed on the Display Screen.

5
 

Open the Top Cover.

Note

• If you do not respond within two minutes, shaft cleaner replacement is canceled. In this case, repeat the procedure.

6
 

Hold the Shaft Cleaner on the right side of the Carriage
by the grips (a) and pull it to the right to remove it.
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Important

• Do not touch the Linear Scale (a), Carriage Shaft (b), or
Fixed Blade (c). This may stain your hands and damage
the printer.

 

7
 

Holding the new Shaft Cleaner by the grips (a), attach it
to the Carriage.

Note

• Be sure to put the used Shaft Cleaner in the small box before putting it in the larger box with the used Maintenance
Cartridge for disposal.

8
 

Close the Top Cover.
The Carriage moves back into position.
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Checking the Remaining Maintenance Cartridge CapacityChecking the Remaining Maintenance Cartridge Capacity
The Maintenance Cartridge absorbs excess ink from borderless printing, printhead cleaning, and other processes. You
can confirm the remaining capacity of the Maintenance Cartridge by checking the Maintenance Cartridge capacity
shown on the Display Screen.
To check remaining Maintenance Cartridge capacity, access the Tab Selection screen on the Control Panel and

press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

If the Display Screen indicates to replace the Maintenance Cartridge, replace the Maintenance Cartridge. If a message
is displayed indicating to check the remaining capacity of the Maintenance Cartridge, or before tasks that deplete much
of the capacity such as head cleaning or preparations to move the printer, check the remaining Maintenance Cartridge
capacity and prepare a new Maintenance Cartridge as needed.  (See "Replacing the Maintenance Cartridge.") →P.852

When to Replace the Maintenance CartridgeWhen to Replace the Maintenance Cartridge
Replace or prepare to replace the Maintenance Cartridge in the following situations.

If a message for checking the Maintenance Cartridge is shown on the Display Screen
When the Maintenance Cartridge is almost full, the Message Lamp is lit and "The level is low" is shown on the Dis-
play Screen. You can continue to print, but check the remaining Maintenance Cartridge capacity and prepare to re-
place the Maintenance Cartridge with a new one.  (See "Checking the Remaining Maintenance Cartridge Capacity.")
→P.859

When much of the Maintenance Cartridge capacity is depleted
Printhead cleaning, Printhead replacement, and preparations to transfer the printer deplete much of the Maintenance
Cartridge capacity. (In particular, preparing to move the printer depletes a lot of the capacity.)
Check the remaining Maintenance Cartridge capacity before this maintenance and replace the Maintenance Cartridge
if necessary.
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If a message for the Maintenance Cartridge replacement is shown on the Display Screen
When the Maintenance Cartridge is almost empty, the Message Lamp lights, a message to replace the Maintenance
Cartridge is displayed on the Display Screen, and you cannot print. Replace the Maintenance Cartridge with a new
one.
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Cleaning the PrinterCleaning the Printer
Cleaning the Printer Exterior .............................................................................................................................. 861
Cleaning Inside the Top Cover .......................................................................................................................... 861
Cleaning the Printhead ....................................................................................................................................... 839

Cleaning the Printer ExteriorCleaning the Printer Exterior
Clean the printer regularly to maintain better printing quality and help prevent problems.
About once a month, clean the printer exterior.

1 Turn the printer off.  (See "Turning the Printer On and Off.") →P.21

2 Unplug the power cord from the outlet.

Caution

• Always turn off the printer and unplug the power cord before cleaning or maintenance. Accidentally leaving the print-
er on poses a risk of injury if you touch moving parts inside the printer.

3
 

Using a damp cloth that you have wrung out complete-
ly, wipe away any dirt or paper dust from the Paper
Feed Slot (a), power cord plug, and so on. Dry these
parts with a dry cloth.

Warning

• Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come into contact with elec-
trical components inside the printer, there is a risk of fire or electrical shock.

Important

• If the Ejection Guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend cleaning the
Ejection Guide even if it does not appear dirty, because it may actually be covered with paper dust.

4 Plug the power cord into the outlet.

Cleaning Inside the Top CoverCleaning Inside the Top Cover
Clean inside the Top Cover to maintain better printing quality and help prevent problems.
Also clean inside the Top Cover in the following situations to ensure optimal operation.

• If the printed surface or the underside of paper is dirty after printing
• After you have used up a roll
• After borderless printing
• After printing on small paper
• After printing on paper that generates a lot of cutting debris
• If you have replaced the roll
• After printing on paper that generates a lot of paper dust
• If the message "Blue platen switch is dirty." is displayed
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Important

• If the Platen inside the Top Cover becomes dirty, it may soil the underside of paper. We recommend cleaning the Platen after
borderless printing or printing on small paper.

• If the Ejection Guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend cleaning the Ejection
Guide even if it does not appear dirty, because it may actually be covered with paper dust.

1
 

Open the Top Cover.

2
 

If paper dust has accumulated in the Vacuum holes (a)
on the Platen, in the Borderless Printing Ink Grooves
(b), or on the cutter guide (c), use the Cleaning Brush
(d, provided with the printer) to wipe it away.

Note

• If the Cleaning Brush is dirty, rinse it in water.
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3
 

Using a damp cloth that you have wrung out complete-
ly, wipe inside the Top Cover to clean it. Wipe away
any ink residue and paper dust (debris from cutting) on
the Top Cover Roller (a), all over the Platen (b), on the
Paper Retainer (c), the Borderless Printing Ink Grooves
(d), the Ejection Guide (e), the cutter guide (f), around
the ink suction holes at left (g), around the Borderless
Printing Ink Grooves at right (h), on the blue Switch (i),
and so on.

Warning

• Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come into contact with elec-
trical components inside the printer, there is a risk of fire or electrical shock.

Important

• Do not touch the Linear Scale (a), Carriage Shaft (b), or
Fixed Blade (c). This may stain your hands and damage
the printer.

• Do not use a dry cloth to wipe inside the Top Cover. This may create a static charge, which may attract dust and
affect the printing quality.

• Do not touch the clear sheet on the side of the Top Cover Roller. This may damage the roller.
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4
 

Close the Top Cover.
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Other MaintenanceOther Maintenance
Preparing to Transfer the Printer ........................................................................................................................ 865
Updating the Firmware ....................................................................................................................................... 871

Preparing to Transfer the PrinterPreparing to Transfer the Printer
To protect the internal parts in transit, always follow these steps before transferring the printer to a new location.
Refer to the Setup Guide for details on packing the printer and installing it after transfer.

Important

• Be sure to contact your Canon dealer before transferring the printer to a new location. Ink may leak and damage the printer if
you do not prepare the printer correctly and it is tipped or stood on end in transit.

Note

• Depending on the state of the printer, part replacement may be necessary when preparing to transfer the printer (that is, when
you execute the printer menu item to prepare for transfer).

• Ink must be drawn into the Maintenance Cartridge before Level 2 or Level 3 printer transfer, as described in the following
table. Prepare the Maintenance Cartridge in advance.

• Always follow the instructions of the service representative when transferring the printer under Level 3 conditions.

Level Shipping Method
(Example) Permitted Angle of Inclination Amount of Ink

to Dispose of

Required
Mainte-

nance Car-
tridges(*1)

1 By truck Lengthwise: 0–30º

Rotation: 0–10º

0 0(*2)

2 By plane All directions: 0–30º Approx. 600
ml (20.3 fl
oz)

1 or 2
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Level Shipping Method
(Example) Permitted Angle of Inclination Amount of Ink

to Dispose of

Required
Mainte-

nance Car-
tridges(*1)

3 Tipping the
printer or
holding it up-
right for eleva-
tors or stairs

Lengthwise: 0–90º
Rotation: 0–30º

Approx.
1,900 ml
(64.3 fl oz)

2 or 3

*1: This is the number of new Maintenance Cartridge required when you execute the Prep.MovePrinter menu. The num-
ber varies depending on the amount remaining in the Maintenance Cartridge being used.

*2: If a message instructing you to replace the Maintenance Cartridge is displayed on the Display Screen, the Maintenance
Cartridge needs to be replaced.

Remove paper

1 Remove the paper.

• Rolls  (See "Removing the Roll from the Printer.") →P.539
• Sheets  (See "Removing Sheets.") →P.560

Access the Prep.MovePrinter menu

1 If a message instructing you to replace the Maintenance Cartridge is displayed on the Display Screen, replace
the Maintenance Cartridge.
 (See "Replacing the Maintenance Cartridge.") →P.852

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Prep.MovePrinter, and then press the OK button.

5 Press ▲ or ▼ to select the level of transfer, and then press the OK button.

6 Press ▲ or ▼ to select Execute, and then press the OK button to display the confirmation screen.

7 Press ▲ or ▼ to select Yes, and then press the OK button.
The printer is now prepared for transfer.

• Level 1
Once preparations are finished, a message on the Display Screen requests you to turn off the printer.
Turn off and pack the printer. There is no need to remove the ink tanks.
 (See "Pack the printer.") →P.869

• Level 2 and Level 3

 

Preparing to Transfer the Printer                                                                                                                                                                                         iPF9400

                                                                                                                                                                                                                                       User's Guide

  

M
aintenance and C

onsum
ables

O
ther M

aintenance

 866



When the preparation is finished, instructions are displayed on the Display Screen.
Remove the ink tanks before packing the printer.
 (See "Removing Ink Tanks.") →P.867

Important

• If consumables must be replaced, the message "Consumables must be replaced. Call for service." is shown on
the Display Screen and preparation is not possible. If this message is displayed, press the OK button and contact
your Canon dealer for assistance.

Removing Ink Tanks

1
 

Open the left and right ink tank covers.

2
 

Lift the stopper (a) of the Ink Tank Lock Lever (a). Lift
the Ink Tank Lock Lever until it stops, and then push it
down to the front.
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3
 

Hold the Ink Tank by the handle (a) and remove it.

Important

• Store the Ink Tank you removed in the box with the ink holes (a) facing up.
Otherwise, ink may leak and cause stains.

 

4 Repeat steps 2 and 3 to remove all ink tanks.

5
 

Push down the release lever (a) as shown as you gen-
tly return all ink tank lock levers to the original position.
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6
 

Close the Ink Tank Cover.
At this point, ink is drawn out from inside the tubes.

Important

• Do not remove the Maintenance Cartridge except when the message for replacing it is displayed.
If you remove the Maintenance Cartridge while ink is being drawn out, the ink may leak out.

7 When the process is finished, "Preparations for moving the printer finished. Turn the power off" is dis-
played.
When this happens, replace the Maintenance Cartridge currently being used with a new Maintenance Car-
tridge.

8
 

Press the Power button and turn off the printer.

Pack the printer

1 Disconnect the printer power cord and interface cable, as well as the Media Take-up Unit Power Inlet.

Important

• Turn the power off and then disconnect the power cord. It may damage the printer if you unplug it before it is off and
transfer it in that state. If you accidentally unplug the printer, plug it in again, reinstall the ink tanks, and follow this
procedure again.

2
 

Open the Top Cover and lift the Ejection Guide.
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3
 

Remove the six Ejection Supports and lower the Ejec-
tion Guide.

4
 

Grasp the Belt, insert it between the Belt Stopper, and
affix the Belt Stopper with a hex screw at the position
indicated.

Important

• Here, the Belt Stopper is the one that was removed and stored after initial installation. Neglecting to attach the Belt
Stopper may damage the printer.

• Do not touch the Linear Scale (a), Carriage Shaft (b), or
Fixed Blade (c). This may stain your hands and damage
the printer.
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5
 

Close the Top Cover.

6 Tape down printer covers to secure them, in the reverse order of tape removal during installation.

7 If the Output Stacker is installed, reverse the installation procedure to remove the Output Stacker.

8 Remove the Stand by reversing the installation procedure, when it was attached to the printer.

9 Disassemble and repackage the Stand by following the installation procedure (with six people lifting the printer)
in reverse.

Important

• Do not use the procedure for rotated installation (installing by rotating the printer). This may damage the printer. For
details, see Setup Guide.

10 Repack the Roll Holder, Holder Stopper, and printer in shipping materials, and then package them in a shipping
box.

Updating the FirmwareUpdating the Firmware
Update the printer firmware to take advantage of new and improved printer functions.

Confirming the firmware version

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to se-

lect the Settings/Adj. tab ( ).

Note

• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Printer Info, and then press the OK button.

4 Press ▲ or ▼ to select System Info, and then press the OK button.
The firmware version is displayed.
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Updating the Firmware
To obtain the latest firmware, visit the Canon website. If the firmware available online is newer than the installed firm-
ware, update the printer firmware. For details on downloading and updating the firmware, visit the Canon website.
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ConsumablesConsumables
Ink Tanks ............................................................................................................................................................ 826
Printhead ............................................................................................................................................................ 838
Cutter Unit .......................................................................................................................................................... 848
Maintenance Cartridge ...................................................................................................................................... 852
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Frequently Asked QuestionsFrequently Asked Questions
Frequently Asked QuestionsFrequently Asked Questions

This section presents frequently asked questions and answers. To view more detailed explanations, click the hyper-
links in the answer column.

Question Answer
I want to easily create ver-
tical or horizontal banners.

You can print originals that are in landscape (or portrait) orientation automatically enlarged to fit the roll width. This
is an easy way to create vertical or horizontal banners.
 (See "Printing Vertical or Horizontal Banners (Large-Format Printing).") →P.108

Does this printer support
sub-ink tank system?

This printer supports sub-ink tank system.
Even if an ink tank becomes empty during printing, since a certain amount of ink always is stored in a sub-ink
tank, you can replace the ink tank while printing.
 (See "Replacing Ink Tanks.") →P.826

I want to know how to con-
figure roll cutting.

You can select the cutting method by the setting of the printer driver and the setting of the printer.
To cut rolls automatically after printing, set Cutting Mode of the printer to Automatic and Automatic Cutting of
the printer driver to Yes.
When using paper for which ink adhesion takes time or the print surface is easily scratched, we recommend that
you set the Cutting Mode setting of the printer to Eject.
 (See "Specifying the Cutting Method for Rolls.") →P.546
 (See "Cutting Roll Paper After Printing.") →P.167

I want to configure so that
the roll is cut automatically
after waiting for the ink to
dry.

In the printer driver, you can set the time for waiting until the ink dries.
Also, you can set likewise on the printer.
 (See "Specifying the Ink Drying Time for Rolls.") →P.544
 (See "Menu Structure.") →P.661

How do I print without bor-
ders?

When printing on rolls, you can perform borderless printing by configuring the printer driver. (when printing on cut
sheets, you cannot perform borderless printing)
 (See "Borderless Printing on Paper of Equivalent Size.") →P.95
 (See "Borderless Printing by Resizing Originals to Fit the Roll Width.") →P.101
 (See "Borderless Printing at Actual Size.") →P.89

I want to know the paper
types that can be used in
this printer.

Concerning the paper that can be used in this printer, refer to the imagePROGRAF home page or the Paper Ref-
erence Guide.
 (See "Types of Paper.") →P.522

The paper type that I want
to print is not displayed on
the Display Screen.

When using newly released paper, paper information must be registered on the printer and the printer driver.
Download the new version of Media Information File from the imagePROGRAF website and install it.
 (See "Types of Paper.") →P.522

What type of function is
color calibration?

Color calibration improves color consistency by compensating for slight differences in how color appears when
printing due to individual variations or aging among the printers.
We recommend color calibration in the following situations.

• After initial printer installation
• After Printhead replacement
• When you sense a change of color compared to previously
• To print with colors aligned from multiple printers
• When the execution guide is displayed

 (See "Corrects slight differences in how colors appear (color calibration).") →P.820

Can I perform duplex
printing?

This printer cannot perform duplex printing.
If you use the Folded Duplex function in the Free Layout of Windows software, you can print two pages one-
sided, fold them at the center and suspend them to substitute for duplex printing.
 (See "Prints using Folded Duplex (Windows).") →P.239

I want to perform enlarge-
ment printing.

With the printer driver, you can specify the ratio matching the document with the paper size and width and perform
enlargement printing or reduction printing.
 (See "Resizing Originals to Match the Paper Size.") →P.68
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Question Answer
I want to perform enlarge-
ment printing.

 (See "Resizing Originals to Fit the Roll Width.") →P.72
 (See "Resizing Originals by Entering a Scaling Value.") →P.78
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Problems Regarding PaperProblems Regarding Paper
Clearing Jammed Roll Paper ............................................................................................................................. 878
Clearing a Jammed Sheet .................................................................................................................................. 881
Roll paper cannot be inserted into the paper feed slot ..................................................................................... 883
Cannot load sheets ............................................................................................................................................ 884
Paper is not cut straight ..................................................................................................................................... 884
Paper is not cut .................................................................................................................................................. 884
The media take-up unit continues rotating ......................................................................................................... 884
The size of clear film cannot be detected .......................................................................................................... 885
Margins are wide ................................................................................................................................................ 885
When printing on thin roll paper, the printed surface becomes scratched ....................................................... 885

Clearing Jammed Roll PaperClearing Jammed Roll Paper
If roll paper jams, follow the steps below to remove jams.

1 Turn the printer off.  (See "Turning the Printer On and Off.") →P.21

2
 

Open the Top Cover.

Note

• If the leading edge of the roll jams in the carriage such as when the paper curls strongly, you may be able to avoid
paper jamming by setting the roll cutting method to Manual and setting the detection of paper leading edge to [Off].
 (See "Specifying the Cutting Method for Rolls.") →P.546

3
 

If the Carriage is out, move the Carriage out of the way,
away from the paper.

Caution

• If you push the Carriage to the left edge, the blade of the Cutter Unit will be lowered in preparation to cut the paper.
Be careful not to pinch your fingers between the Carriage and Platen if you have pushed the Carriage to the left
edge or if a paper jam occurs during cutting.
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Important

• Do not touch the Linear Scale (a), Carriage Shaft (b), or
Fixed Blade (c), This may stain your hands and damage
the printer.

 

4
 

Lift the Release Lever.

5
 

Holding the paper on both sides, pull the jammed por-
tion out toward the front. Use scissors or a cutting tool
to cut away the printed or wrinkled portion.
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Caution

• When cutting paper, be careful to avoid injury or damage to the printer.

6
 

If the Carriage is on the left, move the Carriage to the
right until it stops.

Important

• Always move the Carriage to the right side. If the Carriage is on the left, a Carriage error may occur when you turn
on the printer.

7
 

Hold the edge of the roll paper in the middle as you
gently pull it evenly to the position of the Ejection Guide
(a). Align the right side of the roll paper with the Paper
Alignment Line (b), keeping this side parallel to the line,
and then lower the Release Lever.

Important

• Do not force the roll paper into alignment with the Paper Alignment Line (b). This may prevent the paper from being
advanced straight.

8
 

Close the Top Cover.
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9 Turn the printer on.  (See "Turning the Printer On and Off.") →P.21
The roll is advanced and the printer is ready to print.

Note

• For a neater edge, press the Cut button, select Yes, and cut the edge.
 (See "Specifying the Cutting Method for Rolls.") →P.546

Clearing a Jammed SheetClearing a Jammed Sheet
If a sheet jams, follow the steps below to remove it.

1 Turn the printer off.  (See "Turning the Printer On and Off.") →P.21

2
 

Open the Top Cover.

3
 

If the Carriage is out, move the Carriage out of the way,
away from the paper.

Caution

• If you push the Carriage to the left edge, the blade of the Cutter Unit will be lowered in preparation to cut the paper.
Be careful not to pinch your fingers between the Carriage and Platen if you have pushed the Carriage to the left
edge or if a paper jam occurs during cutting.
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Important

• Do not touch the Linear Scale (a), Carriage Shaft (b), or
Fixed Blade (c). This may stain your hands and damage
the printer.

 

4
 

Lift the Release Lever.

5
 

If the paper is visible, hold the paper and pull it out to-
ward the front.

 

 

Clearing a Jammed Sheet                                                                                                                                                                                                   iPF9400

                                                                                                                                                                                                                                       User's Guide

  

Troubleshooting
Problem

s R
egarding Paper

 882



6
 

If the paper is not visible, lift the Ejection Guide, remove
the Roll Holder, and clear the paper jam from below.

After removing the paper, make sure there are no other
scraps of paper in the printer, and then lower the Ejec-
tion Guide.

7
 

If the Carriage is on the left, move the Carriage to the
right until it stops.

Important

• Always move the Carriage to the right side. If the Carriage is on the left, a Carriage error may occur when you turn
on the printer.

8
 

Lower the Release Lever and close the Top Cover.

9 Turn the printer on.  (See "Turning the Printer On and Off.") →P.21

Roll paper cannot be inserted into the paper feed slotRoll paper cannot be inserted into the paper feed slot
Cause Corrective Action

The roll paper is warped. Straighten out curls and reload the roll.

Paper is jammed by the paper feed slot. Remove the jammed paper.
 (See "Clearing Jammed Roll Paper.") →P.878
 (See "Clearing a Jammed Sheet.") →P.881
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Cause Corrective Action
The paper source selection is incorrect. Press the Load button and select the paper source.

Cannot load sheetsCannot load sheets
Cause Corrective Action

The paper source selection is incorrect. Press the Load button and select the paper source.

Paper is not cut straightPaper is not cut straight
Cause Corrective Action

The paper is bent or curled at the cut position. Straighten out any curling by the edges of the paper.

Paper rises by the ends of the cut position before it is
cut.

Reload the paper correctly.

You are using paper that cannot be cut with the Cutter
Unit.

Specify Manual in Cutting Mode in the Control Panel menu and use scissors or a
cutting tool to cut the roll after printing.
 (See "Specifying the Cutting Method for Rolls.") →P.546

The Cutter Unit is not installed correctly. Reinstall the Cutter Unit correctly.
 (See "Replacing the Cutter Unit.") →P.848

The Cutter Unit blade is worn out. Replace the Cutter Unit.
 (See "Replacing the Cutter Unit.") →P.848

Cut Speed is not configured correctly in the Control
Panel menu.

Change the Cut Speed setting in the Control Panel menu.
 (See "Menu Structure.") →P.661

During cutting, printed documents fall out at an angle. In the Control Panel menu, set Cutting Mode to Eject. Hold documents after printing,
as they are cut.
 (See "Specifying the Cutting Method for Rolls.") →P.546

Paper is not cutPaper is not cut
Cause Corrective Action

In the printer driver, No or Print Cut Guide-
line is specified in Automatic Cutting.

Specify Yes in Automatic Cutting in the printer driver.
 (See "Page Setup Sheet (Windows).") →P.195
 (See "Paper Detailed Settings Dialog Box (Mac OS X).") →P.368

In the Control Panel menu, Cutting Mode is
set to Eject or Manual.

If the Cutting Mode is Eject, press the Cut button to cut the paper.
If the Cutting Mode is Manual, cut rolls with scissors or the like.
 (See "Specifying the Cutting Method for Rolls.") →P.546

The Cutter Unit is not installed. Install the Cutter Unit.
 (See "Replacing the Cutter Unit.") →P.848

Rolls are not cut when you are using the Me-
dia Take-up Unit.

Either cut the roll paper by pressing the Cut button or lift the Release Lever and cut the roll with
scissors.
 (See "Removing Printed Documents from the Media Take-up Unit.") →P.579

The media take-up unit continues rotatingThe media take-up unit continues rotating
Cause Corrective Action

There is a foreign object in the path of the Media Take-up Sensor (indicated by a
dotted line).

Remove the foreign object from the Media Take-up Sensor
path. Arrange the Basket Cloth and Basket Rod so they do
not interfere with the Media Take-up Sensor.
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Cause Corrective Action
Remove the foreign object from the Media Take-up Sensor
path. Arrange the Basket Cloth and Basket Rod so they do
not interfere with the Media Take-up Sensor.

The Media Take-up Sensor cord is not connected to the Right Media Take-up Unit
correctly.

Reconnect the Media Take-up Sensor cord as follows.

1. Turn the printer off.

2. Disconnect the Media Take-up Sensor cord from the
Right Media Take-up Unit and reconnect it firmly, all the
way in.

3. Turn the printer on.

 (See "Using the Media Take-up Unit.") →P.570

If the Media Take-up Unit continues rotating, contact your
Canon dealer for assistance.

The size of clear film cannot be detectedThe size of clear film cannot be detected
Cause Corrective Action

The Platen is soiled with ink or other substances. Open the Top Cover and clean the entire Platen.
 (See "Cleaning Inside the Top Cover.") →P.861

Margins are wideMargins are wide
Cause Corrective Action

Rolls are advanced a specific amount before cutting to prevent problems with cutting and paper ejection. This operation is normal.

When printing on thin roll paper, the printed surface becomes scratchedWhen printing on thin roll paper, the printed surface becomes scratched
Cause Corrective Action

The roll paper has sagged during printing, scratching
the surface of the paper and causing wrinkle creases
in the paper.

Set Roll Tension to High in the Control Panel menu.
 (See "Menu Settings.") →P.667
If you change the Roll Tension setting, We recommend that you perform Adj. Quali-
ty.
 (See "Automatic Banding Adjustment.") →P.806
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Printing does not startPrinting does not start
The Data lamp on the Control Panel does not light up ...................................................................................... 886
The printer does not respond even if print jobs are sent ................................................................................... 886
Ink Filling.. is displayed ...................................................................................................................................... 886
The display screen indicates Agitating... ........................................................................................................... 886

The Data lamp on the Control Panel does not light upThe Data lamp on the Control Panel does not light up
Cause Corrective Action

The printer is not on. Make sure the power cord is securely plugged in, all the way. Press the Power button to turn on the printer.

The target printer was not
selected when printing.

In Windows, select the printer by clicking Select Printer or Printer in the printing dialog box and try printing
again.

In Mac OS X, open the dialog box of the printer driver, select the printer from the list of Printer, and try printing
again.

The print job is paused. In Windows, restart the print job as follows.

1. Select the printer icon in the Printers and Faxes (or Printers) window.
2. Clear Pause Printing in the File menu to restart the print job.

In Mac OS X, restart the print job as follows.

1. Click Print & Fax. (This is identified as Printer Setup Utility or Print Center in other versions of Mac OS
X.)

2. Select the printer, and then Resume Printer (or Start Jobs) in the Printers menu to restart the print job.

The printer does not respond even if print jobs are sentThe printer does not respond even if print jobs are sent
Cause Corrective Action

In the Control Panel menu, Pause Print is On. Set Pause Print to Off.
 (See "Pausing Printing.") →P.33

You have selected Save in mail box in Output Method on the
printer.

Print the job saved on the printer's hard disk.
 (See "Printing Saved Jobs.") →P.763

Print jobs are pending. Manage the jobs on hold and print as needed.
 (See "Managing Pending Jobs (Printing or Deleting Jobs on Hold).") →P.761

Ink Filling.. is displayedInk Filling.. is displayed
Cause Corrective Action

The printer was forced off during operation. Wait until the system has been filled with ink. This process may take about nine minutes.

The display screen indicates Agitating...The display screen indicates Agitating...
Cause Corrective Action

Ink agitation is in pro-
gress.

Please wait until ink agitation is finished.
The time for agitation varies depending on how long the printer was off. (Between about a minute and a half to
twenty minutes.)
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The printer stops during a print jobThe printer stops during a print job
An error message is shown on the Display Screen ........................................................................................... 887
The printer ejects blank, unprinted paper .......................................................................................................... 887

An error message is shown on the Display ScreenAn error message is shown on the Display Screen
Cause Corrective Action

An error message is displayed during printing. Check the error message and take action as necessary.
 (See "Error Messages.") →P.908

The last portion of roll paper was used during a print job, and paper could not be
advanced because the trailing edge is taped to the roll.

Remove the used roll and insert a new roll.
 (See "Removing the Roll from the Printer.") →P.539
 (See "Removing the Roll Holder from Rolls.") →P.542
 (See "Loading and Printing on Rolls.") →P.22

The printer ejects blank, unprinted paperThe printer ejects blank, unprinted paper
Cause Corrective Action

The leading edge of the roll paper was cut
to straighten it.

The leading edge of rolls may be cut to straighten it if Trim Edge First is set to a value other than
Off in the Control Panel menu.
 (See "Cutting the Leading Edge of Roll Paper Automatically.") →P.552

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and make sure the Printhead is in good condition for print-
ing.
 (See "Checking for Nozzle Clogging.") →P.838

A print job was received from an incom-
patible printer driver.

Use the correct imagePROGRAF printer driver for the printer and try printing again.

The printer is damaged. Contact your Canon dealer for assistance.
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Problems with the printing qualityProblems with the printing quality
Printing is faint .................................................................................................................................................... 888
Paper rubs against the printhead ...................................................................................................................... 889
The edges of the paper are dirty ....................................................................................................................... 889
The surface of the paper is dirty ........................................................................................................................ 890
The back side of the paper is dirty .................................................................................................................... 890
Immediately after borderless printing, the trailing edge margin is soiled during regular printing .............................................. 891
Printed colors are inaccurate ............................................................................................................................. 891
Banding in different colors occurs ..................................................................................................................... 891
Colors in printed images are uneven ................................................................................................................. 892
Image edges are blurred or white banding occurs ........................................................................................... 893

Setting the Blue Switch on the Platen ........................................................................................................... 893
The contrast becomes uneven during printing .................................................................................................. 896
The length of printed images is inaccurate in the feeding direction .................................................................. 896
Images are printed crooked ............................................................................................................................... 897
Documents are printed in monochrome ............................................................................................................ 897
Line thickness is not uniform .............................................................................................................................. 897
Lines or colors are misaligned ........................................................................................................................... 898
Borders appear in borderless printing ............................................................................................................... 898

Printing is faintPrinting is faint
Cause Corrective Action

You may be printing on the wrong side of
the paper.

Print on the printing surface.

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if they are clogged.
 (See "Checking for Nozzle Clogging.") →P.838

Because the printer was left without ink
tanks installed for some time, ink has be-
come clogged in the ink supply system.

After the ink tanks have been installed for 24 hours, run Head Cleaning B from the Control Panel.
 (See "Cleaning the Printhead.") →P.839

Paper is jammed inside the Top Cover. Follow the steps below to remove the jammed piece of paper inside the Top Cover.

1. Open the Top Cover and make sure the Carriage is not over the Platen.

2. Remove any scraps of paper inside the Top Cover.
 (See "Clearing Jammed Roll Paper.") →P.878
 (See "Clearing a Jammed Sheet.") →P.881

3. Close the Top Cover.

The ink was not dry when paper was cut. Specify a longer drying period in the Control Panel menu, in Paper Details > Roll DryingTime.
 (See "Menu Settings.") →P.667

Printing may be faint if Print Quality in
Advanced Settings in the printer driver is
set to Standard or Fast.

In Advanced Settings of the printer driver, choose Highest quality or High in Print Quality.
Printing in Fast or Standard mode is faster and consumes less ink than in Highest quality or
High modes, but the printing quality is lower.
 (See "Giving Priority to Particular Graphic Elements and Colors for Printing.") →P.61

You are printing on paper that tends to
generate dust when cut.

In the Control Panel menu, set CutDustReduct. in Paper Details to On.
 (See "Reducing Dust from Cutting Rolls.") →P.554
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Paper rubs against the printheadPaper rubs against the printhead
Cause Corrective Action

The type of paper specified in the printer
driver does not match the type loaded in
the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

Make sure the same type of paper is specified in the printer driver as you have loaded in the print-
er.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

Paper has been loaded incorrectly, caus-
ing it to wrinkle.

Reload the paper.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

The Printhead is set too low in the Control
Panel menu.

In the Control Panel menu, set Head Height to Automatic.
 (See "Troubleshooting Paper Abrasion and Blurry Images.") →P.803

You are printing on heavyweight paper or
paper that curls or wrinkles easily after
absorbing ink.

When printing on Canon Heavyweight Coated Paper or other paper-based media, choose a Vac-
uumStrngth setting of Strong or Strongest in the Control Panel menu. If rubbing still occurs, in
the Control Panel menu, use a higher Head Height setting.
 (See "Adjusting the Vacuum Strength.") →P.811
 (See "Troubleshooting Paper Abrasion and Blurry Images.") →P.803

When printing on CAD Tracing Paper or other film-based media, choose a VacuumStrngth set-
ting of Standard, Strong, or Strongest in the Control Panel menu. If rubbing still occurs, in the
Control Panel menu, use a higher Head Height setting.
 (See "Adjusting the Vacuum Strength.") →P.811
 (See "Troubleshooting Paper Abrasion and Blurry Images.") →P.803

When printing on paper 0.1 mm (0.004 in) thick or less, choose a VacuumStrngth setting of
Weakest in the Control Panel menu. If rubbing still occurs, in the Control Panel menu, use a higher
Head Height setting.
 (See "Adjusting the Vacuum Strength.") →P.811
 (See "Troubleshooting Paper Abrasion and Blurry Images.") →P.803

When you have loaded paper, the paper
you have loaded does not match the type
selected on the Control Panel.

Be sure to select the correct type of paper in the Control Panel menu when loading paper.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

Since the leading edge of the paper
strongly warps upward or ripples, the
leading edge of the paper rubs against
the printhead.

Set Cutting Mode to Manual on the Control Panel menu, and select Off for the paper leading
edge detection setting.
In this case, when keeping track of the amount of roll paper left, set ManageRemainRoll to Off
before loading the roll paper and then set ManageRemainRoll to On after loading the roll paper.
 (See "Specifying the Cutting Method for Rolls.") →P.546
 (See "Keeping Track of the Amount of Roll Paper Left.") →P.544

The edges of the paper are dirtyThe edges of the paper are dirty
Cause Corrective Action

The Platen has become dirty after borderless
printing or printing on small paper.

Open the Top Cover and clean the Platen.
 (See "Cleaning Inside the Top Cover.") →P.861

The type of paper as specified on the printer
does not match the type specified in the
printer driver.

Make sure the same type of paper is specified on the printer as in the printer driver.
 (See "Changing the Type of Paper.") →P.537

Make sure the same paper type is specified in the printer driver as on the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

The paper is wrinkled or warped. Straighten out the wrinkles or curls and reload the paper. Do not use paper that has been prin-
ted on previously.
 (See "Loading Rolls in the Printer.") →P.533
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Cause Corrective Action
The paper is wrinkled or warped.  (See "Loading Sheets in the Printer.") →P.555

A cut line is printed because CutDustRe-
duct. is On in the Control Panel menu to re-
duce cutting dust.

If this function is not needed, set CutDustReduct. to Off in the Control Panel menu.
 (See "Menu Settings.") →P.667

The Printhead is set too low in the Control
Panel menu.

In the Control Panel menu, set Head Height to Automatic.
 (See "Troubleshooting Paper Abrasion and Blurry Images.") →P.803

You are printing on heavyweight paper or pa-
per that curls or wrinkles easily after absorb-
ing ink.

When printing on Canon Heavyweight Coated Paper or other paper-based media, choose a
VacuumStrngth setting of Strong or Strongest in the Control Panel menu. If rubbing still oc-
curs, in the Control Panel menu, use a higher Head Height setting.
 (See "Adjusting the Vacuum Strength.") →P.811
 (See "Troubleshooting Paper Abrasion and Blurry Images.") →P.803

When printing on CAD Tracing Paper or other film-based media, choose a VacuumStrngth
setting of Standard, Strong, or Strongest in the Control Panel menu. If rubbing still occurs, in
the Control Panel menu, use a higher Head Height setting.
 (See "Adjusting the Vacuum Strength.") →P.811
 (See "Troubleshooting Paper Abrasion and Blurry Images.") →P.803

The Ejection Guide is soiled. Clean the Ejection Guide.
 (See "Cleaning the Printer Exterior.") →P.861

The surface of the paper is dirtyThe surface of the paper is dirty
Cause Corrective Action

The Paper Retainer is soiled. Clean the Paper Retainer.
 (See "Cleaning Inside the Top Cover.") →P.861

You are using a paper that does not
dry easily.

In the Control Panel menu, set Roll DryingTime to at least 1 min.
 (See "Menu Settings.") →P.667

When paper that does not dry easily is used for printing, it may curl during printing and touch the Output
Tray.
In this case, in the Control Panel menu, complete the settings for Dry time and Area in Scan Wait
Time.
However, note that printing will now take longer.
 (See "Menu Settings.") →P.667

The back side of the paper is dirtyThe back side of the paper is dirty
Cause Corrective Action

The Platen has become dirty after borderless printing or
printing on small paper.

Open the Top Cover and clean the Platen.
 (See "Cleaning Inside the Top Cover.") →P.861

In the Control Panel menu, set CarriageScanWdth to Fixed.
 (See "Menu Settings.") →P.667

The Platen has become soiled because you have set
Width Detection to Off in the Control Panel menu.

Set Width Detection to On in the Control Panel menu, and then open the Top Cover
and clean the Platen.
 (See "Cleaning Inside the Top Cover.") →P.861

Open the Top Cover and clean the Platen. After this, manually advance the roll onto
the Platen before printing.
 (See "Cleaning Inside the Top Cover.") →P.861
 (See "Feeding Roll Paper Manually.") →P.543

The Platen suction is too strong. In the Control Panel menu, reduce the level of VacuumStrngth.
 (See "Adjusting the Vacuum Strength.") →P.811

"BordlessOversize" is set to Standard in the Control
Panel menu.

Set "BordlessOversize" to "Little" in the Control Panel menu.
 (See "Menu Settings.") →P.667
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Immediately after borderless printing, the trailing edge margin is soiled during regular printingImmediately after borderless printing, the trailing edge margin is soiled during regular printing
Cause Corrective Action

Depending on your printing environment, after border-
less printing in which the leading and trailing edge of
the roll is cut automatically, any ink adhering to the cut-
ter unit may rub off on the next printed document.

Follow these steps to change the Between Pages setting of Drying Time to a value
between about 30 seconds and 3 minutes before trying borderless printing again.

1. On the Main sheet of the printer driver, click Advanced Settings by Media Type.
2. Select an ink drying time in the list for the Between Pages setting of Drying Time.

Printed colors are inaccuratePrinted colors are inaccurate
Cause Corrective Action

Color adjustment has not been activated in the Advanced Settings
of the printer driver.

In the Advanced Settings of the printer driver, access Color Settings
in Color Mode to adjust colors.
 (See "Main Sheet (Windows).") →P.182
 (See "Main Pane (Mac OS X).") →P.364

Colors have not been adjusted on the computer or monitor. Refer to the computer and monitor documentation to adjust the colors.

Adjust the settings of the color management software, referring to the
software documentation as needed.

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if they are clogged.
 (See "Checking for Nozzle Clogging.") →P.838

In the Windows printer driver, Application Color Matching Priority
is not selected.

Click Special Settings on the Layout sheet of the printer driver and se-
lect Application Color Matching Priority in the dialog box.
 (See "Layout Sheet (Windows).") →P.200

There may be a slight difference in how colors are printed after
Printhead replacement because of individual variation among print-
heads.

Execute color calibration.
 (See "Corrects slight differences in how colors appear (color calibration).")
→P.820

Printhead characteristics gradually change through repeated use,
and colors may change.

Execute color calibration.
 (See "Corrects slight differences in how colors appear (color calibration).")
→P.820

Color may change slightly even on the same model of printer if you
use a different version of the firmware or printer driver, or when you
print under different settings or in a different printing environment.

Follow these steps to prepare the printing environment.

1. Use the same version of firmware or printer driver.
 (See "Updating the Firmware.") →P.871

2. Specify the same value for all settings items.

3. Execute color calibration.
 (See "Corrects slight differences in how colors appear (color calibra-
tion).") →P.820

When reinstalling the printer driver, you changed the region selec-
tion of the Media Configuration Tool.
Changing the region selection of the Media Configuration Tool dele-
tes the region-specific paper information originally registered on the
printer before installation. Using paper with deleted information
when executing color calibration will prevent the resulting calibration
adjustment value from being applied to all other types of the paper.

Prepare paper compatible with calibration in the newly selected region
and perform calibration again.
 (See "Corrects slight differences in how colors appear (color calibration).")
→P.820

Banding in different colors occursBanding in different colors occurs
Cause Corrective Action

The paper feed amount is out of adjustment. Adjust the feed amount.
 (See "Adjusting the Feed Amount.") →P.805

Printing does not proceed smoothly because
print jobs are interrupted during transmission.

Exit other applications and cancel other print jobs.
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Cause Corrective Action
In the Control Panel menu, Adj. Priority is
set to Print Length.

Setting Adj. Priority to Print Quality in the Control Panel menu and adjusting the feed amount
may improve results.
 (See "Adjusting the Feed Amount.") →P.805

The Printhead is out of alignment. Adjust the Printhead alignment.
 (See "Automatic Adjustment to Straighten Lines and Colors.") →P.798

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if they are clogged.
 (See "Checking for Nozzle Clogging.") →P.838

Streaks may occur if you set the Print Quali-
ty too low.

Choose a higher level of Print Quality in the Advanced Settings of the printer driver and try
printing again.
Printing in Fast or Standard mode is faster and consumes less ink than in Highest quality or
High modes, but the printing quality is lower.
 (See "Giving Priority to Particular Graphic Elements and Colors for Printing.") →P.61

The type of paper specified in the printer driv-
er does not match the type loaded in the
printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

Make sure the same type of paper is specified in the printer driver as you have loaded in the
printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

Colors in printed images are unevenColors in printed images are uneven
Cause Corrective Action

Line Drawing/Text is selected when printing
images in many solid colors.

In Print Priority in the Advanced Settings of the printer driver, choose Image.

You are printing on paper that curls easily. Printed colors may appear uneven on the leading edge of paper that is susceptible to curling.
Select a stronger level in VacuumStrngth in the Control Panel menu to increase suction
against the paper, or specify a leading margin of 20 mm (0.79 in) or more.
 (See "Adjusting the Vacuum Strength.") →P.811

Printed colors may be uneven if you set the
Print Quality too low.

Choose a higher level of Print Quality in the Advanced Settings of the printer driver.
Printing in Fast or Standard mode is faster and consumes less ink than in Highest quality or
High modes, but the printing quality is lower.
 (See "Giving Priority to Particular Graphic Elements and Colors for Printing.") →P.61

Color may be uneven between dark and light
image areas.

Select Unidirectional Printing in the Advanced Settings of the printer driver.

When borderless printing is used, the edge of
the paper is cut during printing. Thus, ink
density may be slightly uneven at the leading
edges.

Specify No in Auto Cut in the printer driver before printing. In this case, the paper can be prin-
ted without borders on the left and right sides only. Cut the printed document ejected from the
printer, and then use scissors or a cutting tool to cut away the edges on the top and bottom.

Choose a higher level of Print Quality in the Advanced Settings of the printer driver.
 (See "Giving Priority to Particular Graphic Elements and Colors for Printing.") →P.61

The Printhead is out of alignment. Adjust the Printhead alignment.
 (See "Automatic Adjustment to Straighten Lines and Colors.") →P.798

Allowing printed documents to dry on top of
each other may cause uneven colors.

To avoid uneven colors, we recommend drying each sheet separately.

Density may be uneven if you use Glossy
Paper or Canon Coated Paper.

In Advanced Settings of the printer driver, choose Highest quality or High in Print Quality.

The type of paper specified in the printer driv-
er does not match the type loaded in the
printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

Make sure the same type of paper is specified in the printer driver as you have loaded in the
printer.
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Cause Corrective Action
The type of paper specified in the printer driv-
er does not match the type loaded in the
printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

Scan Wait Time > Area in the Control Panel
menu is set to Leading edge.

When Scan Wait Time > Area is set to Leading edge, colors may be uneven 110–160 mm
from the leading edge. (The position varies depending on the Print Quality setting.)
In this case, select Scan Wait Time > Area > Entire area.
However, note that printing will now take longer.
 (See "Menu Settings.") →P.667

Image edges are blurred or white banding occursImage edges are blurred or white banding occurs
Cause Corrective Action

The Platen suction is too strong. In the Control Panel menu, reduce the level of VacuumStrngth.
 (See "Adjusting the Vacuum Strength.") →P.811

Close the blue Switch on the platen so that it matches the paper size.
 (See "Setting the Blue Switch on the Platen.") →P.893

Incorrect Printhead alignment value. When printing fine lines or text at high precision on glossy or semi-glossy photo or proofing paper, set
the optimal Printhead height before aligning the printhead.
 (See "Enhancing Printing Quality.") →P.796

In the Control Panel menu, set Head Height to a lower height.
 (See "Troubleshooting Paper Abrasion and Blurry Images.") →P.803

The type of paper specified in the print-
er driver does not match the type loa-
ded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

Make sure the same type of paper is specified in the printer driver as you have loaded in the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

Setting the Blue Switch on the PlatenSetting the Blue Switch on the Platen
If printed documents exhibit the following symptoms, adjust the setting of the blue Switch on the Platen.

• Image edges are blurred
• Image edges are affected by white banding

Important

• Always set the blue Switch on the Platen to the ● side for borderless printing. Printing quality may be affected if the Switch is
incorrectly set.

1 Remove any loaded paper that will not be used.

• Rolls  (See "Removing the Roll from the Printer.") →P.539
• Sheet  (See "Removing Sheets.") →P.560

2
 

Open the Top Cover.

 

iPF9400                                                                                                                                                             Image edges are blurred or white banding occurs

User's Guide                                                                                                                                                                                                                                       

  

Troubleshooting
Problem

s w
ith the printing quality

893  



3
 

Remove the Cleaning Brush (a).

4
 

Using the back of the Cleaning Brush, move the first
Switch to the side opposite ●.
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5
 

Refer to the following table to confirm the number on the
Platen (a) that corresponds to the size of paper for printing.

Number Dimensions
2 254.0 mm (10.00 in)

3 355.6 mm (14.00 in)

4 431.8 mm (17.00 in)

5 515.0 mm (JIS B2 or B3)

6 594.0 mm (ISO A1 or A2) or 609.6 mm (24.00 in)

7 841.0 mm (ISO A0 or A1)

8 914.4 mm (36.00 in)

9 1030.0 mm (JIS B0 or B1)

10 1066.8 mm (42.00 in)

11 1117.6 mm (44.00 in)

12 1270.0 mm (50.00 in)

13 1524.0 mm (60.00 in)
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6 Using the back of the Cleaning Brush, move the Switch to the side opposite ●, corresponding to the size of the
paper for printing.
In this case, note that you will move the switch in the opposite direction from the direction in step 4.

Note

• The Switch only moves number 1 and the number that
matches the paper size. Set all of the switches where the
number does not match the paper size in switches number
2 and higher to the ● side.

 

7
 

Close the Top Cover.

The contrast becomes uneven during printingThe contrast becomes uneven during printing
Cause Corrective Action

The paper feed amount is out of adjustment. Adjust the feed amount.
 (See "Adjusting the Feed Amount.") →P.805

The type of paper specified in the printer driver
does not match the type loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

Make sure the same type of paper is specified in the printer driver as you have loaded in
the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

The length of printed images is inaccurate in the feeding directionThe length of printed images is inaccurate in the feeding direction
Cause Corrective Action

In the Control Panel menu, Adj. Priority is set to
Print Quality.

Set Adj. Priority to Print Length in the Control Panel menu, and then execute Adjust
Length.
 (See "Adjusting the Feed Amount.") →P.805

The type of paper specified in the printer driver
does not match the type loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

Make sure the same type of paper is specified in the printer driver as you have loaded in
the printer.
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Cause Corrective Action
The type of paper specified in the printer driver
does not match the type loaded in the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

Images are printed crookedImages are printed crooked
Cause Corrective Action

In the Control Panel menu, Skew Check Lv. is set to Loose or Off. In the Control Panel menu, set Skew Check Lv. to Standard.
 (See "Menu Settings.") →P.667

In the Control Panel menu, Width Detection is set to Off. Set Width Detection to On in the Control Panel menu.
 (See "Menu Settings.") →P.667

Roll paper is loaded askew. If there is a gap between the roll paper and roll holder, reload the roll.
 (See "Attaching the Roll Holder to Rolls.") →P.530
 (See "Loading Rolls in the Printer.") →P.533

Documents are printed in monochromeDocuments are printed in monochrome
Cause Corrective Action

In the Advanced Settings of the printer driver, Mono-
chrome or Monochrome (Photo), is specified in Col-
or Mode.

In the Advanced Settings of the printer driver, specify Color in Color Mode and try
printing again.

The Printhead nozzles are clogged. Print a test pattern to check the color ink nozzles and see if they are clogged.
Checking for Nozzle Clogging →P.838

Line thickness is not uniformLine thickness is not uniform
Cause Corrective Action

In the Special Settings dialog box of the
Windows printer driver, Fast Graphic
Process is selected.

Access the printer driver Properties dialog box from Print in the File menu of the source applica-
tion, and follow these steps to print.

1. Clear the option Open Preview When Print Job Starts on the Main sheet.
2. Clear the option Page Layout on the Layout sheet.

3. Click the Special Settings button on the Layout sheet to display the Special Settings dialog
box, and then clear the option Fast Graphic Process.

The blue Switch on the platen is set in-
correctly.

Move the Switch numbered corresponding to the size of paper for printing opposite to the ● posi-
tion.
 (See "Setting the Blue Switch on the Platen.") →P.893

The type of paper specified in the printer
driver does not match the type loaded in
the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

Make sure the same type of paper is specified in the printer driver as you have loaded in the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

Incorrect Printhead alignment value. When printing fine lines or text at high precision on glossy or semi-glossy photo or proofing paper,
set the optimal Printhead height before aligning the printhead.
 (See "Enhancing Printing Quality.") →P.796

In the Control Panel menu, use a lower Head Height setting.
 (See "Troubleshooting Paper Abrasion and Blurry Images.") →P.803

Depending on the type of paper, the
thickness of printed lines may be noticea-
bly inconsistent.

Specify Proof in Print Priority in the printer driver.
 (See "Giving Priority to Particular Graphic Elements and Colors for Printing.") →P.61
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Lines or colors are misalignedLines or colors are misaligned
Cause Corrective Action

The Printhead is not being aligned correct-
ly.

Adjust the Printhead alignment.
 (See "Automatic Adjustment to Straighten Lines and Colors.") →P.798
 (See "Manual Adjustment to Straighten Lines and Colors.") →P.800

When printing fine lines or text at high precision on glossy or semi-glossy photo or proofing pa-
per, set the optimal Printhead height before aligning the printhead.
 (See "Enhancing Printing Quality.") →P.796

In the Control Panel menu, use a lower Head Height setting.
 (See "Troubleshooting Paper Abrasion and Blurry Images.") →P.803

The type of paper specified in the printer
driver does not match the type loaded in
the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

Make sure the same type of paper is specified in the printer driver as you have loaded in the
printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

Depending on the type of paper, printed
lines may be noticeably misaligned.

Specify Proof in Print Priority in the printer driver.
 (See "Giving Priority to Particular Graphic Elements and Colors for Printing.") →P.61

Borders appear in borderless printingBorders appear in borderless printing
Cause Corrective Action

If borderless printing was performed at the actual size,
paper wider than the page size was selected.

When performing borderless printing at the actual size, use roll paper with the same
width as the width of the page size.
 (See "Borderless Printing at Actual Size.") →P.89

The printing image data has margins. Check that the printing image data does not have any objects like crop marks and
transparent objects.

Margins are configured in the application software you
are using.

Check that no margins are configured in the application software you are using.

"BordlessOversize" is set to "Little" in the Control Pan-
el menu.

Set "BordlessOversize" to Standard in the Control Panel menu.
 (See "Menu Settings.") →P.667
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Cannot print over a networkCannot print over a network
Cannot connect the printer to the network ......................................................................................................... 899
Cannot print over a TCP/IP network ................................................................................................................... 899
Cannot print over a NetWare network ................................................................................................................ 899
Cannot print over AppleTalk or Bonjour networks ............................................................................................. 900

Cannot connect the printer to the networkCannot connect the printer to the network
Cause Corrective Action

The Ethernet cable is
not connected cor-
rectly to the printer's
Ethernet port.

1. Make sure the printer is connected to the network with the correct Ethernet cable, and then turn the printer on. For
instructions on connecting the cable, refer to the Setup Guide.

2. Make sure the Link indicator is lit.
The top and bottom indicators are lit if the printer is connected via 1000Base-T. The bottom indicator is green if the
printer is connected via 100BASE-TX, and the top indicator is orange if connected via 10BASE-T.
If the Link indicator is not lit, check the following points.

• Make sure the hub is on.

• Make sure the end of the Ethernet cable is connected correctly.
Insert the Ethernet cable until it clicks and locks in place.

• Make sure there is no problem with the Ethernet cable.
If there is any problem, replace the Ethernet cable.

• Check the communication mode with the hub.
Although the printer normally detects the hub communication mode and transmission rate automatically (in auto
negotiation mode), sometimes the hub settings cannot be detected. In this case, configure the connection meth-
od manually, specifying the communication mode in use.
 (See "Configuring the Communication Mode Manually.") →P.727

Cannot print over a TCP/IP networkCannot print over a TCP/IP network
Cause Corrective Action

The printer's IP address is not configured correctly. Make sure the printer's IP address is configured correctly.
 (See "Configuring the IP Address Using imagePROGRAF Device Setup Utility.") →P.730
 (See "Configuring the IP Address Using the Printer Control Panel.") →P.705

The printer's TCP/IP network settings are not config-
ured correctly.

Make sure the printer's TCP/IP network settings are configured correctly.
 (See "Configuring the Printer's TCP/IP Network Settings With RemoteUI.") →P.709

The computer you are trying to print from is not con-
figured correctly.

Make sure the computer's TCP/IP network settings are configured correctly.
 (See "Configuring the Printer Driver Destination (Windows).") →P.708
 (See "Configuring the Destination in TCP/IP Networks (Mac OS X).") →P.720

Cannot print over a NetWare networkCannot print over a NetWare network
Cause Corrective Action

The printer's NetWare settings are
not configured correctly.

Make sure the printer's NetWare settings are configured correctly. In particular, make sure a valid frame
type is selected.
For details, see "Configuring the Printer's NetWare Network Settings With RemoteUI." →P.717

The computer you are trying to
print from is not configured correct-
ly.

Make sure the computer's NetWare settings are configured correctly.
For details, see "Configuring NetWare Network Settings." →P.712

The NetWare server and services
are not configured correctly.

Check the following points.

1. Make sure the NetWare file server is running.
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Cause Corrective Action
The NetWare server and services
are not configured correctly.

2. Make sure there is enough free disk space on the NetWare file server. Insufficient disk space may
prevent you from processing large print jobs.

3. Start NWADMIN or PCONSOLE and confirm that the print service is configured correctly and the print
queue is available.

4. If data transmission to a printer on another subnet fails, deactivate NCP burst mode in that printer's
network protocol settings.

5. If the printer is used in queue server mode, specify Other/Unknown as the printer type.

The printer was turned off and on
when not disconnected from the
server.

Leave the printer off for at least 30 seconds, and then restore power.

Cannot print over AppleTalk or Bonjour networksCannot print over AppleTalk or Bonjour networks
Cause Corrective Action

The AppleTalk protocol is not ena-
bled on the printer.

Activate AppleTalk on the printer.
 (See "Configuring the Printer's AppleTalk Network Settings.") →P.724

The computer you are trying to print
from is not configured correctly.

Make sure the computer's AppleTalk settings are configured correctly.
 (See "Configuring the Destination for AppleTalk Networks (Mac OS X).") →P.723
 (See "Configuring the Destination for Bonjour Network (Mac OS X).") →P.721

The computer and printer are not on
the same network.

Due to the nature of Bonjour, you cannot print if the printer is on another network behind a router. Make
sure the computer and printer are on the same network. For information about network settings, ask
your network administrator.
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Installation problemsInstallation problems
Removing Installed Printer DriversRemoving Installed Printer Drivers

Follow these steps to remove installed printer drivers and utilities.

Removing printer drivers (Windows)
Remove the printer driver as follows.

Note

• The following instructions are for Windows XP. The method of removing printer drivers varies depending on the version of
Windows.

1 From the Windows start menu, select Programs > Canon Printer Uninstaller > imagePROGRAF Printer
Driver Uninstaller to display the Delete Printer window.

2 Select the printer in the list and click Delete.

3 Click Yes after the Warning message is displayed.

4 Make sure that the printer has been removed from the list, and then click Exit.

Removing printer drivers and imagePROGRAF Printmonitor (Macintosh)
Remove the printer driver or imagePROGRAF Printmonitor as follows.

1 Insert the User Software CD-ROM provided with the printer in the CD-ROM drive.

2 Start the printer driver installer included in the User Software CD-ROM.
Open the OS X folder and double-click iPF Driver Installer X.

3 In the upper left menu, choose Uninstall, and then click Uninstall.

4 Follow the instructions on the screen to remove the printer driver or imagePROGRAF Printmonitor.

Removing imagePROGRAF Status Monitor (Windows)
Remove imagePROGRAF Status Monitor as follows.

Note

• The following instructions are for Windows XP. The method of removing printer drivers varies depending on the version of
Windows.

1 Select Control Panel from the start menu.

2 Select Add or Remove Programs.

3 Select imagePROGRAF Status Monitor, and then click the Change/Remove button.

Removing imagePROGRAF Device Setup Utility (Windows)
Remove imagePROGRAF Device Setup Utility as follows.

Note

• The following instructions are for Windows XP. The method of removing printer drivers varies depending on the version of
Windows.
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1 From the Windows start menu, select Programs > imagePROGRAF Device Setup Utility > Uninstaller (im-
agePROGRAF Device Setup Utility) to start the wizard.

2 In the wizard window, click Delete, and then click Next.

3 Follow the instructions on the screen to remove imagePROGRAF Device Setup Utility.
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Other problemsOther problems
The printer does not go on ................................................................................................................................. 903
The printer takes time to start up ....................................................................................................................... 903
If the Printer Makes a Strange Sound ................................................................................................................ 903
Messages advising to check the maintenance cartridge are not cleared ......................................................... 903
The printer consumes a lot of ink ....................................................................................................................... 904
Ink Level Detection ............................................................................................................................................. 904

The printer does not go onThe printer does not go on
Cause Corrective Action

The printer is unplugged. Plug the power cord into the outlet, and then turn on the printer.

The specified voltage is not supplied. Check the voltage of the outlet and breaker.
 (See "Specifications.") →P.934

The printer takes time to start upThe printer takes time to start up
Cause Corrective Action

The printer may have shut down incorrectly last time. This may happen af-
ter power outages or if the printer is unplugged before it is turned off.
In this case, the next time power is restored, the printer's hard disk is
checked, and startup may take some time.

Please wait a while, because it may take several minutes to fin-
ish checking the hard disk.
If an error message is displayed after the hard disk check, follow
the instructions indicated to resolve the problem.

If the Printer Makes a Strange SoundIf the Printer Makes a Strange Sound
Cause Corrective Action

The printer
makes a sound
during opera-
tion.

The following sounds do not indicate a problem with the printer.

• There is a sound of suction from the Platen.
To prevent paper from rising, paper is held against the Platen by suction from Vacuum holes under it.

• Roll paper makes a fluttering sound during printing.
There may be a fluttering sound when large paper is advanced.

• You suddenly hear the sound of cleaning operations.
At regular intervals, for printer maintenance, cleaning operations will begin automatically, even if the printer is in Sleep
mode.

• You suddenly hear the sound of ink agitation.
At regular intervals, to ensure optimal printing quality, the ink is agitated automatically, even if the printer is in Sleep
mode. Ink agitation takes about a minute and a half.
The ink is also agitated automatically under the following conditions. Note that other operations are not possible while
Agitating... is displayed on the control panel.

• After the printer is turned on
• After data transmission
• After ink tank replacement

In other cases, contact your Canon dealer.

Messages advising to check the maintenance cartridge are not clearedMessages advising to check the maintenance cartridge are not cleared
Cause Corrective Action

The printer has not detected the new Maintenance Car-
tridge that was used to replace the old one.

Remove the new Maintenance Cartridge you have just installed and insert it again
firmly.
 (See "Replacing the Maintenance Cartridge.") →P.852
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The printer consumes a lot of inkThe printer consumes a lot of ink
Cause Corrective Action

Many full-page color images are
printed.

In print jobs such as photos, images are filled with color. This consumes a lot of ink. This does not indi-
cate a problem with the printer.

Head Cleaning B in the Control
Panel menu is executed frequently.

Head Cleaning B in the Control Panel menu consumes a lot of ink. This does not indicate a problem
with the printer. Unless the printer has been moved or stored for a long period or you are troubleshoot-
ing Printhead problems, we recommend not performing Head Cleaning B, to the extent possible.

You have just finished initial installa-
tion, when more ink is consumed to
fill the system.

After initial installation or at the first-time use after transfer, ink flows into the system between the Ink
Tank and Printhead, which may cause the ink level indicators to drop to 80%. This does not indicate a
problem with the printer.

The Printhead nozzles are clogged. Check for nozzle clogging.
 (See "Checking for Nozzle Clogging.") →P.838

Ink Level DetectionInk Level Detection
Ink level detection will be deactivated if you load ink tanks once emptied.

Ink level detection
Ink tanks specified for this printer feature an ink level detection function to prevent the ink from running out during print-
ing, which prevents printer damage.  (See "Ink Tanks.") →P.826
This function will not work correctly if you use refill ink tanks. As a result, printing stops. Thus, before using refill ink
tanks, you must cancel the ink level detection.
Printing with the ink level detection canceled may lead to printer damage and printing problems. Canon Inc. is not liable
for any damage that may occur as a result of refilling ink.

Important

• After ink level detection has been released, this function cannot be reactivated for currently loaded Ink Tank. To use ink level
detection again, replace the Ink Tank with new ones specified for use with the printer.

• Repeatedly removing and inserting an Ink Tank may damage the connection between the Ink Tank and the printer, which
may cause ink leakage from the Ink Tank and damage the printer.

Releasing ink level detection

1
 

On the Display Screen, a message indicates that the ink level cannot be
detected. After checking the message, press the ▶ button.

2
 

Press ▲ or ▼ to select Information, and then press the OK button.
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3
 

A confirmation message is shown on the Display Screen about releasing
ink level detection. After checking the message, press the ▶ button.

4
 

After checking the message, press the ▶ button.

5
 

Press ▲ or ▼ to select Yes, and then press the OK button.

6
 

Check the message and press the ▶ button.

7
 

Check the message and press the ▶ button.
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8
 

Press ▲ or ▼ to select Yes, and then press the OK button.

9
 

A confirmation message about updating ink information is shown on the
Display Screen. After checking the message, press the ▶ button.

10
 

Press ▲ or ▼ to select Yes, and then press the OK button.

Ink level detection is now released.
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Error MessagesError Messages
Before borderless printing, move the blue platen switch. ................................................................................. 923
Blue platen switch is dirty. ................................................................................................................................. 924
Borderless printng not possible. ........................................................................................................................ 918
Borderless printng not possible. Paper stretched or shrank. ............................................................................ 923
Calibration There is a problem with the multi-sensor. ........................................................................................ 931
Cannot adjust paper feed. ................................................................................................................................. 924
Cannot adjust printhead. .................................................................................................................................... 925
Cannot calibrate. ................................................................................................................................................ 922
Cannot cut this paper. ........................................................................................................................................ 916
Cannot detect papr ............................................................................................................................................ 916
Cannot execute this command. Use other paper. ............................................................................................. 922
Cannot feed paper. ............................................................................................................................................ 916
Cannot recognize print head x. (x is L, R, or not displayed) ............................................................................. 926
Check printed document. .................................................................................................................................. 924
Close Ink Tank Cover ......................................................................................................................................... 920
End of paper feed. ............................................................................................................................................. 917
ERROR Exxx-xxxx (x represents a letter or number) ......................................................................................... 930
Excessive temperature or humidity. ................................................................................................................... 922
Execute printhead cleaning. .............................................................................................................................. 926
File read error. .................................................................................................................................................... 928
GARO Wxxxx (x represents a number) .............................................................................................................. 930
Hard disk error. .................................................................................................................................................. 928
Hardware error. xxxxxxxx-xxxx (x represents a letter or number) ..................................................................... 930
Ink insufficient. ................................................................................................................................................... 920
Ink tank is empty. ............................................................................................................................................... 921
Insufficient paper for job .................................................................................................................................... 913
Mail box full. Delete unwanted data ................................................................................................................... 928
Mail box full. Now printing without saving data. ................................................................................................. 928
Mail box nearly full. ............................................................................................................................................ 928
Maint. cart. The level is low ................................................................................................................................ 927
Maintenance cartridge full. ................................................................................................................................ 927
Maintenance cartridge problem. ........................................................................................................................ 927
Maximum jobs stored. ........................................................................................................................................ 928
Media take-up unit ready. .................................................................................................................................. 918
MediaType Mismatch ......................................................................................................................................... 910
Move the blue platen switch No.xx to the right. (xx represents a number) ....................................................... 924
Multi-sensor error ............................................................................................................................................... 931
No ink left. .......................................................................................................................................................... 920
No ink tank loaded. ............................................................................................................................................ 921
No Maintenance Cartridge capacity. ................................................................................................................. 927
No maintenance cartridge. ................................................................................................................................ 927
No sheets. .......................................................................................................................................................... 915
Not much ink is left. ............................................................................................................................................ 921
Paper jam. .......................................................................................................................................................... 915
Paper loaded askew. ......................................................................................................................................... 916
Paper mismatch ................................................................................................................................................. 910
Paper position not suitable for borderless printing. ........................................................................................... 918
Paper size not detected. .................................................................................................................................... 912
PaprWidth Mismatch .......................................................................................................................................... 912
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Parts replacement time has passed. ................................................................................................................. 931
PHeads: wrong pos. ........................................................................................................................................... 925
Please calibrate using above paper. ................................................................................................................. 923
Please commn calibrt using above paper. ........................................................................................................ 923
Please execute common calibration. ................................................................................................................. 923
Prepare for parts replacement. .......................................................................................................................... 931
Regular printing is selected, but a roll is loaded. .............................................................................................. 915
Rel lever is in wrong position. ............................................................................................................................ 917
Remaining level of the ink cannot be correctly detected. .................................................................................. 920
Rewinding error. ................................................................................................................................................. 917
Roll printing is selected, but sheets are loaded. ................................................................................................ 914
Roll printing is selected. ..................................................................................................................................... 914
Sheet printing is selected. .................................................................................................................................. 915
The following ink tanks cannot be recognized. .................................................................................................. 921
The mail box is full. ............................................................................................................................................. 928
The paper is too small. ....................................................................................................................................... 911
The paper is too small. ....................................................................................................................................... 911
The roll is empty. ................................................................................................................................................ 914
This paper cannot be used as size is not supported. ........................................................................................ 913
Top cover is open. ............................................................................................................................................. 930
Turn on the media take-up unit. ......................................................................................................................... 918
Unknown file. ...................................................................................................................................................... 931
Wrong maintenance cartridge. .......................................................................................................................... 927
Wrong x printhead. (x is L, R, or not displayed) ................................................................................................ 925
x printhead error (x is L, R, or not displayed) .................................................................................................... 925
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Messages regarding paperMessages regarding paper
Paper mismatch ................................................................................................................................................. 910
MediaType Mismatch ......................................................................................................................................... 910
The paper is too small. ....................................................................................................................................... 911
The paper is too small. ....................................................................................................................................... 911
PaprWidth Mismatch .......................................................................................................................................... 912
Paper size not detected. .................................................................................................................................... 912
Insufficient paper for job .................................................................................................................................... 913
This paper cannot be used as size is not supported. ........................................................................................ 913
Cannot execute this command. Use other paper. ............................................................................................. 922
Roll printing is selected. ..................................................................................................................................... 914
Roll printing is selected, but sheets are loaded. ................................................................................................ 914
The roll is empty. ................................................................................................................................................ 914
No sheets. .......................................................................................................................................................... 915
Sheet printing is selected. .................................................................................................................................. 915
Regular printing is selected, but a roll is loaded. .............................................................................................. 915
Paper jam. .......................................................................................................................................................... 915
Paper loaded askew. ......................................................................................................................................... 916
Cannot detect papr ............................................................................................................................................ 916
Cannot feed paper. ............................................................................................................................................ 916
Cannot cut this paper. ........................................................................................................................................ 916
End of paper feed. ............................................................................................................................................. 917
Rel lever is in wrong position. ............................................................................................................................ 917
Rewinding error. ................................................................................................................................................. 917
Media take-up unit ready. .................................................................................................................................. 918
Turn on the media take-up unit. ......................................................................................................................... 918
Borderless printng not possible. ........................................................................................................................ 918
Paper position not suitable for borderless printing. ........................................................................................... 918

Paper mismatchPaper mismatch
Cause Corrective Action

You tried to print a test pattern for printer adjustment on
several sheets, but sheets of different types or sizes of pa-
per were used.

When printing a test pattern for adjustment, use sheets of the same size and type
of paper, in the required quantity.
Press ▲ or ▼ to select Change Paper, press the OK button, and replace the pa-
per.
 (See "Loading and Printing on Sheets.") →P.25
The printer now starts printing the test pattern.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

MediaType MismatchMediaType Mismatch
Cause Corrective Action

When Detect Mismatch in the Control Panel menu
is set to Pause, the type of paper loaded does not
match the type specified in the printer driver.

Follow these steps to ensure the paper type matches on the printer and in the printer
driver.

1. Press ▲ or ▼ to select Stop Printing, and then press the OK button.

2. Change the paper type setting in the printer driver to the type loaded in the printer
and try printing again.

Follow these steps to ensure the paper type matches on the printer and in the printer
driver.
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Cause Corrective Action
When Detect Mismatch in the Control Panel menu
is set to Pause, the type of paper loaded does not
match the type specified in the printer driver.

1. Press ▲ or ▼ to select Change Paper, and then press the OK button.

2. Replace the loaded paper with paper of the type and size you have specified in the
printer driver.
 (See "Loading and Printing on Rolls.") →P.22
 (See "Loading and Printing on Sheets.") →P.25

Press ▲ or ▼ to select Print, and then press the OK button to resume printing.
However, note that this error may cause paper jams and affect the printing quality.

You tried to print a test pattern for printer adjustment
on several sheets, but sheets of different types of
paper were used.

When printing a test pattern for adjustment, use sheets of the same type of paper, in the
required quantity. Replace the paper as follows and perform adjustment again.

1. Lift the Release Lever and stop printing.

2. Replace the paper.
 (See "Loading and Printing on Sheets.") →P.25

3. Execute adjustment again from the control panel menu.

When Detect Mismatch in the Control Panel menu
is set to Warning, the type of paper loaded does not
match the type specified in the printer driver.

You can continue to print, but note that this error may cause problems in the printing
results.

The paper is too small.The paper is too small.
Cause Corrective Action

When Detect Mismatch in the Control Panel menu is
set to Pause or Hold Job, paper smaller than the size
specified in the printer driver is loaded.

Press ▲ or ▼ to select Print, and then press the OK button to resume printing.
However, note that this error may cause paper jams and affect the printing quality.

Adjust the paper size setting in the printer driver to match the size loaded in the printer
as follows.

1. Press ▲ or ▼ to select Stop Printing, and then press the OK button.

2. Change the paper size setting in the printer driver to the size loaded in the printer
and try printing again.

Replace the loaded paper with paper of a size that matches the size setting in the
printer driver as follows.

1. Press ▲ or ▼ to select Change Paper, and then press the OK button to stop print-
ing.

2. Replace the loaded paper to match the settings in the printer driver and try printing
again.
 (See "Loading and Printing on Rolls.") →P.22
 (See "Loading and Printing on Sheets.") →P.25

When Detect Mismatch in the Control Panel menu is
set to Warning, paper smaller than the size specified
in the printer driver is loaded.

You can continue to print, but note that this error may cause problems in the printing
results.

The paper is too small.The paper is too small.

"Replace paper with A4/LTR (vertical) or larger"
Cause Corrective Action

The loaded paper is too small.
(When you have attempted to print a test print sheet
or other printer status information.)

Replace the paper with paper of A4/Letter (vertical) size or larger as follows.

1. Press ▲ or ▼ to select Change Paper, press the OK button, and remove the paper.
 (See "Removing Sheets.") →P.560

2. Switch to paper A4/Letter (vertical) or larger.
 (See "Loading and Printing on Sheets.") →P.25
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Cause Corrective Action
The loaded paper is too small.
(When you have attempted to print a test print sheet
or other printer status information.)

The printer will resume printing.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

"Replace roll with 10 in. wide or larger roll."
Cause Corrective Action

The loaded paper is too small.
(When you have attempted to print a test print sheet or other print-
er status information.)

Replace the roll with a roll 10 inches in width or larger as follows.

1. Press ▲ or ▼ to select Change Paper, and then press the OK button.
 (See "Removing the Roll from the Printer.") →P.539
 (See "Removing the Roll Holder from Rolls.") →P.542

2. Replace the roll with a roll 10 inches wide or larger.
 (See "Attaching the Roll Holder to Rolls.") →P.530
 (See "Loading Rolls in the Printer.") →P.533
The printer will resume printing.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

PaprWidth MismatchPaprWidth Mismatch
Cause Corrective Action

When Detect Mismatch in the Control Panel menu is set to
Pause or Hold Job, the width of the loaded roll does not
match the width specified in Fit Roll Paper Width in the print-
er driver.

Press ▲ or ▼ to select Print, and then press the OK button to resume print-
ing.
However, note that this error may cause paper jams and affect the printing
quality.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

Follow these steps to replace the roll to match the width specified in the printer
driver.

1. Press ▲ or ▼ to select Change Paper, and then press the OK button.
 (See "Removing the Roll from the Printer.") →P.539
 (See "Removing the Roll Holder from Rolls.") →P.542

2. Replace with paper of the width configured in the printer driver.
 (See "Attaching the Roll Holder to Rolls.") →P.530
 (See "Loading Rolls in the Printer.") →P.533
The printer now starts printing the print job.

Make sure the roll width selected in the dialog box displayed when you select
Fit Roll Paper Width in the printer driver matches the width of the roll loaded
in the printer, and then try printing again.

Paper size not detected.Paper size not detected.
Cause Corrective Action

Paper has been loaded askew, or warped paper has been loaded. Lift up the Release Lever and reload the paper.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555
 

If "Not finished printing. Finish printing re-
maining jobs?" is displayed on the Display
Screen, press the OK button.
Printing will resume, starting from the page on
which the error occurred.
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Cause Corrective Action
If this error recurs after you reload the roll, re-
move the Roll Holder from the printer, push the
roll firmly in until it touches the Roll Holder
flange, and reload the Roll Holder in the print-
er.
 (See "Attaching the Roll Holder to Rolls.")
→P.530

Because the Platen is soiled with ink or other substances, the size of the clear film cannot
be detected.

Open the Top Cover and clean the entire Plat-
en.
 (See "Cleaning Inside the Top Cover.")
→P.861

Insufficient paper for jobInsufficient paper for job
Cause Corrective Action

The printer has received a print job longer than the amount of roll paper left when ManageR-
emainRoll in the Control Panel menu is On.

Press ▲ or ▼ to select Print, and then press
the OK button to resume printing.
When using the Media Take-up Unit, press ▲
or ▼ to select Print, and then press the OK
button to resume printing.
However, the roll paper may run out during the
print job and you may not be able to print all of
the document.

Press ▲ or ▼ to select Change Paper, and
then press the OK button.
Change the Paper Source of the printer driver,
or replace the roll with a roll that has enough
paper for the print job, and then printt.
When using the Media Take-up Unit, press ▲
or ▼ to select Stop Printing, and then press
the OK button to stop printing.
Remove the printed document from the Media
Take-up Unit, replace the roll with a roll that
has enough paper for the print job, and then try
printing again.
 (See "Removing the Roll from the Printer.")
→P.539

 (See "Loading Rolls in the Printer.") →P.533
 (See "Removing Printed Documents from the
Media Take-up Unit.") →P.579

Press ▲ or ▼ to select Stop Printing or press
the Stop button to stop printing.

This paper cannot be used as size is not supported.This paper cannot be used as size is not supported.
Cause Corrective Action

Paper that is too large for the printer has been loaded. Lift the Release Lever and load paper of the correct size.
 (See "Paper Sizes.") →P.522
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Cause Corrective Action
Paper that is too small for the printer has been loaded. Lift the Release Lever and load paper of the correct size.

 (See "Paper Sizes.") →P.522

Paper has been loaded that is too small to print the test
pattern for printhead adjustment or nozzle checking.

Lift the Release Lever and load unused paper A4/Letter (vertical) or larger. More
than one sheet may be required depending on the adjustment.

Roll printing is selected.Roll printing is selected.
Cause Corrective Action

You have attempted to print on a roll, but no
roll is loaded.

Press ▲ or ▼ to select Load Roll Paper, and then press the OK button. Load the roll, and
then print.
 (See "Attaching the Roll Holder to Rolls.") →P.530
 (See "Loading Rolls in the Printer.") →P.533

Press ▲ or ▼ and select Stop Printing or press the Stop button to stop printing.

Roll printing is selected, but sheets are loaded.Roll printing is selected, but sheets are loaded.
Cause Corrective Action

A print job for rolls was received when a sheet is loaded. Follow these steps to load and print on a roll.

1. Press ▲ or ▼ to select Eject Paper, press the OK button, and remove the sheet.
 (See "Removing Sheets.") →P.560

2. Load a new roll.
 (See "Loading Rolls in the Printer.") →P.533
The printer now starts printing the print job.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

The roll is empty.The roll is empty.
Cause Corrective Action

The roll is empty. Follow these steps to replace the used roll with a new roll of the same type and size.

1. Lift the Release Lever and remove the roll.
 (See "Removing the Roll from the Printer.") →P.539
 (See "Removing the Roll Holder from Rolls.") →P.542

2. Load the new roll.
 (See "Attaching the Roll Holder to Rolls.") →P.530
 (See "Loading Rolls in the Printer.") →P.533

3. If no barcode was printed on the roll, specify the type of paper.
 (See "Changing the Type of Paper.") →P.537

4. When you have selected ManageRemainRoll > On in the control panel menu and a barcode is not
printed on the roll, also specify the paper length.
 (See "Specifying the Paper Length.") →P.539

5. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display Screen, press
the OK button.
Printing will resume, starting from the page on which the error occurred.

There is remaining roll paper, but be-
cause it could not be advanced, it
could not be detected.

• If the trailing edge of the paper is
taped to the roll paper core

The paper was not advanced because the trailing edge is taped to the roll paper core.
Remove the used roll paper and insert a new roll paper.
 (See "Removing the Roll from the Printer.") →P.539
 (See "Removing the Roll Holder from Rolls.") →P.542
 (See "Loading and Printing on Rolls.") →P.22

There is remaining roll paper, but be-
cause it could not be advanced, it
could not be detected.

The paper was not advanced because the unused portion of the roll paper is heavy and is placing a
burden on the printer.
It may be helpful to change the printing mode, which will change the paper feed timing.

Roll printing is selected.                                                                                                                                                                                                      iPF9400
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Cause Corrective Action
• If the unused portion of the roll pa-

per is heavy and is placing a bur-
den on the printer

Choose a higher level of Print Quality in the Advanced Settings of the printer driver.
 (See "Giving Priority to Particular Graphic Elements and Colors for Printing.") →P.61

No sheets.No sheets.
Cause Corrective Action

A sheet has come out of the printer during printing. 1. Lift the Release Lever and remove the paper.

2. Reload the paper.
 (See "Loading Sheets in the Printer.") →P.555

Sheet printing is selected.Sheet printing is selected.
Cause Corrective Action

You have attempted to print on a sheet, but no
sheet is loaded.

Press ▲ or ▼ to select Load Paper, and then press the OK button. Load a sheet, and
then print.
 (See "Loading and Printing on Sheets.") →P.25

Press ▲ or ▼ and select Stop Printing or press the Stop button to stop printing.

Regular printing is selected, but a roll is loaded.Regular printing is selected, but a roll is loaded.
Cause Corrective Action

A print job for printing on sheets was
sent when a roll is loaded.

1. Press ▲ or ▼ to select Remove Roll Paper, and then press the OK button to stop printing.

2. After removing the roll, load and print on a sheet of the type and size of paper you have specified in
the printer driver.
 (See "Removing the Roll from the Printer.") →P.539
 (See "Loading and Printing on Sheets.") →P.25

Press ▲ or ▼ to select Stop Printing, and then press the OK button to stop printing.

You are using a roll with the Media
Take-up Unit, but a print job requir-
ing sheets was sent.

1. Press the OK button to stop printing.

2. After removing the roll, load and print on a sheet of the type and size of paper you have specified in
the printer driver.
 (See "Removing Printed Documents from the Media Take-up Unit.") →P.579
 (See "Loading and Printing on Sheets.") →P.25

Paper jam.Paper jam.
Cause Corrective Action

A paper jam occurred
in the printer during
printing.

1. Lift the Release Lever and remove the jammed paper.
 (See "Clearing Jammed Roll Paper.") →P.878
 (See "Clearing a Jammed Sheet.") →P.881

2. Load the paper.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

3. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display Screen, press the OK button.
Printing will resume, starting from the page on which the error occurred.

iPF9400                                                                                                                                                                                                                            No sheets.
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Paper loaded askew.Paper loaded askew.
Cause Corrective Action

Paper loaded crooked was detected when the paper was advanced. Lift up the Release Lever and reload the paper.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

If this error recurs after you reload the roll, re-
move the Roll Holder from the printer, push the
roll firmly in until it touches the Roll Holder
flange, and reload the Roll Holder in the print-
er.
 (See "Attaching the Roll Holder to Rolls.")
→P.530

Important

• To disable this message (if it is displayed repeatedly despite reloading paper, for example), choose Off or Loose in the
Skew Check Lv. setting of the printer menu. However, this may cause jams and printing problems because paper may be
askew when printed. Also, the Platen may become soiled, which may soil the back of the next document when it is printed.

Cannot detect paprCannot detect papr
Cause Corrective Action

The printer could not detect the paper. Reload the paper as follows.

1. Remove the paper and press the OK button.

2. Reload the paper.
 (See "Loading Sheets in the Printer.") →P.555
 (See "Loading Rolls in the Printer.") →P.533

Cannot feed paper.Cannot feed paper.
Cause Corrective Action

Paper could not be ad-
vanced correctly dur-
ing feeding.

1. Lift the Release Lever and remove the jammed paper.
 (See "Clearing Jammed Roll Paper.") →P.878
 (See "Clearing a Jammed Sheet.") →P.881

2. Load paper.
3. Lower the Release Lever.

4. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display Screen, press the OK button.
Printing will resume, starting from the page on which the error occurred.

 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading Sheets in the Printer.") →P.555

Cannot cut this paper.Cannot cut this paper.
Cause Corrective Action

There are sheets left on the Ejec-
tion Guide.

1. Lift the Release Lever and remove the paper.
2. Load paper.
3. Lower the Release Lever.

Paper loaded askew.                                                                                                                                                                                                           iPF9400
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Cause Corrective Action
There are sheets left on the Ejec-
tion Guide.

4. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display Screen, press the
OK button.
Printing will resume, starting from the page on which the error occurred.

 (See "Loading Rolls in the Printer.") →P.533

There is a foreign object by the
Output Tray, obstructing the Cut-
ter Unit.

1. Lift the Top Cover and remove the foreign object.

2. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display Screen, press the
OK button.
Printing will resume, starting from the page on which the error occurred.

You are not using the printer un-
der the recommended environ-
mental conditions for the paper.

Use the printer only where the recommended environmental conditions for the paper are met. Note that
various environmental conditions are recommended for various types of paper. For details on the recom-
mended environmental conditions, see the Paper Reference Guide.
(See Paper Reference Guide.)

You are using paper that is not
compatible with automatic cut-
ting.

1. Specify Manual as the cutting method and use scissors or a cutting tool to cut the roll.
 (See "Specifying the Cutting Method for Rolls.") →P.546
For information about paper that is compatible with automatic cutting, see the Paper Reference Guide.
(See Paper Reference Guide.)

2. Lift the Release Lever and remove the paper.

In other cases, the Cutter Unit
may be damaged.

Contact your Canon dealer for assistance.

End of paper feed.End of paper feed.
Cause Corrective Action

Although an attempt was made to advance the paper manually, it reached the limit position
that can be advanced.

Canceling manual advancing.
 (See "Feeding Roll Paper Manually.") →P.543

Paper can be retracted only up to 17 mm (0.7 in) when using the Media Take-up Unit. Canceling manual advancing.

Rel lever is in wrong position.Rel lever is in wrong position.
Cause Corrective Action

The Release Lever is up. Lower the Release Lever.

If the error occurs again, turn off the printer and wait a while before restoring power.

Rewinding error.Rewinding error.
Cause Corrective Action

There is some foreign object near the Media Take-up Unit sensor and
the roll cannot be detected.

Remove the foreign object near the sensor.

The Media Take-up Unit sensor is soiled and the roll cannot be detec-
ted.

Wipe the sensor with a dry cloth to clean it.

The roll is out of range of detection by the Media Take-up Unit sensor. Reload the roll.
Press the OK button to clear the error.
 (See "Loading Rolls in the Printer.") →P.533
 (See "Loading the Rewind Spool on the Media Take-up Unit.") →P.572

A paper jam has occurred and the roll cannot be rewound. Remove the paper from the Media Take-up Unit.
Press the OK button to clear the error.

The Media Take-up Unit sensor is damaged. Contact your Canon dealer for assistance.

*1: Printing will stop momentarily if an error involving the Media Take-up Unit occurs. If you prefer printing not to stop, set Skip Take-Up Err
to On. However, note that this error may cause paper jams and affect the printing quality.

iPF9400                                                                                                                                                                                                               End of paper feed.
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Media take-up unit ready.Media take-up unit ready.
Cause Corrective Action

The Take-up Reel setting in the printer Set./Adj. Menu was
changed from Enable to Disable, but a print job was re-
ceived before the roll was removed.

Press ▲ or ▼ to select Stop Printing, and then press the OK button to stop
printing.
The mode switches from take-up mode to regular mode after you change the
Take-up Reel setting in the Set./Adj. Menu from Enable to Disable and lift the
Release Lever to remove a roll, or after you execute Paper Cutting.

Press ▲ or ▼ to select Print, and then press the OK button to resume printing.

Turn on the media take-up unit.Turn on the media take-up unit.
Cause Corrective Action

The Take-up Reel setting in the control panel menu was changed to Enable while the power to the
Take-up Reel was off and the Roll Media lamp on the control panel was lit.

Turn the Media Take-up Unit on.

The Take-up Reel setting in the control
panel menu changes to Disable.

Borderless printng not possible.Borderless printng not possible.
Cause Corrective Action

The print job received specifies a type
or width of paper that is not compatible
with borderless printing.

Follow these steps to change the settings of the print job to enable borderless printing.

1. Press ▲ or ▼ to select Stop Printing, and then press the OK button.

2. Make sure the correct printer driver for the printer is selected and try printing again.
For information on types of paper compatible with borderless printing, refer to the Paper Refer-
ence Guide.
(See Paper Reference Guide.)

Select None when you have set Detect Mismatch on the control panel to Warning.
However, note that this error may cause paper jams and affect the printing quality.

Press ▲ or ▼ to select Print With Border, and then press the OK button to continue printing. The
document will be printed with a border.

The loaded paper is a size not compati-
ble with borderless printing.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

Replace the paper with paper compatible for borderless printing as follows.

1. Press ▲ or ▼ to select Change Paper, and then press the OK button.
 (See "Removing the Roll from the Printer.") →P.539
 (See "Removing the Roll Holder from Rolls.") →P.542

2. Replace the paper with paper compatible for borderless printing.
 (See "Attaching the Roll Holder to Rolls.") →P.530
 (See "Loading Rolls in the Printer.") →P.533
The printer now starts printing the print job.
For information on types of paper compatible with borderless printing, refer to the Paper Refer-
ence Guide.
(See Paper Reference Guide.)

Press ▲ or ▼ to select Print With Border, and then press the OK button to continue printing. The
document will be printed with a border.

Paper position not suitable for borderless printing.Paper position not suitable for borderless printing.
Cause Corrective Action

Because paper expands or contracts de-
pending on the environment of use, it may
become narrower or wider than the suppor-
ted width for borderless printing.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.
Use each type of paper only where the recommended environmental conditions are met. For
details on environmental conditions for various paper, see the Paper Reference Guide.
(See Paper Reference Guide.)

Select None when you have set Detect Mismatch in the Control Panel menu to Warning.

Media take-up unit ready.                                                                                                                                                                                                    iPF9400
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Cause Corrective Action
Because paper expands or contracts de-
pending on the environment of use, it may
become narrower or wider than the suppor-
ted width for borderless printing.

However, note that this error may affect the printing quality.

The paper is loaded askew. Press ▲ or ▼ to select Change Paper and straighten the paper so that the edges are between
the ink grooves for borderless printing.
Insert the roll firmly until it touches the flange of the Roll Holder.
 (See "Attaching the Roll Holder to Rolls.") →P.530

Select None when you have set Detect Mismatch in the Control Panel menu to Warning.
However, note that this error may affect the printing quality.

Press ▲ or ▼ to select Print With Border, and then press the OK button to continue printing.
The document will be printed with a border.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

iPF9400                                                                                                                                                            Paper position not suitable for borderless printing.
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Messages regarding inkMessages regarding ink
Ink insufficient. ................................................................................................................................................... 920
No ink left. .......................................................................................................................................................... 920
Remaining level of the ink cannot be correctly detected. .................................................................................. 920
Close Ink Tank Cover ......................................................................................................................................... 920
Ink tank is empty. ............................................................................................................................................... 921
Not much ink is left. ............................................................................................................................................ 921
No ink tank loaded. ............................................................................................................................................ 921
The following ink tanks cannot be recognized. .................................................................................................. 921

Ink insufficient.Ink insufficient.
Cause Corrective Action

The ink level is low, so you cannot print, clean the Printhead, or do other operations that
require ink.

Press the OK button and replace the Ink Tank
that is low with a new Ink Tank.
 (See "Replacing Ink Tanks.") →P.826

No ink left.No ink left.
Cause Corrective Action

There is no ink left.
There are no ink colors with × displayed above the re-
maining ink indicator.

Press the OK button, open the Ink Tank Cover, and replace the Ink Tank for the
color that is out of ink.
 (See "Replacing Ink Tanks.") →P.826

Remaining level of the ink cannot be correctly detected.Remaining level of the ink cannot be correctly detected.
Cause Corrective Action

Ink level detection cannot work correctly if you
use refill ink tanks.

The refill ink tank can no longer be used. See the section Ink level detection and take the
appropriate action.  (See "Ink Level Detection.") →P.904

Close Ink Tank CoverClose Ink Tank Cover
Cause Corrective Action

The Ink Tank Cover is open. Close the Ink Tank Cover.

Ink insufficient.                                                                                                                                                                                                                     iPF9400
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Ink tank is empty.Ink tank is empty.
Cause Corrective Action

There is no ink left in an ink tank.
There are no ink colors with × displayed above the remaining ink indicator in
the Ink tab top screen.
 (See "Checking Ink Tank Levels.") →P.836

Open the Ink Tank Cover, and replace the Ink Tank for the
color that is out of ink.
 (See "Replacing Ink Tanks.") →P.826

Not much ink is left.Not much ink is left.
Cause Corrective Action

Not much ink is left. Prepare a new Ink Tank.
We recommend replacing the Ink Tank with a new Ink Tank at this point if you plan to print large-
format or high-quantity jobs.

No ink tank loaded.No ink tank loaded.
Cause Corrective Action

There is no Ink Tank of the indicated color in the printer. Load the Ink Tank.
 (See "Replacing Ink Tanks.") →P.826

There is a problem with the Ink Tank. Replace it with a new Ink Tank.
 (See "Replacing Ink Tanks.") →P.826

The following ink tanks cannot be recognized.The following ink tanks cannot be recognized.
Cause Corrective Action

An Ink Tank that is incompatible with the printer is loaded. Load an Ink Tank that is compatible with the printer.
 (See "Replacing Ink Tanks.") →P.826

iPF9400                                                                                                                                                                                                                 Ink tank is empty.
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Messages regarding printing or adjustmentMessages regarding printing or adjustment
Cannot execute this command. Use other paper. ............................................................................................. 922
Cannot adjust printhead. .................................................................................................................................... 925
Cannot calibrate. ................................................................................................................................................ 922
Excessive temperature or humidity. ................................................................................................................... 922
Please execute common calibration. ................................................................................................................. 923
Please commn calibrt using above paper. ........................................................................................................ 923
Please calibrate using above paper. ................................................................................................................. 923
Borderless printng not possible. Paper stretched or shrank. ............................................................................ 923
Before borderless printing, move the blue platen switch. ................................................................................. 923
Borderless printng not possible. ........................................................................................................................ 918
Blue platen switch is dirty. ................................................................................................................................. 924
Move the blue platen switch No.xx to the right. (xx represents a number) ....................................................... 924
Cannot adjust paper feed. ................................................................................................................................. 924
Check printed document. .................................................................................................................................. 924

Cannot execute this command. Use other paper.Cannot execute this command. Use other paper.
Cause Corrective Action

Paper compatible with
color calibration is not
loaded.

1. Press the OK button to clear the error.

2. Load paper that is compatible with color calibration.
See the Paper Reference Guide.
(See Paper Reference Guide.)

Always make sure the loaded paper matches the type of paper in the printer paper settings. Adjustment cannot be
completed correctly unless the loaded paper matches the settings.

Cannot calibrate.Cannot calibrate.
Cause Corrective Action

The paper for printing a test pattern is soiled. Otherwise,
you have loaded colored paper.

Press the OK button to clear the error.
Load unused paper compatible with color calibration.
(See Paper Reference Guide.)

The test pattern was printed too faintly. Press the OK button to clear the error.
Take steps to remedy faint printing.
 (See "Printing is faint.") →P.888

Direct sunlight or strong lighting may be shining on the
printer and causing the sensor to malfunction.

Press the OK button to clear the error.
Take steps to ensure the printer is not used when exposed to direct sunlight or
strong lighting.

Excessive temperature or humidity.Excessive temperature or humidity.
Cause Corrective Action

The temperature or humidity where the
printer is installed is out of the acceptable
range for operation.

Press ▲ or ▼ to select Stop, and then press the OK button to stop printing.
Use the printer under suitable environmental conditions. Also note that various environmental
conditions are recommended for various types of paper. For details on the recommended envi-
ronmental conditions, see the Paper Reference Guide.
(See Paper Reference Guide.)

Press ▲ or ▼ to select Continue, and then press the OK button to continue with color calibra-
tion. However, note that correct adjustment may not be possible.

Cannot execute this command. Use other paper.                                                                                                                                                              iPF9400
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Please execute common calibration.Please execute common calibration.
Cause Corrective Action

There is not even one Common calibration execution result.
Note that this is displayed when all of the following are satisfied.

• If "Set Exec. Guide" is On in the Control Panel menu.

• If the printer is loaded with a type of paper on which color calibration cannot be executed.

Execute Common calibration.
 (See "Corrects slight differences in how colors
appear (color calibration).") →P.820

Set "Set Exec. Guide" to Off on the Control
Panel menu.
 (See "Menu Structure.") →P.661

Please commn calibrt using above paper.Please commn calibrt using above paper.
Cause Corrective Action

It is now recommended that you execute Common calibration.
Note that this is displayed when "Set Exec. Guide" in the Control Panel menu is set to On and any of the following
is true.

• If the printer is loaded with a type of paper on which color calibration cannot be executed and the predefined
conditions since executing the Common calibration the last time have been reached.

• Although a media type that color calibration can be executed on is loaded in the printer, there is no record or
performing color calibration on that media, and the designated criteria from executing Common calibration the
last time have been reached.

Execute Common cali-
bration.
 (See "Corrects slight dif-
ferences in how colors
appear (color calibra-
tion).") →P.820

Set "Set Exec. Guide"
to Off on the Control
Panel menu.
 (See "Menu Structure.")
→P.661

Please calibrate using above paper.Please calibrate using above paper.
Cause Corrective Action

It is now recommended that you execute Unique calibration.
Note that this is displayed when "Set Exec. Guide" in the Control Panel menu is set to On and any of the following is
true.

• If the printer is loaded with a type of paper on which color calibration can be executed, but there is no record of
having executed color calibration on that paper or a record of having executed Common calibration other any other
type of paper.

• If the printer is loaded with a type of paper on which color calibration can be executed, there is a record of having
executed color calibration on that paper, and the predefined conditions since executing the color calibration the last
time have been reached.

Execute Unique cali-
bration.
 (See "Corrects slight
differences in how col-
ors appear (color cali-
bration).") →P.820

Set "Set Exec. Guide"
to Off on the Control
Panel menu.
 (See "Menu Struc-
ture.") →P.661

Borderless printng not possible. Paper stretched or shrank.Borderless printng not possible. Paper stretched or shrank.
Cause Corrective Action

The loaded roll has expanded or contracted due to environmental conditions,
making it wider or narrower than the supported width for borderless printing.

Press the OK button to stop printing.

Use each type of paper only where the recommended environ-
mental conditions are met. For details on environmental condi-
tions for various paper, see the Paper Reference Guide.
(See Paper Reference Guide.)

Before borderless printing, move the blue platen switch.Before borderless printing, move the blue platen switch.
Cause Corrective Action

The blue Switch on the platen was set to the side opposite ● when
a borderless print job was received.

Before borderless printing, set the blue Switch on the platen to the ● side.
 (See "Setting the Blue Switch on the Platen.") →P.893

iPF9400                                                                                                                                                                                  Please execute common calibration.
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Blue platen switch is dirty.Blue platen switch is dirty.
Cause Corrective Action

The blue Switch on the platen is dirty. Open the Top Cover and clean the blue Switch on the platen.
 (See "Cleaning Inside the Top Cover.") →P.861

Move the blue platen switch No.xx to the right. (xx represents a number)Move the blue platen switch No.xx to the right. (xx represents a number)
Cause Corrective Action

The printer has detected that the blue Switch on the platen needed in main-
tenance during printing is set away from the ● mark.

Set blue platen Switch of the indicated number toward the ● side.
 (See "Setting the Blue Switch on the Platen.") →P.893

Cannot adjust paper feed.Cannot adjust paper feed.
Cause Corrective Action

The Printhead nozzles are clogged. Execute Adj. Quality again, as follows.

1. Press the OK button to clear the error.

2. Print a test pattern to check the nozzles.
 (See "Checking for Nozzle Clogging.") →P.838

3. Clean the Printhead if the nozzles are clogged.
 (See "Cleaning the Printhead.") →P.839

4. Execute Adj. Quality again.
 (See "Automatic Banding Adjustment.") →P.806

Highly transparent film is loaded that cannot be used for
automatic feed amount adjustment.

Press the OK button to clear the error, and then adjust the feed amount manually.
 (See "Manual Banding Adjustment.") →P.807

Check printed document.Check printed document.
Cause Corrective Action

The Printhead nozzles are becoming clogged. If printing is faint, clean the Printhead.
 (See "Cleaning the Printhead.") →P.839

Blue platen switch is dirty.                                                                                                                                                                                                   iPF9400
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Messages regarding printheadsMessages regarding printheads
Cannot adjust printhead. .................................................................................................................................... 925
PHeads: wrong pos. ........................................................................................................................................... 925
Wrong x printhead. (x is L, R, or not displayed) ................................................................................................ 925
x printhead error (x is L, R, or not displayed) .................................................................................................... 925
Cannot recognize print head x. (x is L, R, or not displayed) ............................................................................. 926
Execute printhead cleaning. .............................................................................................................................. 926

Cannot adjust printhead.Cannot adjust printhead.
Cause Corrective Action

The Printhead nozzles are clogged. Execute Head Posi. Adj. again, as follows.

1. Press the OK button to clear the error.

2. Print a test pattern to check the nozzles.
 (See "Checking for Nozzle Clogging.") →P.838

3. Clean the Printhead if the nozzles are clogged.
 (See "Cleaning the Printhead.") →P.839

4. Execute Head Posi. Adj. again.
 (See "Automatic Adjustment to Straighten Lines and Colors.") →P.798

The Printhead cannot be aligned; highly
transparent film is loaded.

Press the OK button to clear the error.
We recommend using a type of paper that you often use, other than film, for Printhead adjustment.
 (See "Automatic Adjustment to Straighten Lines and Colors.") →P.798

PHeads: wrong pos.PHeads: wrong pos.
Cause Corrective Action

The printheads are installed in the
wrong positions.

Open the Top Cover and switch the Printhead used once in the right side to the right side. Switch the
Printhead used once in the left side to the left side.

Wrong x printhead. (x is L, R, or not displayed)Wrong x printhead. (x is L, R, or not displayed)
Cause Corrective Action

An incompatible Print-
head has been installed.

Open the Top Cover. Replace the Printhead L with a new one if Printhead L is displayed and the Printhead R if
Printhead R is displayed. If neither left or right is indicated, replace both Printhead L and Printhead R with new ones.
 (See "Replacing the Printhead.") →P.840

x printhead error (x is L, R, or not displayed)x printhead error (x is L, R, or not displayed)
Cause Corrective Action

There is a prob-
lem with the Print-
head.

Follow these steps to replace the Printhead.

1. Open the Top Cover.

2. Replace the Printhead L with a new one if Printhead L is displayed and the Printhead R if Printhead R is displayed. If
neither left or right is indicated, replace both Printhead L and Printhead R with new ones.
 (See "Replacing the Printhead.") →P.840

Follow these steps to replace the Printhead.

1. Turn off the printer, wait a while, and then turn it on again.
2. Open the Top Cover.

3. Replace the left printhead with a new one if Printhead L is displayed and the right one if Printhead R is displayed. If
neither left or right is indicated, replace both printheads.
 (See "Replacing the Printhead.") →P.840

iPF9400                                                                                                                                                                                                     Cannot adjust printhead.
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Cannot recognize print head x. (x is L, R, or not displayed)Cannot recognize print head x. (x is L, R, or not displayed)
Cause Corrective Action

No Printhead is installed. Follow these steps to install the Printhead.

1. Open the Top Cover.

2. Install the Printhead L if Printhead L is displayed and the Printhead R if Printhead R is displayed. If neither left
or right is indicated, install both Printhead L and Printhead R.
 (See "Replacing the Printhead.") →P.840

The Printhead cannot be
recognized because it is
not installed correctly.

Follow these steps to reinstall the Printhead.

1. Open the Top Cover.

2. Reinstall the Printhead L if Printhead L is displayed and the Printhead R if Printhead R is displayed. If neither
left nor right is indicated, re-install both Printhead L and Printhead R.
 (See "Replacing the Printhead.") →P.840

Execute printhead cleaning.Execute printhead cleaning.
Cause Corrective Action

The Printhead noz-
zles are clogged.

Follow these steps to clean the Printhead.

1. Stop printing by pressing ▲ or ▼ to select Stop Printing.

2. Clean the Printhead.
 (See "Cleaning the Printhead.") →P.839

If the message is still displayed when printing, replace the Printhead.
 (See "Replacing the Printhead.") →P.840

Press ▲ or ▼ to select Print, and then press the OK button to resume printing. However, note that this error may affect
the printing quality.

If OK is shown on the Display Screen, clean the Printhead.

1. Press the OK button on the Control Panel to stop printing.

2. Clean the Printhead.
 (See "Cleaning the Printhead.") →P.839

If the message is still displayed when printing, replace the Printhead.
 (See "Replacing the Printhead.") →P.840

Cannot recognize print head x. (x is L, R, or not displayed)                                                                                                                                               iPF9400
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Messages regarding the maintenance cartridgeMessages regarding the maintenance cartridge
No maintenance cartridge. ................................................................................................................................ 927
Wrong maintenance cartridge. .......................................................................................................................... 927
Maint. cart. The level is low ................................................................................................................................ 927
No Maintenance Cartridge capacity. ................................................................................................................. 927
Maintenance cartridge full. ................................................................................................................................ 927
Maintenance cartridge problem. ........................................................................................................................ 927

No maintenance cartridge.No maintenance cartridge.
Cause Corrective Action

The Maintenance Cartridge is not installed. Install the Maintenance Cartridge.
 (See "Replacing the Maintenance Cartridge.") →P.852

Wrong maintenance cartridge.Wrong maintenance cartridge.
Cause Corrective Action

A Maintenance Cartridge for a different model of printer is installed. Replace it with the Maintenance Cartridge for your particular model.
 (See "Maintenance Cartridge.") →P.852

Maint. cart. The level is lowMaint. cart. The level is low
Cause Corrective Action

The Maintenance Cartridge is al-
most full.

You can continue to print, but prepare a new Maintenance Cartridge to use when the message for re-
placement is displayed.

No Maintenance Cartridge capacity.No Maintenance Cartridge capacity.
Cause Corrective Action

The Maintenance Cartridge cannot absorb enough ink
for Printhead cleaning or other operation.

After confirming that the printer has stopped operating, replace the Maintenance Car-
tridge.
 (See "Replacing the Maintenance Cartridge.") →P.852

Maintenance cartridge full.Maintenance cartridge full.
Cause Corrective Action

The Maintenance Cartridge is full. After confirming that the printer has stopped operating, replace the Maintenance Cartridge.
 (See "Replacing the Maintenance Cartridge.") →P.852

Maintenance cartridge problem.Maintenance cartridge problem.
Cause Corrective Action

An incompatible or used Maintenance Cartridge has been installed. Install an unused Maintenance Cartridge specified for use with the printer.
 (See "Replacing the Maintenance Cartridge.") →P.852

iPF9400                                                                                                                                                                                                  No maintenance cartridge.
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Messages regarding the hard diskMessages regarding the hard disk
Hard disk error. .................................................................................................................................................. 928
File read error. .................................................................................................................................................... 928
The mail box is full. ............................................................................................................................................. 928
Mail box full. Now printing without saving data. ................................................................................................. 928
Mail box nearly full. ............................................................................................................................................ 928
Maximum jobs stored. ........................................................................................................................................ 928
Mail box full. Delete unwanted data ................................................................................................................... 928

Hard disk error.Hard disk error.
Cause Corrective Action

The format of the printer's hard
disk is invalid.

Press the OK button to start reformatting the hard disk. When formatting is finished, data on the printer
hard disk is erased and the printer automatically restarts.

File read error.File read error.
Cause Corrective Action

Files on the printer's hard disk have become corrupted. Restart the printer. Only the corrupted files will be deleted, and the printer will restart.

The mail box is full.The mail box is full.
Cause Corrective Action

There is no more space on the printer's hard disk. Press the Stop button and stop printing.

Delete print jobs from the queue.
 (See "Managing the Job Queue (Deleting or Preempting Other Jobs).") →P.759

Delete unneeded jobs stored in personal boxes.
 (See "Deleting Saved Jobs.") →P.768

Mail box full. Now printing without saving data.Mail box full. Now printing without saving data.
Cause Corrective Action

No more space is available on the printer's hard disk, so jobs are now printed without saving
them. (Print jobs can no longer be saved on the hard disk.)

After printing, this message is cleared.

Delete unneeded jobs stored in personal boxes.
 (See "Deleting Saved Jobs.") →P.768

Mail box nearly full.Mail box nearly full.
Cause Corrective Action

The free hard disk space left for Personal Boxes in the printer's hard disk does not have
more than 1 GB, combined.

Delete unneeded jobs stored in Personal Boxes.
 (See "Deleting Saved Jobs.") →P.768

Maximum jobs stored.Maximum jobs stored.
Cause Corrective Action

100 jobs are stored in the personal box. Delete unneeded jobs stored in personal boxes.
 (See "Deleting Saved Jobs.") →P.768

Mail box full. Delete unwanted dataMail box full. Delete unwanted data
Cause Corrective Action

100 jobs are stored in the Personal Box. Press the Stop button and stop printing.

Delete print jobs from the queue.

Hard disk error.                                                                                                                                                                                                                    iPF9400
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Cause Corrective Action
100 jobs are stored in the Personal Box.  (See "Managing the Job Queue (Deleting or Preempting Other Jobs).") →P.759

Delete unneeded jobs stored in personal boxes.
 (See "Deleting Saved Jobs.") →P.768
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Other MessagesOther Messages
GARO Wxxxx (x represents a number) .............................................................................................................. 930
ERROR Exxx-xxxx (x represents a letter or number) ......................................................................................... 930
Hardware error. xxxxxxxx-xxxx (x represents a letter or number) ..................................................................... 930
Top cover is open. ............................................................................................................................................. 930
Prepare for parts replacement. .......................................................................................................................... 931
Parts replacement time has passed. ................................................................................................................. 931
Unknown file. ...................................................................................................................................................... 931
Calibration There is a problem with the multi-sensor. ........................................................................................ 931
Multi-sensor error ............................................................................................................................................... 931

GARO Wxxxx (x represents a number)GARO Wxxxx (x represents a number)
Cause Corrective Action

There is a problem with the print job. Try printing again, using the correct printer driver.

It is also possible to continue printing in this state.
However, you may not be able to obtain the desired printing results.

ERROR Exxx-xxxx (x represents a letter or number)ERROR Exxx-xxxx (x represents a letter or number)
Cause Corrective Action

An error requiring service may have occurred. Write down the error code and message, turn off the printer, and contact your Canon dealer for
assistance.

Hardware error. xxxxxxxx-xxxx (x represents a letter or number)Hardware error. xxxxxxxx-xxxx (x represents a letter or number)
Cause Corrective Action

The last portion of roll paper was used during a print job. The paper was
not advanced because the trailing edge is taped to the roll.

Turn off the printer and remove the roll from the printer before re-
storing power.

Fastening tape or the Belt Stopper has not been removed inside the Top
Cover.

Turn off the printer, open the Top Cover and remove the tape or the
Belt Stopper before restoring power.

An error requiring service may have occurred. Turn off the printer and wait at least three seconds before restoring
the power.
If the message is displayed again, write down the error code and
message, turn off the printer, and contact your Canon dealer for as-
sistance.

Top cover is open.Top cover is open.
Cause Corrective Action

The printer has detected that the Top Cover is open. Open the Top Cover fully, remove any foreign objects, and close the Top Cover again.

If the error occurs again, turn off the printer and wait a while before restoring power.
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Prepare for parts replacement.Prepare for parts replacement.
Cause Corrective Action

It is almost time to replace consumables for
which service is required.

If "Parts replacement time has passed." is displayed, you can continue to use the printer for
some time.
Contact your Canon dealer for assistance.

Parts replacement time has passed.Parts replacement time has passed.
Cause Corrective Action

It is past the recommended time to replace consumables for which service is required. Contact your Canon dealer for assistance.

Unknown file.Unknown file.
Cause Corrective Action

Data sent to keep the printer up to date (such as paper
information) is in the wrong format.

Check the data. Turn off the printer and wait a while before restoring power, and
then resend the data.

You have uploaded firmware for a different model. Check the firmware version. Turn off the printer and wait a while before restoring
power, and then resend the firmware.

If the message is displayed again, contact your Canon dealer for assistance.

Calibration There is a problem with the multi-sensor.Calibration There is a problem with the multi-sensor.
Cause Corrective Action

The performance of a sensor inside the printer may be im-
paired.

Press the OK button and cancel calibration. Contact your Canon dealer for assis-
tance.

Multi-sensor errorMulti-sensor error
Cause Corrective Action

Direct sunlight or strong lighting may be shining on the
printer and causing the sensor to malfunction.

Take steps to ensure the printer is not used when exposed to direct sunlight or
strong lighting.

The performance of a sensor inside the printer may be
impaired.

Turn off the printer and wait at least three seconds before restoring the power.
If the message is displayed again, contact your Canon dealer for assistance.

iPF9400                                                                                                                                                                                           Prepare for parts replacement.
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Printer SpecificationsPrinter Specifications
Specifications ..................................................................................................................................................... 934
Print Area ............................................................................................................................................................ 935

SpecificationsSpecifications

Important

• The following values may vary depending on the operating environment.

Printer

Power supply 100–240 V AC (50/60 Hz)

Power consumption During operation 190 W max.

100–120 V: 5 W max.

220–240 V: 6 W max.

Off 0.5 W max. (*1)

Operating noise (*2) Sound pressure level During operation Approx. 52 dB (A)

Standby 35 dB (A) max.

Audio power level (during operation) Approx. 6.8 bels

Operating environment Temperature 15–30°C (59–86°F)

Humidity 10–80%, non-condensing

Dimensions (W × D × H) Printer and Stand (including Roll
Holder and Media Take-up Unit)

2,299 × 766 × 1,144 mm (90.5 × 30.2 × 45.0 in)

Weight Printer and Stand (including Roll
Holder and Media Take-up Unit)
(not including Printhead and Ink
Tank)

Approx. 164 kg (361.6 lb)

Space for installation (W × D ×
H)

Printer and Stand 2,699 × 1,466 × 1,500 mm (106.3 × 57.7 × 59.1 in)

Applicable standards International Energy Star Program (worldwide), Law on Promoting Green Purchasing (Japan), GPN,
RoHS directive, IT Eco Declaration (Europe), WEEE, U.S. presidential directives, J-MOSS (Green Mark),
Chinese RoHS, ErP Lot6 (Europe)

*1: The printer uses a trace amount of power even when turned off. To stop all power consumption, turn off the printer and unplug the power
cord.

*2: Calculation based on ISO 7779. Operating conditions: On the Main sheet of the printer driver, Media Type > Canon Glossy Photo
Paper HG 170, Advanced Settings > Print Priority > Image, and Print Quality > Standard.

Printing performance

Print method Bubblejet

Maximum resolution 2400 dpi horizontally (*1) × 1200 dpi vertically

Printhead PF-05 ×2

Number of nozzles 2,560 per color

*1: Prints with a minimum 1/2400 inch dot pitch between ink droplets.
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Memory and hard disk

Memory 640 MB

Hard disk capacity 250 GB

Personal mail boxes (Permanent storage
area)

140 GB

Print job storage capacity Common Box 100 jobs

Personal Boxes 100 jobs

Interface

  Hi-Speed USB Format Internal port

Mode Full-speed (12 Mbps), high-speed (480 Mbps), bulk transfer

Connector Series B (4-pin)

  Gigabit Ethernet Format Internal port

Specification IEEE 802.3 10Base-T,
IEEE 802.3u 100Base-TX/Auto-Negotiation,
IEEE 802.3ab 1000Base-T/Auto-Negotiation,
IEEE 802.3x Full Duplex

Protocols IPX/SPX (Netware 3.2 (J), 4.1 (J), 4.11 (J), 4.2 (J), 5.0 (J), 5.1 (J),
6.0 (J) ), SNMP (Canon-MIB compatible), HTTP, TCP/IP, AppleTalk

Ink
For information on the ink the printer supports, see "Ink Tanks." →P.826

Paper
For information on the types of paper the printer supports, refer to the Paper Reference Guide. (See Paper Reference
Guide.)
For information on the paper sizes the printer supports, see "Paper Sizes." →P.522

Paper width Rolls 254–1,524 mm (10–60 in)

Sheets 203.2–1,524 mm (8–60 in)

Minimum paper length 203.2 mm (8.0 in)

Maximum printable length (*1) Rolls 18 m (19.7 yd)

Sheets 1,600 mm (63.0 in)

Thickness Rolls 0.07–0.8 mm (0.0028–0.031 in)

Sheets 0.07–0.8 mm (0.0028–0.031 in)

Roll maximum outer diameter 150 mm (6 in) or shorter

Supported paper core inner diameter 2 inches / 3 inches

Print area For details, see "Print Area." →P.935

*1: Varies depending on the operating system or application.

Print AreaPrint Area
A margin required by the printer is added with respect to the size of paper loaded in the printer. Except in borderless
printing, the actual printing area corresponds to the paper size minus the space for this margin.

iPF9400                                                                                                                                                                                                                             Print Area
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Note

• Printable Area: The area that can be printed.
• There is no margin (that is, a margin of 0 mm) during borderless printing on rolls.
• Recommended Print Area: We recommend printing within this area.

• To print so that your original matches the print area exactly, use an oversized paper size that includes the required margin.
 (See "Printing on Oversize Paper.") →P.84

 
Margins of Printable Area Margins of Recommended Print Area

Top Edge Bottom Edge Sides Top Edge Bottom Edge Sides
Sheets 5 mm (0.20 in) 23 mm (0.91 in) 5 mm (0.20 in) 20 mm (0.79 in) 23 mm (0.91 in) 5 mm (0.20 in)

Rolls 0/5 mm (0/0.20 in) 0/5 mm (0/0.20 in) 0/5 mm (0/0.20 in) 20 mm (0.79 in) 5 mm (0.20 in) 5 mm (0.20 in)

Sheets

• Printable Area:
A margin of 5 mm (0.20 in) on top, 23 mm (0.91 in) on bottom, and 5 mm (0.20 in) on left and right sides is re-
quired.

• Recommended Print Area:
A margin of 20 mm (0.79 in) on top, 23 mm (0.91 in) on bottom, and 5 mm (0.20 in) on left and right sides is re-
quired.

Rolls

• Printable Area:
A margin of 5 mm (0.20 in) on all sides is required. During borderless printing, the margin on all sides is 0 mm. For
information on paper compatible with borderless printing, see the Paper Reference Guide.  (See "Types of Paper.")
→P.522

• Recommended Print Area:
A margin of 20 mm (0.79 in) on top, 5 mm (0.20 in) on bottom, and 5 mm (0.20 in) on left and right sides is re-
quired.
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Safety PrecautionsSafety Precautions
Safety Precautions ............................................................................................................................................. 938
Legal Notices ..................................................................................................................................................... 940

Safety PrecautionsSafety Precautions
Follow the warnings and precautions below to use the printer safely. Do not perform any operations or procedures oth-
er than as described in this manual. Doing so may result in unexpected accidents and can cause a fire or electrical
shocks.

Printer location

Warning

• Do not set up the printer in any location exposed to alcohol, thinner, or other volatile liquids. If these substances come into
contact with electrical components inside the printer, there is a risk of fire or electrical shock.

Caution

• Never install the printer on an unstable or vibrating surface. If it falls over, this could cause personal injury.

• Never set up the printer in a location that is exposed to high humidity or large amounts of dust, or exposed to direct sunlight,
high temperature, or open flame. This could cause a fire or electrical shock. Use the printer location in an environment where
temperature and humidity are within the ranges of 15 °C to 30 °C (59 °F to 86 °F) and 10 to 80% RH (with no condensation).

• Never place the printer on a heavy wool or shag carpet. The fibers may enter the printer and cause a fire.

• Keep the area around the power outlet clear of items so that you can disconnect the power cable immediately if the printer
starts operating abnormally. In the event of a printer malfunction, remove the power cable from the outlet as soon as possible
to prevent fire and electrical shocks.

• Do not install the printer near sources of strong electromagnetic fields, whether equipment that generates such fields or pla-
ces where such fields occur. This could damage the printer or cause malfunction.

Power Supply

Warning

• Never handle the power cable with wet hands. Doing so may cause electrical shock.

• Insert the power cable securely and completely into the power source. If the power cable is not inserted completely, this could
cause a fire or electrical shock.

• Do not use any power cable other than the one provided. This could cause a fire or electrical shock. Never use the power
cable with any other electrical device.

• Never cut the power cable or attempt to modify it, and never stretch it or bend it forcefully. Never place a heavy object on the
power cable. Damaged sections of the power cable could cause a short circuit and may cause a fire or electrical shock.

• Never connect the power cable to a power strip or any power source shared by other electrical devices. This could cause a
fire or electrical shock.

• Never knot the power cable or wrap it around itself. This could cause a fire or electrical shock.

• Periodically disconnect the power cable and use a dry cloth to wipe away dust that has collected on the plug and the area
around the power outlet. Leaving the power cable plugged in and not cleaned for a long period, especially in an area subject
to dust, oil, and humidity, could cause the insulation material to deteriorate and lead to a fire.

Caution

• Always grip the plug to remove the power cable from the power outlet. Pulling on the power cable could damage the cable
and lead to a fire or electrical shock.

• Never use an extension cord. This could cause a fire or electrical shock.

• Never use any power source other than 100–120 / 220–240 V AC. This could cause a fire or electrical shock. The printer
operating conditions are described below. Use the printer under the following conditions.
Power supply voltage: 100–120 / 220–240 V AC
Power supply frequency: 50/60 Hz
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In an Emergency

Warning

• If the printer emits smoke or strange odors, continuing to use the printer may cause a fire or electrical shock. Switch the
printer off immediately and remove the power plug from the power outlet. Contact the nearest service center.

Cleaning the Printer

Warning

• For cleaning, use a cloth dampened in water. Never use flammable solvents such as alcohol, benzene, or thinner. If these
substances come into contact with electrical components inside the printer, there is a risk of fire or electrical shock.

Caution

• Always disconnect the power cable from the outlet before cleaning the printer. If the printer is switched on accidentally, mov-
ing parts inside the printer may cause personal injuries.

Pacemakers

Warning

• This printer generates a low-level magnetic field. Anyone wearing a pacemaker who experiences discomfort while working
around the printer should leave the area. Consult a physician before continuing to work around the printer.

Moving the Printer

Caution

• Moving the printer requires at least six people, holding it on both sides. Be careful to avoid back strain and other injuries.

• When moving the printer, firmly grasp the Carrying Handles under each side. The printer may be unsteady if you hold it at
other positions, which poses a risk of injury from dropping the printer.

Printhead, Ink Tanks, and Maintenance Cartridge

Caution

• Always store consumables in a safe location out of the reach of small children. If a child licks or ingests ink accidentally, seek
medical assistance immediately.

• If ink accidentally gets in your eyes, immediately rinse with water.
If ink gets on your skin, immediately clean it off with soap and water.
If irritation persists in your eyes or on your skin, contact a physician immediately.

• Avoid dropping or shaking printheads, ink tanks, and maintenance cartridges. Spilled ink can stain clothing and the work area.

• Never touch the electrical contacts of the Printhead after printing. The contacts become extremely hot and can cause minor
burns.

Other

Warning

• Never disassemble the printer or attempt repairs. There are high voltage parts inside the printer that can cause a fire or elec-
trical shock.

• Never use flammable sprays around the printer. The gas of flammable sprays can cause a fire or electrical shock, if it contacts
high voltage points inside the printer.

• After removing the Cutter Unit, never touch the cutting edge (a). This could cause personal injury.

iPF9400                                                                                                                                                                                                               Safety Precautions
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Caution

• Never place anything on the printer such as small metal objects (paper clips, staples), liquids, any type of liquid container that
contains flammable liquids (alcohol, benzene, etc.). If such objects fall into the printer, this could cause a fire or electrical
shock.

• Never insert your hand into the printer while it is printing. Moving parts inside the printer can cause injuries.

• To prevent a fire hazard or dangerous electric shock, if a foreign object falls into or a liquid spills into the printer, press the
Power button immediately to switch the printer off, unplug the printer power cable from the outlet, and then call for service. If
you continue to use the printer, this could cause a fire or electrical shock.

Important

• Connect the interface cable correctly. To avoid damage, before connection make sure that the shape of the cable connector
matches the connection point on the printer.

• During printing, turn on the ventilation system in the room.

• We recommend ensuring ample space for installation.

Legal NoticesLegal Notices

FCC Regulations (U.S.A)

Canon Large Format Printer iPF9400

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This de-
vice may not cause harmful interference, and (2) this device must accept any interference received, including interfer-
ence that may cause undesired operation.
 

Note: This equipment has been tested and found to comply with the limits for class B digital device, pursuant to Part 15
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residen-
tial installation.
This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications.However, there is no guarantee that in-
terference will not occur in a particular installation. If this equipment does cause harmful interference to radio or televi-
sion reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

 

Use of shielded cable is required to comply with Class B limits in Subpart B of Part 15 of FCC Rules.
Do not make any changes or modifications to the equipment unless otherwise specified in the manual.
If such changes or modifications should be made, you could be required to stop operation of the equipment.
Canon U.S.A. Inc.
One Canon Plaza, Lake Success, NY 11042, U.S.A.
Tel No. 516-328-5600

For CA, USA Only
Included battery contains Perchlorate Material - special handling may apply.
See http://www.dtsc.ca.gov/hazardouswaste/perchlorate/ for detail.

Trademarks

• Canon, the Canon logo, and imagePROGRAF are trademarks or registered trademarks of CANON INC.

• Microsoft and Windows are trademarks of Microsoft Corporation, registered in the U.S. and other countries.

• Macintosh is trademark of Apple Inc., registered in the U.S. and other countries.
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• Other company and product names in this manual are trademarks or registered trademarks of their respective
owners.

Copyright

• Unauthorized reproduction of this user manual in whole or part is prohibited.

Legal Notice

• It is illegal to reproduce currency, bills, negotiable securities and other documents prohibited by law. Reproduction
of such items may be subject to criminal prosecution.

• It is illegal to reproduce legal certificates, licenses, travel tickets, and certain public and private documents prohibi-
ted from reproduction by law. Reproduction of such items may be subject to criminal prosecution.

• Please note that intellectual property protected by copyright may not be reproduced without the express permis-
sion of the copyright holder except for personal or household use under limited circumstances.
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Manuals for this printerManuals for this printer
Manuals for this printer ....................................................................................................................................... 942
About This User Manual ..................................................................................................................................... 942

Manuals for this printerManuals for this printer
This printer has the following manuals.

Name Contents Medium
Setup Guide Instructions for unpacking and setting up the printer, and for instal-

ling the software and electronic manuals.
Printed Manuals

Basic Guide Descriptions of basic printer operations.

User's Guide Detailed instructions for using the printer. Electronic manuals

Paper Reference Guide This guide describes about the types and specifications of the availa-
ble media on the printer.

Setup Guide Basic Guide User's Guide Paper Reference Guide

About This User ManualAbout This User Manual

• Symbols
The following symbols are used in this user manual to indicate safety information and explanations on restrictions
or precautions in use.

Warning Indicates warning items for which operating error poses a risk of death or serious injury. To ensure safe use, always
follow these warnings.

Caution Indicates caution items for which operating error poses a risk of injury. To ensure safe use, always follow these cau-
tions.

Important Indicates important information and restrictions that definitely are to be followed during operation. Be sure to read this
information to prevent troubles, malfunctions, or damage to equipment or property by operating errors.

Note Indicates helpful reference information and supplemental information on particular topics.

• Button names and user interface elements
Key and button names on the control panel and user interface elements in software (such as menus and buttons)
are indicated as follows in this user manual.

Control panel buttons Example: Press the OK button.

Control panel messages Example: Head Cleaning is displayed.

Software interface items
(menus and buttons)

Example: Click OK.

Keyboard keys Example: Press the Tab key.
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• Cross-reference
Other pages or manuals that provide related information are indicated as follows in this user manual.

Cross-reference in the same user manual Example: see "Turning the Printer On and Off." →P.21
Click the link to jump to the corresponding page.

Cross-reference in related manuals Example: See the Paper Reference Guide.

Other cross-reference Example: See the printer driver help.

• Figures and software screens

• Figures in this user manual may be different from the actual appearance of the printer in some cases.

• Screens depicted in this user manual for the printer driver or other software may be different from the actual
screens because of subsequent updates.

• May we request

• The information in this user manual is subject to change without notice.

• We strive to ensure accuracy of information in this user manual, but if you notice errors or omissions, please
contact us.
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How to use this manualHow to use this manual
Searching Topics ............................................................................................................................................... 944
HTML Version of the Manual for Printing ............................................................................................................ 945

Searching TopicsSearching Topics
You can find information in topics of this User Manual by searching for relevant terms.

1 Enter a term and click the Search button.

Note

• To search for multiple terms at once, enter a space between each term.

Search results are listed at left.

2
 

Click a topic you want to read.
The terms you searched for will be highlighted in the
topic.
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To review multiple topics at once, select the check box
of desired topics and click the Apply button.

HTML Version of the Manual for PrintingHTML Version of the Manual for Printing
You can select a group of topics in the table of contents or individual topics in this manual for printing.
The following procedure describes how to do this, using the information in Basic Printing Workflow as an example.

Printing a group of topics in the manual
When you access printable HTML versions of the content from section titles in the table of contents, you can specify a
group of topics to print.

1
 

Click a section title in the table of contents. Here, Basic
Printing Workflow is used as an example.
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2
 

Click Access to the HTML for printing in the title
area.

The topics in Basic Printing Workflow are displayed
together in HTML format, ready for printing.

3
 

Clear the sections you will not print and click the Apply
button.
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Printing a group of individual topics in the manual
When you access printable HTML versions from subtitles in the table of contents, you can specify a group of topics to
print.

1
 

Click a section title in the table of contents. Here, Basic
Printing Workflow is used as an example.

2
 

Under Basic Printing Workflow, click Printing Proce-
dure.

3
 

Click Access to the HTML for printing in the title
area.
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The topics in Printing Procedure are displayed togeth-
er in HTML format, ready for printing.

4
 

Clear the topics you will not print and click the Apply
button.
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Printing selected topics
Print selected topics as follows.

1 Access the printing dialog box as follows, depending on your computer's operating system.

• Windows
In Windows, right-click anywhere in the explanation
area except on a figure or a link.In the shortcut
menu, click Print to display the Print dialog box.

• Macintosh
On a Macintosh computer, click anywhere in the
explanation area except on a figure or a link while
holding the Ctrl key. In the shortcut menu, click
Print Frame to display the Print dialog box.
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2 Specify conditions as needed, and then click Print (Windows) or Print (Macintosh).

• Windows

• Macintosh

Note

• To print only individual topics that are displayed, use this method.
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Disposal of the productDisposal of the product
WEEE DirectiveWEEE Directive
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